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P R E F A C E

                
Using the Documentation and 
Additional Resources
Welcome to Final Cut Pro, the all-in-one solution for professional digital video editing and 
compositing. Final Cut Pro is designed to work with professional broadcast equipment in 
post-production environments, enabling you to produce broadcast-quality productions in a 
flexible environment. 

Final Cut Pro comes with several types of documentation to help you learn more about Final 
Cut Pro and how to use the application.

m Final Cut Pro user’s manual

m Final Cut Pro tutorials

m Final Cut Pro onscreen help 

m Apple’s Final Cut Pro Web site

m Apple’s Service and Support Web site

m Other Apple Web sites 

Final Cut Pro User’s Manual

This manual provides setup and installation instructions, background and conceptual 
information, step-by-step instructions for tasks, and a glossary of terms and effects. 

The manual is divided into several main sections:  Basics, Acquisition, Creation, Effects, 
Distribution, Creating Custom Filters Using FXScript, and Appendixes. Check out the 
sections you’re interested in or use the index to find specific topics.
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Final Cut Pro Tutorials

There are several tutorials to help you learn more about acquisition, basic editing, creating 
effects and compositing, working with audio, and distributing your media projects. The 
tutorials are available onscreen via the Help menu and provide step-by-step instructions on the 
screen while you are working in Final Cut Pro. A print version of the tutorials also comes with 
Final Cut Pro, if you prefer to use it.

Note:  Before you can use the tutorials, you need to install the media files from the Final Cut 
Pro 2 Tutorial Media CD. The tutorial media files require approximately 310 megabytes (MB) 
of free space on your hard disk.

To go through the tutorials onscreen:

m Choose Final Cut Pro Tutorials from the Help menu.

Final Cut Pro Onscreen Help

Help allows you to access information directly onscreen while you’re working in Final Cut 
Pro. To view this information, choose Final Cut Pro Help from the Help menu. Help content 
is nearly the same as in the manual:  there are step-by-step instructions for particular tasks, 
along with reference information. You can click a topic in the left table of contents or search 
for a specific word or phrase.

Click a tutorial topic to 
be guided step-by-step 
through various tasks.
8 Preface  



               
To access Final Cut Pro Help:

1 Choose Final Cut Pro Help from the Help menu.

2 Do one of the following:

m Enter a search term or phrase, then click Search.

m Click a topic in the left table of contents

Late-Breaking News

Final Cut Pro Help also contains information about issues with third-party hardware and 
software and known bugs. This information is found in the “Late-breaking news” section of 
the onscreen help.

To access late-breaking news:

m Choose Final Cut Pro Help from the Help menu, then click “Late-breaking news” in the 
left table of contents.

Enter a few words or a phrase 
here, then click Search.

Click a topic to go to it.
 Using the Documentation and Additional Resources 9



                          
Additional Onscreen Help Information

There are various other onscreen resources within Final Cut Pro that are available from the 
Help menu.

m Context Sensitive Help:  Choose this to view onscreen help information for the 
active window.

m Help Cursor:  Choose this, then click a window in Final Cut Pro to view onscreen help 
information about it.

m What’s New?  Provides information on new features and enhancements in this version of 
Final Cut Pro.

m Where Do I Start?  This menu item provides an overview of the major tasks in Final Cut Pro 
and the windows and commands you’ll use for them.

m Keyboard Shortcuts:  Provides a list of keyboard shortcuts by key and function.

Apple’s Final Cut Pro Web Site 

Go here for general information and updates as well as the latest news on Final Cut Pro. You 
can also find out which third-party products Apple has qualified for use with Final Cut Pro.

To go to the Final Cut Pro Web site:

m Open your Internet browser, then enter:

www.apple.com/finalcutpro

There are a variety of discussion boards, forums, and educational resources related to Final 
Cut Pro on the Web. For more information, go to the Tips & Training area of the Final Cut Pro 
Web site at:  www.apple.com/finalcutpro/training

Apple’s Service and Support Web Site

Go here for software updates and answers to the most frequently asked questions for all 
Apple products, including Final Cut Pro. You’ll also have access to product specifications, 
reference documentation, and Apple and third-party product technical articles. 

These menu items provide access 
to specific help pages for the active 
window and other selected items 
within the Final Cut Pro interface.

These items provide
quick access to

selected Help pages.
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To access Apple’s Service and Support Web page:

m Open your Internet browser, then enter:  www.apple.com/support

Click here to access 
additional support 
resources.

Click here to access
the Final Cut Pro

Support page.

The Final Cut Pro 
Support page is 
one place to go for 
technical information 
and solutions to 
common problems.
 Using the Documentation and Additional Resources 11



                     
Other Apple Web Sites
m www.apple.com

Start at Apple’s main home page to find the latest and greatest information about 
Apple products.

m www.apple.com/quicktime

QuickTime is Apple's industry-standard technology for handling video, sound, animation, 
graphics, text, music, and 360-degree virtual reality ( VR) scenes. QuickTime provides a 
high level of performance, compatibility, and quality for delivering digital video. Go to the 
QuickTime Web site for information on the types of media supported, a tour of the 
QuickTime interface, specifications, and more.

m www.apple.com/firewire

FireWire is one of the fastest peripheral standards ever developed, which makes it great 
for use with multimedia peripherals, such as video camcorders and the latest high-speed 
hard disk drives. Visit this Web site for facts and benefits about FireWire technology, 
FireWire software information, and available third-party FireWire products.

m www.apple.com/creative

This Web site provides news, information, and other resources on seminars, events, and 
third-party tools used in Web publishing, design and print, music and audio, desktop 
movies, digital imaging, and the media arts.

m www.apple.com/education

Look here for resources, stories, and information about projects developed by users in 
education using Apple software, including Final Cut Pro.

m store.apple.com

Go here to buy software, hardware, and accessories direct from Apple. You can also find 
special promotions and deals that include third-party hardware and software products.
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C H A P T E R

1

1 Video Creation in Final Cut Pro

The days when post-production facilities with specialized, expensive video-editing equipment 
dominated the post-production process are over. Now, with a Macintosh computer and Final 
Cut Pro, high-quality desktop movie production is within the reach of anyone with the desire 
to tell a story.

This chapter explores the differences between analog and digital video, the guiding principles 
for working in Final Cut Pro, and how the four basic steps of video editing—acquisition, 
editorial, effects, and distribution—are applied in Final Cut Pro.

Determining Your Video Format
Long before editing begins, the most basic decision a video producer needs to make is 
which video format to shoot with. This decision affects not only the equipment needed 
for editorial work, but how the finished product will look. There are two videotape 
formats:  analog and digital. 

About Analog Video

Analog tape formats include VHS, Hi-8, and Beta SP. The video is stored on tape as an analog 
waveform. To bring analog video into your computer for editing with Final Cut Pro, you need 
to translate the analog signal to a digital one so it can be stored on your hard disk  as a digital 
file. This translation is done by a video capture card that’s installed in your computer, or by 
an external converter device. When you’re finished editing, you can send your edited 
program to videotape through the video capture card or external device. The digital video on 
your hard disk is then translated back into an analog signal that your camcorder or video 
deck can recognize.
  15



The main advantage of analog video is its widespread use. Nearly everyone has a VHS deck, 
and most post-production houses have at least one Beta SP deck. The main disadvantage of 
analog tape is generational loss, or the reduction in video quality over time. When you 
duplicate an analog tape, the duplicate has a slightly lower quality. If you repeat this process 
several times and use the duplicate to make more copies, your videotape may be 
unwatchable because of the cumulative loss of quality. Repeated playback also increases wear 
and tear on your original source tapes.

About Digital Video

The term digital video can mean a variety of things—a movie on DVD, a home video stored 
on a tape, or a QuickTime movie trailer on the Web. All represent video stored digitally, but 
in different formats. Digital video formats include DV and Digital Betacam.

Unlike analog video, a digital video signal is stored as a series of ones and zeroes on tape. 
This allows computer-based video editing programs, such as Final Cut Pro, to capture DV, a 
specific digital video format, without any additional hardware. Since the video signal is 
already digital, it can be imported using the FireWire interface of your Macintosh computer.

Copying digital video is similar to copying a computer file. As long as you use a digital 
interface on your DV device, there is no generational loss. You can make as many copies as 
you like and they all look as good as the original.

The Basics: Clips, Sequences, and Projects
The key components of Final Cut Pro are clips, sequences, and projects. 

m A clip is an individual section of a video, audio, or graphics file. All video, audio, and 
graphics that you import into Final Cut Pro appear as clips. A clip can be the smallest 
individual part of an edited program, analogous to a shot in a movie, or it can be an entire 
program. How much or how little you capture in a clip is up to you. 

m A sequence is a series of clips edited together to create a program. Sequences can be up 
to four hours long and contain as many clips as you need to tell your story. A sequence 
can contain your entire edited program or be limited to a single scene. Final Cut Pro 
gives you the flexibility to organize your edit however you like, with as many sequences 
as you need.

m A project contains all the clips, sequences, and files that relate to a particular program or 
programs. You can have more than one project open at a time—for example, if you’re 
working on various programs at one time. 
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About Nonlinear and Nondestructive Editing
In the past, editing material and changing a project was a time-consuming process. Now, with 
the rise of computer video production, nonlinear, nondestructive video-editing programs 
such as Final Cut Pro give you an amazing amount of flexibility for rearranging and reediting 
your sequences. These applications are like a word processor for video, letting you rearrange, 
copy, delete, and reformat items very easily.

With linear editing, video editors had to edit everything onto a tape sequentially, one shot 
after another, from the beginning to the end. If you wanted to change a series of shots in the 
middle of your edit, you had to reedit everything forward. 

Nonlinear editing is possible with digital video that you’ve captured on your hard disk. Once 
all your material is captured, you can easily cut, paste, add, and delete material from any part 
of the sequence. You can begin editing at any point. If you want, you can start from the end 
of the program and work your way back to the beginning. 

Nondestructive editing means that you can change a captured clip in Final Cut Pro without 
affecting the original source clip stored on your hard disk. Clips in Final Cut Pro are pointers 
to your original source material, not the actual source material. 

Almost nothing you do in Final Cut Pro has any effect on the original digital video files you 
captured to disk. Even if you delete entire clips, they are still stored in the folder to which 
you captured them, until you drag them to the Trash in the Finder. The two exceptions to 
this are changing a clip’s timecode and reel number. Whenever you change these “item 
properties” for a clip, the change is saved to the original clip on your hard disk. Also, if you 
edit a clip in a sequence and you cut it short, the edited piece is not gone forever. You can 
recapture the material you cut from the clip at any time using the original source files on 
your hard disk.

Online and Offline Editing
When you’re doing a final edit using a high quality, tape-based editing suite with extremely 
expensive equipment, hourly rates can be high. To avoid this expense, editors have 
traditionally done the majority of their decision-making “offline,” editing video at lower 
quality with inexpensive equipment. To keep track of shots, editors use timecode recorded to 
each source tape and reel numbers that identify individual tapes.

In the past, an offline edit was done for linear tape-to-tape editing. When nonlinear editing 
software came into widespread use, the systems captured video at very low quality compared to 
professional, tape-based editing suites. Editors still had to do a final edit using the original tapes.
  Video Creation in Final Cut Pro 17



Once they’d completed their offline edit, editors could generate an Edit Decision List, or 
EDL, from the timecode numbers at the beginning and end of every edited shot. Then they 
used the list to recreate the edit at the online editing facility using the original tapes. Because 
the majority of decisions were already made, this process didn’t take a long time, and editing 
costs were lower.

Today, many nonlinear editing systems rival tape-based editing suites in quality, so editors no 
longer need to bear the expense of an online tape-based edit. Still, importing digital video at 
the highest level of quality can take up a lot of disk space. For this reason, offline editing has 
also come to refer to the process of capturing your initial set of video clips at low visual 
quality. Each video clip takes substantially less disk space, so you can import more material to 
use for your editorial decisions.

Once the offline edit is finished, the original imported video clips can be discarded. Because 
editors typically import more material than is ultimately used in the final program, discarding 
the original source material frees up plenty of hard disk space to record only the clips used in 
the program at the highest quality. Using timecode, these clips can then be reimported.

The Video Creation Process in Final Cut Pro
The post-production process in Final Cut Pro involves four main steps:  acquisition, editorial, 
effects, and distribution.

Step 1: Acquisition

Acquisition refers not only to capturing video clips for use in your project, but also to 
accumulating all the media you need to complete your project. Final Cut Pro allows you to 
capture video and audio from a wide variety of sources, if you have the appropriate 
hardware. You can also import a variety of QuickTime, audio, and graphics file formats. Once 
they are imported, you can organize these clips in a variety of ways using bins and tabs.

One of the main steps of acquisition in Final Cut Pro is logging. In this process, you go 
through all of your source tapes and identify the clips you may want to use in your project 
before actually capturing them. To log your tapes, you need to use a camcorder or deck with 
device control. (For more information on device control for video capture, see “Video 
Capture Using Device Control” on page 149.) Logging gives you the opportunity to become 
more familiar with your source material and to annotate clips that you may find useful. 
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Step 2: Editorial

This process involves taking the video you’ve captured, along with any audio or graphics you 
imported, and turning these raw materials into an edited sequence of clips. Most editors start 
with a rough cut, where they assemble all the clips for their program very quickly to provide 
the general structure of their edit. Once that’s finished, they work on fine-tuning, adding the 
polish and pizzazz desired for the final product. Editing in transitions such as wipes and 
dissolves and adding music, voiceover, and sound effects are also a part of this process.

Step 3: Effects

With the timing of your edit largely completed, you can then add effects such as titles, 
superimpositions, and filters. You can also add keyframes and motion effects for rotating, 
resizing, and moving video and images. Final Cut Pro has a wide variety of video and audio 
effects with parameters that can change over time.

Step 4: Distribution

The last step is deciding how you want to distribute your final product. Will you output your 
program back to videotape? Do you want to send a high-resolution digital file to another 
editing facility? Or do you want to compress your program for the Web or CD-ROM? Final Cut 
Pro lets you do all of these and more.

Formats Supported in Final Cut Pro
Final Cut Pro supports many video, still image, and audio formats. For more information about 
formats you can import, see “Supported File Formats for Importing” on page 288. For 
information about formats you can export, see “Supported File Formats for Distribution” on 
page 1148. For an up-to-date list, go to the Final Cut Pro Web site (www.apple.com/finalcutpro).

Formats supported by Final Cut Pro include

m DV video using FireWire

m Composite, Component, and Serial Digital Interface (SDI) NTSC and PAL video using 
third-party cards qualified for use with Final Cut Pro

m Standard QuickTime video and file formats, including Motion and Photo JPEG, Sorensen, 
Cinepak, and more (for both import and export)

m Standard image formats, including BMP, JPEG, MacPaint, Photoshop, PICT, PNG, 
QuickTime Image File (QTIF), SGI, TARGA, and TIFF, with alpha channels maintained (for 
import only)

m Standard audio formats, including AIFF and WAV files

m QuickTime streaming video (for export)

m Edit Decision Lists (EDLs) and batch capture lists (for import and export)
  Video Creation in Final Cut Pro 19



Learning to Edit and Being Prepared
Your success in post-production depends in large part on the preparation that went into 
production. Aside from the quality of your script, casting, and the production value of your 
shoot, it’s important to answer the following questions:

m Did you shoot enough material to cover your entire program?

m Do you have shots you can cut away to if you need to cover an edit (commonly called 
“B-roll”)?

m If you’re editing dialog, do you have enough coverage of all the characters in the scene so 
that you can cut to another actor to cover a mistake?

The key to a successful edit is the experience, talent, and imagination of the user. If your first 
edits are not as good as you like, don’t be discouraged. You’re entering a profession that has 
been around for over 100 years.

The best way to improve as an editor is to edit. With each project, your ability and confidence 
will improve. Along the way, you can use references, such as the numerous books, videos, 
and classes about the art of editing, to help you add to your creative vocabulary and skills.

What’s Next?
In the rest of this section, you’ll learn how to set up your computer and video equipment, 
how to install Final Cut Pro and other software, and how Final Cut Pro’s basic features and 
interface work. 

In addition to the manual, Final Cut Pro includes several tutorials in both print and onscreen 
formats. These tutorials provide step-by-step instruction for various editorial tasks, giving you 
an easy introduction to using Final Cut Pro.
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C H A P T E R

2

2 Setting Up Your System

This chapter presents ways you can set up your computer, video equipment, and other 
hardware for use with Final Cut Pro. It’s a good idea to set up and connect your system before 
you install the software. Final Cut Pro can then detect the type of video device connected to 
your computer and automatically set certain preferences based on your configuration.

m For information on system and hardware requirements, see the Read Me document on 
the Final Cut Pro CD. 

m For the latest information on Final Cut Pro and Mac OS updates, go to the Final Cut Pro 
Web site at www.apple.com/finalcutpro

Final Cut Pro works with two basic setups:  DV and analog. 

DV

You can easily connect a DV-format camcorder or deck to a FireWire port on your computer. 
DV-format equipment uses the FireWire interface to transfer video, audio, timecode, and 
device control data over a single FireWire cable. FireWire (also referred to as IEEE 1394 and 
i.LINK) is a high-speed technology for connecting and transmitting data to and from various 
external devices. This standard is supported by many professional and consumer-level DV 
camcorders and decks. 

You can set up a DV system using FireWire or serial device control. For more information, see 
“Setting Up a DV System Using FireWire Device Control” on page 38 and “Setting Up a DV 
System Using Serial Device Control” on page 40.

Analog

If you need to capture and output analog video at varying degrees of quality, you can install 
an approved third-party video capture card in your computer. With an analog setup, video, 
audio, and device control use separate cables. Make sure you have the correct cables and 
adapters for your setup and that they are properly connected. For more information, see 
“Setting Up an Analog-to-DV System” on page 42.
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Additional Equipment to Consider
You may consider using additional hardware and equipment, depending on your video 
format and workflow:

m additional random-access memory (RAM) and storage space

m an NTSC or PAL video monitor

m a second computer display

m external speakers for monitoring audio

m an audio mixer to adjust audio levels

m an audio matchbox to correct audio levels

m a USB-to-serial adapter to connect analog equipment

m a third-party video capture card to capture video from a non-DV–format source

m a real-time card to view effects, filters, and transitions in real time with no rendering

m a patch panel for multiple video and audio setups with analog equipment

Additional RAM and Storage Space

If you plan to work on large projects or with multiple media applications at one time, it’s 
useful to have extra random-access memory, or RAM, installed in your computer. You must 
have at least 192 megabytes (MB) of RAM to use Final Cut Pro, but it’s a good idea to have 
256 MB or more. (Some third-party video capture cards may require more than 256 MB.)

It’s also a good idea to have as much hard disk space as you can possibly afford. Editors 
commonly capture far more material than appears in their final programs, and even highly 
compressed full-screen video requires a lot of space. The more disk space you have, the 
more source material you can capture to work with. For more information on hard disk 
requirements and recommendations, see “Hard Disk Storage for Digital Media” on page 29.

An NTSC or PAL Monitor

NTSC and PAL are standards for video. NTSC, or National Television Systems Committee, is 
the television and video standard used in most of the Americas, Taiwan, Japan, and Korea. 
PAL, or Phase Alternating Line, is the television and video standard used in most of Europe, 
Brazil, Algeria, and China. (SECAM, a video standard based on PAL and used in France, 
Poland, Haiti, and Vietnam, is not supported by Final Cut Pro. However, post-production 
work is usually done in PAL and converted to SECAM.)

If you’re outputting to videotape for broadcast on television, it’s highly recommended that 
you watch your video output on an NTSC or PAL monitor. Color is represented differently on 
computer and video displays. Color-correcting video filters and other visually oriented effects 
don’t look the same on a computer monitor as they will when played back from videotape. 
22 Chapter  2   



You can connect a video monitor to your computer through a camcorder or deck that is 
connected to the FireWire port on your computer. You can also connect a video monitor 
directly to the analog output of an analog-to-digital capture card installed in your computer. 
Before doing this, see the documentation that came with your video capture card, video 
monitor, and camcorder or deck.

Depending on the type of video signals your camcorder, deck, or video capture card 
produces, you can use a video monitor with a combination of composite, S-Video, 
Component YUV, or Component RGB inputs. The higher the quality of input your video 
monitor can use, the clearer your analog video image will be. For more information on video 
signals and their use, see “Types of Video Signals” on page 26.

A Second Computer Display

If your computer has expansion slots, you may be able to install a monitor card in an available 
PCI slot. If you have a second display, you can use screen real estate more effectively by 
taking advantage of several dual-screen window arrangements in Final Cut Pro. 

For information on connecting and using a second computer display with your system, see 
the documentation that came with your computer and the second display. For more 
information about Final Cut Pro’s screen layouts, see “Changing the Layout of Windows” on 
page 94.

External Speakers

External speakers allow you to monitor audio output from your computer or from a 
camcorder or deck at higher quality than you’d get from the speakers in your computer, 
camcorder, or deck. This is important if you do a lot of audio editing, since hearing what 
you’re working on determines how you adjust the relative volumes of sound clips used in 
your projects. You can use self-powered speakers or speakers that include an amplifier.

For information on connecting external speakers to your video equipment, see the 
documentation that came with the speakers and your video equipment.

Note:  If you’re using a video monitor that’s connected to a camcorder or deck via FireWire 
or one that is connected to an analog-to-digital capture card, connect your speakers to the 
same set of outputs that your video monitor is connected to. If external video is enabled in 
Final Cut Pro, delays in the signal paths cause audio output through the computer’s speakers 
or headphone jack to be slightly out of sync with the video displayed on your connected 
NTSC or PAL monitor. In this case, your computer’s audio is disabled and audio is sent to 
your external device via FireWire or an analog-to-digital capture card. This is also the case 
whenever you’re using Log and Capture with a DV device.
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An Audio Mixer to Adjust Audio Levels

An audio mixer lets you easily adjust and monitor audio levels output from Final Cut Pro as 
you mix the audio tracks of your program together. Multichannel mixers allow you to plug in 
multiple audio devices, set their levels using sliders or knobs, and see how the resulting 
levels look on a built-in Volume Unit, or VU, meter. 

Using the manual level controls and VU meter of a mixer, you can calibrate the analog audio 
output from your system to an analog reference standard of 0 dBfs (decibels, referred to as 
dB in the Final Cut Pro documentation). An analog audio level of 0 dB on your mixer will 
usually map to a digital reference tone level set to –12 dB, –18 dB, or –20 dB on Final Cut 
Pro’s audio meter.

Another useful feature of an audio mixer is that it shows you the average levels of your 
program, in addition to the peak levels displayed by Final Cut Pro’s audio meter. By watching 
both the average levels in the mixer’s VU meter, and the peak levels in Final Cut Pro’s audio 
meter, you can set the levels of all the clips in your piece so that the final combined audio 
level (or mix) of your program is neither too quiet nor too loud.

You can use a mixer for monitoring and output in one of two ways:

m To monitor or output audio from a DV device connected to your computer, connect the 
mixer between your DV device and your amplified speaker or analog output device. 

m If you regularly monitor or output analog audio using an analog-to-digital capture card, 
connect the audio mixer between the analog audio outputs from your capture card, and 
your amplified speaker or analog output device. 

For more information on setting levels and mixing audio, see Chapter 17, “Working With 
Audio,” on page 727.

An Audio Matchbox to Correct Audio Levels

Audio captured or output using an analog device with balanced audio connectors via an analog-
to-digital capture card produces different audio levels from audio captured or output with the 
built-in sound input port (or microphone jack) on your computer. This can cause problems if 
it’s not corrected.
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Balanced audio, which usually uses XLR connectors, has a line level of +4 dBV. Unbalanced 
audio, which almost always uses either a microphone jack or RCA connectors, has a line level of 
–10 dBu. If you run an unbalanced signal to a balanced input, the audio will be far too quiet to 
record a good level. If you run a balanced signal to an unbalanced input, you’ll end up 
distorting your audio badly. (For more information, see Chapter 17, “Working With Audio,” on 
page 727.)

You can correct audio level problems using an audio matchbox. A matchbox is a powered 
adapter that converts balanced audio to unbalanced audio and vice versa. Matchboxes can 
usually have a set of stereo inputs and a set of stereo outputs at the same time.

A USB-to-Serial Adapter 

If you’re using an analog video camcorder or deck capable of device control, you need 
to connect it to your computer using a qualified USB-to-serial adapter. The adapter lets 
you exchange device control and timecode signals between Final Cut Pro and the analog 
video device.

A Third-Party Video Capture Card

If you plan to capture video from a non-DV–format source (such as Hi-8, Beta SP, or Digital 
Betacam) using FireWire, you need to install a third-party video capture card in your 
computer. There are several qualified cards you can use with Final Cut Pro, each with options 
for transferring different types of video signals to your computer. The card you use depends 
on the quality of your video equipment and your needs. 

For more information, see the documentation that came with your card. For information on 
various video signals in use, see the next section, “Types of Video Signals.”

Miniplug connector (unbalanced)

Stereo RCA connector (unbalanced)

Balanced XLR connector  
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A Real-Time Video Card

Final Cut Pro allows you to play cuts-only video in real time with no delays. However, transitions 
such as wipes and dissolves and effects such as filters and Motion tab animation need to be 
rendered before playback. With a real-time video card installed in your computer, you can view 
certain effects, filters, and transitions in real time with no rendering. Although this type of 
system is more expensive, it can save you a lot of time and effort and is useful when your client 
is in a hurry or frequently checks your work in progress.

Each real-time card may support a different set of real-time effects and features within Final 
Cut Pro. For detailed information and installation instructions, see the documentation that 
came with your card.

A Patch Panel

You can use a patch panel with analog video equipment to make it easier to switch between 
multiple video and audio setups. A patch panel can be configured with video and audio 
sockets, one for each video and audio input and output port of your capture card, your analog 
deck or camcorder, and your video monitor. Instead of reconnecting cables every time you 
want to set up a new configuration, you can use patch cables to connect one socket to another 
on the front of your patch panel. This saves time and wear and tear on your equipment.

Types of Video Signals
When connecting video equipment, you can use different video signals. The signal you use 
determines the quality of your video when you capture and output it. Video camcorders, 
decks, and monitors can use different combinations of signal types, depending on their 
quality. Consumer equipment is limited; professional gear gives you the greatest range of 
options for the highest possible video quality. 

A piece of equipment with a high-end video interface is not enough, however. If you plan to 
use video other than DV, you need an analog-to-digital video card that uses the same kind of 
video that your camcorder or deck produces. 

Both consumer and professional video equipment use these video signals and connectors:

m Composite

m S-Video ( Y/C)

m Component YUV ( YCrCb)

m Component RGB

m FireWire (IEEE 1394 or i.LINK)

m SDI

m SCART
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Composite

Composite is the lowest common denominator of video signals. A composite signal runs all 
color and brightness information through a single pair of wires. This creates analog 
“artifacts,” making this the lowest quality video signal. Nearly all video equipment has 
Composite outputs. This format uses a single RCA or BNC connector. 

A Composite video signal is most commonly used for troubleshooting and menu outputs, as 
well as for generating timecode characters to create window burns. Many high-end video 
decks allow you to adjust their settings using special menus. These menus are typically only 
visible using a special Composite output. This output displays the deck’s video playback, any 
special menus from that deck’s menu mode, and “window burn” timecode displays.

S-Video

S-Video, also known as Y/C, is typically the highest quality of video used by high-end 
consumer video equipment. The image looks sharper and has better color than Composite 
video because S-Video sends the color and brightness information separately along two pairs 
of wires, keeping the signals cleaner. Most low-cost analog-to-digital video capture cards have 
S-Video as their highest quality video connector. 

Component YUV (Also Called YCrCb) and Component RGB

Professional video equipment, such as Beta SP decks, has Component YUV video inputs and 
outputs. Component YUV breaks up the color and brightness information between three 
separate pairs of wires, keeping the video signal extremely sharp and the color quality strong 
and accurate. Component YUV is as good as analog video gets. Analog-to-video capture cards 
capable of capturing and outputting Component video are generally more expensive.

Another form of Component video, Component RGB, is not as widespread on professional 
gear as Component YUV. High-end consumer equipment, such as DVD players and 
televisions, have increasingly begun to support Component RGB.

RCA connector

BNC connector  

S-Video connector
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Both Component YUV and RGB signals may use from three to five connectors. You can use 
three BNC connectors, plus a fourth (typically labeled “Genlock” or “House Sync”) for 
sending a timing signal. Or, sync can be embedded in Y or G (using 3 connectors), a separate 
Composite sync (using 4 connectors), or separate H and V drive signals (using 5 connectors). 
See your equipment’s documentation for more information. 

FireWire (Also Called IEEE 1394 or i.LINK)

This is the consumer and professional standard for DV-format digital video. FireWire is now 
included on nearly all Macintosh computers and is an inexpensive and easy way to capture 
and export high-quality digital video using a variety of camcorders and decks. 

There are two kinds of FireWire connectors:  a 4-pin connector (typically found on video 
equipment, such as your camcorder or deck) and a 6-pin connector (used for computer 
equipment). However, some newer video equipment uses the 6-pin connector and some video 
cards use the 4-pin connector. See your equipment’s documentation for more information. 

SDI (Serial Digital Interface)

SDI is the standard for high-end, uncompressed digital video formats, such as D1-D5 and Digital 
Betacam. If you want to capture digital video from these formats at the highest possible quality, 
you need a video capture card with SDI input and output, as well as a high-performance disk 
array (a set of external disk drives) to accommodate the high data rates you’ll work with.

Component

Y or green

YUV

RGB

R or red On some equipment,
you can switch between
RGB and YUV modes.

B or blue

6-pin connector to camcorder or VTR
(Sometimes labeled i.LINK)

4-pin connector to computer  

SDI uses a single BNC connector  
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SCART

PAL equipment may also have a special connector called a SCART connector. These 
connectors have multiple pins that run Composite, Component RGB, and stereo audio in 
one bundle. SCART input or output can be broken up into individual connections using 
special adapters available from video and home electronics stores.

Hard Disk Storage for Digital Media
Digital video can take up an enormous amount of storage space. Your computer’s internal 
hard disk may have enough storage space for DV capture. Other considerations, such as disk 
fragmentation or the need to do high data rate M-JPEG capture, may help you decide to use 
additional disks. 

In most cases, you should use dedicated volumes for capturing and playing back your digital 
video and other media files. You can use separate disks or partitions of your internal disk to 
store the Final Cut Pro software and other media. Separate volumes provide a lower chance 
of fragmentation and faster performance than your computer’s internal disk.

You may be able to add both internal and external hard disks to your computer. Here are the 
pros and cons for both kinds of disks: 

SCART connector

Important  If you have multiple hard disks and partitions, make sure they do not have 
similar names, or you could encounter problems during capture. For more information, see 
“About Naming Disks and Folders” on page 163.

Internal disks

m May be less expensive.

m Are inside your computer, causing less noise.

m Are limited by the expansion capabilities of your computer.

External disks

m Let you switch easily between projects by changing the disk connected to the computer.

m Let you move a project quickly from one computer system to another in a different location.

m May be more expensive.

m May be noisy.
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Using Fast Hard Disks for High Data Transfer Rates

Digital video and audio demand high data rates. Here are some examples:

Your storage disk’s sustained transfer speed must be fast enough to keep up with the data 
rate. Most of the time, an individual AV-rated disk is not fast enough.

When you capture M-JPEG video at 12 MB/sec. or higher or capture uncompressed video, a 
single hard disk cannot transfer data fast enough. If the disk is not fast enough, frames are 
dropped. You need to use special software to create a disk array so multiple disks can work 
together to capture video at higher data rates. For more information, see “SCSI Disk Arrays” 
on page 33.

Note:  Removable media drives such as Jaz, Zip, and CD-RW drives are not suitable for video 
capture because of their low data transfer rates.

When comparing types of storage media, consider three factors: sustained transfer speed, 
seek time, and spindle speed.

m Sustained transfer speed is a measurement of how fast data can be written to a disk in 
MB per second. When you use capture cards that utilize M-JPEG compression (for 
example, Targa or Igniter cards), the higher the sustained transfer speed of a hard disk, 
the higher the data rate of video that can be written to it, and the higher the quality will 
be. For imported DV material, this is not as great a concern because DV has a fixed data 
rate that does not vary.

m Seek time is a measurement of how quickly data stored on the disk can be accessed in 
milliseconds (ms). Low seek times are important when playing back an edited sequence 
of clips, because the disk must spend a lot of time searching for the next clip to play.

m Higher spindle speed increases a disk’s sustained transfer rate (typical multimedia disks run 
at 7200 revolutions per minute, or rpm). However, a hard disk heats up the faster it runs, 
so ventilation is important when you install drives internally or in external enclosures.

Format Typical data rate

DV 3.6 megabytes per second (MB/sec.)

M-JPEG 1–12+ MB/sec.

Uncompressed 24 MB/sec.
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Determining How Much Space You Need

The amount of disk space you need depends on the quality at which you capture your video 
and the length of your finished projects. Use the table below to estimate how much space 
you need.

In addition to space for captured files and project files, you need space for render files, extra 
copies, and test files. A rule of thumb to determine how much space you need is to multiply 
the amount of space needed for your finished program by five. 

For example, if you want to create a music video that’s approximately four minutes long 
using DV video:

m 3.6 MB/sec. video data rate x 60 seconds = 216 MB/min. x 4 minutes = 864 MB needed 
for project files 

m 864 x 5 = 4320 MB needed for project, render, cache, and other files

Round off 4320 MB to 4.5 GB to be on the safe side. This is the amount of disk space you’ll 
need to allow just for this one project. If you plan to work on multiple projects at the same 
time, estimate the amount for each project and add these numbers together.

Video data 
transfer rates 30 sec. 1 min. 5 min. 10 min. 30 min. 60 min.

1 MB/sec., Offline 
quality M-JPEG 

30 MB 60 MB 300 MB 600 MB 1.8 GB 3.6 GB

3.6 MB/sec., 
DV-format video

108 MB 216 MB 1.08 GB 2.16 GB 6.5 GB 13 GB

6 MB/sec., Medium 
quality 
M-JPEG

180 MB 360 MB 1.8 GB 3.6 GB 10.8 GB 21.6 GB

12 MB/sec., High 
quality 2:1 M-JPEG

360 MB 720 MB 3.6 GB 7.2 GB 21.6 GB 43.2 GB

24 MB/sec., 
Uncompressed

720 MB 1.4 GB 7.2 GB 14.4 GB 43.2 GB 86.4 GB
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Using Ultra ATA or SCSI Disk Drives

Whether you use Ultra ATA or SCSI hard disk drives depends on the kind of video you capture.

Ultra ATA Disk Drives

Many editors use Ultra ATA disks (also called Ultra DMA, Ultra EIDE, and ATA-33/66/100) with 
DV equipment. Imported DV material has a fixed data rate of approximately 3.6 MB/sec. 
High-performance Ultra ATA disks typically can import and output these streams without 
difficulty. These disks do not offer as high a performance as LVD or 160M SCSI disks.

If you plan to use Ultra ATA disks, make sure that 

m the sustained transfer speed is 8 MB/sec. or faster

m the average seek time is below 9 ms

m the spindle speed is at least 5400 rpm

These disks can only be installed internally. An ATA interface occupies one PCI slot and can 
support up to four additional internal drives. 

m If you have a Power Macintosh G3 computer:  You may need to use a third-party 
accelerated ATA card to install additional EIDE/ATA disks because the built-in ATA 
interface is used by the internal hard disk and CD-ROM drive. Earlier Power Macintosh G3 
computers may have unused ATA ports available. 

m If you have a Power Mac G4 computer:  Your computer has an unused, built-in ATA-66 
interface connector that can be used for one additional disk. Early Power Mac G4 computers 
may lack this connector, so you’d need to install a third-party accelerated ATA card.

For detailed information about connecting internal disks, see the documentation that came 
with your computer and the disk.

SCSI Disk Drives

SCSI disk drives are the fastest available. SCSI (Small Computer Systems Interface) 
technology has been implemented in various ways over the years, with each successive type 
of SCSI achieving higher performance. Currently, the two fastest SCSI standards for video 
capture and playback are

m Ultra2 LVD (Low Voltage Differential) SCSI:  Ultra2 SCSI disks offer high enough 
performance to capture and output M-JPEG video at high data rates when a single 
disk is formatted as a single volume (as opposed to formatting several disks together 
as a disk array).

m 160M SCSI:  These are faster than Ultra2 LVD SCSI disks.
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SCSI disks can be installed internally or connected externally. Many users prefer external 
cases because they’re easier to move and they stay cooler. If your Power Macintosh G3 or G4 
computer didn’t come with a preinstalled Ultra2 or 160M SCSI drive, you need to install a 
SCSI card in a PCI slot. Both Atto and Adaptec make Ultra2 SCSI cards that work with Final 
Cut Pro. 

A SCSI card allows you to connect up to 14 SCSI disks in a “daisy chain,” with each disk 
connected to the one before it and the last being terminated. Use high-quality, shielded 
cables to prevent data errors. These cables should be as short as possible (three feet or less); 
longer cables can cause problems. You must use an active terminator on the last disk for 
proper performance.

Note:  Active terminators have an indicator light that goes on when the SCSI chain is powered.

All devices on a SCSI chain run at the speed of the slowest device. To achieve a high level of 
performance, connect only Ultra2 or faster SCSI drives to your Ultra2 or 160M interface. 
Otherwise, you may impede performance and cause dropped frames during capture or 
playback.

Note:  Many kinds of SCSI devices are slower than Ultra2, including scanners and removable 
storage media. You should not connect such devices to your high-performance SCSI interface. 

SCSI Disk Arrays

Ultra2 LVD SCSI has a maximum transfer speed of 80 MB/sec., and 160M SCSI has a transfer 
rate of 160 MB/sec. However, the actual transfer speed of individual disks is much lower. You 
can improve the transfer speed by configuring multiple disk drives in a disk array. 

Disk arrays use special software to combine multiple disks into a single volume. Therefore, 
you see only one hard disk icon on your desktop. (If you partition the array into multiple 
volumes, you see an icon for each partition.) When you write to a volume, the file is divided 
and pieces are written to all of the disks simultaneously. 

Computer

SCSI card

SCSI cableSCSI cable

SCSI cable

SCSI terminator
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By working together, the disks in the array increase the amount of data you can transfer to 
the total capacity of the Ultra2 SCSI interface. This allows you to capture and play back 
higher-quality video without dropping frames. The disadvantage of an array is that if one of 
the disks stops working, all data stored on the entire array is lost.

When you create or purchase a disk array, there are two important considerations:

m Compatibility:  Make sure the software you use to create the array is compatible with 
Final Cut Pro. For more information, go to the Final Cut Pro Web site at www.apple.com/
finalcutpro

m Ventilation:  If you’re creating an array yourself with an off-the-shelf drive enclosure, good 
ventilation is extremely important. Disk arrays store information on several disks 
simultaneously. If one of your disk drives fails, information on all the disks is lost. One of 
the most common reasons a disk drive breaks down is overheating, so make sure that 
your disks stay cool. 

Using Serial Device Control With Final Cut Pro
Some camcorders and decks have an interface you use to send and receive timecode to and 
from your computer. If your device uses a protocol supported by Final Cut Pro (see “Device 
Protocols Supported by Final Cut Pro” on page 37), you can exchange timecode and device 
control data with the camcorder or deck directly from Final Cut Pro. This lets you automatically 
cue and import several clips at once (called a batch capture) and output frame-accurate clips or 
sequences to tape, based on timecode In and Out points on your tape.

Important  Check the manufacturer’s specifications before buying disks to make sure the 
disks offer high enough performance. 

Using a RAID (Redundant Array of Independent Disks)

If you require rock-solid data integrity, consider purchasing a RAID, or Redundant 
Array of Independent Disks. With a RAID system, all of your data is backed up 
redundantly on hidden portions of all the other disks. If one disk fails, your data can 
be easily reconstructed on a replacement disk. 

There are many RAID technologies available, but one that has high performance for 
both digital video capture and data redundancy is RAID level 3. RAID level 3 systems 
can be more expensive, as they use specialized hardware, but they should be 
considered whenever the safety of your media is more important than the price of 
your disks.
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Device control and timecode capture is done in two ways:

m FireWire with DV timecode

m Serial RS-232 or RS-422 with SMPTE timecode

Decks with device control have a switch that lets you choose either Local or Remote control. 

m To control your deck with Final Cut Pro:  Set this switch to Remote. 

m To use the transport buttons on your deck to control the deck:  Set the switch to Local.

Using a Non-Controllable Device

If you don’t have a camcorder or deck with device control, you can still capture and edit clips 
in Final Cut Pro. You start and stop your camcorder or deck manually and use the Log and 
Capture and Print to Video commands. 

Note:  You can choose not to use device control with a device-controllable deck. You 
typically won’t, however, unless you don’t have the proper cable.

Using FireWire Device Control

FireWire (also called IEEE 1394 or i.LINK) is a standard supported by many professional and 
consumer-level camcorders and decks. FireWire transmits device control data, timecode, 
video, and audio signals over a single FireWire cable. Using FireWire, you can capture video 
directly from DV camcorders with a built-in FireWire port and from older analog-only 
equipment using an analog-to-FireWire converter. 

Final Cut Pro also outputs media to your camcorder or deck through the FireWire connection 
so you can record the media on tape. All DV-format tapes have DV timecode on them. Final Cut 
Pro uses this timecode when exporting and importing clips and sequences to and from tape.

Important  While most camcorders support DV or serial device control, many professional 
video decks support both. When deciding which to use, it’s important to know that DV 
device control is not always frame-accurate. If you need precise In and Out points for every 
shot you log and capture, use serial device control. This is especially important if you plan to 
recapture your footage after editing.

Important  Once you capture a clip manually, your chances of recapturing the exact same 
clip with the same In and Out points are low. If there’s a chance you may reedit a project that 
includes manually captured clips, back up the clips.
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Video devices vary greatly in their functionality and adherence to FireWire specifications for 
device control. For this reason, there are two versions of the FireWire protocol you can use in 
Final Cut Pro:

m Apple FireWire:  This is the default.

m Apple FireWire Basic:  This is a simplified device control protocol for camcorders and 
decks that aren’t compatible with Apple FireWire’s full set. Using this protocol doesn’t 
affect the quality of captured video or audio. 

For more information about changing the FireWire protocol that Final Cut Pro uses, see 
“Editing a Preset” on page 110 and “About Device Control Presets” on page 128. For more 
information about FireWire technology, go to Apple’s FireWire Web site at www.apple.com/
firewire/

Using Serial Device Control

Some high-end DV-format camcorders and decks, as well as nearly all professional analog 
camcorders and decks, support serial device control. Unlike FireWire, serial device control has 
no video or audio information. It only sends and receives timecode and transport control data. 

Professional video camcorders and decks use two serial interfaces:

m RS-232:  Found on more inexpensive equipment. RS-232 is functionally similar to RS-422, 
but it’s not used as frequently.

m RS-422:  This interface tolerates greater cable lengths than RS-232. It’s more widely used 
by facilities where video decks are in a different room from the editing bay.

For more information, see the documentation that came with your camcorder or deck.

Final Cut Pro can use two kinds of timecode sent over a serial connection:

m LTC:  Longitudinal timecode, or LTC, is an audio signal located on a special track on the 
source tapes. If you add or change the timecode on your original tapes after they’ve been 
recorded, the timecode is LTC. LTC is also extensively used with professional audio 
formats, such as DAT and ADAT.

m VITC:  Vertical interval timecode, or VITC, is written into the video signal on the source 
tapes as they’re being shot. You can view this timecode as a series of changing, flickering 
white dots and line segments in one of the scan lines above the active picture on a 
monitor in underscan or pulse-cross modes. When viewed normally, the line containing 
the timecode is off the top of the screen. Because it’s part of the video signal, VITC 
timecode can’t be changed on your original tapes. The VITC part of the video signal is 
captured as part of a Final Cut Pro clip’s video frame.

Important  After you connect a DV camcorder to your computer, switch it to VCR mode. 
You can record to a camcorder from Final Cut Pro in Camera mode, but to do so, you need to 
turn off device control in Final Cut Pro, which limits your control during output.
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LTC timecode is most easily read when a deck is in fast-forward, and VITC is most easily read 
when a deck is in slow motion. Most professional video decks can read both signals and 
automatically send timecode from the one that’s clearest at any moment. For this reason, the 
LTC and VITC timecode on any tape are almost always identical.

Unlike DV format, analog tape formats don’t always have timecode written onto them. If 
you’re using S-VHS or Hi-8, which don’t record with VITC timecode, you need to make sure 
you’re using a device-controllable deck and, if your tapes don’t already have timecode on 
them, that you can post-stripe timecode onto them. For information on how to do this, see 
the documentation that came with your video deck.

To take advantage of all of Final Cut Pro’s features, particularly the Edit to Tape feature 
(described in Chapter 27, “Editing to Tape,” on page 1123), your video device must support 
auto-editing protocols. An auto-editing VTR can take timecode In and Out points, along with 
defined video and audio tracks for an insert edit, and perform an edit frame-accurately, 
regardless of the state of the controlling device or its software.

Device Protocols Supported by Final Cut Pro

The following is a list of all device control protocols you can use in Final Cut Pro. Not all 
protocols are compatible with all of Final Cut Pro’s features. See the documentation that 
came with your camcorder or deck for more information on the device control specification 
it uses, or visit the Final Cut Pro Web site at www.apple.com/finalcutpro

m Apple FireWire or Apple FireWire Basic

m Sony RS-422

m Sony RS-232:  (SVO-2100) 9.6K; (SVO-2100) 19.2K; (UVW-1400) 9.6K; (UVW-1400) 19.2K

m Sony VISCA

m Sony LANC (via Addenda RS-4/L)

m Panasonic RS-232 and RS-422

m JVC RS-232

Note:  The Panasonic RS-422 and Sony RS-422 protocols use serial cables that differ from 
Panasonic and Sony RS-232 cables. For more information on cables and their availability, see 
the information that came with your device. You can buy these cables at specialty video 
equipment or electronics retailers.

Important  Video decks capable of reading both LTC and VITC timecode usually have a 
switch that lets you select whether a deck outputs one or the other, or both. Leave this 
switch set to both. 
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Setting Up Your Hardware
To set up your hardware, you can simply connect your video camcorder or deck to your 
computer’s built-in FireWire port or approved third-party video card and do all your video 
and audio monitoring using your computer’s monitor and speakers.

It’s also useful to have an external NTSC or PAL monitor and speakers connected. This way, 
you can see what you’re working on at full broadcast resolution, with NTSC or PAL colors, as 
it will look to your viewer. Using external speakers lets you hear your audio with much more 
clarity as you mix your tracks together. 

The next sections describe how to connect your camcorder or deck with both a video 
monitor and external speakers.

Setting Up a DV System Using FireWire Device Control

With this setup, a DV device is connected to the FireWire port of your computer, letting you 
capture video and output your program to tape. For more information about FireWire 
technology, see “Using FireWire Device Control” on page 35.

FireWire
cable

DV camcorder
in VTR mode

Computer NTSC monitor

Composite
or S-Video

Audio
Amplified speakers

FireWire
FireWire
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The following are basic instructions for connecting DV equipment to your computer. 
For detailed information, see the documentation that came with your equipment and 
your computer.

To set up your DV system using FireWire device control:

1 With your DV camcorder or deck turned off, connect the 6-pin connector of the FireWire 
cable to the FireWire port on your computer.

2 Connect the 4-pin connector on the other end of the cable to the FireWire port on the 
camcorder or deck.

On some DV devices, the FireWire port may be labeled IEEE 1394 or i.LINK. Make sure you 
align the connector and port properly by matching the indentation on the connector to the 
indentation in the port. Do not force the two together.

3 Turn on your camcorder or deck.

4 If you are using a camcorder, switch it to VCR mode (sometimes labeled VTR).

For information on using Final Cut Pro to control your DV devices, see “Using Device 
Control” on page 226.

5 Connect the analog video output (S-Video or Composite) of your DV camcorder or deck to 
the appropriate input on your NTSC or PAL video monitor. 

Note:  If you’re using Composite, you may need a male BNC-to-female RCA video adapter.

6 Connect the analog audio output (stereo RCA) on your DV camcorder or deck to the audio 
input of your external speakers or amplifier. 

A recommended DV system using FireWire device control

m your computer and display

m a DV device, such as a DV camcorder or deck

m a 4-to-6-pin FireWire cable, available at an electronics store or an Apple-authorized 
retailer

m the analog audio and video cables that came with your DV device 

Note:  Some camcorders use a special cable to separate left and right audio and 
Composite video.

m an NTSC or PAL video monitor

m external speakers

For more information about some of this equipment, see “Additional Equipment to 
Consider” on page 22.
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Setting Up a DV System Using Serial Device Control

If you want to use seriaconverterl timecode and device control for completely frame-accurate 
timecode capture, you can connect a USB-to-serial adapter between your video device and 
your computer. You’d do this in the following situations:

m You’re using a DV-to-analog converter box to convert a tape format, such as Beta SP or 
Digital Betacam, to DV for video capture and output via FireWire, while you control your 
deck with RS-232 or RS-422.

m You’re using a high-end DV deck that has serial device control in addition to FireWire, for 
added frame accuracy when capturing and recapturing video.

FireWire cable

USB cable
RS-232 or
422 serial cable

Computer DV VTR

USB-to-serial
adapter

FireWire

USB

FireWire
Serial

A recommended DV system using serial device control

m your computer and display

m a DV device, such as a DV camcorder or deck

m a 4-to-6-pin FireWire cable, available at an electronics store or an Apple-authorized 
retailer

m the analog audio and video cables that came with your DV device 

Note:  Some camcorders use a special cable to separate left and right audio and 
Composite video.

m an NTSC or PAL video monitor

m external speakers

m a USB-to-serial adapter

m an RS-232 or RS-422 video deck control cable

For more information about some of this equipment, see “Additional Equipment to 
Consider” on page 22.
40 Chapter  2   



The following are basic instructions for connecting equipment to your computer. For 
detailed information, see the documentation that came with your equipment and your 
computer.

To set up your DV system using serial device control:

1 If you’re using a DV deck: 

a With your DV camcorder or deck turned off, connect the 6-pin connector on the FireWire 
cable to the FireWire port on your computer.

b Connect the 4-pin connector on the other end of the cable to the FireWire port on the 
camcorder or deck.

On some DV devices, the FireWire port may be labeled IEEE 1394 or i.LINK. Make sure 
you align the connector and port properly by matching the indentation on the connector 
to the indentation in the port. Do not force the two together. 

2 If you’re using an analog-to-DV converter box: 

a With your analog-to-DV converter box turned off, connect the 6-pin connector on the 
FireWire cable to the FireWire port on your computer.

b Connect the 4-pin connector on the other end of the cable to the FireWire port on your 
analog-to-DV converter. 

c Connect the analog audio and video connectors to the analog inputs and outputs on your 
device-controllable non-DV video deck. 

Usually you’ll use Composite or S-Video connectors.

3 Connect the USB connector on the USB-to-serial adapter to a USB port on your computer.

4 Connect the 8-pin connector of the video deck control cable to the USB-to-serial adapter, 
then connect the 9-pin connector on the other end of the cable to your device-controllable 
camcorder or deck.

5 Connect the analog video output (S-Video or Composite) of your DV camcorder or deck to 
the appropriate input on your NTSC or PAL video monitor. 

Note:  If you’re using Composite, you may need a male BNC-to-female RCA video adapter.

6 Connect the analog audio output (stereo RCA) on your DV camcorder or deck to the audio 
input of your powered speakers or amplifier. 

Important  For best results, always connect a USB-to-serial adapter directly to your 
computer, not to a USB hub connected to your computer.
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Setting Up an Analog-to-DV System

If you’re using analog equipment, such as Hi-8 or Beta SP decks and camcorders, or you want 
to capture using the analog output from a DV-format camcorder or deck, you can install an 
analog-to-digital capture card and import your video using M-JPEG, rather than DV. Cards 
using M-JPEG can capture video at data rates both lower and higher than the standard for DV, 
which is 3.6 MB/sec.

Unlike DV video devices using FireWire, analog-to-digital capture cards send and receive your 
video, audio, and device control on separate cables. Since device control on analog devices is 
done using a serial connector, you need an approved USB-to-serial adapter. For more 
information on serial device control, see “Using Serial Device Control” on page 36.

USB-to-serial
adapter

Computer

Analog
capture

card

Analog/digital VTR NTSC monitor

Video Video

Audio

USB Serial Audio Amplified speakers

A Recommended Analog-to-DV System

m your computer and display

m an analog video device, such as a camcorder or deck

m the analog audio and video cables that came with your analog device

Note:  Some camcorders use a special cable to separate left and right audio and 
Composite video.

m an analog-to-digital capture card installed in your computer

m a USB-to-serial adapter with the appropriate serial device control cable for your 
camcorder or deck

m an NTSC or PAL monitor

m external speakers

For more information about some of this equipment, see “Additional Equipment to 
Consider” on page 22.
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The following are basic instructions for connecting analog equipment to your computer. 
For detailed information, see the documentation that came with your equipment and 
your computer.

To set up your analog system:

1 Install an analog-to-digital capture card (qualified for use with Final Cut Pro) in your computer. 

For more information, see the documentation that came with the capture card and 
your computer.

2 If the capture card came with a breakout box, connect the breakout box to the capture card 
using the cables that came with them.

3 Connect one end of your video and audio cables to the output jacks on your camcorder, 
deck, or other video device.

4 Connect the other ends of these cables to the input ports on your capture card or breakout box.

5 If you’re using device control, connect the USB connector on the USB-to-serial adapter to a 
USB port on your computer.

6 Connect the 8-pin connector of the serial control cable to the USB-to-serial adapter, then 
connect the 9-pin connector on the other end of the cable to your device-controllable 
camcorder or deck.

7 To connect your analog video equipment to the capture card, do one of the following:

m Use the video input and output on your capture card, monitor, and deck.

To set up for output to tape:  Connect the analog video output (Component, S-Video, or 
Composite) on your analog deck or camcorder to the appropriate input on your NTSC or 
PAL monitor. If you’re using Composite, you may need a male BNC-to-female RCA video 
adapter. For more information on analog video signals and their connectors, see “Types of 
Video Signals” on page 26.

To set up your equipment for capture:  Connect the output of your analog deck or 
camcorder to the input of your capture card, then connect the output of the capture card 
to your NTSC or PAL monitor. This way of connecting your analog device and capture card 
is simple but inefficient because you have to disconnect and reconnect cables often. If 
you decide to set up your equipment this way, you may want to use a patch panel (see “A 
Patch Panel” on page 26).

Important  For best results, always connect a USB-to-serial adapter directly to your 
computer, not to a USB hub connected to your computer.
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m Use the multiple video input and outputs of your capture card, monitor, and deck.

For example, you can connect a cable from the capture card’s Composite output to the 
video monitor’s Input 1, and connect the higher-quality S-Video output to your analog 
deck’s input. Then connect your analog deck’s S-Video output to your capture card’s 
S-Video input and the analog deck’s Composite output to your video monitor’s Input 2. If 
your video monitor has multiple switchable inputs, this setup lets you switch between the 
computer’s video output and your deck’s video output by pushing a button. 

8 Connect your analog audio cables. 

You’ll do this much the same way as video, in one of the following ways:

m Use the audio input and output on your capture card, monitor, and deck.

Connect the analog audio output (usually stereo RCA) of your capture card to the audio 
inputs on your deck or camcorder. Then connect your deck or camcorder’s output to the 
audio input on your audio amplifier or powered speakers. You can then record and hear 
audio output from your computer, but you’ll have to reconnect the cables when you want 
to start capturing. 

You can also use a patch panel to easily switch from one configuration to another. For 
more information, see “A Patch Panel” on page 26.

m Use the multiple audio inputs and outputs of your capture card, monitor, and deck.

9 Turn on your camcorder or deck.

10 If you’re using a camcorder, switch it to VCR mode (sometimes labeled VTR). 

11 If you’re using Final Cut Pro to control your camcorder or deck, make sure that the device 
control switch on the equipment is set to Remote. 

For more information, see “Using Serial Device Control With Final Cut Pro” on page 34.
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C H A P T E R

3

3 Installing Software and Choosing 

Your Initial Setup
Before you install Final Cut Pro, connect and turn on your video equipment so Final Cut Pro 
can automatically detect your method of video capture. For more information, see Chapter 2, 
“Setting Up Your System.” You should also install the version of QuickTime included on the 
Final Cut Pro CD.

Installing QuickTime
Before you install Final Cut Pro, install the version of QuickTime included on the Final Cut 
Pro CD. QuickTime is a technology developed by Apple for handling video, sound, 
animation, graphics, text, music, and 360-degree QuickTime VR scenes. QuickTime is an 
industry standard for working with digital video and is required to capture, play back, and 
output video with Final Cut Pro.

To install QuickTime:

1 Insert the Final Cut Pro CD in your CD or DVD drive.

2 Double-click the CD’s icon, then double-click the QuickTime folder.

3 Double-click the QuickTime Installer icon and follow the onscreen instructions.

4 When the Choose Installation Type window appears, select Custom.

5 In the next window, click Select All, then click Continue. 

This replaces any previous version of QuickTime and ensures a complete installation of all 
components required by Final Cut Pro.

6 When a message appears saying installation was successful, click Restart.
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Unlocking QuickTime Pro
After you install QuickTime, you can register QuickTime Pro and “unlock” it to access its 
extended multimedia capabilities. The registration numbers for QuickTime Pro are on a 
sheet that came with the software titled Final Cut Pro and QuickTime Pro Registration 
Numbers. 

To register and unlock QuickTime Pro:

1 Choose Control Panels from the Apple (K) menu, then choose QuickTime™ Settings from 
the submenu.

2 Choose Registration from the pop-up menu at the top of the control panel.

3 Click Edit Registration.

4 In the “Registered to” field, type the following using uppercase and lowercase letters:

QuickTime Pro

5 In the Organization field, type your organization’s name.

6 In the Registration Number field, type the QuickTime Pro registration number from the sheet 
that came with your software titled Final Cut Pro and QuickTime Pro Registration Numbers.

7 Click OK, then close the QuickTime Settings control panel.

Then click here.

Choose Registration 
from the pop-up menu.

Enter the QuickTime registration 
number from the sheet that came 
with your software.

Enter your organization here.
46 Chapter  3  



If a message says the registration information is not valid, follow steps 4–7 again. When you 
enter the registration number, make sure you type a 0 for the numeral zero. Make sure you 
didn’t enter the Final Cut Pro registration number (which is also found on the Final Cut Pro 
and QuickTime Pro Registration Numbers sheet). That number cannot be used to unlock 
QuickTime Pro.

Installing Final Cut Pro
Installation places Final Cut Pro and its components on the hard disk you specify, typically 
your startup disk. Some additional software components may be installed, depending on the 
video capture interface you’re using. If you’re using a third-party video capture card and you 
haven’t already installed it in your computer and configured it, see Chapter 2, “Setting Up 
Your System.”

Recommendations for Good Performance

Follow these recommendations to help Final Cut Pro work smoothly on your system.
m Don’t use your computer as a server.

Using your system as a server can impede Final Cut Pro’s performance, causing dropped 
frames and other problems.

m Don’t use Final Cut Pro while connected to the Internet via modem.

m Turn off AppleTalk when capturing or outputting to tape.

Turn off AppleTalk when you’re using the Log and Capture window or when outputting 
your program to tape to prevent the possibility of dropped frames. For more information, 
see Mac Help.

m Limit your use of third-party extensions.

Some users prefer to install Final Cut Pro on a system that doesn’t have third-party 
extensions for anything other than video editing. However, depending on how your 
system is set up, you may need other extensions, such as drivers for USB-to-serial 
adapters, USB-to-ADB adapters, and printers and third-party video capture cards. 

Avoid installing extensions for increasing memory or performance, customizing your 
pointer, or modifying the behavior of your screen or desktop. If you need memory, buy 
and install more RAM. If you need faster performance, consider a faster computer. 

Important  If you have a QuickTime Pro registration number for QuickTime 4 or earlier, it 
won’t work for QuickTime 5. Use the registration number that came with this version of Final 
Cut Pro. 
 Installing Software and Choosing Your Initial Setup 47



If you must have some third-party extensions installed that may interfere with the smooth 
operation of Final Cut Pro, set up extension sets to use for various purposes. Use the 
Extensions Manager control panel to create a set of extensions for use with Final Cut Pro 
that excludes unnecessary third-party extensions. When you use Final Cut Pro, you can 
start up your computer with the appropriate set of extensions. For more information, see 
Mac Help.

Installing the Final Cut Pro Software

Follow these instructions to install Final Cut Pro.

To install Final Cut Pro:

1 Insert the Final Cut Pro CD into your CD or DVD drive.

2 Double-click the Install Final Cut Pro icon.

3 When the Installer window appears, click Continue.

4 Read the software license agreement, then click Accept.

5 Read the Before You Install document, then click Continue.

6 When the Install Final Cut Pro window appears, choose an installation option.

m Final Cut Pro:  Choose this if you are not using a Matrox real-time card.

Read this document for
system requirements
and other important

installation information.
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m Final Cut Pro with Matrox RTMac:  Choose this if you are using a Matrox real-time video 
card in your setup.

7 Choose an installation location from the pop-up menu at the bottom of the screen, then 
click Install.

8 When a message appears saying installation was successful, click Quit.

Allocating Memory for Final Cut Pro

To use Final Cut Pro, you must have a minimum of 192 MB of RAM installed in your 
computer; 256 MB or more is preferable. You should have 100 to 150 MB of RAM allocated to 
Final Cut Pro. A larger RAM allocation allows higher performance for long projects and those 
with numerous layers. 

Note:  Some third-party video capture cards may require more than 256 MB. Check the 
documentation that came with your card for more information.

Click the desired
installation option.

If desired, choose 
an installation location 
from this pop-up menu.
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To allocate more memory to Final Cut Pro, determine the amount of free memory on your 
computer, then allocate an appropriate amount.

To allocate memory to Final Cut Pro:

1 Quit all open applications.

2 Choose About This Computer from the Apple ( ) menu.

The number next to “Largest Unused Block” is the total amount of memory not used by 
other software and the most you can allocate to Final Cut Pro.

Note:  Don’t allocate all of your free memory to Final Cut Pro; you may want to use some for 
other applications. Instead, subtract 15 from the total available memory and use the result as 
your maximum memory allocation for Final Cut Pro.

3 Close the About This Computer window.

4 Click the Final Cut Pro application icon.

5 Choose Get Info from the File menu, then choose Memory from the submenu.

This is the amount of
available memory.
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6 Type a value in the Preferred Size box.

7 If you want, set the Minimum Size to the same value as the Preferred Size.

If both values are the same, Final Cut Pro will not open unless the preferred amount of 
memory is available. This way, Final Cut Pro always has a known amount of memory allocated 
to it, even when multiple applications are running.

Note:  If enough memory is not available, a warning message appears when you try to open 
Final Cut Pro. If this happens, quit other open applications or allocate less memory to Final 
Cut Pro for both the Minimum and Preferred Sizes. 

Now you can start Final Cut Pro for the first time. See the next section for information on 
choosing your initial setup.

This size should be
at least 100 MB

and preferably
closer to 150 MB.

If you want,
change this value.
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Choosing an Initial Setup
The first time you open Final Cut Pro, a Choose Setup window appears where you’re 
prompted to choose several items:  an Easy Setup, a primary scratch disk, and a user mode. 

m Easy Setup:  An Easy Setup is a collection of settings Final Cut Pro uses for controlling 
your video device, capturing media, editing, and exporting video. It includes presets, or 
groups of settings, for sequences, capture, device control, and external video that define 
how Final Cut Pro works with your particular video setup. 

m Primary Scratch Disk:  This is where the clips you capture in Final Cut Pro are saved. It’s 
also where render files are saved, which are files that Final Cut Pro generates when you 
use transitions and effects. 

m User Mode:  This sets the feature set you’ll use—Final Cut Pro’s full feature set, or the 
“Cutting Station,” an abbreviated set streamlined for simple editing.

Note:  If you reinstall Final Cut Pro, your settings are cleared and you need to choose an Easy 
Setup again.
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About Easy Setups

You choose an Easy Setup based on the system and media you’re using with Final Cut Pro and 
the type of project you’re working on. Final Cut Pro comes with Easy Setups for some of the 
most common video configurations, and you can create your own custom Easy Setups. 

For example, if you have an NTSC FireWire DV camera, choose the Easy Setup that includes 
those settings, DV-NTSC. This Easy Setup includes the following settings:

m Sequence preset:  DV NTSC 48 kHz 

m Capture preset:   DV NTSC 48 kHz Capture

m Device control preset:  FireWire NTSC

m External video:  Apple FireWire NTSC (720 x 480) for playback and print to video

The Easy Setup you choose becomes your default setup and all projects and sequences use 
its settings until you change it. You can change your Easy Setup or individual presets and 
settings at any time: however, you don’t need to change the Easy Setup unless you change 
your video hardware or source media. Changing your Easy Setup only affects new projects 
that you create. It doesn’t change the settings of a project that’s already created or that’s 
currently open. For detailed information on Easy Setups and presets, see Chapter 5, 
“Working With Easy Setups, Presets, and External Video Settings,” on page 99.

How Do Easy Setups Relate to Earlier Versions of Final Cut Pro?

If you’ve used an earlier version of Final Cut Pro, you’re familiar with the tabs of the 
Preferences window: General, Device Control, Capture, Sequence Presets, and Scratch 
Disks. The settings in three of these tabs (Device Control, Capture, and Sequence 
Presets), along with the External Video settings in the General tab are now 
consolidated in a single Easy Setup configuration. 

Instead of choosing several presets and external video settings using various tabs, you 
now choose them all in a single window, Easy Setup. This makes selecting and 
changing settings much easier.
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To choose your initial setup:

1 Double-click the Final Cut Pro icon to open the application.

2 Choose an Easy Setup from the Setup For pop-up menu.

The Easy Setup you choose should be based on the video interface, video hardware, or 
media you’re working with and the type of project you’re working on.

A summary of the selected Easy Setup appears below the menu. The summary includes 
information about the purpose of the Easy Setup, along with a list of the presets and external 
video settings the Easy Setup is based on.

For more information or to change your Easy Setup later, see “Working With Easy Setups” on 
page 101.

Choose an Easy Setup 
to use predefined 
sequence, capture, 
device control, and 
external video settings.

This shows the
presets and external
video settings for the
selected Easy Setup.

This provides a brief 
explanation of this setup.
54 Chapter  3  



3 Choose a primary scratch disk.

This is where you want to save your captured video, audio, render, and cache files. By default, 
Final Cut Pro uses the disk where the application is installed. 

Note:  It’s best to use a separate disk dedicated to video capture. For more information, see 
“Hard Disk Storage for Digital Media” on page 29.

Only connected external and internal disk drives are listed. If your hard disk doesn’t appear 
in the pop-up menu, make sure it’s properly connected to your computer, correctly 
initialized using drive-formatting software compatible with Final Cut Pro, and mounted. For 
more information, see the documentation that came with your computer, the hard disk, or 
your drive-formatting software.

Scratch disks are listed by the amount of available disk space, those with the largest amount 
listed first. To change or add scratch disks, see “Setting Up Scratch Disks for Storing Media” 
on page 899.

4 Choose a user mode to work in.

m Standard:  Provides access to all of Final Cut Pro’s features.

m Cutting Station:  Disables many of the advanced features of Final Cut Pro, such as 
keyframing and advanced effects, so you can use a streamlined tool for basic editing. This 
lets you focus on rough cutting and fine-tuning your edits. To change the user mode, see 
“Setting the User Mode” on page 892.

Choose the location where you want to 
store your media and render files.
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Installing the Tutorial Files
Final Cut Pro includes several tutorials to give you hands-on experience and help you learn 
how to use the program. There are five tutorials:  Acquiring Media, Basic Editing, 
Compositing and Effects, Working With Audio, and Distributing Your Final Output.

These tutorials are available in print as a separate book, Final Cut Pro 2 Tutorials. You can 
also use an onscreen version, available in the Help menu. Before you take the tutorials, you 
need to install the media files.

To copy the tutorial media files to your computer:

1 Insert the Final Cut Pro Tutorial CD in your CD or DVD drive.

2 If necessary, double-click the CD icon to open it.

3 Drag the appropriate tutorial folder, NTSC or PAL, from the CD to the desired location on 
your computer. 

For information on using the tutorials, see the Final Cut Pro 2 Tutorials book or choose 
Final Cut Pro Tutorials from the Help menu in Final Cut Pro.

Installing Bundled Third-Party Software
Additional third-party software is included on the Final Cut Pro CD. Installation instructions 
and onscreen documentation are included in the application folders. 

For additional information about third-party software, contact the software manufacturer or 
visit the manufacturer’s Web site.

Choose a folder 
based on the video 
format you’re using.

Important  Review any Read Me files or documentation before installing the software.
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4

4 Learning About the Interface

Read this chapter before you start the tutorials that came with Final Cut Pro. 

In Final Cut Pro, you do the most of your work in four windows: the Browser, the Viewer, the 
Canvas, and the Timeline. A floating Tool palette contains tools for selecting, navigating, 
performing edits, and manipulating items. A set of floating audio meters lets you monitor 
audio levels. There are also numerous menus, shortcuts, and controls. 

Before you begin working, you need to specify settings for your video setup. These include 
an Easy Setup that you choose the first time you open Final Cut Pro, along with a scratch disk 
for storing media and a user mode that determines which Final Cut Pro features will be 
available to you as you work. You may also want to select preferences before you begin.
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Easy Setups and Presets
The first time you open Final Cut Pro, you’re prompted to choose an Easy Setup, a scratch 
disk, and user mode. For more information, see Chapter 3, “Installing Software and Choosing 
Your Initial Setup.”

Easy Setup Window

Each Easy Setup consists of a set of presets that are summarized in the Easy Setup window. 
For detailed information, see Chapter 5, “Working With Easy Setups, Presets, and External 
Video Settings,” on page 99.

To access the Easy Setup window:

m Choose Easy Setup from the Edit menu.

m Press Control-Q.

This shows the
presets and external
video settings for the
selected Easy Setup.

This gives a brief 
explanation of the 
setup.
58 Chapter  4   



Audio/Video Settings Window

You can choose other presets or create a custom setup (if no existing setup is what you 
need) in the Summary tab of the Audio/Video Settings window. 

To access the Audio/Video Settings window:

m Choose Audio/Video Settings from the Edit menu.

m Press Command-Option-Q.

The pop-up menus
show the current

presets and external
video setting.

Click a tab to see
detailed information
about presets or to
customize presets.
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Preferences
You choose settings for how you work in Final Cut Pro in the Preferences window. This 
window includes tabs for each main group of settings: General, User Mode, Timeline 
Options, Labels, and Scratch Disks. 

To view and set preferences:

1 Do one of the following:

m Choose Preferences from the Edit menu.

m Press Option-Q.

2 Click the desired tab.

Click a tab to view and
set preferences for a
variety of settings in

Final Cut Pro.
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Setting Preferences Before You First Start Working

You may want to set or change some important preferences before you start working. These 
preferences are briefly described in the following sections. For more information, see also 
Chapter 19, “Viewing and Setting Preferences,” on page 883.

General

You may want to set the following general preferences before you start working in Final Cut Pro.

m Levels of Undo:  This specifies the number of actions that can be undone (up to 99). The 
default is 10. The more levels of undo you specify, the more memory is required.

m Automatic Save Every:  This saves your opened project in a backup file at regular 
intervals. Your original project file isn’t touched until you choose the Save command. 
When you do, the autosave backup file is discarded.

m Report dropped frames during playback:  With this option enabled, a message appears 
when frames are dropped during playback from the Viewer, Canvas, or Timeline. 

m Abort capture on dropped frames:  With this option enabled, a message appears when 
frames are dropped during capture and the capture process is stopped.

m Prompt for settings on New Sequence:  By default, this option is disabled and new 
sequences use the sequence settings specified in the current Easy Setup. If you enable this 
option, when you create a new sequence, a message asks you to choose a sequence preset.

m Preview Pre-roll and Post-roll:  Enter durations in these fields to specify the amount of a 
clip played when you use the Play Around Current control. Pre-roll specifies the amount 
of material played before the position of the playhead; post-roll specifies the amount of 
material played after the playhead. These amounts are used for all clips on disk.
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Timeline Options

You may want to set the following options for viewing items in the Timeline before you start 
working in Final Cut Pro.

m Starting Timecode:  This sets the starting timecode number in the Timeline for new 
sequences. You can change this number later in the Sequence Settings window. 

m Drop Frame:  Check this box to display drop frame timecode in the Timeline (this is only 
applicable to NTSC format). For more information on drop and non-drop frame 
timecode, see “About Drop Frame and Non-Drop Frame Timecode” on page 91.

m Track Size:  Choose a track size to set the initial vertical height of tracks in the Timeline 
for new sequences.

m Default Number of Tracks:  Enter the number of video and audio tracks you want created 
in new sequences.

m Show Audio Waveforms:  Check this box to display audio as audio waveforms rather than 
plain media bars in the Timeline.

Audio waveform

Plain media bar
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Labels

You can assign colored labels to clips and media to help distinguish and sort them in 
the Browser. 

Scratch Disks

This tab lets you specify up to five scratch disks for storing files. It’s best to set these after 
you set up your hardware but before you start to work in Final Cut Pro.

When you capture or render clips, files are saved to the first disk in the list. When that disk is 
full, Final Cut Pro goes to the next disk in the list until it’s full, and so on. 

Click a label, then type 
a new name for it.
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About the Editing and Project Windows
There are four main windows in Final Cut Pro: the Browser, Viewer, Canvas, and Timeline. 
Tabs organize sets of commands or represent open sequences. Click a tab to use its functions 
and controls or to bring a sequence forward to work in it. 

The Standard window arrangement in Final Cut Pro displays the windows as shown. You can 
choose a different window arrangement with the Arrange command in the Window menu. 
For more information, see “Changing the Layout of Windows” on page 94.

To make a window active so you can work in it:

m Click the window.

m Choose the desired window from the Window menu. 

m Use a keyboard shortcut to select it. 

Important  The Canvas and Timeline are only displayed for open sequences. If your project 
doesn’t contain any sequences or none of your sequences are open, the Canvas and Timeline 
do not appear.

CanvasViewer

Browser

Timeline

Audio meters

Tool palette
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For more information, see Appendix B, “Keyboard Shortcuts,” on page 1297.

Browser

The Browser is the central storage area where you organize all of the source material you’ll 
use in your project. The Browser lists all files—video and audio clips, sequences, and 
markers—in a project. Each project is represented by a tab that contains that project’s files. 
You can organize your media clips in bins, or folders, within a project. You can have multiple 
projects open.

To open (and close) the Browser:

m Choose Browser from the Window menu.

m Press Command-4.

The Browser is not a collection of files, but a collection of references to files. The actual 
media files exist on your hard disk. Final Cut Pro is a nondestructive editing application; 
when you modify clips, the original source material stored on your disk is not affected.

Press one of these key 
combinations to make a 
specific window active.

Audio and video clips

Sequence

Tabs represent
open projects.

Bin for organizing clips
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You can display up to 45 columns of information for items in the Browser, such as notes, clip 
duration, type of audio, and In and Out points. You can also show and hide columns and 
view items by list or by large or small icons (no columns appear in icon views). 

You can open clips and sequences from the Browser. Double-click a clip to open it in the 
Viewer. Double-click a sequence to open it in the Timeline. For detailed information about 
the Browser, see Chapter 7, “Using the Browser and Managing Projects and Clips,” on 
page 161.

The Browser also contains the Effects tab, which provides drag-and-drop access to Final Cut 
Pro’s video and audio effects, filters, and generators. For information on using the Effects tab, 
see Chapter 22, “Working With Video Filters, Generators, and Speed Settings,” on page 1023.

Drag the scroll box to 
view additional columns.

The Name column
is always shown. Click the arrow in a 

column heading to 
sort information.

The Effects tab 
stores all effects, 
filters, and generators.You can put frequently

used effects in the
Favorites bin.

These are some of
the effects you can

use in your projects.
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Viewer

The Viewer acts as your source monitor. Use the Viewer to watch individual source clips 
and mark In and Out points in preparation for editing them into your sequence.You can 
also customize transitions, modify filters, and view and edit various effects. Clips from the 
current sequence in the Timeline can be opened in the Viewer to refine edits, effects, and 
audio volume. 

To open (and close) the Viewer:

m Choose Viewer from the Window menu.

m Press Command-1.

There are several controls in the Viewer for playing, jogging, and shuttling through your clip. 
Most of these controls are found in other windows as well. There are also controls for setting 
In and Out points, zooming, displaying title and action safe boundaries, and opening 
generators to create graphics such as color mattes, text, and gradients. For information about 
some of the basic controls, see “Using Playback and Editing Controls in the Viewer and 
Canvas” on page 88.

Tabs provide access to
different functions and

controls.

Transport controls

Shuttle control Jog control

Editing and 
marking controls
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The tabs at the top of the Viewer provide certain functions and controls for clips.

m Video tab:  (Shown above.) Click this to view video frames and locate and mark your edit 
points (In and Out points).

m Audio tab:  Click this to view the waveforms of your audio channels and change volume 
levels and stereo pan (or spread) settings. You can also set In and Out points, markers, 
and keyframes for mixing levels of your audio clips. Clips with stereo audio have two tabs, 
one for the left channel and one for the right. 

These controls are
the same as those

in the Video tab.

You can modify settings
using these controls.

Audio waveform
for an audio clip
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m Filters tab:  Click this to change settings for video and audio filters applied to a clip. You 
can animate filter parameters by setting keyframes over time. They appear in graph view 
on the right.

m Motion tab:  Click this tab to apply and modify motion effects to a clip, such as scaling, 
cropping, and rotating. You can animate motion effects by setting keyframes over time. 
They appear in graph view on the right.

The type of filter
applied to the clip

The settings for a
particular filter

Use the keyframe 
buttons to set 
keyframes and 
change the filter’s 
settings over time.

Motion settings
you can specify

Use the keyframe 
buttons to set 
keyframes and 
change motion 
settings over time.
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m Controls tab:  The Controls tab appears only if you’ve added a generator. Click it to 
change the generator’s parameters and customize output. For more information on using 
generators, see Chapter 22, “Working With Video Filters, Generators, and Speed Settings,” 
on page 1023.

For detailed information about the Viewer, see Chapter 12, “Working With Clips and the 
Viewer,” on page 327.

Parameters you can
specify for a generator
effect, such as a title.
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Canvas

The Canvas is the equivalent of a record monitor and shows what your edited sequence 
looks like when it is played. The Canvas looks similar to the Viewer and has many of the same 
transport, editing, and marking controls.

To open (and close) the Canvas:

m Choose Canvas from the Window menu.

m Press Command-2.

You can perform seven types of edits in the Canvas: insert, overwrite, replace, fit to fill, 
superimpose, insert with transition, and overwrite with transition. 

There are two ways to edit in the Canvas:

m Drag a clip from the Browser or Viewer to a section of the Edit Overlay.

Each open sequence
has its own tab.

The Canvas is where
you edit clips together
and play them to see
what your sequence

will look like.

Transport
controls

Editing and 
marking controls

Jog control Shuttle control
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Note:  The Edit Overlay only appears when you drag an item to the Canvas.

m Select a clip in the Browser or open a clip in the Viewer, then click an edit button.

For detailed information about the Canvas, see Chapter 13, “Working With Sequences, the 
Timeline, and the Canvas,” on page 403.

Edit Overlay

Edit buttons

Drag a clip from the
Browser or Viewer to

the desired section
of the Edit Overlay.

Click this button to see the 
four additional edit buttons.

The edit buttons
correspond to

the areas of the
Edit Overlay.
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Timeline

The Timeline displays a chronological view of an open sequence. Each sequence has its own 
tab in the Timeline. You can have multiple sequences open. 

To open (and close) the Timeline:

m Choose Timeline from the Window menu.

m Press Command-3.

Video tracks are displayed in descending order, with track V1 as the bottom layer. When you 
edit clips to the tracks above, they obscure clips in the lower tracks. The order of the tracks 
in the Timeline determines layering order when you composite multiple tracks of video. A 
sequence can have up to 99 video and 99 audio tracks. 

Each track has visibility and lock controls. There are Target Track controls to specify the 
audio and video tracks to which clips are edited. There are also controls for track height, the 
scale of the Timeline, and navigating from one end of the Timeline to the other. A render bar 
appears at the top of the Timeline to indicate if any transitions or effects in your sequence 
need to be rendered before playback.

The Timeline and the Canvas windows work together. When you play back your sequence in 
the Timeline, your program plays in the Canvas. Changes you make to a sequence in the 
Timeline are seen when you play back that sequence in the Canvas. If you modify clips in the 
Canvas, the changes are stored with the clips in the Timeline.

For detailed information on the Timeline, see Chapter 13, “Working With Sequences, the 
Timeline, and the Canvas,” on page 403.

Audio tracks

Video tracks

Tab representing an
open sequence

Move the slider to navigate 
through your sequence.

Track Height 
control
  Learning About the Interface 73



Tool Palette

The Tool palette contains tools for editing, zooming, cropping, and distorting items in 
the Timeline. 

To view the Tool palette:

m Choose Tools from the Window menu.

To select a tool:

1 Click a tool in the Tool palette. 

2 Choose the tool you want from the pop-up menu. 

For detailed information on various tools, see Chapter 12, “Working With Clips and the 
Viewer,” on page 327 and Chapter 13, “Working With Sequences, the Timeline, and the 
Canvas,” on page 403. 

Track Selection tools

Edit, Group, and 
Range Selection tools

Slip Item and
Slide Item tools

Zoom In, Zoom
Out, Hand, and

Scrub Video tools

Selection tool

Pen, Pen Delete, and
Pen Smooth tools

Press and hold to
choose additional tools.

Roll Edit and 
Ripple Edit tools

Razor Blade tools

Crop and Distort tools
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Audio Meters

The audio meters let you monitor audio output levels from your computer. Use them for 
editing, logging media, and outputting your program. For more information, see Chapter 17, 
“Working With Audio,” on page 727.

To open (and close) the audio meters:

m Choose Audio Meters from the Window menu.

m Press Option-4.

Trim Edit Window

When you fine-tune the edit point between two clips in the Timeline, you’re trimming an 
edit. You can trim your edits using the Ripple, Roll, Slide, and Slip tools or keyboard 
shortcuts. These tools and shortcuts can also be used in the Viewer, Timeline, and Trim Edit 
window. 

The Trim Edit window displays both sides of your edit: the Out point of the outgoing clip on 
the left and the In point of the incoming clip on the right. In this window you can refine your 
edits very precisely, frame by frame. 

The boxes show the top level 
for each audio channel.

When you play audio, the 
meter moves up and down 
to show the decibel level.
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For more information on using the Trim Edit window, see Chapter 16, “Advanced Editing 
and Trimming Techniques,” on page 653.

Outgoing clip Incoming clip
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Acquiring and Distributing Media
You use the Log and Capture window and the Import command to bring media into Final Cut 
Pro. Once you’ve edited material together, you can export it in various ways: printing to 
videotape, editing directly to tape, or exporting sequences or clips in several formats.

Log and Capture

You use the Log and Capture window to log clips, or enter information about them, from 
source tapes. You then capture these clips to the designated scratch disk so you can edit 
them in Final Cut Pro. 

To open the Log and Capture window:

m Choose Log and Capture from the File menu.

Transport controls 
and status of your 
video equipment

The Preview area lets
you determine what
footage you want to

log and capture.

Use this area to 
specify settings and 
log and capture clips.
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How you log and capture media in Final Cut Pro depends on whether your equipment has 
device control, meaning that you can use Final Cut Pro to control your video equipment. 
Check the documentation that came with your equipment. 

m If your video equipment has device control:  You can use Final Cut Pro’s transport 
controls or keyboard shortcuts to play, fast-forward, and rewind the deck as you view the 
tape. This lets you log all the clips you want to capture, then capture them all at once with 
a batch capture. This type of equipment gives you more control of your captured material.

m If your video equipment doesn’t have device control:  Use the controls on your 
camcorder or deck to play the tape, then click the Capture Now button to capture clips as 
you view them. You can also use this button to capture live video.

For more information about logging and capturing media, see Chapter 8, “Logging and 
Capturing Media.”
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Print to Video Window

The Print to Video command in the File menu allows you to output clips or sequences to 
videotape quickly. You can add elements on the tape such as color bars and tone, a 
countdown, a slate, and a black trailer. You can also loop your footage if you want to output 
your program multiple times on the same tape. Your video equipment does not need device 
control to use this function. For more information, see Chapter 26, “Recording to Videotape,” 
on page 1113.

To open the Print to Video window:

m Choose Print to Video from the File menu.

m Press Command-M.

This section specifies 
the time needed for 
elements you add.

To add a trailer, 
click the checkbox 
and specify a duration.

Add elements to your
sequence or clips.

Use these settings to
loop your program.
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Edit to Tape Window

If your video equipment supports device control, you can edit directly to videotape using the 
Edit to Tape window. This window works like the Canvas, but clips are edited to tape instead 
of to the Timeline. The source media is Final Cut Pro’s output and the edits on your 
videotape become your final product. 

You can put together several sequences as one long program and edit a clip or sequence to 
tape using In and Out points. The editing functions available depend on the capabilities of 
your video equipment. For more information, see Chapter 27, “Editing to Tape,” on 
page 1123.

To open the Edit to Tape window:

m Choose Edit to Tape from the Tools menu.

These controls are
similar to those in

the Canvas.

The Edit to Tape window has an 
Edit Overlay that lets you do two 
types of edits and preview your 
edit.

Click a tab to add
elements to your

program and specify
device control.
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Managing Your Media and Render Files
The Browser, Media Manager, and Render Manager help you manage your media and files. 
The Browser, described earlier, is where you organize and store your source media and the 
sequences you create. For detailed information, see Chapter 7, “Using the Browser and 
Managing Projects and Clips,” on page 161.

Media Manager

The Media Manager lets you manage media files in Final Cut Pro without using the Finder. 
Use the Media Manager to move and archive clips, sequences, and projects, along with their 
associated media and render files, without breaking any links. 

To open the Media Manager:

m Choose Media Manager from the Sequence menu. 

Note:  This window is only available when a sequence is open in the Canvas or Timeline.

Important  The functions you use in the Media Manager can permanently alter source 
media on your hard disks. 

This section provides 
a summary of the 
options you select.

Choose options for
copying, moving, and

deleting items or
making them offline.

Click here to set the 
folder where you want 
to move or copy files.
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Render Manager

You can use the Render Manager to delete unwanted render files to free disk space. 
Whenever you add effects or filters to a clip, Final Cut Pro must render the clip to display the 
effect correctly. Render files are created each time a clip is rendered. For more information, 
see Chapter 23, “Rendering,” on page 1065.

Final Cut Pro takes care of most render file “housekeeping” tasks, but you may want to 
occasionally delete some or all of your render files yourself using the Render Manager. The 
Render Manager displays files from unopened projects as well as open projects. 

To open the Render Manager:

m Choose Render Manager from the Tools menu.

For more information, see “Deleting Render Files With the Render Manager” on page 880.

Click in this 
column for 
render files you 
want to delete.
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Using Menus, Shortcuts, and Controls
Final Cut Pro offers several methods for performing video-editing tasks. Some people work 
fastest using keyboard shortcuts; others prefer to use their mouse to access the menu bar or 
shortcut menus. Experiment to find out which method best suits your editing style. 

Menu commands and keyboard shortcuts apply to the active window. Click a window or use 
keyboard shortcuts to make it active.

Using Keyboard Shortcuts

Keyboard shortcuts let you perform actions on your computer using the keyboard instead of 
pointing and clicking. These shortcuts can help you work more efficiently. 

Keyboard shortcuts for tasks are presented throughout this manual and in the onscreen help. 
They are also shown in menu commands and tooltips; for more information, see “Showing 
Descriptions of Interface Elements (Tooltips)” on page 85. For a complete list, see 
Appendix B, “Keyboard Shortcuts.”
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Viewing and Using Shortcut Menus

Shortcut menus (also called contextual menus) are available in nearly every section of every 
window and offer a quick way to perform various tasks. The commands in a shortcut menu 
depend on the location of the pointer in the selected window. For example, the shortcut 
menu for a column heading in the Browser shows different options from the menu for an 
item within the column.

A shortcut menu
for the selected clip

Shortcut menu in the 
Browser when no item 
is selected
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To view and use a shortcut menu:

1 Press the Control key and click an item.

2 In the shortcut menu that appears, choose the command you want, then release the Control 
key and mouse button.

Showing Descriptions of Interface Elements (Tooltips)

When you move the pointer over a control in Final Cut Pro, a small box called a tooltip 
appears with a description of the control. Next to the description is the keyboard shortcut for 
using the control. You can turn tooltips off and on in the General tab of the Preferences 
window. For more information, see Chapter 19, “Viewing and Setting Preferences,” on 
page 883.

Choose an option from the 
shortcut menu, then release 
the mouse button.

This tooltip appears when the 
pointer is over the Play button 
in the Canvas.
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Working With Tabbed Windows

The Viewer and Browser contain tabs that let you access different functions. Tabs in the 
Timeline and Canvas represent open sequences. You can drag tabs out of their main, or 
parent, window so they appear in a separate window. This is useful when you are working on 
more than one sequence or project at a time. 

To make a tab appear in its own window:

m Drag the tab out of its parent window (Browser, Viewer, Canvas, or Timeline).

The Browser
contains tabs

for open projects
and effects.

Like the 
Canvas, the 
Timeline 
contains tabs 
for each open 
sequence.

The Viewer contains
tabs that specify

functions within clips.

The Canvas 
contains tabs 
for each open 
sequence.

The Effects tab is dragged 
out of the Browser and 
appears in its own window.
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To put a tab back in its original window:

m Drag the tab to the title bar of its parent window.

Drag the tab back
to the title bar of the
main window to put

the tab back in its
original window.
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Using Playback and Editing Controls in the Viewer and Canvas

Transport (or playback) controls

Transport controls let you play clips and sequences in the Viewer and the Canvas, as well as 
move the playhead in the Timeline. (The same controls also appear in the Log and Capture 
and Edit to Tape windows.) These controls play clips and sequences at 100 percent (or 1x) 
speed. There are keyboard shortcuts for each control.

Control Function Keyboard shortcut

Previous 
Edit

Moves the playhead backward from its current 
position to a preceding edit in the Canvas or to a 
preceding edit point (start, In, or Out) of a clip in the 
Viewer. 

Use this control to navigate quickly in a sequence of 
edits.

Up Arrow

Play In to 
Out

Moves the playhead to the current In point of a clip 
and plays forward from that point to the Out point. 

Use this control to play the clip you’re editing from 
beginning to end. 

Shift-\ (backslash)

Play Plays your clip or sequence from the current location 
of the playhead to the end, regardless of the Out 
point. Clicking it again stops playback.

Space bar

Play 
Around 
Current

Plays the selected clip or sequence from before the 
current playhead position (based on a pre-roll 
setting) to the amount of time specified by the post-
roll setting (you specify these settings in the General 
tab of the Preferences window). 

Use this control to get a quick view of material at the 
current position of the playhead.

\ (backslash)

Next Edit Moves the playhead forward from its current position 
to the next edit in the Canvas or to the next edit 
point (In, Out, or end) of a clip in the Viewer. 

Down Arrow

Next Edit

Play Around CurrentPlay In to Out Play

Previous Edit
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Playhead, clip and sequence controls

These three controls are used to navigate and play through clips and sequences at speeds 
other than 100 percent (or 1x) playback speed. The shuttle and jog controls are on opposite 
sides in the Viewer (shown below) and Canvas.

Control Function Keyboard shortcut

Shuttle 
control

Drag the slider to the right to fast-forward and to the 
left to rewind. Playback speed depends on the 
distance of the slider from the center. When the 
slider is green, playback speed is normal, or 
100 percent. 

Use this to play clips and sequences at different 
speeds in fast and slow motion. It also shifts the pitch 
of audio as you play at varying speeds. 

J (Reverse)
K (Stop)
L (Forward)

Press J or L up to four 
times to increase or 
decrease speed.

Jog control Use this control in the Viewer and Canvas to move 
forward or backward precisely. 

Use this to locate a specific frame, such as when 
you’re trimming an edit. 

Press the Left and Right 
Arrow keys to move one 
frame at a time.

Press Shift–Left Arrow and 
Shift–Right Arrow to move 
one second at a time.

Playhead 
and 
scrubber 
bar

The scrubber bar covers the entire width of the 
Viewer and Canvas below the video image. To scrub 
(or move though) a clip, drag the playhead in the 
scrubber bar. Click anywhere in the scrubber bar to 
move the playhead to a different location. 

Use this to quickly navigate a clip or sequence. 

Press the Left and Right 
Arrow keys to move one 
frame at a time.

Press Shift–Left Arrow and 
Shift–Right Arrow to move 
one second at a time.

Playhead

Shuttle control
Scrubber bar

Jog control
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Marking controls

These controls let you set markers, In and Out points, and keyframes and match audio and 
video for clips and sequences.

Control Function
Keyboard 
shortcut

Match Frame Click to match the currently displayed frame of a clip in the 
Canvas with the same frame in the original source clip in the 
Viewer. This is useful to synchronize audio and video or 
locate exact frames.

F

Mark Clip Click to use the current boundaries of a clip to set In and Out 
points.

X

Add 
Keyframe

Click to add a keyframe to the current clip at the position of 
the playhead. A keyframe is a special-purpose marker that 
denotes a change in value of an applied effect, such as 
motion or audio level.

Control-K

Add Marker Click to add a marker at the current position of the playhead. 
This lets you bookmark a location in your clip or sequence as 
you edit, such as potential In or Out points, edit points, or 
where you may want to apply effects.

M

Mark In Click to set the In point at the current position of the 
playhead. 

For clips, this defines the first frame you edit into your 
sequence.

I

Press Shift-I to 
move the 
playhead to the 
next In point.

Mark Out Click to set the Out point at the current position of the 
playhead. 

For clips, this defines the last frame you edit into your 
sequence.

O

Press Shift-O to 
move the 
playhead to the 
next Out point.

Mark Clip

Mark OutMatch Frame

Mark In

Add
Keyframe

Add 
Marker
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About Timecode
Timecode is a signal recorded with your video that uniquely identifies every frame of your 
tape using a time stamp in hours, minutes, seconds, and frames. Timecode always uses the 
following format: 

About Drop Frame and Non-Drop Frame Timecode

There are two types of timecode: non-drop frame and drop frame. Non-drop frame timecode 
is simple: for every frame of video, there is a corresponding timecode number. Twenty-five 
frames per second (fps) PAL video uses non-drop frame timecode exclusively.

Drop frame timecode (used with NTSC video) compensates for the fact that the NTSC format 
has a frame rate of 29.97 fps, which is .03 fps slower than the nearest whole number frame rate 
of 30 fps. Timecode can only be represented by whole numbers, so timecode numbers are 
periodically skipped in drop frame timecode. This way, the timecode number listed matches the 
seconds and minutes of video that have played. NTSC can be represented by either drop frame 
or non-drop frame timecode.

To determine the type of timecode:

m Non-drop frame has a colon (:) between the seconds and frames fields.

01:22:45:26

m Drop frame has a semicolon (;) between the seconds and frames fields.

01:22:45;26

Hours     Minutes     Seconds     Frames

SMPTE timecode

01:32:15:28

Important  No video frames are dropped when you use drop frame timecode. Only the 
associated timecode numbers are skipped. 
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You set the type of timecode used for a sequence using the Drop Frame checkbox in the 
Timeline Options tab in the Sequence Settings window.

Entering Timecode

When you enter timecode in a field, such as the Current Timecode field, you don’t need to 
enter all of the colons or semicolon. Final Cut Pro automatically adds them for you after each 
set of two digits.

For example:  If you enter 01221419, Final Cut Pro interprets it as 01:22:14:19.
This stands for 1 hour, 22 minutes, 14 seconds, and 19 frames.

If you enter a partial number, Final Cut Pro formats it with the rightmost pair of numbers as 
frames and puts each successive pair of numbers to the left in the remaining seconds, 
minutes, and hours areas. Numbers you omit default to 00. 

For example:  If you enter 1419, Final Cut Pro interprets it as 00:00:14:19.

Each hour, minute, second, or frame number must contain two digits. Therefore, you must 
add a leading zero to single numbers.

For example:  You must enter 03 to represent frame 3.

Make sure this box has an X in it 
to use drop frame timecode.

How Drop Frame Timecode Works

When you use drop frame timecode, frames 0 and 1 are skipped the first second of 
every minute, unless the minute number is exactly divisible by 10. The dropped 
numbers do not appear in Final Cut Pro’s timecode fields because they’ve been 
dropped and are not on your tape.

If you’re entering timecode to navigate and inadvertently type a dropped timecode, 
Final Cut Pro automatically moves forward to the next available timecode.
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Timecode Navigation and Shortcuts

There are several ways to enter and navigate using timecode. You can move the 
playhead to a specific frame by entering a complete timecode number in the Current 
Timecode field in the Canvas or Viewer, then press Return or Enter. You don’t need to 
click in the field to enter a new timecode; simply enter the timecode.

To avoid typing zeroes when moving by larger amounts, type a period instead.

m To move to timecode 00:00:03:00, type “3.” (3 and a period). The period is 
automatically interpreted by Final Cut Pro as 00 in the frames field.

m To move to 00:03:00:00 from the previous position, type “3..” (3 and two periods). 
These periods insert 00 into both the frames and seconds fields.

m Type 3... to move to 03:00:00:00.

Instead of moving the playhead to an absolute timecode number, you can move it 
relative to its current position by pressing the + and – keys.

m To move the playhead 15 frames forward from the current position, type “+15”.

m To move the playhead 1 minute and 20 frames back from the current position, type 
“–01.20” (the period automatically adds 00 to the seconds field).

For detailed information, see “Using Timecode in the Viewer” on page 355.
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Timecode Fields

The Viewer and Canvas have two timecode fields:

m Timecode Duration:  Specifies the time between In and Out points for a clip or sequence. 
If no points are marked, the entire duration of the clip is displayed.

m Current Timecode:  Represents the current position of the playhead. If you set an In or 
Out point, that timecode number is used.

The Browser has a corresponding Duration column for clips and sequences so you can 
quickly see how long a clip or sequence is.

Changing the Layout of Windows
Screen layouts determine the size and location of the four main windows in Final Cut Pro (the 
Browser, Viewer, Canvas, and Timeline). Final Cut Pro comes with a predefined set of layouts. 
Choose a layout that maximizes your screen real estate in the best way for your source 
material, editing function, screen resolution, and monitor type. 

For example, if you’re compositing, you can choose the Compositing layout. The Timeline is 
expanded in this layout so you can easily see multiple layers. To compensate, the Canvas is 
smaller, since the focus is on building layers, not viewing your final output.

If none of the existing layouts meets your needs, you can create up to two of your own and 
save them for future use. 

Note:  All screen layouts arrange the size of windows based on the selected screen 
resolution of your monitor.

Timecode fields
in the Viewer

Timecode Duration field Current Timecode field

The Duration column in the 
Browser shows the length of 
a clip or sequence.
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To choose a screen layout:

m Choose Arrange from the Window menu, then choose an option from the submenu.

To customize the screen layout:

1 Arrange the four main windows, Tool palette, and audio meters as you want them.

Choose the desired 
screen layout.

Arrange the four
windows, Tool palette,

and audio meters where
you want them.
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2 Hold down the Option key and choose Arrange from the Window menu, then choose one of 
the Set Custom Layout options.

3 The next time you open Final Cut Pro, you can choose the custom layout you created from 
the Arrange submenu of the Window menu.

Choose a custom 
layout menu item.

The custom layout you 
created is available.
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Undoing and Redoing Changes
You can undo changes you make in your projects, sequences, and clips. This is helpful if you 
make a change you don’t like and want to revert to an earlier version. You can also redo 
actions that you have undone. 

By default, you can undo 10 of your previous changes. You can set this to undo up to 99 
changes. The more levels of undo you select, the more memory is needed to save all of your 
changes. For more information on modifying the number of changes to undo, see “Setting 
General Preferences” on page 885.

To undo a change:

m Press Command-Z or choose Undo from the Edit menu.

To redo a change:

m Press Command-Y or choose Redo from the Edit menu.

When you use the Undo or Redo command, Final Cut Pro makes the window where the last 
or next action occurred the active window. 

For example, let’s say you delete a clip from the Browser, then select a clip in the Timeline 
and duplicate the clip there. Choosing Undo once eliminates the duplicate clip you created 
in the Timeline, which is still the active window. Choosing Undo a second time undeletes the 
clip you deleted in the Browser and makes the Browser the active window.
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C H A P T E R

5

5 Working With Easy Setups, Presets, 

and External Video Settings
In Final Cut Pro, there are numerous settings for capturing and editing media and controlling 
your video equipment. 

m A setting adjusts a specific feature of Final Cut Pro—for example, the frame rate of 
a sequence.

m A preset is a predefined group of settings that configure a particular function in Final Cut 
Pro. There are three types of presets:  sequence presets, capture presets, and device 
control presets. For example, a device control preset consists of approximately ten 
settings for controlling your video equipment. When you select a device control preset, 
all ten settings are automatically selected.

Note:  Final Cut Pro also has external video settings, but these are not considered 
a preset.

m An Easy Setup is a group that includes all three presets mentioned above, plus the 
external video settings. When you choose an Easy Setup, Final Cut Pro automatically 
specifies these four items so you don’t have to select them individually.
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An Easy Setup contains a group of presets and an external video setting, and each preset 
contains a group of settings. To change a preset, you change the settings in that preset. To 
change your Easy Setup, you change the presets or external video settings in the Easy Setup.

Settings, presets, and Easy Setups may seem complicated, but they aren’t. In fact, Easy Setups 
make your job easier by determining and specifying settings for you. Choose an Easy Setup 
when you first open Final Cut Pro, and you’re ready to get to work. You don’t need to change 
your Easy Setup unless you change your media (type or format) or video equipment.

Note:  In earlier versions of Final Cut Pro, you had to configure the three presets and 
external video settings in separate windows. In this version, all the settings are consolidated 
in one Easy Setup. 

Easy Setup

Sequence
preset

Frame size
Time base
Field dominance
Aspect ratio

Capture
preset

Codec
Frame rate
Frame size
Sample rate

Device Control
preset

Protocol
Time source
Frame rate
Pre-roll
Post-roll
Offset

External
video

View during
playback device
View during
recording device

What About Preferences? 

Preferences are settings that determine how you work with media in Final Cut Pro. 
Preferences include specialized settings like Timeline options and scratch disks (where 
you store media), as well as general settings, such as the number of actions you can 
undo, automatic saving, and the duration of still images. For more information, see 
Chapter 19, “Viewing and Setting Preferences,” on page 883.
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Working With Easy Setups
Final Cut Pro comes with several predefined Easy Setups based on the most commonly used 
settings, such as DV-NTSC and DV-PAL. The Easy Setup you choose applies to all new 
projects and sequences until you choose another Easy Setup or change any of the presets or 
external video settings in your current Easy Setup. 

If you make changes to your Easy Setup, such as choosing a different sequence preset, it 
doesn’t change the settings of currently opened projects or sequences. If you create new 
sequences and projects, they use the modified Easy Setup. 

If you always use the same type of media and equipment, you may never have to change 
your Easy Setup. If you do change your media or equipment, it’s simple to change your 
Easy Setup.

Selecting Your Initial Easy Setup

The first time you open Final Cut Pro after installing the software, you’re prompted to 
choose an Easy Setup, as well as a scratch disk (where you’ll store your media and render 
files) and user mode (which defines the features available to you). For more information, see 
“Choosing an Initial Setup” on page 52.

Choosing a Different Easy Setup

You can choose a different Easy Setup at any time. Typically, you won’t have to unless 
you change 

m the type of project you’re working on

m the kind of media you’re using in your projects and sequences

m the video hardware in your computer setup

For example, if you use DV NTSC media and equipment, you’d choose DV-NTSC as your Easy 
Setup. This adjusts your sequence, capture, and device control presets and external video 
settings to capture and output DV media with NTSC equipment. If you started working on a 
different project with QuickTime files compressed using Photo JPEG, you’d change your Easy 
Setup to Photo JPEG-NTSC, and your presets and external video settings would then be 
adjusted for Photo JPEG media.

To change your Easy Setup:

1 Choose Easy Setup from the Edit menu.
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2 Choose an Easy Setup from the Setup For pop-up menu.

A summary of your selected Easy Setup appears below the pop-up menu.

3 When you’re ready, click Setup.

The selected Easy Setup applies to all new projects and sequences. Settings for existing 
sequences do not change.

Removing or Deleting an Easy Setup

Easy Setups that come with Final Cut Pro are located in a specific folder on your hard disk: 
Final Cut Pro: Plugins: Final Cut Pro Settings: Hardware Settings

Easy Setups in this folder are locked, so you cannot modify or delete them while they are in 
this folder. You can move an Easy Setup file from this folder if you don’t want it to be 
available in the Easy Setup window or in the Choose Setup window that appears during an 
initial setup. 

Choose a different
Easy Setup from this

pop-up menu.

Presets and external
video settings for the
selected Easy Setup

Important  If you decide to make an Easy Setup unavailable, make sure you aren’t using it in 
any current projects and won’t need it for future projects. Once you remove or delete an 
Easy Setup, sequences that use it will not play properly.
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To make an Easy Setup unavailable:

1 Quit Final Cut Pro.

2 Drag the desired Easy Setup file out of the Hardware Settings folder.

This file is located in the following path: Final Cut Pro: Plugins: Final Cut Pro Settings: 
Hardware Settings

You can leave this file on your hard disk for future use or you can drag it to the Trash.

3 Drag the Final Cut Pro Preferences file to the Trash.

This file is located in the following path:  System Folder: Preferences: Final Cut Pro Data

Note:  If you don’t delete this preferences file, the Easy Setup will still appear in the Easy 
Setup window and the Choose Setup window (for an initial setup).

4 Choose your initial setup (see “Choosing an Initial Setup” on page 52). 

If you don’t delete an Easy Setup you removed, you can use it again by moving it back to its 
original folder (Hardware Settings).

To restore the original Easy Setups that came with Final Cut Pro:

m Reinstall the software.

What If None of the Easy Setups Works for You?

If none of the predefined Easy Setups suits the needs of your particular project, you have 
several options:
m Change individual presets or the external video setting.

You can choose presets and an external video setting that work for your media and 
project. The newly selected presets or external video setting applies to all new projects 
and sequences. For more information, see the next section, “Working With Presets,” and 
“Specifying External Video Settings” on page 132.

m Edit an existing preset.

Final Cut Pro comes with predefined presets that are locked and cannot be modified. 
However, you can create a new preset by duplicating an existing one and editing it. For 
more information, see “Creating a New Preset” on page 108.

m Create a custom Easy Setup.

If you regularly use a specific set of presets and an external video setting that aren’t all 
used in one of the predefined Easy Setups, you can create your own Easy Setup. For 
information, see “Creating a Custom Easy Setup” on page 137.
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Working With Presets
A preset is a predefined group of settings that configure a particular function in Final Cut Pro. 
There are three types of presets:

m Sequence preset:  These settings apply to sequences you create and include frame size, 
frame rate, pixel aspect ratio, QuickTime audio and video settings, and video processing 
of RGB and superwhite. While new sequences will automatically have the settings 
specified in the sequence preset you’ve selected, after you create a sequence, these 
settings can be changed at any time.

The sequence preset also determines the editing timebase, or frame rate, for new 
sequences. Unlike the other settings, once a sequence has been created, you can only 
change its editing timebase as long as the sequence contains no clips. Once you’ve edited 
one or more clips into a sequence, you can’t change its editing timebase without first 
removing all clips from the sequence.

m Capture preset:  This group of settings applies to media you capture and is based on your 
source media and video hardware. These settings are similar to those in the sequence 
preset and include frame size, pixel aspect ratio, and QuickTime audio and video settings.

m Device control preset:  These settings control your camcorder or deck and include device 
control protocol (such as FireWire), frame rate, time source, pre- and post-roll duration, 
handle size, and timecode offset.

When you choose a preset, all the settings within the preset are automatically specified.

Note:  There are also external video settings, but these are not considered a preset. For 
information about external video settings, see “Specifying External Video Settings” on 
page 132.

Choosing Individual Presets

If a preset doesn’t suit your needs, you can choose another one in the Summary tab of 
the Audio/Video Settings window. The preset you choose then applies to all new projects 
and sequences.

For example, if you’re currently using the DV-NTSC Easy Setup, these settings are in effect:

m Sequence Preset:  DV NTSC 48 kHz 

m Capture Preset:  DV NTSC 48 kHz Capture using DV FireWire

m Device Control Preset:  FireWire NTSC

m External Video:  Apple FireWire NTSC (720 x 480)
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But suppose you change your work location and are now using a video deck that doesn’t 
have device control. You need to change the device control preset to Non-Controllable 
Device; the two other presets and external video setting remain as is.

To choose a different preset in your current Easy Setup:

1 Choose Audio/Video Settings from the Edit menu.

2 In the Summary tab, choose a preset from the appropriate pop-up menu, then click OK.

Below are the default choices in the preset pop-up menus. If you’ve removed presets or 
installed additional presets, your pop-up menus will look different.

m Sequence Preset 

m Capture Preset 

Choose a different
preset from the
pop-up menus.

Read the summary
below each preset to

help you determine
which setting to choose.
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m Device Control Preset 

If you’re unsure which preset to choose, you can view a preset’s settings. For more 
information, see the next section, “Viewing Settings for a Preset.” If none of the existing 
presets matches your needs, you can create a custom preset. For more information, see 
“Creating a New Preset” on page 108.

When you change a preset (or the external video setting), your current Easy Setup 
changes to Custom Setup in the Setup For pop-up menu. However, if the selected presets 
and external video setting match that of another Easy Setup, Final Cut Pro will use that 
Easy Setup.

Viewing Settings for a Preset

Below each pop-up menu in the Summary tab of the Audio/Video Settings window, there is a 
brief overview of what each preset is used for. If you’re not sure which preset to choose, you 
can view detailed information in the individual preset tabs. 

To view settings for a preset:

1 Choose Audio/Video Settings from the Edit menu, then click the desired preset tab. 

2 Click a preset to view its settings. 

Note:  If you click in the far left column, you may change the current preset.

After you change a preset 
(or external video setting), your 
current Easy Setup is customized.

Click a tab to view settings 
for a specific preset.
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m Sequence Presets 

m Capture Presets 

Select the preset
whose settings

you want to view.

A checkmark
appears next to

the current preset.

Summary of
settings for the

highlighted preset

This icon indicates
a preset is locked.

Select the preset
whose settings

you want to view.

A checkmark
appears next to

the current preset.

Summary of
settings for the

highlighted preset.

This icon indicates
a preset is locked.
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m Device Control Presets 

A locked icon to the right of a preset indicates that it cannot be edited or deleted. These 
are presets that came with Final Cut Pro or presets you installed yourself, such as a 
third-party preset. 

Creating a New Preset

If none of the existing presets are exactly what you need or want, you can duplicate an 
existing preset, change its settings, and save it as a new preset. Once you create a preset, you 
can use it until you delete it. 

To create a new preset:

1 Choose Audio/Video Settings from the Edit menu.

2 Click the tab for the type of preset you want to create. 

Select the preset
whose settings

you want to view.

A checkmark
appears next to

the current preset.

Summary of
settings for the

highlighted preset

This icon indicates
a preset is locked.
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3 Click the preset you want to copy, then click Duplicate.

4 In the Preset Editor window, enter a name and description for the new preset, select its 
settings, then click OK.

For detailed information about settings and options, see “About Sequence Preset Settings” on 
page 113, “About Capture Preset Settings” on page 121, or “About Device Control Preset 
Settings” on page 129.

The newly created preset becomes the currently selected preset and appears in the 
appropriate preset pop-up menu in the Audio/Video Settings window.

Click the preset you
want to duplicate.

Then click here.

The information you
enter here becomes

the summary.

The new preset 
appears in the 
pop-up menu.
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Editing a Preset

You can edit a preset you created. However, you cannot edit presets that are locked.

To edit a preset:

1 Choose Audio/Video Settings from the Edit menu.

2 Click the tab for the type of preset you want to edit. 

3 Click the preset you want to modify, then click Edit.

If the preset is locked, a message appears saying a copy will be made for editing.

4 In the Preset Editor window, modify the desired settings, then click OK.

For detailed information about settings and options, see “About Sequence Preset Settings” on 
page 113, “About Capture Preset Settings” on page 121, or “About Device Control Preset 
Settings” on page 129.

Click the preset
you want to edit.

Then click here.
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Locking Presets

Presets are stored with the Easy Setup they are used with. If you want to lock a preset that 
you’ve created, you can make a custom Easy Setup and store it in the folder where all locked 
Easy Setups are located.

To lock a preset that you’ve created:

1 Create a custom Easy Setup using the preset you want to lock.

For more information, see “Creating a Custom Easy Setup” on page 137.

2 Drag your custom Easy Setup from:
System Folder: Preferences: Final Cut Pro Data: Custom Settings

to:
Final Cut Pro: Plugins: Final Cut Pro Settings: Hardware Settings

Note:  The Easy Setup file uses the filename you entered when saving it.

You must quit Final Cut Pro and open the application again for the preset to appear locked in 
one of the preset tabs in the Audio/Video Settings window.

Deleting Presets

You may decide to delete a preset that you’ve created. Make sure you aren’t using it in 
current projects and won’t need it for future projects. 

To delete a preset you’ve created:

1 Choose Audio/Video Settings from the Edit menu.

2 Click the appropriate preset tab.
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3 Select the preset you want to delete, then click Delete.

m If the preset has a checkmark next to it designating it as the current preset, you cannot 
delete it. You need to choose another preset as the current preset. To do this, click the 
left column next to the preset you want to make the current one.

m If a preset has a locked icon in the right column, it is locked and cannot be deleted.

Installing Presets

Final Cut Pro places several preset files on your hard disk during installation. Additional 
presets are available on the Final Cut Pro CD in the Extras folder. Third-party hardware and 
software manufacturers may also create presets for you to use with Final Cut Pro.

If you remove any of the presets installed during Final Cut Pro installation, you can use them 
again by simply placing them back in the correct folder. If you deleted these presets, you can 
reinstall them by reinstalling the Final Cut Pro software from the Final Cut Pro CD.

Click the preset
you want to delete.

Click the appropriate
preset tab.

Then click Delete.
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To use preset files that are on the Final Cut Pro CD:

1 Insert the Final Cut Pro CD in your CD or DVD drive.

2 If necessary, double-click the CD icon to open it.

3 Double-click the Extras folder, then double-click the 3rd Party Hardware Settings folder to 
open it.

4 Drag the desired preset files from the CD to the following folder:
Final Cut Pro: Plugins: Final Cut Pro Settings: Hardware Settings

The next time you open Final Cut Pro, the presets will be available in the Audio/Video 
Settings window.

About Sequence Presets
A sequence preset is a group of settings that are applied to each new sequence you create. 
These settings include frame size, pixel aspect ratio, an anamorphic option, editing timebase 
(frame rate), and QuickTime video and audio settings.

Settings from the current sequence preset are applied to each new sequence you create. You 
can see the settings in the Sequence Settings window for the sequence. For more 
information about this window, see “Changing a Sequence’s Settings” on page 415. 

About Sequence Preset Settings

There are various settings and options in the General and Video Processing tabs of the 
Sequence Preset Editor. Remember that the settings you choose for your sequence preset are 
applied to new sequences in your project when you create them. Even if you plan to deliver 
your files at a lower, multimedia resolution, it’s recommended that you create and edit your 
project at the highest quality, then compress it later.
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The best options for editing full-resolution video (such as DV-NTSC) are described in the 
following section.

General Settings for Sequence Presets

m Name:  Enter a name for the preset. This name appears in the Audio/Video Settings 
window in two places: the Sequence Preset pop-up menu in the Summary tab, and the list 
of presets in the Sequence Presets tab.

m Description:  Enter a brief description, or summary, of what the preset is to be used for. 

m Frame Size:  Choose a frame size from the Aspect Ratio pop-up menu. To use a different 
frame size, choose Custom, then enter a nonconstrained frame size in the Width and 
Height fields. 

Note:  Frame size and pixel aspect ratio often go hand in hand. 

Choose a frame size 
from this pop-up menu.

Or, choose one of these 
custom options and enter 
your own frame size.
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Common frame sizes for video include

m 640 x 480:  A 4:3 ratio suitable for square pixel multimedia video

m 720 x 480:  A non-square video frame size for DV-NTSC video

m 720 x 576:  A non-square video frame size for CCIR 601-PAL or DV-PAL video

m 720 x 486:  A non-square video frame size for standard CCIR 601 NTSC video

Even if you’ll be outputting at a smaller frame size for multimedia use, it’s best to edit 
your video at its full size, then scale it down later.

m Pixel Aspect Ratio:  Choose the pixel type based on your video source.

m Square:  For multimedia and high definition video

m Non-Square:  For broadcast video, including DV-NTSC and DV-PAL

m Anamorphic 16:9:  Check this box only if you’re capturing 16:9 media. This setting only 
affects the way video is displayed on your monitor and does not permanently rescale your 
source media. (For more information on anamorphic 16:9 video, see Appendix D, 
“Working With Anamorphic Media,” on page 1341.)

If this box is not checked and you’re editing 16:9 clips, your 16:9 media fills the entire 
screen and appears distorted.

If this box is checked and you’re not editing 16:9 clips, your clips are rescaled incorrectly 
and appear distorted.

m Field Dominance:  Choose the field dominance of your captured video. Most video is 
Upper (Odd) or Lower (Even) depending on the video capture interface you’re using. 

For noninterlaced video or multimedia clips, set this to None. For DV captured via 
FireWire, always set this to Lower (Even). For more information, see “About Field 
Dominance” on page 292.

m Editing Timebase:  Choose the editing timebase, or frame rate, of your sequence. 
Standard frame rates for capture and playback are 29.97 frames per second (fps) for NTSC 
video and 25 fps for PAL video.

A sequence’s timebase can be changed only if there are no clips in it. If a sequence has 
clips edited into it, you must remove or delete the clips from the sequence to change the 
sequence’s timebase. 
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QuickTime Video Settings for Sequence Presets

m Compressor:  Choose the compression method, or codec, for the clips in your edited 
sequence. Any clip in your sequence that doesn’t use the codec specified in this pop-up 
menu will have to be rendered. 

The most popular codecs for capturing and editing video are

m DV-NTSC and DV-PAL:  These Apple DV codecs are used to capture video digitally from 
FireWire-enabled devices such as camcorders, decks, or analog-to-DV converter boxes. 
The codecs import DV as YUV-encoded video and Final Cut Pro processes it that way, 
so that your output has the same color and brightness levels as your captured media. 

m Motion JPEG A and B:  These are variable data rate codecs and are similar to the ones 
used by video capture cards. Motion JPEG is a lossy codec, which means that it will 
degrade the quality of your video (or add “artifacts”) when it applies compression. The 
severity of these artifacts depends on the data rate you choose. Several capture and 
playback cards on the market use one or the other of these codecs for capture and 
export. Consult the manufacturer of your capture card to find out which one you 
should use.

m Photo-JPEG:  Photo-JPEG is similar to M-JPEG, except that degradation of quality can 
be less severe at similar data rates. Photo-JPEG movies may not play back in real time 
on your computer, depending on the computer’s speed and the data rate of the 
movie. They won’t play through a video capture card unless they’re rerendered first.

m Third-party codecs:  Most third-party capture cards use a codec based on variations of 
the M-JPEG codec.

Note:  If you’re working on a long edit using different digital and analog source formats, 
don’t capture some clips using FireWire and other clips using a third-party capture card. 
This results in unnecessary rendering because one set of clips will be rerendered using 
the codec specified in your sequence settings. Choose one method to capture all of your 
material (capture your DV media using analog or your analog media using a FireWire 
converter box). For more information on video capture, see Chapter 9, “Importing 
Graphics, QuickTime, and Audio Files,” on page 287.
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m Quality:  Adjust the slider or enter a percentage to set the quality level of the visual image. 
Lower settings apply more compression with lower visual quality; higher settings apply a 
smaller amount of compression with higher visual quality. The quality varies depending 
on the selected codec.

m Advanced:  Click this button to set additional QuickTime video settings, if necessary for 
your video hardware. For detailed information, see “Advanced QuickTime Video Settings 
for Sequence Presets.”

QuickTime Audio Settings for Sequence Presets

m Rate:  Choose a standard audio sample rate.

m 8 kHz–22.225 kHz:  These lower sample rates are used for multimedia.

m 32 kHz and 48 kHz:  Mini-DV, DV-Cam, and DVC-Pro all use these two sample rates, 
but 48 kHz is preferred. (In your camcorder’s menu, choose 12-bit for 32 kHz and 
16-bit for 48 kHz.)

m 44.1 kHz:  This is the sample rate of music CDs.

Note:  If you use 32 kHz audio (12-bit) and 48 kHz audio (16-bit) in the same sequence, 
you may get slight audio distortion. You can mix 44.1 kHz audio and 48 kHz audio without 
distortion, but your audio will sound best with the rate set to 48 kHz. In Final Cut Pro, 
“upsampling” audio, or using a higher sample rate, sounds better than “downsampling” it.

m Advanced:  Click this to set additional QuickTime audio settings. For detailed 
information, see “Advanced QuickTime Audio Settings for Sequence Presets” on page 119.

Advanced QuickTime Video Settings for Sequence Presets

Ordinarily you shouldn’t have to adjust these settings. Occasionally, depending on your video 
hardware, you may need to modify some additional settings for the codec you choose in the 
Sequence Preset Editor. For detailed information about QuickTime codecs and their settings, 
see Chapter 25, “Choosing an Output Method for Final Distribution,” on page 1097.
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All these settings should match those of the clips you’re capturing or importing.

m Compressor:  Choose the compression method, or codec, that clips in your edited 
sequence use. For example, if you’re editing material captured from an NTSC DV 
camcorder, select the DV-NTSC codec.

Depending on which codec you choose, you may be able to choose additional color 
depths from the second pop-up menu. If additional options are available for the selected 
codec, click Options. 

m Quality:  Most codecs allow varying degrees of spatial compression, meaning that you can 
specify the level of compression applied to each frame in the video clip. Adjust the Quality 
slider to choose your desired setting: Least applies the most compression with the lowest 
visual quality and Best applies the smallest amount of compression with the highest visual 
quality. The quality varies depending on the selected codec.

For example, if you’re capturing video using the Motion JPEG-A codec, you may want 
to set the slider to Medium, which lowers the data rate and the quality of your 
captured video.

m Frames per second:  Enter a value or choose a value from the pop-up menu to specify the 
frames per second for your sequence. The frame rate you choose should match the 
editing timebase you chose in your sequence preset. For example, if you’re setting up to 
work with NTSC video, set your frame rate to 29.97 fps. If you’re working with PAL media, 
choose 25 fps.

m Key frame every _ frames:  You only need to specify this if you are going to export your 
sequence. If your selected codec uses temporal compression, click the box to select this 
option, then enter a value to set the number of frames between key frames. Temporal 
compression compares one frame of video to the next one in time. If there is little motion 
in a clip, resulting in no variation from one frame to the next, then temporal compression 
yields better results. 
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Increasing the number of frames between keyframes increases the amount of 
compression and makes the final file size smaller. However, depending on the codec you 
use, having more frames between key frames may decrease the movie file’s quality, 
especially for clips and sequences with a lot of motion. ( With some lossless codecs, such 
as Animation, there is no decrease in quality.) A setting of one keyframe every ten frames 
is a good starting point.

For example, if you’re outputting a QuickTime movie using the Animation codec, you can 
set the frame rate to 25 fps and the keyframe rate to 25, so one keyframe is created for 
every twenty-five frames of video. Final Cut Pro uses this ratio, along with the model of 
video compression specified by the Animation codec, to losslessly compress your video. 
For more information on video compression and output, see Chapter 25, “Choosing an 
Output Method for Final Distribution,” on page 1097.

m Limit data rate to _ KBytes/sec.:  This option is available for some codecs. Click to select 
it, then enter a target data rate for your compressed QuickTime file. The codec uses a 
combination of spatial and temporal compression to try to reach your target. Be aware of 
your frame size and frame rate so you don’t set an impossible goal and get disappointing 
quality in your visual image.

Advanced QuickTime Audio Settings for Sequence Presets

Typically, you won’t have to modify these settings. If you’re using a third-party capture card, 
you may need to adjust these settings for the compressor, or codec, that’s used with that 
card. For more information, see the documentation that came with your capture card.

m Compressor:  Choose an audio compressor, if available. If the selected audio compressor 
has additional options, click Options.

m Rate:  Choose a standard sample rate from the pop-up menu or enter a value to specify 
the output rate for audio. For more information on audio sample rates, see “About Sample 
Rates and Bit Depth” on page 730.

m Size:  Choose a bit resolution for audio; 8-bit is typically used for multimedia clips, 16-bit 
for professional work.

m Use:  Choose Mono or Stereo output for the audio in your sequence.
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Video Processing Settings for Sequence Presets

If you use a codec that supports the YUV (or YCrCb) color space, you’ll be able to set 
additional options in the Video Processing tab. To find out which codecs support this, go to 
the Final Cut Pro Web site at www.apple.com/finalcutpro

m Always Render in RGB:  When this is checked, codecs that normally process color using 
the YUV (or YCrCb) color space are forced to process in RGB color space. Selecting this 
option may cause subtle changes in color in your rendered material. If your video capture 
card doesn’t support YUV rendering, this option is not available.

Select this option if compositing in the RGB color space might yield a different desired 
result from what you’d expect in straight YUV color space (due to color or luminance 
clamping). For example, if you’re using After Effects filters, which only process in RGB 
color space, with Final Cut Pro filters, which process in YUV color space, choosing this 
option ensures a consistent look.

m Process maximum white as:  Many DV camcorders record video with white values that 
are brighter than 100 IRE, the level allowed by the engineering standard for video 
(referred to as CCIR 601). Whites brighter than 100 IRE are called “superwhite.”

When you use clips created in RGB color space (such as imported graphics files, Final Cut 
Pro generator clips such as mattes or gradients, or QuickTime movies that use codecs in 
RGB color space), whites in these imported clips may not match imported clips recorded 
using superwhite levels.

This pop-up menu allows you to match RGB brightness to YCrCb clips using superwhite. 
This pop-up menu is only available if “Always Render in RGB” is not selected. 

m White:  If you choose this setting, the maximum brightness of imported clips from RGB 
color space will be 100 IRE, or normal white. If you’re sure that the maximum 
brightness of your imported video clips is 100 IRE, use this setting.

m Super-White:  If you choose this, the maximum brightness of imported clips from RGB 
color space will match the superwhite levels of clips from DV camcorders.
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About Capture Presets
A capture preset is a group of settings that control how your media is captured. These 
settings, which are based on the video hardware your source media will be playing on, 
include frame size, aspect ratio, and an anamorphic option, along with QuickTime video and 
audio settings.

About Capture Preset Settings

In the following section, you’ll find a description of the settings available in the Capture 
Preset Editor. Remember that the settings you choose for your capture preset are applied to 
media you capture. Even if you plan to deliver your files at a lower, multimedia resolution, it’s 
recommended that you capture your media at the highest quality, then compress it later.

The best options for capturing full-resolution video (such as DV, Photo JPEG, or Motion JPEG 
with a third-party capture card) are described in the following section.

Important  If you’re using a third-party video capture card, see the documentation that 
came with the card for information on how to set up an appropriate capture preset. Incorrect 
capture settings can result in dropped frames and other problems.
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General Settings for Capture Presets

m Name:  Enter a name for the preset. This appears in the Audio/Video Settings window in 
two places: the Capture Preset pop-up menu in the Summary tab, and the list of presets 
in the Capture Presets tab.

m Description:  Enter a brief description, or summary, of what the preset is to be used for. 

m Frame Size:  Choose a frame size from the Aspect Ratio pop-up menu. To use a different 
frame size, choose Custom, then enter a nonconstrained frame size in the Width and 
Height fields. Common frame sizes for video include

m 640 x 480:  A 4:3 ratio suitable for square pixel multimedia video

m 720 x 480:  A non-square video frame size for DV-NTSC video

m 720 x 576:  A non-square video frame size for CCIR 601-PAL or DV-PAL video

m 720 x 486:  A non-square video frame size for standard CCIR 601 NTSC video

Even if you’ll be outputting at a smaller frame size for multimedia use, it’s best to capture 
and edit your video at its full size, then scale it down later.

m Anamorphic:  Check this box if you’re capturing 16:9 media.

m Capture Card Supports Simultaneous Play Through and Capture:  Check this box (near 
the bottom of the window) if your card can display video on an external video monitor 
while the Log and Capture window is open for video capture. For more information, see 
the documentation that came with your card.

QuickTime Video Settings for Capture Presets

m Digitizer:  Choose the capture interface you want to use. If you’re using FireWire but 
don’t have a FireWire device attached, this is set to Missing (DV Video).

m Input:  Choose the video input you want to use. Many third-party capture cards have 
multiple video inputs, including Composite, S-Video, and Component YUV (also called 
YCrCb). 

m Compressor:  Choose the codec recommended by the manufacturer of your video 
capture card. If you’re using FireWire, choose DV-NTSC or DV-PAL, depending on the 
standard you’re using.
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m Quality:  Adjust the slider or enter a percentage to set the visual image quality level 
according to the documentation that came with your video capture card. If you’re using 
FireWire, set this to Medium.

m FPS (Frames per second):  Choose a value to specify the number of frames captured per 
second. For NTSC, set it to 29.97 fps; for PAL, set it to 25 fps.

Note:  This value should match the editing timebase you plan to use in your edited 
sequences.

m Limit Data Rate to _ K/Second:  If you’re using an analog-to-digital capture card, click to 
select this option, then enter a numerical value in the field to define the data rate for 
captured clips in kilobytes (K) per second. 

Note:  DV has a fixed data rate, so this option doesn’t apply for DV clips.

The data rate you specify determines the quality of your video. Here are several sample 
data rates:

m Offline M-JPEG:  1 MB/sec.

m DV-format video:  3.6 MB/sec. 

m Medium quality M-JPEG:  6 MB/sec.

m High quality 2:1 M-JPEG:  12 MB/sec.

The maximum data rate depends on the maximum throughput of your capture card as 
well as the maximum sustained transfer speed of your hard disk. For more information, 
see the documentation that came with your video card or hard disk. See also “Finding the 
Maximum Data Rate of Analog Video Equipment.”

m Advanced:  Click this button to set additional QuickTime video settings, if necessary for 
your video hardware. For detailed information, see “Advanced QuickTime Video Settings 
for Capture Presets” on page 124.

Finding the Maximum Data Rate of Analog Video Equipment

If you’re not sure of the maximum data rate for your equipment, do the following:

1 Capture a video clip from tape with a data rate of 3 MB/sec. 

2 If no dropped frames are reported, increase the data rate to 3.5 MB/sec., then 
recapture the clip.

3 If no dropped frames are reported, recapture the same clip, raising the data rate by 
.5 MB/sec. each time, until the clip you capture reports dropped frames. 

When a message appears saying frames were dropped, you’ve reached the maximum 
data rate for your equipment.
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QuickTime Audio Settings for Capture Presets

m Device:  Choose the audio capture interface you want to use: None, Built-in, DV Audio, or 
Internal CD. If you choose None, some options (Input, Rate, and Advanced) are not 
available. If you’re using FireWire but don’t have a FireWire device attached, this is set to 
Missing (DV Audio).

If you’re using a third-party capture card, its audio input is an item in the pop-up menu. 
Check the documentation that came with your card to determine Input and Rate settings 
and any advanced options.

m Input:  Choose the audio tracks you want to capture: First 2 channels, Second 2 channels, 
or Mix 4 channels. DV video devices can support up to four tracks of audio, but you can 
only record two at a time. Mix 4 channels mixes all four audio tracks into two stereo 
tracks.

m Rate:  Choose a standard audio sample rate. Choose 32 kHz or 48 kHz if you’re importing 
12-bit or 16-bit DV audio; choose 44.1 kHz if you’re importing CD-quality audio.

m Advanced:  Click this button to set additional QuickTime audio settings, if necessary for 
your video hardware. For detailed information, see “Advanced QuickTime Audio Settings 
for Capture Presets” on page 126.

Advanced QuickTime Video Settings for Capture Presets

Normally, you can just select a codec, frame rate, and data rate. In some cases, you may need 
to set advanced settings for compression and source.

m Choose Compression or Source from the top pop-up menu, then specify your settings.
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Advanced Compression Settings for Capture Presets

m Compressor:  Choose a compression method for captured video. For DV, choose DV-
NTSC or DV-PAL, depending on the standard you’re using. If you’re using a third-party 
capture card, choose the codec that came with the card. For more information, see the 
documentation that came with the card.

m Depth:  Choose a color depth for captured video. For DV, the only option available is 
Color. Third-party codecs may give you additional options. For more information, see the 
documentation that came with your card.

m Quality:  Adjust the slider to determine the image quality for your video. Lesser image 
quality yields a high data compression, while higher image quality yields the lowest data 
compression. For DV, make sure it’s set to Best.

m Frames per second:  Choose a value to specify the number of frames captured per 
second. For NTSC, set it to 29.97 fps; for PAL, set it to 25 fps.

Note:  This value should match the editing timebase you plan to use in your edited 
sequences.

m Key frame every _ frames:  If your capture codec uses temporal compression, click the 
box to select this option, then enter a number to set the number of frames between key 
frames. For video capture, do not choose this option. (This option should only be 
enabled for rendering compressed clips.)

m Limit data rate to _ KBytes/sec.:  With some codecs, you can click to select this option, 
then enter a target data rate for your compressed QuickTime file. The codec uses a 
combination of spatial and temporal compression to try to reach your target. Be aware of 
your frame size and frame rate so you don’t set an impossible goal and get disappointing 
quality in the visual image.

Choose Compression.

Specify the
desired settings.
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Advanced Source Settings for Capture Presets

m Digitizer:  Choose the digitizing hardware you want to use. The choices in the pop-up 
menu will include your third-party capture card or DV device.

m Input:  Choose a video input interface. DV devices typically have only one input interface, 
whereas third-party capture cards may have separate inputs for Composite, S-Video, 
Component YUV or RGB, and SDI. Choose the input you want to use to record video.

m Format:  Choose a broadcast format (NTSC or PAL), depending on your source video.

m Filter:  Select the type of filter used when processing the source video: TV, LaserDisc, or 
VCR. This option is not available for DV. 

Advanced QuickTime Audio Settings for Capture Presets

In some cases, you may need to set some advanced audio settings.

m Choose Sample or Source from the top pop-up menu, then specify your settings. You’ll 
also need to specify additional settings on the right side of the dialog box.

Advanced Sample Settings for Capture Presets

m Rate:  Choose a standard audio sample rate. Choose 32 kHz or 48 kHz if you’re importing 
12-bit or 16-bit DV audio; choose 44.1 kHz if you’re importing CD-quality audio.

m Size:  Choose an audio bit depth. In most cases, this should be 16-bit.

Choose Source.

Specify the
desired settings.

Choose Sample.

Specify the
desired settings.
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Advanced Source Settings for Capture Presets

m Device:  Choose the audio capture interface you want to use: None, Built-in, DV Audio, or 
Internal CD. If you’re using a third-party capture card, its audio input is also a choice. 

m Input:  Choose the audio tracks you want to capture: First 2 channels, Second 2 
channels, or Mix 4 channels. DV video devices can support up to four tracks of audio, 
but you can only record two at a time. Mix 4 channels mixes all four audio tracks into two 
stereo tracks.

Additional Audio Settings for Capture Presets

m Speaker:  Choose an option to specify how you want to play audio from Final Cut Pro: Off, 
On, or Off While Recording.

m Volume:  Adjust the slider to set the speaker’s playback volume. This doesn’t affect the 
recorded volume of a captured clip or clips saved to your hard disk.

m Gain:  Adjust this slider to set the gain levels used when recording audio by itself or while 
capturing video.

Choose Source.

Specify the
desired settings.
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About Device Control Presets
A device control preset is a group of settings that define how you use Final Cut Pro to control 
your video hardware. The settings, which are based on your system and the protocol you’re 
using to control your camcorder or deck, include the connection protocol (such as FireWire), 
time source, system (NTSC or PAL), handle size, and timecode and playback offsets. 

Settings in this preset are used during logging, capturing, and editing to tape, and when 
using the Play Around Current control in the Viewer and Canvas.

Using Multiple Video Decks for Capturing Media

If you have several video decks that you regularly capture from, you may have to 
change your device control settings each time you use a different deck. For example, 
the timecode offset is typically different from deck to deck, even with DV decks. 

To avoid constant recalibration, it’s a good idea to create a different device control 
preset for every deck you use. When you switch decks, you can simply change the 
device control preset to set up quickly.
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About Device Control Preset Settings

In the following section, you’ll find a description of the settings and options available in the 
Device Control Preset Editor.

m Name:  Enter a name for the preset. This appears in the Audio/Video Settings window in 
two places: the Device Control Preset pop-up menu in the Summary tab, and the list of 
presets in the Device Control Presets tab.

m Description:  Enter a brief description, or summary, of what the preset is to be used for. 

m Protocol:  Choose the protocol your camcorder or deck uses. 
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m If you’re using FireWire:  Choose Apple FireWire or Apple FireWire Basic, depending 
on your connected device. The Basic version is a simplified device control protocol for 
camcorders and decks that aren’t compatible with Apple FireWire’s full set. Choosing 
the Basic protocol will not affect the video or audio quality of your captured media. 
For more information about FireWire technology, go to Apple’s FireWire Web site at 
www.apple.com/firewire. You may need to install one or more DV Tuner scripts for 
your camera to work properly with Final Cut Pro. Some scripts are available on the 
Final Cut Pro CD in the Extras folder. For more information on the protocol and tuner 
script to use, go to the Final Cut Pro Web site at www.apple.com/finalcutpro

m If you’re using serial device control:  Choose an option based on the equipment 
you’re using. To find out which device control protocols are supported, see the 
documentation that came with the equipment. For more information on serial device 
control, see “Using Serial Device Control” on page 36.

m Time Source:  Some camcorders or decks have multiple timecode tracks that can be 
read independently or together. Choose the track you want Final Cut Pro to read 
timecode from:

m LTC:  LTC (Longitudinal timecode) is an audio signal that’s on a special track on your 
source tapes. If you add or change the timecode on your original tapes after they’ve 
been recorded, then the timecode is LTC. LTC is also used with professional audio 
formats, such as DAT and ADAT.

m VITC:  VITC ( Vertical interval timecode) is written in the video signal on your source 
tapes as you shoot video. You can see it as a series of alternating square dots at the top 
of the video signal on a monitor in underscan mode. (These dots are visible in Final 
Cut Pro except when you’re capturing DV clips.) Because VITC timecode is part of the 
video signal, it can’t be changed on your original tapes. The VITC part of the video 
signal is also not captured as part of a Final Cut Pro clip’s video frame.

m LTC+VITC:  Many source tapes have both LTC and VITC written to them with identical 
timecode numbers. If you choose this setting, Final Cut Pro looks at both timecodes so 
that accurate timecode can be read while the tape is in motion or paused.

m Timer:  A clock-based timecode.

m DV Time:  DV (Digital Video) timecode is available for devices that use FireWire. DV 
timecode is not frame-accurate; if frame accuracy is important, choose LTC or VITC.

m Port:  Choose the port to which your device control cable is connected. If you’re using DV 
timecode, this option is not available. If you’re using serial device control rather than DV 
device control, choose your USB-to-serial adapter.

m Frame Rate:  Choose the frame rate of the video you’ll be capturing. For NTSC, set it to 
29.97 fps; for PAL, set it to 25 fps.
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m Use Deck Search Mechanism:  Check this box to use a deck’s internal search mechanism 
to find timecode, if available. Decks with serial device control may have this option. Do 
not select this option if your deck has problems moving the playhead to a specified 
timecode during capture. For more information, see the documentation that came with 
your video equipment.

m Pre-roll:  Enter a value to determine how far in advance a device-controlled camcorder or 
deck starts playing back your source tape before initiating capture. In most cases, the 
default of three seconds is appropriate. The pre-roll setting gives your device time to 
stabilize and reach a steady speed after starting from a stopped or paused position. The 
amount of pre-roll should not cross over any timecode breaks on your tape. If it does, you 
may get timecode errors in your captured clip. 

For example, let’s say you want to capture a clip that starts at 00:23:22:00, but there’s a 
timecode break at 00:23:20:00. Final Cut Pro starts recording at 00:23:19:00, before the 
timecode break. The dropped frame is captured, resulting in incorrect timecode for the 
entire clip. You must set your clip to be captured at a later In point, such as at 00:23:24:00, 
or shorten the pre-roll value to one or two seconds and hope that your deck reaches 
speed in time to correctly record the clip.

m Post-roll:  Enter a value to determine the amount of video played after the current 
position. This setting is used (with the pre-roll setting) when you click the Play Around 
Current button in the Viewer and Canvas, and when you preview an edit in the Edit to 
Tape window.

m Timecode Offset:  Because of the way timecode and video are captured by Final Cut Pro, 
there may be a small, but consistent, offset between when video and timecode are written 
to your disk. Therefore, you must calibrate your timecode by determining the offset and 
entering it in this field before capturing video using device control. The frame accuracy of 
your edits depends on how your timecode and video device work together. For more 
information, see “Calibrating the Timecode Signal” on page 249.

m Handle Size:  Enter a value in this field to determine if you want additional footage, 
or handles, automatically added to batch captured clips (clips that are captured all at 
one time).
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m Playback Offset:  Enter a number to compensate for delays between the start of playback 
and the start of recording on your deck when editing to tape. This is normally set to zero. 
Enter a positive number to start playback before recording begins; enter a negative 
number to start playback after recording begins.

Note:  If the first frame is duplicated over several frames when you’re editing to tape, 
enter the number of duplicated frames in this field to eliminate the problem.

Specifying External Video Settings
The external video settings determine if and how you view external video on your 
camcorder, deck, or NTSC or PAL monitor. There are several places where you can specify 
external video settings. 

m Audio/Video Settings window:  In this window, you can modify settings for playing back 
video, printing to video, and editing to tape. For more information, see the next section, 
“Choosing an External Video Setting.”

m External Video tab:  This tab in the Audio/Video Settings window lets you specify 
additional options when viewing external video. For more information, see “Specifying 
External Video Settings” on page 134.

m View menu:  From this menu you can change some options for viewing external video. 
For more information, see “Controlling When Final Cut Pro Renders” on page 136.
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Choosing an External Video Setting

When you select an Easy Setup, the external video setting is automatically set for you. You 
can change this setting if you like.

To choose the external video setting:

1 Choose Audio/Video Settings from the Edit menu.

2 In the Summary tab, choose an option from the External Video pop-up menu, then click OK.

m None:  This turns off external video output. If you play clips or sequences in Final Cut Pro, 
you won’t be able to view them on your camcorder, deck, or NTSC or PAL monitor.

m Apple FireWire NTSC (720 x 480):  If you’re using a computer with built-in FireWire and an 
NTSC device is properly connected to your computer and turned on, this choice appears. 
If you choose this option and you have a television or video monitor connected to your 
DV device, your video will be displayed on it.

m Apple FireWire PAL (720 x 576):  If you’re using a computer with built-in FireWire and a 
PAL device is properly connected to your computer and turned on, this choice appears. If 
you choose this option and you have a television or video monitor connected to your DV 
device, your video will be displayed on it.

m Rendered Frames:  If you choose this option, rendered frames will be displayed on your 
external monitor, as well as video that doesn’t require rendering. 

m Other available video capture interface:  If you have a third-party capture card 
installed, it appears in this list. Choose the card to view video on a device that’s connected 
to the card.

When you change the external video setting (or a preset), your existing Easy Setup changes 
to Custom Setup in the Setup For pop-up menu.

After you change the external 
video setting (or a preset), your 
current Easy Setup is customized.
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Specifying External Video Settings

For more control over how your video plays in different situations, you can specify additional 
options for viewing external video.

To specify additional external video settings:

1 Choose Audio/Video Settings from the Edit menu, then click the External Video tab.

2 Choose your desired settings, then click OK.

Viewing Options During Playback

m View During Playback Using:  Choose an option for how you want to view video when 
playing sequences and clips from the Viewer, Canvas, and Timeline.

m None:  This turns off external video output. If you play clips or sequences in Final Cut 
Pro, you can’t view them on your camcorder, deck, or NTSC or PAL monitor.

m Apple FireWire NTSC (720 x 480):  If you’re using a computer with built-in FireWire and 
an NTSC device is properly connected to your computer and turned on, this choice 
appears. If you choose this option and you have a television or video monitor 
connected to your DV device, your video will be displayed on it.

m Apple FireWire PAL (720 x 576):  If you’re using a computer with built-in FireWire and a 
PAL device is properly connected to your computer and turned on, this choice 
appears. If you choose this option and you have a television or video monitor 
connected to your DV device, your video will be displayed on it.

m Rendered Frames:  If you choose this option, rendered frames will be displayed on 
your external monitor, as well as video that doesn’t require rendering. 

m Other available video capture interface:  If you have a third-party capture card 
installed, it appears in this list. Choose the card to view video on a device that’s 
connected to the card.
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m Options:  Depending on your hardware, you may need to decompress frames when 
viewing video on an external monitor. Click Options, then check the box next to 
“Decompress after compress.” This option is not available when using FireWire. If you’re 
using a third-party capture card, check the documentation that came with the card to see 
if you should use this option.

m Mirror on desktop during Playback:  Check this box to show video both on your 
computer’s display and on an external video monitor when you play clips or sequences in 
the Viewer and Canvas. (Some third-party video cards may have settings that override this 
mirroring setting.)

Viewing Options During Recording

m View During Recording Using:  This option allows you to print to tape or edit to tape 
using a different video capture interface from the one you use to view the Timeline. 

For example, if you’re using a real-time card, you may want to play back your video using 
its analog outputs, but print your final program to tape using the built-in FireWire 
interface of your computer.

m Same as Playback:  Choose this to use the same settings as those for playing back 
video from the Viewer and Timeline.

m None:  This turns off external video output. If you play clips or sequences in Final Cut 
Pro, you can’t view them on your camcorder, deck, or NTSC or PAL monitor.

m Apple FireWire NTSC (720 x 480):  If you’re using a computer with built-in FireWire and 
an NTSC device is properly connected to your computer and turned on, this choice 
appears. If you choose this option and you have a television or video monitor 
connected to your DV device, your video will be displayed on it.

m Apple FireWire PAL (720 x 576):  If you’re using a computer with built-in FireWire and a 
PAL device is properly connected to your computer and turned on, this choice 
appears. If you choose this option and you have a television or video monitor 
connected to your DV device, your video will be displayed on it.

m Rendered Frames:  If you choose this option, rendered frames will be displayed on 
your external monitor, as well as video that doesn’t require rendering. 

m Other available video capture interface:  If you have a third-party capture card 
installed, it appears in this list. Choose the card to print to video through it.

Make sure this is
checked if you need

to decompress frames.
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m Options:  Depending on your hardware, you may need to decompress frames when 
viewing video on an external monitor. Click Options, then check the box next to 
“Decompress after compress.” This option is not available when using FireWire. If you’re 
using a third-party capture card, check the documentation that came with the card to see 
if you should use this option.

m Mirror on desktop during Recording:  Check this box to show video on both your 
computer’s display and on an external video monitor when you record to videotape. 
(Some third-party video cards may have settings that override this mirroring setting.)

Controlling When Final Cut Pro Renders

If your project uses a lot of effects, such as transitions or filters, it takes time to render 
these for playback unless you have a real-time system. You can choose an external display 
option to control when clips with effects or transitions are rendered as you move the 
playhead in the Timeline.

To set the external display option:

m Choose External Video from the View menu, then choose an option from the submenu.

Make sure this is
checked if you need

to decompress frames.
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m Off:  Turns off external video and audio output so nothing plays on your video monitor.

m All Frames:  Plays video that doesn’t require rendering and automatically renders the 
frame at the current playhead position while paused. This is useful if you’re working on 
video with effects and transitions and want to spot-check how your edit looks at different 
locations in the Timeline without rendering the entire edited sequence. 

For example, let’s say you superimpose two video clips and set the top clip to 50 percent 
opacity. If you choose All Frames, Final Cut Pro renders just the frame at the location of 
the playhead, so rendering doesn’t take as long. Move the playhead in one-second 
increments in the Timeline, so each frame is rendered as you go, and you get a good idea 
how your sequence looks.

m Single Frames: Displays only video that doesn’t require rendering. To control when you 
want Final Cut Pro to render, choose this option.When you want to render the frame at 
the current position of the playhead, press F15 (press Shift-F12 if you’re using a 
PowerBook).

This option is useful if you have a sequence with many effects and each frame would take 
a significant amount of time to render. You can work quickly and not get delayed by 
rendering each frame when you move the playhead. 

Creating a Custom Easy Setup
If you have your own group of presets that you use regularly, you can create a custom Easy 
Setup. This gives you great flexibility, particularly if the needs of your project don’t quite fit 
with the predefined Easy Setups or presets that come with Final Cut Pro. 

This is also useful if you use a specific combination of presets a lot or if you want to save your 
group of presets for use in the future. Whenever you need those settings again, you can 
choose your custom Easy Setup instead of having to remember which settings you changed.

You can easily move custom Easy Setups from system to system, which is useful if you’re 
editing on more than one workstation. Simply copy the Easy Setup file from its stored 
location on your hard disk to another disk or storage medium. 

Note:  By default, the files for Easy Setups you create are stored in the following 
location:  System Folder: Preferences: Final Cut Pro Data: Custom Settings. Items in this 
folder will show presets as unlocked in the presets list in each preset tab.

To create a custom Easy Setup:

1 Choose Audio/Video Settings from the Edit menu.

2 In the Summary tab, choose the desired presets.
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For more information, see “Choosing Individual Presets” on page 104. If you want to create a 
custom preset, see “Creating a New Preset” on page 108.

3 Choose an external video setting.

For more information, see “Choosing an External Video Setting” on page 133. If you want to 
set additional options, see “Specifying External Video Settings” on page 134.

4 Click Create Easy Setup.

5 If you want Final Cut Pro to check for device control every time you start the application, 
click the checkbox labeled “Enable verification of device control in first start dialog.”

6 Enter a name and description for your new Easy Setup, then click Create. 

Enter a detailed 
description so you 
remember what this 
setup is for.
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7 Enter a filename and location if you don’t want to use the defaults.

Note:  By default, the files for Easy Setups you create are stored in this location:
System Folder: Preferences: Final Cut Pro Data: Custom Settings

8 Click Save.

Your new Easy Setup is automatically selected and appears in the Setup For pop-up menu.

Your new 
custom Easy 
Setup now 
appears in this 
menu.
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To delete a custom Easy Setup:

1 Quit Final Cut Pro.

2 Drag the Final Cut Pro Preferences file to the Trash.

This file is in the following location:  System Folder: Preferences: Final Cut Pro Data

3 Open the Custom Settings folder in the Final Cut Pro Data folder, then drag the Easy Setup 
file (with the custom name you entered when you created it) to the Trash.

Example: Creating a Custom Easy Setup

The following example shows how to create a custom Easy Setup for capturing DV NTSC 
video from a Beta SP deck using a USB-to-serial adapter for serial device control and an 
analog-to-FireWire converter box. You can use the existing sequence and capture presets and 
external video setting, but you need to create a new device control preset.

1 Choose Audio/Video Settings from the Edit menu.

2 In the Summary tab, choose DV NTSC 48kHz from the Sequence Preset pop-up menu.

3 Choose DV NTSC 48kHz Capture from the Capture Preset pop-up menu.

Drag the Easy Setup
you want to delete

and the Preferences
file to the Trash.
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4 Choose Apple FireWire NTSC (720 x 480) from the External Video pop-up menu.

5 Click the Device Control Presets tab to create a new preset for serial device control.

a Click Edit to create a new preset using the current device control preset.

A message may appear saying “The selected preset is locked and cannot be modified. A 
copy will be made for editing.” 

b In the Device Control Preset Editor, change the name to “Beta SP Serial Device Control.”

c Change the description to “Use this preset when controlling your Beta SP deck using 
RS-422 serial device control.”

d Choose Sony RS-422 from the Protocol pop-up menu.

e Choose LTC+VITC from the Time Source pop-up menu.

f Click OK.

Choose settings for
all but the device

control preset, since
you’ll create a custom

preset for this.
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Eventually, you’ll need to calibrate the timecode offset for your hardware setup and enter 
it in this custom device control preset to ensure frame-accurate video capture. For more 
information, see “Calibrating the Timecode Signal” on page 249.

6 Click the Summary tab.

The Device Control Preset pop-up menu is now set to the newly created preset, Beta 
SP Serial Device Control.

7 Click Create Easy Setup.

8 Enter a name and description for your new Easy Setup, then click Create. 

9 Enter a filename and location if you don’t want to use the defaults, then click Save.
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6 Acquisition Strategies
Before editing in Final Cut Pro, you must acquire all of the material you want to edit by 
capturing or importing it. 

m Capturing means getting source media from your camcorder or deck onto your 
computer’s hard disk. 

m Importing refers to copying files onto your computer’s hard disk, then importing the files 
into a project in Final Cut Pro.

Logging is also an important part of acquisition. It’s the process of identifying which shots on 
tape you want to capture to your disk for use in editing.

You can capture and import material into a project at any time. You may capture or import a 
group of clips, start editing, and then add more clips incrementally to your project until you 
have everything you need.

Media You Can Use in Final Cut Pro
You can use a variety of media in Final Cut Pro, including

m video clips captured from tape

m audio files captured from tape or CD or imported from CD-ROM libraries

m computer-generated animation (CGI) files created in other applications

m stock video files imported from CD-ROM libraries

m graphic files created in graphics applications

You can import files in a number of formats. See “Supported File Formats for Importing” on 
page 288. Final Cut Pro is based on QuickTime technology. Files that can be read by 
QuickTime can be imported, giving you a lot of flexibility when gathering material.
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Using Video From Different Tape Formats
For most projects, you’ll work with video clips that are captured from digital or analog tape 
formats. Video clips captured into Final Cut Pro are stored on the specified scratch disk as 
QuickTime files using the compressor, or codec, specified in your capture preset (see “About 
Capture Presets” on page 121).

Using Material With Different Formats

You may frequently use source material from a variety of formats in your project (for 
example, mini-DV footage and Beta SP footage). While you can mix clips captured with 
different video capture interfaces, such as the built-in FireWire interface or a third-party video 
capture card, this is not always the best way to work. 

Each sequence you create uses a QuickTime codec that’s specified in your sequence preset 
(see “About Sequence Presets” on page 113). Clips that use this codec play properly without 
rendering. If you use clips in the sequence that were captured or imported using a different 
codec, they must be rendered using the codec specified in the sequence preset before they’ll 
play back properly. Therefore, editing is faster and more efficient when you capture all of 
your clips from all of your source tapes using one interface and one codec.

For example, let’s say you capture half of your material using FireWire with the DV codec and 
the other half using a third-party capture card with the Motion JPEG codec. Half of the clips 
in your sequence need to be rendered for you to view them properly. This takes up valuable 
editing time.

You can avoid this by capturing everything with one interface. One option is to capture the 
DV footage via the FireWire interface, then capture the Beta SP footage using FireWire with 
an analog-to-DV converter box. Another option is to capture your Beta SP footage using a 
third-party capture card and its codec, then capture the DV footage using the analog outputs 
of your camcorder or deck with your third-party capture card.

Capturing From DV Media

When working with DV, it’s best to capture from the original media. If you experience 
difficulties capturing from mini-DV tapes duplicated from DV-CAM originals, try capturing 
from the original DV-CAM media.
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Strategies for Logging and Capturing Video
There are three ways to capture video in Final Cut Pro. You can

m manually capture individual clips one by one without device control

m capture individual clips one by one with device control

m log clips using device control, then capture clips individually or all at once

Logging is the process of watching your footage and selecting the starting and ending 
timecode numbers of each section of tape that you’d like to use. It also allows you to 
annotate and organize your material in preparation for editing. 

What’s a Codec?

Codec stands for COmpression DECompression. Codecs are extensions that work with 
QuickTime to allow Final Cut Pro to capture, play back, and output different formats of 
digital video. Numerous codecs come with QuickTime, such as DV-NTSC, DV-PAL, 
Motion JPEG A and B, and Photo JPEG. Other manufacturers’ capture cards may come 
with their own QuickTime codecs and drivers that must be installed for the card to 
work properly.

The codec you choose for capture depends on the format of video you shot and the 
video capture interface you’re using. Several codecs are commonly used for full-
resolution video capture:

m Apple DV-NTSC and DV-PAL:  The Apple DV codec is used to capture video digitally 
from FireWire devices such as camcorders, decks, or analog-to-DV converter boxes. 
The Apple DV codec imports DV as YUV-encoded video, and Final Cut Pro 
processes it that way as well, so that what you output has the same color and 
brightness levels as what you captured. The Apple DV codec has a fixed data rate of 
3.6 MB/sec.

m Motion JPEG:  There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. 
These are variable data rate codecs, similar to ones used by third-party video 
capture cards. Motion JPEG is a “lossy codec,” meaning that you’ll get “artifacts” in 
your final video. The severity of these artifacts depends on the data rate you 
choose. Several capture and playback cards use Motion JPEG A or B for capture and 
export. Check with the manufacturer of the capture card to find out which codec to 
use.

m Third-party codecs:  There are several manufacturers of video capture cards; most 
of them use variations of the Motion JPEG codec.
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Your capture method depends on whether your video equipment has device control. Device 
control lets you control your video equipment using Final Cut Pro’s transport controls 
(including play, fast forward, reverse, and stop). If your equipment doesn’t support device 
control, you must use the controls on the equipment to play your tapes manually. For more 
information, see the documentation that came with your equipment. 

Manual Video Capture Without Device Control

If you don’t have a deck with device control, such as a DV-format camcorder with FireWire or 
a high-end video deck, then you must capture video manually. Provided you use the right 
video capture interface, you can capture video from any source—VHS, 8 mm videotape, or 
even live video from a camera—giving you a great deal of flexibility.

However, once you manually capture a clip, you can never recapture exactly the same clip 
with the same In and Out points. If you need to recapture your clips for any reason, such as 
to capture them at a higher resolution or to recreate an old project that you want to update, 
you must reedit your program using slightly different footage.

If you manually capture clips, make sure you

m capture clips at the same resolution you plan to output 

Since you can’t recapture your clips with the same In and Out points, you should capture 
them at a high resolution using the data rate at which you want to output your project. 
This way, you won’t have to recapture later.

m back up all of your source clips 

If you back up your clips, your source material is always available for reediting. Because 
video clips require a lot of disk space, you need to use a high-capacity backup format, 
such as streaming tape (like Data DAT, Mammoth, DLT, AIT, and VXA), CD-ROM, or 
DVD-RAM. 

To capture clips manually, you press the Play button on your video device, then click the 
Capture Now button in the Log and Capture window. When your entire clip has been 
captured, press Esc to stop capture. For detailed instructions, see “Using Capture Now 
Without Device Control” on page 266.
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Video Capture Using Device Control

The best and most efficient way to capture video is using device control. Whether you log 
your clips first or simply capture them one by one, using device control to capture your 
video clips with timecode gives you the most control over your video. The reel numbers and 
timecode stored with your clips in Final Cut Pro record exactly which sections of the source 
tapes clips are from, so you’ll always be able to recapture your clips. 

Being able to recapture your clips whenever you need to frees you from having to back up 
source clips, which take up a lot of disk space. As long as you have your Final Cut Pro project 
file and your original source tapes, you’ll be able to recapture exactly the same clips. 

For information on capturing clips using device control, see “Capturing Video and Audio” on 
page 265.

Methods of Device Control

There are two methods of device control:  FireWire and serial. Which you use depends on 
the degree of frame accuracy you want.
m DV device control via FireWire (also called IEEE 1394 or i.LINK)

Nearly every FireWire-capable camcorder and deck has device control, and some 
consumer models are quite inexpensive, so anyone can work like a professional. However, 
DV device control does not, by its nature, have perfect frame accuracy. Although it does 
an outstanding job most of the time, occasionally you may notice clips that are captured 
starting a frame too early or too late. 

Regardless of this starting frame inaccuracy, all timecode correctly matches the frame. If 
your clips all have In points that occur after the first frame, this shouldn’t cause any 
problems. If you use a clip’s entire duration in an edited sequence, double-check its In 
point after recapture to make sure that it’s not missing a frame.

m Serial device control (LTC or VITC via RS-232 or RS-422)

Serial device control uses industry-standard SMPTE timecode to control camcorders 
and decks using a serial interface. When properly calibrated, serial device control is 
frame-accurate every time. 

Camcorders and decks that use serial device control are generally more expensive than 
those with FireWire device control (although some equipment has both).

Note:  There are other device control formats, such as VISCA and LANC. These are 
consumer-level device control protocols and aren’t suitable for extensive editing and 
frame-accurate work.

For more information on DV and serial device control formats and how to connect them, see 
“Using Serial Device Control” on page 36. 
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Logging Clips 

When you capture using device control, you can log your footage beforehand. When you log 
a tape, you watch your footage and select the starting and ending timecode numbers of each 
section of tape that you’d like to use. You can then use this information to capture all of your 
selections from tape at one time in a “batch capture.”

Logging is an important step because it represents the first set of decisions you make as an 
editor. Even if you were to capture every minute of every tape you shot, from start to finish, 
eventually you’d have to watch all of your footage, decide which takes you like, and which 
ones you don’t want to use. Logging your material in advance allows you to go through this 
process before you capture, so you don’t have to use valuable scratch disk space to store 
clips you’ll never use.

Can I Use iMovie to Capture DV Clips Automatically?

iMovie and Final Cut Pro capture DV-format video in different ways. When iMovie 
captures DV clips, one at a time or by automatically capturing an entire tape and 
breaking each shot into its own clip, all video and audio is saved to disk as DV Stream 
files. When Final Cut Pro captures DV clips, they are saved as QuickTime video files 
using the DV-NTSC or DV-PAL codec.

Final Cut Pro can recognize both DV Stream and QuickTime files, but the information 
in these files is stored differently. DV Stream files encode the audio and video of a clip 
together as one data stream, the way it’s stored on DV-format tape. In QuickTime files, 
video and audio are separate tracks inside a single QuickTime movie file.

DV Stream files that are edited into a Final Cut Pro sequence must be rendered before 
their audio plays back properly. QuickTime files require no rendering.

Video files captured using iMovie don’t have timecode. This makes it impossible to 
recapture exactly the same clip twice, which may disrupt your workflow. If you must 
use a clip captured using iMovie, it’s best to back it up before archiving your project, in 
case you need it for future revisions.
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Logging your material in advance also lets you annotate and organize your material in 
preparation for editing. As you log your clips in Final Cut Pro, you can add notes to them, 
such as what action you liked in a clip, director’s notes, how you want to use the clip, and 
other information, such as scene, shot, and take numbers. When it’s time to edit, you have a 
whole array of information available to help you.   

There are two ways you can log your clips:  using the Log and Capture window in Final Cut 
Pro or creating a batch capture list in a third-party application and importing it into 
Final Cut Pro.

Using the Log and Capture Window in Final Cut Pro

Logging your tapes in Final Cut Pro is easy. If you’re set up properly for video capture, you 
can use the transport controls (or the keyboard equivalents) in the Log and Capture window 
to play your footage, tape by tape. Mark the In and Out points of a clip you want to capture, 
then click the Log button. The specified clip is stored in your logging bin as an offline clip. 

An offline clip represents material that hasn’t been captured yet. Offline clips are treated like 
any other clip, but they have a red diagonal slash. 

The log bin is the bin you specify all logged clips to be stored in. By default, your project is 
the log bin, but you can create a specific bin within your project for storing captured clips. 
For more information, see “Using Bins to Organize Your Clips” on page 184. For information 
on logging, see “Logging Your Media” on page 251.

Important  There’s one other reason to log your tapes in advance, as opposed to capturing 
whole tapes at once. Many source tapes have timecode breaks. If Final Cut Pro captures a clip 
with a timecode break, all timecode following the point of the timecode break is wrong. This 
clip will be usable, but if you try to recapture segments of it later, you’ll capture the wrong 
clips. If you export this clip in an Edit Decision List (EDL), the timecode reference in that 
EDL will be wrong. If you log your tapes first, instead of capturing an entire tape, there’s a 
greater chance you’ll avoid these timecode breaks and the problems they cause.

Online clips

Offline clips

Log bin
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Creating and Importing a Batch Capture List

You can also log your tapes using nothing more than a camcorder or deck with a timecode 
display and a spreadsheet program or word processor. Enter a reel number, timecode in, 
timecode out, and clip name for each clip you want to log. Save this “batch capture list” as a 
text file, then import it into Final Cut Pro. The result is a set of offline clips stored in your 
logging bin.

A batch capture list is frequently useful. Often, there is a written or electronic log of all the 
shots on all the source tapes created during the shoot. This log may include information 
about which clips the director liked, as well as notes about the various shots. All you need to 
do is reformat this list for use in Final Cut Pro. You can also have a client or assistant editor 
log your tapes in advance so you can focus your time and energy on working with good 
takes only.

For more information on importing batch capture lists, see “Importing a Batch List” on 
page 260.

Capturing Video at Different Data Rates
If you’re capturing video from DV-format tapes, all of your clips are captured and output to 
tape at the same fixed data rate of 3.6 MB/sec. If you’re using a third-party video capture 
card, you may have the option of capturing your video at any data rate you choose. The 
maximum possible data rate is determined by the capabilities of your capture card and the 
maximum sustained transfer speed of your specified scratch disk. 

You can use video captured at different rates to work on your project in two steps:

m Offline edit:  You do most of your editing in this step, using low-resolution video clips.

m Online edit:  You recapture only the clips used in your final edit at high quality. ( Your 
video equipment must support device control.)

This shows
part of a log in a

spreadsheet program.
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Capturing Video for Offline Editing

When you initially log your shots for capture, you usually log more material than you’ll 
ultimately use in your final edit. 

For example, let’s say you’re cutting a half-hour project. At a high-quality data rate of 9 MB/
sec., your finished program alone will require approximately 16.2 GB of disk space. But that’s 
not all you’ll be capturing. In addition, you may have alternate B-roll shots to cut away to, 
additional lines of interview footage, extra audio, and multiple takes that you might capture 
so you can use the best pieces of each. 

In all, you could initially log more than three times the final amount of footage, or 48 GB at 
9 MB/sec. If you only have two 20 GB LVD SCSI hard disks in a high-performance disk array, 
totaling 40 GB of hard disk space, you’ll have a storage problem.

Fortunately, you can capture your video at a lower data rate. Since it doesn’t matter what 
your video looks like when you’re doing the bulk of your offline editing, you can capture 
your 90 minutes of source clips at a data rate of 2 MB/sec. The footage will require only 10.8 
GB of hard disk space instead of 40 GB.

Making Low Data Rate Copies of DV Clips for Offline Editing

Even though the DV codec has a fixed data rate, you can still make low data rate copies 
of DV clips to edit with a PowerBook or other computer that has limited disk space.

Capture your DV clips as you normally would, then do a batch export of the clips using 
the Photo JPEG codec. Photo JPEG clips can have data rates as low as 202 K/sec. These 
exported clips have the same timecode as your original DV clips, so when you’re 
finished editing, you can discard the Photo JPEG copies and recapture your original 
DV clips.

For more information on batch exporting clips from one codec to another, see “Batch 
Exporting Clips and Sequences” on page 1179.
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Recapturing Video for Online Output

When you’ve finished editing, you’ll know which clips you’re not using as well as which clips 
you’re only using small parts of. With the Media Manager in Final Cut Pro, you can 

m create a duplicate of your project that only uses the clips and sections of clips you need

m delete your original clips

m recapture the material in your duplicate project at a final resolution of 9 MB/sec. (using 
device control)

This creates additional disk space for extra clip overlap and for render files. It leaves plenty of 
room to recapture clips at high resolution for final output. For more information, see “About 
the Media Manager” on page 859.

Importing QuickTime Files
You can import material that’s already been captured or created as a QuickTime movie. 
Examples of QuickTime movies you can import are

m footage captured from another computer

m stock footage from a CD-ROM or DVD collection

m 3D animation clips

m a special effect or composited clip from another editor or facility

You can import any QuickTime video clip as long as you have the codec it was compressed 
with. Since codecs are system extensions, you can install ones you don’t have. 

For more information on importing QuickTime files, see Chapter 9, “Importing Graphics, 
QuickTime, and Audio Files,” on page 287.

Popular Codecs for Video File Exchange

You can use several video codecs in Final Cut Pro:  Uncompressed, Animation, Apple M-JPEG, 
JPEG, and third-party codecs.

Although you can use clips compressed with different codecs in your sequence, the only 
clips that play properly without rendering are those compressed using the codec specified in 
your sequence preset (see “About Sequence Presets” on page 113). Also, it’s more convenient 
to edit a clip that uses the same codec straight into your sequence. 
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Uncompressed

This isn’t really a codec, but a way of storing QuickTime movies with no compression at all. 
Since applying compression generally results in video artifacts, no compression guarantees 
the highest quality. Unfortunately, it also guarantees enormous file sizes. Uncompressed 
movies can consume up to 32 MB per second of video. They will not play back in real time on 
most systems, making them useful primarily for file exchange. 

Uncompressed movies can have an alpha channel. Alpha channels define levels of 
transparency in your movie and are useful if you’re delivering an effects shot for use in 
someone else’s composition. For more information on alpha channels, see “Using Video and 
Graphics Clips With Alpha Channels” on page 918.

Animation

The Animation codec was developed for computer-generated imagery, which often has large 
areas of uniform color and little, if any, noise. It is a lossless codec, which means it doesn’t 
degrade quality or add artifacts to your video when it applies compression. For more 
information, see “More About Video Compression” on page 1110.

Video footage, which generally has more grain, noise, and variations of texture and color 
than animated material, may not be compressed as much with the Animation codec as with 
other methods. This codec is used more frequently than Uncompressed. 

Animation movies will not play back in real time on most systems. Animation movies can also 
have an alpha channel.

Apple M-JPEG

There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. These are variable data rate 
codecs similar to the ones used by video capture cards. If you need to deliver more heavily 
compressed material to keep files small, consider these codecs. M-JPEG is a lossy codec and 
will result in artifacts in your final video. The severity of these artifacts depends on the data 
rate you choose. 

Several capture and playback cards on the market can play back either M-JPEG A or M-JPEG B 
in real time without rerendering the material, or, at most, doing minimal rerendering. This 
makes file interchange very fast. Before you use either M-JPEG A or B, consult the 
manufacturer of the capture card you’re using to find out which one you should use.

Apple M-JPEG movies cannot have alpha channels.
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JPEG

JPEG is similar to M-JPEG, except that the compression artifacts can be less severe at similar 
data rates. JPEG movies may play back in real time on your system, depending on your 
system’s speed and the data rate of the movie.

JPEG movies cannot have alpha channels.

Third-party codecs

There are several manufacturers of video-editing solutions, most of whom use different 
variations of the M-JPEG codec. Many make software-only QuickTime codecs that you can 
install in your System Folder, enabling you to play back movies with little or no rerendering. 
For more information, contact the manufacturer of the editing system.

Most third-party codecs cannot have alpha channels.

Importing Image Files and Sequences
You can import a variety of still-image formats into Final Cut Pro. These include freeze-frames 
you’ve exported as stills, title graphics from other applications, and images from stock 
libraries. You can also import numbered image sequences and multilayered Photoshop files.

Popular Image Formats You Can Import
m PICT:  A common image format used on Mac OS computers. PICT files can use any of the 

standard QuickTime codecs for compression in color or grayscale.

m TIFF:  Common on Mac OS and Windows computers. TIFF files allow color depths from 
dithered black-and-white to millions of colors and one form of compression. 

m TGA:  The Targa file format. An uncompressed file format that stores images with millions 
of colors. Targa files are supported by nearly every platform and media application. 

m Photo JPEG:  An extremely popular file format because it can create highly compressed 
yet good-looking graphics files. You can choose grayscale or color as well as the amount of 
compression. 

All of these file formats except Photo J-PEG can contain an alpha channel.

For more information on importing graphics files, see “About Importing Still Images” on 
page 296.
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Importing Numbered Image Sequences

You can export a numbered image sequence from another application to one of the file 
formats listed above, then import the sequence into Final Cut Pro. A numbered image 
sequence is an edited sequence exported as a series of numbered image files stored in a 
folder. Each image file contains one frame of your video. 

Final Cut Pro imports all of the files associated with a numbered image sequence individually. 
If you register QuickTime Player with the QuickTime Pro license included with Final Cut Pro, 
you can convert an image sequence to a standard QuickTime movie. For more information, 
see the documentation that came with QuickTime Pro.

Importing Multilayered Photoshop Files

Final Cut Pro lets you import multilayered Photoshop files. Any version of Photoshop files 
can be imported, but only Photoshop 3.0 features are supported for import. Supported 
features include opacity, composite modes, layer order, and layer name.

When you import a multilayered Photoshop file, Final Cut Pro creates a sequence with all the 
layers of your Photoshop file composited together using a frame size identical to the 
imported file’s frame size. 

If you’re working on a motion graphics sequence, you can lay out all the graphic elements 
you want to animate in Photoshop as separate layers of painted and scanned graphics. After 
you import the file, all of your graphics are in place so you can quickly and easily animate and 
add motion effects in Final Cut Pro.

For more information, see “About Importing Layered Photoshop Files” on page 306.

Capturing and Importing Audio
You can capture audio clips, as well as video clips, using the Log and Capture window. You 
can capture several types of audio:

m DV audio using a connected FireWire device

m Built-in audio using your computer’s sound input port

m Audio from a third-party audio or video capture card installed in your computer

Note:  Final Cut Pro can capture audio from most audio input devices that are supported by 
the Sound Manager (for more information, see Mac Help).
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You can capture audio through the sound input port on your computer and using 
device control. You can also import audio files recorded at an audio-editing facility or 
from an audio CD.

Capturing Audio Using Device Control

There may be times when you want to record your audio using device control. Professional 
DAT (digital audio tape) decks used for field or studio recording can record standard drop 
frame timecode along with high quality audio. Some DAT decks also support standard serial 
device control. These decks may be controllable using one of Final Cut Pro’s standard device 
control protocols via a USB-to-serial adapter. For more information, see the documentation 
that came with your professional DAT deck, as well as information in Chapter 2, “Setting Up 
Your System,” on page 21.

If you want to use timecode to capture your audio, another option is to dub all of your audio 
onto DV-format tape. Make sure your DV-format camcorder or deck is set to 16-bit audio mode 
so you record at the highest possible quality. Once audio is recorded, you can import your DV 
audio clips using FireWire and DV device control, the same way you’d import DV video clips.

For more information, see “Capturing Video and Audio” on page 265.

The Importance of Using High Quality Audio

When watching a video, viewers forgive problems with picture more readily than 
problems with sound. Therefore, it’s vital to capture and import audio using the 
highest quality source material available, recorded at good volume levels using the 
highest quality audio input interface. 

Important  Audio clips should be recorded at nothing less than 16-bit, 44.1 kHz 
audio. (Most DV devices and all DAT decks support 48 kHz audio.)

If you’re doing your own audio capture and high audio quality is a priority, avoid using 
the sound input port on your computer. Instead, capture audio via FireWire or a third-
party video or audio capture interface. If you plan to export your audio tracks using 
OMF for mixing at an audio facility, it’s extremely important to make sure your source 
audio is as good as possible.

For information on audio interface compatibility with Final Cut Pro, see the Final Cut 
Pro Web site (www.apple.com/finalcutpro).
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Importing Prerecorded Audio

If you’re having audio recorded at a professional recording facility, such as voiceovers, dialog 
replacement, or effects, you can usually request that your source material be formatted as 
digital files and placed on CD instead of on tape. This way you won’t have to capture audio in 
Final Cut Pro. You can just copy the audio files you want to use to your hard disk, then 
import them into Final Cut Pro.

Final Cut Pro supports the most popular audio formats, so you can use digital audio files 
from other digital audio-editing applications. Two commonly used audio file formats are

m AIFF:  Audio Interchange File Format is a cross-platform file format supported by a wide 
variety of video and audio digital editing applications. AIFF files can use a variety of 
compressors to reduce their file size, though this will reduce the quality. AIFF audio can 
be either 8-bit or 16-bit and uses sample rates from 8 to 48 kHz.

m Wave:  This is the primary audio file format used by Windows-compatible computers. 
Wave files can be either 8- or 16-bit and use sample rates from 8 to 48 kHz.

These formats are also used for stock sound effects in CD collections. For more information 
on importing audio files into Final Cut Pro, see “About Importing Audio Files” on page 307.

Importing Audio Tracks From CD

You can digitally import prerecorded material by importing audio tracks from audio CDs. You 
can adjust import options, including the bit depth, sample rate, and In and Out points for the 
selected track. When you import a CD track, it’s saved to your hard disk and imported as an 
audio clip in your project. 

For more information, see “Importing Audio CD Tracks” on page 309.

Organizing Your Material
Capturing and importing media is the focus of the acquisition process. Before you do this, 
however, you may want to plan and organize your project using the Browser. This window is 
the central storage area where you organize and manage media in your project and finished 
program. You can sort and search for clips various ways and you can display items as lists or 
icons and thumbnails of clips. 

For more information, see Chapter 7, “Using the Browser and Managing Projects and Clips,” 
on page 161.
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C H A P T E R

7

7 Using the Browser and Managing 

Projects and Clips
You use many kinds of media to create your projects in Final Cut Pro. To organize your media 
so you can work efficiently, you need to understand the basic organizational elements of 
Final Cut Pro—clips, sequences, projects, and bins—and how they relate to the Browser.

m Project:  A project contains all the clips, sequences, and files for a particular program. If 
you captured your clips using timecode and a camcorder or deck with device control, 
your project file contains all the information necessary to recreate your edit, except for 
imported audio and graphics files. You can copy your project file to another Final Cut Pro 
workstation along with the associated audio and graphics files, then recapture all your 
original source clips.

Browser

Bin 1 Sequence 1

Clip

Clip

Clip

Clip Clip Clip

Clip

Clip

Bin 2

Clip

Clip

Clip
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m Bin:  Within projects you can create bins, which are similar to folders, to store your clips 
and sequences. These are useful for file management. You can use bins to

m separate different kinds of footage

m organize your video, audio, and graphics files separately

m separate sequences along with their supporting clips

m Sequence:  A sequence is a container where you edit together a series of clips to create a 
new program. A sequence can be only one part of a project. You can have multiple 
sequences within a project; sequences can also be used as source clips and edited into 
other sequences. You cannot save sequences outside a project, but you can export them 
as movies or clips.

Sequences are analogous to bins in that they also contain clips. In fact, a sequence may 
contain clips that aren’t located anywhere else in the Browser (for example, when you 
import an Edit Decision List, or EDL). For more information on importing EDLs and 
working with the resulting sequences, see Chapter 10, “Importing Edit Decision Lists 
(EDLs),” on page 313.

m Clip:  A clip is an individual section of a video, audio, or graphics file. A clip is not the 
actual media file, but a reference to the media file stored on your hard disk. Clips are the 
building blocks from which all sequences are created.

m Browser:  Although media files are actually stored on your hard disk, you use the Browser 
and all of its features to help manage your projects, sequences, and clips. The Browser is 
the central storage area where you organize the source material for your project and the 
finished program.
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Getting Started
Before you begin working on projects or capturing material, you can change your 
preferences to suit how you want to work with Final Cut Pro. For more information, see 
Chapter 19, “Viewing and Setting Preferences,” on page 883.

If you try to open and work with projects created with an earlier version of Final Cut Pro, 
you’ll be prompted to update your projects. For more information, see the next section, 
“Updating Projects Created With a Version Earlier Than Final Cut Pro 2.”

Updating Projects Created With a Version 
Earlier Than Final Cut Pro 2
You can open and use projects created with versions of Final Cut Pro earlier than 2, but you 
need to specify how Final Cut Pro handles the color space in these files. Older versions of 
Final Cut Pro and the Apple DV-NTSC and DV-PAL codecs converted YCrCb video to RGB 
video whenever rendering was required. The conversion sometimes resulted in subtle but 
noticeable shifts in color or intensity. Although this version of Final Cut Pro handles color 
space differently, your old projects may still have links to older render files that exhibit the 
color and intensity shifts.

About Naming Disks and Folders

If you have multiple hard disks and partitions, or volumes, that have similar names, 
they may cause problems during the capture process. Each hard disk should have a 
name that doesn't contain the entire name of another disk or partition. 

m Bad Names:  “Media” and “Media 1”

m Good Names:  “Zeus” and “Apollo”

If you name disks and folders with double-byte characters (double-byte character sets 
are needed for languages with many characters, such as Japanese), Final Cut Pro may 
not be able to export or import EDLs (Edit Decision Lists). To make sure you can 
export and import EDLs properly, don’t use double-byte characters in the names of 
disks and folders you use for import or export.
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Before Updating Projects

Before updating projects from earlier versions of Final Cut Pro, consider these things:

m Third-party effects scripts, or scripts that you’ve already written or customized, may need 
to be modified to take full advantage of Final Cut Pro’s use of YCrCb color space. For 
more information, go to the Final Cut Pro Web site at www.apple.com/finalcutpro

m All Final Cut Pro effects take advantage of the new YCrCb color space. If you used any of 
the effects listed below in previous projects, the effects may look slightly different when 
you recreate the project’s render files.

m Video Transitions:  Map/Luminance Map, Wipe/Gradient Wipe

m Video Filters:  Blur/Gaussian Blur, Channel/Invert, Image Control/Brightness and 
Contrast, Gamma Correction, Levels, Proc Amp, Sepia, Tint, Key/Blue and Green 
Screen, Color Key, Difference Matte

m Video Generators:  Matte/Color

m Third-party After Effects filters and QuickTime transitions and filters do not take 
advantage of the new YCrCb color space. They always render in RGB space.

Updating Projects

You can open and use projects created with earlier versions of Final Cut Pro, but you need to 
specify how you want Final Cut Pro to handle the color space in these files.

To update earlier projects:

1 Open a project created using an earlier version of Final Cut Pro. A message tells you that the 
file’s format is outdated and asks if you want to update the format. Click Yes.

Click here to update 
your project.
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2 If a dialog box appears with options for improved color fidelity, click the appropriate 
checkboxes, then click OK.

Note:  These options are available for codecs that support YCrCb color space. To find out 
which codecs support this, go to the Final Cut Pro Web site at www.apple.com/finalcutpro

m Update sequences for improved color fidelity:  This sets the maximum white value to 
superwhite in the Video Processing tab of the Sequence Settings and Sequence Preset 
Editor windows. All future rendering in the sequence is done in YCrCb in superwhite.

Note:  If you check this option, the “Always Render in RGB” option in the Sequence 
Settings or Sequence Preset Editor window is not selected (see “Setting Up for YCrCb 
Rendering” on page 1084).

m Remove existing render files:  This deletes all render files on the scratch disk for the 
sequences in this project. If you keep existing render files, the rendered media may have 
color or intensity shifts. You should keep existing render files if the quality difference is 
not a problem for your projects or if you need to get a project done fast and don’t want to 
rerender files. If you keep existing render files and want consistent-looking media, you’ll 
have to rerender the files because sequences in previously rendered media may have 
color or intensity shifts.

Choosing these options will not rerender any material immediately. You need to open any 
affected sequences and render them manually.

Choose the desired
options for color fidelity.

Important  You cannot restore deleted render files with the Undo command.
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Updating Projects or Sequences From Final Cut Pro 1.2.1

If you upgrade a project or sequence created in Final Cut Pro 1.2.1 and the compression 
codec used for the sequence (such as Animation or Targa) is not found by the system, the 
codec in the Sequence Settings is listed as “Unknown” and is set to RGB. If you want to 
render the sequence in YUV, you need to change this manually. 

To enable YUV processing in a sequence with an unknown codec:

1 Choose Settings from the Sequence menu. 

2 In the Sequence Settings window, click the General tab, then click Advanced in the 
QuickTime Video Settings section. 

3 Choose DV-NTSC or DV-PAL (whichever you are using) from the compressor pop-up menu at 
the top of the Compression Settings dialog box, then click OK. 

4 Click the Video Processing tab, then click the checkbox labeled “Always Render in RGB” (to 
remove the checkmark).

Learning About the Browser
The Browser is the central storage area where you organize the source material for your 
project and the finished product. The Browser can contain multiple projects, each with its 
own tab. It also contains all the effects—video and audio transitions and filters and 
generators—in a separate tab that you can drag and drop into your sequences. Within each 
project, or tab, you can have bins, similar to folders, where you organize your media. 

In list view, the Browser’s scrollable columns provide information about your files. You can 
sort and search for items within the Browser. You can also view the Browser using two other 
modes:  small icon view or large icon view. The picture below shows list view, which is the 
default. For more information, see “Customizing the Browser Display” on page 191.

 

Each project
has its own tab
in the Browser.

This is a sequence.

These are audio
and video clips.
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About Browser Columns

The Browser can display up to 41 columns of information. You can customize the display to 
view only the columns you want, as well as rearrange columns and change their width. The 
Name column always appears at the far left. 

Information in the Browser columns is based on one of the following:

m the item properties of a clip

m the device control and capture settings that were enabled when your clips were captured 
(device control preset and capture preset)

m the sequence settings of an individual sequence (sequence preset)

You can change properties in some columns directly in the Browser by Control-clicking 
within the column, then choosing an option from the shortcut menu. For more information, 
see “Viewing and Changing the Properties of a Clip” on page 208. You can also modify these 
properties in the Item Properties window for a clip (see “Viewing and Changing Clip 
Properties in the Item Properties Window” on page 210).

Other properties, such as the frame size or video rate, were determined by the capture 
preset you used to capture the clip (see “About Capture Presets” on page 121).

There are also two sets of columns that can be displayed:  a standard set and a logging set. 
The Standard Columns display shows default columns and is typically used when editing. The 
Logging Columns display shows only logging information for clips and media and is useful 
when logging media. Both sets can be modified. For more information, see “Working With 
Standard or Logging Columns” on page 201.

Browser column Information provided

Name Name of the media file (from the Name field in the Logging tab of the 
Log and Capture window).

The name is typically entered when logging, but you can also add or 
change it in the Browser or Item Properties window. Changing the 
name of a clip doesn’t change that clip’s source file on your hard disk.

Alpha Shows the type of alpha channel present—None/Ignore, Straight, Black, 
or White. 

Graphics or animation files created outside Final Cut Pro may have an 
alpha channel. Different kinds of channels display different results, 
depending on whether transparency is used. Final Cut Pro discerns the 
correct type when you capture or import your media. 
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Anamorphic A checkmark in this column indicates the media is anamorphic. You can 
also set this property to force a clip to be widescreen.

For clips, this property is based on the capture preset; for sequences, 
it’s based on the sequence preset. For imported DV clips, Final Cut Pro 
automatically detects whether the clip was captured anamorphically.

This property can be set or changed in the Browser or Item Properties 
window. For more information on anamorphic video, see Appendix D, 
“Working With Anamorphic Media,” on page 1341.

Aud Format Audio format, including the bit size and type of sound (stereo or 
mono). 

Aud Rate Audio sample rate. If you captured a DV clip with the Sync Adjust 
Movies feature enabled, the true sample rate of the clip will be 
calculated and indicated here.

Audio Indicates whether or not a clip has audio.

Aux TC 1-2 Aux 1 and Aux 2 are additional timecode tracks that can be edited for 
any clip in the Browser. These fields can be useful when your source 
material has multiple camera angle edits that weren’t originally 
recorded with synchronized timecode or for numerically synchronizing 
clips captured from multiple sources.

For example, when synchronizing audio clips captured from DAT with 
video clips captured from Digital Betacam, the source timecode of each 
clip reflects timecode that was captured on each tape. You can also set 
the Aux 1 timecode of your audio clips to reflect the source timecode of 
their corresponding video clips, offset to match the sync point. 

Capture Displays the capture state of a clip in the Batch Capture queue:  Not Yet, 
OK (captured already), Queued, or Aborted.

Comment 1-4 Displays comment information (notes you’ve added for an item after 
it’s been logged). 

You can add or change this property in the Browser or Item Properties 
window. You can rename the Comment columns in the Project 
Properties window.

Composite Shows the composite mode of the clip, such as Normal, Add, or Travel 
Matte. This controls how the colors in a clip combine with the colors in 
clips in underlying video layers, or how the clip visually interacts with 
the clip on the track immediately below it.

For more information on composite modes, see “Compositing Modes” 
on page 926.

Browser column Information provided
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Compressor Displays the codec used by a clip. For clips, this property is based on 
the clip; for sequences, it’s based on the codec specified in the 
sequence preset.

Different codecs have different ways of compressing video and audio 
clips to save bandwidth. Video clips in a sequence must use the codec 
specified in the sequence preset if you want them to play without 
rendering.

Data Rate Rate of data flow per second; a clip’s data rate is set when it’s captured.

Often, a clip’s data rate determines its visual quality. For example, the 
data rate of clips captured using the DV codec is 3.6 MB/sec. Since DV is 
a fixed data rate codec, visual quality is at its highest. Other codecs may 
use different data rates, with different resulting quality.

Description Displays descriptive text about a clip (from the Description field in the 
Logging tab of the Log and Capture window). This is typically entered 
when logging, but you can also add to it or change it in the Browser or 
Item Properties window. 

Duration Shows the duration between a clip’s In and Out points.

Frame Size Displays the video frame size in pixels. For clips, this property is based 
on the size of the clip’s frame; for sequences, it’s based on the 
sequence preset.

Good Identifies clips that are marked Good (indicating shots you want to use) 
in the Logging tab of the Log and Capture window. Clips are typically 
marked Good during logging, but you can also mark a clip in the 
Browser or Item Properties window. 

In Timecode of the In point of a clip. The In point specifies the beginning 
of a section of a clip or sequence used in editing.

Out Timecode of the Out point for a clip.The Out point specifies the end of 
a section of a clip or sequence used in editing.

Label and Label 2 You can assign label names to items to help organize and manage your 
media—None, Good Take, Best Take, Alternate Shots, Interviews, B Roll. 
Each label has an associated color, so clips and sequences with labels 
are easily identifiable in the Browser.

The label names appear in the Label columns and each item’s icon is 
colored appropriately. Label names can be changed in the Labels tab of 
the Preferences window; colors cannot be changed.

Browser column Information provided
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Last Modified Indicates the date and time an item was modified, or the last time a 
sequence was edited. This information is similar to the creation date of 
the file, or what you see when you select an item in the Finder, then 
choose Get Info from the File menu.

Length Shows the total length of a clip’s source media on disk. The length is 
different from the duration of a clip, which reflects the number of 
frames between the In and Out points of a clip (and can be changed).

Log Note Displays text from the Log Note field in the Logging tab of the Log and 
Capture window. This is typically entered when logging, but you can 
also add to it or change it in the Browser or Item Properties window.

Media Start The timecode on the source tape for the In point (when capture 
began). This timecode value represents the first frame of a clip, 
regardless of where the In point is set in Final Cut Pro.

Media End The timecode on the source tape for the Out point (when capture 
ended). This timecode value represents the very last frame of a clip, 
regardless of where the Out point is set in Final Cut Pro.

Offline A checkmark indicates a clip is offline, meaning it hasn’t been captured 
yet or the source media on disk is missing or has been moved.

Pixel Aspect Displays the pixel type of the source media—non-square for NTSC and 
PAL video or square for multimedia and HDTV video. This property is 
determined by the capture preset and your third-party capture card (if 
one is installed).

Reel Identifies a clip’s reel number (specified in the Logging tab of the Log 
and Capture window). This is typically entered when logging, but you 
can also change it in the Browser or Item Properties window. Changing 
the reel number of a clip also changes the reel number of its source file 
on disk.

Reverse Alpha This property can be set to Yes or No. Selecting Yes places a checkmark in 
the column, indicating the alpha channel is set to the reverse of the 
current setting. Reverse Alpha compensates for graphics and video files 
imported from other applications that display the solid and transparent 
areas of an alpha channel as the reverse of how Final Cut Pro displays 
them.

Scene Identifies a clip’s scene (specified in the Logging tab of the Log and 
Capture window). You can enter this when logging or in the Browser or 
Item Properties window. 

Browser column Information provided
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About Icons in the Browser

Icons appear next to the name of each item in the Browser and represent the item’s file type.

Shot/Take Identifies a clip’s shot or take, which is entered in the Logging tab of 
the Log and Capture window. It can also be added or changed in the 
Browser or Item Properties window. 

Size Shows the file’s size on the hard disk in megabytes (MB).

Source Shows the directory path of the source media file on disk. For example:
Capture Disk: Capture Scratch: Interview Clip.mov

TC Timecode currently displayed in the Viewer; can be the source or 
auxiliary timecode.

Thumbnail Displays the first frame of the clip. You can drag to “scrub,” or move 
through, a thumbnail icon for a clip.

Tracks The total number of video and audio tracks in a clip or sequence.

Type Type of item—clip, subclip, merge clip, sequence, bin, or effect.

Vid Rate Shows the frame rate in frames per second (fps). For clips, this property 
is based on the frame rate of the file on disk, which is determined by 
the capture preset. For sequences, it’s based on the sequence preset 
and can be changed.

Browser column Information provided

Icon Name Description

Bin Similar to folders, bins are used to organize clips, sequences, and even 
other bins.

Locked bin A locked bin contains all effects except those in the Favorites bin that 
you cannot move to another bin or delete (such as those that were 
installed with Final Cut Pro).

Bin opened 
in its own 
window

A bin that’s been opened as a separate window from its project.

Sequence An edited series of clips and edit information.
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Clip A media file. A clip can be an individual section of a video or graphics 
file, other imported content, or a merged clip (a clip created by 
merging an audio and a video clip).

Audio clip A media clip composed of audio samples; can be any kind of audio 
clip, including QuickTime, AIFF, or Wave.

Offline clip A placeholder clip that references media not yet captured or source 
media that’s missing from your hard disk.

Video 
transition

Transition effect; applied to a video track between any two overlapping 
video clips.

Audio 
transition

Transition effect; applied to an audio track between any two 
overlapping audio clips.

Video filter Effects filter applied to a video clip.

Audio filter Effects filter applied to an audio clip.

Video 
generator

Effects utility that generates color mattes, gradients, tones, and text.

Subclip A segment of a clip defined by In and Out points. Any number of 
subclips may reference one master clip (and therefore one source 
media file on your hard disk). Subclips exist in the Browser inside 
other clips and can be viewed hierarchically.

Marker A reference point in a clip; used to denote areas of special interest. 

Icon Name Description
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Working With Projects
To start working, you must create a new project in the Browser. You can have multiple 
projects open in Final Cut Pro, each with its own tab in the Browser. 

How you use and organize your projects depends on what you’re working on, as well as your 
work style. Typically, you create a new project for each program you work on. For example, if 
you’re working on a documentary and a training piece for different clients that use 
completely different media, it makes sense to create two separate projects.

On the other hand, if you’re cutting two different programs using the same media, it makes 
sense to keep everything together in one project file and create multiple sequences for your 
different edits. For example, you may use the same material to edit together a thirty-second 
version and a two-minute version of the same public service announcement video. Your 
footage would be in one project, but you’d create two sequences, one for each version.

Performance issues may also come into the picture. If the performance of your computer 
slows when using Final Cut Pro and you have a large number of clips and render files in your 
current project, you may want to divide your project into two or more smaller projects using 
the Media Manager (see “Using the Media Manager” on page 859). Reducing the size of the 
project can save time and help you keep better track of your work.

Creating and Saving Projects

When you create a new project in Final Cut Pro, a new blank sequence is automatically 
created and named Sequence 1. You can change the sequence name to better reflect its 
content or the type of program you’ll be working on. The new sequence is based on settings 
specified in your current Easy Setup. (To see these settings, choose Sequence Settings from 
the Sequence menu.)

As you work in new projects, you capture and import clips and edit them into one or more 
sequences. You can also set and save preferences to customize the way you work in 
individual projects and sequences.
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To create a new project:

m Choose New Project from the File menu. 

A new, untitled project appears in the Browser with an empty sequence. You can name the 
project when you save it.

To save a project:

m Select the project’s tab in the Browser, then choose Save Project from the File menu, or 
press Command-S.

If you haven’t named the project yet, a dialog box appears where you can enter a name 
and choose a location for the project.

To save all open projects:

m Choose Save All from the File menu, or press Option-S.

If you haven’t named a project yet, a dialog box appears where you can enter a name and 
choose a location for the project.

A new sequence is
automatically created

when you create a
new project.

This is your
new project.
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Automatically Saving Projects

Final Cut Pro can automatically save backup copies, or autosave versions, of all open projects 
as you work. The autosave version includes all changes made to the project since the last 
autosave file was created. 

The autosave file is stored in the same folder as your project file and has a filename in 
this form:  Project name-auto. For example, an autosave version of Dance Project is called 
Dance Project-auto.

Backing Up Project and Media Files

Make sure you back up your project files frequently on your computer’s hard disk or 
on separate removable media. If anything happens to your project file, it’s important 
to have a backup version. It’s also a good idea to back up any graphics or audio files 
you may be using in your project that weren’t captured using device control, because it 
is very difficult to capture exactly the same clip with the same In and Out points 
without device control.

If you’re using device control, you can recapture any clips you captured from tape 
because information about the clips is saved in your project file. This file also contains 
the many hours of editing that you’ve put into your program. As long as you’re using 
device control, if you delete your video clips, they can be easily recaptured. However, 
it’s very important not to inadvertently delete or lose your project file.

Get into the habit of saving frequently. If you think you’ll forget, you can use 
Final Cut Pro’s autosave feature. For more information, see “Automatically Saving 
Projects” on page 175.
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Turning the Autosave Feature On and Off

The autosave feature does not save changes to your original project file until you choose the 
Save command. When you do, the autosave file is discarded and your project file is the only 
version until the next autosave version is created.

Note:  If you’re working on exceptionally long projects that are time-consuming to save, you 
may want to disable the autosave feature to prevent unwanted interruptions to your workflow.

To turn the autosave feature off or on:

1 Choose Preferences from the Edit menu, then click the General tab.

2 Click the checkbox next to “Automatic Save Every:”

3 Enter a number of minutes to set how often a new autosave file should be saved. 

You can set the time interval between 1 and 60 minutes.

Opening Autosave Files

If something causes your computer to shut down while you’re working on a project and the 
autosave feature is on, you’ll see two versions of your project when you restart—the original 
project file (which was modified the last time you chose Save Project or Save All) and the 
autosave version. Autosave files are saved in the source project’s folder in the Finder or in 
the Document folder of the currently selected scratch disk.

m If you open the original project file:  A message appears asking if you want to open the 
newer autosave version. 

m If you open the autosave version, it takes the place of your original project file 
automatically (if you save it). The autosave version is not deleted until you save over 
the original project by choosing the Save Project or Save All command. 

m If you don’t open the autosave version, you can open your original project file, which 
is in the same state as the last time you saved it. 

m If you open the autosave version of your project file:  Final Cut Pro treats it as a separate 
project, leaving your original project file unchanged.

Enter a number to set 
the autosave time.

An X in this
box indicates
the autosave
feature is on.
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Opening and Closing Projects

You can open and work on more than one project at a time. When you finish working and 
quit Final Cut Pro, a message appears for each open project, asking if you want to save your 
changes. The next time you open Final Cut Pro, all projects that were open at the end of your 
last session automatically open.

To open a project:

1 Choose Open from the File menu. 

2 Locate and select the project file, then click Open.

If you created the project in a previous version of Final Cut Pro, you’ll be asked if you want to 
update your project. For more information, see “Updating Projects Created With a Version 
Earlier Than Final Cut Pro 2” on page 163.

To close a project:

1 Click the project’s tab to bring it to the front.

2 Do one of the following:

m Choose Close Project from the File menu.

m Control-click the project’s tab, then choose Close Tab from the shortcut menu.

m Press Control-W.

To switch between
projects, click a

project’s tab.

Control-click the tab 
and choose Close Tab.
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3 If you’ve modified the project and haven’t saved it, a message asks you to save changes to the 
project. Click Save.

To close all open projects:

m Close the Browser. 

Any projects that have their own window (because you dragged the project’s tab out of the 
Browser) remain open.

Viewing and Changing the Properties of a Project

Each project has a set of properties, including timecode display, render qualities, and 
Comment column headings, that apply to all sequences in the project. You can change these 
properties at any time.

To view or change the properties of a project:

1 Click the project’s tab, then choose Project Properties from the Edit menu.

2 Choose or enter your options, then click OK.

m Time Display:  Choose whether to view time in timecode or frames.

Click here to modify the
render quality levels.

Choose a time
display option.

You can change the 
Comment column headings 
shown in the Browser.
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m Comment Column Headings:  Enter customized headings that appear as column 
headings in the Browser.

m Edit Render Qualities:  Click here to modify the render quality levels for the project. 

The render quality influences the time it takes to render and the quality of the rendered 
result. Final Cut Pro has four default render quality levels that you can adjust to suit the 
needs of your project. For more information, see Chapter 23, “Rendering,” on page 1065.

Working in the Browser 
The Browser is where you organize all of your media and projects. You can place items in 
projects into bins, or folders, to organize them. Within the Browser, you can copy, move, 
delete, and sort items. You can also customize the display of the Browser to suit your 
project’s individual needs.

Before you can work with items in the Browser, you must make the Browser the active window.

To select the Browser and make it active:

m Click anywhere in the Browser.

m Press Command-4.

Selecting Items in the Browser

There are several ways to select single or multiple clips or bins. Selected clips or bins 
are highlighted.

To select a single clip:

m Click an item.

A selected clip
is highlighted in

the Browser.
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To select a group of adjacent clips:

m Select an item, press and hold the Shift key, then click the last item. The first and last 
items are selected, along with all items in between.

m Drag over multiple clips.

To select multiple, nonadjacent clips:

m Press and hold the Command key while clicking multiple items.

Select the first clip.

Then press the Shift
key while selecting

the last clip.

Drag across multiple
items to select them.

Select the first clip.

Then press the
Command key while
selecting other clips.
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Navigating Within the Browser Using the Keyboard

To navigate within the Browser:

m Press the Up and Down Arrow keys to move up and down in a list of items or in icon view. 

m Press the Right and Left Arrow keys to move horizontally between items in icon view.

m Press Tab to move between items alphabetically. (Press Shift-Tab to move backward.)

m Type the first few letters of an item’s name.

Opening Bins in the Browser

To open bins in list view:

m Press the Right Arrow key. Press the Right Arrow key again to select the first item in a bin. 
(Press the Left Arrow key to close a bin.) 

m Click the disclosure triangle to the left of the bin you want to open. Click it again to close 
the bin.

To open bins in large or small icon view:

m Select the bin, then press Return or Enter. 

m Double-click a bin.

You must click to select a bin to navigate within it.

Copying and Deleting Items in the Browser

To copy an item:

m Select the item, then hold down the Option key while you drag the item to a new bin or 
to the Name column heading.

Click the triangle to
show the contents

of a bin.

Hold the Option key 
while you drag the item 
to the Name column 
heading or to a new bin.
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m Press Option-D to duplicate the selected item.

m Select an item, choose Copy from the Edit menu, then choose Paste from the Edit menu.

Note:  For the first two methods, the item is copied and “Copy” is appended to the item 
name. For the third operation, the copy has the same name as the original item.

To delete a clip, sequence, or bin from a project:

m Select the item, then press Delete.

m Control-click the item you want to delete, then choose Cut from the shortcut menu.

Note:  Deleting a clip from a project does not delete it from any sequences it’s in or from 
your hard disk.

Renaming Clips, Sequences, and Bins

You can rename items within Final Cut Pro. Renaming clips, sequences, and bins only 
changes the filenames in the project. It does not change the names of source media files on 
your disk. 

To rename clips, sequences, and bins within Final Cut Pro:

1 Select the desired clip, sequence, or bin.

2 Click the item’s name, then type a new name.

If you rename a file in the Finder that is used by Final Cut Pro, the clip will go offline because 
Final Cut Pro loses the link to that file. To make sure renamed files remain online, you need 
to relink the source media and the files in your project. For more information, see “About 
Links Between Clips and Source Media” on page 214.

A copy of the item
is created that you

can rename.

Enter a new name for the 
item in the name field.
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Sorting Items in the Browser

You can sort clips, sequences, and bins in a project by any column. By default, items are 
sorted by the Name column. You can refine a sort by sorting additional columns. For 
information on how Final Cut Pro sorts names of clips, see “How Final Cut Pro Sorts 
Filenames” on page 184.

To sort items in the Browser:

1 Click a column heading to sort by it.

The heading of the primary sort column contains a green arrow whose direction indicates 
the sort order:  down for descending (the default) and up for ascending.

2 To switch between descending and ascending sort order, click the green arrow.

3 To sort by secondary columns, Shift-click additional column headings.

4 To switch between descending and ascending sort order in the secondary columns, click the 
light blue arrow.

If you inadvertently select the wrong secondary column or too many secondary columns, you 
can clear all secondary sort columns by choosing a new primary sort column. Then select any 
other secondary sort columns.

A green arrow indicates 
the primary sort column 
and the sort order.

A light blue arrow indicates 
a secondary sort column 
and the sort order.

Items are further sorted
using a secondary

sort column.
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Using Bins to Organize Your Clips
You can organize the files and sequences in a project into bins, which are similar to folders. 
This creates a logical structure for your projects, making your media easier to manage. 

Bins exist only in project files. Changes you make to the contents of a bin, such as deleting, 
moving, and renaming clips or renaming the bin itself, have no effect on the original files or 
folders on disk where the source material is stored. If you delete a clip from a bin, it is not 
deleted from the disk. Likewise, creating a new bin does not create a new folder on your disk. 

How Final Cut Pro Sorts Filenames

The Browser sorts clip names in numerical order on computers using Western-
language script systems (English, French, and German). Keep this in mind when you 
are naming your clips, so they sort in the desired order. 

In versions earlier than Final Cut Pro 1.2.5, you needed to insert a leading zero in a 
clip’s name to guarantee a sort in numerical order. Otherwise, numbered items came 
out in a rather odd order based on the first digit of the number, rather than the entire 
number.

If items in the Browser consist only of Roman low-ASCII characters (values of 32–126) 
followed by a number, they are sorted in numerical order, taking the value of the 
ending number into account. For all other text, alphabetic-only sorting is used. 

m Previous way of sorting:  Clip 1, Clip 100, Clip 30, Clip 5

m Current way of sorting:  Clip 1, Clip 5, Clip 30, Clip 100

Because the new sorting method requires Western-language script systems, clip names 
in systems using double-byte fonts (such as Kanji) still need a leading zero in the name 
to sort in numerical order.

Bins help you organize
media in your projects.
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Creating New Bins

You can create separate bins for different stages of your project or to separate your original 
and production footage. You can organize bins hierarchically and open them in their own 
windows. You can even put bins inside other bins.

To add a new bin to a project:

1 In the Browser, click the project tab where you want to add a bin.

2 Do one of the following:

m Choose New from the File menu, then choose Bin from the submenu. 

m Control-click the Name column, then choose New Bin from the shortcut menu.

3 Enter a name for the new bin.

Opening and Closing Bins

To preserve screen real estate or avoid scrolling in the Browser, it’s useful to open a bin in its 
own window. 

Control-click anywhere 
in the Name column to 
see the shortcut menu.

Enter a name for the bin.
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To open a bin in its own window:

m Double-click the bin.

To close a bin that’s open in its own window:

m Control-click the bin’s tab, then choose Close Tab from the shortcut menu.

m Make sure the bin is the active window, then press Control-W.

m Click the close box of the bin window.

The bin appears in
its own window.

The icon for this bin in the 
Browser indicates the bin is 
open in its own window.
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For easy access to a bin, you can create a tab for it in the Browser.

To create a Browser tab for a bin:

1 Double-click a bin to open it in its own window.

2 Drag the bin’s tab from the bin window to the top of any column heading in the Browser.

To close a bin’s tab and move it back into a project:

m Control-click the tab, then choose Close Tab from the shortcut menu.

 

m Make sure the bin is the active (frontmost) tab, then press Control-W.

m Drag the bin’s tab out of the Browser, then click the close box to close the bin’s window.

Drag the bin’s tab to a column 
heading in the Browser.

The bin now has its
own tab in the Browser.
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Moving Items Between Bins

As you work on your project, you can reorganize clips and move them into different bins. 
Moving clips within bins has no effect on the original files or folders on disk where the 
source material is stored.

To move items between bins in list view:

m Select the desired items, then drag them to a bin. (The bin can be open or closed.)

m If the bin has its own window, drag items to that bin’s window.

To move an item to the top level of a project:

m Drag the item to the Name column heading.

The clip “Jumptown”
is moved to the

Swing bin.

You can also move
items into separate

bin windows.
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Using Labels to Organize Your Clips

You can use labels to organize your clips. If you assign labels to clips, you can easily sort clips 
by type. You can assign five labels to clips in the Browser, each with an associated color and 
name. When you choose a label for a clip, that clip’s icon becomes the color of that label and 
that label’s name appears in the Label column. 

Label names are Good Take, Best Take, Alternate Shots, Interviews, B Roll, and None. You can 
change these names so they’re more appropriate for your project. There are two Labels 
columns, Label and Label 2. Both columns are displayed only when you have Standard Columns 
selected in the Browser.

If you click the heading of the Label column, all labeled clips are sorted by this order, with 
unlabeled clips appearing underneath.

Note:  You can’t assign labels to bins. 

To assign a label to a clip in the Browser:

Do one of the following:

m Select a clip, choose Item Properties from the Edit menu, click the Logging Info tab, then 
choose the desired label.

m Control-click in the Label column of the clip, then choose a label from the shortcut menu.

m Control-click a clip, choose Label in the shortcut menu, then choose the desired label in 
the submenu.
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To assign a label to multiple clips at once:

1 Select the desired clips in the Browser (see “Selecting Items in the Browser” on page 179).

2 Do one of the following:

m Control-click one of the selected clips, choose Label from the shortcut menu, then 
choose the desired label in the submenu.

m Control-click in the Label column of one of the selected clips, then choose a label from 
the shortcut menu.

To customize label names:

1 Choose Preferences from the Edit menu, then click the Labels tab.

2 Click a label to highlight it, type a new name, then click OK.

All clips using that label now display the renamed label in the Label column.

Select the clips
you want to label.

Then Control-click 
in the label column 
and choose a label.

Click a label, 
then enter the 
desired name.
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Customizing the Browser Display
By default, Final Cut Pro displays items in the Browser in list view. If you want to organize 
your clips visually, you can set the Browser to display your clips as small or large icons. 

In list view, you can work quickly and see a lot of information. Clips and bins appear in an 
easy-to-access hierarchy, allowing you to easily store and move items between bins in a project.

List view (default)

Small icon view

Large icon view
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In large icon view or list view, you can scrub, or move through, clips. This lets you get a quick 
visual idea of a clip without opening it.

To display Browser items as icons or in a list:

m Choose Browser Items from the View menu, then choose an option from the submenu.

m Control-click in the Name column (or any place in the tab other than an icon), then 
choose a view option from the shortcut menu.

m Press Shift-H to switch between all three views.
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Working With the Browser in List View

When items are displayed as a list, the Browser displays information about the items in 
columns. You can customize these columns several ways:

m rearrange, resize, hide, and show individual columns

m sort columns

m view a predefined set of standard columns or a set of columns designed for logging

m change the Comment column headings

m display, hide, and scrub (move through) thumbnails of clips

To rearrange a column:

m Drag the column heading to the new location.

To resize a column:

m Drag the right edge of the column heading to the desired width.

To hide a column:

m Control-click the column heading, then choose Hide Column from the shortcut menu.

As you drag a column, the 
pointer changes to a rectangle.

The pointer between two columns 
changes to a Resize pointer, 
indicating a column can be resized.

You can’t hide the
Name column; it’s
always displayed.

Control-click a column heading, 
then choose Hide Column.
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To display a hidden column:

m Control-click the column heading to the right of where you want to display the column, 
then choose the column you want to display from the shortcut menu.

To display thumbnails:

m Control-click any column heading other than Name, then choose Show Thumbnail from 
the shortcut menu.

A thumbnail column appears with images for all video clips.

Control-click a column 
heading, then choose the 
column you want to display.

Control-click a column heading, 
then choose Show Thumbnail 
from the shortcut menu.

Thumbnails appear as small 
images of your video clips.
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When thumbnails are shown, the first image is the start of the clip or the In point of the clip, 
if one is set. You can scrub a thumbnail by dragging in the image, but the frame shown in the 
Browser always reverts to the start or In point of the clip.

You can change the starting image (called the “poster frame”) if you want to display another 
frame in the thumbnail. For more information, see “Setting the Poster Frame” on page 199.

To hide thumbnails:

m Control-click the Thumbnail column heading, then choose Hide Column from the 
shortcut menu.

To scrub, or move through, a thumbnail:

m Drag the thumbnail image in the direction you want to view.

You can also scrub clips that are displayed in large icon view (see “Working With the Browser 
in Icon View” on page 196).

To change the names of the Comment column headings:

1 Control-click a Comment column heading, then choose Edit Heading from the shortcut menu.

The thumbnail you’re 
scrubbing is highlighted.
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2 Type a new name in the column name field, then press Return.

The Comment column headings are the only column headings you can change. Once you 
customize the name of a Comment column, it remains changed in that project file, even if 
you hide it. New projects you create use the original names.

If you want to change several Comment headings at once, use the Project Properties window. 
For more information, see “Viewing and Changing the Properties of a Project” on page 178.

Working With the Browser in Icon View

In large or small icon view, you arrange your clips graphically in the Browser. Video clips are 
displayed as a thumbnail of the starting frame of video; audio clips are displayed as a speaker; 
and bins are indicated by a folder icon. If a video clip has an audio track, a small speaker icon 
appears inside the clip’s thumbnail.

You can use different views for open Browser windows and tabs. For example, you can keep 
the main tab of your project in the Browser in list view for organizational purposes, but open 
bins in their own window or tab using large icon view to quickly identify clips visually.

Enter the new 
column name.

Thumbnails of
clips for icon views

Audio clip

Video clip

Video clip with audio
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Scrubbing Clips in Icon View

In large icon view, you can scrub, or move through, video clips to see their content. You can 
also scrub thumbnails of clips displayed in list view (see “Working With the Browser in List 
View” on page 193). However, you don’t have some of the same options you have in large 
icon view. 

Note:  You can’t scrub clips in small icon view.

To scrub clips in large icon view:

1 Do one of the following:

m Select the Scrub Video tool in the Tool palette. 

 

Note:  When the Scrub Video tool is selected, you can hold down the Shift or the Command 
key to temporarily make the Selection tool active to select, open, or move clips.

m With the Selection tool chosen, press Control-Shift to temporarily make the Scrub Video 
tool active.

Selection tool

Select the Scrub Video tool.
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2 Drag the Scrub Video tool over the thumbnail.

Automatically Arranging Clips in Icon View

When you’re in icon view in the Browser, you can move icons around. You can use the 
Arrange command to automatically arrange your icons from left to right in alphabetical order, 
within the current width of the Browser or bin window. This is useful if the Browser or a bin 
window has overlapping icons or if you have to scroll to see icons.

To neatly arrange items displayed as icons:

m Choose Arrange from the View menu.

m Control-click in the Browser, then choose Arrange from the shortcut menu.

Move right to scrub forward; 
move left to scrub backward.

Before using the 
Arrange command
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Setting the Poster Frame

When thumbnails of clips are displayed in large or small icon view, the first frame shown is 
typically the start of the clip or the clip’s In point, if one is set. Although you can scrub, or 
move through, a thumbnail, the image shown in the Browser always reverts to the start or In 
point of the clip. However, this frame may not help you distinguish the actual contents of clips.

In Final Cut Pro, you can specify the image that you want to appear as the first frame in a 
thumbnail, called a “poster frame.” Specifying a poster frame can help you visually distinguish 
clips, particularly if many of your clips start with a countdown or slate or if they include extra 
footage because you added handles during the capture process. For example, you can set a 
poster frame to the actual start of a scene so you can quickly see which clip contains a particular 
scene or shot. You can select the poster frame for a clip in the Browser or the Viewer.

To set the poster frame in the Browser in large icon view:

m Scrub a clip until you get to the desired frame, press and hold the Control key, then 
release the mouse button.

After using the 
Arrange command

The poster frame is 
now set to the last 
frame you scrubbed to.

Original 
poster 
frame
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To set a poster frame in the Viewer:

1 Double-click a clip in the Browser to open it in the Viewer.

2 In the Viewer, move the playhead to where you want the poster frame.

For more information, see “Navigating in the Viewer” on page 352.

3 Choose Set Poster Frame from the Mark menu.

Original poster frame for 
the clip in the Browser.

Move the playhead to
the image you want
as the poster frame.

The poster frame is set to the 
desired frame of the clip.
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Working With Standard or Logging Columns

Final Cut Pro has two preset arrangements of columns, standard and logging columns.

m Standard columns:  Choose this set to see most of a clip’s properties as you edit and 
work with clips in the Browser.

By default, the standard columns are displayed in this order:  Duration, In, Out, Media 
Start, Media End, Tracks, Good, Log Note, Label, Label 2, Audio, Frame Size, Vid Rate, 
Compressor, Data Rate, Aud Rate, Aud Format, Alpha, Reverse Alpha, Composite, Pixel 
Aspect, Anamorphic, Description, Scene, Shot/Take, Reel, Comment 1, Comment 2, 
Offline, Timecode, Last Modified.

m Logging columns:  Choose the Logging Columns option when logging clips so you can 
see all of the logging information and the Browser isn’t cluttered with unnecessary 
columns of information. 

By default, the logging columns are displayed in this order:  Media Start, Media End, In, 
Out, Duration, Good, Capture, Description, Scene, Shot/Take, Reel, Log Note, Comments 
1–4, Pixel Aspect, Anamorphic, Vid Rate, Frame Size, Aud Rate, Aud Format, Compressor, 
Data Rate.

You can customize both sets of columns, displaying, hiding, and reordering columns in any 
way you like. Any modifications you make are remembered for the column layout you’re 
using for that project. New projects you create use the default columns.

Note:  For a description of column information, see “About Browser Columns” on page 167.

To switch between standard and logging columns:

m Control-click any column heading in the Browser, then choose Standard Columns or 
Logging Columns from the shortcut menu. 

Choose the column arrangement 
you want to display. 
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Performing Searches in the Browser
In Final Cut Pro, you can use the Find command to search for items in a project by any property 
or combination of properties. You can also limit your search to the kind of media—all, used, or 
unused media. You can manipulate the search results and show or delete found items.

The simplest search for a clip is by name, but you can also search for clips by other fields, 
such as timecode or file type. You can search in all open projects or restrict your search to a 
single project, or tab, in the Browser. 

Note:  Searching is a good way to find all of the unused media in your project.

About Search Options

Before you start your search, familiarize yourself with the numerous options that are available 
in the Find dialog box.

Search scope

Search criteria

Click here to 
specify more 
search options.

Additional search
criteria after clicking the

More button
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Options for Defining the Scope of a Search

m Search:  Choose an option from the pop-up menu to specify which open projects or 
folders you want to search—All Open Projects, Effects, or the current open project.

m For:  Choose an option from the pop-up menu to specify what kind of media you want to 
search for—All Media, Unused Media, or Used Media.

m In Selected Sequences:  Click this checkbox to search in the selected sequences only.

m Results:  Choose an option for what you want to do with the search results.

m Replace Find Results:  Choose this to replace the results of a previous search.

m Add to Find Results:  Choose this to add the results of the current search to any 
previous search.

Options for Defining the Criteria of a Search

m More:  Click this to add another search level to further refine your search. 

m Less:  Click this to remove extra search levels.

m Match:  Choose an option from the pop-up menu.

m All:  Finds clips that match all criteria.

m Any:  Finds clips that match any single criterion.

m Omit:  Click this checkbox to omit certain criteria or items from your search.

m Column:  Choose a specific column to search in this pop-up menu.

m Contains:  Choose a search option to narrow your search—Starts With, Contains, Equals, 
Ends With, Less Than, or Greater Than. 

For example, you may have some clip names that end in “birds,” while others begin with 
“birds.” To find only the clips that end in “birds,” choose Ends With.

m Text field:  Enter the desired search criteria.

Search Commands

m Find Next:  Click this to search for the next item that matches your search criteria. Once an 
item is found, press Option-G to continue the search in your currently selected bin.

m Find All:  Click this to search for all items that match your search criteria. This will place 
all found items into a results window.
  Using the Browser and Managing Projects and Clips 203



Searching for Items in the Browser

You can search in all open projects or restrict your search to a single project, or tab, in 
the Browser.

To search for a single item in the Browser:

1 Choose Find from the Edit menu.

You can also make the Browser active, then press Command-F.

2 Enter your search criteria, then select your search options.

For more information, see “About Search Options” on page 202.

In the above example, we’re searching the Tutorial Project 1 for all used media in the sequences 
we’ve selected. 

3 Click Find Next.

The found item is highlighted in the Browser. Press Option-G to continue your search in the 
same bin.

Specify your
search criteria.

Then click here.

The found item is
highlighted in the

Browser.
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You can also do a search to find multiple clips all at once. For example, if you want to find all 
of the unused clips in your project so you can mark them for future use, you can use this as a 
criterion for your search.

To search for multiple items in the Browser:

1 Choose Find from the Edit menu.

2 Enter your search criteria, then select your search options.

For more information, see “About Search Options” on page 202.

3 Click Find All.

A list of found items is displayed in the Find Results window. You can search and manipulate 
items that you’ve found. In this case, you’ll see all the items that aren’t currently edited into a 
sequence. For more information, see the next section, “Manipulating Items in the Find 
Results Window.”

Specify your
search criteria.

Then click here.
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Manipulating Items in the Find Results Window

When you do a search on multiple items, Final Cut Pro compiles the list of found items in the 
Find Results window. Items in this window are references or pointers to the clips in the Browser.

The Find Results window works much like the Browser, and you can do many of the 
same operations:

m delete found items from a project

m move or copy found items to another location in the Browser

m sort and display found items

m edit found items into a sequence

m perform additional searches and combine the results

m modify information in Browser columns for found clips

For example, you can set the Good column to Yes for all unused clips found. You can also 
assign the same label to a group of clips.

To modify information in a column for a group of found clips:

1 Perform a Find All search.

See “Searching for Items in the Browser” on page 204.

2 In the Find Results window, press Command-A to select all items in the window.

3 Control-click in the column you want to modify, then choose a new option. 

Control-click in a 
column, then choose 
the desired setting or 
information.
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To see where found items are in the Browser:

m Select the desired items, then click Show in Browser.

To delete found items:

m Select the desired items, then click Remove from Project.

Note:  This deletes the items from the project only, not from your hard disk.

To search for items within the Find Results window:

1 With the Find Results window active, choose Find from the Edit menu.

2 Enter your search criteria, then select search options.

For more information, see “About Search Options” on page 202.

3 Click Find All or Find Next.

A new Find Results window appears with your search results.

Then click here.

Select items you want
to see in the Browser.

Then click here.

Select the items
you want to delete.
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Viewing and Changing the Properties of a Clip
Each item in the Browser, such as a clip, has a set of associated properties. You can view all 
the properties of a clip in the Item Properties window. Some properties are also displayed in 
columns in the Browser. Some properties can be changed directly in the columns of the 
Browser; others can be changed in the Item Properties window. 

Some properties, such as the frame size or video rate, are determined by the selected preset 
in the Easy Setup and cannot be changed unless you change the preset (see Chapter 5, 
“Working With Easy Setups, Presets, and External Video Settings,” on page 99).

Changing Clip Properties in the Browser

Changing properties in a Browser column lets you easily change information without 
opening clips or other windows. For example, you can clear the In or Out point of a clip or 
enter a comment in one of the Comment columns. 

Properties in some columns can be changed in groups. If you want to change multiple 
properties of a clip or change properties for several clips at one time, it’s easier to use the 
Item Properties window. For more information, see “Viewing and Changing Clip Properties in 
the Item Properties Window” on page 210.

To change a clip’s properties in a Browser column:

m Select a clip, click a column, then enter the new information in the text field.

If a text field doesn’t appear when you click a column, the property cannot be changed 
directly in the Browser; you need to open the Item Properties window.

Enter the desired 
information.
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m Control-click a column for the clip or sequence you want to change, then choose an 
option or setting from the shortcut menu.

You can select multiple clips and change them all at once. Some columns that allow you to 
do this are the Good, Description, Pixel Aspect, Reel, and Anamorphic columns. 

To change the properties of multiple clips in a Browser column:

1 Select the desired clips.

For more information, see “Selecting Items in the Browser” on page 179.

2 Control-click the column of one of the selected clips, then choose a new setting or option 
from the shortcut menu.

Information for all clips is changed.

Control-click a column, 
then choose an option 
from the shortcut menu.

Information for all selected 
clips is changed.
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Viewing and Changing Clip Properties in the Item Properties 
Window

The Item Properties window provides you with information on an individual clip. Three tabs 
in this window—Format, Timing, and Logging Information—allow you to view or change 
various properties of a clip.

To view and modify clip properties:

1 Select a clip in the Browser or Timeline, or double-click a clip to open it in the Viewer.

2 Do one of the following:

m Choose Item Properties from the Edit menu.

m Press Command-9.

3 Click a tab and if desired, modify properties.

Format Information for a Clip

The Format tab provides information on a clip’s location, file size, and format characteristics. 
If you’ve changed the name of a clip and removed the original source media files, you can 
use the information in this tab to determine the original media and its location.

Many of the properties are based on the settings in the sequence or capture preset.

m Source File:  This specifies the path of the source media file on your hard disk.

m File Size:  This specifies the disk space used by the entire source media file.
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The items on the left are determined by the sequence preset or capture preset and cannot 
be changed in this window.

Video Items

These properties can be changed in the Item Properties window.

m Field Dominance:  The field dominance selected here helps Final Cut Pro determine how 
to play back this clip, as well as how to process it for effects and compositing. It is set to 
Unknown by default, relying on the codec selected in the capture preset for this 
information. Choosing another option overrides what the codec specifies.

m Alpha Type:  Selects the method Final Cut Pro uses to enable the alpha channel of a video, 
animation, or graphics clip. Alpha channels determine transparency in a clip. For more 
information, see “Using Video and Graphics Clips With Alpha Channels” on page 918.

m Reverse Alpha:  Reverses the alpha channel of the video clip. This may be useful if you’re 
importing a clip from a system that reverses 100% white and 100% black in the alpha 
channel track.

m Composite Mode:  Selects the mode to use when compositing the video clip. The 
composite mode determines how this clip visually interacts with other clips in adjacent 
tracks. For more information on composite modes for effects work, see Chapter 21, 
“Compositing, Applying Motion Effects, and Using Keyframes,” on page 907.

m Pixel Aspect Ratio:  Choose an aspect ratio for your sequence from this pop-up menu. 
Standard definition (SD) video for playback on television is non-square; multimedia video 
for computer playback is square. This information allows Final Cut Pro to make 
adjustments as clips are edited into your sequence, particularly if you edit media with 
different pixel aspect ratios. 

m Anamorphic 16:9:  Check this box if your clip was shot using anamorphic 16:9. If this 
option is not selected, your anamorphic 16:9 video will be sized into a 4:3 frame and will 
look distorted.These options are not available once a clip has been edited into a 
sequence. For more information on shooting and editing 16:9 video, see Appendix D, 
“Working With Anamorphic Media,” on page 1341.
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Timing Information for a Clip

The Timing tab provides information on the timing, including duration and speed, of a clip.

Clip

This section specifies the total media length, the location of the In and Out points, and the 
duration of the clip. The following properties can only be changed if the clip is in the 
Browser; if you copied it directly into the Timeline, you cannot change these properties.

m In:  Enter or modify the timecode for the In point of a clip.

m Out:  Enter or modify the timecode for the Out point of a clip.

m Duration:  Enter or modify the desired duration of a clip.

Speed

This section specifies the current speed and frame blending status for a clip.

Media

m Length:  The total duration of a clip’s media on the hard disk.

m Start:  The start timecode of a clip’s media on the hard disk.

m End:  The end timecode of a clip’s media on the hard disk.
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Logging Information for a Clip

The Logging Info tab shows the logging information for a clip. This is set when you log and 
capture the clips. However, you can change this information at any time, which may be 
helpful if you decide to recapture clips later.

m Reel:  Enter or modify the name of the source tape for the clip.

m Description:  Enter or modify the description of the clip.

m Scene:  Enter or modify descriptive detail for a clip.

m Shot/Take:  Enter or modify tracking information.

m Capture:  Specify the status of the clip (Not Yet, Captured, or Queued).

m Label and Label 2:  Enter or modify the labels associated with this clip.

m Log Note:  Enter or modify a log note.

m Mark Good:  Click the Mark Good checkbox to mark the clip Good.

m Comments 1–4:  Enter or modify comments for the clip in these fields. If you customized 
Comment column names in the Browser, your changes do not appear here.
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About Links Between Clips and Source Media
There are links between the clips used in the Browser and in sequences and their associated 
source media files on disk. Links are based on the location of the source media on your 
computer’s hard disk and on the names of your files. If you move your source media files on 
disk, change their names, or put them in the Trash, the links break and these clips in your 
project become offline clips. 

Offline clips have a red slash through their icon in the Browser or their file in the Timeline. 
To view these clips properly in your project, you must recapture the clips or reconnect the 
clips to their corresponding source files at their new locations on disk. 

Final Cut Pro only shows the offline icon (a red slash through a file) for offline clips, not for 
sequences where those offline clips are used. An exception to this is if you import an Edit 
Decision List (EDL) into Final Cut Pro as a sequence. For more information, see Chapter 10, 
“Importing Edit Decision Lists (EDLs),” on page 313.

If you open a project that has offline clips, a message asks if you want to reconnect them 
immediately. However, if you know you have offline clips, you can reconnect, or relink, them 
at any time using the Reconnect Media command. 

Reconnecting Clips When You Open a Project

When you open a project, Final Cut Pro automatically detects if the links between your 
project’s clips and the corresponding source media on disk has been broken. If so, a dialog 
box displays a list of the offline clips and gives you the option to reconnect, or relink, some 
or all of these clips. If you rename, move, or delete a source file in the Finder that is used in 
the currently opened project, when you return to work in your project in Final Cut Pro, this 
dialog box also appears.

Important  If you reconnect a clip used in a sequence, make sure you reconnect both the 
clip in the Browser and the clip within the sequence.

Offline clips have a
red slash through

their icons.
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To reconnect media files:

1 Open a project file. 

If media files are missing, a dialog box appears.

Final Cut Pro indicates if the missing files are movie files or render files. 

2 If desired, click the Movie or Render button to eliminate one of the sets of files indicated in 
the list.

Choose one of these options if you deliberately discarded a set of files.

3 Click Reconnect to reconnect all of the clips in the list. (If you click OK, the clips are left 
offline and you can reconnect them at a later time.)

This section lists
which files are missing.

Click a button
to remove files

from this list.

Click here to continue 
without reconnecting.

Click here to reconnect
the listed files.
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4 Choose the type of files to reconnect, then click OK.

Final Cut Pro searches for the source media files corresponding to each offline clip in your list.

5 Choose any desired options for searching for the files.

m Show Preview:  Click this to view thumbnails of files to the left of the file list. 

m Create:  If the Show Preview option is selected, this button appears. Click the button to 
create a thumbnail for video clips and a player for audio clips.

m Show:  This determines the type of file you can choose from. 

m All Files:  You’ll see every file in the selected folder on your hard disk, regardless of 
whether or not it can be imported into Final Cut Pro. 

m Video Files, Sound Files, or Still Image Files:  You’ll see only the type of file you 
select here.
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m Show Only Files that Match Name:  Matching filenames exactly makes it easier to locate 
the file you want. This is helpful if you have many files with similar names.

m Reconnect All Files in Relative Path:  Check this option to reconnect other clips with 
broken links that are in the same folder as one that’s been found.

m Skip or Skip All:  Click these to skip clips that can’t be found or to stop the search.

m Find Again:  Click this to search for the media again within the selected folder. This is 
useful if you choose a folder yourself in this dialog box.

6 Final Cut Pro searches again based on any new criteria.

7 Choose the correct file, then click Select. 

This process continues until all clips are reconnected.

Reconnecting Clips When Your Project Is Already Open

You can reconnect, or relink, media files to reestablish links between the original source 
media and the clips or sequences where the media is used. You can do this for offline clips as 
well as online clips and render files.

To reconnect media files:

1 Select the files you want to reconnect.

For more information, see “Selecting Items in the Browser” on page 179. Press Command-A 
to select all clips in the Browser. 

2 Do one of the following:

m Choose Reconnect Media from the File menu.

m Control-click a clip or sequence, then choose Reconnect Media from the shortcut menu.

Select the files you
want to reconnect.
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3 Choose the type of files to reconnect, then click OK.

If you’ve selected a sequence, you can also reconnect your render files. 

Final Cut Pro searches for the source media files corresponding to each offline clip in your list.

4 Choose any desired options for searching for the files.

m Show Preview:  Click this to view thumbnails of files to the left of the file list. 

m Create:  If the Show Preview option is selected, this button appears. Click the button to 
create a thumbnail for video clips and a player for audio clips.

m Show:  This determines the type of file you can choose from. 

m All Files:  You’ll see every file in the selected folder on your hard disk, regardless of 
whether or not it can be imported into Final Cut Pro. 

m Video Files, Sound Files, or Still Image Files:  You’ll see only the type of file you 
select here.

Select your
reconnect options.
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m Show Only Files that Match Name:  Matching filenames exactly makes it easier to locate the 
file you want. This is helpful if you have many files with similar names. 

m Reconnect All Files in Relative Path:  Check this option to reconnect other clips with 
broken links that are in the same folder as one that’s been found.

m Skip or Skip All:  Click these to skip clips that can’t be found or to stop the search.

m Find Again:  Click this to search for the media again within the selected folder. This is 
useful if you choose a folder yourself in this dialog box.

5 Final Cut Pro searches again based on any new criteria.

6 Choose the correct file, then click Select. 

This process continues until all clips are reconnected.

Making Clips Offline

You can deliberately make a clip in your project offline. This breaks the link between the clip 
in your project and its source media file on disk. It also removes all references to that source 
media file wherever the clip is used—in sequences, duplicate clips in the Browser, and 
subclips. Making clips offline is useful if you want to delete all of your source material in 
preparation for recapturing at a higher data rate, without having to close and reopen your 
project.

To make clips and sequences offline:

1 In the Browser or Timeline, select the clips or sequences you want to make offline.
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2 Do one of the following:

m Choose Make Offline from the Modify menu.

m Control-click a selected item and choose Make Offline from the shortcut menu.

3 Choose an option in the Make Offline dialog box, then click OK.

m Leave Them on the Disk:  Click this to break the link but leave the original media files on 
your disk.

m Move Them to the Trash:  Click this to break the link and move the source media files to 
the Trash. This action is not undoable. You must empty the Trash before the files are 
actually deleted, which gives you time for second thoughts. If you decide you need the 
files again, you must drag them out of the Trash, then reconnect them using the 
Reconnect Media command.

m Delete Them from the Disk:  Click this to break the link and immediately delete the media 
files from the disk. This action is not undoable. If you need the media again, you’ll have to 
recapture it.

4 If you choose to move or delete the files, a message warns you this action cannot be undone. 
To continue, click OK.
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C H A P T E R

8

8 Logging and Capturing Media 

Before you can use video in Final Cut Pro, it must be transferred, or captured, to your hard 
disk in preparation for editing. If you’re using a device-controllable camcorder or deck, you 
can also log your media before capturing it. For more information about device control, see 
“Using Serial Device Control With Final Cut Pro” on page 34.

How This Chapter Is Organized
Logging and capturing clips to use in your project is a process that involves planning, setup, 
and care. To guide you through this process, this chapter is divided into the following topics:
m About Log and Capture

The first section (on page 222) explains some of the concepts in this chapter, including 
the log and capture process, what batch lists are for, the different video capture 
commands available in Final Cut Pro, and the difference between offline and online clips. 

m Controls in the Log and Capture Window

This section (starting on page 225) examines the different controls in the Log and Capture 
window, including the transport, playhead, and marking controls. 

m Setting Up to Log Clips

This section (on page 230) covers the many steps involved in setting up Final Cut Pro to 
log clips before capturing. It includes information on Final Cut Pro’s controls for defining 
reel and clip names and adjusting clip settings. The section concludes with an overview of 
how to calibrate the image quality and audio gain for your tapes using color bars, and how 
to make sure your timecode is accurate. 

m Logging Your Media 

Once you’ve set up Final Cut Pro for logging, this section (starting on page 251) includes 
step-by-step instructions on how to log your tapes in preparation for capture. Tips and 
techniques for streamlining this process are also included. 
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m Creating and Importing Batch Lists

Importing batch lists into Final Cut Pro gives you even more flexibility in how you can log 
clips for capture. This section (on page 258) explains how to create and import them.

m Setting Up For Capture

This section (on page 261) gives you an overview of what you need to set up prior to 
capture. Capture preferences and relevant settings in the Preferences window are covered. 

m Capturing Audio and Video

Once you’ve set up all of Final Cut Pro’s capture preferences, this section (on page 265) 
shows you how to perform the three kinds of capture operations available in Final Cut Pro. 
These operations include the Capture Now, Capture Clip, and Batch Capture commands. 

m Capturing Audio

In the last section of this chapter (on page 280), you’ll find out how to configure Final Cut 
Pro to capture audio only. 

About Log and Capture

Logging Your Tapes

Logging is the process of identifying which shots on tape you want to capture to disk for use 
in editing. You assign a name to a shot you want to capture, then use device control to get 
the timecode of the In and Out points for that shot. You can also assign a reel name to each 
tape, so you know which shots came from which tape.

These timecode numbers, along with a reel name, allow Final Cut Pro to automatically find 
your logged shots for future capture. You can also enter other information about your clips 
for use while you edit, such as shot and take numbers, notes, and markers identifying various 
parts of each logged clip. You can log as many tapes as you want at one time.

Note:  You must have a device-controllable camcorder or deck in order to log tapes with 
Final Cut Pro.
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Importing a Batch Capture List

In addition to logging clips for capture in Final Cut Pro, you can create and import a batch 
capture list. A batch list is a tab-delimited text file that contains information about clips you 
want to capture and use in your project. Increasingly, logging on the set is done using a 
computer, which makes it easy to reformat for use in Final Cut Pro. 

If you have a spreadsheet program or word processor, such as AppleWorks, you can easily 
log tapes for capture even if Final Cut Pro is not installed on your computer. Using a 
camcorder or deck that can display timecode, you can enter In points, Out points, reel 
numbers, and clip names in a list in the spreadsheet or word processor to identify the clips 
you want to capture. 

After you import a batch capture list into Final Cut Pro, your project contains a series of 
offline clips, one for each entry in the batch capture list (see “Offline and Online Clips” on 
page 224). You then need to recapture or relink the clips to the actual media. For information 
on importing batch capture lists, see “Creating and Importing Batch Lists” on page 258.

Capturing Media

Capturing is the process of getting the source media from your camcorder or deck to the 
hard disk on your computer. There are three ways you can capture video into Final Cut Pro.

m Capture Now:  Using Capture Now, you can capture live video, video from camcorders or 
decks that lack device control, or video from a device-controllable camcorder or deck. 
This command is useful for video that you capture from an analog source, such as VHS or 
Hi-8, with an analog-to-DV FireWire converter box. 

If you use Capture Now with a device that’s supplying timecode, that timecode will be 
captured along with your clip.

m Capture Clip:  Capture Clip captures video one clip at a time from a camcorder or deck 
with device control. This command is useful if you’re simply grabbing a few clips and you 
want to capture them as soon as you identify where they are.

m Capture Batch:  Capture Batch requires that you have already logged clips in your project. 
If you have, Capture Batch allows you to capture them all at once, stopping only to insert 
the next video reel.
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Offline and Online Clips

When you log a shot on your source tape as a clip, Final Cut Pro creates an “offline” clip in 
the designated log bin of your project’s tab in the Browser. A log bin is a folder where clips 
are stored. An offline clip is a reference to a media file that you haven’t yet captured; it 
doesn’t take up any space on your hard disk. Your projects can have as many offline clips 
from as many sources as you want. 

After you capture a clip, it’s stored on the disk you’ve designated as the scratch disk (see 
“Setting Up Scratch Disks for Storing Media” on page 899). Once captured, a clip is “online” 
because it’s linked to captured media on your hard disk.

The link between clips (and sequences) in the Browser and their source media files on disk 
determines a clip’s online or offline status. If you move, rename, or delete your source media 
files on your hard disk, the corresponding clips in your project go offline, since the reference 
files no longer know where to point to the actual source media.

If the original source media file was deleted, you can recapture it. If it was moved, you can 
use the Reconnect Media command to reestablish the link between the source media and the 
clip. For more information, see “About Links Between Clips and Source Media” on page 214.

Offline clips

Online clips
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Controls in the Log and Capture Window 
When device control is enabled, many of the controls in the Log and Capture window are 
similar to those in the Viewer. The difference is that instead of controlling the playback of a 
clip or sequence, they control the playback of your attached camcorder or deck.

To open the Log and Capture window:

m Choose Log and Capture from the File menu or press Command-8.

There are three main areas in the Log and Capture window. 

m Preview area:  On the left is the area where you view video as you log or capture it. This 
area contains playback and marking controls and timecode fields.

m Tabs:  On the right are three tabs that provide access to various settings—Logging, Clip 
Settings, and Capture Settings. 

m Log Clip button:  This button is near the bottom of the tabbed area. You click this to log a 
clip and save the logging information with the clip name for capture at a later time.

m Capture buttons:  Also on the bottom of the window are the buttons for the three capture 
methods:  Clip, Now, and Batch.

As stated earlier, you can capture clips with or without device control. However, capturing 
your clips with device control gives you much more flexibility to manage your media as you 
work on your project.

Log and Capture 
buttons

Preview area
with marking and
playback controls

Tabs for additional options
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Using Device Control

When device control is enabled, many of the controls in the Log and Capture window are 
similar to those in the Viewer. However, instead of controlling the playback of a clip or 
sequence, the controls are used to play back video on the camcorder or deck that’s 
connected to your computer. 

Note:  If your video equipment does not support device control, see “Using a Non-
Controllable Device” on page 35.

Playback and Marking Controls

This section of the Log and Capture window lets you view video as you log or capture it. If 
your camcorder or deck is not on or there is no tape inserted, you’ll see color bars or black. 
The following controls appear if a device-controllable camcorder or deck is hooked up and 
device control is enabled.

m Available space and time:  Final Cut Pro displays the amount of available space on the 
current scratch disk and the amount of capture time available, which depends on the 
Capture/Input setting selected in the Capture Settings tab.

m Timecode Duration field:  Displays the duration of the section of tape you’ve marked for 
capture, based on the In and Out points you marked. You can enter timecode directly in 
this field to set a new duration from the In point.

m Current Timecode field:  Displays the timecode number of the currently displayed frame 
of your source tape. You can enter timecode directly in this field to navigate to that 
timecode point on your tape.

Current Timecode field

Clip Out point 
timecode

Go to 
Out point

Mark 
In

Timecode Duration field

Preview area

Go to In point

Device 
status

Jog control

Shuttle control

Available space and time

Transport controls

Mark
Out

Clip In point
timecode
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Transport controls

If you have device control, use these to control your camcorder or deck.

m Play In to Out:  Plays the tape from the currently marked In point to the currently marked 
Out point. Use this to see how the clip you’ve logged plays from beginning to end. The 
keyboard equivalent is Shift–\ (backslash).

m Rewind:  Moves the tape backward. The keyboard equivalent is the J key.

m Stop:  Stops playback of the tape. The keyboard equivalents (along with Play) are the 
Space bar and the L key.

m Play:  Begins playback of the tape, from the current location of the playhead to the end, 
regardless of the Out point. Clicking again stops playback. The keyboard equivalents 
(along with Stop) are the Space bar and the L key.

m Play Around Current:  Plays the selected section of tape from before the current frame 
(based on a pre-roll setting) and continues through the amount of time specified by the 
post-roll setting. (The preview pre-roll and post-roll settings are in the General tab of the 
Preferences window.) Use this control to get a quick sense of what material is at the 
current section of tape as you navigate. The keyboard equivalent is the \ (backslash) key.

m Fast Forward:  Moves the tape forward.

Playhead controls

The playhead controls are used to navigate through the current tape quickly and easily.

m Shuttle control:  Use this to quickly play your tape at different speeds forward or back, in 
fast and slow motion. Drag the slider to the right to fast-forward and to the left to rewind. 
Playback speed varies depending on the distance of the slider from the center of this 
control. When the slider is green, playback speed is normal (or 1x). 

The keyboard equivalents of the shuttle control are the J, K, and L keys. 

m J:  Reverse motion

m K:  Pause/Stop (Press this key once to pause; press twice to stop.)

m L:  Forward motion

Rewind

Play In to Out Stop Play Play Around Current

Fast Forward

Jog controlShuttle control
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Repeated pressing of the J and L keys increases or decreases the speed of forward or 
reverse motion. Speeds vary from deck to deck. Typical deck speeds attainable when 
pressing L to move forward are 1/5x, 1/2x, 1x, 2x, 5x, and maximum (which can be 8x to 
64x, depending on the deck). Most decks do not have the same range of speeds in 
reverse as in fast forward and most do not have speeds less than 1x, or normal speed.

Note:  When using keyboard shortcuts for device control, the speed of forward (L) and 
reverse ( J) may differ depending on your video equipment.

m Jog control:  This control allows you to move forward or backward very precisely, as if you 
were actually moving the control with your hand. There is a one-to-one correspondence 
between the motion of your mouse and the tape’s motion. This control is useful for 
locating a specific frame.

The keyboard equivalents of the jog control are the Left and Right Arrow keys. 

m Left Arrow:  Moves forward one frame at a time.

m Right Arrow:  Moves backward one frame at a time.

m Shift-Left Arrow:  Moves forward one second at a time.

m Shift-Right Arrow:  Moves backward one second at a time.

Marking controls

Use these to set the start and end frames to select a part of your tape for logging or capture.

m Mark In:  Click this to set the starting frame of your tape for logging or capture.

m Clip In Point timecode:  Displays the timecode location of the current In point.

m Go to In Point:  Click this to cue the tape to the current In point.

m Mark Out:  Click this to set the end frame of your tape for logging or capture.

m Clip Out Point timecode:  Displays the timecode location of the current Out point.

m Go to Out Point:  Click this to cue the tape to the current Out point.

Go to In Mark In

Clip In point timecode

Mark Out Go to Out

Clip Out point timecode
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Log and Capture Buttons

After you’ve used the playback and marking controls to identify a section of videotape, these 
buttons perform the log or capture operations.

m Log Clip:  Click this to log a clip using the currently specified In and Out points, along 
with the current information in the Logging tab and the settings in the Clip Settings tab. 
After you log a clip, it appears as an offline clip in your currently selected logging bin.

m Clip:  Click this to capture a clip immediately using the currently specified In and Out 
points, along with log information you enter into the Logging tab. After you capture a clip, 
it appears as an online clip in your currently selected logging bin. This option lets you 
capture a clip quickly without associating it with a specific project.

m Now:  Click this to capture media without setting In and Out points. You can use this two 
ways:

m If your camcorder or deck doesn’t have device control, this is the only capture option 
you can use. For more information, see “Using a Non-Controllable Device” on page 35.

m If your camcorder or deck supports device control, you can use Capture Now to 
quickly capture a clip with timecode, without having to set In and Out points.

m Batch:  Click this to batch capture a set of previously logged clips. You can also use this to 
recapture clips in your project that have already been captured. In that case, the original 
clips are discarded if they are on the currently specified scratch disk. For more 
information on batch capturing, see “Doing a Batch Capture” on page 275.

Tabs in the Log and Capture Window

For detailed information on the settings in each of the three tabs in the Log and Capture 
window, see “Setting Up to Log Clips” on page 230.
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Using a Non-Controllable Device for Capture

When a device-controllable camcorder or deck is not available or device control is not enabled, 
the Log and Capture window looks very different from the way it does when you’re using 
device control. The transport and timecode controls are not displayed and only the Capture 
Now button is available.

Setting Up to Log Clips
The Logging and Clip Settings tabs of the Log and Capture window contain information that 
will be included along with every clip that is logged or captured. It is important, before 
proceeding with either task, to make sure that all of these settings are correct.

Reel number in the Logging tab

Before you start logging your tapes, it’s important to make sure that each of your source 
tapes is uniquely identified with a reel name. As long as you’re not exporting an EDL, your 
reel names can be anything you want. Commonly, tapes recorded using professional video 
equipment allow the user to define the timecode with custom hour numbers, so you can use 
those for your reel names. Most mini-DV devices don’t allow custom hour numbers, so with 
these devices the best policy is to write reel names onto the tapes themselves, and to use 
these to identify your tapes.

If you aren’t using
device control,

the Log and Capture
window is simplified.
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If you plan on exporting an EDL, there are restrictions on the reel names you can use. The 
restrictions depend on what EDL format you’re using:

Capture and audio format in the Clip Settings tab

Each clip you log can have individual picture quality and gain settings, if your capture 
method supports this, and you can capture both video and audio, just video, or just audio. In 
addition, you can capture both audio tracks, just track one, or just track two. Whichever 
settings you select here will apply to all the clips that you log until they’re changed again, so 
it’s important to be mindful of what these controls are set to. 

Note:  DV only allows Stereo or Ch 1+Ch 2 as the audio format.

While these settings can always be changed later, correctly setting them will spare you the 
inconvenience of accidently recording the wrong clips, or of inadvertently capturing all your 
clips without audio.

System Reel name length Reel name characters

CMX 340 1–253 characters Numbers only

CMX 3600 8 characters Uppercase alphabetical; 
numbers 0–9

GVG and GVG 4 Plus 6 characters Uppercase alphabetical; 
numbers 0–9

Sony 5000 1–998 characters Numbers only

Sony 9100 6 characters Uppercase alphabetical; 
numbers 0–9; underscore (_)
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Controls and Information in the Logging Tab

The Logging tab in the Log and Capture window is where you enter all of the descriptive 
information about clips being logged. You can use this information later to help you while 
you’re editing. 

The reel affects which clips are captured from which source tapes, so it must correspond to 
the actual tape the source media for the clip is on. The name for each clip becomes the 
captured clip’s filename on disk, therefore all clip names must be unique. The remaining 
information in the Logging tab is primarily for your use as an editor; it’s up to you and the 
particular needs of your project to determine how to format this information. 

The information you enter in the Logging tab is displayed in corresponding Browser columns 
and in a clip’s Item Properties window (see “Viewing and Changing the Properties of a Clip” on 
page 208). Any of this information can be changed later, before or after clips have been captured. 

Note:  If you’ve previously logged a clip (and it’s offline or online), you can drag the clip from 
the Browser to the Log and Capture window to open the clip’s settings. This lets you log a 
clip with modified information, or use the Capture Now command to capture it right away.

Information in the Logging 
tab helps you later when 
you’re editing.
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Logging Bin Controls and Reel Information

Use the Log Bin controls to keep track of where logged clips are stored in your project. You 
can only have one log bin set at a time. Once you enter a reel name, you can simply click the 
Slate button next to it to increment the reel name. 

m Log Bin:  This button contains the name of the bin, or folder, in your project where 
logged clips will be placed. You can have only one log bin at a time, no matter how many 
projects are open. When you click this button, the bin opens in its own window; if the bin 
is already open, it brings that window to the front.

m Up:  Click to move the log bin up a level from the currently selected one. For example, 
you could switch from a selected bin up to the main project tab. 

m New Bin:  Click this to create a new bin inside of the currently selected bin, and set it as 
the log bin.

m Reel:  Enter the name of the current source tape being logged. Control-click to choose 
from a list of all reel names used in the current project. 

m Slate button:  Click this to add a number at the end of your selected reel name for 
incremental labeling. If your reel name is a number or has a number at the end of it, it will 
be incremented by one. If your name is alphabetical and takes the form of “Tape A,” for 
example, the last character is incremented; in this case, the name changes to “Tape B.” 
Option-click this button to clear the Reel field.

Name and Clip Description Fields

There are several fields you can use to name and describe each clip you log. You can name 
each clip as you log it, or you can use the automatic naming controls to have Final Cut Pro do 
this for you.

New bin
Slate button

Up

Click these checkboxes 
to add text in these 
fields to the Name field.

Click the Slate button to add
incremental numbers to the

current text in each field.
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m Name:  The name in this field is compiled from information entered in the Description, 
Scene, and Shot/Take fields. Only the checked information fields will contribute to the 
automatic name that’s generated. Clip names appear in the first column of the Browser, 
and are also used as the names of the source file saved on disk. The names you use will 
most likely be the most common way you refer to your clips, so pick a naming scheme 
that makes sense to you.

m Prompt:  Check this box to be prompted for a clip name when you click the Log Clip 
button or press F2. If you don’t want to use the automatic Description, Scene, and Shot/
Take fields, this will allow you to type in your own name for every clip you log as you 
log it.

m Description:  Enter descriptive text about your clip.

m Scene:  Enter scene information using letters or numbers.

m Shot/Take:  Enter shot or take information using letters or numbers.

The Description, Scene, and Shot/Take fields each have a Slate button and a checkbox 
control to help you manage their content.

m Slate button:  Click this to add incremental numbers to the current text. If the current text 
has no number, then “1” is added to the end of the field. For example, “Man Talking” 
becomes “Man Talking1” automatically. 

To add a space before the number, make sure you add one yourself. If your current text 
already has a number in it, then it’s incremented by 1. For example, “Man Talking 1” 
becomes “Man Talking 2” automatically, with the spacing preserved. If your name takes 
the form of “Shot A,” the last character is incremented to the next letter. In this case, the 
name changes to “Shot B,” followed by “Shot C,” and so on.

m Click the Slate button next to the Description field to clear the Shot/Take field.

m Click the Slate button next to the Scene field to reset the Shot/Take field to “01” no 
matter what the number was before (assuming a new scene will begin at the first take).

m Option-click the Slate button next to the Description or Shot/Take fields to clear each 
field.

m Option-click the Slate button next to the Scene field to clear the field and reset the 
Shot/Take field to “01” (assuming a new scene will begin at the first take).
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m Checkboxes:  Click these buttons to automatically add text in the selected fields to the 
Name field. Underscores (the _ character) are used to separate all three pieces of 
information. If all three boxes are checked, the Description, Scene, and Shot/Take 
information is combined. For example, the name of your clip may be “Man Talking 
3_23_2” to indicate a description (“Man Talking”), the scene (“3”), and the shot and take 
(“23/2”).

m Log Note:  Enter descriptive text. Control-click this field to choose from a list of recent Log 
Note comments in the current project.

m Mark Good:  If you check this box, a checkmark appears in the Good column of the 
Browser. This is helpful if you want to log every shot on all of your tapes, but capture only 
a few shots. You can also use this setting to find just the shots you want to capture, mark 
those shots Good, do a search for all clips that are marked Good, then do a batch capture 
of these clips.

Marker Controls for Logged Clips

Click the disclosure triangle next to Markers to see the marking controls.

m Marker name:  Enter a name or comments to go with the marker in this field. The marker 
name remains until you change it.

m Set Marker:  Once you’ve set the marker In and Out points, click this to create a new 
marker.

m Set Marker In:  Click this to set a marker In point, or enter a timecode in this timecode field.

m Set Marker Out:  Click this to set a marker Out point, or enter a timecode in this 
timecode field.

Marker In point
timecode

Set Marker In button Set Marker Out button
Marker Out point 
timecode

Marker information after clicking 
the Set Marker button
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m Update:  To update a marker in the list, click to select it, make your changes, then click 
Update. The marker in the list then displays the new information.

m Marker list:  Displays all markers and associated information for the current clip.

When you click the Log Clip button, all information in this section is saved with the clip and 
the window clears. 

Note:  If you drag a clip to the Log and Capture window, you’ll see all that clip’s settings and 
markers in the appropriate fields. 

Using Markers While Logging

You can set markers within clips to note significant parts for future reference. Markers can be 
used for several purposes.

m Reference:  Each marker can contain a name and associated note to help you identify the 
content or other noteworthy information.

m Navigation:  You can move the playhead from marker to marker in the Viewer and the 
Timeline to quickly go to specific parts of a clip.

m Creation of subclips:  You can also use markers to automatically create subclips, or parts 
of a larger clip, in the Browser. For example, when you log a lengthy clip for capture, you 
can arrange the markers to break the clip into smaller subclips for use while you edit. For 
more information on creating subclips, see “Creating and Working With Subclips” on 
page 386. 

You can set as many markers as you like. Markers appear in a list and can be edited and 
deleted. Markers you set for clips during the logging process also appear in the Browser, the 
Viewer, and the Timeline.

Controls and Information in the Clip Settings Tab

The Clip Settings tab in the Log and Capture window lets you calibrate and adjust the 
incoming video and audio signals. These adjustments are saved, along with the information 
in the Logging tab, as part of the clips you log and capture. These settings also affect how 
your clips are captured when you perform a batch capture.
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Each clip can have its own image settings, gain level, and track settings. For example, you can 
capture audio and video for five clips, and video only for two other clips.

Image and Gain Controls

Use these controls to adjust your incoming video and audio signals as they’re captured on 
tape. (If you’re using color bars and reference tone, you’ll also use the Waveform Monitor 
and Vectorscope.) 

These controls are only available if you’re using a third-party video or audio capture card to 
import your media. Since DV video is digital as it’s recorded, all of your video’s image and 
level parameters are already set and these controls aren’t available.The only way you can 
adjust the image quality of DV-format clips is by using video filters in your edit.

m Image controls:  Adjusts the incoming video signal if you’re using a third-party analog-to-
digital video capture card.

m Gain slider:  Adjusts the gain, or audio level, of the incoming audio signal. You can also 
use this control with third-party audio or video capture cards.

m Use Digitizer’s Default Settings:  Click this to restore the default video and audio settings 
for your capture system, defined by the manufacturer of your capture card.

Click here to restore 
default settings.

Choose an audio format 
from this pop-up menu. 

Choose a capture
format from this

pop-up menu.

Click here to examine
and calibrate the

incoming video signal.

Image and gain controls 
(for analog capture)
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Capture Format and Track Controls

Sometimes you don’t need to capture the video and both audio tracks all together. The capture 
controls let you log and capture only the media tracks you need, on a clip-by-clip basis.

m Capture pop-up menu:  Specify whether you want your clips to be captured with Audio 
Only, Video Only, or Audio+Video. If you’re using an audio source, such as DAT, to 
import clips, this is where you enable audio only capture.

m Audio Format pop-up menu:  Specify the channels of audio you want to capture.

m Channel 1:  Captures only channel 1 of the source media. Stereo pan is centered. (Pan 
is the distribution of sound between the right and left channels.) This option is not 
supported for DV media.

m Channel 2:  Captures only channel 2 of the source media. Stereo pan is centered. This 
option is not supported for DV clips.

m Channels 1+2:  Sets the two audio channels as separate channels, but not as a “stereo 
pair.” When a clip captured this way is opened in the Viewer, each audio channel has 
its own tab—Ch 1 and Ch 2. Levels or effects applied to one channel during editing 
aren’t automatically applied to the other channel, and pan is centered by default for 
both channels. 

m Stereo:  Both audio channels are captured as a stereo pair. A stereo pair of tracks 
appears in the Viewer as a single Audio tab. The waveforms of both audio channels are 
displayed in this tab; any levels or effects applied to one channel are automatically 
applied to the other channel.

If you select the audio portion only of a clip in the Timeline that was captured as Ch 1+Ch 2, 
you can independently select audio track 1, audio track 2, or both. For example, if you have the 
same dialog on each track, but track 1 was recorded from a lavalier microphone and track 2 was 
recorded with a shotgun microphone, you may only want to use one of these channels in your 
edit, but you’re not yet sure which one. If you record your audio as channels 1 and 2, you can 
easily disable or delete one of the clip’s audio tracks in the Timeline. 

If you select just the audio portion of a clip in the Timeline that was captured as Stereo, you 
can only select the two tracks together. This is useful if you’re importing clips with music, 
sound effects, or other intrinsically stereo material that you don’t want to edit separately. 
Stereo pairs can be changed to channel 1 and 2 pairs by choosing Stereo Pair from the 
Modify menu (so there’s no checkmark next to it).
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Audio tracks captured as Ch 1+Ch 2 can be converted to a stereo pair at any time by 
choosing Stereo Pair from the Modify menu.

m Mono Mix:  Captures both channels of audio and mixes them into a single track.

m Waveform Monitor and Vectorscope:  Click this button to open the Waveform Monitor 
and Vectorscope to examine and calibrate an incoming video signal. This is a graphical 
representation of where the color and brightness levels fall on a predetermined scale 
and is used in conjunction with the various image controls at the top of the Clip Settings 
tab (for analog video only). For more information on using the Waveform Monitor and 
Vectorscope, see “Calibrating Image Settings With Color Bars and Audio Tone” on 
page 240.

The double arrow icons 
indicate this is a stereo pair.

This represents a 
linked audio pair.
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Changing Clip Settings After Logging

Once a clip is logged, you can override its settings in one of two ways:

m Batch Capture dialog box:  Deselect the “Use Logged Clip Settings” checkbox. Individual 
clip settings will be ignored in favor of the settings currently chosen in the Clip Settings 
tab.

m Tracks column in the Browser:  You can also change a clip’s capture settings by Control-
clicking the Tracks column for the clip in the Browser, and choosing a new capture setting 
from the shortcut menu. 

Calibrating Image Settings With Color Bars and Audio Tone

Broadcast video professionals use color bars to ensure that video shot in the field is adjusted 
for accurate color and brightness and that there’s no distortion when this video is captured 
by Final Cut Pro. It’s also used to calibrate Final Cut Pro’s output back to tape, so that dubs of 
your final master tapes all have correct color and brightness.

Note:  You only calibrate using bars and tone if you use analog source tapes, such as Beta SP 
or Hi-8, and you’re capturing your material using an analog-to-digital capture card. If you’re 
using DV, you don’t have to calibrate using color bars and tone.

Make sure this option
is not selected.

Choose the tracks for a clip 
in this Browser column.
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Typically, 30 to 60 seconds of color bars are recorded at the beginning of each new videotape 
shot in the field. Color bars output from a professional camcorder are initially used to 
calibrate the monitors used to watch what’s being shot, so that adjustments for brightness or 
color temperature made to the camcorder are accurately seen. Later, the color bars recorded 
at the head of all of the source tapes are used to calibrate the clip settings in Final Cut Pro. If 
you don’t have bars and tone on your tape, see “Adjusting Source Tapes Without Color Bars” 
on page 245.

Using Final Cut Pro’s Waveform Monitor and Vectorscope

Before logging new clips, it’s a good idea to check the bars and tone of each new tape you 
log with Final Cut Pro’s built-in Waveform Monitor and Vectorscope. You can also make 
adjustments to individual clips on tape, if necessary. Final Cut Pro saves individual image 
control settings with each clip, so your changes to these settings are saved for future use. 

To use the built-in Waveform Monitor and Vectorscope to adjust your clip 
settings:

1 Make sure your video deck is connected to the capture card in your computer.

2 Cue the videotape to the 30 seconds of color bars recorded at the beginning of the tape.

3 Choose Log and Capture from the File menu, click the Clip Settings tab, then click the 
Waveform Monitor and Vectorscope button. 

Important  Each source tape should be individually calibrated because tapes from various 
cameras may have slightly different settings. For more information on using the Waveform 
Monitor and Vectorscope, see Appendix F, “Video Calibration Using Color Bars,” on 
page 1357.
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Note:  Don’t worry if the graph appears to be “noisy”; this is normal for video played back 
from tape.

On the left is the Waveform Monitor, which displays the brightness levels of the color bars 
within the video frame as a graph. Each “step” of the graph corresponds to one of the color 
bars. The goal is to adjust the brightness and contrast so that the green bars of the graph 
match their ideal targets, shown in purple. 

4 Click the Targets checkbox to display the target settings. 

5 Adjust video brightness and contrast using the Waveform Monitor.

Waveform Monitor 
and Vectorscope 
controls

VectorscopeWaveform
Monitor

Make sure this is selected to show the 
ideal brightness and contrast targets.
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For more information on brightness settings, see “How Brightness Is Measured” on page 244.

There are two ways of adjusting video brightness and contrast using the Waveform Monitor, 
depending on the kind of video capture card you’re using. 

m If you’re capturing using a Composite or S-Video input, only the Hue, Saturation, 
Brightness, and Contrast sliders are enabled.

1 Adjust the Brightness slider so that all of the bars in the Waveform Monitor are set near 
the upper purple targets in the background. 

2 Adjust the Contrast slider so that the tops of the bars and the bottoms in the Waveform 
Monitor are within the boundaries of the top and bottom targets. 

3 Continue adjusting the Brightness and Contrast sliders until there is an acceptable 
range of brightness between the 100 and 7.5 IRE targets. 
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m If you’re capturing using a Component video input, such as YCrCb or RGB, you’ll 
probably only see the Black Level and White Level sliders.

1 Adjust the Black Level slider so that the third bar from the left is at the 7.5 IRE target 
towards the bottom.

2 Adjust the White Level so that the second bar from the left is at the 100 IRE target at 
the top.

How Brightness Is Measured

The brightness, or luminance, in the image is measured in IRE (Institute of Radio 
Engineers) units, which describe the amplitude characteristics of a video signal. 100 
IRE represents absolute white. Absolute black is represented by 7.5 IRE in the United 
States when using NTSC and by 0 IRE when using PAL or NTSC in Japan. 

If any part of the signal goes above 100, the result will be overbright whites that wash 
out. Likewise, if too much of the signal goes below 7.5 or 0, the result will be lost detail 
in the dark parts of the picture. While 7.5 IRE is the standard in the United States, in 
Europe and Japan, black is standardized at 0 IRE.

Many consumer camcorders record superwhite video levels. While this is fine for 
personal use, professional video facilities are fairly stringent about keeping all video 
levels between 0 (PAL) or 7.5 (NTSC) and 100 IRE. 
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On the right is the Vectorscope, which displays the color values of the different areas of the 
video frame as a point graph. Each point on the circular graph represents one of the color 
bars. The goal is to line up these points with their respective targets. 

6 Adjust the clip’s target settings using the Vectorscope.

a Click the Lines checkbox to “connect all the dots” and make the positions of points 
relative to one another. 

b Adjust the Hue slider to rotate these points around the center of the graph.

c Adjust the Saturation slider to move the dots closer or further away from the center of the 
graph. If this slider is properly adjusted, each point falls within the purple target boxes.

Adjusting Source Tapes Without Color Bars

If there are no color bars at the beginning of your source tapes, you can adjust your tapes 
using the flesh tones of people in the shot. As long as the skin tones look accurate, chances 
are the rest of colors in that shot will look fine. To help you find the correct flesh tone, 
there’s a special marker in the Vectorscope labeled FT. 

To adjust tapes using flesh tones:

1 Cue your tape to a section that has a well-lit facial closeup.

2 Check to see if there’s a spike on the Vectorscope near the FT line.

3 Adjust this spike so that it falls approximately along the FT line. While doing so, be sure to 
check the image quality of your clip on a broadcast monitor to make sure that your 
adjustment is accurate.
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The FT line is only meant to be an approximation; it’s more important that the shot look 
correct than that it fit this line exactly.

Using Hardware for Color Bar Calibration 

Working with Final Cut Pro’s built-in Waveform Monitor and Vectorscope gives you fairly 
accurate color and brightness, and for most users this provide good results. However, for 
many third-party capture cards, the Waveform Monitor and Vectorscope base their 
measurements on RGB conversions of the original YUV video signals on tape. This may not 
be accurate enough for the discerning video engineer.

If you want, you can set up your Final Cut Pro workstation with equipment appropriate for 
measuring and adjusting video input and output more accurately. For more information on 
hardware calibration and color calibration in general, see Appendix F, “Video Calibration 
Using Color Bars,” on page 1357.

Adjusting Audio Using the Gain Slider

Along with the color bars at the beginning of your tape, there should also be a reference tone 
that matches the duration of your bars. It sounds like a long beep and is a 1 kiloHertz (kHz) 
tone that’s adjusted to play at 0 decibels (dB) on analog systems and typically at –12 dB on 
digital systems. 

All of the audio on your source tape should have been recorded in relation to the level of this 
reference tone. When you adjust the Gain slider to the appropriate matching level on Final 
Cut Pro’s recording audio meter, none of the audio recorded on that source tape is 
overdriven. Overdriven audio recorded digitally sounds crackly and distorted and should be 
avoided whenever possible.

Note:  When capturing DV audio, the gain level is already set and cannot be modified.

The FT (flesh tone)
target is here on

the Vectorscope.
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To adjust the audio Gain setting:

1 Make sure your video deck is connected to the capture card in your computer.

2 Cue the videotape to the reference tone recorded at the beginning of the tape.

3 Choose Log and Capture from the File menu, then click the Clip Settings tab in the Log and 
Capture window.

4 Play back your tape.

5 Adjust the Gain slider so that the visible bars of the audio meter average at around –12 dB, 
represented by the green section of the audio meter.

Your audio can peak anywhere between –12 dB and –3 dB (represented by the yellow 
section of the audio meter). To avoid distortion, the audio should not hit higher than 0 dB.

How you adjust the gain depends on the dynamic range of your clip. Dynamic range refers 
to the difference in decibels between the loudest and the softest part of your recording. You 
don’t want to record your material at levels too low because you’ll end up with a soft audio 
signal that doesn’t sound clear. If you’re capturing material that ranges between very soft and 
very loud, adjust the gain for the very loud sections to avoid periodic distortion.

For more information on setting levels properly, see Chapter 17, “Working With Audio,” on 
page 727.

Move this slider so the audio 
meter average is around –12 dB.

The audio level can peak anywhere 
from –12 to –3 dB in the audio meter.
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Making Sure Device Control Is Properly Set Up

Before you start the logging and capture process, make sure that your device control 
hardware is properly set up. 

To verify device control is properly set up:

1 Do one of the following:

m If you’re using DV device control:  Make sure your FireWire cables are properly 
connected. Depending on the device you’re using, you may also need to install one or 
more DV tuner scripts in the Plugins folder within the Final Cut Pro application. For more 
information on whether or not your device needs a tuner script installed, see the Final 
Cut Pro device certification page on Apple’s Final Cut Pro Web site at www.apple.com/
finalcutpro

m If you’re using serial device control:  Final Cut Pro is unable to communicate with your 
camcorder or deck. Make sure you have the correct cable for the type of device control 
you’re using—RS-232 or RS-422. Also make sure that the USB-to-serial adapter is properly 
connected and you installed the proper software drivers. For more information on setting 
up device control hardware, see “Using Serial Device Control With Final Cut Pro” on 
page 34.

2 Choose a device control preset in the Audio/Video Settings window that accurately reflects 
your setup. 

For more information, see “Using Serial Device Control With Final Cut Pro” on page 34 and 
“Choosing Individual Presets” on page 104.

About Device Control Status Messages

At the bottom of the Log and Capture window, the device status area shows the readiness of 
camcorders and decks being controlled by Final Cut Pro. 

The device status area can display any of these messages:

m VTR OK:  This indicates your equipment is connected and working properly.

m VTR in Local:  Your device is set to work only with its built-in playback buttons. Set the 
switch on your camcorder or deck from Local to Remote and you’ll be able to use device 
control through Final Cut Pro.

Device status
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m No Communication:  Check to make sure you’re using the right FireWire or serial control 
cables and that they’re connected properly. Also make sure your device is turned on.

m Not Threaded:  This indicates that you have a camcorder or deck connected to your 
computer, but there’s no tape in the deck or the tape is still loading and isn’t ready yet. 

m Tape Trouble:  This indicates that your tape may be jamming. It’s important to 
immediately stop playback and remove your tape from the deck, if possible. If you can’t 
eject your tape, take your camcorder or deck to a qualified technician. For more 
information, see the documentation that came with your video equipment.

m Device Control Disabled:  This appears if you turned off device control or selected Non-
Controllable Device in the device control preset for your camera or deck.

m Device not available:  Check to make sure that your camcorder or deck is connected and 
turned on.

Calibrating the Timecode Signal

During video capture, the timecode and video signals are sent separately from the video deck 
to the computer. Because the signals are separate, they can arrive at different times, which 
causes incorrect timecode values to be recorded. You must calibrate your system by entering 
the amount of time by which the signals are offset from one another. 

You need to calibrate the video signal every time you change decks or cables. If you regularly 
use multiple decks, it’s a good idea to create different device control presets, one for each 
deck you use. Since each deck always has the same offset, a set of precalibrated presets lets 
you quickly change decks without having to go though the whole recalibration procedure. 

For more information on setting up your hardware for device control, see “Using Serial 
Device Control With Final Cut Pro” on page 34. For more information on setting up Final Cut 
Pro’s device control presets, see “About Device Control Presets” on page 128.

To determine the timecode offset:

1 Capture a clip of video from a tape with LTC or VITC timecode on it. This can be

m a tape with a “window-burn,” where the timecode number is visible in the video frame

m a tape playing on a deck with a timecode display option that’s enabled

m a clip from a DV-format tape with a specific frame that can be individually identified with a 
timecode number on your camcorder or deck’s display (The first frame of a new scene is 
a good reference to use.)

See “Capturing Video and Audio” on page 265 to learn how to capture a clip of video.

2 Compare the timecode value recorded in the captured movie (in the Current Timecode 
field) with the burned-in timecode on the video frame or the DV frame you’ve chosen for 
reference.
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If both timecode values match, then there is no offset and no adjustment is necessary. If the 
timecode values do not match, there’s an offset and you’ll need to compensate for this to 
capture your video properly.

To enter a timecode offset:

1 Choose Audio/Video settings from the Edit menu, then click the Device Control Presets tab.

2 Make sure your current method of device control is checked, then click Edit.

If you’re using a locked preset, a new copy of the preset is created.

3 Enter a new name and description for this device control preset indicating which camcorder 
or deck it is calibrated for.

4 Enter the offset, in frames, in the Timecode Offset field, then click OK.

If the timecode value in Final Cut Pro for a frame in your captured movie is greater than the 
burned-in timecode value in that clip’s picture, enter the offset as a negative number. If it’s 
less, enter the offset as a positive number.

After entering the timecode offset, it’s a good idea to capture a few more clips and compare 
them to determine if the timecode offset you entered is correct and to confirm your 
equipment is working properly.

Enter the timecode offset here; add 
a hyphen for a negative offset.

Enter an appropriate
name and description

for your new preset.
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Logging Your Media
Once you’ve calibrated the color and audio levels and set up your equipment, it’s time to 
start logging.

When you define In and Out points and other information for your clip and click the Log Clip 
button, your clip is stored in the Browser as an “offline” clip. It’s offline because it’s ready to 
capture, but hasn’t been captured and is not physically stored on your hard disk. Offline clips 
take up no hard disk space. They are saved inside of the Final Cut Pro project file you’ve 
created, along with all of the information you set in the Logging and Clip Settings tabs.

When you have a set of offline clips representing all of the material that you want to capture 
from one of your source tapes, you can then do a batch capture to automatically capture all 
(or a specified subset) of your offline clips to your scratch disks. Once the media is captured, 
the offline clips in your project become online clips and are linked to the captured media 
files on your hard disk.

You can only log media ahead of time if your camcorder or deck supports device control 
(that is, you can use Final Cut Pro to control your video equipment). If your equipment 
doesn’t support device control, you can manually log and capture clips while the tape is 
playing. For more information, see “Using Capture Now Without Device Control” on 
page 266.
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Naming Your Files

Before you start logging clips, think about the file naming scheme you want to use for your 
project. It’s easier to edit when you have an organized naming system, especially if there are 
several people working on a project at one time.

There are two general categories of projects that you can work on. Choose file naming 
options that make the most sense to you. Here are some tips:

The Importance of Avoiding Timecode Breaks

As you log your footage, it is extremely important to avoid timecode breaks in your 
clips. A timecode break is any jump in the timecode that may interrupt its continuous 
flow. If you’re capturing mini-DV material, a break in the timecode may reset your 
footage back to 00:00:00:00. If you’re capturing video from other tape formats, breaks 
in the timecode may cause minute gaps.

If Final Cut Pro captures a clip with a timecode break anywhere in it, the timecode that 
Final Cut Pro captures and writes to that clip’s source file on disk will be incorrect 
from the point of the break onward. Since the timecode is incorrect, you will be 
unable to use that clip with any Final Cut Pro function that requires timecode to work 
properly. Batch Capture, the Media Manager, and EDL export all require accurate 
timecode to function, so you’ll be unable to use a clip with a timecode break with any 
of these.

Fortunately, Final Cut Pro warns you if there is a clip with a timecode break in it after 
capture. If you perform a batch capture, a list will appear afterwards showing all clips 
that have timecode breaks, so you can relog them to avoid the break. If you don’t, 
you’ll be unable to recapture those clips, export them in an EDL, export batch capture 
lists, or perform functions with the Media Manager involving those clips.

For this reason, if you’re planning on capturing an entire DV tape using Final Cut Pro’s 
DV Start/Stop Detection feature, it’s imperative that you are positive there are no 
timecode breaks on your tape. Otherwise, you’ll have to treat each section of tape 
before and after the break as a separate reel, capturing only those sections in between.
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Projects That Are Tightly Scripted

These include narrative and educational projects or projects with scripts that actors adhere 
to. Projects like this can benefit from:

m Using the Description field to name each separate shot.

m Using the auto incrementing scene and take numbers to keep track of where your clips fit 
into the overall script. Every time you log a new clip, it’s automatically incremented, so 
you can focus on logging and not on entering information.

m Use the Mark Good checkbox to differentiate the takes you want to use. Your first 
impression is important and you might forget what it was later on. When you’re ready to 
start capturing your clips, you can then use the Find command or sort by the Good 
column in the Browser, to select only the clips you’ve marked good, and then capture 
them, if you like.

Documentary-Style Projects

These include not only documentaries, but any kind of project where the majority of your 
material is found footage, previously recorded or stock material, or unscripted interviews.

m Use the Prompt checkbox to enter clip names as you think of them. It’s a good idea to 
identify clips by their content, as well as by where you might use them in your project.

m You can use the Notes field in the Prompt window (where you enter the name of a logged 
clip) to enter the scene number where you think that clip might be placed. Later, you can 
sort your clips in the Browser by the Notes column and all of your clips will be grouped by 
scene number.

m Use markers, especially if you’re logging long takes. Markers can remind you, later on 
when you’re editing, of sections of video that you liked.

m Feel free to log more clips then you intend on capturing. Especially when editing an 
unscripted piece, you never know when you’re going to need an alternate take or a B-Roll 
shot that you didn’t initially think you’d use. If you log all of the shots on a given reel for 
reference, you can use the Mark Good checkbox to mark the shots that you know you 
want to capture right away. You can then store the other offline shots in a separate bin for 
reference. If you need these shots later on, it’s easy to select and batch capture them.

For All Projects

m For audio files, it’s a good idea to add information to the filename indicating the sample 
rate, file format, and recording mode (stereo or mono) of the clip.

m Avoid duplicate clip names.

Important  All filenames you create must be less than 25 characters.
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Creating and Setting Log Bins

The log bin is where all newly logged clips are saved. By default, the log bin is set to the top 
level of the last project that was opened or created. As you log new clips for capture, think 
about how you want to organize your project. Organizing your clips in advance saves you 
time and hassle later on. 

Once you log your offline clips, you can organize them in the Browser using bins. You can 
organize your clips by reel, by scene, by type of material (audio vs. video files), by content, 
whatever you need. When you’re ready to capture your media, as long as the log bin contains 
the bins where you placed your offline clips, you can capture the clips in one or more of your 
bins using the batch button in the Log and Capture window. You can also select clips in the 
Browser manually and then capture or recapture those, regardless of whether or not they’re 
in the log bin.

For more information on organizing your clips using the Browser, see Chapter 7, “Using the 
Browser and Managing Projects and Clips,” on page 161.

To create and set a new log bin from the Log and Capture window:

1 Click the Logging tab.

2 Click the New Bin button.

To set a log bin from the Browser:

1 In the Browser, select the bin you want to use as your log bin.

2 Do one of the following:

m Choose Set Log Bin from the File menu

m Control-click the bin and choose Set Logging Bin from the submenu.

A slate icon appears next to the bin in the Browser to indicate that it is the current log bin.

 

Click here to 
create a new bin.

This shows the
current log bin.

To move up a directory 
level, click the Up button.

A slate icon appears next 
to the current log bin.

If the project is your
log bin, the slate icon

appears here.
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To create a log bin in the Browser:

1 Select the folder where you want the bin to be located.

By default, the folder used for the last opened or created project is designated as the log bin.

2 Do one of the following:

m Choose New from the File menu, then choose Bin from the submenu. 

m Control-click the folder, then choose New Bin from the submenu.

To open a log bin:

m In the Log and Capture window, click the Logging tab, then click the Log Bin button.

m In the Browser, double-click the bin.

Logging Clips

Now that everything’s set up and you’ve decided how you want to organize your material, it’s 
time to start logging.

To log clips:

1 Make sure your video equipment is properly connected and turned on.

For more information, see Chapter 2, “Setting Up Your System,” on page 21.

This shows a bin open in its 
own window in the Browser.
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2 Choose Log and Capture from the File menu, then click the Logging tab.

3 If necessary, set a log bin.

For more information, see “Creating and Setting Log Bins” on page 254.

4 Enter the name of the current source tape in the Reel field.

Option-click this field to clear the contents; Control-click the field to choose from a list of 
recent reel names.

5 Click the Reel Slate button to add a number at the end of the name for incremental labeling. 

6 Name your clip.

You can name clips two ways:

m Use Final Cut Pro’s automatic naming conventions:  Enter a name for the clip in the 
Description field. Then, in the Scene and Shot/Take fields, enter any descriptive text. Click 
the Slate button to increment the labels in a field. Option-click a field to clear the 
contents; check the box to the right of the field to add its information to the Name field.

m Be prompted for a clip name:  Check the Prompt box to be prompted for a name for 
each clip as you log it, instead of using the automatic naming fields.

Enter the source 
tape name here.

Slate button 
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7 Use the transport controls in the Log and Capture window to locate the footage you want to 
log or enter a timecode in the Current Timecode field to navigate to a specific location.

8 Select In and Out points to define a clip that you want to capture. 

The In point corresponds to the Media In property of that clip in the Browser. The Out point 
corresponds to the Media Out point. 

Note:  The In and Out points of clips in the Browser refer only to edit points set within a clip 
for use in editing. For more information on the item properties of individual clips, including 
the Media In and Out and the clip In and Out points, see “Viewing and Changing the 
Properties of a Clip” on page 208.

9 If you haven’t already, click the Clip Settings tab to make sure you chose the correct tracks 
you want to capture from the Capture pop-up menu:  Video, Audio, or Video+Audio.

For more information, see “Controls and Information in the Clip Settings Tab” on page 236.

10 If the Prompt option is selected, enter a name for the new clip in the dialog box that appears. 
Otherwise, click the Slate button next to the fields you want to increment.

11 When you’re ready to log the clip, click Log Clip or press F2.

An offline clip now appears in the selected logging bin.

To go directly to a shot, 
enter a timecode in the 
Current Timecode field.
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Creating and Importing Batch Lists
A batch list, also called a batch capture list, is a tab-delimited text file that contains 
information about clips you want to capture and use in your project. Increasingly, entering 
this information, or logging, is done on the set using a computer, making it easy to reformat 
for use in Final Cut Pro. If you have a camcorder and a spreadsheet program or word 
processor, such as AppleWorks, you can easily log tapes for capture even if Final Cut Pro is 
not installed on your computer. 

You can use batch lists several ways:

m Producers and directors can create a list of clips for you to edit with and save you the 
tedium of reviewing endless takes. 

m The assistant cameraperson can log the In and Out points of every shot and make a note 
of whether the director liked each one.

m You can log material on one Final Cut Pro workstation for import and capture on another 
workstation. 

Logging Media Efficiently

If you’re logging a lot of material, it’s a good idea to familiarize yourself with the 
various keyboard shortcuts you can use. Here’s an example of a logging workflow.

1 Use the J, K, and L keys to quickly play through your tape. 

J cycles through various speeds in reverse, K stops playback, and L cycles through a 
variety of speeds going forward.

2 When you’ve identified your In and Out points, press I to mark the In point and 
press O to mark the Out point.

3 Press F2 to log your clip.

4 If the Prompt box is checked, enter a name, then press Tab to move down to the 
Notes field, if desired.

5 Press Return or Enter to finish logging the clip.

Repeat this sequence as many times as you need to continue logging clips. 

Here are additional pointers for logging your material quickly:

m A new In point is set at the Out point of the last logged clip.

m If you’re using Final Cut Pro’s automatic naming feature and the Prompt box is 
unchecked, the Shot/Take field that makes up the clip’s name is automatically updated.
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About Creating a Batch List

Batch lists can be created using any popular spreadsheet program or word processor. 
Because spreadsheets are already set up to enter rows and columns of data, they are the 
easiest programs to use to create batch capture lists. However, even a very simple program 
such as SimpleText will work, as long as you use tabs instead of spaces to separate entries in 
your list. For detailed information, see “Using Batch Lists” on page 1207.
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Importing a Batch List

You can import a batch list into Final Cut Pro and use it to capture clips to edit or to create a 
sequence originally done on another editing system.

To import a batch capture list:

1 In the Browser, open an existing bin, or create a new bin to store the offline clips and open it.

For more information, see “Using Bins to Organize Your Clips” on page 184.

2 Choose Import from the File menu, then choose Batch List from the submenu.

3 Locate the batch list, select it, then click Open.

The logged clips appear in the Browser as offline clips that you need to capture.

You can capture the clips all at one time by doing a batch capture. For more information, see 
“Capturing Clips All at Once” on page 273.

Note:  Make sure you receive all source tapes associated with the batch list before starting 
the capture process.

Locate the batch list,
then click Open.

Clips from the batch list
are offline until you

capture them.
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Setting Up for Capture
Before you start capturing your video clips, it’s a good idea to make sure you’re properly set 
up.

Step 1: If necessary, change your device control, capture, and scratch 
disk preferences

By default, Final Cut Pro uses the preferences and settings you selected when you first 
opened the application (see “Choosing an Initial Setup” on page 52). You only need to 
change these settings if you changed your video hardware or if you want to store your data 
on a different disk. For detailed information, see the next section, “Specifying Capture 
Preferences From the Log and Capture Window” on page 262.

Step 2: If you’re using device control, calibrate your timecode signal

Timecode comes into your computer differently from how audio and video signals do. As a 
result, there may be an offset between the two when captured. It’s important to check and 
adjust for this before you begin capturing. For more information, see “Calibrating the 
Timecode Signal” on page 249.

Step 3: Calibrate capture settings with color bars and audio tone (for 
non-DV systems only)

Calibrating your quality settings and audio gain to the bars and tone at the beginning of each 
source tape maintains the image and sound quality while editing and outputting your 
program. For more information, see “Calibrating Image Settings With Color Bars and Audio 
Tone” on page 240.

Step 4: Adjust clip settings for individual clips, if necessary, while you 
log your clips

You can change your settings for both visual quality and for capturing video, audio, or both, 
as you view and log each clip. See “Adjusting Clip Settings in Preparation for Logging and 
Capturing” on page 264.
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Specifying Capture Preferences From the Log and Capture 
Window

The same presets and settings that affect capture in the Audio/Video Settings window are also 
available in the Log and Capture window:  Device Control, Capture, and Scratch Disks. Whether 
you change these settings here, in the Audio/Video Settings window, or by selecting an Easy 
Setup, you’re changing the same settings, so whatever you select is mirrored in the other 
windows.

m Device control preset:  You can choose a device control preset from the Device Control 
pop-up menu. The choices in this pop-up menu reflect the options that are available in 
the Device Control Presets tab of the Audio/Video Settings window.

Note:  When you’re capturing clips from a PAL device, if the device control preset is set to 
NTSC, the captured clip will have a non-drop frame starting timecode number. To set the 
timecode properly, make sure you choose a device control preset specifically for PAL.

m Capture preset:  This lets you modify your video input and any capture card settings, if 
available. The choices in this pop-up menu reflect the options that are available in the 
Capture Presets tab of the Audio/Video Settings window.

m Scratch Disks:  To redefine your scratch disk, click Scratch Disks, choose your settings, 
then click OK.

The Scratch Disks window appears, where you can define up to five disks where you want 
your captured video stored (they can be partitions or whole disks). After the disk with the 
most empty space gets filled to capacity, Final Cut Pro begins capturing to the next disk in 
the list with the most available space, and so on.

If necessary, you can choose 
another device control preset 
in this pop-up menu.

If necessary, you can choose 
another capture preset in this 
pop-up menu.

Click here to change or add 
scratch disks, where your 
captured clips will be stored.
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The area near the Scratch Disks button displays capture information, including how much 
free space is available on the selected scratch disk in gigabytes (GB) and in minutes (min), 
based on the scratch disk and other capture preferences you selected.

Note:  Final Cut Pro is not constrained by a 2 GB file size limit, as in earlier versions. The 
only limiting factor when capturing clips is the total amount of hard disk space available.

There are several options in the Scratch Disks window that you may want to set. These 
include capturing audio and video to separate files, a hard disk space limitation (if you 
want to leave room for additional files), capture file size, and time limits for doing a 
Capture Now. For more information, see “Setting Up Scratch Disks for Storing Media” on 
page 899.

Important Settings for Capture in the Preferences Window

Three settings in the Preferences window are relevant to video and audio capture. (To view 
or change these preferences, choose Preferences from the Edit menu.)

m Sync Adjust Movies Over N Minutes:  This option should always be checked when 
capturing clips using DV, because it keeps the audio and video of longer captured clips in 
sync. The number of minutes you enter depends on the type of equipment you have. For 
more information, see the Final Cut Pro Web site at www.apple.com/finalcutpro

Note:  For third-party, non-DV video capture cards, this option should be disabled. 

Information for the 
current scratch disk

Make sure this
option is enabled

when capturing DV
video clips to keep
audio and video for

long clips in sync.

These two options are important for 
alerting you to dropped frames.
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m Report dropped frames during playback:  This warns you if any frames drop during 
playback from the Viewer or Canvas. It can also be a good warning of performance 
problems with your system.

m Abort capture on dropped frames:  When this option is checked, Final Cut Pro stops 
capture whenever a frame is dropped. Dropped frames can affect sync and cause other 
problems, so it’s a good idea to leave this checked. Under normal circumstances, Final 
Cut Pro doesn’t drop frames. If many of your captures are interrupted and stopped, make 
sure you have the correct scratch disk selected and that the disk has high enough 
performance for the data rate of the video you’re capturing. For information on hard disk 
performance, see “Using Fast Hard Disks for High Data Transfer Rates” on page 30.

For additional information on preferences, see Chapter 19, “Viewing and Setting 
Preferences,” on page 883.

Adjusting Clip Settings in Preparation for Logging and 
Capturing

If you’re capturing or logging clips one by one, you can adjust each clip’s settings 
individually.

If you’re performing a batch capture, you can deselect the “Use Logged Clip Settings” 
checkbox in the Batch Capture dialog box to override each clip’s individually logged settings. 
Instead, the settings currently chosen in the Clip Settings tab will be used for all clips 
captured in the batch.

To adjust clip settings while logging and capturing:

1 Click the Clip Settings tab.

2  If you’re capturing analog video, use the image controls to adjust the video signal. 

Choose a capture
format from this

pop-up menu.

Choose a format for your 
audio from this pop-up menu.

For analog video, use the 
image control sliders to 
adjust the video signal.

Use the Gain slider to adjust 
the audio level.
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For information on using image controls, along with Final Cut Pro’s Waveform Monitor and 
Vectorscope, see “Calibrating Image Settings With Color Bars and Audio Tone” on page 240.

3 If you’re capturing analog video or audio, use the Gain slider to adjust your audio input level.

For more information, see “Adjusting Audio Using the Gain Slider” on page 246.

4 Choose what you want to capture from the Capture pop-up menu:  Audio Only, Video Only, 
or Audio+Video.

For detailed information on these settings, see “Controls and Information in the Clip Settings 
Tab” on page 236.

5 Choose a format from the Audio Format pop-up menu:  Ch 1+Ch 2, Ch 1, Ch 2, Stereo, or 
Mono Mix.

For detailed information on these settings, see “Controls and Information in the Clip Settings 
Tab” on page 236.

Capturing Video and Audio
There are three ways you can capture video in Final Cut Pro.

m Capture Now:  This lets you capture live video from camcorders or decks, with or without 
device control. This command is convenient to use with video that you capture from an 
analog source, such as VHS, Hi-8, or from an analog-to-DV FireWire converter box. If you 
use Capture Now with a device that’s supplying timecode, that timecode is captured along 
with your clip.

Note:  The limit for this option in Preferences is approximate. Extra time may be added.

m Capture Clip:  This option captures video, one clip at a time, from a camcorder or deck 
with device control. This command is useful if you want to capture a few clips as soon as 
you identify where they are on the tape.

m Capture Batch:  This lets you do a batch capture, or capture your clips all at one time. 
Before you can do this, however, you must have logged clips in your project. Once you 
start the batch capture process it’s fairly automatic; Final Cut Pro stops only to request the 
insertion of the next video reel. 

You can also use this option to recapture clips, whether they’re online or offline. If 
you batch capture a group of previously captured online clips, the original media files 
are deleted.

There are several things to keep in mind before and during the capture process.

m When working with DV material, it's best to capture from the original media. If you 
experience difficulties capturing from mini-DV tapes that have been duplicated from 
DV-CAM originals, try capturing from the original DV-CAM media.
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m Final Cut Pro supports file sizes larger than 2 GB. However, some hardware and software 
products by other manufacturers may not support large files. 

Using Capture Now Without Device Control

If your equipment doesn’t support device control, you must manually capture your clips 
while a tape is playing using the Capture Now button.

To capture a clip without device control:

1 Make sure your video equipment is properly connected and turned on.

2 Insert a tape that includes clips you want to capture.

3 Choose Log and Capture from the File menu.

4 In the Log and Capture window, click the Logging tab and enter any desired information.

For more information, see “Logging Clips” on page 255.

5 Click the Clip Settings tab and change any desired settings.

For more information, see “Controls and Information in the Clip Settings Tab” on page 236 
and “Adjusting Clip Settings in Preparation for Logging and Capturing” on page 264.

6 Use the camcorder or deck’s controls to locate the footage you want to capture.

7 Rewind the tape about 10 seconds prior to the material you want.

8 Press the Play button on your equipment when you’re ready to begin recording.

Important  When you capture without using device control, you won’t be able to perform 
an automated batch recapture.

Click these tabs 
to change any 
necessary settings.
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9 A few seconds before the first frame of the clip you want to capture, click Capture Now or 
press Shift-C.

10 To stop recording, press Esc, then press the Stop button on your video equipment. The clip 
opens in a separate Viewer window. 

It’s a good idea to capture several seconds beyond the point where you want to end the clip. 

11 Use the controls in the Viewer to play the clip and make sure it’s what you want.

12 Save the clip by doing one of the following:

m To add the captured clip to your current project:  Drag the clip from the Viewer to a 
selected (or open) log bin in the Browser or to an open sequence in the Timeline.

Click here to capture a clip 
without device control.

To save the clip in the 
Browser, drag it to a bin.

You can also drag the 
clip to a sequence 
in the Timeline.
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m To save the clip outside the current project:  Choose Save Clip As from the File menu. 
Choose a location where you want to save the file, enter a name for the clip, then click Save.

Note:  The file is saved to the specified Capture Scratch folder for your current project.

Even though your clip is on disk, if you close the clip’s Viewer window without saving it and 
ignore the save prompt, it will be discarded.

Using Capture Now With Device Control

If your equipment supports device control, you can manually log and capture clips while the 
tape is playing. As long as device control is enabled, you can capture timecode along with 
your clips using the Capture Now button.

To use Capture Now with device control:

1 Make sure your video equipment is properly connected and turned on and device control is 
properly set up.

2 Insert a tape that includes clips you want to capture. 

3 Choose Log and Capture from the File menu.

Choose a place
to save the file.

If you want, enter
a name for the file.

Click these tabs 
to change any 
necessary settings.
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4 Click the Logging tab and enter any desired information. 

In particular, make sure that the reel number is properly set to reflect your current tape. For 
more information, see “Logging Clips” on page 255.

5 Click the Clip Settings tab and change any desired settings.

For more information, see “Controls and Information in the Clip Settings Tab” on page 236 
and “Adjusting Clip Settings in Preparation for Logging and Capturing” on page 264.

6 Use the controls in the Log and Capture window to locate the footage to capture. 

7 Rewind the tape about 10 seconds prior to the material you want.

8 Press the Play button or the Space bar when you’re ready to begin recording.

9 A few seconds before the first frame of the clip you want to capture, click Capture Now or 
press Shift-C.

10 To stop recording, press Esc, then press the Stop button. The clip opens in a separate Viewer 
window.

Note:  It’s a good idea to capture several seconds beyond the point where you want to end 
the clip. 

11 Use the controls in the Viewer to play the clip and make sure it’s what you want.

12 Save the clip by doing one of the following:

Use the transport 
controls to find the clip 
you want to capture.

Click here to capture a clip.
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m To add the captured clip to your current project:  Drag the clip from the Viewer to a 
selected (or open) logging bin in the Browser or to an open sequence in the Timeline.

m To save the clip outside the current project:  Choose Save Clip As from the File menu. 
Choose a location where you want to save the file, enter a name for the clip, then click Save.

Even though your clip is on disk, if you close the clip’s Viewer window without saving it and 
ignore the save prompt, it will be discarded.

Note:  If you choose Save (Command-S), the file is saved to the specified Capture Scratch 
folder for your current project.

To save the clip in the 
Browser, drag it to a bin.

You can also drag the 
clip to a sequence 
in the Timeline.

Choose a place
to save the file.

If you want, enter a
name for the file.
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Using Capture Clip

If you have device control enabled, but you only want to capture one clip at a time, as 
opposed to an entire group of clips, you can use the Capture Clip button. This allows 
you to capture individual clips much more precisely than if you were to use the Capture 
Now command.

To capture a clip with device control:

1 Make sure your video equipment is properly connected and that device control is turned on.

2 If your deck or camcorder has a Local/Remote switch, make sure it’s set to Remote. 

For more information, see the documentation that came with your video equipment.

3 Insert a reel, or tape, that includes clips you want to capture.

4 Choose Log and Capture from the File menu.

5 Click the Logging tab and enter any desired information. 

In particular, make sure that the reel number is properly set to reflect your current tape. 
For more information, see “Logging Clips” on page 255.

6 Click the Clip Settings tab and enter the desired settings.

For more information, see “Controls and Information in the Clip Settings Tab” on page 236 
and “Adjusting Clip Settings in Preparation for Logging and Capturing” on page 264.

Click these tabs 
to change any 
necessary settings.
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7 Shuttle through your tape and mark the clip you want to capture by doing one of 
the following:

m Click the Mark In and Mark Out buttons to set In and Out points.

m Enter a timecode for the In point in the left timecode field and a timecode for the Out 
point in the right timecode field at the bottom of the Log and Capture window.

m Press I to set an In point and press O to set an Out point.

8 Click the Capture Clip button.

9 If the Prompt checkbox is selected in the Logging tab, a Log Clip dialog will appear. Enter or 
change any information for this clip, then click OK.

Final Cut Pro captures the clip and it appears in the Viewer. The clip is saved outside the 
current project, in the selected log bin.

Mark In button Mark Out button

Enter the In point 
timecode here.

Enter the Out point
timecode here.

Click here to capture a clip.

Click the Slate button to 
increment the clip name.

Click here to mark the 
clip as Good.

If desired, enter additional 
notes here.
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10 To add the captured clip to your current project, drag it from the Viewer to an open 
sequence in the Timeline or to a selected (or open) log bin in the Browser.

Capturing Clips All at Once
After you review and log all the media on a source tape, or reel, you can capture all the clips 
from all your tapes in one operation, called a batch capture. Batch capture is an automated 
process and can be done unattended. However, if you’re capturing from multiple reels, you’ll 
need to insert new tapes when Final Cut Pro’s ready for them (a message will appear).

Note:  You can only do an automated batch capture if your camcorder or deck supports 
device control.

You can batch capture the following types of clips:

m a group of clips you’ve logged with Final Cut Pro

m clips in a text file, or batch list, that you’ve imported from another application or project

(See “Importing a Batch List” on page 260.)

m clips from an Edit Decision List that you’ve imported 

(See Chapter 10, “Importing Edit Decision Lists (EDLs),” on page 313.)

m previously captured online clips that you want to recapture using different settings 

(See “Recapturing Clips” on page 279.)

To save the clip in the 
Browser, drag it to a bin.

You can also drag the 
clip to a sequence in 
the Timeline.
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Preparing to Batch Capture

Since batch capture is an automated process, make sure all your settings and preferences are 
correct before starting the process.

Things to check before performing a batch capture:

m Make sure that you accounted for any timecode breaks when you logged your tapes. If 
you’re capturing from mini-DV format tapes, you should have separate reel numbers for 
each section of tape with timecode reset to 00:00:00:00 as a result of a timecode break. 

For example, let’s say you have a mini-DV tape with footage from 00:00:00:00 to 
00:30:00:00 and then there’s a timecode break. You could name the first half of the tape 
reel “4A,” and the second half of your tape (which goes from 00:30:00:00 through the end 
of the tape reel), “4B.”

If you’re using another video format that doesn’t reset the timecode, make sure you avoid 
timecode breaks in the clips that you capture. Otherwise, Final Cut Pro won’t be able to 
capture the correct media for your logged clips.

m Make sure the capture and scratch disk preferences are correct; if not, make any 
necessary changes. You won’t be able to change these once you start the batch capture 
process. For more information, see “Specifying Capture Preferences From the Log and 
Capture Window” on page 262.

m If you’re capturing a lot of clips and the first specified scratch disk is getting full, make 
sure you select additional scratch disks. This way Final Cut Pro can automatically start 
saving on another disk and the capture process won’t be interrupted. 

If you only have one volume, make sure that it has enough room for your capture. In the 
Log and Capture window, click the Capture Settings tab and check the free space listed 
next to the Scratch Disks button. Compare this to the space needed in the Batch Capture 
dialog box.

m When you log offline clips, it’s possible to create two or more clips with the same name. 
When you batch capture, all clips in the same scratch disk and folder must have unique 
file names. Since clip names are used as filenames, you’ll need to change any duplicate 
names before you capture.

m If you set up a batch capture that includes two clips with the same name, a dialog box 
appears to let you change the name of one of the clips.

m If a clip to be captured already exists on disk, a dialog box appears where you can 
rename the new clip, skip capturing it, or replace the old clip with the new one.
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Doing a Batch Capture

You can do a batch capture from the Log and Capture window or use the Batch 
Capture command.

To batch capture clips:

1 Select the clips you want to capture in the Browser.

m Select individual clips in one or more bins.

For more information, see “Selecting Items in the Browser” on page 179.

m Control-click the desired bin, then choose Set Logging Bin from the shortcut menu. The 
log bin can have other bins inside of it or you can have your entire project be your log bin 
if you want to capture clips from all of your project’s bins.

2 Do one of the following:

m If the Log and Capture window is open, click Capture Batch. 

m Choose Batch Capture from the File menu (press Command-H). 

m Control-click the selected items in the Browser, then choose Capture from the 
shortcut menu.

Note:  The options in the Capture pop-up menu in the Batch Capture dialog box, described 
in step 3, will be limited to Selected Items if you choose Batch Capture from the File menu or 
from a shortcut menu.

The selected
log bin has a

slate icon next to it.
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3 In the Batch Capture dialog box, choose the kind of clips you want to capture from the 
Capture pop-up menu.

m Offline Items in Logging Bin:  Captures only the offline clips in the log bin. If there are no 
offline clips available, this option doesn’t appear.

m All Items in Logging Bin:  Captures or recaptures all clips in the log bin, whether or not 
they’ve already been captured. If there are only offline clips in the log bin, this is the only 
option available.

If you’re recapturing online clips to the same folder on the same scratch disk that you 
originally captured your clips to, your online clips will be overwritten. If you’re 
recapturing online clips and the currently selected scratch disk is different from the one 
the original clips are in, your original clips will be preserved.

m Selected Items in Logging Bin:  If you selected specific clips in your log bin, you can 
choose to capture only these. This is a good way to capture or recapture clips from a 
specific reel or a limited number of clips that you isolate using the Find command or by 
sorting a specific Browser column. 

Select the desired options.

Select your capture settings.

Choose the kind of
clips you want to
capture from this

pop-up menu.

These calculations are
based on the capture

settings you specify.
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4 Choose your desired capture options.

m Coalesce Overlapping Clips:  Check this box to combine any overlapping clips into a single 
media file. This can save disk space and cut down on capture time. Overlapping clips still 
appear as separate items in the Browser, but they all reference the same media file. 

m Use Logged Clip Settings:  Check this box to capture all your clips using the settings you 
specified for each individual clip during the logging process. If this box is unchecked, all 
your clips will be captured using the current settings in the Clip Settings tab. For more 
information, see “Adjusting Clip Settings in Preparation for Logging and Capturing” on 
page 264.

m Add Handles:  Check this box to capture additional frames, called handles, before and 
after the In and Out points of a clip. Then enter a duration in the timecode field. 

Handles are useful if you’ve logged your clips starting at precisely the first and last frames 
that you thought you wanted to use, but you now want to add a little bit more in case you 
want additional frames for performing dissolves and other transitions.

5 Choose a capture setting from the Capture Preset pop-up menu. 

This pop-up menu includes the same settings available in the Capture Presets tab of the 
Audio/Video Settings window. 

6 When you’re ready to capture, click OK.

Click the checkboxes
to specify your

capture options.

If you’re adding handles, enter
the desired duration here.

Choose the desired capture 
preset in this pop-up menu.

Summary of 
capture settings
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7 You’re prompted with a list of all the reels needed for capture. Click a reel in the list, then 
click Continue.

Final Cut Pro captures all of the clips on that reel, then prompts you to select another, until 
all the clips you’ve specified have been captured.

A Batch Capture Example

Batch Capture and the Find command within Final Cut Pro provide a powerful opportunity for 
you to locate and capture (or recapture) clips based on specific properties. For example, you 
can batch capture only clips in your logging bin that are marked Good.

To batch capture selected clips from a search:

1 Click the Browser to make it active, then choose Find from the Edit menu.

2 In the Find window, choose “Good Y/N” from the appropriate pop-up menu.

3 Enter “Y” in the text field to search for all columns marked Good, then click Find All.

4 In the resulting Find Results window, choose Select All from the Edit menu, or press 
Command-A, to select all of the clips. 

The corresponding clips in the Browser are selected.

5 Now, you’re ready to do a batch capture using the Batch Capture command (see “Doing a 
Batch Capture” on page 275).

This is just one of several different ways you can select multiple clips based on various logged 
clip settings.

Choose the Good 
column to search.

Enter Y to search for 
clips with the Marked 
Good setting selected.

Click here to find 
all clips with this 
property.
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Stopping and Restarting a Batch Capture

To stop a batch capture at any time:

m Press Esc, or click the mouse button.

All clips that weren’t captured are labeled “Aborted” in the Digitize column in the Browser.

To restart the batch capture process:

1 Choose Batch Capture from the File menu.

2 In the Batch Capture dialog box, choose Aborted Clips from the Capture pop-up menu.

3 Follow the same steps in the section “Doing a Batch Capture” on page 275.

Recapturing Clips

The main reason you may want to recapture clips that you’ve already captured is if 
you originally captured your clips at a lower quality and data rate so more clips can be 
stored on your hard disks. You’ll typically capture more video than you’ll use in your final 
edited sequence. 

Once you’ve finished your edit, you can use the Media Manager to create a new, streamlined 
version of your edited sequence, omitting all unused media. (See “About the Media Manager” 
on page 859.)

There are several things you can do using the Media Manager to help streamline your 
workflow during the capture and recapture process.

m Capture clips at a lower resolution, then recapture the clips at a higher resolution towards 
the end of your project. You can then use the Media Manager to create a duplicate of your 
edited sequence to weed out all your unused clips, recapturing only the ones you need.

m Even if you’re not recapturing at a different data rate, if you find yourself needing 
additional disk space (for example, if you have a lot of long clips that you only use parts 
of ), the Media Manager can help. You can use the Media Manager to create a duplicate of 
your currently selected sequence as an offline sequence that contains only the parts of 
the clips that you’re currently using. You can then discard your original source media and 
recapture all necessary clips using the new duplicate sequence. 

m Capture an entire tape, make subclips of all the shots you want to use, then use the 
Media Manager to remove all unused footage. If you’re using DV tapes, you can use the 
DV Start/Stop Detection tool to automatically mark all of your takes in preparation for 
creating subclips. For more information, see “Creating and Working With Subclips” on 
page 386 and “Creating Subclips Using DV Clips and Start/Stop Detection” on page 399.
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Note:  If you’re capturing an entire tape in order to follow the above workflow, it’s 
vital to make sure that your tape has no timecode breaks! If it does, you’ll need to capture 
each section of tape in between your timecode breaks individually, or your timecode will 
be incorrect.

Creating a Preset to Capture Audio Only
Using Final Cut Pro and a compatible audio capture interface, you can capture analog audio 
from nearly any audio source:  a cassette player, television, or even a device-controllable DAT 
player with timecode. This is useful for bringing in audio that you want to use for narration, 
sound effects, ambient tracks, or second source audio that was recorded in sync with your 
video.

Capturing audio is the same as capturing video; you only need to change your input device. 
When you change your input device, it’s a good idea to create and save a new audio-only 
capture preset for future use. 

To create an audio-only capture preset:

1 Choose Audio/Video Settings from the Edit menu, then click the Capture Presets tab.

2 Click a preset, then click Duplicate. Final Cut Pro automatically duplicates the selected preset 
and opens a new Capture Preset Editor window. 
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3 In the Capture Preset Editor, adjust the following settings, then click OK.

a Enter a new name.

b In the Quicktime Video Settings section, choose None from the Digitizer pop-up menu.

c In the Quicktime Audio Settings section, set the Device pop-up menu to Built-In (if you’re 
using your microphone input) or the name of your Sound Manager-compliant audio 
capture interface.

d If you chose Built-In, choose External Mic from the Input pop-up menu. 

e Choose the appropriate audio rate from the pop-up menu:

m 32 kHz:  If you’re recording from a DV camera set to 12-bit recording

m 44.1kHz:  If you’re using your microphone input or other audio interface

m 48 kHz:  If you’re recording from an audio interface capable of this rate or if you’re 
recording from a DV camera set to 16-bit recording.

For detailed information about other settings in the Capture Preset Editor, see “About 
Capture Preset Settings” on page 121.

Enter a name
and appropriate

description for your
audio capture preset.

Make sure you
choose None in

this pop-up menu.

Choose Built-in from
this pop-up menu.

Choose External Mic
from this pop-up menu.

Choose the desired 
audio rate from this 
pop-up menu.
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To capture audio in Final Cut Pro:

1 Choose Log and Capture from the File menu.

2 Click the Capture Settings tab and do one of the following:

m If you’re using a device-controllable audio source (such as a professional DAT 
deck):  Choose the appropriate method of device control from the Device Control 
pop-up menu. See the documentation that came with your device for more information.

m If you’re not using device control:  Choose None from the Device Control pop-up menu.

3 Make sure that your new audio-only capture setting is selected in the Capture/Input pop-up 
menu.

4 Use your audio equipment’s controls to locate the audio you want to capture.

5 Before recording your audio clip, click the Clip Settings tab, then play back the audio clip you 
want to record. 

Make sure that the maximum audio level of your clip doesn’t go into the red zone of the 
audio meter. It’s a good idea to keep your clip’s maximum audio level at about –12 dB.

Choose the appropriate 
device control preset.

Make sure you select 
the appropriate audio 
capture preset.

Make sure the audio level 
doesn’t go above –12 dB.
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6 Cue your audio clip to about 10 seconds prior to the material you want, then press the Play 
button on the equipment.

7 A few seconds before the first sound in the audio clip you want to capture, click the Capture 
Now button in the Log and Capture window.

8 To stop recording, press Esc, then press the Stop button on your audio equipment.

It’s a good idea to capture several seconds beyond the point where you want to end the clip. 

9 The clip opens in a separate Viewer window. 

Use the controls in the Viewer to play the clip and make sure it’s what you want.

10 Save the clip by doing one of the following:

m To add the captured clip to your current project:  Drag the clip from the Viewer to a 
selected (or open) log bin in the Browser or to an open sequence in the Timeline.

To save the clip in the 
Browser, drag it to a bin.

You can also drag the 
clip to a sequence in 
the Timeline.
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m To save the clip outside the current project:  Choose Save Clip As from the File menu. 
Choose a location where you want to save the file on disk, enter a name for the clip, then 
click Save.

Even though your clip is on disk, if you close the clip’s Viewer window without saving it and 
ignore the save prompt, it will be discarded.

Planning Ahead for Audio Export

Once you’ve finished with your edit, you can export your audio to a digital audio workstation 
(DAW) for more intensive audio editing at a post-production studio specializing in sound 
sweetening. There are two ways to export your audio:

m as an OMF file (see Chapter 30, “About Multi-Track and OMF Audio Export,” on page 1211) 

m as an EDL so that your audio can be recaptured at the other studio (see Chapter 29, 
“Working With Edit Decision Lists (EDLs) and Batch Lists,” on page 1191)

Before you export audio, however, it’s important to plan ahead during the capture process so 
that your audio export goes smoothly.

Quality Control for OMF Export

Many editors may want to move their audio out of Final Cut Pro using OMF export. OMF 
export moves all of the audio in your edited sequence into a self-contained file, with all In 
and Out points preserved in relation to the total duration of the project. 

This makes export a simple process. Importing your audio into a digital audio workstation 
(DAW) depends on that application’s ability to import the OMF format. Most popular DAWs are 
able to do this, but it’s best to find out in advance. Another advantage of OMF export is that all 
of the edit points are preserved, so the editor at your audio facility can start working 
immediately after the OMF file has been imported and resynchronized to your video.

Choose a place
to save the file.

If you want, enter a
name for the file.
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However, because an OMF file contains your audio exactly as it was imported into your 
computer, the audio quality depends on two things:  the quality of your capture hardware 
and your ability to capture audio at the proper levels. It’s critical that your captured audio not 
be too quiet; if it is, the audio will be closer to the noise floor of your recording and be less 
“clean.” It’s also important to make sure that your recording is not too loud, or “hot.” If that 
happens, you may overdrive the recorded level of your audio and get periodic bits of 
distortion whenever the audio level goes too deep into the red.

Even if your levels are correct, it’s a very good idea to use a capture interface other than the 
built-in microphone port that comes with your computer to record audio that you plan on 
using in your final product. The microphone port is fairly noisy compared to the inputs of 
higher-end audio workstation hardware. A better option would be to use the audio interface 
of a third-party video capture card or a dedicated third-party audio capture card.

If you’re using music and sound effects imported from CD or CD-ROM or audio imported 
digitally from DV video or DAT (Digital Audio Tape), you don’t have to worry. This audio is 
almost always captured using the appropriate hardware and at the proper levels, making 
OMF export easy. You have to be careful of your levels and audio capture interface especially 
when you’re importing material from analog tape.

For detailed information on OMF export, see Chapter 30, “About Multi-Track 
and OMF Audio Export,” on page 1211.

Rerecording Audio Onto Device-Controllable Masters for EDL Export

If you don’t plan on using OMF export (for example, if your audio editor will rerecord all of 
the audio material you used in your edit for further editing and mixing), you can export an 
EDL, or Edit Decision List. EDLs were originally developed for video export to describe the In 
and Out points of each shot relative to the duration of the entire program. However, EDLS 
also describe the audio of each edit as well. EDLs themselves are plain text files; they only 
describe the edits of a program and contain no media clips.

EDLs can be used to describe the editing of audio clips imported using a timecode- 
controllable source, such as timecoded DAT tape, or videotape formats (including Beta SP, 
Digital Betacam, and DV ), for export to a digital audio workstation (DAW). The DAW ignores 
the video and imports just the audio information.

The advantage of this is that once an EDL is imported into the DAW at the audio post-
production facility, all media clips described by SMPTE timecode on the list will be 
recaptured by the audio engineer using their equipment. Since the engineers are recreating 
all of the audio directly from the source tapes using workstations with dedicated high-end 
audio hardware, you can be assured of the highest possible quality.
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The drawback is that EDL export only works with audio clips that were captured from a 
timecode-capable source. If you recorded clips from non-device-controllable sources, non-
timecode DAT tapes, non-timecode reel-to-reel tape recorders, or other video and audio tape 
formats, Final Cut Pro can’t add these to the EDL.

There is a way around this. Before you log and capture, dub all of the non-timecoded audio 
material onto device-controllable formats using SMPTE timecode. Device-controllable DAT 
decks, device-controllable video decks, and DV decks capable of serial device control are all 
acceptable, but ones that only use DV framecode with FireWire are not. 

Once you’ve moved all of your non-timecoded audio material onto timecoded tape formats, 
you can log and capture your audio the same way you’d log and capture video, knowing that 
all of your audio edits can now be described in an exported EDL.

CD
Cassette

Media without timecode

DAT without
timecode

DAT with
timecode

DV tape

Media with timecode
286 Chapter  8   



C H A P T E R

9

9 Importing Graphics, QuickTime, 

and Audio Files
In addition to capturing video and audio clips from tape, you can import a variety of digital 
video and audio file types into Final Cut Pro projects, including QuickTime video clips, AIFF 
and Wave sound files, and still images. Imported files appear as clips in the Browser and are 
references to the corresponding source files on your hard disk. (For more information, see 
Chapter 7, “Using the Browser and Managing Projects and Clips,” on page 161.)

Because Final Cut Pro supports many file formats, you typically won’t have to save media files 
in a different format before importing them into Final Cut Pro. Also, you don’t have to make 
backup copies of your original media files since Final Cut Pro is a nondestructive editing 
application. Nothing you do during the editing process, except for changing the timecode 
and reel number of a clip, affects source media on disk. ( You may want to back up your files 
regularly in case of hard disk problems, however.)

This shows a variety of
clips in the Browser.
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Supported File Formats for Importing
Final Cut Pro is a QuickTime standard application, so it supports standard QuickTime-
compatible file formats. You can import the following file formats into Final Cut Pro projects 
and sequences:
m Graphics

BMP, FlashPix, GIF, JPEG/ JFIF, MacPaint (PNTG), Photoshop (PSD), PICS, PICT, PNG, 
QuickTime Image File (QTIF), SGI, TARGA (TGA), and TIFF

m Video

AVI, QuickTime Movie
m Audio

AIFF, Audio CD Data (Macintosh), Sound, and Wave
m Special formats

Macromedia Flash (video only; you won’t be able to play any audio portions)

For information about the more commonly used formats, see Chapter 6, “Acquisition 
Strategies,” on page 145. For a complete list of all QuickTime-compatible file formats, see the 
documentation that came with QuickTime Pro or visit Apple’s QuickTime Web site at 
www.apple.com/quicktime

Importing Media Files Into Final Cut Pro
You can import media files one at a time, by folder, or by groups of folders. If you import a 
group of folders, one folder inside another, Final Cut Pro imports all files in each folder and 
subfolder that are in formats it recognizes; unsupported file types are ignored. Folders 
imported into your project appear as bins in the Browser. If you import a group of folders, 
Final Cut Pro creates bins and organizes the files in the same hierarchy as on your hard disk. 

Note:  When importing reference movies, the only file that will be recognized by Final Cut 
Pro is the main file that contains the references (to the other associated files). You may see 
error messages, such as “file unknown,” if you try to open these referenced files.

Important  If you import files from removable storage media, such as a CD, make sure you 
copy the files to the hard disk and folder where you want your project media stored. If you 
don’t, the clips will become offline when you remove the media from your drive.
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To import a file or folder:

1 In the Finder, copy or move the files and folders you want to import to the desired project 
folder and hard disk. 

While not necessary, it’s a good idea to keep all of the media files used for any given project 
together, for organizational purposes. When you back up or archive your project file, you’ll 
also want to back up or archive any graphics, audio, or QuickTime files that weren’t captured 
from tape, so they don’t get lost.

2 In the Browser, select a destination.

m To import files or folders into the main, or root, level of a project, click that project’s tab.

m To import files into a bin within a project, double-click the bin. The bin opens in a 
separate window. 

For more information, see “Using Bins to Organize Your Clips” on page 184.

3 Do one of the following:

m Drag the desired files or folders from your desktop to a project tab or bin in the Browser. 
This is a fast and easy way to import many files.

To place imported
files into a bin,

double-click the bin.

To import files at the
main level, click a

project’s tab.
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m Choose Import from the File menu, then choose File or Folder from the submenu. (To 
import a file, you can also press Command-I.) Select a file or folder in the dialog box, then 
click Open.

m Control-click in the Browser or a bin’s window, then choose Import File or Import Folder 
from the shortcut menu. Select a file or folder in the dialog box, then click Open.

m Drag the desired files or folders from your desktop to the Timeline of a sequence. 

Locate the file
(or folder) you

want to import,
then click Open.

Choose an import
option, then in the

dialog box that
appears, locate the file

or folder you want to
import and click Open.

Clips you drag directly to 
the Timeline do not appear 
in the Browser.
290 Chapter  9   



This places a reference to the source media in the Timeline, but does not place a 
reference in the Browser. Sequences can contain clips that aren’t in the Browser. These 
sequences are “edited bins” that contain clips of their own. For example, if you import an 
Edit Decision List (EDL), the sequence that’s created contains only offline clips. These 
clips aren’t found in the Browser; they are only inside of this sequence.

4 Save your project.

For more information, see “Creating and Saving Projects” on page 173.

About Importing QuickTime Files
You can import any QuickTime movie clip into a project if you have the correct codec 
installed on your computer. If the clip uses a third-party codec you don’t have, check with the 
clip’s creator to see if you can get the codec. For more information on QuickTime codecs, 
see “What’s a Codec?” on page 147.

Using Imported Clips and Sequence Settings

You can import QuickTime movie clips into a project even if the clip’s frame size, frame rate, 
and codec are different from those of your sequence preset. However, any media clips in the 
sequence that do not use the same settings as your sequence need to be rendered before 
you can properly play your edited sequences. For more information, see “About Sequence 
Presets” on page 113.

For example, let’s say your project and sequences are set up to edit DV-format video with a 
frame size of 720 x 480, a frame rate of 29.97 fps, and the Apple DV-NTSC codec. Then you 
import a QuickTime video with a frame size of 640 x 480, a frame rate of 29.97 fps, using the 
Animation codec. When you edit this clip into your sequence, a red bar appears above the 
clip in the Timeline, indicating it needs to be rendered. When you view the clip in the 
Canvas, there’s a black border around it because the Canvas is set to properly view clips at 
720 x 486.
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About Field Dominance

Another clip property you need to consider is field dominance. (For more information, see 
the next section, “What Is Field Dominance?” on page 293.) All clips used in a sequence must 
have the same field dominance. If you’re editing clips that you captured yourself, field 
dominance won’t be a problem. It’s only when you import clips from another system that 
you need to be careful. Clips imported with an incorrect field dominance stutter during 
playback because each pair of fields plays back in the wrong order. 

For example, DV-NTSC and DV-PAL have a field dominance of Lower. If you’re working on a 
sequence that was captured using DV-NTSC and you want to import additional clips that 
were captured on another system using a third-party capture card, see the documentation 
that came with that system to determine its field dominance. You’ll need to make sure the 
field dominance of those additional clips matches the field dominance of your edited 
sequence.

Also, if your imported QuickTime clips are interlaced, the field dominance of these clips 
must match that of your other captured clips, or the imported clips won’t play back properly 
even after rendering. 

Important  You only need to change the Field Dominance setting of your projects and 
sequences when you change your video hardware setup.
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What Is Field Dominance?

All video displays, whether analog or digital, work by breaking a single frame of video 
into individual lines of horizontal resolution running across the screen. NTSC and PAL 
are both interlaced video formats, as opposed to video displayed on a computer 
screen, which uses progressive scanning. With progressive scanning, these lines are 
drawn one at a time, from the top of the screen to the bottom. 

Interlaced video, including NTSC and PAL, works differently. When you record footage 
with your camcorder, each individual video frame is broken down into two fields, each 
containing half of the total lines of resolution in the frame. The first field is recorded, 
then the second, then both are laid down to tape, one after the other, so both fields 
constitute one frame. When you play the tape back, a television monitor displays each 
recorded frame in two passes, first drawing field 1, then drawing field 2.

Field dominance refers to the order in which video fields are recorded from your video 
equipment to your hard disk. If you remember that video fields come one after 
another in time, as if playing 60 “frames” per second, it becomes a little easier to 
understand. 

In Final Cut Pro, there are two options for field dominance:

m Upper (Field 2 is dominant, so the second field is drawn first)

m Lower (Field 1 is dominant, so the first field is drawn first)

Generally, Upper is used by 640 x 480 systems, while Lower is most common in 
professional 720 x 486 and DV 720 x 480 systems. Video capture cards can be either 
Upper or Lower. 

It's important to render digital video with the field dominance used by your hardware. 
Since motion continues from one field to the next, it’s crucial that each field play in 
the correct order. Also, different capture cards handle interlacing differently, so 
choosing the correct field dominance allows for proper playback.
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Importing Clips With Alpha Channels

Some clips and images you import may have alpha channels. Ordinary video clips have three 
channels of information for the red, green, and blue channels respectively. An alpha channel 
contains additional information that defines areas of transparency in the movie. 

When you import a QuickTime movie or an image file, its alpha channel is immediately 
recognized by Final Cut Pro. After you edit this clip into a sequence, Final Cut Pro uses the 
alpha channel for compositing against background layers. You can turn off alpha channels if 
you decide not to use them. 

Types of Alpha Channels

Final Cut Pro recognizes three kinds of alpha channels:

m Straight:  Typically generated in a 3D animation or compositing program, straight alpha 
channels contain only the pixels rendered for an image, with no background (although 
the background appears black). Because of this, movies with translucent effects, like 
volumetric lighting or lens flares, appear distorted unless they’re composited with 
something in the background. Movies or images with a straight alpha channel are easy to 
composite and always have very clean edges when composited in a multilayered 
sequence.

m Black:  This type of alpha channel is precomposited against black. Alpha channels, 
particularly ones that are hand-drawn in Photoshop, are premultiplied. Movies with alpha 
channels premultiplied against black always look right, even if they have translucent 
lighting effects, because the entire image is precomposited against black.

m White:  White alpha channels work the same as the black alpha channel, except that the 
clip is precomposited against white.

Important  When you import a clip with an alpha channel that contains no data, the clip 
appears white. To display the clip properly, change the alpha channel for the clip to None 
(see “Correctly Identifying Alpha Channels” on page 295).
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Correctly Identifying Alpha Channels

It’s important that you correctly identify alpha channels. For example, if a clip with a black 
alpha channel is incorrectly identified as having a straight alpha channel, a black fringe 
appears around the edges of the imported image. To view the image properly, you’d need to 
change the alpha channel setting in the clip’s Item Properties window. 

Some editing and compositing applications output alpha channels that are the reverse of 
what Final Cut Pro uses. If you use a clip or image from these applications, the areas that are 
supposed to be transparent are solid and the areas that are supposed to be solid are 
transparent. To view the clip correctly, you must reverse the alpha channel. 

To change or reverse the alpha channel type of a clip:

1 Do one of the following:

m Select a clip in the Browser, then choose Item Properties from the Edit menu.

m Select a clip in the Browser, then press Command-I.

m Control-click a clip in the Browser, then choose Item Properties from the shortcut menu.

2 In the Item Properties window, choose the alpha channel type—None/Ignore, Straight, Black, 
or White.

3 If desired, click the Reverse Alpha checkbox.

Choose the desired alpha channel 
type from this pop-up menu.Click this checkbox

to set the alpha
channel to the

reverse, if necessary.
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If your editing and compositing application outputs alpha channels that are the reverse of 
what Final Cut Pro uses, you must reverse the alpha channel to view the clip properly.

About Importing Still Images
When you import a still image, it becomes a clip that’s approximately two minutes of 
identical video frames, with a default duration of 10 seconds between the In and Out points. 
If you like, you can change the duration in the General tab of the Preferences window. For 
more information, see “Setting General Preferences” on page 885.

Once edited into a sequence, still images need to be rendered unless you are using a real-
time system. For more information, see Chapter 23, “Rendering,” on page 1065.

Using Square or Non-Square Pixels When Creating Graphics

When you’re preparing to import graphics into Final Cut Pro, it’s important to be aware of 
the pixel aspect ratio you’re using and whether your project requires you to work with 
square or non-square pixels.

m Non-square pixels:  Use this for projects that are going to standard definition tape in 
NTSC or PAL.

m Square pixels:  Use this for high definition video projects, as well as multimedia video that 
will be played back only on computers and doesn’t use any captured video footage.

Graphics created on a computer, whether scanned, painted, or rendered, look distorted on a 
video monitor unless you account for the different pixel aspect ratio. Fortunately, this is easy 
to do, since every non-square video frame size has an equivalent square frame size that you 
can use to create your graphics.
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To create graphics that look correct when output to video:

1 In your graphics application, create a frame size that’s the square pixel equivalent of the 
video frame size you’re using.

See the chart below for equivalent sizes. For example, if you’re working in DV PAL with a 
non-square video frame size of 720 x 546, your graphic should have a square pixel frame 
size of 768 x 576.

2 Create your graphic.

3 Do one of the following:

m In your graphics program, rescale the graphic from the square frame size you created it 
with to the non-square equivalent used in Final Cut Pro.

After you import the image into Final Cut Pro, the graphic looks distorted, or squashed, 
on your computer display, but will look right when you output it to video. It’s a good idea 
to save this resized graphic in case you want to change it in the future (you can then 
reimport it into Final Cut Pro).

m Save your image as is. 

When you import your image into Final Cut Pro, it’s automatically set to the pixel type, or 
pixel aspect ratio, it was created with. You can change the pixel aspect ratio in the clip’s 
Item Properties window. For more information, see “Viewing and Changing the Properties 
of a Clip” on page 208.

Video format
Non-square pixel size 
(Final Cut Pro)

Square pixel size 
(graphics program)

601 NTSC 4:3 720 x 486 720 x 540

601 NTSC 16:9 Anamorphic 720 x 486 864 x 540

DV NTSC 4:3 720 x 480 720 x 534

DV NTSC 16:9 Anamorphic 720 x 480 864 x 540

601/DV PAL 720 x 546 768 x 576
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Working With Standard Definition (SD) Video Monitors and Computer 
Displays

Standard definition (SD) video monitors differ from computer displays in a significant way 
(aside from interlacing): computer displays represent images using a grid of square pixels, 
while video monitors use pixels that are rectangular in shape. 

SD NTSC pixels are taller than computer pixels and SD PAL pixels are wider than computer 
pixels. As a result, a 720 x 486 pixel image looks different on a computer display than it does 
on a video monitor. For example, if you capture a clip of video with a globe in the picture, 
export a frame, and look at this frame in a graphics application, you’ll see something like this:

The Viewer and the Canvas let you display non-square pixel video correctly on the 
computer’s screen. This option is in the View pop-up menu in both windows.

Note:  High definition video uses only square pixels, so it doesn’t show this discrepancy.

720 X 486 Broadcast
(720 X 480 DV)

640 X 480

720 X 486 Broadcast
(720 X 480 DV)

640 X 480

Looks right on a video monitor

Square vs. non-square pixels

Looks wrong on a computer monitor
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Differences in Color Between Computer and Video Graphics

You should also be aware that the range of colors that can be displayed on a broadcast video 
monitor is much smaller than that which can be displayed on your computer. For this reason, 
colors that appear bright and clean on NTSC or PAL video can seem duller when viewed on 
your computer.

If you output graphics images with colors that go outside the “legal” range for video, they will 
appear oversaturated, and may “bleed” into other parts of the image. This distortion can be 
easily avoided by controlling the palette of colors you use in your graphics program. As you 
create the graphics you’ll be outputting to video, resist the temptation to use the brightest 
and most saturated shades of color available in your paint program. When you’re finished 
with your image, use a video colors filter (if your program has one) to make sure that all of 
the colors in your image are in the legal broadcast range for video.

Using Fonts and Creating Line Art for Video

When creating line art or selecting a font to use for a broadcast video image, you should 
avoid creating horizontal single-pixel lines, or using fonts that are too thin. Because video is 
interlaced, single-pixel lines will flicker as the field in which they appear alternates on and off. 
This will result in “buzzing” in your graphics, with the buzzing becoming more pronounced 
the closer thin areas in your image are to horizontal.

This can be mitigated by adding a bit of blur or anti-aliasing to your image, but the best thing 
to do is to avoid single-pixel lines altogether when creating graphics for broadcast.

Scaling Imported High-Resolution Graphics

Images that are scanned at high resolution, such as 300 dpi, look large when imported into 
Final Cut Pro because video uses a resolution of 72 dpi. A large image is useful if you want to 
pan and zoom in or out of the image, such as a scanned map or photograph. There won’t be 
any image degradation because you typically won’t have to zoom more than 100 percent.

If you zoom in on an image originally shot on video in 72 dpi, scaling it higher creates 
artifacts that you may not want to use, because you’d have to enlarge a 72 dpi image more 
than 100 percent.

Sometimes the frame size of your imported graphic doesn’t match the frame size of your 
edited sequence. If the frame size of the graphic is too large, only a small part of your image 
appears. If it’s too small, there is black around the border of the graphic. You can scale 
imported graphics so they fit exactly into your sequence’s image frame.
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To scale an imported graphic to a sequence’s frame size:

1 Edit the image in the desired sequence in the Timeline. 

2 Select the clip in the Timeline.

3 Choose Scale to Sequence from the Modify menu. 

The frame size of your image is scaled to that of your sequence so you can view the image 
properly in the sequence.

Changing the Duration of Still Images

When you import an image file, it has a default duration of 10 seconds. You can change the 
default duration several ways. There are also several ways to change the duration of a clip.

To change the default duration of still images:

1 Choose Edit from the Preferences window, then click the General tab.

2 Enter a new value in the Still/Freeze Duration field.
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To change a clip’s duration, do one of the following:

m In the Browser, double-click the Duration column for a clip, then enter a new duration.

m Double-click a clip in the Browser to open it in the Viewer, then enter a value in the Clip 
Duration field. 

m Select a clip in the Browser, then choose Item Properties from the Edit menu. Click the 
Timing tab, then enter a value in the Duration field. For more information, see “Changing 
Clip Properties in the Browser” on page 208.

Enter a new duration in 
the Duration column for 
the image.

Enter a new
duration here.

Click the Timing tab.

Then enter a new 
duration here.
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Importing Numbered Image Sequences

Numbered image sequences are the lowest-common-denominator file format for exchanging 
video across editing and compositing platforms. While QuickTime is increasingly used to 
exchange video clips between platforms, image sequences are still very common. 

There are two ways you can import numbered image sequences. You can import all of your 
image files, then edit them sequentially into a sequence. You can also use QuickTime Pro to 
convert a numbered image sequence into a QuickTime movie that can be imported into Final 
Cut Pro and used like any other clip.

Importing Individual Image Files

You can import a numbered image sequence as a set of individual image files. This gives you 
more flexibility because you have control over which files are imported and which of those 
are then edited into your sequence.

To import image files from a numbered image sequence:

1 Choose Preferences from the Edit menu. 

2 Set the Still/Freeze Duration value to one frame (00:00:00:01).

3 Open the project where you want to import the files.

For more information, see “Opening and Closing Projects” on page 177.

4 Import all of the image files associated with the numbered image sequence you want to use 
in your project.

Change the duration of 
the clip to one frame.
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For more information, see “Importing Media Files Into Final Cut Pro” on page 288.

5 Do one of the following:

m Choose New from the File menu, then choose Sequence from the submenu.

m Control-click in the Browser, then choose New Sequence from the shortcut menu.

6 Double-click the new sequence to open it in the Timeline.

7 Select the newly imported bin with all of the image clips in it, open it, and press Command-A 
to select all of these clips.

8 Drag the clips to the Insert section of the Edit Overlay in the Canvas.

You can now edit this sequence into other sequences.

Drag the clips to
the Insert section

of the Edit Overlay.
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Converting a Numbered Image Sequence Into a QuickTime Movie

You can use QuickTime Pro to convert a numbered image sequence into a QuickTime movie. 
This is useful if you want all of your images to be one single clip. You can then import the 
movie into Final Cut Pro and use it like any other clip.

To convert a numbered image sequence into a QuickTime movie:

1 Make sure that you’ve registered QuickTime Pro.

For more information, see “Unlocking QuickTime Pro” on page 46.

2 Open QuickTime Player.

3 Choose Open Image Sequence from the File menu.

4 Locate the first numbered file of the image sequence you want to import, then click Open.

5 In the Image Sequence Settings dialog box, choose a frame rate, then click OK.

If you’re importing broadcast resolution clips, choose 29.97 fps for NTSC or 25 fps for PAL.

Your image sequence is imported into QuickTime Player as an uncompressed video file.

6 Choose Save from the File menu.

Locate and select
the first file of your
image sequence.

Then click Open.

Choose a frame rate for the 
movie from this pop-up menu.
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7 Choose a location and enter a name for the file.

8 Choose an option for how you want to save the movie, then click Save.

m Save normally:   If you choose this option, QuickTime Player creates a reference movie 
that points to the original folder of image files. Since no data is actually duplicated, the 
reference movie itself is very small, takes very little hard disk space, and is quick to create. 
The resulting movie file is the same as a QuickTime movie file and can be imported into 
Final Cut Pro just like any other QuickTime file. 

Note:  Since a reference movie needs the original source material for playback, if you give 
this clip to someone else, you must giv‘e them the original image files as well.

m Make movie self-contained:  If you’re going to be giving this clip to someone else, the 
easiest thing to do is to make it self-contained. This type of movie takes longer to save and 
consumes more hard disk space than a reference movie. However, a self-contained movie 
isn’t dependent on other files and is a better option for exchanging and archiving files.

Because no compression is applied (other than any that may have been used in the original 
image sequence files), the saved movie is uncompressed and may not play back in real time. 
After you import the movie and edit it into a sequence, Final Cut Pro rerenders this clip using 
the codec specified in your sequence settings.

Choose a place
to save the file.

If you want, enter a
name for the file.

Choose a save option.
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About Importing Layered Photoshop Files

When you import a layered Photoshop file into Final Cut Pro, the file becomes a sequence in 
your project. All the layers of the source Photoshop file are composited together with a 
sequence frame size identical to the imported Photoshop file’s frame size. 

Note:  If you want to import a layered Photoshop file as a single clip, you must flatten the 
image in Photoshop, then import the file into Final Cut Pro.

The sequence Final Cut Pro creates has the same number of layers as there are in the 
imported file. The background layer appears in track V1 and each consecutive layer is in the 
same order as the original Photoshop file. If you change the order of the video tracks, the 
layering order changes. If the background in the Photoshop file is transparent, then the 
background of the new sequence is transparent as well and defaults to black. 

Layer opacity settings, layer modes, and visibility are preserved, but layer masks are not. If a 
Photoshop layer mode has no corresponding compositing mode in Final Cut Pro, that layer 
mode is ignored. For more information on compositing modes and compositing images in 
Final Cut Pro, see Chapter 21, “Compositing, Applying Motion Effects, and Using Keyframes,” 
on page 907.

An imported
Photoshop file

becomes a sequence
in the Browser.

The background layer becomes 
a clip in track V1, with other 
layers on the tracks above.

A Photoshop file is a
sequence with its own

tab in the Timeline.

Important  Changes you make to a Photoshop file after it’s imported into Final Cut Pro do 
not appear in the Final Cut Pro sequence. To update the sequence, you must delete the 
original Photoshop file from your project, then import the updated file.
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About Importing Audio Files
There are two kinds of audio files you can import into Final Cut Pro. You can import an audio 
file in any supported format from disk, just like any other media file, or you can import audio 
tracks from an audio CD directly into your project.

Note:  This version of Final Cut Pro does not support MP3 and QDesign audio files. If you 
want to use an MP3 audio file, convert it to an AIFF file using QuickTime Player or an MP3 
converter, then import the AIFF file into Final Cut Pro.

Importing Audio Clips With Different Sample Rates

You can import an audio file as it was originally recorded and use it in a project with 
sequence settings that are set to a different sample rate. If a sequence contains audio clips 
whose sample rates don’t match the sequence settings, Final Cut Pro converts their sample 
rates to those of the sequence settings in real time when you play back the sequence.

This automatic sample rate conversion works well when combining 44.1 kHz audio from 
audio CDs or other sources with 48 kHz, 16-bit audio imported from DV tape. It does not 
work well when combining 32 kHz, 12-bit audio with 44.1 or 48 kHz audio, as the difference 
in sample rates is too great to allow for smooth-sounding audio. It’s generally recommended 
that you shoot your DV-format tapes using 16-bit, 48 kHz as a rule. If you can’t, and you must 
mix clips with different sample rates together, it’s best to rerecord any non-DV audio you 
want to use as 32 kHz audio in advance.

Note:  When using 44.1 kHz and 48 kHz clips, it’s best to set your sequence’s sample rate to 
48 kHz. Upsampling your audio clips makes them sound a little bit better than 
downsampling. 

Converting Audio Sample Rates for Use With DV Sequences

If you are working with a DV sequence that is set to an audio sample rate of 32 or 48 
kilohertz (kHz), you may get better results by converting your audio CD files from 44.1 kHz 
to 32 or 48 kHz. When you play a 44.1 kHz audio file in a 32 or 48 kHz sequence, Final Cut 
Pro converts the 44.1 kHz audio sample rate in real time, as you play, to the sequence’s audio 
sample rate. In some cases the automatic conversion may result in audible distortions in the 
audio.

To convert CD audio files to 32 or 48 kHz:

1 Do one of the following:

m Choose Import from the File menu, then choose File from the submenu. 

m Control-click in the Browser, then choose Import File. 
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2 Locate and select the audio track you want to import, then click Convert.

3 Enter a name for the track and specify a location to save it.

4 Click Options.

5 In the Settings section, choose 44.1 from the Rate pop-up menu, then click OK.

6 Export the file from Final Cut Pro as a QuickTime movie in AIFF format, choosing 32 or 48 
kHz for the sample rate.

Select the track
you want to import,
then click Convert.

If you want,
enter another

name for the file.

Choose a place
to save the file.
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For more information, see “Exporting Audio Only” on page 1176.

7 Reimport the files into Final Cut Pro.

For more information, see the next section, “Importing Audio CD Tracks.”

Importing Audio CD Tracks

When you import an audio track from a CD, QuickTime converts it into a digital audio file, 
saves it to one of your hard disks, and automatically imports it into your project, ready for 
editing. You can choose to convert an entire audio track, or only a portion of a track.

If you import audio CD files directly, Final Cut Pro converts the sample rate. This may cause 
audible distortions in the audio. You can convert the sample rate of the audio CD files to the 
sample rate used in your sequence settings using an audio conversion application.

If you’re working with a DV sequence, you can also convert the sample rate using Final Cut 
Pro. For more information, see “Converting Audio Sample Rates for Use With DV Sequences” 
on page 307.

To import an audio track from a CD:

1 Do one of the following:

m Choose Import from the File menu, then choose File from the submenu. 

m Control-click in the Browser, then choose Import File. 

2 Locate and select the audio track you want to import, then click Convert.

Important  You cannot import a CD audio track by dragging it to the Browser. If you do so, 
Final Cut Pro won’t be able to access the file once you eject the CD.

Select the track
you want to import,
then click Convert.
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3 Enter a name for the track and specify a location to save it.

4 To specify audio settings, select a portion of the track to record, or listen to the track, 
click Options. 

5 Adjust the settings, then click OK.

m Settings:  Select an audio sampling rate, bit size, and audio format that matches the 
sequence settings (48 kHz is not available).

m Audio Selection:  To import a portion of the track, enter start and end times or drag the 
sliders to set the start and end times. 

m Play:  To listen to the track, click Play. Drag the time marker in the slider bar to move the 
playhead to a different location in the track.

If you want,
enter another

name for the file.

Choose a place
to save the file.

To listen to the 
track, click Play.

Enter start and end times to 
convert only part of the track.

Specify audio
settings here.

Move the time marker
to go to a specific
point in the track.

You can also drag the sliders 
to set the part of the track 
you want to import.
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6 When you’re ready to import the track, click Save.

The imported audio
track is an audio

clip in the Browser.
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10 Importing Edit Decision Lists (EDLs)

In the process of creating your final program, you may use another nonlinear editing system. 
Eventually you’ll need to move your sequence from that editing system into Final Cut Pro so 
you can finish (or “online”) your edit, or simply continue to work on it. To bring the 
sequence into Final Cut Pro, you can import an Edit Decision List, or EDL. An EDL is a plain 
ASCII text file with every shot in your edited sequence represented as two pairs of In and 
Out points. One pair describes the location of the edit points on the source tape. The other 
pair describes where that edit goes on the master tape. 

EDLs were originally developed for use on older tape-to-tape editing systems that had limited 
capabilities. Therefore, they describe only a narrow set of edits, transitions, and tracks. 
Although today’s nonlinear editing systems have introduced a wide variety of transitions, 
filters, and special effects, the EDL format reflects the simplicity of older systems. 

EDLs have become the lowest-common-denominator format for exchanging projects between 
nonlinear editing systems that use different project file formats. Importing an EDL is a good way 
to recreate a project from another editing system in Final Cut Pro for further editing.

This chapter provides information on importing EDLs so you can recreate a sequence 
created on another editing system. More detailed information, such as the format and 
limitations of EDLs, are described in Chapter 29, “Working With Edit Decision Lists (EDLs) 
and Batch Lists,” on page 1191. 
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Limitations of Importing EDLs
Not everything that can be done in another editing application shows up in an EDL imported 
into Final Cut Pro. If you export an EDL from another editing application, the following do 
not appear:

m filters

m motion effects

m any composited video tracks above the first two tracks

m any audio tracks above the first four tracks

m non-SMPTE standard video transitions

While the above items aren’t directly part of an exported EDL, you can export them as notes 
for reference.

Importing EDLs
You can import an EDL into Final Cut Pro to recreate an edit from another nonlinear system or 
recreate an older sequence originally cut on a tape-to-tape linear system. An imported EDL 
becomes an offline sequence in your project. All you need to do then is recapture clips 
associated with the imported sequence; you don’t have to import a separate batch capture list.

Important  If you name hard disks and folders with double-byte (or 16-bit) characters (such 
as characters used for the Japanese language), Final Cut Pro may not be able to either import 
or export EDLs. To avoid this problem, import from or export to disks and folders with 
names that do not contain double-byte characters.
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To import an Edit Decision List:

1 Choose Import from the File menu, then choose EDL from the submenu.

2 Specify your import options, then click OK. 

m Select Preset:  Choose the sequence preset you want to use for editing this material. This 
determines how clips in the sequence are captured.

m Import For:  Choose an option from the pop-up menu.

m Recapture:  This is useful if you’re importing an EDL from a tape-to-tape linear editing 
system or a non-QuickTime standard nonlinear editing system. This option makes the 
recaptured clip names unique and adds 1-second (1:00) handles before and after the 
clips during capture. You can change the handle size.

m Reconnect:  Choose this option if you already have the files on disk and simply want to 
link the sequence to them. This is useful if you’ve imported a sequence from another 
nonlinear editing system that uses QuickTime movie files. This option keeps clip 
names in the same order to make relinking easier. Reconnecting creates no handles, so 
you won’t see a “Not enough media” error message.

m Custom:  Choose this option to specify handle size, drop frame timecode, and unique 
clip names.

m Handle Size:  Specify the number of additional frames you want to capture on either side 
of the edit. You should always add handles when capturing clips from an imported EDL 
because it gives you more flexibility for adjusting edits to find better cut points in your 
imported sequence.

Note:  This option is not available when you choose Reconnect since the media files are 
already on your disk and are not being captured.

m Drop Frame:  Check this box if you want to use drop frame timecode for the clips.

m Make File Names Unique:  Check this box if you are recapturing clips so no two clips 
inadvertently have the same name. Leave the box unselected if you are relinking to clips 
that are already on disk.
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3 Locate and select the EDL, then click Open.

When you import an EDL, it becomes a sequence in your current project tab.

Note:  If you selected Sony 5000 as the EDL format when you exported the file, the EDL’s 
title changes to “Untitled” when you import it.

Recapturing Clips From an Imported EDL

Unless you already have the files on your hard disk, the imported EDL becomes a sequence 
with offline clips that must be recaptured. To do this, select the imported sequence, then 
batch capture the clips. For more information on doing a batch capture, see “Capturing Clips 
All at Once” on page 273. 

Note:  Make sure you get all source tapes associated with the EDL before starting the 
capture process.

Select the EDL, then
click Open.

The imported EDL
is a new sequence

in the Browser.

Clips from your imported 
EDL remain offline until you 
recapture them. 
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How Clips Are Imported

Clips imported from an EDL are named in one of two ways. If the EDL was exported from a 
nonlinear system, the name is exported like this:

* FROM CLIP NAME: CLIP NAME HERE

where “CLIP NAME HERE” is the name of your clip. Final Cut Pro can recognize clip names 
exported from the following nonlinear editing systems:

m Final Cut Pro

m Media 100

m Avid 

Note:  Avid 24-track EDLs are not supported.

In all other cases, Final Cut Pro uses the reel number and starting timecode numbers as the 
clip name. For example:

0001 01:02:20:05

Dissolves and wipes are mapped to the appropriate transitions following the basic SMPTE 
set. Key edits are imported as well.

Note:  Final Cut Pro places markers in the imported sequence if errors occur.
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11 Getting Started With Editing
Once you’ve captured some or all of the clips that will go into your finished program, it’s 
time to begin editing. You’ll do most of your editing in the Viewer, Canvas, and Timeline, 
which are covered in this part of the manual. There are also other tools and windows in Final 
Cut Pro to perform a variety of detailed editorial tasks, manage files, and specify preferences 
and settings for how you work.

Final Cut Pro is extremely flexible. You can perform edits visually, using the mouse to choose 
various clips, buttons, controls, and visual interface elements. You can use keyboard 
shortcuts, since nearly everything you can do with the mouse can also be done from the 
keyboard. Some editors find this to be a faster way of working.

Once you’ve assembled an edited sequence, you can trim your edits and modify your 
sequence several ways:

m using visual controls in the interface

m directly manipulating your clips using the mouse in the Timeline

m using keyboard shortcuts to open clips in the Viewer or Trim Edit window for 
refined editing
 321



     
How to Edit Using Final Cut Pro’s Interface
You’ll do most of your editing in three main windows: the Viewer, Canvas, and Timeline. 
Since you organize and “store” your clips in the Browser, you’ll use that window for editing, 
as well. 

A typical editing operation follows these steps:

Step 1: Select a clip in the Browser to add to your sequence (A)

Step 2: Open the clip in the Viewer (B)

Step 3: In the Viewer, set In and Out points for the clip to specify what you 
want to use in your sequence (B)

Step 4: Edit the marked clip into an open sequence in the Canvas (C) or 
Timeline (D)

B C

A D
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Using the Chapters in Part 3
m Chapter 12, “Working With Clips and the Viewer,” and Chapter 13, “Working 

With Sequences, the Timeline, and the Canvas” 

These two chapters cover the Viewer, the Canvas, and the Timeline. It’s useful to 
familiarize yourself with the controls and display options of each of these windows before 
moving on to the basics of editing.

m Chapter 14, “Basic Editing,” and Chapter 15, “Adding and Editing Transition 
Effects”

This begins an in-depth look at editing using all three windows together (the Viewer, 
Canvas, and Timeline). Chapter 15 covers transitions you can add to your sequence. 

m Chapter 16, “Advanced Editing and Trimming Techniques”

This chapter outlines the trimming operations available in Final Cut Pro. 
m Chapter 17, “Working With Audio”

Discusses editing, mixing, and effects for the audio portion of your program.
m Chapter 18, “Using Media Tools”

Covers media tools, including the Media Manager, which allows you to reorganize the 
sequences and source media files associated with your project. 

m Chapter 19, “Viewing and Setting Preferences”

Covers the Preferences window, which contains settings that affect how many of the 
editing operations work.

For a fast, basic overview of how to edit with Final Cut Pro, it’s a good idea to go through the 
tutorials (see “Final Cut Pro Tutorials” on page 8).

Being Prepared: Logging Your Clips in Advance

Depending on how you choose to log and capture your clips, the first part of your editorial 
process may already be completed. Selecting specific clips to use is the most basic level of 
editing. If you’ve done this already, your job is now much easier. 

It’s a good idea to go through your material prior to editing, watching and annotating all of 
the shots you plan to use in your edit, to familiarize yourself with the footage. The person 
who initially logged your footage may have included notes about which were the preferred 
takes, along with the shot and scene number information. Perhaps you compiled a 
preliminary shot order in the notes for each clip. If not, you can add this type of information 
later to any clip by entering it into the relevant column in the Browser. 

For more information on logging your clips in preparation for capture, see “Logging Your 
Media” on page 251. For more information on adding notes to and changing the information 
of clips in the Browser, see “Changing Clip Properties in the Browser” on page 208 and 
“Viewing and Changing Clip Properties in the Item Properties Window” on page 210.
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Choosing the User Mode to Work In

When you first open Final Cut Pro, you choose your initial setup, which includes your user 
mode. There are two user modes: Standard (the default) and Cutting Station (an abbreviated 
feature set). The user mode you choose determines the feature set available to you when 
you edit your project. For detailed information, see “Setting the User Mode” on page 892.

Editing Strategies
Editors use a variety of strategies to meet the challenge of turning several hours of raw 
footage into a finished program. Editors tend to work in two different ways. Final Cut Pro’s 
diverse feature set accommodates both of these working styles. 
m Creating an edit in two stages, from rough cut to fine cut

Some editors like to do a quick edit of all the shots they may want to use in a program in 
order to get a sense of how the shots play together. They can quickly rearrange their 
shots, deleting some and adding others. 

When they’re satisfied that they’ve got the right material, they go through each edit, clip 
to clip, finding the exact moment to cut from each shot, line of dialog, or visual to the 
next. Eventually, the fine cut is finished and the project is completed.

m Creating a more polished edit from the first shot

Other editors like to start polishing their edit from the very first clip they edit into their 
sequence. They edit and trim all their shots as they work, from the first clip to the last.

Often, the type of project you’re working on determines your method of editing. How you 
start working on a documentary is often quite different from how you start on a more tightly 
scripted project, such as a comedic feature.

Be Organized

There are no hard and fast rules for editing. Different editors have different working styles 
and, given the same source material, no two editors will cut the same finished program. 
Here’s an example of how your work might flow:

Step 1: Log your footage

Logging your footage in advance, although time-consuming, is a good idea. For example, 
because there is often a great amount of footage shot in the field for documentaries, 
transcripts are often made of all interview footage. By poring over these transcripts, you can 
see which video clips you may want to use and can then log these clips for capture with an 
idea of how you want to piece them together. 
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If you’re editing a more scripted piece, looking through all the takes will give you an idea of 
what you have to work with before you actually start cutting. If you’ve already seen all the 
footage that’s available, you can make decisions based on the best take in your footage, 
rather than the best take that you captured in Final Cut Pro.

Adding notes to your clips as you log them can be instrumental in keeping everything in 
order as you work. It’s a good idea to keep a log of all material you shoot in the field, so that 
you can keep track of all of your shots and use the log as a starting point for the notes in your 
logged clips. For more information on how to add notes to the clips you’re logging, see 
“Logging Your Media” on page 251.

Step 2: Create a rough cut

Once you’ve logged and captured the clips you want to start with, it can be helpful to do a 
rough cut. Piece together the clips you want to use in the order you want them to appear in 
your sequence (in the Timeline). Once your clips are laid out, you can play them back and 
see how they work together. 

If you numbered your shots or used another ordering scheme when you logged them, you 
can work this way:

1 Create a new sequence in the Browser and open it in the Timeline.

2 Sort your captured clips by the relevant column in the Browser (such as the Name, Log 
Note, Scene, or Shot/Take column).

3 Select the desired clips.

4 Drag these clips to your open sequence in the Canvas or Timeline to quickly assemble 
your rough cut.

To learn how to make simple edits from the Viewer to your sequence, see Chapter 14, “Basic 
Editing,” on page 533.

Step 3: Polish your edit

As you fine-tune your rough cut into a more polished sequence, you can reorder and finely edit 
the clips in your sequence (see Chapter 16, “Advanced Editing and Trimming Techniques,” on 
page 653). You can also add variety to your program in the form of transitions, such as dissolves 
and wipes (see Chapter 15, “Adding and Editing Transition Effects,” on page 605).

Step 4: Mix your audio

Once the bulk of your program is edited and you know how the images appear, you can 
begin working more extensively on your audio. This involves

m cleaning up the dialog

m adding sound effects and music

m mixing the levels of all the different clips together to create a harmonious sound track

For more information, see Chapter 17, “Working With Audio,” on page 727.
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Step 5: Work on effects

Unless you’re working on a broadcast, design-oriented piece, it’s a good idea to save 
extensive effects and graphics work in your program for last. Setting up effects 
tends to be more time-consuming than the rest of your project. It’s good to focus on basic 
edits before getting distracted with effects that may make up a very small part of your 
program in the end. Once you have a sense of how your program is working and the pace 
of your picture and audio, it becomes easier to find ways to enhance your program with 
graphics and animation. 

For more information on visual effects, see Chapter 20, “Overview of Effects,” on page 905.

Using the Keyboard or the Mouse

One way of editing (which some editors may find faster and more streamlined) is to keep 
your hands on the keyboard as much as possible. Another method of editing (which some 
find more intuitive) is to use the mouse and Final Cut Pro’s visual controls. Final Cut Pro 
accommodates both kinds of users. And, no matter which editing style you prefer, you’ll 
probably find yourself doing a little of both.

Final Cut Pro’s visual controls (including menu commands, buttons, and shortcut menu 
commands) are mentioned throughout the manual. Keyboard shortcuts are shown side-by-
side with the editorial function they perform in the tooltips in the interface (see “Showing 
Descriptions of Interface Elements (Tooltips)” on page 85). 

For a complete list of Final Cut Pro’s keyboard shortcuts, see Appendix B, “Keyboard 
Shortcuts,” on page 1297.
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12 Working With Clips and the Viewer
A clip is the basic unit of media that you use to create sequences and movies in Final Cut Pro. 
Clips can be movies, still images, generators, and audio files. You can also use sequences as 
you would clips, and put them inside of other sequences.

To view a clip, you select it in the Browser, then open it in the Viewer. The Video tab of the 
Viewer acts as your “source” monitor; there, you watch your selected clip and mark the In 
and Out edit points, which define how much of the clip you want to edit into your sequence. 
If you have an external video monitor and speakers connected, any video you play will also 
be played on your external video monitor.

How You Can Use the Viewer

The Viewer is extremely versatile. Besides defining In and Out edit points for different media 
clips, you can also use the Viewer to

m mix and edit clips with audio in the Audio tab

m open clips from any open sequences in the Timeline and perform detailed editing

Note:  Changes you make to a clip opened from a sequence are applied to the clip only in 
that sequence. If you make changes to a clip opened from the Browser, the changes only 
appear in the clip in the Browser.

m open a transition, such as a dissolve or a wipe, from an edited sequence for detailed 
editing

The transition appears in detail as an A track, a transition track, and a B track. For more 
information, see Chapter 15, “Adding and Editing Transition Effects,” on page 605.

m add filters to your clips and edit them later

m access the motion settings of clips to modify or animate such properties as scale, rotation, 
cropping, and opacity
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m create and modify generators

Generators are special clips that can be generated by Final Cut Pro, so they don’t require 
source material. Final Cut Pro has generators that create color mattes, text of different 
types, gradients, color bars, and artificial static. For more information, see “Using 
Generators” on page 1057.

In this chapter, we’ll focus on using the Viewer’s Video tab. The Video tab is where you 
perform the primary tasks used to edit video and audio into your sequence. 

About the Viewer
There are many controls in the Viewer. (Some of these appear in other areas of the interface, 
as well; for example, the playhead controls also appear in the Canvas.) The following is a 
quick summary of the Viewer controls; for more detailed description, see the sections 
starting with “Tabs in the Viewer” on page 330.
m Tabs

Each tab in the Viewer provides certain editing functions:  Video, Audio, Filters, Motion, 
and Controls. The Video and Audio tabs appear only if the clip currently opened in the 
Viewer contains video or audio media. For example, you’ll see the Audio tab only when 
you open an audio clip or a video clip that includes audio. The Filters tab appears for all 
clips, and the Motion tab appears only for video and graphics clips.

m Playhead and scrubber bar

These let you locate and move or jump to different parts of a clip quickly and easily.
m Transport controls

You use these to move the playhead within clips and sequences. The position of the 
playhead corresponds to the currently displayed frame.

m Jog and shuttle controls

You use the jog and shuttle controls to navigate more precisely within your clip.
m Marking controls

You use these to mark clips with edit points (In and Out points), markers, and keyframes.
m Zoom pop-up menu

This lets you enlarge or shrink the image that appears in the Viewer.
m View pop-up menu

This allows you to change the viewing format and control the display of various overlays 
that can appear in the Viewer.
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m Generator pop-up menu

You use this to select and open generators in the Viewer for modifying and editing into 
your sequence. Generators are special clips that can be generated by Final Cut Pro; for 
example, they can be used to create color mattes and text of different types.

m Recent Clips pop-up menu

This allows you to open recently used clips in the Viewer for modifying and editing into 
your sequence.

m Timecode fields

The Current Timecode field displays the timecode of the frame at the current position of the 
playhead. The Timecode Duration field lets you view and change the duration of marked 
clips.

Timecode Duration field
Current 
Timecode field

Clip name and 
project it’s in.

View pop-up menuZoom pop-up menu

Transport 
controls

In point

Playhead

Shuttle control Jog control
Scrubber bar

Recent Clips 
pop-up menu

Generator
pop-up menu

Out point

Marker

Tabs provide access 
to certain functions.

Marking 
controls
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Opening the Viewer

To open the Viewer:

m Press Command-1. (Press this again to close the Viewer.)

m Double-click a clip in the Browser.

m Double-click a clip in an open sequence in the Timeline.

Before you can work in the Viewer, it must be the currently selected, or active, window. 
(Otherwise, any keyboard shortcuts you use may perform the wrong operations.)

To make the Viewer active:

m Click the Viewer.

m Press Q to switch between the Viewer and the Canvas.

Tabs in the Viewer

Each tab in the Viewer provides a specific set of editing functions.

m Video tab:  Lets you view video frames and locate and mark edit points, or In and Out 
points. The Video tab appears by default when you play back clips that include video.

m Audio tab:  Appears for clips with audio only; lets you adjust the volume and spread (or 
pan) over time.

m Filters tab:  Lets you adjust settings for any filters and effects you’ve applied to a clip.

m Motion tab:  Lets you apply and modify motion effects to a clip, such as scaling and 
rotating.

m Controls tab:  Lets you change the parameters and controls for generators, which create 
new information (such as text for titles).

You can drag tabs out of the Viewer so they appear in a separate window. This is useful if you 
want to edit all the settings of a particular clip at one time. For more information, see 
“Working With Tabbed Windows” on page 86.
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Audio Tab

If your clip has audio, you can use the Audio tab to view an expanded waveform display of 
the clip and change the volume and the stereo spread of the clip over time. If you open an 
audio-only clip, you’ll only see audio tabs:  one tab for mono or stereo audio clips, and two 
tabs for non-stereo multichannel clips.

You can also use the Audio tab to set In and Out points, markers, and keyframes for audio 
clips. To learn more, see Chapter 17, “Working With Audio,” on page 727.
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Filters Tab

This is where you adjust settings for any filters and effects you’ve applied to a clip. You can 
also create animated effects by changing the filter settings over time using keyframes. 

For more information, see Chapter 22, “Working With Video Filters, Generators, and Speed 
Settings,” on page 1023.
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Motion Tab

You apply and modify motion effects for a clip in this tab. Every video clip, whether it’s video, 
graphics, or animation, has the same motion properties:  scale, rotation, center, anchor 
point, crop, distort, opacity, drop shadow, and motion blur. 

You can create animated effects by changing the motion properties over time using 
combinations of keyframes. For more information, see Chapter 21, “Compositing, Applying 
Motion Effects, and Using Keyframes,” on page 907.
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Controls Tab

You use the Controls tab to change the parameters and controls for generators, which create 
new information (such as text for titles). The Controls tab appears only when a generator is 
open in the Viewer. 

See Chapter 22, “Working With Video Filters, Generators, and Speed Settings,” on page 1023 
for additional information.
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Playhead and Clip Controls

The playhead and clip controls let you navigate and locate different parts of a clip quickly 
and easily.

Playhead and Scrubber Bar

The playhead shows the location of the currently displayed frame within the current clip or 
clip in a sequence. The scrubber bar runs along the entire width of the Viewer, below the 
video image. To scrub, or move through, a clip, drag the playhead across the scrubber bar. 
You can also click anywhere in the scrubber bar to instantly move the playhead to that 
location. This is useful for quickly navigating through a clip or sequence. 

You can also hold down the Command key to drag the playhead at a slower speed, so you 
can more easily locate specific frames.

The playhead’s movement in the scrubber bar is affected by whether “snapping” is turned 
on. When snapping is enabled, the playhead “snaps,” or moves directly, to any markers, In, or 
Out points in the scrubber bar when the mouse gets close to them. (To turn snapping on or 
off, choose Snapping from the View menu.)

Shuttle Control 

This control lets you quickly play through clips and sequences at different speeds, in fast and 
slow motion. It also shifts the pitch of audio as it plays at varying speeds. In slow motion, this 
can make it easier to locate specific words and sounds for editing.

Drag the slider to the right to fast-forward and to the left to rewind. Playback speed varies 
depending on the distance of the slider from the center of the control. When the slider is 
green, playback speed is normal (or 100 percent speed). The further away from the center 
you move, the faster the playback speed. The keyboard equivalents of the shuttle control are 
the J, K, and L keys. For more information, see “Shuttling Through a Clip” on page 353.

Jog Control

To move forward or backward in your clip very precisely, use the jog control. The jog control 
allows you to move the playhead in the Viewer or Canvas as if you were actually moving it 
with your hand, with a one-to-one correspondence between the motion of your mouse and 
the playhead’s motion. This control is useful for carefully locating a specific frame, for 
instance if you’re trimming an edit. 

Jog control

Inactive video 

Shuttle control

Scrubber bar
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The keyboard equivalents for the jog control are the Left Arrow and Right Arrow keys.

m Left Arrow:  Moves the playhead backward, one frame at a time.

m Right Arrow:  Moves the playhead forward, one frame at a time.

m To move the playhead one second at a time:  Hold down the Shift key and press the Left 
Arrow or Right Arrow key.

Inactive Video

When you set In and Out points, any video that falls outside of the area between these two 
points becomes grayed out. This indicates that the video is currently not being used and will 
not be edited into your sequence. It is always available if you decide to edit it back in or do 
further trimming. (See Chapter 16, “Advanced Editing and Trimming Techniques,” on 
page 653 for information on trimming your clips.)

Transport Controls

You use the transport controls to move the playhead within clips and sequences. 

m Previous Edit

Moves the playhead backward to a preceding edit point (start, In, or Out) of a clip in the 
Viewer. This is useful for quickly navigating through a sequence of edits.

m Play In to Out

Resets the playhead to the In point of the current clip and plays forward from that point 
to the Out point. If you want to see how the clip you’re editing plays from beginning to 
end, this is the control to use. 

m Play

Plays back your clip or sequence from the current location of the playhead to the end, 
regardless of the Out point. Clicking this control again stops playback.

m Play Around Current

Plays the selected clip or sequence from before the current playhead position, based on a 
pre-roll setting, and continues through the amount of time specified by the post-roll 
setting. (The preview pre-roll and preview post-roll settings are located in the General tab 
of the Preferences window.) You can use this control to get a quick sense of what material 
is at the current position of the playhead as you navigate through a clip.

Next Edit

Play Around CurrentPlay In to Out

Previous Edit

Play
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m Next Edit

Moves the playhead forward from its current position to the next edit point (In, Out, or 
end) of a clip in the Viewer.

Marking Controls

These controls are used to mark clips in various ways.

m Match Frame

Click this button to match the currently displayed frame of a clip in the Viewer with the 
same frame in the first edited instance of that clip in the currently open sequence. The 
playhead in the Timeline will move to the location of that frame, which will appear in the 
Canvas. This can be useful when you need to locate exact frames in your edit quickly. For 
more information about using the Match Frame command, see “Locating a Match Frame” 
on page 600.

m Mark Clip

Click this button to use the current boundaries of a clip to set In and Out points.
m Add Keyframe

Click this button to add a keyframe to the current clip at the position of the playhead. A 
keyframe is a special-purpose marker that denotes a change in value of an applied effect, 
such as a motion effect or audio level.

Transport control Keyboard shortcut

Previous Edit Up Arrow key

Option-E

Play In to Out Shift-\ (backslash)

Play Space bar 

L key

Play Around Current \ (backslash) 

Next Edit Down Arrow key

Shift-E

Mark In

Add MarkerAdd Keyframe

Mark OutMatch Frame

Mark Clip
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m Clicking this button with the Video tab selected creates a keyframe for every motion 
effect in the Motion tab except for the drop shadow and motion blur effects.

m Clicking this button with one of the Audio tabs selected creates keyframes for level 
and pan.

m Control-clicking this button opens a shortcut menu that allows you to select a motion 
effect that you want to set a keyframe for. 

m Add Marker

Click this button to add a marker to the clip at the current position of the playhead. A 
marker is used to bookmark and make notes about important points in your clip or 
sequence as you edit, such as pinpointing locations of potential In or Out points, edit 
points, or places where effects might be applied.

The keyboard equivalent to the Add Marker button is the M key. Pressing M with the 
playhead on a marker will bring up that marker’s information window, where you can 
type a name or notes for the marker, or press delete to eliminate the marker. 

m To delete a marker:  Move the playhead to it, then press Control-` (the accent key). 

m To move the playhead to the next marker:  Press Option-M. 

m To move the playhead to the previous marker:  Press Shift-M.
m Mark In and Mark Out

Click to set the In point or the Out point for the clip at the current position of the 
playhead. These points will define the beginning and ending frames of a clip you edit into 
your sequence. 

Marking control Keyboard shortcut

Match Frame F

Mark Clip X

Add Keyframe Control-K (adds a keyframe to the effect you 
select in the shortcut menu)

Add Marker M

Mark In I 

Shift-I moves the playhead to the In point.

Mark Out O

Shift-O moves the playhead to the Out point.
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Recent Clips and Generator Pop-up Menus

The two pop-up menus near the lower-right corner of the Viewer let you quickly choose 
source media and generator effects.

m Recent Clips

This pop-up menu shows recently used clips. A clip is not added to this list when first 
opened in the Viewer, but only when another clip replaces it. The last clip that was 
replaced in the Viewer appears at the top of the list.

By default, the maximum number of clips that appear in this list is 10, but you can
change this number. For more information, see “Setting General Preferences” on 
page 885.

m Generator

Use this pop-up menu to choose a generator effect, such as Bars and Tone, Color Mattes, 
Gradients, and Text. A generic version of the effect appears in the Viewer; you can then 
customize it using the Controls tab before editing it into your sequence. For more 
information, see “Using Generators” on page 1057.

Recent Clips 

Generator pop-up menu

The clip replaced most recently 
is at the top of the list.

Various generator effects
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Zoom and View Pop-up Menus

The two pop-up menus near the top center of the Viewer let you quickly choose a 
magnification level and a viewing format.

m Zoom

Choose a magnification level from this pop-up menu. This changes the display size of the 
image, but doesn’t affect the frame size of your clip or your edited sequence. For more 
information, see “Zooming In and Out” on page 360.

m View

Choose a viewing format from this pop-up menu, including title safe boundaries, color 
and alpha channel displays, and wireframe modes for compositing. None of these view 
options affect your rendered media or material sent to tape; they are only for display 
within Final Cut Pro. For more information, see “Viewing Title and Action Safe 
Boundaries” on page 371.

View pop-up menu

Zoom pop-up menu
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Timecode Fields

Two fields display timecode in the Viewer:  Timecode Duration and Current Timecode. To 
change numbers in these fields, you click the icon to the left of the field to highlight the 
contents of the field.
m Timecode Duration

This field displays the total time between the In and Out points for the clip that’s open in 
the Viewer. If there are no edit points, the beginning and end of the clip are used as the In 
and Out points. If you change this number manually, the Out point of your clip changes 
to match the new duration (the In point remains the same).

You can Control-click this field to open a shortcut menu that lets you choose how to 
display the clip duration:  using non-drop frame timecode, drop frame timecode, or 
frames. Choosing a different display option does not affect the clip duration.

m Current Timecode

This field displays the current position of the playhead. If you enter a new timecode, the 
playhead moves to that position. You can enter both absolute and relative timecode 
numbers to navigate through a clip. For more information on navigating using timecode, 
see “Timecode Navigation and Shortcuts” on page 93. For more information on how 
timecode works, see “About Timecode” on page 91.

Timecode Duration
field

The shortcut menu for 
this field allows you to 
change the display.

Current Timecode field
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If you Control-click this field, a shortcut menu opens that lets you select several 
timecode options.

m View as Non-Drop Frame, Drop Frame, or Frames:  You can choose how timecode is 
displayed. Changing this option doesn’t affect your original clip’s timecode. The menu 
item in bold indicates the timecode that was captured with the clip. Drop frame is 
available only for clips with a frame rate of 29.97 fps and 59.94 fps (not PAL clips).

m View using Source, Aux 1, or Aux 2:  You can display the source timecode captured 
with the clip. You can also display Aux 1 and Aux 2, additional timecode tracks that can 
be useful for synchronizing clips from multiple sources. For example, if you’re working 
with audio clips captured from DAT, and video clips captured from Digital Betacam, 
the source timecode of each clip will reflect the timecode that was captured on the 
different tapes. However, you can also set the Aux 1 timecode of each audio clip to 
reflect the source timecode of its corresponding video clip, offset to match the sync 
point. This can also come in handy when synchronizing source material that was 
originally recorded using multiple camera angles but without synchronized timecode.

m Markers:  You can choose a marker from the list to move the playhead to the marker’s 
location. All the markers in the current clip appear in the shortcut menu.

Working With Clips Between the Browser and Viewer
When you capture or import clips into a project in the Browser, you don’t copy the original 
media file on your disk into your project; you only place a linked reference to that media in 
the Browser. A clip in the Browser can also be “offline,” which means the media hasn’t been 
captured yet, the media has been captured but moved to another location on disk, or the 
media was deleted.

At the most basic level, the editorial process involves moving a clip from the Browser to the 
Viewer, setting your desired In and Out points, and then editing it into the Timeline, which 
represents your edited sequence. As you work with clips between these windows, here are 
some rules to remember:
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m If you delete the original media file, your clip still appears in the Browser and in the 
Timeline (if you’ve added it to a sequence) as an offline clip. 

You won’t actually see any of the clip’s frames if you play it in the Viewer, since the original 
file can no longer be accessed. If the clip was captured using timecode, you can recapture 
it easily using the Batch Capture button in the Log and Capture window. See “Capturing 
Clips All at Once” on page 273 for more information.

m If you moved the original media file on your hard disk, you can use the Reconnect 
Media command in the File menu. 

This lets you find the clip’s new location on your hard disk and recreate the link between 
the source file and the clip in your project. For more information, see “About the 
Reconnect Media Command” on page 871.

m When you apply motion effects or filters to a clip and edit the In and Out points of a 
clip, you do not affect the original media file. 

You only change the clip’s appearance in your edited sequence. You’ll only change your 
source media on disk are if you modify the reel number and timecode of a clip in the 
clip’s Item Properties window. 

m When you edit a clip into the Timeline, the clip that appears in your sequence is a copy 
of the clip in the Browser. 

The clip in the Browser is the master clip, and the clip in your sequence is a sequence 
clip. For more information on using the Canvas and the Timeline to edit sequences, see 
Chapter 13, “Working With Sequences, the Timeline, and the Canvas,” on page 403.
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Working With Master Clips and Sequence Clips

You can make changes to a “master clip” in the Browser without affecting the duplicates of 
the clip that appear in your edited sequences, and vice versa. This is true of any changes you 
make, including In and Out points, filters, motion settings, and audio levels. This means that 
you have to be careful which clip you open in the Viewer when you want to perform an edit. 

m If you want to edit a new clip into a sequence, open the clip from the Browser. Because 
you’re working with the master clip, the In and Out points and any other changes you 
make have no effect on any copies of this clip that you’ve already edited into other 
sequences.

m If you want to modify a clip in an existing sequence, open it from that sequence’s 
Timeline. You’ll be editing the “sequence clip,” which is a duplicate of the master clip in 
the Browser. If you change the In and Out points or other settings for this sequence clip, 
the master clip in the Browser does not change.

Opening Clips in the Viewer

You can open clips in the Viewer from the Browser or from the Timeline. You can also open 
clips from outside the currently open project. Whether you open a clip from a file on disk, or 
double-click a clip in the Browser or the Timeline, it will appear in the Viewer with the last 
selected tab displayed. Otherwise the Audio tab is displayed. Although the Viewer can show 
only one clip at a time, you can open multiple selected clips in the Viewer, and they will 
appear in the Recent Clips pop-up menu.

Final Cut Pro distinguishes between clips opened from the Browser and clips from the 
Timeline:  clips opened from the Browser have a plain scrubber bar, while those opened 
from the Timeline have two lines of dots in the scrubber bar that resemble sprocket holes in 
a strip of film.

To open a clip from the Browser:

m Double-click the clip.

m Drag the clip from the Browser to the Preview area of the Viewer. 

m Select the clip with the Up and Down Arrow keys, then press the Return key.

m Control-click the clip, then choose Open Viewer from the shortcut menu.

To open a clip from a sequence in the Timeline:

m Double-click the clip.

m Select the clip, then press Return.

A clip opened from the Browser 
has a plain scrubber bar.
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m Move to an edit point (using the Up and Down Arrow keys), then press Shift-Return. The 
clip immediately to the right of the edit point opens in the Viewer.

m Control-click the clip, then choose Open Clip “Name” from the shortcut menu (where 
“Name” is the name of the clip).

m Double-click the currently displayed clip in the Canvas.

To open a “copy” of a clip in the Viewer:

m Hold the Option key down while dragging the clip from the Browser to the Viewer.

To open a clip in its own Viewer window:

m Select the clip in the Browser or Timeline, then choose Clip in New Window from the 
View menu.

m In the Browser, Control-click the clip, then choose Open in New Viewer from the 
shortcut menu.

m In the Timeline, Control-click the clip, then choose Open Editor from the shortcut menu.

m With a clip selected, press Shift-Return.

A clip opened from a sequence 
in the Timeline has a dotted 
scrubber bar.
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To open a recently viewed clip:

m Choose the desired clip from the Recent Clips pop-up menu in the Viewer.

To open a clip outside the current project:

1 Choose Open from the File menu.

2 Locate the clip, select it, then click Open.

The clip opens in its own Viewer window. Changes you make to this clip, such as marking 
edit points or creating markers, are not saved with the clip unless you add it to a project. To 
add an open clip to a project, drag it from its Viewer to the Browser.

Opening Imported Clips in Their Original Application

You can open the application a clip was created in directly from Final Cut Pro, if that 
application is installed on your computer. If you’re working with imported graphics, this can 
be a handy way to make changes to the original image. 

For example, if you import a file that was created in Photoshop and edit it into a sequence, 
you can reopen the file in Photoshop for further editing. When you save the changes you 
made to the image in the application, the source media on your hard disk is changed. Also, 
that clip is changed wherever you used it, in edited sequences and in the Browser tabs of 
any projects.

Before opening a clip in its own application, make sure you have enough memory available 
to have both Final Cut Pro and the other application open at the same time.

To open a clip in its original application:

1 Open the clip in the Viewer or Canvas.

2 Choose Clip Editor from the View menu.

If the application used to create the clip is not on your computer, a dialog box asks you to 
choose an application to edit the clip in.

The Recent Clips menu 
only contains names of clips 
opened from the Browser.
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Adding Clips to Open Projects

You can import a clip into one project and then add it to another open project. You can also 
insert clips that you’ve opened from outside their current project. If you make changes to an 
open clip, such as marking edit points, they are not saved with the clip until you add the clip 
to a project.

To add an open clip in the Viewer to an open project:

m Drag the clip from the Preview area of the Viewer to the project’s tab in the Browser.

Playing Clips

You use the transport controls in the Viewer to play clips forward, backward, between In and 
Out points, one frame at a time, looped, and (with the proper video card) on an external 
NTSC or PAL monitor. You can also move around within clips by jogging, shuttling, and 
scrubbing, and by entering timecode.

To play a clip in the Viewer:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Click the Play button.

m Press the Space bar.

m Press L.

m Choose Play from the Mark menu, then choose Forward from the submenu.

To stop playback, press the Space bar or click the Play button again.

You can navigate backward in your clip at 1x (normal) speed if you want to search for precise 
locations to set your In and Out points.
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To play a clip in reverse:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Shift-click the Play button.

m Press Shift–Space bar.

m Press J.

m Choose Play from the Mark menu, then choose Reverse from the submenu.

To stop playback, press the Space bar or click the Play button again. 

You may want to review a clip whose In and Out points you’ve just defined. The Play In to 
Out button starts precisely at the In point and stops at the Out point, so you can make sure 
that the edit points are exact. This can be especially useful if you’re editing dialog and you 
want to make sure you’re cutting on the proper sound at each of your edit points. Another 
example is if you’re matching action and you want to make sure you’re starting and ending at 
the right frames.

To play a clip between In and Out points:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Click the Play In to Out button.

m Press Shift-\ (backslash).

m Choose Play from the Mark menu, then choose In to Out from the submenu.

To stop playback, press the Space bar or click the Play button. 

If you want to preview how the cut you’ve made at the Out point will play, you can play to 
the Out point. This is useful because it quickly shows you if you’ve left out a frame, or if you 
need to shave off more frames. For example, if you’re editing dialog, you can make sure you 
cut out on the very last frame of a pause at the end of an “s” sound, while leaving out an “i” 
sound that follows in the actor’s next sentence.
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To play a clip from its current position to the Out point:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Command-click the Play button.

m Press Shift-P.

m Choose Play from the Mark menu, then choose To Out from the submenu.

To stop playback, press the Space bar or click the Play button. 

You can play around the playhead position. This is useful if you’re looking through different 
sections of your clip, and you want to get a quick sample of the material around the current 
playhead position.

To play a clip around the current playhead position:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Click Play Around Current.

m Press \.

m Choose Play from the Mark menu, then choose Around from the submenu.

Note:  The amount of video played depends on the pre-roll and post-roll settings in the 
General tab of the Preferences window (see “Setting General Preferences” on page 885).

To stop playback, press the Space bar or click the Play button. 

You can also play every frame of a clip, if you want to get a preview of an uncompressed clip 
you’ve imported, or of a clip with effects applied to it, without rendering it first. While the 
clip won’t play back at 1x (normal) speed (it plays back somewhat more slowly, depending 
on the number of effects applied and on the data rate of the clip), every frame plays back, 
with no frames dropped.

To play every frame of a clip:

1 Open the clip and make the Viewer active.

2 Do one of the following:

m Choose Play from the Mark menu, then choose Every Frame from the submenu.

m Press Option-P.

To stop playback, press the Space bar or click the Play button. 
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Looping Playback

Normally, playback of a clip starts at the current playhead position and stops at the end of 
the clip. With looped playback enabled, when the end of a clip is reached, playback starts 
again at the beginning, continuing over and over until you stop playback.

To turn looped playback on and off:

1 Open a clip in the Viewer.

2 Do one of the following:

m Choose Loop Playback from the View menu.

m Press Control-L. 

A checkmark appears next to the command in the View menu. To turn off looped playback, 
choose Loop Playback or press Control-L again.

3 Play your clip.

For more information, see “Playing Clips” on page 347.

When you loop clips, keep the following in mind:

m Play In to Out loops playback only between your two edit points.

m Playing in reverse loops playback from the end of your clip to the beginning.

m In all other playback modes, playback always starts over from the beginning of the clip.

To stop playback, press the Space bar or click the Play button again.

Note:  When you loop playback, there is a split-second pause at the end point of the clip 
before the next loop starts. For this reason, enabling looped playback to loop a clip during 
output to tape may not give you the desired results. For more information on outputting to 
tape, see Chapter 26, “Recording to Videotape,” on page 1113.

About the Display Quality of DV Video
When you play back DV clips on your computer screen, the quality of the image may vary 
depending on the model of computer you’re working with. Power Macintosh G3 computers 
display DV clips at a slightly lower resolution, so the resulting image looks somewhat soft. 
Power Mac G4 computers can display the same clips at a higher quality, resulting in a sharper 
image on your screen.

By default, Final Cut Pro displays DV video using this variable quality mode to take advantage 
of the best quality your computer is capable of displaying. You can force Final Cut Pro to 
display DV video at the highest quality, but it’s best to not to enable this option, since it slows 
down Final Cut Pro’s performance. 
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To check to see the current playback quality:

m Choose Project Properties from the Edit menu, then click Edit Render Qualities. 

Although video normally plays back at a full frame rate of 29.97 fps for NTSC and 25 fps for 
PAL, enabling external video may lower the frame rate of video simultaneously displayed on 
your computer monitor during playback. Final Cut Pro uses the following guidelines:

m On 400 mHz (and faster) Power Mac G4 computers:  DV video always plays back using a 
relatively high quality mode, with a sharp picture at 29.97 fps for NTSC or 25 fps for PAL.

m On all earlier Final Cut Pro-qualified computers:  Video plays back at 29.97 fps for NTSC 
or 25 fps for PAL. With external video disabled there is a softer picture; with external video 
enabled, playback is at 12 fps with a softer picture.

If no checkmark 
appears next to 
High Quality 
Playback, the high 
quality option is 
turned off.

Important  This option affects only how your video will be displayed on your computer 
monitor. DV media is always captured to your hard disk at the highest quality, and video 
output to tape or rendered using the DV codec is always at full video resolution and 29.97 
frames per second (fps).
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Audio/Video Sync With External Video Enabled

Whenever you enable external video, audio plays only through your selected video capture 
interface, because Final Cut Pro disables audio output through your computer’s speakers or 
headphone jack. If you’re using FireWire, this means that you’ll only hear audio coming out 
of the DV device connected to your FireWire port, such as your DV deck or camcorder.

Audio playing through an attached DV device will sync up only with the video that’s playing 
on that same device. If you listen to the audio coming from an attached DV deck or 
camcorder, and watch the mirrored video playing on your computer monitor, you’ll notice a 
sync offset. This is normal. To eliminate the audio offset with video on your computer 
monitor, disable external video.

To enable and disable external video, see “Controlling When Final Cut Pro Renders” on 
page 136.

Navigating in the Viewer
Aside from using the playback commands, there are numerous ways to move around within 
clips in Final Cut Pro. You can navigate through your clips more quickly using the specialized 
jog and shuttle controls, moving through your media at slower or faster speeds. You can also 
enter absolute or relative timecode values directly into timecode fields to move the playhead 
within your clips and sequences. All of these methods work with external video enabled, and 
external video output will be continuously updated

Note:  The jog and shuttle controls and their keyboard shortcuts work in the Canvas and Log 
and Capture windows, as well as in the Viewer. To make sure your keyboard shortcuts affect 
what you see in the Viewer, be sure the Viewer is the currently selected, or active, window.

Scrubbing, or Moving Through, a Clip

The scrubber bar represents the entire duration of the clip that’s open in the Viewer. 
Dragging the playhead in the scrubber bar lets you scrub, or move through, your clip with a 
one-to-one correspondence between the movement of your mouse and the playhead’s 
movement through the clip. 

This is the fastest way to move through a clip in order to find the point you want, although 
how quickly you can move through the clip depends on the clip’s duration. In a short clip, 
moving the mouse a given distance in the scrubber bar will move through less footage than 
in a clip of lengthy duration. 

As you scrub your clip, audio also plays back more quickly, but it doesn’t play back smoothly, 
seeming to stutter (not speed up) as individual audio samples are skipped. This is normal. 
For smooth playback of audio at speeds under 1x, use the shuttle control instead.
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To scrub, or move through, a clip:

m Drag the playhead in the scrubber bar.

You can also use the scrubber bar to jump to a different part of your clip instantly, without 
playing all the footage between the previous location of the playhead and the new location.

To jump to a new location in the scrubber bar:

m Click the desired location in the scrubber bar.

Shuttling Through a Clip

While using the scrubber bar is a great way to quickly navigate to different parts of your clip, 
sometimes you want to play through your clip smoothly at varying speeds as you make 
decisions about where to place your edit points. The shuttle control gives you this kind of 
smooth control, playing back your clip’s video and audio at various speeds in either 
direction, much like the shuttle of a video deck.

In particular, the shuttle is useful for playing back clips at less than 1x speed. As the audio 
slows down, it’s sometimes easier to distinguish individual words, and to mark your In and 
Out points more accurately.

The shuttle control can play your clip at five speeds in each direction:  1/4x, 1/2x, 1x, 2x, and 
4x. The shuttle control snaps to the closest available speed. When the shuttle control is at 1x 
speed, or 100 percent, the slider turns green.  

To play media at varying speeds using the shuttle control:

m Drag the slider to the left or right.

Dragging to the right moves the clip forward; dragging to the left moves the clip in reverse. 
The farther you drag the slider from the center, the faster the clip plays in that direction.

To move around in a clip, drag the
playhead along the scrubber bar.

Drag to the right to play forward; 
drag to the left to play in reverse.
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You can also use the J, K, and L keys on your keyboard to shuttle through your clip. When 
you use the keyboard shortcuts, the only speed available under 1x is 1/3x. However, you can 
use the keyboard commands to speed playback up to eight times normal speed, faster than 
you can with the shuttle control interface.

To play clips at various speeds using the J, K, and L keys:

m To begin forward playback at normal (1x) speed:  Press L.

m To begin reverse playback at normal (1x) speed:  Press J.

m To pause playback:  Press K.

m To double the current playback speed:  Press L or J again.

You can play back up to eight times normal speed, switching from 1x to 2x to 4x to 8x 
normal speed (pressing either key a total of 4 times). 

Pressing the key for playback in the opposite direction halves the playback speed, slowing 
playback in that direction down until it reaches 1x playback. Playback then begins 
doubling in reverse, starting from 1x.

m To immediately reverse direction of a clip:  Press K to pause, and then press the key for 
the direction you want.

m To move the playhead one frame at a time:  Hold down the K key and press J or L.

m To move the playhead at below 1/3x speed:  Hold down the K key and hold down J or L.

Note:  When using keyboard shortcuts for device control, the speed of forward (L) and 
reverse ( J) may differ depending on your video equipment.

Jogging Through a Clip

To move through a clip more precisely, you can use the jog control. The jog control offers a 
one-to-one correspondence between the mouse and the playhead’s movement, but also 
provides frame-by-frame accuracy that’s not dependent on the duration of the clip. It’s a 
good tool to use to play through a section of your clip very slowly, looking for the right 
frame to cut on.

> Moves through
    reverse speeds

Pause . Moves through
   forward speeds
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To move forward or backward using the jog control:

m Drag the jog control to the left or to the right. 

The playhead moves with a one-to-one correspondence to the movement of your mouse. 
Moving your mouse slowly moves the playhead slowly, even frame-by-frame. Moving the 
mouse faster moves the playhead faster. If you stop dragging, the playhead instantly stops.

You can also move the playhead a frame at a time by using the arrow keys on the keyboard.

To move a frame at a time:

m Press the Right Arrow key to move forward a frame at a time; press the Left Arrow key to 
move back.

m To move one second at a time, press Shift while you press the Right or Left Arrow keys.

Using Timecode in the Viewer
You can move the playhead around in a clip by entering a new timecode number in the 
Current Timecode field. You can enter a complete timecode number to move to an exact 
frame in your clip, or you can enter a relative number to move the playhead forward or 
backward a precise number of hours, minutes, seconds, and frames from the current 
position. You can also enter values in the Timecode Duration field to adjust the duration of a 
clip or marker (see “Creating Markers With Durations” on page 398).

Before you read about using timecode in the Viewer, it’s helpful to know a little about how 
it works.

How Timecode Works

Timecode is a signal recorded with your video that uniquely identifies every single frame 
of your tape, using a time stamp in hours, minutes, seconds, and frames. It always follows 
this format: 

To move precisely through a clip, 
drag the jog control.

Hours     Minutes     Seconds     Frames

01:32:15:28
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There are two types of timecode:  non-drop frame and drop frame. Non-drop frame 
timecode is fairly simple:  for every frame of video, there is a corresponding timecode 
number. 25 frame-per-second (fps) PAL video uses non-drop frame timecode.

Drop frame timecode, which is used with NTSC-format video, is a frame-labeling scheme that 
compensates for the fact that NTSC has a frame rate of 29.97 fps, which is .03 fps slower than 
the nearest whole number frame rate of 30 fps. (Drop frame is also used at 59.94 fps). Since 
timecode is only represented by whole numbers, dropframe timecode corrects this 
discrepancy by periodically skipping timecode numbers, so that the timecode number listed 
matches the seconds and minutes of video that have played.

Here’s how you can tell if you’re using non-drop or drop frame timecode:

m If there’s a colon (:) between the seconds and frames fields, it’s a non-drop frame 
timecode number.

m If there’s a semi-colon (;), it’s drop frame timecode.

The kind of timecode used in the Timeline of a sequence is determined by a checkbox in the 
Timeline Options tab of the Sequence Settings window.

There are other differences in how timecode works. For example, timecode information is 
recorded differently on devices that use DV timecode and devices that use SMPTE timecode, 
which is what you’d capture via serial device control (for more information on connecting 
and using serial timecode, see “Using Serial Device Control With Final Cut Pro” on page 34). 
SMPTE timecode can be either drop frame or non-drop frame, and devices using SMPTE 
timecode often allow the user to define the timecode start numbers. DV code is drop frame 
only, and mini-DV tapes always start at 00:00:00:00.

Important  No video frames are dropped when you use drop frame timecode. Only the 
timecode numbers are affected.

How Drop Frame Timecode Works

When you’re using drop frame timecode with video that has a frame rate of 29.97 fps, the 
timecode numbers corresponding to frames 0 and 1 are skipped the first second of every 
minute, except if the minute number is exactly divisible by 10. (For video that has a frame 
rate of 59.94 fps, frames 0, 1, 2, and 3 are skipped.) These dropped numbers don’t appear 
in Final Cut Pro’s timecode fields because they are not on your tape.

It’s good to know this, because if you’re using timecode to navigate in the Viewer, and 
you inadvertently enter a dropped number, Final Cut Pro will automatically go forward 
to the next available timecode number. So don’t be concerned; this is normal for drop 
frame timecode.
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Otherwise, there is no numerical difference between SMPTE and mini-DV timecode. Both 
describe drop frame timecode using the same numbering scheme. While the data may be 
encoded onto your source tapes differently, the end result as captured by Final Cut Pro is 
the same.

Entering Timecode

There are several ways you can work with timecode:

m Enter a timecode with the Viewer active (you don’t need to select the Current Timecode 
field first). If you type the numbers outside of the Current Timecode field, you only need 
to type the timecode values that change to go to a specific point. Numbers that don’t 
change, like the hour or minute, don’t need to be entered. For more information, see the 
next section, “Entering Partial Timecode Numbers.”

m Use the Copy command in the Edit menu to copy a timecode from one field and paste it 
into another field.

m Press the Option key to drag a timecode value from one field to another.

When you type timecode numbers, you don’t have to type the colons. For example, if you 
type “01221419,” Final Cut Pro automatically formats this as “01:22:14:19,” which stands for 1 
hour, 22 minutes, 14 seconds, and 19 frames.

Here are a few examples of entering timecode, based on a starting timecode of 01:22:05:23.

m To go to 01:22:08:10, type 810 without the Current Timecode field selected (for 8 
seconds, 10 frames), then press Enter.

The playhead moves to 01:22:08:10. The hour and minutes don’t change, so you don’t 
need to type them.

m To go to 01:22:16:12 (same hour and minute, but 16 seconds, 12 frames), type 1612.

The playhead moves to 01:22:16:12.

m To go to 01:25:22:18, type 252218.

The playhead moves to 01:25:22:18.

To avoid typing zeros when moving by larger amounts, type a period instead, as in the 
following examples:

m To move to timecode 01:25:03:00, type “3.” (3 and a period). The period is automatically 
interpreted by Final Cut Pro as 00 in the frames field.

m To move to 01:03:00:00 from the previous position, type “3..” (3 and two periods). The 
periods insert 00 into both the frames and seconds fields.

m Type “3...” (3 and three periods) to move to 03:00:00:00.
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Entering Partial Timecode Numbers

You can type in only partial numbers (for example “1419”). Final Cut Pro formats the number 
by placing the far-right pair of numbers in the frames field, and putting each pair of numbers 
to the left in the remaining seconds, minutes, and hours fields, like this: “00:00:14:19.” 

What happens to the numbers to the left of the values you typed depends on whether you 
type the partial timecode value inside the Current Timecode field, or outside of it.

m If you type a partial timecode number outside the Current Timecode field, you need only 
type the timecode values that change to move the playhead to a specific point. Numbers 
that don’t change, like the hour or minute, don’t need to be entered.

For example, if the current timecode is 01:22:05:23 and you enter 1612, the playhead 
moves to 01:22:16:12.

m If you type a partial timecode number inside the Current Timecode field, numbers you 
omit will default to “00.”

For example, if the current timecode is 01:22:05:23 and you enter 1612 in the Current 
Timecode field, the playhead moves to 00:00:16:12, assuming that your clip’s In point is 
set that far back. (If it isn’t, the playhead remains where it is.)

In both cases, every hour, minute, second, or frame number you enter must consist of two 
digits. Single numbers must be accompanied by a zero; for example, “03” would represent 
frame 3.

Moving Forward and Backward in Time

You can move the playhead relative to its current position by entering a minus (–) or a plus 
(+) and the timecode value.

m To move forward:  Enter + (plus), then a timecode value.

For example, if you type +1612, the playhead moves ahead 16 seconds and 12 frames.

m To move back:  Enter – (minus), then a timecode value.

For example, to move back by 16 seconds and 12 frames, enter –1612. To move back 5 
minutes, 20 seconds, and 10 frames, enter –52010.
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Moving the Playhead Entering Timecode Values

To move the playhead in a clip by typing outside the Current Timecode field:

1 Open the clip in the Viewer.

2 With the Viewer active, enter a new timecode value, then press Return. 

Even though the Current Timecode field isn’t selected, the timecode you type appears in this 
field.

The playhead moves to the location of the new timecode value, and the new timecode is 
shown in the Current Timecode field.

To move the playhead in a clip by entering a value in the Current Timecode field:

1 Open the clip in the Viewer.

2 Click the Current Timecode field (or the watch icon to the left of it) to highlight the field.

3 Enter your new timecode value, then press Return.

This shows the timecode 
of the current frame.
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Changing How Video Is Displayed in the Viewer
You can change the way video is displayed in the Viewer in a number of ways, including

m changing the magnification of the image

m enabling and disabling clip overlays

m displaying or hiding title and action safe boundaries

m changing the background display

m enabling and disabling viewing the alpha channel of your image as a separate overlay

These settings are for you to use as you edit or composite your clips together. None of them 
affect your final clips or sequences, and none of them are added to video output to tape.

Zooming In and Out

You can zoom in on, or magnify, images displayed in the Viewer. You can also zoom in on 
part of an image. This is very useful if you’re compositing images together, as zooming in can 
help you see the details of your picture or the spacing between the clips you’ve arranged in a 
sequence more clearly. 

To zoom in or out on a clip’s image in the Viewer:

m Choose a magnification level from the Zoom pop-up menu.

Important  Clips don’t play back smoothly if you zoom in on them so far that part of the 
image is obscured and you see scroll bars to the right and below the Viewer window. Also, 
other windows blocking the Viewer also affect playback.
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m Choose Level from the View menu, then choose a magnification level from the submenu.

m Select the Zoom In tool in the Tool palette, then click the video image.

Clicking again magnifies the image more, based on the same magnification levels available 
in the Zoom pop-up menu and Level submenu.

m Press Command-= (equal) or Command-+ (plus) to zoom in; press Command-–(minus) 
to zoom out. Each time you use one of these keyboard shortcuts, you’ll move up or down 
the same list of possible magnifications, from 12 percent through 800 percent.
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To zoom in on part of an image:

m Select the Zoom In tool in the Tool palette, then drag a box (or “marquee”) around the 
area you want to zoom in on. Hold down the Option key and click once in the Viewer to 
zoom back out.

To zoom out from an image:

m Select the Zoom Out tool in the Tool palette, then click the video image. 

Clicking again zooms out farther, based on the same magnification levels available in the 
Zoom pop-up menu and Level submenu.

Drag the Zoom In tool 
around the part you 
want to magnify.
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To move around in a magnified image:

m Select the Hand tool in the Tool palette, then drag it over the image to move the view.

m Use the scroll bars.

Use the Hand tool to move 
around in the image.

You can also use the 
scroll bars to move 
around the image.
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Adjusting Clip Size Relative to the Viewer Size

When you change the size of the Viewer window, the video image in the window remains 
the same size. If the Viewer window becomes smaller than the video image, you’ll only 
see a small part of the image. If it becomes bigger, there will be a gray border around your 
video image.

Using Fit to Window

With the Fit to Window setting enabled, you can increase or decrease the size of the Viewer, 
and the size of your video frame will automatically increase or decrease to fill the new 
window size.

To enable Fit to Window:

m Choose Fit to Window from the Zoom pop-up menu.

m Press Shift-Z.

To resize the Viewer window to match the video frame size:

m Make the Viewer active, then double-click the Zoom In tool in the Tool palette.

Using Fit All

When you use the Fit All command (it’s not a mode), Final Cut Pro automatically zooms the 
image to fit the current size of the Viewer window. For example, if you’ve zoomed in on your 
image to 800 percent, but the Viewer window is only 320 x 240 pixels large, you’ll only see a 
fraction of your image. If you choose Fit All, your Viewer image will be zoomed out to match 
the size of the Viewer window. However, if you resize the Viewer again, the zoomed-out 
image will stay small; the Fit All command only fits the image to the size of the Viewer at the 
time you choose the command.
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To fit all items into view and include a 10 percent margin:

m Choose Fit All from the Zoom pop-up menu.

m Choose Level from the View menu, then choose Fit All from the submenu.

To view the image at the actual size:

m Choose 100 percent from the Zoom pop-up menu.

With the Fit All 
command, the image 
fits the current size of 
the Viewer window.
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Viewing Your Image in Square or Non-Square Pixel Mode

Standard definition (SD) video equipment and computer monitors display video quite 
differently. SD video equipment displays video using non-square pixels, while computer 
monitors display video with square pixels. Because of the discrepancy in the pixel shape, the 
same video image looks different on each kind of monitor. For example, let’s suppose you 
have a video clip of a ball. When you view it on a video monitor, it looks perfectly round. You 
capture the clip into your computer, and after opening the clip in the Viewer, you see this:

The ball appears to be distorted on your computer monitor. Fortunately, Final Cut Pro can 
simulate how your images will look on video using the computer’s display, so that your video 
images look correct as you edit. This does not permanently affect your video; it just affects 
how the video is displayed within Final Cut Pro.

Looks right on a video monitor

Square and non-square pixels compared (NTSC)

Looks wrong on a computer monitor
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To preview non-square pixel clips on your computer’s display using 
square pixels:

m Choose Level from the View menu, then choose Show As Sq. Pixels from the submenu.

m Choose Show As Sq. Pixels from the Zoom pop-up menu.

For more information on the differences between square and non-square pixels, see “Using 
Square or Non-Square Pixels When Creating Graphics” on page 296.
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Viewing RGB and Alpha Channels in the Viewer

When you’re working in the Viewer, it can sometimes be handy to have a quick look at the 
alpha channel of your clip. The alpha channel defines areas of transparency, and can change 
if various filters are applied. For example, if a blue screen clip is added to the Viewer, and a 
blue screen filter is applied to it, you can check to see what the alpha channel looks like by 
itself by choosing Alpha from the Channels submenu of the View menu.

.

There are several channel viewing modes in the View menu:

m RGB:  This is the default mode; it shows the three color channels that make up the actual 
video image as it would look when output to tape.
368 Chapter  12   



m Alpha:  This mode represents the alpha channel as black against white, where absolute 
black represents 100 percent transparency, levels of gray represent varying degrees of 
transparency, and absolute white represents nontransparent areas of the picture.

m Alpha+RGB:  This mode lets you see a representation of the alpha channel overlaid on 
top of the RGB channels that constitute the actual image of the video clip. The alpha 
channel is overlaid in red, with solid red representing nontransparent areas.

The RGB and Alpha options in the View menu are most effective when used with different 
backgrounds (described in the next section).
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Choosing a Background

When working with clips that have an alpha channel, you can choose different backgrounds 
that make it easier to see which areas of your picture are transparent. Translucent clips 
or generated text may be easier to see if you choose a background that emphasizes them, 
such as checkerboard 1 or 2. If you’re compositing colored images, an opposing color would 
work better.

Note:  When a clip is rendered for export to tape, the background is always set to black. If it 
is rendered for export as a QuickTime movie, the background will still appear to be black, 
even if the alpha channel is exported along with it.

To choose a background for viewing a clip:

m Choose the background from the View pop-up menu in the Viewer. 

m Choose Background from the View menu in the menu bar, then choose a background 
from the submenu.

About Viewing Overlays

Final Cut Pro provides visual cues, called overlays, to help you easily recognize certain parts 
of your edit (such as In and Out points and markers) in the Viewer. You can turn overlays on 
or off using the View pop-up menu, but because they relate to the process of setting edit 
points, they’re covered in more detail in “About Viewing Overlays Related to In and Out 
Points” on page 382.
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Viewing Title and Action Safe Boundaries

Most NTSC and PAL monitors don’t display the full video image, but instead hide the edges 
behind the plastic border of the TV screen. Hiding the top, bottom, and sides of the video 
image to give the illusion that video is covering the entire area is known as overscanning. 
Conversely, when video is displayed on a computer monitor with a black border around the 
edge, so that nothing is hidden, it’s known as underscanning.

To make sure important elements in your work are not cut off at the edges when you’re 
creating titles, laying out graphics, or compositing a complex sequence of clips and images, 
you can use the title safe and action safe overlays. These overlays display boundaries that 
show you where titles and actions, such as moving an image, will be out of view when shown 
on an NTSC or PAL monitor.

Action Safe

The action safe boundary is 5 percent smaller than the overall size of the video frame, 
whether you’re using NTSC or PAL. Most of the time, anything in your video image that’s 
outside this border won’t be seen at all. In fact, professional video equipment shows this 
border even when footage is being shot, to make sure that any important material is framed 
inside the viewable video area.

Still, since there’s no precise consensus among TV manufacturers regarding exactly where 
this boundary should be, it’s a good idea to make sure you don’t have anything objectionable 
too close to the inside edge of the nonviewable region; depending on what monitor the 
video is viewed on, the unwanted items may be seen. On the other hand, it’s a pretty good 
bet that things at the outer edges of this region, such as one or two line glitches from your 
source material, will never be seen by anyone.

There is one exception, however. If you’re rendering video for multimedia use, you’ll see the 
entire frame. If there’s anything in the video you don’t want viewers to see (including cases 
when the original image simply has a larger area than you want to be seen), it’s a good idea 
to crop it out when you render your output to QuickTime. For more information on 
rendering QuickTime files from Final Cut Pro, see Chapter 23, “Rendering,” on page 1065.
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Title Safe

The title safe boundary is 10 percent smaller than the overall size of the frame, whether 
you’re using NTSC or PAL. The title safe region gives you an additional level of safety, along 
with the action safe boundary. Since different manufacturers use different amounts of 
overscan when they build TVs, it’s possible for some TVs to display even less area than action 
safe allows for. The title safe boundary is guaranteed to be the minimum displayed area of 
your image. To prevent even half a line of text in your video from being chopped in two by 
the edge of a TV set, you should restrict any titles or text you add to the title safe area. 

In particular, you should make sure that graphics you import into Final Cut Pro respect these 
boundaries. The background you use can still occupy the entire video frame, but anything 
you want viewers to see in its entirety should be within the title safe area.

Again, QuickTime video is not subject to this limitation, unless you plan to crop out the edge 
of your video to remove unwanted parts of the frame. For more information on exporting 
QuickTime movies from Final Cut Pro, see Chapter 28, “QuickTime Export of Video, Images, 
and Sound,” on page 1145.

To view title safe and action safe boundaries:

m Choose Title Safe from the View menu, so a checkmark appears next to it.

m Choose Title Safe from the View pop-up menu in the Viewer, so a checkmark appears 
next to it.

To remove boundaries:

m Choose Title Safe from the View menu, so no checkmark appears next to it.

m Choose Title Safe from the View pop-up menu in the Viewer, so no checkmark appears 
next to it.
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Setting and Modifying In and Out Points
Setting In and Out points is the first step in performing an edit. When you set In and Out 
points for a clip in the Viewer, only the frames located between the In and Out points will be 
edited into your sequence. By setting up combinations of In and Out points, you can

m open a clip from the Browser, create simple In and Out points, and edit it into a sequence

m create a split edit, where the audio In or Out points are different from those for the video

m open a clip from the Timeline and modify its In or Out points in a previously edited sequence

Setting In and Out Points for a Clip

When you set basic In and Out points for a clip in the Viewer, you’re preparing to perform an 
edit where the video and audio for the clip cut in or out at the same time. An edited 
sequence composed of clips set up in this way will look like this:

Note:  The video and audio edit points are the same.

There are a few simple things to remember about setting edit points in the Viewer. If you 
don’t set In and Out points for a clip in the Viewer, the beginning and end of the clip will be 
used as In and Out points. Likewise, if you only set an In point, the very end of your clip will 
be considered the Out point, and vice versa.

Once you’ve set In and Out points, the area in the scrubber that falls outside these two 
points will turn gray. This is the inactive area, and indicates the frames of the current clip that 
will not be used if an edit is performed. Media in this inactive area does not disappear; you 
can add it back in to your clip at any time by setting new In and Out points.

If you’re setting both edit points, it’s important to set the In point at an earlier location in the 
clip than the Out point. If you set an Out point ahead of a previously set In point, the In 
point will be reset to the very beginning of your clip.

Video track

Audio tracks

Edit pointEdit point
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To mark an In or Out point for a clip:

1  Open the clip in the Viewer.

2 Move the playhead to the location in the clip where you want to place the In or Out point.

3 Do one of the following:

m Press I to set an In point or press O to set an Out point.

m Click the Mark In or Mark Out button.

m Control-click in the scrubber bar, then choose Mark In or Mark Out from the shortcut menu.

m Choose Mark In or Mark Out from the Mark menu.

If you want, you can mark In and Out points while the clip is playing. Sometimes this is easier 
because you can set your In or Out point right when you hear or see the frame that’s 
important to you.

To mark In and Out points while playing a clip:

1 Press the Home key to position the playhead at the beginning of the clip.

2 Press the Space bar or click the Play button to start playing a clip in the Viewer.

3 Do one of the following:

m Press I once to set an In point or press O once to set an Out point.

m Press and hold either the I or O key. The In or Out point will be marked at the location of 
the playhead when you release the key.

m Click either the Mark In or Mark Out button once.

m Click and hold either the Mark In or Mark Out buttons. The In or Out point will be 
marked at the location of the playhead when you release the button.

If you need a clip to have a specific duration, you can quickly define an Out point relative to 
your In point.

Mark Out button

Mark In button
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To set an Out point by changing the duration of a clip:

1 Open the clip in the Viewer.

2 Use one of the methods in the previous task to set an In point. If no In point is marked, the 
Out point will be marked relative to the very beginning of the clip.

3 Select the Timecode Duration field and enter the desired duration. Final Cut Pro will 
calculate the location of the Out point by adding the duration you entered to the timecode 
value of the In point, and will mark it automatically.

If you decide that you want to set In and Out points at the very beginning and end of your 
clip, you can do so with the click of a button.

To mark the beginning and end of the clip as the In and Out points:

m Click the Mark Clip button.

m Choose Mark Clip from the Mark menu.

m Press X.

Reviewing Your Edit Points

When you’ve set the In and Out points you think you want to use, it’s a good idea to 
use the different playback commands to review your clip (see “Playing Clips” on 
page 347). 

Use the Play In to Out button (or Shift-\) and Play to Out (Shift-P) to make sure that 
you’ve included or omitted all the frames you need for the clip you’re editing.
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Setting Up Split Edits

With a basic edit, such as those described in the previous section, the video and audio both 
cut in and out at exactly the same time. While many times this will work just fine, sometimes 
you’ll want to set the In or Out point of your audio at a different spot from that of your video. 
When you do this, it’s called a split edit.

For example, suppose you have an edited sequence of two shots in a row: a woman talking, 
cutting to a man talking. If you want to hear the man talking before you cut away from the 
visual of the woman (to show that she’s listening to him and to introduce the man’s character 
before you actually cut to him), you use a split edit. The audio cuts from her to him first; two 
seconds later, the video cuts from her to him.

Note:  The video and audio edit points are not the same.

Split edits are a common editorial technique, so it’s important to learn how to create them. 
There are three ways you can create a split edit:

m Set up separate edit points for the video and audio tracks of the clip in the Viewer before 
you edit the clip into your Timeline. This section covers how to do this.

m Disable either the audio or video target track in the Timeline, so that you only add media 
on the other track. This is good if you want to edit in video with no accompanying audio, 
or vice versa.

m Do a basic edit on your clips, assigning matching In and Out points, and then modify your 
edit in the Timeline later (see Chapter 13, “Working With Sequences, the Timeline, and 
the Canvas,” on page 403).

Video track

Audio tracks

Edit pointAudio edit point

Video edit point
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Notice that the scrubber bar is divided in half by a light gray line. The upper half of the 
scrubber bar contains your video In and Out points, and the lower half contains your audio 
In and Out points. When you mark simple In and Out points, each pair of audio and video In 
and Out points join to form a small triangle. When you mark separate video and audio edit 
points, you’ll see that the upper half of these triangles mark the video edit points, and the 
lower half mark the audio edit points.

You can use split edits to define both In and Out points, or you can mix split In points with 
simple Out points, or vice versa.

To set up a split edit in the Viewer:

1  Open the desired clip in the Viewer.

2 Move the playhead to the location in your clip where you want to set the video In or Out 
point (separate from the audio).

3 To set a split video In or Out point, do one of the following:

m Press Control-I to set a video In point or Control-O to set a video Out point.

m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
either Video In or Video Out from the submenu.

Audio Out point

In point Out point
Video In

point
Video Out

point

Audio In point

Split edit
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m Choose Mark Split from the Mark menu, then choose either Video In or Video Out from 
the submenu.

The resulting video edit point in your scrubber bar should look something like this:

4 Now move the playhead to the location in your clip where you want to set your audio In or 
Out point.

5 To set a split audio In or Out point, do one of the following:

m Press Option-Command-I to set an audio In point or Option-Command-O to set an audio 
Out point.

m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
either Audio In or Audio Out from the submenu.
378 Chapter  12   



m Choose Mark Split from the Mark menu, then choose either Audio In or Audio Out from 
the submenu.

The resulting combination of video and audio edit points in your scrubber bar should 
look something like this:

Changing the Location of In and Out Points

You can quickly change the In and Out points of a clip in the Viewer at any time. The simplest 
way to do so is to use the commands in the previous section to set the edit points at different 
locations in the scrubber bar. There are a few other ways to change your designated In and 
Out points:

To change the location of the In and Out points:

m Drag any previously marked In or Out point icons along the scrubber bar.

m Option-drag any previously marked simple In or Out point along the scrubber bar to turn 
it into a split edit. Option-dragging the top half of an edit point changes the video edit 
point, while Option-dragging the bottom half of an edit point changes the audio edit 
point.

m Click the In or Out point column of an item in the Browser, then enter a new timecode.
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m To change the Out point, enter a new timecode in the Timecode Duration field. Final Cut 
Pro will calculate the location of the Out point by adding the duration you entered to the 
timecode value of the In point, and will mark it automatically. If no In point is marked, the 
Out point will be marked relative to the beginning of the clip.

m Click the clip in the Browser, then select either the In, Out, or Duration timecode 
numbers and enter new ones.

You can also change the location of both In and Out points at the same time. The duration of 
the marked media doesn’t change, just the location of the In and Out points. This is 
commonly referred to as slipping an edit, because you slip a pair of In and Out points inside 
the available footage.

To slip both the In and Out points at the same time:

Do one of the following:

m Press and hold the Shift key, then drag the In or Out point left or right in the scrubber 
bar.
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m Select the Slip Item tool in the Tool palette, then drag the In or Out point left or right in 
the scrubber bar.

Clearing In and Out Points

If you want to eliminate one or both edit points to start over again, there are several ways you 
can do so.

To remove an In or Out point:

m Drag an In or Out point vertically off the scrubber bar, either up or down.

m Press Option-I to clear the In point, or Option-O to clear the Out point.

m Control-click in the scrubber bar, then choose Clear In, Clear Out, or Clear In and Out 
from the shortcut menu.

m Option-click the Mark In button to clear an In point.

m Option-click the Mark Out button to clear an Out point.

m Option-click the Mark Clip button to clear both In and Out points at the same time.

m Press Option-X to clear both In and Out points at the same time.
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Moving the Playhead to In and Out Points

You can move the playhead directly to an In or Out point. This can be useful if you need to 
make a slight adjustment to your In or Out point. Move the playhead to the edit point, then 
move it by the necessary frames and mark it again at the correct location.

To go directly to the In point:

m Press Shift-I.

m Shift-click the Mark In button.

To go directly to the Out point:

m Press Shift-O.

m Shift-click the Mark Out button.

To navigate back and forth between edit points:

m Click the Next or Previous Edit buttons.

m Press the Up and Down Arrow keys.

About Viewing Overlays Related to In and Out Points

Final Cut Pro provides translucent visual cues, called overlays, to help you easily recognize 
the In and Out points you’ve set in the clip or sequence currently open in the Viewer. 
Overlays appear on top of the video when the playhead is stopped at a specific frame, such 
as the location of an In point or a marker. Overlays appear only in the Viewer and Canvas and 
are turned on separately by default. They are not rendered into your material, and do not 
appear in your output.

Can’t Make Up Your Mind?

Are there several frames that might make good edit points in your clip? Instead of 
picking one and forgetting where the others are, note the locations of any frames that 
might cut well by using markers. For more information on adding markers to your clip 
in the Viewer, see “Using Markers” on page 392.
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You can display the following overlays:

m In and Out points:  These overlays, or icons, appear when the playhead is positioned at 
an In or Out point frame.

m Split edits:  A split edit is any edit where the video track In or Out point is different from 
the audio track In or Out point. The In and Out points of split edit clips look different 
from regular markers.

In or Out point overlay
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m Start and end of media:  A filmstrip symbol indicates the start or end of the video media. (A 
symbol to the left indicates the start of the clip, a symbol to the right indicates the end.)

m Start and end of edits:  If an edited sequence is open in the Viewer, an L-shaped icon in 
the lower-left corner indicates the start of an edit. A backward L-shaped icon in the lower- 
right corner indicates the end of an edit. Even though there are no visual indicators of 
edit points in the scrubber bar, you can still navigate from edit to edit using the Up and 
Down Arrow keys. 

A filmstrip symbol on the left 
indicates the start of the media. 

A filmstrip symbol on the right
indicates the end of the media.

This icon indicates
the start of an edit.
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m Markers:  Marker overlays appear as translucent boxes containing the marker’s name and 
comment text, if any. For information about creating markers, see “Using Markers” on 
page 392.

To view overlays:

m Choose Overlays from the View pop-up menu, so a checkmark appears next to it.

To hide overlays:

m Choose Overlays from the View pop-up menu, so no checkmark appears next to it.

When the playhead 
is over a marker, an 
overlay appears.
  Working With Clips and the Viewer 385



Creating and Working With Subclips
Normally, as you edit material from the master clips in the Browser or Viewer into various 
edited sequences in the Timeline, no matter how many clip duplicates you edit into your 
sequences, they all refer to a single master clip in the Browser. This helps keep the Browser 
from getting cluttered, since if you need to make a change to a sequence clip, you can always 
open it in the Viewer directly from the Timeline, and you’ll instantly have access to the entire 
clip, exactly the same as from the master clip.

Still, if you want to, you can break up a single master clip into several subclips. Subclips are 
shorter clips that you create from In and Out points or from markers set in a master clip. 
When you create a subclip, a duplicate of your master clip is created, containing only the 
media that was between that master clip’s In and Out points. 

Subclips allow you to work more easily with lengthy media, or to break up a clip into smaller 
sections for organizational purposes. For example, you can open a 20-minute clip comprising 
fifteen different shots in the Viewer and divide it into fifteen subclips, one for each shot you 
want to use in your edit. 

Final Cut Pro places these new subclips in the same project bin as the master clip, numbering 
each. For example, if the master clip is named “Long interview,” the first subclip is named 
“Long interview subclip,” the second is “Long interview subclip 2,” and so on. When a new 
subclip is first created, its name is highlighted and ready to be changed.

You can rename subclips, move them into different bins, and organize them however you 
choose. After you’ve created your subclips, you can open them in the Viewer and set new 
edit points, just as with any other clip. The master clip remains in the Browser, but is 
completely independent of your subclips. Any changes you make to a subclip are not made 
to the master clip.

Numbered subclips are
placed in the same bin

as the master clip.
386 Chapter  12   



To create a subclip:

1 Open a clip in the Viewer.

2 Mark In and Out points.

3 Do one of the following

m Choose Make Subclip from the Modify menu.

m Press Command-U.

A new subclip appears in the Browser below the master clip.

If you’ve opened a subclip to a certain frame in the Viewer, but you find you’d rather go to 
the same frame in the subclip’s master clip to pick a different set of edit points, you can easily 
swap the two in the Viewer.

To find a subclip’s original master clip:

1 Open the subclip in the Viewer.

2 Find the frame you want to match to that in the master clip.
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3 Do one of the following:

m Choose Go To from the Mark menu, then choose Master Clip from the submenu.

m Press Shift-F.

Final Cut Pro matches whichever frame the playhead was on in the subclip with the same 
frame in the master clip, which is now open in the Viewer.

Sometimes, you may be looking for an In point or Out point in a subclip, and realize that 
although those frames existed in the original master clip, they were left out when you 
created the subclip. Instead of swapping the two, you can quickly bring back all of the 
original media, right in your currently open subclip.

To extend the In and Out points on a subclip to those of the original 
master clip:

1 Open the subclip in the Viewer.
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2 Choose Remove Subclip Limits from the Modify menu.

Your subclip will now have all of the media in the original master clip.

Using Markers to Define Subclips

You can also use markers to define subclips. For more information on how to do this, see 
“Using Markers” on page 392.

Changing Poster Frames

When you look at clips in the Browser in large icon view or if you show the Thumbnail 
column in list view, the icon or thumbnail picture you see reflects either the designated In 
point for that clip (or the first frame of the clip if no In point has been set), or the poster 
frame that was set for the clip in the Browser.

Any frame of a clip can be its poster frame. Poster frames are useful if you want to identify a 
clip visually in the Browser using a specific image, and can be especially useful if you’re 
working with a lot of clips or subclips with similar imagery. 

For example, let’s say you have five talking head interview clips that all look the same at the 
beginning, but the camera zooms into one of the shots so that it ends up as an extreme 
close-up of the subject’s hands. You can open this clip in the Viewer and set a poster frame at 
the point where the hands are in the frame. That way, you can easily spot that clip among all 
the others.
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To set a poster frame for a video clip:

1 Open the clip from the Browser in the Viewer.

2 Locate the frame you want to designate as the poster frame.

3 Do one of the following:

m Choose Set Poster Frame from the Mark menu.

m Press Control-P.

That frame will now appear as that clip’s poster frame. You can change the poster frame as 
frequently as you like, or you can clear it if it’s no longer necessary.

To clear a poster frame from a video clip:

1 Open the clip from the Browser in the Viewer.

2 Choose Clear Poster Frame from the Mark menu.
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Removing Unused Footage But Leaving Your Subclips

If you’ve created several subclips and are using them exclusively, and are not using all of the 
media in the original master clip, you can remove all of your unused footage and leave just 
the subclip portions of your media. Simply selecting a group of subclips and recapturing 
them using the Batch Capture command won’t work, because Final Cut Pro will recapture 
the entire master clip all over again. Instead, you can use the Media Manager to delete any 
unused footage and free up valuable hard disk space.

To eliminate unused footage from your project and leave just your subclips:

1 First, delete your master clip from the Browser. 

If you don’t, you may not eliminate anything. Remember, deleting a clip from the Browser 
only deletes the reference to the media on your hard disk, not the media itself.

2 Now, select all of the subclips that you created from the master clip you just deleted.

Any subclips you don’t select will be lost, so it’s important to get them all.

3 Control-click one of the selected subclips, then choose Media Manager from the shortcut 
menu.

4 In the Media Manager dialog box, make the following selections:

a Deselect the “Duplicate selected item and place into a new project” checkbox.

b Check the “Delete unused media from selected item” checkbox.
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c Choose “Use existing” from the “media referenced by selected item” pop-up menu.

5 Now, click OK.

All unused media will now be deleted, both from your project and from the source media on 
the hard disk, leaving only the clips you selected. 

The Media Manager is an extremely versatile tool, giving you great flexibility in working with 
all the captured media in a given project. For more information on using the Media Manager, 
see Chapter 18, “Using Media Tools,” on page 855.

Using Markers
Markers are reference points within clips that identify specific frames of a clip or sequence. 
Markers let you do a wide variety of tasks:

m Mark several possible In or Out points for future use.

m Quickly move the playhead to a marker in a clip or sequence.

m Mark a range in a clip that you may want to use as a subclip.

m Align a clip marker to a marker in an edited sequence to match a visual or audio cue.

m Align a filter or motion keyframe to a marker for future reference.

m Align other clip markers, clip boundaries, or transition boundaries to a marker in the 
Timeline.

m Add visual notes about clips that will help you identify sections while editing.
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You can have any number of markers in a clip. You can set markers while a clip is playing or 
while the playhead is stopped. When you add a marker to a clip that you’ve opened from the 
Browser, that marker is also displayed in the Browser. This lets you work with the marker as if 
it were a subclip. If your markers have durations, they can be turned into subclips 
automatically.

Marker overlays appear over the video image whenever the playhead is positioned at a 
marker (see “About Viewing Overlays Related to In and Out Points” on page 382). Marker 
icons also appear in the scrubber bar.

Markers within a clip

A marker overlay
  Working With Clips and the Viewer 393



Adding or Deleting Markers to or From a Clip

You can add markers and attach comments to them. Both the name and the comments 
appear as overlays in the Viewer whenever the frame containing the marker is displayed. 

To add a marker to a clip:

1 Open the clip in the Viewer.

2 Play the clip or sequence.

3 When the playhead reaches the desired point, do one of the following:

m Choose Markers from the Mark menu, then choose Add from the submenu.

m Press M.

m Click the Add Marker button.

To move the playhead to the frame of a marker you’ve created:

m Drag the playhead to the marker in the scrubber bar. If snapping is turned on, the 
playhead will snap to the position of a nearby marker.

m Control-click in the Current Timecode field in the Viewer, then choose a marker from the 
shortcut menu.

m Choose Previous from the Mark menu, then choose Marker from the submenu.

m Choose Next from the Mark menu, then choose Marker from the submenu. 

m Press Shift-Up Arrow to jump to the next marker to the left of the playhead, or Shift-Down 
Arrow to jump to the next marker to the right.

m Press Option-M to jump to the next marker to the left of the playhead, or Shift-M to jump 
to the next marker to the right.
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To add information, rename, or edit a marker with the playhead stopped:

1 Stop playback if playback is in progress.

2 Move the playhead so that it is directly over the marker you want to edit.

3 Press M or click Add Marker.

4 In the Edit Marker dialog box, enter a name and any additional comments, then click OK.

You can also Shift-click the Add Marker button to set a marker and automatically open the 
Edit Marker dialog box at the same time.

To delete markers from a clip or sequence:

1 Move the playhead to the marker.

2 Do one of the following:

m Option-click the Add Marker button.

m Choose Markers from the Mark menu, then choose Delete from the submenu.

m Press Command-` (the accent key).
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Renaming Markers

By default, the first marker you add is named Marker 1, the second Marker 2, and so on. The 
default names indicate the order you’ve added them to a clip. You can rename markers to 
indicate the location they mark.

To rename a marker:

1 Move the playhead to the marker, then do one of the following:

m Choose Markers from the Mark menu, then choose Edit from the submenu.

m Control-click the marker in the Browser, then choose Edit Marker from the shortcut 
menu.

m Press ` (the accent key).

m Select the marker, then press M.

m Press Command-Option-M to edit the nearest marker.

2 In the Edit Marker dialog box, enter the new name and any comments, then click OK.

Moving a Marker

You can move a marker by repositioning the playhead, or by entering a different start 
timecode.

To move a marker by repositioning the playhead:

1 Move the playhead to the location where you want to move the marker.

You can only move a marker 
forward, not backward.
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2 Do one of the following:

m Choose Markers from the Mark menu, then choose Reposition from the submenu.

m Press Shift-‘ (the accent key).

Final Cut Pro moves the marker immediately to the left of the playhead’s current position. 
Even if there are multiple markers, only the one immediately to the left of the playhead is 
moved.

To move a marker by entering new timecode:

1 Move the playhead to the marker.

2 Do one of the following:

m Press M.

m Click the Add Marker button.

m Choose Markers from the Mark menu, then choose Edit from the submenu.

m Press Command-Option-M to edit the nearest marker.

3 Enter a new start time in the Start field of the Edit Marker dialog box, then click OK.
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Creating Markers With Durations

You can extend a marker’s duration if you decide you want to use that marker to create a 
subclip, or to note a specific duration for future reference, such as when creating a transition 
or a superimposition.

To extend a marker’s duration by entering a timecode:

1 Move the playhead to the marker.

2 Do one of the following:

m Press M.

m Click the Add Marker button.

m Choose Markers from the Mark menu, then choose Edit from the submenu.

m Press Command-Option-M to edit the nearest marker.

3 Enter a duration value.

An extended duration marker appears on the scrubber bar; it looks like a marker icon with a 
bar that extends along the scrubber bar. 

Enter the desired 
marker duration here.
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To extend a marker’s duration to the playhead’s location:

1 Position the playhead ahead of the marker.

2 Do one of the following:

m Choose Markers from the Mark menu, then choose Extend from the submenu.

m Press Option-` (accent key)

The marker’s duration is extended from the original location of the marker to the location of 
the playhead.

Turning a Marker Into a Subclip

An extended duration marker can act like a subclip when selected from the Browser. If you 
double-click a marker in the Browser, it opens a subclip in the Viewer. If you like, you can 
make an actual subclip from an extended duration marker. This way, you can use markers to 
note all the sections of a long clip that you’d like to make into individual subclips.

To make a subclip from a marker:

1 Select the marker in the Browser.

2 Choose Make Subclip from the Modify menu.

The subclip appears in the same bin as the master clip, with the names of both the marker 
and master clip. 

Creating Subclips Using DV Clips and Start/Stop Detection

You can use the Make Subclip command in combination with the DV Start/Stop Detection 
command to automatically split up long DV clips (such as entire captured sections of tape) 
into individual subclips based on the starts and stops on your DV tape. Starts and stops occur 
any time the Record/Pause button is pressed on your camcorder.

To break a long DV clip into subclips based on starts and stops:

1 Capture a long clip from a DV tape containing several starts and stops. 

Note:  If you’re capturing the contents of an entire DV tape, make sure there are no 
timecode breaks, as these could cause errors in the captured timecode of your clip.

2 Open this clip in the Viewer.
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3 With the Viewer active, choose DV Start/Stop Detection from the Tools menu.

4 You should now see a marker in front of every start and stop in the clip. 

(If you have any exceptionally long clips, you can break these up further by adding a few 
more markers manually.)

5 Switch the Browser to list view and locate the clip you were working on in the Viewer. 

6 Click the disclosure triangle to view the clip’s markers.

If you want to give any of the markers a more descriptive name, simply click the marker in 
the Browser, then click the marker’s name to select it. You can now change it to whatever 
you like.
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7 Drag in the Browser to select all the markers.

8 Choose Make Subclip from the Modify menu.

All of the material between the markers you selected should now appear as subclips. If you 
gave your markers new names, your subclips will use them.

Now that you’ve created all of your subclips, you can review them, deleting any clips you 
might not need. If you do remove unused clips, you can use the Media Manager to remove 
your unused footage from disk, leaving your remaining subclips alone. For more information, 
see “Removing Unused Footage But Leaving Your Subclips” on page 391.
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13 Working With Sequences, 

the Timeline, and the Canvas
This chapter covers how to create and modify sequences and how to work in the Timeline 
and the Canvas.

The Timeline and Canvas are two interlinked windows that represent an edited sequence. 
Neither appears unless a project with at least one sequence is open. The Timeline shows a 
graphical representation of your edited sequence, with all of that sequence’s clips laid out in 
the order in which they were edited. 

The playhead in the Canvas is locked to the playhead in the Timeline, and displays the frame 
at the playhead’s current position in an open sequence. The controls in the Canvas are 
similar to those in the Viewer, but instead of navigating and playing back individual clips, the 
controls in the Canvas navigate the entire sequence currently displayed in the Timeline.

Before covering the interface of the Timeline and Canvas in more detail, it’s important to 
understand how to create and modify the sequences they represent.
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Working With Sequences
While the project tab in the Browser displays all the clips and sequences that are available for 
use while you edit, an individual sequence is a container in which you edit together a series 
of clips to create a new program. A project can have multiple sequences, and sequences can 
also be used as source clips and edited into other sequences. You cannot save individual 
sequences as files outside of a project, but you can export their content as video or 
QuickTime files.

New sequences are placed in the currently selected project tab in the Browser. When you 
create a new project, by default it contains one new sequence titled Sequence 1.

Sequences in your project act as containers for groups of clips. In fact, a sequence may 
contain clips that aren’t located anywhere else in the Browser. For example, when you import 
an Edit Decision List (EDL), all the clips that make up the newly imported sequence are 
found only in that sequence. There are no other duplicates in the Browser unless you put 
them there. (For more information on importing EDLs, see Chapter 10, “Importing Edit 
Decision Lists (EDLs),” on page 313.)

Once you’ve edited clips together inside a sequence, that sequence itself can be treated like a 
clip. It can be played in the Viewer and edited into other sequences, just like any other clip. 
See “Nesting Sequences” on page 937 for more information on editing sequences inside of 
other sequences.

You can have more than one sequence open at a time. Each open sequence appears as a tab 
in both the Canvas and Timeline. Clicking a tab in the Timeline or Canvas brings that 
sequence to the front for editing and playback.

New sequence
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Changing the Default Settings for New Sequences

New projects automatically contain one new sequence, called “Sequence 1.” This first sequence 
uses the default sequence preset specified in the Easy Setup you chose when you configured 
Final Cut Pro (see “Working With Presets” on page 104), with Timeline settings specified by the 
current settings in the Timeline Options tab of the Preferences window. Unless you change 
your video or audio input device, you probably won’t ever need to change your Easy Setup and 
its associated sequence preset, but if necessary, you can do so at any time.

Changing your Easy Setup or sequence preset doesn’t change the settings of any sequences 
you’ve already created; it only affects new sequences that you create from that point forward. 
If none of the Easy Setups or presets that ship with Final Cut Pro suit your needs, you can 
easily create a new Easy Setup or custom preset. See Chapter 5, “Working With Easy Setups, 
Presets, and External Video Settings,” on page 99 for more information. 

Viewing an Existing Sequence’s Settings

When you open the Sequence Settings window for a sequence that’s already been created, 
you’ll see three tabs that allow you to view and modify that sequence’s settings: the General, 
Timeline Options, and Video Processing tabs.

General Settings in the Sequence Settings Window

When you create a sequence, the current sequence preset determines the settings in this tab. 
Settings, which include the frame size, video compressor, and audio sample rate, can be 
modified for a sequence at any time.

The editing timebase, or frame rate, for the sequence is an exception. Once a sequence is 
created, you can change its editing timebase only if the sequence contains no clips. Once a 
sequence contains one or more clips, you can’t change its editing timebase.

Important  It’s extremely important that the settings in the General tab match the majority 
of your source media clips. Although you can import nearly any QuickTime clip you want to 
edit into your sequence, any video clip in your sequence that doesn’t use the timebase, frame 
size, and codec specified in this tab will have to be rendered prior to playback.
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The General tab has the following settings:

m Name:  The name of your sequence.

m Frame Size:  Choose a frame size from the Aspect Ratio pop-up menu or choose Custom 
to enter an arbitrary nonconstrained frame size in the Width and Height fields. If you type 
a number in a field with an aspect ratio other than Custom selected, the other field will be 
automatically calculated using the current aspect ratio. 

Note:  Frame size and pixel aspect ratio (below) often go hand in hand. 
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Common frame sizes for video include the following:

Even if you’ll be outputting at a smaller frame size for multimedia use, it’s best to capture and 
edit your video at its full size, and then scale it down later.

m Pixel Aspect Ratio:  Choose square or non-square pixels, depending on your video source: 

m Square is commonly used for multimedia or high definition video.

m Non-Square is commonly used for broadcast video, including DV-NTSC and DV-PAL.

m Anamorphic 16:9:  Check this box only if you’ll be capturing, editing, or outputting 16:9 
media. If this option is not selected, your 16:9 media will be displayed anamorphically, 
filling the entire screen image and appearing distorted. This checkbox only affects the 
display of video on your screen, and does not permanently rescale your source media. 
(For more information on anamorphic 16:9 video, see Appendix D, “Working With 
Anamorphic Media,” on page 1341.)

If this box is checked and you’re not editing 16:9 clips, they’ll be rescaled incorrectly and 
will look distorted.

m Field Dominance:  Choose the field dominance of your captured video. Most video will 
be either Upper (Odd) or Lower (Even), depending on the video capture interface you’re 
using. For noninterlaced video or multimedia clips, you should choose None.

Note:  DV captured via FireWire is always Lower (Even).

Standard frame sizes

640 x 480 A 4:3 ratio suitable for square pixel multimedia video

720 x 480 A non-square video frame size for DV-NTSC video

720 x 576 A non-square video frame size for CCIR 601-PAL or DV-PAL video

720 x 486 A non-square video frame size for standard CCIR 601 NTSC video
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m Editing Timebase:  Use this pop-up menu to change the editing timebase, or frame rate, 
of your sequence. Standard frame rates for capture and playback are

m 29.97 fps:  for NTSC video

m 25 fps:  for PAL video

A sequence’s timebase can be changed only if no clips have been edited into it. If one or 
more clips have been placed in a sequence, those clips must be removed before you can 
change the timebase.

m Compressor:  Choose the compression method, or codec, that the majority of clips in 
your edited sequence will use. Any clip in your sequence that doesn’t use the codec 
specified here will have to be rendered.

m Quality:  Adjust the slider or enter a percentage to set the visual image quality level. A lower 
setting yields the highest data compression and lowest quality, and a higher setting yields the 
lowest data compression and best quality (The quality levels will vary depending on the 
selected codec).

m Advanced:  Click this button to set additional QuickTime video settings, if necessary for 
your video hardware. For detailed information, see “Advanced QuickTime Video Settings 
for Sequence Presets” on page 117.

Sequence settings other than the timebase can be changed individually, or you can apply 
another sequence preset with a matching timebase to quickly modify all the settings at once.
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Timeline Options Settings in the Sequence Settings Window

When you first create a sequence in a project, the way it’s displayed in the Timeline is 
determined by the settings in the Timeline Options tab in the Preferences window. Each 
sequence stores its own Timeline settings, however, so you can change the Timeline settings 
of different sequences in your project using in the Sequence Settings window. When you 
open another sequence in the Timeline or switch from one sequence’s tab to another, the 
Timeline’s display changes to reflect each sequence’s settings.

The Timeline Options tab has the following settings:

m Starting Timecode:  This is the timecode number that appears at the beginning of the 
sequence. Typically, this will be 01:00:00:00, but if you want your program to begin at a 
particular hour, you can enter the timecode here.

m Drop Frame:  Selecting this checkbox makes your timecode drop frame. This option is 
not available for PAL sequences.
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m Track Size:  This determines how tall your tracks will appear in the Timeline. The shorter 
your track heights, the more tracks you’ll be able to see in the Timeline at once. The 
options are Reduced, Small, Medium, and Large. You can change this setting at any time 
using the Track Height control at the bottom of the Timeline window.

If the track size is set to Reduced, thumbnails and audio waveforms will not be displayed.

m Thumbnail Display:  This setting affects how individual clips are displayed within the 
Timeline.

m Name:  Displays each clip in the Timeline with only a name and a solid bar 
representing the clip’s duration.

m Name Plus Thumbnail:  Display’s the clip’s name and duration, as well as a one-frame 
thumbnail at the beginning of the clip. This is the default setting.

m Filmstrip:  Displays your clips as a series of consecutive thumbnails that show the 
action in that clip. The time scale of the Timeline will determine how many thumbnails 
are displayed for each clip.

Name of clip

Thumbnail and 
name of clip
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Note:  If the track size is set to Reduced, thumbnails are not displayed.

m Audio Track Labels:  There are two ways to display labels for audio tracks.

m Sequential:  Sequential labels number each audio track consecutively (A1, A2, A3, and 
so on). Each audio track is identified individually, which is useful if you want to have a 
one-to-one correspondence between your video and audio tracks.

m Paired:  Paired labels identify audio tracks in pairs (A1a, A1b; A2a, A2b; A3a, A3b; and 
so on). This is useful if you have a lot of stereo material, and you want an easy way to 
see the relationship between each stereo pair of tracks.

Series of consecutive 
thumbnails

Audio track 
sequential

Audio tracks paired
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m Show Filter and Motion Bars:  With this checkbox selected, additional space is added 
underneath each audio and video track in the Timeline. If a filter is added to an audio or 
video clip, a small green bar appears in this space for the duration of the clip. If a motion 
setting is modified for a video clip in the Timeline, a small blue bar appears in this space 
for the duration of the clip.

If keyframes are added to the filter or motion settings for a clip, those keyframes appear 
on top of the bar to which they apply, where they can be edited or moved. For more 
information about filters, see Chapter 22, “Working With Video Filters, Generators, and 
Speed Settings,” on page 1023; for more information about motion settings, see 
Chapter 21, “Compositing, Applying Motion Effects, and Using Keyframes,” on page 907.

Filter and motion bars can be displayed or hidden at any time by clicking the Clip 
Keyframes control at the bottom of the Timeline window.

A green bar indicates a 
filter has been applied.

A blue bar indicates
motion has been applied.
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m Show Keyframe Overlays:  With this checkbox selected, opacity overlays will be displayed 
over video tracks (as thin black lines), and audio level overlays will be displayed over 
audio tracks (as thin red lines). 

These lines indicate how transparent or how loud each video and audio clip in your 
edited sequence will be when you play it back. Any keyframes added to these properties 
will appear as handles, directly on top of the overlay. Overlays and their related keyframe 
handles also serve as controls themselves, and can be manipulated directly. 

You can display or hide keyframe overlays at any time by clicking the Clip Overlays control 
at the bottom of the Timeline window.

m Show Audio Waveforms:  Selecting this checkbox will display your audio clips in the 
Timeline as waveforms, rather than plain bars. Waveforms are useful when you’re editing 
if you want to see a visual representation of the loud and soft parts of your audio. The 
keyboard shortcut for turning waveform display on or off is Command-Option-W.

Note:  If the track size is set to Reduced, audio waveforms are not displayed.

 Audio waveform Video opacity overlayAudio level overlay
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Video Processing Settings in the Sequence Settings Window

The options in this tab are available for codecs that support YCrCb color space. To find out 
which codecs support this, go to the Final Cut Pro Web site at www.apple.com/finalcutpro

m Always Render in RGB:  When this is checked, codecs that normally process color using 
the YUV (or YCrCb) color space are forced to process in RGB color space. Selecting this 
option may cause subtle changes in color in your rendered material. If your video capture 
card doesn’t support YUV rendering, this option will be unavailable.

Use this option if you want to accomplish a specific compositing task, and you think color or 
luminance clamping in RGB color space might give you a different desired result than 
straight YUV color space. For example, if you’re using After Effects filters, which only process 
in RGB color space, with Final Cut Pro filters, which process in YUV color space, choosing 
this option ensures a consistent look.

m Process maximum white as:  Many DV camcorders record video with whites that are 
brighter than 100 IRE, the level allowed by the engineering standard for video (referred to 
as CCIR 601). Whites brighter than 100 IRE are called “superwhite.”

When you use clips created in RGB color space (for example, imported graphics files, 
Final Cut Pro generator clips such as mattes or gradients, or QuickTime movies that use 
codecs in RGB color space), whites in these imported clips may not match imported 
video clips recorded using superwhite levels.

Choose the desired 
options.

Click the Video 
Processing tab.

When you’re finished 
changing settings, 
click OK.
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This pop-up menu allows you to match RGB brightness to YUV (or YCrCb) clips using 
superwhite. It is only available if “Always Render in RGB” is not selected. It has two options:

m White:  If you choose this, the maximum brightness of imported clips from RGB color 
space will be 100 IRE, or normal white. If you’re sure that the brightness of your 
imported video clips is no more than 100 IRE, you should use this setting.

m Super-White:  If you choose this, the maximum brightness of imported clips from RGB 
color space will match the superwhite levels of clips from DV camcorders.

Changing a Sequence’s Settings

Typically, you’ll only need to change your sequence’s settings if you

m change your video or audio capture device

m import previously captured media and notice that the editing timebase, frame size, or 
codec of your source media doesn’t match that of your sequence

If you import previously captured clips with properties that don’t match your current 
sequence settings, you’ll need to change your sequence settings to match them. If you edit 
the clips in without changing these settings, you’ll find that you’ll have to render all the clips 
before playback. Instead of changing your sequence settings individually to match the 
properties of your imported clips, you can simply select a new preset that matches the media 
you want to work with, and all your sequence settings will be changed at once.

For example, let’s say you’ve imported a bunch of DV PAL clips into a new project, but then 
realized that your project was originally set up to work with DV NTSC. Instead of deleting the 
sequence you just created, you can simply open your sequence settings and change them.

There are two ways to change a sequence’s settings after opening its Sequence Settings window:

m Change each setting one at a time:  This lets you create a new, custom group of settings, 
if needed. 

m Change all settings at once by selecting a different sequence preset:  This is an easy way 
to switch to a predefined group of settings.
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To view and change individual settings for a sequence:

1 Select a sequence in the Browser or in the Timeline.

2 Do one of the following:

m Choose Settings from the Sequence menu.

m Control-click the sequence’s icon, then choose Sequence Settings from the shortcut menu.

m Press Command-0 (zero).

3 In the Sequence Settings window, click a tab, change its settings, then click OK.

To change sequence settings using a new sequence preset:

1 Select a sequence in the Browser.

2 Do one of the following:

m Choose Settings from the Sequence menu.

m Control-click the sequence’s icon, then choose Sequence Settings from the shortcut menu.

m Press Command-0 (zero).
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3 Click the Load Preset button.

4 Choose a new preset from the pop-up menu in the Select Preset dialog box, then click OK.

Creating and Deleting Sequences

You can create as many new sequences as you want in a project. There are many different 
reasons to use multiple sequences in a single project. You can

m break down a complex edit into a series of separate sequences.(for example, one for each 
scene in your project). These sequences can then be edited together later when all the 
scenes are finished.

m use separate sequences to edit different versions of the same program. For example, you 
could edit three different versions of the same five-minute training video in preparation 
for a client’s review.

m edit separate programs based on the same material. For example, you could edit a thirty 
second-version and a two-minute version of the same public service announcement video.

m separate an elaborate effects shot into its own sequence to render separately. For 
example, you might build an animated title sequence separately, render it, and edit the 
title sequence into your program sequence. Editing the title sequence inside another 
sequence doesn’t cause Final Cut Pro to rerender all the prerendered effects in the 
original title sequence. For more information about the rendering process, see 
Chapter 23, “Rendering,” on page 1065.

Click here to change
the sequence preset

for this sequence.

Choose the 
desired preset, 
then click OK.
  Working With Sequences, the Timeline, and the Canvas 417



To create a new sequence and add it to the current project:

1 Do one of the following:

m Choose New from the File menu, then choose Sequence from the submenu.

m Control-click in the Viewer, then choose New Sequence from the shortcut menu.

m Press Command-N.

A new sequence appears with the name selected.

2 Enter a name for the sequence and press the Enter or Return key.

To delete a sequence from the current project:

1 Select the sequence you want to delete in the Browser.

2 Do one of the following:

m Choose Clear from the File menu.

m Press the Delete key.

Enter a new name for the 
sequence, if desired.
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Opening and Closing Sequences

You can only edit clips into open sequences. When you open a sequence, the Timeline and 
the Canvas automatically open, if they’re not open already. If the Timeline and Canvas are 
already open, newly opened sequences will appear in their own tab on top of any other 
sequence tabs.

To open a sequence in the Timeline and Canvas:

m Double-click the sequence.

m Select the sequence in the Browser using the arrow keys, then press Return.

m Control-click the sequence, then choose Open Timeline from the shortcut menu.

m Select the sequence, then choose Sequence Editor from the View menu.

The sequence opens in the Timeline and Canvas windows.

You can also open a sequence in the Viewer. Sequences in the Viewer can’t be edited, but you 
can mark them with In and Out points in preparation for editing them into other sequences 
or editing them to tape using the Edit to Tape command. For more information on editing 
sequences into other sequences, see “Nesting Sequences” on page 937. For information on 
editing to tape, see Chapter 27, “Editing to Tape,” on page 1123.

To open a sequence in the Viewer:

1 Select the sequence in the Browser.

2 Do one of the following:

m Choose Sequence from the View menu.

m Drag the sequence icon from the Browser to the Viewer.

m To open the sequence in a new window, choose Sequence in New Window from the 
View menu.

To close a sequence that’s open in the Timeline and Canvas:

Do one of the following:

m With the sequence tab selected in either the Timeline or the Canvas, choose Close Tab 
from the File menu.

m Control-click a tab in the Timeline or Canvas, then choose Close Tab from the shortcut menu.

m Press Control-W.

When you close the tab of a sequence in the Timeline, its tab in the Canvas automatically 
closes, and vice versa.
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Duplicating a Sequence

Duplicating a sequence is a good way to make revisions to an edited sequence while 
preserving the original version.

To duplicate a sequence:

1 Select the sequence in the Browser.

2 Do one of the following:

m Choose Duplicate from the Edit menu.

m Control-click the sequence, then choose Duplicate from the shortcut menu.

m Press Option-D.

m Option-drag the sequence to a new location in the Browser.

3 In the Browser, enter a new name for the duplicate sequence.

Changes you make to the copied sequence will not affect the original sequence or its 
rendered files.

Type a unique name for the 
copied sequence.
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Copying a Sequence

You can copy a sequence from one project and paste it into another project. When you copy 
and paste a sequence from one project to another, the clips in that sequence reference the 
same source media on your hard disk as the sequence in the original project. No media is 
duplicated on disk.

To copy a sequence from one project into another:

1 Select the sequence in the Browser.

2 Do one of the following:

m Choose Copy from the File menu.

m Press Command-C.

3 Open a new project and select its tab in the Browser.

4 Do one of the following:

m Choose Paste from the File menu.

m Press Command-V.

You can also copy a sequence into another project window by dragging and dropping.

To drag a sequence from one project to another:

1 Open a second project. 

This project will appear as another tab in the Browser.

2 Drag the second project tab into its own window.

3 Drag your sequence from the first project tab to the second.
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Working With the Timeline and Canvas
As mentioned at the beginning of this chapter, the Timeline and Canvas both represent an 
open sequence. When you open a new sequence, it appears simultaneously in tabs in both 
the Canvas and the Timeline. These two windows mirror one another, and their playheads 
are locked together.

The Timeline shows a graphical representation of your entire sequence with all of the clips in 
it laid out in the order in which they were edited. The Canvas displays whichever frame is at 
the current position of the playhead. If you move the Timeline’s playhead, the Canvas 
changes accordingly. If you make a change in the Timeline, it’s reflected in the Canvas.

The Canvas and Viewer Play Different Media

Although the Canvas and Viewer windows are very similar in appearance and use many of the 
same controls, the video displayed in the Canvas is not the same as that in the Viewer. In the 
Viewer, you open and play clips in preparation for editing, while the Canvas shows media 
that’s already been edited into a sequence.

Unlike the Viewer, there are no Audio, Filter, or Motion tabs in the Canvas. The only tabs that 
appear in the Canvas are those of sequences that you open. As in the Viewer, you can also set 
In and Out points and markers in the Canvas. Unlike the edit points and markers you set in 
the Viewer, however, these are sequence In and Out points and are used for functions like 
printing to video and exporting to QuickTime. Markers that you set in the sequence appear 
in the Timeline, not inside individual clips.
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About the Display Quality of DV Video 
When you play back DV clips, the quality of the image on your computer screen may vary 
depending on the model of computer you’re working with. Power Macintosh G3 models will 
display your DV clips at a slightly lower resolution, with the resulting image looking 
somewhat soft. The Power Mac G4, on the other hand, can display the same clips using a 
higher quality, resulting in a sharper image on your computer screen. 

Warning  By default, Final Cut Pro displays your DV video using this variable quality 
mode to take advantage of the best quality your computer is capable of displaying. You 
can force Final Cut Pro to display DV video at the highest quality by choosing Project 
Properties from the Edit menu, clicking Edit Render Qualities, then selecting the High 
Quality Playback checkbox. It’s best to leave this option unchecked; it will only slow Final 
Cut Pro’s performance.

To avoid slowing Final Cut 
Pro down, leave this option 
unchecked.

Important  The playback quality only describes how your video is displayed on your 
computer monitor. DV media is always captured to your hard disk at the highest quality, 
and video output to tape or rendered out of Final Cut Pro using the DV codec is always at 
full video resolution and 29.97 frames per second (fps) for NTSC or 25 fps for PAL, regardless 
of what the image on your computer monitor looks like.
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While Final Cut Pro normally plays back video at a full frame rate of 29.97 fps for NTSC and 25 
fps for PAL, enabling external video may lower the frame rate of video on your computer 
monitor during playback. Final Cut Pro uses the following guidelines:

m On 400 MHz (or faster) Power Mac G4 computers:  DV video always plays back using a 
relatively high quality, with a sharp picture, at 29.97 fps for NTSC or 25 fps for PAL.

m On all earlier Final Cut Pro-qualified computers:  With external video disabled, video 
plays back at 29.97 fps for NTSC or 25 fps for PAL, and has a softer picture. With external 
video enabled, video plays back at 12fps with a softer picture.

Audio/Video Sync With External Video On

Whenever you enable external video, audio plays only through your selected video capture 
interface, since Final Cut Pro disables audio output through your computer’s speakers or 
headphone jack. If you’re using FireWire, this means that you’ll only hear audio coming out 
of the DV device that’s connected to your FireWire port, such as your DV deck or camcorder.

Audio playing through an attached DV device will only sync up with video that’s playing 
through that same device. If you listen to the audio through an attached DV deck or 
camcorder, and watch the mirrored video playing on your computer screen, you’ll notice a 
sync offset. To eliminate the audio offset with video on your computer display, disable 
external video in the View menu.

Choose Off to turn 
external video off.
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About the Canvas
If the Viewer is analogous to a source monitor, then the Canvas is Final Cut Pro’s record 
monitor, showing what your edited sequence will look like when it’s played. There are many 
controls and displays in the Canvas.

m Tabs:  Each tab in the Canvas represents an open sequence. Each tab in the Canvas has a 
corresponding tab in the Timeline.

m Image display area:  The area of the Canvas where you can see the video from your 
sequence play back.

m Playhead and scrubber bar:  These let you locate and jump to different parts of your 
sequence quickly and easily.

Timecode Duration field
Current Timecode field

Name of the currently 
selected sequence and 
the project it’s in.

View pop-up menuZoom pop-up menu

Transport 
controls

In point

Jog control Shuttle control

Scrubber bar Out point

Image display area

Sequence 
marking controls

Edit
buttons

Sequence marker

Playhead

Tabs
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m Transport controls:  These are used to play back your edited sequence.

m Jog and shuttle controls:  These let you more precisely navigate within your sequence.

m Sequence marking controls:  These are used to mark your sequence with edit points: In 
and Out points, markers, and keyframes.

m Editing controls:  The edit buttons and the Edit Overlay allow you to perform seven 
different types of edits.

m View and Zoom pop-up menus:  These let you enlarge or shrink the image that appears in 
the Canvas, change the viewing format, and control the display of various overlays.

m Timecode fields:  Two timecode fields allow you to move the playhead to a specific frame 
or timecode, as well as to change the sequence Out point based on an entered duration.

Selecting the Canvas

Before working with the Canvas, make sure it’s the currently selected window. Otherwise 
your keyboard shortcuts might trigger the wrong actions.

To select the Canvas window:

m Click in the Canvas.

m Press Command-2.

m Press the Q key to switch between the Viewer and the Canvas.

Selecting and Closing Tabs in the Canvas

All controls and commands in the Canvas affect only the sequence in the foreground.

To select a tab in the Canvas:

m Click a tab to bring it to the front.

To close a tab in the Canvas:

Do one of the following:

m With the tab selected, choose Close Tab from the File menu.

m Command-click the tab, then choose Close Tab from the shortcut menu.

m Press Control-W.

When you close the tab of a sequence in the Canvas, its corresponding tab in the 
Timeline closes.
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Navigation and Marking Controls in the Canvas
This section covers the playback and navigation controls located at the bottom of the Canvas. 
Although you use these controls to work with your sequences, not with individual clips, they 
mirror the functionality of the Viewer controls (with a few exceptions). 

Note:  For more information about Match Frame control, see “Locating a Match Frame” on 
page 600.

Playhead and Sequence Controls

You use the playhead and sequence controls to locate different parts of your sequence quickly.

m Playhead:  The playhead shows the location of the currently displayed frame of the 
sequence.

m Shuttle control:  This control is useful for quickly playing through your sequence at different 
speeds, in fast and slow motion. It also shifts the pitch of audio as it plays at varying speeds. 
Drag the slider to the right to fast-forward and to the left to rewind. Playback speed varies 
depending on the distance of the slider from the center of the control. 

The shuttle can play your sequence at five speeds in each direction: 1/4x, 1/2x, 1x, 2x, and 
4x. The shuttle control snaps to the closest available speed. When the slider is at –1x or 1x 
speed, it turns green.

You can use a number of keyboard commands to shuttle through your sequence:

m To begin forward playback at normal (1x) speed, press the L key.

m To pause playback, use the K key.

m To begin reverse playback at normal (1x) speed, press the J key.

Shuttle control

Playhead

Scrubber bar
Jog control
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m Press either the L or J key again to double the current playback speed. You can play 
back up to eight times normal speed, switching from 1x to 2x to 4x to 8x normal speed 
(pressing either key a total of 4 times). 

m Press the key for playback in the opposite direction to halve the playback speed. 
Pressing the same key again will slow until it reaches 1x, and will then begin doubling 
playback in the opposite direction starting from 1x.

m To immediately reverse the direction of a clip, press K to pause, and then press the key 
for the direction you want.

m Hold down the K key while pressing the L or J key to move the playhead one frame at 
a time in the desired direction.

m Hold down the K key while holding down the L or J key to play back in the desired 
direction at 1/3x speed.

Note:  When using keyboard shortcuts for device control, the speed of forward (L) and 
reverse ( J) may differ depending on your video equipment.

m Jog control:  To move forward or backward more precisely, use the jog control. The jog 
control lets you move the playhead in the Canvas as if you were moving it with your hand, 
with a one-to-one correspondence between the motion of your mouse and the playhead’s 
motion. This control is useful for locating a specific frame (for instance, if you’re trimming 
an edit). 

m The keyboard equivalents for the jog control are the Left and Right Arrow keys, which 
move the playhead forward and back a frame at a time. 

m To move the playhead one second at a time, hold down the Shift key when you drag 
the jog control.

m Scrubber bar and playhead:  The scrubber bar covers the entire width of the Canvas, 
below the video image. To scrub, or move through, a sequence, drag the playhead along 
the scrubber bar. You can also click anywhere in the scrubber bar to instantly move the 
playhead to that location. This is useful for quickly navigating through your sequence. 
Notice that if snapping is enabled, the playhead “snaps” to any markers, and to the In and 
Out points in the scrubber bar. (To turn snapping on or off, choose Snapping from the 
View menu.) Gray marks in the scrubber bar indicate one-minute increments.

As you scrub your clip, audio will also play more quickly, but it will not play back 
smoothly; instead, it will seem to stutter since individual audio samples are skipped. For 
smooth playback of audio at speeds under 1x, use the shuttle control instead.

m The keyboard equivalents for the scrubber bar and playhead are the same as those for 
the jog control. Press the Left and Right Arrow keys to move the playhead forward and 
back a frame at a time. Hold down the Shift key as you drag to move the playhead one 
second at a time. 
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m Inactive video:  When you set In and Out points, any sections of your sequence that fall 
outside the area between these two points is grayed out. This indicates that these sections 
of the sequence are not being used. These sections will still be available should you 
decide to change your edit points.

Transport Controls

Transport controls let you move the playhead within sequences. 

m Previous Edit:  Moves the playhead backward from its current position to a preceding edit 
in the Canvas. This is a good control to use to navigate quickly around a sequence of edits. 

m The keyboard equivalent is the Up Arrow key.

m Play In to Out:  Resets the playhead to either the beginning of your sequence, or the 
currently set sequence In point, and plays forward from that point to the end of the last 
clip in your edited sequence, or the currently set sequence Out point. 

m The keyboard equivalent is Shift-\ (backslash).

m You can also choose Play from the Mark menu, then choose In to Out from the submenu.

m Play:  Plays back your sequence from the current location of the playhead to the end, 
regardless of the Out point. Click this button again to stop playback.

m The keyboard equivalent is the Space bar (to play forward).

m To play backward, you can Shift-click the Play button, or press Shift-Space bar.

m You can also choose Play from the Mark menu, then choose Forward or Backward 
from the submenu.

Next Edit

Play Around CurrentPlay In to Out

Previous Edit

Play
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m Play Around Current:  Plays your sequence from a point before the current playhead 
position (specified by your pre-roll setting) and continues through the amount of time 
specified by the post-roll setting. The preview pre-roll and preview post-roll settings are 
located in the General tab of the Preferences window. You can use this control to get a 
quick sense of the material at the current position of the playhead. 

m The keyboard equivalent is the \ (backslash) key, or Command-click the Play button.

m You can also choose Play from the Mark menu, then choose Around from the submenu.

m Next Edit:  Moves the playhead forward from its current position to the next edit in 
the Canvas. 

m The keyboard equivalent is the Down Arrow key.

Other Playback Options

There are some other playback options in the Canvas that don’t have graphical controls.
m Play Every Frame

The Play Every Frame command comes in handy if you want to get a preview of an effects-
intensive sequence without rendering it first. Your sequence won’t play back at normal 
(1x) time; it will play back somewhat more slowly, depending on the number of effects 
applied and on the data rate of your clips. However, it will play back every frame without 
dropping any. To play every frame of a sequence:

m Choose Play from the Mark menu, then choose Every Frame from the submenu.

m Press Option-P.

m To stop playback, press the Space bar or click the Play button again.
m Looping Playback

With looping disabled, playback of a sequence starts at the current playhead position and 
stops at the end of the sequence. If you enable looped playback, when the end of the clip 
is reached, playback will start at the beginning again, continuing until you stop playback.

To enable looped playback: 

m Choose Loop Playback from the View menu (or press Control-L). If it’s already 
enabled, you’ll see a checkmark next to the command in the menu.
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When looped playback is enabled:

m Using Play In to Out loops playback only between your two edit points.

m Using Play in Reverse loops playback from the end of your clip to the beginning.

m In all other playback modes, playback always starts over from the beginning of the clip.

To disable looped playback: 

m Choose Loop Playback from the View menu (or press Control-L again) so that the 
checkmark next to the menu item disappears.

Note:  When you loop playback, there is a split-second pause at the end of your sequence 
before the next loop starts. For this reason, enabling looped playback to loop a sequence 
during output to tape from the Canvas might not give you the results you want. For more 
information on outputting to tape, see Chapter 26, “Recording to Videotape,” on 
page 1113.

Marking and Matching Controls

These controls are used to place sequence In and Out points, markers, and keyframes in the 
current sequence. You can also use the Match Frame control to do match frame editing in the 
Canvas and Viewer.

m Match Frame:  When you click this button, a copy of the clip in your sequence’s target 
track is placed at the current position of the playhead in the Viewer. The playhead 
position on the clip in the Viewer will match that of the playhead in the Canvas, so both 
the Canvas and the Viewer display the same frame. Also, the In and Out points of the clip 
in your sequence will be matched to those of the copy in the Viewer. 

This control is useful when you need to quickly reedit a clip that’s already been edited 
into your sequence. For a more comprehensive discussion of using the Match Frame 
controls, see Chapter 14, “Basic Editing.”

m The keyboard equivalent is the F key.

Mark In

Add MarkerAdd Keyframe

Mark OutMatch Frame

Mark Clip
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m Mark Clip:  When you click this button, sequence In and Out points are set according to 
the boundaries of the clip in the target track under the playhead in your sequence. In and 
Out points you set in the Canvas are also set in the Timeline.

m The keyboard equivalent is the X key.

m Add Keyframe:   Click this button to add a keyframe to the current clip in your sequence 
at the position of the playhead. A keyframe is a special-purpose marker that indicates a 
change in value of an applied effect, such as a motion effect or audio level.

m To set a keyframe for an individual motion effect, control-Click this button and choose 
the motion effect from the shortcut menu.

m The keyboard equivalent is Control-K.

m Add Marker:  Click this button to add a marker to your sequence at the current position 
of the playhead. Markers that you add using the Canvas are also added to the Timeline. 
You can use markers as you edit, to bookmark and make notes about important points in 
your sequence, such as areas to change, potential edit points, or sync points. More 
information on using markers in sequences can be found in “Working With Markers in the 
Timeline and Canvas” on page 520.

m The keyboard equivalent is the M key. 

m Press M with the playhead on a marker to open the Edit Marker window. There, you 
can type a name for the marker, or delete the marker. 

m To delete a marker from a sequence, press Control-` (the accent key).

m Mark In and Mark Out:  Click to set the In point or the Out point for your current 
sequence at the current position of the playhead. These points indicate the target edit 
points for clips being edited into the current sequence, and can also be used with various 
commands such as Print to Video and Export to QuickTime. For more information on 
using these points for editing, see Chapter 14, “Basic Editing.”

m The keyboard equivalents are I for Mark In and O for Mark Out. You can move the 
playhead to the In and Out points by pressing Shift-I and Shift-O.

m You can also Control-click in the scrubber bar, then choose Mark In or Mark Out from 
the shortcut menu.

m You can also choose Mark In or Mark Out from the Mark menu.
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To change the In or Out points you’ve set: 

m Drag the In or Out points along the scrubber bar.

m Option-drag any previously marked simple In or Out point along the scrubber bar to 
turn it into a split edit. Option-dragging the top half of an edit point affects the video 
portion, while Option-dragging the bottom half of an edit point affects the audio 
portion. For more on split edit points, see “Setting Up and Performing Split Edits” on 
page 588.

m To change the Out point, enter a new timecode in the Timecode Duration field. Final 
Cut Pro calculates the location of the Out point by adding the duration you entered to 
the timecode value of the In point, and marks it. If no In point is marked, the Out 
point will be marked relative to the beginning of the clip.

m Click the sequence in the Browser, then select either the In, Out, or Duration 
timecode numbers and enter new ones.

To slip both the In and Out points at the same time: 

m Press and hold the Shift key, then click the In or Out point in the scrubber bar and 
drag it left or right.

m Use the Slip Item tool.

To eliminate one or both of your edit points and start over again: 

m Drag an In or Out point vertically off the scrubber bar, either up or down.

m Press Option-I to clear the In point, or Option-O to clear the Out point.

m Control-click in the scrubber bar, then choose Clear In, Clear Out, or Clear In and Out 
from the shortcut menu.

m Option-click the Mark In button to clear In points.

m Option-click the Mark Out button to clear Out points.

m Option-click the Mark Clip button (or press Option-X) to clear both In and Out points 
at the same time.
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Zoom and View Pop-up Menus

The two pop-up menus near the top center of the window let you quickly select the 
magnification level and a viewing format. They control the way sequences in the Canvas are 
displayed, much as the equivalent controls in the Viewer control the display of clips. For a 
more detailed discussion of these controls, see “Zoom and View Pop-up Menus” on page 340.

m Zoom:  Choose a magnification level from this pop-up menu. Your choice affects only the 
display size of the image; it doesn’t affect the frame size of your edited sequence. Besides 
simply choosing a magnification level, you can choose one of the following:

m Fit to Window:  Increases or decreases the size of your sequence’s image to match any 
change in the size of the Canvas window.

m Fit All:  Zooms the image to fit the current size of the Canvas window. For example, if 
you’ve zoomed the Canvas image to 800%, but the Canvas window is only 320 x 240 
pixels, you’ll only see a fraction of your image. When you choose Fit All, the size of 
your Canvas image is zoomed to match the size of the Canvas window. The next time 
you resize the Canvas, though, your image will stay at the new size.

m Show as Sq. Pixels:  Displays non-square pixel images as square pixel so they look right 
on your computer screen. Standard definition (SD) video equipment displays video 
using non-square pixels, whereas computer monitors display video with square pixels. 
Because of the difference in the shape of the pixels, the same video image looks 
different on each kind of monitor. Final Cut Pro can simulate how your images will 
look on video using the computer’s display, so that your video images look correct as 
you edit. This does not permanently affect your picture; it’s only for display purposes.

View pop-up menu

Zoom pop-up menu

Warning  Clips do not play back smoothly if you zoom in on them so far that part of the 
image is obscured, and you see scroll bars to the right and below the Canvas window. 
Other windows blocking the Canvas will also affect playback.
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m View:  You can choose various options for how you view your sequence in the 
Canvas, including:

m Image, Image+Wireframe, or Wireframe mode:  Image is the default, and simply 
shows the video of your sequence as it plays back. Image+Wireframe is useful when 
you’re using motion effects or compositing. Each video layer in the Canvas has a 
bounding box with handles (or a “wireframe”), which can be used to adjust that clip’s 
size, rotation, and position. Wireframe mode shows only the bounding box and 
handles of each clip in your sequence, without the corresponding image. For more 
information on using motion effects and compositing, see Chapter 21, “Compositing, 
Applying Motion Effects, and Using Keyframes,” on page 907.

m RGB, Alpha, or Alpha+RGB:  When you’re compositing, it can sometimes be handy to 
have a quick look at the alpha channel of your clip. The alpha channel defines areas of 
transparency, and can change if various filters are applied. Viewing your sequence with 
Alpha or Alpha+RGB shows you exactly which areas of your image have transparency. 

m Different backgrounds:  When working with clips that have an alpha channel, you can 
choose different backgrounds to make it easier to see which areas of your picture are 
transparent. For example, translucent clips or generated text may be more visible if 
you choose a background that emphasizes them, such as checkerboard 1 or 2.

m Overlays:  Final Cut Pro provides visual cues, called overlays, that help you easily 
recognize certain parts of your edit in the Canvas, such as the markers and In and Out 
points of clips in your sequence.

m Title and action safe overlays:  These show you the boundaries within which you 
need to keep your graphics and text so they’ll appear when the sequence is played 
back on television. For more information, see “Viewing Title and Action Safe 
Boundaries” on page 371.

None of these view options affect either rendered output or material sent to tape. They 
only affect display in Final Cut Pro.
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Timecode Fields

Two fields display timecode in the Canvas: Timecode Duration and Current Timecode. 
Clicking the icon to the left of each field highlights the entire field so you can enter new 
numbers.

m Timecode Duration:  This field displays the entire duration of your sequence, or the 
duration between the In and Out points marked on the currently open sequence. 
Changing this number manually changes the duration starting from the current sequence 
In point.

Control-clicking this field displays a shortcut menu that lets you select how to display the 
timecode, using non-drop frame timecode, drop frame timecode, or frames. Choosing 
another option will not affect the timecode associated with this sequence.

m Current Timecode:  This field shows the current position of the playhead. If you enter a 
new timecode, the playhead moves to that position. You can enter either absolute or 
relative timecode numbers when using this field for navigation. 

Control-clicking this field displays a shortcut menu that lets you select the following options:

Timecode Duration

Current Timecode
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m Display using non-drop frame timecode, drop frame timecode, or frames. The menu 
item in bold face indicates the type of timecode currently specified in that sequence’s 
settings. Changing the timecode display in the Canvas will not alter that sequence’s 
settings. Drop frame will only be available for clips with a frame rate of 29.97 fps. PAL 
clips will not have drop frame timecode display as an option.

m Move the playhead to a marker in the sequence. All the markers in the currently 
selected sequence are displayed.

For more information on how timecode works, see “How Timecode Works” on page 355.

Marker 3 
selected
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Editing Controls in the Canvas
Unlike the navigating and marking controls described in the previous section, editing controls 
exist only in the Canvas. Once you’ve marked a clip in the Viewer with In and Out points 
defining how much of that clip you want to use, you can perform edits in one of four ways:

Using the Canvas editing controls

m Drag a clip or clips from either the Browser or Viewer to the viewing area of the Canvas 
window and use one of the Edit Overlay sections.

m With a clip open in the Viewer, click one of the edit buttons at the bottom of the Canvas.

Using other editing methods

m With a clip open in the Viewer, press one of the keyboard shortcuts for performing an edit.

m Drag a clip or clips directly into the Timeline from either the Browser or the Viewer.

Types of Edits in Final Cut Pro

There are seven basic types of edits you can perform as you piece together your edited 
sequence. All of these edits are used to put a clip from the Browser or the Viewer into your 
currently selected sequence, as represented by the Timeline. The location of the playhead, 
sequence In and Out points, and the incoming clip’s own In and Out points all affect the 
outcome of these edits.

While all of these edits can be used in many different ways and they’re covered in much 
more detail in the next chapter, here’s a quick summary:
m Overwrite 

Edits your incoming clip into the current sequence, using either the playhead’s current 
position or sequence In and Out points that you’ve set. If there are already clips in the 
tracks that are selected for editing into, they’re written over for the duration of your 
incoming clip. 

m Overwrite with transition

The same as an overwrite edit, except that the default transition is used at the In point of 
the edit, to transition between the previous clip and your incoming clip.
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m Insert

Edits your incoming clip into the current sequence, using either the playhead’s current 
position or sequence In and Out points that you’ve set. If any clips are in or linked to 
those in unlocked tracks that are selected for editing into they’re cut at that point and 
pushed forward in your edited sequence by your incoming clip.

m Insert with transition

The same as an insert edit, except that the standard transition is used at the In point of 
the edit, to transition between the previous clip and your incoming clip.

m Replace

The replace edit is special. Unlike the other edits, which use the In and Out points you set 
in the Viewer and in your sequence to define your edit, it replaces a clip or section of clips 
in your sequence with another that you’ve opened in the Viewer. When the new clip is 
edited into your sequence, the frame at the position of the playhead in the Viewer ends 
up at the position of the playhead in the Timeline. The In and Out points of the new clip 
in your sequence are set to match either the In and Out points of the clip that was already 
there, or sequence In and Out points that you have set. Replace is an extremely powerful 
editing method, but you need to understand it completely to use it to its full advantage.

m Fit to fill

Changes the speed of your incoming clip, either stretching it or compressing it to fill a 
space determined by sequence In and Out points, or by a previously edited clip whose In 
point is at the current location of the playhead.

m Superimpose

Automatically edits the video and audio of your clip into tracks above and below the 
currently selected video and audio target tracks, using either specified In and Out points 
in the Timeline, or the duration of a clip in the target track at the location of the playhead. 
Used to stack clips on top of each other in preparation for superimposing.
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Edit Overlay

The Edit Overlay appears only when you drag clips from the Browser or Viewer to the image 
area of the Canvas. The Overlay appears translucently over the image currently in the Canvas. 

There are seven sections in the Edit Overlay, one for each of the seven types of edits that 
Final Cut Pro can perform. If you simply drag your clip to the viewing area to the left of the 
Edit Overlay, you’ll do an overwrite edit. To perform any of the other edits, drag your clip to 
the overlay area for the edit you wish to perform.

You’ll know that the clip you’re dragging is over a specific overlay when a colored outline 
appears around the border of the overlay.

Drag a clip to
the image area
of the Canvas.

The Edit Overlay 
appears with its 
seven sections.

Edit buttons

Target track indicators
440 Chapter  13   



Edit Buttons in the Canvas

Instead of dragging clips to the Canvas, you can click one of three edit buttons to edit the 
clip in the Viewer into your sequence. ( You can also drag clips to the edit buttons to do the 
same edits.)

The first two buttons from the left perform insert and overwrite edits, respectively.

The third button opens a pop-up menu from which you can choose one of five other edits. 
Clicking the button once does the currently selected edit. Pressing and holding the button 
lets you choose another edit from the pop-up menu.

Press the selector button to display 
the additional edit buttons.

Overwrite

Overwrite with Transition

Insert with Transition

SuperimposeReplace

Insert

Fit to Fill
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About the Timeline
The Timeline, like the Canvas, contains tabs for all open sequences. Each tab in the Timeline 
is organized into separate audio and video tracks, which contain a graphical representation of 
all of the clips you’ve edited into the sequence in the order you arranged them. Using the 
Timeline, you can quickly navigate through an entire edited sequence, adding, overwriting, 
and removing clips.

The playhead in the Timeline is locked to the playhead in the Canvas. You use the same 
navigation, marking, and editing controls in the Timeline that you use in the Canvas, and 
both windows mirror each another. The Canvas displays the frame currently at the position 
of the playhead in the Timeline, and the Timeline’s playhead indicates the location in your 
sequence of the frame currently displayed in the Canvas.

Overview of the Timeline

In addition to showing a sequence’s tracks and the clips edited into them. The Timeline 
contains numerous controls for displaying and manipulating clips. All these controls are 
specific to the sequence in which they’re used; each sequence open in the Timeline can have 
its own set of controls.

Current Timecode field

Name of the currently selected 
sequence and the project it’s in.

Clip
Overlays

Zoom 
slider

Zoom 
control

Render Quality
pop-up menu

Track 
Height

Clip Keyframes

Sequence tabs Playhead

Base tracks Vertical scroll bars 
with thumb tabs 
in between
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Track Display and Organization

m Tabs:  Each tab represents a sequence. You can have multiple sequences open 
simultaneously, each with its own tab. Controls in Final Cut Pro only affect the sequence 
whose tab is in front. Clicking another sequence’s tab brings it to the front, along with 
that sequence’s tab in the Canvas.

m Tracks:  The main portion of the Timeline is divided into audio and video tracks, with a 
divider between the two regions. You can drag the divider up or down to allocate more 
room to either the video or audio half of the Timeline. Audio tracks 1 and 2 are just 
underneath the divider, and all additional audio tracks continue downward. Video track 1 
is just above the divider, and all additional video tracks appear upward. This way, linked 
video and audio clips keep the same relationship to one another even if they’re moved 
from one track to another.

By default, new sequences are created with two audio tracks and one video track. You can 
change this in the Timeline Options tab of the Preferences window. (For more 
information about setting preferences, see Chapter 19, “Viewing and Setting Preferences,” 
on page 883.) More tracks can be added at any time. Additional audio tracks can be used 
for adding music or sound effects, or for organizational purposes. Additional video tracks 
can be used for superimposing clips and compositing complex visuals.

Divider
Video tracks

Audio tracks
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m Unused area:  This is the area either above or below the outermost video and audio 
tracks in your sequence. Ordinarily, this area is blank, but if you edit clips directly into this 
gray area, new tracks are created to accommodate them. 

m Clips:  Individual clips are represented by bars in the various tracks, with the clip’s name 
at the beginning (and, if the clip is long enough, at the end as well). Video clips in the 
Timeline may be represented by a simple bar, a bar with a thumbnail at the beginning, or 
a series of thumbnails, depending on what you selected in the Timeline Options tab of 
your Sequence Settings window. Audio clips can also be set to appear as a bar or as a 
waveform in the same tab. ( You can turn audio waveforms on or off by pressing 
Command-Option-W.)

m If a clip has synchronized stereo audio and video, that clip’s video will appear in a 
video track, and its stereo audio will appear as two associated audio tracks. Their link 
will be preserved, and (unless the linked selection option is off ) clicking one track will 
select all three.

m If a clip is labeled, its name is highlighted in the color of the label you selected.

m If you applied a speed setting to a clip, that speed setting appears after the clip’s name 
in parentheses. Clips that have clip visibility turned off appear dimmed in the 
Timeline, and clips on locked tracks are cross-hatched.

m Vertical scroll bars and thumb tabs:  If you have more tracks than can be displayed in the 
Timeline window at one time, the scroll bars let you scroll through your video and audio 
tracks separately. The thumb tabs between the audio and video track regions can be used 
to define separate groups of audio or video tracks with their own scroll bars.

For example, this can come in handy when you have considerably more audio tracks than 
video. You can use the thumb tabs between your audio and video scroll bars to allocate 
more space to your audio tracks and less for video. 

m Zoom control:  Lets you zoom in and out on the contents of your sequence in the 
Timeline. Zooming in shows more detail in the ruler, and the duration between the 
numbers in the ruler shrinks. Zooming out shows less detail in the ruler, but allows you to 
see more of the total duration of your sequence in the Timeline. Using the Zoom control 
will keep the area of the Timeline visible when you clicked the control centered as you 
zoom in or out.
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Using the zoom keyboard shortcuts has slightly different results. Pressing Option-+ (plus) 
or Option-– (minus) zooms in or out of the contents of the Timeline no matter which 
window in Final Cut Pro is currently selected. If one or more clips are selected, they will be 
the center of the zoom. Otherwise, zooming centers on the current position of the playhead.

m Clip Keyframes:  Click this control to add additional space underneath each audio and 
video track in the Timeline. If a filter is added to an audio or video clip in the Timeline, a 
small green bar appears in this space for the duration of that clip. If a motion setting is 
modified for a video clip in the Timeline, a small blue bar appears in this space for the 
duration of that clip.

If keyframes are added to the filter or motion settings for a clip, those keyframes appear 
on top of the bar to which they apply. Filter and motion bars can be displayed or hidden 
in the Timeline Options tab of the Sequence Settings window. 

m Clip Overlays:  Click this control to display opacity overlays (thin black lines) over your 
video tracks, and audio level overlays (thin red lines) over any clips in the audio tracks of 
your Timeline. 

These lines indicate how transparent or how loud each video and audio clip in your 
edited sequence will be when you play it back. Any keyframes added to these properties 
will appear as handles, directly on top of the overlay. Overlays and their related keyframe 
handles also serve as controls themselves, and can be manipulated directly. 

Keyframe overlays can be displayed or hidden at any time using the Clip Overlays control.

Green bar (on top) indicates filters 
have been applied. Blue bar indicates 
motion has been applied.
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m Filter and motion bars:  When you click the Clip Keyframes controls (see above), you’ll 
see a region underneath each track in your sequence, containing colored bars indicating 
motion effects and their keyframes (blue bars) or filters with their keyframes (green bars). 
Double-click either a blue or green bar or keyframe to open either the Filters or Motion 
tab in the Viewer.

m Track Height control:  Click this control to switch between four track display sizes—
Reduced, Small, Medium, and Large. The current setting is highlighted in blue and has a 
small dot in the center. You can also change this setting in the Timeline Options tab of the 
Sequence Settings window.

Note:  When track size is set to Reduced, neither audio waveforms nor thumbnails are 
displayed.

Timeline Navigation

m Ruler:  The ruler along the top of the Timeline represents the total duration of your 
edited sequence, from the first frame to the last. The ruler can be used for reference, to 
see the timecode corresponding to the location of clips in the Timeline. It can also be 
used as a navigation control that works exactly like the scrubber bar in the Canvas.

Sequences can be a maximum of four hours, but you don’t need to set a duration for any 
of your sequences. If you need more time for a particular sequence, editing more clips 
into it will automatically add to the total duration, until the four-hour limit is reached.

m Playhead:  The playhead displays the current frame location in a sequence. The Timeline 
playhead mirrors the Canvas playhead.

The ruler

The playhead
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m Current Timecode field:  Indicates the current position of the playhead. Typing a new 
timecode number moves the playhead (as in the Viewer and the Canvas).

m Zoom slider:  Like the Zoom control, this control also allows you to zoom in and out of a 
sequence in the Timeline. Dragging the thumb tabs on either side of the slider zooms in 
or out of your sequence, moving the visible area of the Timeline in the direction in which 
you’re dragging. Pressing the Shift key and dragging one of the thumb tabs zooms both 
thumb tabs and leaves the visible area of the Timeline centered. The light gray indicators 
inside the scroll bar indicate one-minute increments in your sequence, and will widen or 
narrow depending on how far into your sequence you’re zoomed.

Once you’ve zoomed into your sequence, you can scroll along the entire duration of the 
sequence by dragging the center of the slider. 

Timeline Editing Controls

m Target Track controls:  You use these controls to designate the target tracks when editing 
clips into your sequence. When you edit clips into your sequence, they’ll be placed in the 
target tracks you specify here. 

Track Visibility control

Render Quality pop-up menu

Target Track controls

Lock Track control

Clip Keyframes control Track Height control

Clip Overlays control
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The current target track is highlighted in yellow. Only one video track and up to two 
audio tracks can be selected as target tracks at one time. Clicking the Target Track control 
for any other combination of tracks selects those as the target tracks for all edits made 
from that point onward.

m Lock Track control:  This control prevents a track’s contents from being moved or 
changed in any way. Locked tracks can also be protected from being changed by editing 
or trimming operations by deselecting the “Edit Items on Locked Tracks” option in the 
Preferences window. Locked tracks are cross-hatched all the way across the Timeline. 
Tracks can be locked and unlocked at any time.

m Track Visibility control:  Determines whether the contents of a track will be displayed and 
rendered in your sequence. When a track is invisible, it appears darkened in the Timeline, 
but its contents remain in your sequence and are still editable. When you play back your 
sequence, invisible tracks don’t appear in the Canvas or on an external monitor, nor will 
they be rendered or output to tape with that sequence. You can make a track visible or 
invisible at any time.

Yellow indicates a
video target track.

Yellow here indicates
an audio target track.

Unlocked

Locked
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Render cache files for a track are deleted if it is made invisible. You can have Final Cut Pro 
display a warning before this occurs by checking the Warn if Visibility Change option in 
the General tab of the Preferences window. For more information, see “Setting General 
Preferences” on page 885.

m Render status bar:  Two bars at the top of the Timeline indicate which parts of the 
sequence have been rendered at the current render quality. The top line is for video, the 
bottom for audio. For more information, see “About the Render Status Bars” on 
page 1066.

m Render Quality pop-up menu:  You can use this pop-up menu to quickly choose one of 
four render quality settings, which determine the video resolution and other render 
options used when rendering transitions and effects in your sequence. You can, for 
instance, pick a lower resolution to perform editing or compositing tasks quickly, then 
switch to a higher resolution to render your material as it will ultimately look when output 
to tape. You can modify these render qualities by choosing Edit Render Quality from the 
Render Quality pop-up menu. (See “Working With Render Quality Settings” on 
page 1070.)

Linking control

Snapping control

Link indicator

An audio clip

Locked tracks are
cross-hatched.

Video clips

Render status bar

Timeline ruler

Stereo pair 
indicators
  Working With Sequences, the Timeline, and the Canvas 449



m Snapping control:  Click this to turn snapping on and off. When snapping is on, the 
playhead “snaps to” key areas in the Timeline, such as the In and Out points of clips, 
markers, sequence In and Out points, and other special markers. This can be extremely 
useful when you need to quickly line up two clips without gaps in between, or to quickly 
move the playhead to a marker in preparation for an edit.

The keyboard equivalent for this control is the N key.

m Linking control:  Click this to turn the linked selection option on and off. With linked 
selection on, clicking either the audio or the video track of a clip selects all items linked to 
that clip, both audio and video. If linked selection is off, clicking the audio or video track 
of a clip selects only that track. This is useful for editing the audio In or Out point of a clip 
separately from the video, such as when doing a split edit.

m Link indicators:  Video and audio clips that are linked together have underlined names. As 
long as linked selection is on, when one linked item is selected, moved, or trimmed, all other 
items linked to it are affected identically. Links can be created or broken at any time, 
although audio and video clips that were captured in sync continue to reference one 
another even when their link is broken; they display out-of-sync indicators, described below.

Snapping control

Linking control
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m Stereo pair indicators:  Two pairs of triangles indicate that two audio clips are linked as a 
stereo pair. If you select an audio track that was captured or changed to a stereo pair, 
selecting one track always selects both audio tracks in the pair. This is useful if you’re 
importing clips with music, sound effects, or other stereo material that you don’t want to 
edit separately. One or more stereo pairs can be changed to simple linked clips by selecting 
them and choosing Stereo Pair from the Modify menu to remove the checkmark.

m Out-of-sync indicators:  Video clips that were captured with synchronized audio are 
linked to their associated audio files. Even if you unlink them, if you move one out of sync 
with the other, out-of-sync indictors will appear at the beginning of the audio clips and at 
the beginning of the video clip, indicating the number of frames they’re out of sync 
relative to one another. If the selected track is ahead of its associated video or audio, a + 
(plus) appears in the indicator. If behind, a – (minus) appears.

Control-click the out-of-sync indicator to see a shortcut menu with two options:

m Move into Sync:  Choosing this option moves the selected track forward or backward 
in the Timeline so that its In point syncs with that of the associated track. For this to 
work, there must be enough of a gap in the selected track of your sequence to 
accommodate the change. This command does not overwrite other clips.

m Slip into Sync:  This option is only available if there’s enough unused footage in the 
affected clip to keep its position in the Timeline while changing the actual In and Out 
points of the clip so that it syncs up with its associated clip. 

Out-of-sync indicators

Stereo pair indicator
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m Labels:  If any clips in your edited sequence in the Timeline have been labeled, their 
names will be highlighted in the color that matches that label.

m Speed indicator:  If the speed of a clip has been changed, either by using a fit to fill edit 
or using the Speed item in the Modify menu, its change of speed will be shown in 
parentheses after the name of the clip in the Timeline.

Color Coding in the Timeline

If you use labels to identify and sort your clips in the Browser, the clips’ names will be 
highlighted in the color that matches each label. The default labels and label colors are:

m Good Take:  Orange

m Best Take:  Red

m Alternate Shots:  Blue

m Interviews:  Purple

m B-Roll:  Green

Selecting the Timeline

Before working with the Timeline, make sure it’s the currently selected window. Otherwise 
your keyboard shortcuts might not perform the actions you intend.

To select the Timeline:

m Click in the Timeline window.

m Press Command-3.

Change of speed 
shown as percentage
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Selecting and Closing Tabs in the Timeline

The controls and commands in the Timeline affect only the sequence whose tab is in front.

To select a tab in the Timeline:

m Click the tab.

To close a tab in the Timeline:

Do one of the following:

m With the tab selected in the Timeline, choose Close Tab from the File menu.

m Control-click the tab, then choose Close Tab from the shortcut menu.

m Press Control-W.

When you close the tab of a sequence in the Timeline, its corresponding tab in the Canvas 
closes, and vice versa.

Customizing the Timeline Display
Several options modify the way a sequence is displayed. To change these settings for any new 
sequences, use the Timeline Options tab in the Preferences window. To change these 
settings for a sequence you’ve already created, open that sequence’s Sequence Settings 
window and click the Timeline Options tab. 

m Video tracks can be displayed by name (only), name and thumbnail frame, or filmstrip. All 
video tracks in the sequence share the same display settings. If you display the Timeline 
in reduced track size view, you can’t see thumbnails.

m Audio tracks can be displayed in the Timeline as waveforms or bars, and audio tracks can 
be labeled as pairs (A1a & A1b, A2a & A2b, etc.) or as sequential tracks (A1, A2, A3, etc.). 

m You can change the size of the tracks and show or hide keyframe details. These options 
affect all tracks in the current sequence.
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Changing the Default Timeline Display Options for New 
Sequences

Unlike the General options or the Video Processing options, which are defined for new 
sequences by the selected sequence preset, the default Timeline display settings for new 
sequences are defined in the Timeline Options tab of the Preferences window.

Timeline Options Tab in the Preferences Window

If you want all new sequences to use a group of Timeline display options, you can set all 
these options in this window.

The Timeline Options tab has the following settings:

m Starting Timecode:  This is the timecode number that appears at the beginning of the 
sequence. Typically, this will be 01:00:00:00, but if you want your program to begin at a 
particular hour, you can enter the timecode here.

m Drop Frame:  Selecting this checkbox makes your timecode drop frame. This option is 
not available for PAL sequences.

m Default Number of Tracks:  To set how many audio and video tracks new sequences have, 
enter the desired numbers in these fields.
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m Track Size:  This determines how tall your tracks will appear in the Timeline. The shorter 
your track heights, the more tracks you’ll be able to see in the Timeline at once. The 
options are Reduced, Small, Medium, and Large. You can change this setting at any time 
using the Track Height control at the bottom of the Timeline window or by pressing 
Shift-T.

Note:  If the track size is set to Reduced, thumbnails and audio waveforms are not 
displayed, even if you select them in this tab.

m Thumbnail display:  This setting affects how individual clips are displayed within the 
Timeline.

m Name:  Displays each clip in the Timeline with only a name and a solid bar 
representing the clip’s duration.

m Name Plus Thumbnail:  Displays the clip’s name and duration, as well as a one-frame 
thumbnail at the beginning of the clip. This thumbnail is not the poster frame that was 
selected for the clip in the Canvas or Browser, but the frame at the designated In point. 
If the In point changes, so does the thumbnail. This is the default setting.

Name of clip

Thumbnail and name
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m Filmstrip:  Displays each clip as a series of consecutive thumbnails that show the 
action in that clip. The time scale of the Timeline determines how many thumbnails 
are displayed for each clip.

Note:  If the track size is set to Reduced, thumbnails are not displayed.

m Audio Track Labels:  There are two ways to display labels for audio tracks:

m Sequential:  Sequential labels number each audio track consecutively (A1, A2, A3, and 
so on). Each audio track is identified individually, which is useful if you want to have a 
one-to-one correspondence between your video and audio tracks.

m Paired:  Paired labels identify audio tracks in pairs (A1a, A1b, A2a, A2b, A3a, A3b, and 
so on). This is useful if you have a lot of stereo material, and you want an easy way to 
see the relationship between each stereo pair of tracks.

Consecutive thumbnails

Audio track 
sequential

Audio tracks 
paired
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m Show Filter and Motion Bars:  With this checkbox selected, additional space is added 
underneath each audio and video track in the Timeline. If a filter is added to an audio or 
video clip, a small green bar appears in this space for the duration of the clip. If a motion 
setting is modified for a video clip in the Timeline, a small blue bar appears in this space 
for the duration of the clip.

If keyframes are added to the filter or motion settings for a clip, those keyframes appear 
on top of the bar to which they apply. 

Once you’ve created a sequence, its filter and motion bars can be hidden or displayed at 
any time by pressing Option-T, or by clicking the Clip Keyframes control at the bottom of 
the Timeline window.

No filter or motion 
bars displayed

A green bar indicates a 
filter has been applied.

A blue bar indicates motion 
has been applied.
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m Show Keyframe Overlays:  With this checkbox selected, opacity overlays are displayed 
over video tracks (as thin black lines), and audio level overlays will be displayed over 
audio tracks (as thin red lines). 

These lines indicate how transparent or how loud each video and audio clip in your 
edited sequence will be when you play it back. Any keyframes added to these properties 
appear as handles directly on top of the overlay. Overlays and their related keyframe 
handles also serve as controls themselves, and can be manipulated directly. 

Once you’ve created a sequence, you can display or hide its keyframe overlays at any time 
by pressing Option-W, or by clicking the Clip Overlays control at the bottom of the 
Timeline window.

m Show Audio Waveforms:  Selecting this checkbox displays your audio clips in the Timeline 
as waveforms, rather than plain bars. Waveforms are useful when you’re editing if you 
want to see a visual representation of the loud and soft parts of your audio.

Once you’ve created a sequence, you can turn waveform display on or off at any time by 
pressing Command-Option-W.

Note:  If the track size is set to Reduced, audio waveforms will not be displayed.
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Changing the Timeline Options of Existing Sequences

Each sequence in your project can have its own Timeline settings. When you open a new 
sequence in the Timeline, or switch from one sequence to another, the Timeline’s display 
changes to reflect the current sequence’s settings.

If you want to change the Timeline options of a sequence that’s already been created, you 
can do so in the Timeline Options tab of the Sequence Settings window for that sequence.

To view and change Timeline display settings for a sequence:

1 Select a sequence in the Browser or in the Timeline.

2 Do one of the following:

m Choose Settings from the Sequence menu.

m Control-click the sequence’s icon in the Browser, then choose Sequence Settings from the 
shortcut menu.

m Press Command-0 (zero).

3 In the Sequence Settings window, click the Timeline Options tab, change the settings, then 
click OK. 

For more on these settings, see “Timeline Options Settings in the Sequence Settings 
Window” on page 409.
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Zooming and Scrolling in the Timeline
Final Cut Pro provides many ways to either zoom in on the contents of the Timeline to focus 
on individual frames of a clip in your sequence, or to zoom out to get an overview of your 
entire edited program.

The Zoom slider, the Zoom control, and the corresponding keyboard shortcuts allow you to 
set any zoom you want. Once you’ve zoomed into your sequence far enough that you can’t 
see either the beginning or ending clips of the sequence, you can also use the Zoom slider as 
a scroll bar, to smoothly scroll forward or backward to a desired section of your sequence.

Scroll arrows

Playhead indicator 
(purple line)

Thumb tabsClick in space around 
slider to scroll one 
length of the Timeline 
window.
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To zoom in and out of the Timeline using the Zoom slider:

m Drag the thumb tabs on either side of the Zoom slider to zoom in or out of your sequence 
from the selected end of the Zoom slider, while keeping the other end locked in place. 
This also moves the visible area of the Timeline in the direction you’re dragging.

Move the Zoom slider to view different 
parts of your sequence.

Drag the end of the Zoom 
slider to adjust how much of 
your sequence you can see. 
Dragging to the left increases 
the scale so you see less of 
your sequence.

Zoom control
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m Hold down the Shift key while you drag one of the thumb tabs to adjust both ends of your 
view at the same time, leaving the visible area of the Timeline centered.

m Click or drag in the Zoom control to view the Timeline at a different time scale while 
keeping the current area of the Timeline centered. Clicking to the right of the control 
zooms out to show more of your sequence, while clicking to the left zooms in to show 
more detail.

To zoom in and out of the Timeline using the keyboard:

1 With either the Canvas or the Timeline selected, move the playhead to the position in the 
Timeline where you want zooming to be centered, or select one or more clips in the 
Timeline that you want to center on as you zoom in or out.

2 Do one of the following:

m Choose Zoom In from the View menu or press Option-+ (plus) to zoom in on your 
sequence.

Pressing Option-+ repeatedly shows more and more detail, down to the individual 
frames of your sequence. 

m Choose Zoom Out from the View menu or press Option-– (minus) to zoom out.

This reduces the amount of detail but shows more of your edited sequence until the 
entire sequence fits into the Timeline. You can zoom out further to reduce the scale of 
your sequence in the Timeline and show more empty area to the right of it.

Drag to change the Timeline 
to a different time scale.
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When you zoom in and out of the Timeline using the keyboard shortcuts, the visible area of 
the Timeline stays centered either on any currently selected clips, or (if no clips are selected) 
on the current position of the playhead.

To zoom in and out of the Timeline using the zoom tools:

1 Select the Zoom In or Zoom Out tool in the Tool palette.

2 Do one of the following:

m Click in the Timeline. 

m Drag to select a region to zoom in or out on. 

As you drag, the box (or “marquee”) snaps to areas that correspond to the percentages of 
zoom in the Timeline.

Before zooming in

Playhead remains in 
the same position.

After zooming in
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Clicking or dragging repeatedly increases the zoom factor. When the Timeline is zoomed in 
or out to the maximum level possible, the + and – signs on the zoom tools disappear.

Note:  When the Zoom In or the Zoom Out tool is selected, pressing the Option key 
temporarily changes it to the opposite tool.

Scrolling Horizontally Through a Zoomed-in Timeline

If you zoom far enough into your sequence in the Timeline, there will be more clips than can 
be displayed in the Timeline area. To see another portion of your sequence, you can drag the 
playhead in the Canvas to move to a new location in the Timeline. If you want to see another 
portion of your sequence in the Timeline without moving the playhead, use the Zoom slider.

The area of the horizontal scroll bar encompasses the total duration of your sequence in the 
Timeline. Gray lines indicate one-minute increments, while a purple line indicates the 
current position of the playhead.

To scroll horizontally through your edited sequence:

m Drag the center of the Zoom slider to the left or right. The displayed area of the Timeline 
moves smoothly in the direction you drag.

m Click the scroll arrows at either end of the scroll bar to move the displayed area in the 
Timeline to the left or right.

Drag the Zoom In tool 
to expand the 
sequence.

This shows the above 
sequence zoomed 
in, so you can see 
more details within 
the sequence.
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m Click the scroll bar to the left or right of the Zoom slider to move the displayed area of the 
Timeline by one length of the Zoom slider’s current scale.

m Press Shift-Page Up or Shift-Page Down to scroll left or right one length of the Timeline.

Scrolling Vertically Through Multiple Tracks

Since you can have up to 99 video and 99 audio tracks in a project, Final Cut Pro lets you 
organize your Timeline into separate, resizable regions for audio and video tracks, making it 
easier to work with multiple tracks.

The tracks in the Timeline are divided by default into two regions, one for audio and one for 
video tracks. A divider between the two regions can be dragged up or down to resize the 
regions, giving more space to either the video or audio tracks in your Timeline.

At the right side of the Timeline, there are scroll bars for each region of tracks. Since you 
might have more audio tracks than video tracks in a documentary piece with sophisticated 
sound design, or you might have more video tracks than audio tracks in a music video with a 
lot of layering and motion graphics work, Final Cut Pro lets you scroll through the tracks in 
each region separately.

To scroll vertically through the audio and video tracks in your sequence:

m Drag the slider for the region in which you wish to scroll. The displayed area of the 
Timeline moves smoothly up or down in the direction you drag.

m Click the scroll arrows to move the displayed area of the Timeline up or down.

m Click the scroll bar above or below the slider to move up or down by one length of the 
slider’s current scale.

Scroll bars

Center divider
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To resize the audio and video regions:

m Drag the divider between the two regions up or down.

Creating a Static Region in the Timeline

You can create a static region in the middle of the Timeline for tracks that you always want to 
see. This region can contain video tracks, audio tracks, or both. Creating a static region 
results in three total regions in the Timeline: A top, scrollable region for your excess video 
tracks, a middle static region, and a bottom scrollable region for your excess audio tracks. 
You can’t scroll up or down in the static region, but it can be resized to accommodate more 
or fewer tracks.

For example,  if you’re working on the audio of a project with sync sound dialog in audio 
tracks 1 and 2, and multiple tracks of music, sound effects, and audio ambience in the tracks 
below that, you can define a static region containing just tracks 1 and 2, leaving the rest of 
your audio tracks in a lower, scrollable region. This way, your dialog tracks will always be 
visible. You can scroll up and down through your other audio tracks, editing and making 
various adjustments while using the audio tracks in the static region as a reference point.

To create a static region for audio and video tracks:

1 Drag the upper thumb tab in the vertical scroll bar up to create a static area for as many video 
tracks as you want to keep in the middle.

Drag here
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2 Drag the lower thumb tab in the vertical scroll bar down to create a static area for as many 
audio tracks as you want to keep in the middle.

When you have a static region in your Timeline, there are two dividers: one between the top 
scrollable region and the static region, and one between the static region and the bottom 
scrollable region. Each divider has its own thumb tabs.

To resize a static region in the Timeline:

m Drag the dividers or thumb tabs to include or exclude tracks from the static region. As the 
static region gets smaller or larger, the size of the other regions is adjusted accordingly.

To move the static region up or down in the Timeline:

m Drag the center tab in the static region’s scroll bar to move the entire region, 
automatically resizing the scrollable regions above and below the static region.

Static area

Drag the upper 
thumb tab to 
include video 
tracks in the 
static area.

Slider

Drag the lower thumb
tab to include audio

tracks in the static area.

Drag center tab
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To eliminate the static region:

Do one of the following:

m To eliminate video tracks from the static region, drag the upper thumb tab of the static 
region down so that it overlaps the lower one, then release the mouse button.

m To eliminate audio tracks from the static region, drag the lower thumb tab of the static 
region up so that it overlaps the upper one, then release the mouse button.

Navigating With the Playhead in the Timeline
The playhead in the Timeline is locked to the playhead in the Canvas, and both windows 
mirror each other. The Canvas displays the frame currently at the position of the playhead in 
the Timeline, whether it’s playing or stopped.

While working in Final Cut Pro, you’ll constantly move the playhead to view frames in your 
sequence, using its location to set edit points, define markers, and edit additional clips into 
your sequence. So it’s important to know how to navigate using the playhead. 

There are several ways you can do this:

m Move the playhead by clicking or dragging in the ruler of the Timeline window.

m Enter a new absolute or relative timecode value in the Current Timecode field.

m Use the same shortcuts you’d use in the Canvas to navigate through and play your edited 
sequence.

Drag lower thumb tab
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Positioning the Playhead Using the Ruler

Moving the playhead in the Timeline ruler works in the same way as moving the playhead in 
the scrubber bar in the Canvas or Viewer.

To scrub a sequence in the Timeline:

m Drag the playhead in the Timeline ruler.

To jump to a specific location in the Timeline:

m Click the desired location on the Timeline ruler. ( You can do this while your sequence is 
stopped or playing).

Using Timecode to Navigate in the Timeline

The Current Timecode field shows the current position of the playhead. If you enter a new 
timecode, the playhead moves to that position. You can enter either absolute or relative 
timecode numbers in this field. 

To move the playhead to a specific location:

1 Make the Canvas or Timeline active. 

If you’re in the Timeline, make sure that all clips are deselected; otherwise, you will move the 
selected clip to a new location. (Pressing Command-D deselects all clips.)

2 Do one of the following:

m Enter a new timecode, then press Return to move to the frame that corresponds to the 
timecode you entered.

m Enter + or – and a relative timecode, then press Return to move forward or backward 
that number of frames from the current position of the playhead.

You do not have to select the Current Timecode field to enter a new timecode number; if the 
Timeline window is active the playhead will move to the new timecode location in both the 
Timeline and Canvas, and the Current Timecode field of the Canvas will mirror that of the 
Timeline.

Playhead
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Navigating With Canvas Controls and Keyboard Shortcuts 

All of the keyboard shortcuts for navigating in the Canvas also work in the Timeline.

To move the playhead to the next edit point:

m In the Canvas, click the Previous Edit or Next Edit button. 

Final Cut Pro looks for the next or previous edit, In point, or Out point.

m Press the Up Arrow (previous) or Down Arrow (next) on the keyboard. 

m Choose Previous or Next from the Mark menu, then choose Edit from the submenu. 

m Press Option-E (for the previous edit) or Shift-E (for the next edit).

If overlays are enabled in the View menu, an L-shaped icon appears in the Canvas, indicating 
whether you are on an In or Out point. 

To move the playhead to the next Timeline marker:

m Control-click in the Current Timecode field in either the Timeline or the Canvas, then 
choose a marker from the shortcut menu.

m Press Shift-Up Arrow to move to the next marker to the right of the playhead.

m Press Shift-Down Arrow to move to the next marker to the left of the playhead.

The playhead moves to that marker. If overlays are enabled in the View menu, your marker is 
displayed in the Canvas. For more information on setting markers in the Timeline, see 
“Working With Markers in the Timeline and Canvas” on page 520.

To shuttle through your sequence:

m In the Canvas, drag the shuttle slider to the right to fast-forward and to the left to rewind. 
Playback speed varies depending on the distance of the slider from the center of the 
shuttle control. 

The shuttle can play your clip at five speeds in each direction: 1/4x, 1/2x, 1x, 2x, and 4x. 
The shuttle control snaps to the closest available speed. When the shuttle control is at 1x 
speed, or 100 percent, it turns green.

The shuttle control is useful for quickly playing through your sequence at different 
speeds. It also shifts the pitch of audio as it plays at varying speeds. 
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m Use one of these keyboard commands to shuttle through your sequence:

m To begin forward playback at normal (1x) speed, press the L key.

m To pause playback, press the K key.

m To begin reverse playback at normal (1x) speed, press the J key.

m Press either the L or J key again to double the current playback speed. You can play 
back up to eight times normal speed, toggling from 1x to 2x to 4x to 8x normal speed 
(pressing either key a total of 4 times). 

m Press the key for playback in the opposite direction to halve the playback speed. Press 
the key again to slow playback in the original direction until it reaches 1x then plays 
back in the opposite direction starting from 1x.

m To immediately reverse direction of a clip, press K to pause, and then press the key for 
the direction of playback you want.

m Hold down the K key while holding down L or J to play back in the desired direction at 
1/3x speed.

To jog through your sequence:

m Use the jog control in the Canvas to move the playhead as if you were moving it with your 
hand, with a one-to-one correspondence between the motion of your mouse and the 
playhead’s motion. This control is useful for carefully locating a specific frame (for 
example, if you’re trimming an edit). 

m Press the Left or Right Arrow keys to move the playhead backward or forward a frame at a 
time. Hold down the Shift key at the same time to move the playhead one second at a 
time.
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How Clips Appear in the Timeline
Before you learn how to modify tracks in the Timeline, it’s a good idea to look at how clips 
are represented when they’re first edited into a sequence. When you edit a clip with one 
video and two audio tracks into the Timeline, a copy of that clip is placed in your sequence. 
The copy looks like this:

Although you edited in one clip, the resulting clip in the Timeline is a group of three items 
spanning three tracks. The video track of your clip is placed in track V1 of the Timeline, and 
the two audio tracks of your clip are placed in tracks A1 and A2, respectively. Each of these 
items is named after the master clip in the Browser from which they came. All three items are 
linked together, which is indicated by the line under the clip name. 

Video track

Audio tracks

Underline link indicator
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All clips that you edit into your sequence are represented in this way. Since the audio and 
video items of each edited clip are linked, selecting a clip’s video item also selects that clip’s 
audio items, and changes you make to one are automatically made to the other. For example, 
if you move a clip’s video item from track V1 to track V2, that track’s audio items move from 
tracks A1 and A2 to tracks A3 and A4.

Video on V1

Audio on A1 and A2

When you move video 
to a new track, audio 
moves as well because 
it’s linked.

Video is now on V2.

Linked audio is on 
A3 and A4.
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Links between the audio and video of a clip can be created, broken, or overridden at any 
time, although audio and video clips that were captured in sync continue to reference each 
other even when the link is broken; they’ll display out-of-sync indicators if they’re moved out 
of sync with each other.

By representing clips in this way, Final Cut Pro makes it easy to edit the video and audio of a 
clip separately, with different In and Out points. However, depending on whether linking is 
turned on for any given set of tracks, modifying a single track may not modify the entire clip 
that the track is associated with.

Working With Tracks in the Timeline
While editing in the Timeline, sometimes you’ll want to modify an entire track at once, along 
with any items in that track. There are a number of ways you can modify tracks in your 
sequence, which may also affect the playback of items on that track. You can

m add or delete tracks

m lock tracks so they can’t be changed

m hide tracks to keep any media on the tracks from displaying, playing back, or being output

m select the entire contents of a track or tracks

These processes involve entire tracks, not individual clips within each track. To learn more 
about editing procedures with individual clips, see “Modifying Clips Already in the Timeline” 
on page 501.

Out-of-sync indicator
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Adding Tracks

You can add tracks to any sequence at any time. You can add tracks one at a time, or you can 
add multiple video and audio tracks at once.

To quickly add a track to a sequence:

m Drag a clip to the unused area above the top video track or below the bottom audio track. 
Final Cut Pro adds new tracks to accommodate any audio or video this new clip contains.

m Control-click anywhere in the track header, then choose Add Track from the shortcut menu.

Dragging a clip to 
unused area above 
top video track.

Using shortcut menu 
to add a track.
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To add multiple tracks to a sequence:

1 Choose Insert Tracks from the Sequence menu. 

2 In the Insert Tracks dialog box, choose your options, then click OK.

m Track type:  Click the appropriate checkbox to add audio and/or video tracks. 

m Number of tracks:  Enter the desired number of tracks for either video or audio. You can 
have a total of 99 tracks for video and 99 tracks for audio.

m Specify a location: 

m Before Base Track:  This inserts the desired number of tracks before the first track in 
the Timeline. Existing tracks and their clips will be moved up. For example, if a video 
track is added before the base track of a sequence with two existing video tracks, V1 
and V2, these tracks along with their clips will be moved to V2 and V3, and the new 
video is placed on V1.

m After Last Target Track:  This inserts the desired number of tracks after the last target 
track for audio or after the current target track for video in the Timeline. If your 
sequence has three video tracks with clips in them, and your target track (specified by 
a yellow Target Track indicator) is video track V2, then inserting a track creates a new 
track at V2, and the previous tracks V2 and V3 will be moved to V3 and V4. 

m After Last Track:  This inserts the desired number of tracks after the last track in the 
Timeline. If your last track is V2, and you add 3 video tracks, new tracks V3, V4, and V5 
are created.

Specify where you want 
to add the tracks.

Click the box next to
the types of tracks you

want to add.

Enter the number of 
tracks to add.
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If you add a single video track before a track that has a series of items on it, those video items 
will move up one track, but any audio items linked to them will not. This will result in an 
offset between the track number of that clip’s video and the track numbers of that clip’s 
audio, but the clip’s audio and video will still be linked and in sync.

Deleting Tracks

You can delete tracks from any sequence at any time. You can delete tracks one at a time, or 
you can delete multiple video and audio tracks at once. If you delete tracks with video that’s 
linked to audio, the video is deleted along with the video track, but the associated audio is 
left alone, and vice versa.

Note:  If you delete the wrong track, you can use the Undo command to restore it.

To quickly delete a single track in a sequence:

m Control-click anywhere in the track header, then choose Delete Track from the shortcut 
menu.

To delete multiple tracks from a sequence:

You can delete either the current target track or several empty tracks from a sequence in the 
Timeline.

1 To delete a specific track, make that track the target track. 

For more information on selecting target tracks, see “Specifying Target Tracks for Editing” on 
page 482.
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2 Choose Delete Tracks from the Sequence menu. 

3 Choose your options for deleting tracks, then click OK.

m Track type:  Click the appropriate checkbox to delete audio and/or video tracks.

m Tracks to delete:  Specify the type of tracks you want to delete.

m Current Target Track:  Click this to delete the current target track (specified by a 
yellow Target Track indicator) in the Timeline. 

m All Empty Tracks:  Click this to delete all tracks in your sequence in the Timeline that 
don’t have any clips edited into them.

m All Empty Tracks at End of Sequence:  Click this to delete all empty video tracks above 
and all empty audio tracks below the outermost tracks with edited clips in them in the 
Timeline.

After tracks are deleted, all remaining tracks in the sequence are renumbered.

Options appear only
after you select the

type of track you
want to delete.
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Locking Tracks

Any track in the Timeline can be locked using the Lock Track control. Items on a locked track 
cannot be modified. Additionally, no new clips can be added to a locked track unless the 
“Edit Items on Unlocked Track” option is selected in the Preferences window. This lets you 
protect the track from any accidental changes. Clips on locked tracks still play back in the 
sequence, and will still be rendered and output to tape. All new tracks in a sequence are 
unlocked by default.

To lock a track:

m Click the Lock Track control for the track you want to lock.

m If it’s a video track:  You can also press F4 and the number of the track you want to 
lock for tracks one through nine.

m If it’s an audio track:  You can also press F5 and the number of the track you want to 
lock for tracks one through nine.

The locked track is cross-hatched to indicate that it’s locked.

To lock all video tracks in a sequence:

m Press Shift-F4.

To lock all audio tracks in a sequence:

m Press Shift-F5.

To lock all other audio or video tracks except for the selected track:

m Press Option while clicking the Lock Track control for the desired track.

The control
changes to the

locked position.
Click the control
again to unlock

the track.
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When Working With Clips on Locked Tracks

If you lock tracks with video that’s linked to audio, the video items will be locked and 
prevented from being deleted, moved, or modified in any other way. Their linked audio 
items, however, can still be moved, which will result in a sync offset even though they’re 
linked. If this happens, an out-of-sync indicator will appear, which you can use to resync 
the two. 

Likewise, although items in locked tracks can’t be modified, they can still be selected, and 
along with them any linked items in other tracks. If you select an item on a locked track 
and press the Delete key, that item will not be deleted, but any linked items on other tracks 
will be.

Making Tracks Invisible

You can hide a track by making it invisible. The contents of an invisible track do not appear in 
the sequence when you play it, nor will they render or be output to tape. You can still edit 
items on invisible tracks, they just won’t appear in your sequence during playback. A track 
can be made visible or invisible at any time. This does not permanently affect either your 
sequence or the clips edited into it.

You can also single out a track by making all of the other tracks in the sequence invisible. 
(This is similar to the “Solo” function in some audio editing applications.) You can single out 
a single video and a single audio track separately. 
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How to Avoid Accidentally Deleting Render Files

Making a track invisible deletes any render files associated with that track. You can 
preserve these render files for later use by choosing a different render quality level 
from the Render Quality pop-up menu before you make a track invisible. ( You can 
switch between the four different render qualities by pressing the Y key.)

This second render quality’s settings should match those of the render quality you 
normally use. All of the render files created at a specific render quality are saved when 
you switch render qualities. When you’re done hiding and showing different tracks, 
simply make all of your tracks visible again, then reselect your original render quality, 
and your render files will be restored to your sequence. For more information about 
modifying the render quality settings for your project, see “Working With Render 
Quality Settings” on page 1070.

Note:  If you make any edits to your clips that delete a render file, switching back to 
your original render quality level won’t preserve the render file.
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To hide a track:

m Click the Track Visibility control of the track you want to hide.

If your sequence has clips that have been rendered, a dialog box appears saying that the 
render files at the current render quality will be deleted. If you don’t need the render files 
at the current render quality level, click Continue. To avoid this, see “How to Avoid 
Accidentally Deleting Render Files” on page 481.

To make one track visible and all the others invisible:

m Press Option while clicking the track’s Track Visibility control. 

All other video tracks or all other audio tracks except for the one you clicked will be 
made invisible. 

Specifying Target Tracks for Editing

Many operations in Final Cut Pro require you to select a target track to determine where 
duplicated, moved, or new clips will appear in your sequence.

When you first edit a clip into a sequence, its audio and video tracks are edited into the 
target tracks you specify. Target tracks can also be used to edit only the video or audio 
portion of a clip into your sequence. For example, if you don’t specify a video target, than 
you’ll edit in just the audio of your clip, or vice versa. If you copy and paste clips, they will 
appear in the target tracks you’ve selected.

Target tracks also affect numerous commands in the Timeline. Whenever you use Mark Clip, 
Match Frame, or Add Keyframe, for example, the clip at the playhead’s position in the target 
track is the clip that’s used.

Click the Track Visibility
control to hide a track.

The hidden track is dimmed 
and will not appear when 
played in the Canvas.

Important  If a track is locked, then targeting for that track will be ignored.
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You specify target tracks using the Timeline’s Target Track controls, located at the left side of 
the Timeline in the track headers.

While editing, make sure the correct target tracks are specified. If you don’t, your edits will 
end up on the wrong track. If you want to use only certain tracks on a source clip for the 
edit, you need to specify those tracks as the target tracks.

If you drag your clip to a specific track in the Timeline, it is placed on that track, even if the 
track is not the target track. However, any currently selected target tracks will modify this in 
two ways:

m If the video target track is deselected and you drag your clip to an audio track, no video 
will be edited into your sequence, and vice versa.

m If you select nonadjacent audio and video target tracks, your incoming media will be 
edited in using the track separation defined by your targets, even though you might not 
be editing your media into the same tracks.

To select a video target track in the Timeline:

m Click a video Target Track control. Clicking the same control again will deselect it so that 
no video target track is selected at all.

m Press F6 and the number of the video track you want to select as the target track (this 
works for tracks one through nine).

The indicator turns yellow on the specified video target tracks. If no target track is 
selected, they will all be gray.

You can specify a 
maximum of three target 
tracks at a time—one for 
video and two for audio.

A dual speaker icon
designates audio

target tracks.

A film icon designates
video target tracks.

Indicator turns yellow on 
specified video target track.
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To select audio target tracks in the Timeline:

m Click the left or right speaker on the audio Target Track control, one to set that track as a 
channel 1 target and the other to set that track as the channel 2 target for stereo audio. 
Clicking the same target track control twice will deselect it, so that no audio target track is 
selected for that channel.

m Press F7 and the number of the audio track you want to select as the target track for audio 
channel 1 (this works for tracks one through nine).

m Press F8 and the number of the audio track you want to select as the target track for audio 
channel 2 (this works for tracks one through nine).

The indicator turns yellow on the specified audio target tracks, and a number 1 or 2 
indicates which channel they are. If no audio target tracks are selected, they will all be gray.

Working With Items in the Timeline
This section describes how you can work with the audio and video items that make up clips 
in the Timeline. This includes selecting, moving, and performing basic edits on these items, 
as well as using snapping and linking. Many of these procedures use tools found in the Tool 
palette, and can be used together with various keyboard shortcuts to achieve more complex 
editing tasks. For more information on the Tool palette, see “About the Tool Palette” on 
page 655.

Click one side of the control 
to turn off the channel.
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How Clips Are Edited Into a Sequence

When you first create a sequence, it is blank, and contains the default number of audio and 
video tracks. An empty sequence becomes an edited sequence when you add, or edit, clips 
with audio, video, or graphics into it. When a clip from the Browser or Viewer is edited into a 
sequence, Final Cut Pro makes a copy of the master clip in the Browser and places it into the 
sequence at the position you specify. Changes made to this resulting sequence clip, such as 
motion effects, filters, and so on, affect only that copy of the clip. The original master clip in 
the Browser or Viewer remains untouched. For more information on working with clips in 
the Browser, see “Using the Browser and Managing Projects and Clips” on page 161.

While the actual step-by-step editing process is covered in more detail in the next chapter, it’s 
important to know, for now, how clips are placed in the Timeline and how you can further 
manipulate them. This chapter shows you the various ways the Timeline lets you manipulate 
clips that have been added to your sequence. 

You can edit clips into your sequence in one of five ways:

m Drag a clip or clips from the Browser or Viewer to the image area of the Canvas and use 
one of the sections of the Edit Overlay (see “Edit Overlay” on page 440).

m With a clip open in the Viewer, click one of the edit buttons at the bottom of the Canvas 
to perform that edit (see “Edit Buttons in the Canvas” on page 441).

m With a clip open in the Viewer, press one of the editing keyboard shortcuts. 

m Drag one or more clips from the Browser or the Viewer directly into the open sequence 
in the Timeline.

m Copy and paste one or more clips from one sequence’s tab in the Timeline to another.

For more information on how to perform each of these edits, see Chapter 14, “Basic Editing,” 
on page 533.
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Working With Linked Items

As explained in “How Clips Appear in the Timeline” on page 472, when clips with linked 
audio and video are edited into your sequence, they’re represented in the Timeline by a 
video track and two audio tracks. Final Cut Pro automatically links video and audio that 
originate from the same media file. Selecting one item automatically selects the other items 
linked to it. For example, clicking a clip’s audio track in track A1 also selects its accompanying 
audio and video tracks in tracks A2 and V1. 

This linking behavior remains true as long as the linked selection option in the Timeline is 
turned on.

With linked selection turned on, Final Cut Pro treats all linked items as a single entity for 
most operations. When it is turned off, linked items are treated as if they were not linked, 
and clicking a clip’s video or audio item selects only that item. 

Video track V1 and 
audio tracks A1 and A2 
are linked tracks.

Indicates linking 
is turned off.

With linking turned off, clicking a 
clip’s video will only select that item. 
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You can turn linked selection on or off at any time. It’s important to remember that even with 
linked selection off, moving two items out of sync still results in an out-of-sync indicator, 
which you can use to bring them back into sync at any time. (See “Audio/Video 
Synchronization in Final Cut Pro” on page 716 for more information.)

To turn linked selection on or off:

m Choose Linked Selection from the Sequence menu. (A checkmark indicates the option 
is on.)

m Press Shift-L.

m Click the Linking control in the upper-right corner of the Timeline.

To temporarily turn linked selection on or off:

m Hold down the Option key. 

Linked selection is disabled (if it’s on) or enabled (if it’s off ) for as long as you hold down 
the Option key. This is an extremely important keyboard modifier, and one you’ll 
probably find yourself using frequently.

For example, if linked selection is turned on, but you press the Option key while you click 
the video item of a linked clip, only the video item will be selected. This is a quick way to 
select only one item of a linked clip for editing, trimming, or deleting.

On

Off
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Linking and Unlinking Video and Audio Items

You can link or relink audio and video clips regardless of their origin. You can link one video 
and two audio items. This is useful if you want to associate some audio items in the Timeline 
with a particular video clip, keeping them in sync with one another. 

To link unrelated items in the Timeline:

1 Arrange your audio and video items in their respective tracks so that the audio and picture 
sync together the way you want.

2 Select up to one video and two audio items on different tracks in the Timeline.

Video and audio tracks are lined 
up but not linked together.

Select video and 
audio tracks.
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3 Choose Link from the Modify menu.

The names of the items you linked are underlined to show that they’re linked, even though 
they still have the names of the master clips in the Browser from which they originated.

You can also break the link between audio and video items in the Timeline.

To break the links between items:

1 Select one or more items in the Timeline.

2 Do one of the following:

m Choose Link from the Modify menu.

m Press Command-L.
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About Stereo Pairs

Audio clips can also be associated with one another, as a stereo pair. You can set up a stereo 
pair during capture or turn stereo pairing on or off later for two audio items in the Timeline.

Stereo audio clips can be captured either as channels 1 and 2, or as a stereo pair. If clips are 
captured as channels 1 and 2, their audio items in the Timeline are treated like any other 
linked items. Clicking one item selects both items with linked selection on, and with linked 
selection turned off, you can select only one at a time. When you open an audio clip in the 
Viewer, each channel has its own tab, levels and filters applied to one channel will not be 
applied to the other, and pan is centered for both channels. 

Audio items that are associated as a stereo pair are treated much more like a single item in 
the Timeline than even linked items are. Stereo pair items are always the same length. If you 
select the audio portion of a clip in the Timeline that is designated as a stereo pair, you can 
only select both audio tracks together. Selecting one item of the pair always selects both, 
even if linked selection is turned off.

A stereo pair of tracks appears in the Viewer as a single tab, called Audio. The waveforms of 
both audio channels are displayed in this one tab, and any levels or effects applied to one 
channel are automatically applied to the other channel. Stereo pairs are very useful if you’re 
importing clips with music, sound effects, or other stereo material that you don’t want to edit 
separately.
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You can create or disable stereo pairs whenever you want. You can enable or disable multiple 
stereo pairs at once, or one pair at a time. 

Note:  If you want to break the link of a clip that has stereo pair audio, you must first disable 
stereo pairing.

To enable or disable one or more pairs of audio items as a stereo pair:

1 Select one or more pairs of audio clips or a linked set of audio and video items in the Timeline.

2 Choose stereo pair from the Modify menu. When a pair of items is a stereo pair, a checkmark 
appears next to the menu item.

An enabled stereo pair has a stereo pair indicator (shown below).

Selecting Items in the Timeline

You can select clips, transitions, and edit points in the Timeline in order to perform different 
editing functions. 

The following items can be selected in the Timeline:

m Items:   Any audio, video, or graphics item that’s part of a clip. This includes multiple 
items or a range of items. 

m Transitions:  Transitions such as dissolves or wipes that have been added between two 
items on the Timeline. You can select these in order to trim or delete them.

m Edits:  Edit points (either the In or Out points of individual items, or the border where 
two items meet) can be selected for further editing. 

m Gaps:  The spaces between two clips on the same track can be selected in order to close 
them or fill them with media.

m Overlay keyframes:  The keyframes on top of a clip overlay, when displayed, can be 
moved to change their value. These affect the opacity of video items and volume levels for 
audio items. 

Note:  You can also add more keyframes directly in the Timeline by holding down the 
Option key and clicking an overlay when the pointer changes to a pen.

Stereo pair indicator
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The following items cannot be selected in the Timeline:

m Filter and motion bars and their keyframes:  You can double-click a bar directly in the 
Timeline to view filter or motion details in the Viewer. Even though you can’t select the 
keyframes, you can move them by dragging them.

m Tracks:  Tracks themselves can’t be selected, although the contents of tracks can be 
selected using the track selection tools.

Tools Used for Selecting Items in the Timeline

Several tools in the Tool palette can be used to select items in the Timeline. You can use each 
one to work with a different set of items in the Timeline. 

Note:  Remember that if you select an item that’s linked to another item, the other item will 
be selected as well, unless you disable the linked selection option.

To select a tool:

1 Move the pointer over a tool in the Tool palette, then press and hold the mouse button.

All of the related tools appear. 

2 Move the pointer to the tool you want to select, then release the mouse button. 

The selected tool becomes the current tool in the Tool palette for that group of tools.

These tools, in order of appearance:

m Selection:  Selects individual items, such as a clip, transition, edit point, or keyframe, or 
multiple items if they’re linked. The functions of this tool can be modified in a variety of 
ways using keyboard shortcuts. This is the default tool.

Click to select the desired tool.

The selected tool
becomes the default

shown in the
Tool palette.

Selection

Group Selection

Range SelectionEdit Selection
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m Edit Selection:  Selects an edit point between clips. You can select edits on as many tracks 
as you want, but you can only select one edit per track. When you release the mouse 
button, the Trim Edit window will open so you can precisely modify all of these edit 
points simultaneously. (For more information on using the Trim Edit window, see 
Chapter 16, “Advanced Editing and Trimming Techniques,” on page 653.)

m Group Selection:  Selects multiple contiguous items. This tool automatically selects an 
entire item in the Timeline even if you only drag over a part of it. Any other items linked 
to it will be selected as well. Use this tool to select several clips in their entirety.

m Range Selection:  Selects a range across multiple contiguous items. This tool will not 
automatically select an entire item, but only the part of the item that you drag across. 
Use this tool to select only a part of a clip, or to create a selection that includes parts of 
several clips.

m Select Track Forward:  Selects all the items in a track after the selection point you click. 
Selected items are ready for any group operation, such as moving or deleting. Items 
linked to selected items in this track will be selected also.

m Select Track Backward:  Selects all the contents of the track before the selection point.

m Select Track:  Selects the entire contents of a single track, as well as any items linked to 
those items.

m Select All Tracks Forward:  Selects all the contents of all tracks after the selection point.

m Select All Tracks Backward:  Selects all the contents of all tracks before the selection 
point.

Select All Tracks Backward

Select All Tracks 
Forward

Select Track
Backward

Select Track 

Select Track Forward
  Working With Sequences, the Timeline, and the Canvas 493



Using the Selection Tools

These tools can be used in a number of ways to select various combinations of items in your 
sequence in the Timeline.

To select an entire clip:

1 Do one of the following:

m Choose the Selection tool in the Tool palette.

m Press A.

2 In the Timeline, click anywhere in a clip.

In the Canvas, a cyan border appears around the video image to indicate that clip has been 
selected, if the playhead is over that clip. 

To select a portion of a clip or a range of clips on a track:

1 Do one of the following:

m Choose the Range Selection tool in the Tool palette.

m Press the G key three times, so the Range Selection tool is displayed in the Tool palette.

Cyan border indicates 
clip has been selected.
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2 Drag a bounding box (or “marquee”) around the area of the clip or clips you want to select. 

To select multiple whole clips:

1 Do one of the following:

m Choose the Group Selection tool in the Tool palette.

m Press the G key two times, so the Group Selection tool is displayed in the Tool palette.

2 Drag a marquee around all of the desired clips. Any clip you touch will be included, even if 
you don’t drag across the entire clip.

Modifying the Selection Tools

The Shift and Command keys modify the behavior of the current selection tool so you can 
select different combinations of clips.

To select multiple non-contiguous clips:

m Hold down the Command key while selecting the desired clips using either the Selection 
tool or the Group Selection tool. 

You can also Command-click a specific item again to deselect it.

Marquee surrounds one 
entire clip and part of a 
second clip.

Marquee surrounds two 
whole clips.
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To select multiple contiguous clips with the Selection tool:

m Select a clip, then hold down the Shift key and select another clip farther down on the 
Timeline. All of the clips in between the two are selected. 

m If you select two clips on the same track, only the items on that track (and items linked 
to items on that track) will be selected. 

m If you select a clip on one track and another clip on a different track, all clips between 
those two tracks will be selected as well.

Using Canvas or Timeline In and Out Points to Select Clips

You can use the In and Out points you set in the Canvas or Timeline to select clips. Since the 
In and Out points in the Canvas and Timeline are locked to each other, setting the points in 
one location sets them in the other.

To select all items between the In and Out points:

1 Set your desired In and Out points in either the Canvas or the Timeline.

2 In the Timeline, specify the target tracks for the clips you want to select by clicking the 
appropriate Target Track controls. 

For more information on selecting target tracks, see “Specifying Target Tracks for Editing” on 
page 482.

3 Do one of the following:

m Choose Select In to Out from the Mark menu.

m Press Option-A.
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Only parts of clips in the target tracks between the In and Out points will be selected.

You can also do the reverse, and use a selected range of clips to define the In and Out points 
in the Timeline and Canvas.

To set In and Out points around a selected part of a sequence:

1 Choose any tool and select a range of clips.

2 Do one of the following:

m Choose Mark Selection from the Mark menu.

m Press Shift-A.

Selecting All Clips on a Track

The track selection tools provide many additional ways of selecting some or all of one or 
more tracks in your sequence. When selecting the contents of a track, remember that linked 
items on other tracks will also be selected if linked selection is enabled. (See “Linking and 
Unlinking Video and Audio Items” on page 488.) 

After selecting a track’s contents, you can perform different operations on all items at once, 
such as moving, copying, or deleting them. This is useful for closing gaps or creating space to 
accommodate new clips in your sequence.
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To select all the items on a single track:

1 Do one of the following:

m Choose the Select Track tool in the Tool palette.

m Press the T key three times, so the Select Track tool is selected in the Tool palette.

2 Click anywhere in the track. All clips on the track are selected, as well as any items linked to 
those clips.

To select all items on a single track before or after a selected clip:

1 Do one of the following:

m Choose the Select Track Forward or Select Track Backward tool in the Tool palette.

m Press the T key to select the Select Track Forward tool, or press the T key twice so the 
Select Track Backward tool is selected in the Tool palette.

2 Click the first clip in the track that you want to include in the selection. 

All clips in that track from the point you click onward (either forward or back) are selected, 
as well as any items linked to the clips. You can select entire clips only; you can’t select a 
portion of a clip.

All clips in V1
are selected.

If you click here, all clips 
to the right are selected.

If you click here, all clips 
to the left are selected.
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To select all items on all tracks forward or backward from a selected clip:

1 Choose the Select All Tracks Forward or Select All Tracks Backward tool in the Tool palette.

2 Click the first clip on any track that you want to include in the selection. 

All clips in all tracks from the point you click onward (either forward or back) are selected, as 
well as any items linked to those clips. You can select entire clips only; you can’t select a 
portion of a clip.

Once you’ve selected a large group of clips with any of the tools, you can always deselect 
individual clips. If a clip is deselected, any operation you perform on the other clips won’t 
affect it.

If you click here, all clips 
on all tracks to the right are 
selected.

If you click here, all clips 
on all tracks to the left 
are selected.
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To deselect an individual item in the Timeline:

1 Do one of the following:

m Select the Selection tool in the Tool palette.

m Press A.

2 Command-click the item you want to deselect.

Selecting or Deselecting All Clips in a Sequence

To select every clip in the Timeline:

m Choose Select All from the Edit menu.

m Press Command-A.

To deselect every clip in the Timeline:

m Choose Deselect All from the Edit menu.

m Press Command-D.

Snapping in the Timeline

When snapping is turned on, items you move in the Timeline, including the playhead and 
selected clips, appear to jump, or “snap,” directly to certain points in the Timeline. Snapping 
makes it easier and quicker to do things like line up two clips, or align the playhead to a 
particular marker.

Several items trigger snapping in the Timeline:

m Clip boundaries

m The playhead

m Markers

m Keyframes

m In and Out points

When you drag the playhead or a selected clip in the Timeline, it “snaps” to these items when 
it encounters them. A small arrow appears above or below the edit, marker, or keyframe to 
indicate that the playhead has snapped to this item. 

While snapping is extremely useful, it can also be a hindrance if you’re trying to move a clip 
only a few frames among a series of markers and clip boundaries, and you don’t want it to 
snap to a new point. You can turn snapping on or off at any time, even as you’re dragging a 
clip.
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To turn snapping on and off:

m Press N (you can do this even while you’re dragging).

m Choose Snapping from the View menu. (A checkmark indicates snapping is on.)

m Click the Snapping checkbox in the General tab of the Preferences window.

m Click the Snapping control in the Timeline.

Snapping affects many of Final Cut Pro’s other functions, and not just those in the Timeline. 
Snapping affects tools and the scrubber in both the Viewer and in the Canvas. It also affects 
compositing tasks when using motion controls.

Modifying Clips Already in the Timeline

Once you’ve edited clips into your sequence, you can still continue to edit them. You can edit 
clips right in the Timeline, by dragging the boundaries of their constituent items, or you can 
reopen them in the Viewer from the Timeline, this time as a sequence clip rather than a 
master clip.

Using the Command Key to “Gear Down”

When you’re dragging clips, edit points, or keyframes, usually the default one-to-one 
correspondence between the motion of your mouse and the motion of the item 
you’re dragging works just fine. However, you can drag even more precisely by 
pressing the Command key to slow, or “gear down,” the dragging speed after you’ve 
started dragging.

For example, holding the Command key down after you’ve started dragging a clip 
causes the motion of that clip on the Timeline to be much slower and more precise. 
This can be helpful if the Timeline is zoomed out so that individual clips look small. 
It’s also useful if you want to make very small changes to an edit point, a keyframe 
parameter, a volume level, or anything else.

The Command key works with nearly any dragging operation in Final Cut Pro.
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Dragging Clip Boundaries in the Timeline

Clips are represented in the Timeline as bars with essentially three regions. The total length 
of the bar represents the clip’s duration. The beginning and end of the bar represent the 
clip’s In and Out points. You can drag each of these regions to modify the clip, right in the 
Timeline. As you move your pointer over a clip, the pointer changes from an arrow (around 
the center of the clip) to a Resize pointer (at either the beginning or the end of the clip).

Dragging the beginning or end of a clip in the Timeline changes the duration of that clip in 
the sequence, either from the beginning or from the end.

Resize pointer at 
beginning of clip

Arrow

Resize pointer at end of clip

Box shows the changed 
length of the clip and the 
new duration of the clip.

Dragging the beginning or 
end of a clip changes the 
clip duration.
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Dragging the center of the clip moves the entire clip to another location in your sequence, 
leaving the In and Out points alone. Dragging a clip onto another clip performs a replace 
edit, but if you hold the Option key down after you start dragging and keep it held down as 
you let go of the mouse button, you will perform an insert edit. 

For more information about editing clips graphically in the Timeline, see “Editing Directly in 
the Timeline” on page 584.

Opening Sequence Clips in the Viewer

You can do more detailed editing by opening a clip from your sequence in the Timeline 
directly in the Viewer. Any changes you make to that clip using the Viewer controls will 
modify the clip only as it appears in your edited sequence. How these changes occur will also 
depend on the editing tool that’s selected. 

Box indicates how far 
clip has been moved and 
in what direction.

Dragging the center of a clip 
moves the entire clip.
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To open a clip in the Viewer from the Timeline for further editing: 

m Double-click the clip in the Timeline.

m Select the clip, then choose Clip from the View menu, or press Return.

m Position the playhead at the In point of the clip in the Timeline (using the Up or Down 
Arrow keys) or anywhere within the clip in the Timeline, and press the Return key. The 
clip will open in the Viewer with the Viewer’s playhead at the location of the frame at the 
Timeline playhead.

The items that appear in the Viewer depend on whether or not they’re linked, and whether 
linked selection is turned on. 

m If an item is linked to other items and linked selection is turned on, all items associated 
with the one you’ve opened in the Viewer will also be opened. Video will appear in its 
own tab and audio in its own tab or tabs. 

m If linked selection is off, or items in the Timeline aren’t linked, only the one item will be 
opened into a tab in the Viewer.

When a sequence clip opens in the Viewer, the tab that appears in front depends on what 
you clicked in the Timeline. 

m If you double-clicked a video item, the video tab will be in front in the Viewer.
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m If you double-clicked an audio item, the audio tab will be in front in the Viewer.

m If you double-clicked either the filter bar or the motion bar in the keyframes area of an item 
in the Timeline, the corresponding Filters or Motion tab will be in front in the Viewer.

m If you had a sequence clip already open in the Viewer with the Filters tab in front, another 
sequence clip opened in the Viewer appears with its Filters tab in front as well.

Changes made to a sequence clip apply only to that copy of the clip, and do not affect the 
original clip in the Browser.

Copying Sequence Clips Back Into the Browser

Clips that have been modified in the Timeline can also be copied back into the Browser. This 
won’t affect the master clip that the clip was originally edited from. It will simply create 
another duplicate of the clip, with the In and Out points defined in the Timeline, and add it 
as an additional item in your Browser. This is useful if you’ve modified a clip in a sequence 
and want to use it later in another sequence. 

To copy a clip from the Timeline to the Browser:

m Drag the clip from the Timeline to the Browser.

Moving Items in the Timeline

In Final Cut Pro, once you’ve moved clips from the Browser or Viewer into the Timeline, you 
might want to move clips around within the Timeline. For more information about editing 
clips into your sequence, see “Editing in Final Cut Pro” on page 535.

There are several ways of moving previously edited clips around in the Timeline:

m Drag the clips with the mouse.

m Select the clips and enter timecode values in the Current Timecode field for more precise 
movement.

To move a clip to a new position using the mouse (and do an overwrite edit):

1 In the Timeline, drag the clip to the desired location. (The pointer looks like a down arrow.) 

2 Release the mouse button.

Dragging a clip to a new location. 
Arrow pointing down indicates 
an overwrite edit will be performed.
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To move a clip to a new position using the mouse (and do an insert edit):

1 In the Timeline, drag the clip to the desired location. 

2 Press and hold the Option key (after you’ve started dragging the clip). 

3 Continue to hold the Option key down while dropping the clip at the new location. (The 
pointer looks like a right arrow.) 

4 Release the mouse button.

To move a clip to another track while keeping its timecode location the same:

1 In the Timeline, select the clip you want to move.

2 Press the Shift key while dragging it vertically to the new track.

The clip will be at the same timecode location, but on another track.

To move an item by entering timecode:

1 In the Timeline, select the item or items you want to move.

2 Enter a relative timecode value for where you want the clip to be positioned. 

Don’t click in the Current Timecode field before you do this or you’ll move the playhead 
instead.

Arrow indicates an insert edit 
will be performed.
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As you type, a timecode field appears below the ruler. Enter a positive number to move the 
clip forward; enter a negative number to move the clip backward. Or, type a regular timecode 
value to move the clip to that location in the Timeline.

3 Press Return.

The clip moves to the new location, if there aren’t any other clips in the way. If there are, you’ll 
see a “media limit” warning indicating which track had a clip that interfered with your edit.

The number of frames 
moved

Clip to be moved

Media limit warning
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Duplicating and Copying Clips in the Timeline

It’s easy to duplicate clips in a sequence in the Timeline either by dragging, or by selecting a 
clip and using the Copy and Paste menu commands (or their keyboard equivalents).

Note:  When you duplicate a clip that has had any kind of effect applied to it and has been 
rendered, the duplicate will need to be rendered.

To copy a clip into another location in the Timeline by dragging:

1 In the Timeline, select the clip.

2 Hold down the Option key and drag the clip to the new location in the Timeline. 

You can also make duplicates of sequence clips by dragging them from the Timeline to the 
Browser. These copies include any changes you’ve made to the clips in the sequence. See 
“Copying Sequence Clips Back Into the Browser” on page 505.

Modifying Commands Using the Option Key

The Option key can be used in many ways. When you’re working with clips in the 
Timeline, you can use the Option key to do one of three things:

m Hold the Option key down while you select a clip to temporarily turn off linked 
selection (if it’s on) or turn it on (if it’s off ). For more information, see “Working 
With Linked Items” on page 486.

m Hold the Option key down while dragging an item from its original position to 
make a duplicate of that item (as covered in this section).

m Hold the Option key down after you’ve started dragging a clip and hold it as you 
release the mouse button to perform an insert edit. For more information, see 
“Moving Items in the Timeline” on page 505.

These tasks can be performed in combination. For example, you might want to select 
only the video item of a clip in the Timeline, duplicate it, and insert edit it into another 
clip. To do this, you’d hold down the Option key before selecting the clip (to unlink 
the video from its linked audio track) and continue to hold it as you drag the clip to a 
new location over another clip and release the mouse button (to do the insert edit). 

If that’s what you meant to do, congratulations, you’re a power user! If it’s not, you 
probably held down the Option key too long.
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To copy and paste clips in the Timeline:

1 There are many ways to select clips to copy and paste. Do one of the following:

m Use one of the selection tools to select the clip or clips you want to copy.

m To use the keyboard to select a single clip:  Navigate the playhead to that clip, press Shift-
A (or choose Mark Selection from the Mark menu), then press Option-A (or choose Select 
In to Out from the Mark menu). 

m To select a range of clips with the keyboard:  Use the I and O keys to mark In and Out 
points in the Timeline, then press Option-A (or choose Select In to Out from the Mark 
menu) to select that range.

2 Do one of the following:

m Choose Cut from the Edit menu (or press Command-X) to cut a clip, removing it from its 
current location.

m Press Shift-C to perform a ripple cut, taking the selected clip or range of clips out of your 
sequence and moving all clips in your sequence on unlocked tracks to the left to close the 
resulting gap.

m Choose Copy from the Edit menu (or press Command-C) to copy a clip, leaving the 
original.

m Control-click the clip (or one of the selected clips), then choose Cut or Copy from the 
shortcut menu.

3 Position the playhead where you want to paste your clip.

4 Make sure that the correct target tracks are selected in your sequence.

For more information on selecting target tracks, see “Specifying Target Tracks in the 
Timeline” on page 550. 

Note:  If you copy items that aren’t on the currently selected target tracks, they will be 
pasted into tracks relative to their original distance from the original target track. See “Pasting 
Clips Onto Different Tracks” on page 510.

5 If you want to paste your copied items into other tracks, change the selected target tracks to 
the ones you want to paste into.

For more information, see “Pasting Clips Onto Different Tracks” on page 510.
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6 Do one of the following:

m To paste your items as an overwrite edit: 

m Choose Paste from the Edit menu.

m Control-click in the Timeline, then choose Paste from the shortcut menu.

m Press Command-V.

m To paste your items as an insert edit: 

m Choose Paste Insert from the Edit menu.

m Control-click in the Timeline, then choose Paste from the shortcut menu.

m Press Shift-V.

Pasting Clips Onto Different Tracks

Ordinarily, when you cut or copy items from the target track, then change the target track 
before pasting, your items will be pasted into the new target track.

If you cut or copy items that aren’t on the selected target track, when you paste them they 
will be placed onto tracks relative to their original distance from the original target track. For 
example, if you copy an item on track V4 when the selected target track is V3, pasting that 
item will simply place it back on track V4.

Select the clip and copy it.Select target track V2.

Copied clip is pasted on 
target track V2.
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However, if you change the target track to V1 before you paste the item, it will be pasted into 
track V2, which is the same distance from V1 as track V4 was from V3, the original target track.

Finding and Closing Gaps

As you edit, cut, paste, and move items around in Final Cut Pro, empty spaces may be left 
between clips in your sequence. These are called gaps. Sometimes they are extremely small, 
(one or two frames), which makes them difficult to see in the Timeline. When a sequence 
with gaps plays back in the Canvas, however, even tiny gaps are apparent as black flashes. 

There are two types of gaps:

m Gaps:  These are empty spaces to the left or right of any two clips in any tracks of your 
sequence.

m Track gaps:  These are empty spaces between two clips in the same track.

Track gap
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To find gaps in a sequence:

1 Move the playhead to the beginning of the sequence to start looking from the beginning. 
( You can do this quickly by pressing the Home key.) Otherwise, you can look for gaps to the 
left or to the right of the playhead’s current position.

2 Do one of the following:

m Choose Next from the Mark menu, then choose Gap from the submenu (Shift-G).

m Choose Previous from the Mark menu, then choose Gap from the submenu (Option-G).

The playhead moves to the beginning of the first gap found to the left or right of the 
playhead. 

To find track gaps in a sequence:

1 Decide which track to search and make it the target track.

2 Do one of the following:

m Choose Next from the Mark menu, then choose Track Gap from the submenu.

m Choose Previous from the Mark menu, then choose Track Gap from the submenu.

The playhead moves to the beginning of the first track gap found.

To close a gap:

m Position the playhead anywhere within the gap, then choose Close Gap from the 
Sequence menu.

m Control-click anywhere within a gap, then choose Close Gap from the shortcut menu.

m Select the gap by clicking it, then press Delete. 

All clips to the right of the gap move left to close the gap. 

Because this command shifts all clips to the right of the gap toward the left, the command is 
not available if another clip on another track overlaps this gap. (This would change the 
relationship of the overlapping clip to the rest of your sequence, or change the audio/video 
sync if it’s an audio clip underneath a video clip.)

If you don’t care about the sync relationship between the rest of your sequence and the 
overlapping clip, you can lock tracks containing overlapping clips, then use any of the above 
commands to close the gap.
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To close a track gap without affecting any other tracks in the sequence:

1 Click the Lock Track control of any tracks with clips that overlap the gap you’re trying to 
close.

2 Close the gap by doing one of the following:

m Position the playhead anywhere within the gap, then choose Close Gap from the 
Sequence menu.

m Control-click anywhere within the gap, then choose Close Gap from the shortcut menu.

m Select the gap by clicking it, then press Delete. 

To close a track gap using the Select Track Forward tool:

1 Make sure snapping is turned on.

For more information, see “Snapping in the Timeline” on page 500.

2 Choose the Select Track Forward tool in the Tool palette.

3 Click the first clip to the right of the track gap.

All clips to the right are selected.

4 Drag the clips to the left until they close the gap and snap into place beside the earlier clip. 
This performs an overwrite edit.

To determine the duration of a gap in the Timeline:

1 Make the track with the gap the target track.

2 Position the playhead in the gap.

3 Do one of the following:

m Choose Mark Clip from the Mark menu.

m Click the Mark Clip button in the Canvas.

m Press X.

Playhead positioned 
within a gap
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The gap’s duration appears in the Timecode Duration field in the Canvas.

Making Clips Invisible in the Timeline

If, instead of disabling an entire track, you only want to disable a single clip temporarily, you 
can do so by making it invisible. Making a single clip invisible prevents it from being played 
back, rendered, or output to tape with the rest of the sequence. 

You might disable visibility for a clip that you don’t want to delete, in case you want it again 
later. You could also disable a clip that you’ve taken a lot of time to edit into your sequence, 
so you can see what another clip edited into an adjacent track would look like in its place. 
Finally, you can disable just a clip’s audio or video track, so you can keep them in your 
Timeline for reference, without their actually appearing during playback or output.

To disable visibility for one or more clips:

1 Select the clip or clips using one of the selection tools. You can only disable the clip visibility 
of one or more whole clips.

2 Do one of the following:

m Choose Clip Visibility from the Modify menu so it’s no longer checked.

m Control-click one of the selected clips and choose Clip Visibility from the shortcut menu.

A clip with disabled visibility is dimmed in the Timeline, and its Clip Visibility menu item is 
unchecked. You can enable or disable clip visibility for a clip as many times as you like.

To selectively disable a clip’s audio or video tracks:

1 Do one of the following:

m Turn the linked selection option off, then select one or more audio or video items in the 
Timeline using one of the selection tools.

m If linked selection is on, hold the Option key down to turn it off temporarily, then select 
one or more audio or video items using one of the selection tools.
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2 Do one of the following:

m Choose Clip Visibility from the Modify menu so it’s no longer checked.

m Control-click one of the selected clips and choose Clip Visibility from the shortcut menu.

Individually disabled audio or video items also appear dimmed in the Timeline, although 
their corresponding linked items will not be dimmed.

Deleting Items in the Timeline

There are two ways you can delete items in the Timeline. 

m Select them individually or in groups and delete them.

m Select a range using the In and Out points in the Canvas or Timeline, then delete all the 
material on all unlocked tracks between them.

Normally, when you delete an item or items, a gap is left in your sequence. This is known as a 
lift edit. 

To perform a lift edit, deleting one or more items and leaving a space in your 
sequence:

1 Do one of the following:

m Select an item or items by clicking them.

m Set In and Out points in either the Timeline or the Canvas. Then, make sure the Timeline 
is selected.

2 Do one of the following:

m Choose Lift from the Sequence menu. 

m Press Delete. 
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m Choose Cut from the Edit menu (or press Command-X) to remove the clip from your 
sequence. (The clip can then be pasted in another location.)

You can also delete an item or items and make all items to the right of the deleted item move 
to the left, filling in the gap left by the deleted clip. This is called a ripple delete.

To perform a ripple delete:

1 Select an item or range of items to delete.

2 Do one of the following:

m Choose Ripple Delete from the Sequence Menu.

m Press Shift-Delete.

m Control-click the item or region you want to delete, then choose Ripple Delete from the 
shortcut menu. (This only works when you’ve selected items manually; it won’t work on a 
region defined by In and Out points.)

Selected clip

A gap is left after the clip is 
deleted.

Selected clip
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Copying and Pasting Clip Attributes

Clip attributes include all of the settings applied to a clip—for example, motion settings, 
audio and video filters, speed settings, and others.

When you copy a clip from the Timeline, you also copy all of its settings. Instead of pasting 
duplicates of the clip you copied, you can paste only the clip’s attributes into other clips that 
you’ve selected in your sequence. When you do this, you can select which attributes are 
pasted and which aren’t using the Paste Attributes dialog box.

For example, let’s say you have twenty clips in your sequence. The first clip has three filters, a 
speed setting of 50%, and a rotation applied to it, and you decide that you want all of these 
same settings to be applied to the nineteen other clips. Instead of recreating all these settings 
clip by clip, you can simply copy the first clip, select all nineteen other clips in your 
sequence, and paste only these attributes into all of them at once. 

This is a quick way to add virtually any setting to clips in an edited sequence. You can copy 
motion paths, frame cropping, animated filter effects, or just about anything you want from 
one video clip to another. 

After a ripple delete, only 
two clips remain with no 
gap between them.
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Clip Attributes You Can Paste

The following options are available in the Paste Attributes dialog box:

m Scale Attribute Times:  Shrinks or stretches the keyframes of your copied clip attributes to 
fit the duration of longer or shorter clips you paste them into.

m Video Attributes:  Determines which attributes of the video clip are pasted.

m Content:  Pastes video frames only. The copied content must have enough source 
material to match the length of the clip into which it’s pasted. This can be worked 
around by changing the speed of the clip to lengthen it. 

m Basic Motion:  Applies the parameter values and keyframes for all motion settings in 
the clip you copied. Scale, rotation, center, and anchor point settings and keyframes 
are all pasted at once.

m Crop:  Applies the parameter values and keyframes for all crop settings and keyframes 
in the clip you copied.

m Opacity:  Applies the parameter values and keyframes for all opacity levels and 
keyframes in the clip you copied.

m Drop Shadow:  Applies the parameter values and keyframes for any drop shadow 
settings and keyframes in the clip you copied.

m Filters:  Applies the parameter values and keyframes for all filters in the clip you 
copied.

m Speed:  Applies the speed settings from the clip you copied.

m Clip Settings:  Pastes all the capture settings for the clip you copied (using the settings 
in the Clip Settings tab in the Log and Capture window).

m Audio Attributes:  Determines which attributes of the audio clip are pasted.

m Content:  Pastes the audio only. Copied content must have enough source material to 
match the length of the clip into which it’s pasted. This can be worked around by 
changing the speed of the clip to lengthen it. 

Warning  Pasting attributes between clips that have different frame rates will give you 
erratic results
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m Levels:  Applies the parameter values and keyframes for all audio levels in the clip you 
copied.

m Filters:  Applies the parameter values and keyframes for all audio filters in the clip you 
copied.

Pasting Clip Attributes

If you use the Paste Attributes command without first selecting a clip in the Timeline or 
Canvas, the entire clip you copied will be pasted into the Timeline. 

Pasting clip attributes into other clips follows these rules:

m All settings in the motion tab of the clip you paste attributes into will be replaced. 

m The speed settings of the clip you paste into will also be replaced.

m Filters will be added to any filters already in the clip you paste into.

To paste the attributes of a copied clip into another clip:

1 In the Timeline, select a clip whose attributes you want to paste into another clip.

2 Do one of the following to copy the clip and its settings:

m Choose Copy from the Edit menu.

m Press Command-C.

3 Select a clip or clips to paste the settings into.

4 Do one of the following:

m Choose Paste Attributes from the Edit menu.

m Control-click the clip or clips you’ve selected in the Timeline, then choose Paste 
Attributes from the shortcut menu.

m Press Option-V.
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5 Select the attributes you want to apply to the selected clip in the Paste Attributes dialog box.

6 If the clip you’re pasting the attributes into is longer than the clip you copied them from, 
click the Scale Attribute Times checkbox to stretch all keyframes that you copied along with 
your attributes to fit the longer clip.

For example, let’s say you copied a five-second clip with motion setting keyframes at the 
beginning, middle, and end. If you paste the motion attributes into a ten-second clip, these 
three keyframes will be stretched to fit at the beginning, the middle, and the end of the ten-
second clip.

Working With Markers in the Timeline and Canvas

Markers can be used in the Timeline for a wide variety of purposes. For example, you can use 
markers to

m mark specific points in your sequence with notes for future reference

m snap the playhead or clips to a specific point when performing an edit

m create points to navigate between in your sequence

You can add markers in the Timeline just as you can add markers in the Viewer or in the 
Canvas, but you should remember that there are two types of markers in Final Cut Pro:

m Clip markers:  These appear on individual clips in the Timeline. When you add markers 
to clips in the Viewer, you’re adding clip markers.
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For more information about clip markers, see “Setting and Modifying In and Out Points” 
on page 373.

m Sequence markers:  These markers appear both in the Timeline ruler and in the Canvas 
scrubber bar.

Adding or Deleting Markers From Clips or Sequences

You can add both kinds of markers in the Timeline using the same commands. The kind of 
marker you add depends on whether a clip is selected and on the position of the playhead. 

To add a marker to a sequence in the Timeline:

1 Make sure no items are selected in the Timeline. (To do this, click in an empty area of the 
Timeline, or press Command-D to deselect all clips.)

2 Move the playhead to the location where you want to add a sequence marker.

3 Do one of the following:

m Click the Add Marker button in the Canvas.

m Choose Markers from the Mark menu, then choose Add from the submenu.

m Press M.

Pink clip markers

Green sequence markers
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To add a marker to a clip in the Timeline:

1 Select one or more clips to which you want to add markers.

2 Position the playhead directly over any selected clip.

3 Do one of the following:

m Click the Add Marker button in the Canvas.

m Choose Markers from the Mark menu, then choose Add from the submenu.

m Press M.

Note:  If you move the playhead to a region of the Timeline where there are no selected 
clips, any markers you add will be added to the Timeline ruler and not to the clips (even if 
clips are present).

To position the playhead on a specific sequence marker:

Do the following:

m Drag the playhead in the ruler to the marker’s location. 

If snapping is turned on, the playhead snaps to the position of the marker.

m Control-click the Timeline ruler, then choose a marker from the list of sequence and clip 
markers in the shortcut menu. 

m Control-click in the Current Timecode field in the Canvas or in the Timeline, then choose 
a marker from the shortcut menu.

The playhead in the Timeline and the Canvas moves to that marker’s position. 

Choose a marker

Choose a marker
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To move the playhead to the next or previous sequence marker:

Do one of the following:

m Choose Previous or Next from the Mark menu, then choose Marker from the submenu. 

m Press Option-M to move to the previous marker, or Shift-M to move to the next marker. 

m Press Shift-Up Arrow to move to the next marker to the left of the playhead, or Shift-
Down Arrow to move to the next marker to the right.

To add information, rename, or edit a sequence marker:

1 Move the playhead to the marker you want to annotate.

2 Press M or click the Add Marker button in the Canvas.

3 In the Edit Marker dialog box, enter a new name or any additional comments, then click OK.

Enter desired name.
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To delete a marker:

1 Move the playhead to the marker.

2 Do one of the following:

m Option-click the Marker button.

m Choose Markers from the Mark menu, then choose Delete from the submenu.

m Press Command-` (the accent key).

To delete all markers:

m Choose Markers from the Mark menu, then choose Delete All from the submenu.

m Press Control-` (the accent key).

Moving Items in the Timeline by Their Markers

You can move a clip in the Timeline by dragging one of its markers. When you do this with 
snapping turned on, instead of the clip’s In and Out points snapping to edit points, the 
playhead, and other markers in the Timeline, the marker itself becomes the clip’s snap point. 
While you’re dragging a clip by one of its markers, the In and Out points won’t snap to 
anything.
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Moving Markers Within a Clip

You can move a marker by repositioning it at the playhead location or by entering a different 
start timecode.

To move a marker by repositioning the playhead:

1 Move the playhead to the location where you want the marker to be repositioned.

You can only move a marker forward, not backward.

2 Do one of the following:

m Choose Markers from the Mark menu, then choose Reposition from the submenu.

m Press Shift-`(accent key).

Final Cut Pro moves the marker immediately to the left of the playhead’s current position. Even 
if there are multiple markers, only the one immediately to the left of the playhead is moved.
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To move a marker by entering new timecode:

1 Move the playhead to the marker.

2 Do one of the following:

m Press M.

m Click the Add Marker button.

m Choose Markers from the Mark menu, then choose Edit from the submenu.

3 Enter a new start time in the Start field of the Edit Marker dialog box, then click OK.

Creating Markers With Durations

You can also extend a marker’s duration. You might do this to note a specific duration for 
future reference, such as when creating a transition or a superimposition.

To extend a marker’s duration by entering a timecode:

1 Move the playhead to the marker.

2 Do one of the following:

m Press M.

m Click the Add Marker button.

m Choose Markers from the Mark menu, then choose Edit from the submenu.

3 Enter a duration value.

An extended duration marker appears on the scrubber bar as a marker icon with a bar 
extending along the scrubber bar. 
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To extend a marker’s duration to the playhead’s location:

1 Control-click the Timeline ruler and choose the marker from the shortcut menu.

2 Move the playhead to the desired location.

3 Do one of the following:

m Choose Markers from the Mark menu, then choose Extend from the submenue.

m Press Option-`(accent key)

An extended duration marker appears on the scrubber bar as a marker icon with a bar that 
extends along the scrubber bar.

Move the playhead to where you 
want to extend the marker.

The selected marker is extended to the 
position of the playhead.
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Searching for Items in the Timeline
Once you’ve started adding material to your edited sequence, the Timeline can get long and 
complex. Between all the video and audio clips, graphics elements, sequences, sequence 
markers, and clip markers, there can be a lot of items in your edit to search through at three 
o’clock in the morning. 

Final Cut Pro makes your work easier by giving you a search tool to find different items in the 
Timeline, including clip names, marker text, and clip values. You can search for an item either 
forward or backward in the Timeline, if you know approximately where the item is.

Remember that clips in the Browser and Timeline can have the same name, even though the 
sequence clip is not the same as the master clip in the Browser. If you want to search for a 
specific sequence clip, you first need to open that sequence and make it active.

To search for text or timecode in a sequence:

1 Open the desired sequence in the Timeline.

2 Do one of the following:

m To find an item everywhere it appears in the sequence, press Home to position the 
playhead at the start of the sequence.

m To search a selected portion of a sequence, position the playhead where you want to start 
the search. You can also search just between the sequence In and Out points (see step 6).

3 Do one of the following:

m Choose Find from the Edit menu.

m Press Command-F.

4 Enter the text or timecode number you want to search for.

Choose additional
search options.

Enter the desired text here.
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5 Choose the type of item to search for from the Search pop-up menu. 

m Names/Markers:  Searches for the text in clip names, marker names, and marker 
comments.

m Timecode Options:  Searches for any source or auxiliary timecode in a clip.

6 Choose which tracks to search from the Where pop-up menu.

m All Tracks:  Searches all tracks in the sequence.

m Target Tracks:  Searches only the current target tracks.

m From In to Out:  Searches between the sequence In and Out points on all tracks.

7 To search, do one of the following:

m Click Find to find the item. 

Final Cut Pro finds all items that match the selected criteria from the current position of 
the playhead until the end of the sequence. It does not find clips that begin before the 
position of the playhead, nor does it wrap around to the beginning of the sequence.

m Click Find All to find all clips that match the search criteria. 

All clips that are found will be selected in the Timeline. When a marker is found, the playhead 
is positioned on the marker. 

To cycle through items in the Timeline that match the criteria:

m Follow the steps above, then choose Find Next from the Edit menu or press F3. 

To search for an item backward from the position of the playhead:

m Follow the steps above, then press Shift-F3. 
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Opening and Modifying Item Properties in the Timeline
You can open the Item Properties window for any clip in your edited sequence. Three tabs in 
this window—Format, Timing, and Logging Information—allow you to view or change various 
properties of a clip.

To view and modify item properties:

1 Open a clip in the Viewer or select a clip in the Browser or Timeline.

2 Do one of the following:

m Choose Item Properties from the Edit menu.

m Control-click the item you want to open, then choose Properties from the shortcut menu.

m Press Command-9.

3 Click a tab and if desired, modify the properties.

For details about format, timing, and logging settings, see “Viewing and Changing Clip 
Properties in the Item Properties Window” on page 210.
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Indicators in the Render Bar
The render bar, which is above the ruler in the Timeline, shows you the render status of 
regions of your sequence that contain elements that need to be rendered for playback, such 
as filters or motion settings. Depending on your hardware configuration, you might see 
different colored bars in this area that indicate whether clips in your sequence have been 
rendered, or if they even need to be.

Separate Audio and Video Indicators

The render bar itself has two regions. The upper region shows the status of video items in 
your sequence. The lower region indicates the status of audio items in your sequence. Since 
you may have audio that needs to be rendered associated with sections of video that don’t 
need rendering, audio and video are kept separate.

The render bars appear
here in the Timeline.
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Different Colors Indicate Different States

An empty sequence has only a light gray area in the render bar. All clips that don’t need 
rendering will appear as dark gray bars inside this light area.

If you apply different transitions, filters, or other effects to items in your sequence, colored 
bars indicating those areas appear in the render bar. The color of the bar indicates whether 
or not the item at that part of the sequence needs to be rendered.

Render Bar Indicator Colors and What They Mean

m Dark Gray:  A normal clip that doesn’t need rendering

m Red:  A transition or effect that needs rendering, but has not been rendered

m Steel Gray:  A transition or effect that needs rendering and has been rendered. This item 
in the Timeline will have a corresponding render file on the current scratch disk.

m Green:  A transition or effect that can be played back in real time on your system

m Yellow:  A transition or effect that can be approximated in real time, so you can see what it 
looks like, but that must be rendered before it’s output to tape at full resolution

More information on rendering in general can be found in Chapter 23, “Rendering,” on 
page 1065. For more information about real-time effects, see Chapter 24, “About Real-Time 
Effects,” on page 1091.

In the Next Chapter
In the next chapter, you’ll learn how to use the Browser, the Viewer, the Canvas, and the 
Timeline together to begin editing sequences.
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C H A P T E R

14

14 Basic Editing

Now that you’ve seen how the Browser, Viewer, Canvas, and Timeline work with one 
another, it’s time to put these different windows together to begin editing. Editing is the 
process of selecting parts of audio, video, and graphics clips and putting them in a sequence 
to create a program. 

This chapter explains the basics of editing simple sequences using Final Cut Pro’s different 
types of edits. You’ll also learn about the different rules Final Cut Pro uses when editing clips 
together under various circumstances.
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You Can Always Undo

Before you begin editing, it’s important to know how to use the Undo and Redo commands. 
Final Cut Pro lets you undo up to 99 actions, remembering each step you take as you work 
on your project. How many levels of undo are actually available to you depends on the 
setting in the General tab of the Preferences window.

When you first install Final Cut Pro, the default number of undo levels is 10. You can change 
this at any time, but be aware that the more levels of undo you set, the more memory Final 
Cut Pro will require.

When you’re first learning to work in Final Cut Pro, it can be comforting to know that if you 
make a change you don’t like or didn’t mean to make, it can usually be undone.

To undo the previous action:

m Choose Undo from the Edit menu.

m Press Command-Z.

You can use the Undo command as many times as you have specified in the Preferences 
window.

To redo an action that you have undone:

m Choose Redo from the Edit menu.

m Press Command-Y.

Repeated use of the Redo command will eventually redo all the steps that you’ve undone.

Using Undo as a Tool

You can use the Undo command to do more than just correct a mistake. You can also use it 
as a fast way to try out a limited number of changes to your edited sequence. If you don’t like 
the changes, simply use the Undo command the number of times required to go back to 
your project’s previous state. If you undo something and then change your mind, you can 
always use the Redo command to go back.

You can change the number 
of undo levels here.
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Creating Multiple Versions of an Edited Sequence

If you want to test changes to your edited sequence that are more extensive than a few 
undos will permit, or if you want to create several versions of your program for your client to 
review, you should duplicate your current sequence and make changes to the duplicate. 
Changes you make to a duplicate of a sequence do not affect the original in any way. You can 
make as many duplicate sequences as you like, renaming them in the Browser for reference 
and reediting them as extensively as you want.

To duplicate a sequence:

1 Select the sequence you want to duplicate in the Browser.

2 Choose Duplicate from the Edit menu, or press Option-D.

Final Cut Pro appends “copy” to the duplicate sequence’s name.

3 If desired, click the duplicate’s name in the Browser to highlight it, then enter a new name.

Editing in Final Cut Pro
There are several types of edits you can perform in Final Cut Pro. While the two most 
commonly used edits are the overwrite and insert edits, the other edits have uses in various 
situations as well.

All of these edit types use a specific set of rules to determine exactly where a clip goes when 
you edit it into your sequence from the Viewer. These rules are designed to give you the 
maximum amount of flexibility and control when piecing together the numerous clips that 
will go into your program.

For Final Cut Pro to use these rules effectively, however, it relies on specific information that 
you provide. When you mark In and Out points in the Viewer and in the Canvas, you tell 
Final Cut Pro how much of a clip you want to edit into your sequence. When you position the 
playhead or select target tracks in the Timeline, you tell Final Cut Pro where you want your 
clip to go. These are just a few of the ways you can specify information that Final Cut Pro 
needs to perform the edit you choose. When it does the edit, Final Cut Pro places only the 
frames of a clip that you specify into the exact location of the Timeline that you pick.
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Types of Edits in Final Cut Pro

There are seven basic kinds of edits you can use to edit material into your sequence. Which 
edit you choose affects how your source clip fits into the edit points you’ve chosen in your 
sequence, as well as what happens to any clips that are already there when the new clip 
comes in. All of these edits are covered in more detail later in this chapter, but here’s a quick 
summary:
m Overwrite

When you edit a clip into your sequence using an overwrite edit, any clips that are already 
in the tracks you’ve selected for editing into will be written over for the duration of your 
source clip.

m Overwrite with transition

This is the same as an overwrite edit, except that the default transition is used at the In 
point of the edit to transition between the previous clip and your source clip. When you 
first install Final Cut Pro, the default transition is a one-second cross dissolve. You can 
change it to anything you want, however, using the Set Default Transition command. 

m Insert

When you edit a clip into your sequence using an insert edit, all clips in all unlocked 
tracks will be cut at the In point of your edit and pushed forward in your edited sequence 
by the duration of your source clip. 

m Insert with transition

This is the same as an insert edit, except that the default transition is used at the In point 
of the edit to transition between the previous clip and your source clip. 

m Replace

The replace edit places a new clip into your sequence so that the frame at the position of 
the playhead in the Viewer ends up at the position of the playhead in the Timeline. The In 
and Out points of the source clip are set to match either

m sequence In and Out points that you set 

m the In and Out points of the clip in the Timeline that intersects the playhead, if there 
are no sequence In and Out points set

The replace edit is an extremely powerful editing tool, but you must understand it fully in 
order to use it properly. (See “Performing a Replace Edit” on page 573.)
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m Fit to fill

This edit type changes the speed of your source clip, either stretching it or compressing it 
to fill a space determined either by preset In and Out points, or by the In and Out points 
of the clip in the Timeline that intersects the playhead. Unlike other edit types, this type 
requires you to select four edit points instead of three. (See “Performing a Fit to Fill Edit” 
on page 579.)

m Superimpose

This automatically edits the video and audio of your clip into tracks above and below the 
currently selected video and audio target tracks, using either specified In and Out points 
in the Timeline, or the duration of a clip in the target track at the location of the playhead. 
You can use this edit to stack clips on top of each other for superimposing. 

About Split Edits

A split edit lets you modify your edit by making your source clip’s audio In or Out points 
different from its video In or Out points. You can also set up a split clip by editing in a clip’s 
video track without its accompanying audio, or vice versa. This is an extremely common 
editorial technique and it’s important to learn how to use it.

Note:  All the basic edit types can be performed as a split edit, but you’ll usually do split edits 
with overwrite editing. 

There is no specific overlay or control for doing a split edit in the Canvas. Instead, there are 
three ways you can create a split edit:

m Set up separate edit points for the video and audio tracks of the clip in the Viewer before 
you edit the clip into your Timeline.

m Disable either the audio or the video target track in the Timeline. 

This is good if you want to edit in video with no accompanying audio, or vice versa.

m Edit your clips in simply, with matching In and Out points, and then modify your edit in 
the Timeline later. 

You can do this using one of a variety of trimming operations, all of which are covered in 
more detail in Chapter 16, “Advanced Editing and Trimming Techniques,” on page 653.

For more on split edits, see “Setting Up and Performing Split Edits” on page 588.
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About Three-Point Editing

When you set up a series of In and Out points to prepare for performing an edit, Final Cut 
Pro abides by the principles of three-point editing.

To set up an edit, you don’t need to specify both In and Out points for your clip in the 
Viewer, and In and Out points for that clip’s destination in the Canvas or Timeline. All you 
have to do is to set up any three of the four needed edit points, and Final Cut Pro calculates 
the fourth one.

The following are a few basic examples of how three-point editing works. Each of these edits 
is discussed in detail later in this chapter.

Example 1:  Editing a Specific Clip Into Your Sequence

The simplest way to perform an edit is to specify In and Out points for a clip in the Viewer, 
and then specify the destination In point in your sequence by positioning the playhead in 
the Canvas:

1 Open a clip in the Viewer. This is your source clip.

2 Specify In and Out points for your source clip in the Viewer.

In point

Out point
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3 In the Canvas, move the playhead to the location in your sequence where you want the 
clip to start (the sequence In point). 

If you don’t define any In and Out points in your sequence, the Canvas or Timeline 
playhead will serve as the edit point.

4 Now, if you do an overwrite edit, you’ll see that the duration of your clip, defined by the 
In and Out points in the Viewer, has been edited into the sequence. 

Since you used an overwrite edit, the clip that was already on that track in the sequence 
has been overwritten by the source clip.

As you can see, defining only three points—the In and Out points in the Viewer and the 
sequence In point in the Canvas—gives you total control of the edit that’s performed.

Move the playhead to 
the location in the 
sequence where you 
want the clip to start.

The new clip starts 
where the playhead was.
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Example 2:  Editing a Clip Into a Gap in Your Sequence

You can also do the reverse of the previous edit. Let’s say you have a space in your edited 
sequence and you want to fill it up entirely with a new clip. You know where you want the 
source clip to start, and you don’t particularly care where it ends. You can specify an In point 
only in the Viewer, and specify both In and Out points in the Timeline to cover the gap:

1 Open a clip in the Viewer. This is your source clip.

2 Specify an In point for the source clip in the Viewer.

3 In the Canvas, move the playhead to the middle of the gap you want to fill.

Specify an In point in 
the Viewer.

Move the playhead to 
the middle of the gap.
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4 Choose Mark Clip from the Mark menu or press X to set In and Out points around the gap.

Note:  The gap must be within the target track.

5 If you do an overwrite edit, you’ll see that your clip, defined by the In and Out points in 
your sequence, has been edited into the sequence.

In and Out points

The new clip 
fills the gap.
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Example 3:  Backtiming a Clip Into Your Sequence

Instead of editing a clip into your sequence using In and Out points in the Viewer and an In 
point in the Canvas or Timeline, you can edit clips using only an Out point in the Canvas or 
Timeline. This is called backtiming a clip. In the resulting edit, your source clip’s Out point 
will be placed at the Out point you marked in your sequence, and the rest of the clip will 
appear in your sequence before this point, to the left:

1 Open a clip in the Viewer. This is your source clip.

2 Specify In and Out points for the source clip in the Viewer.

3 In the Canvas, move the playhead to the point in your edited sequence where you want 
your source clip’s Out point to be, and set an Out point.

In point 

Out point 

Move the playhead 
where you want the 
source clip’s Out point 
to be set.
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4 If you do an overwrite edit, you’ll see that your clip, defined by the In and Out points in 
the Viewer, has been edited into the sequence, the Out point of your clip has been lined 
up with the Out point you specified in the Canvas, and the rest of the clip has overwritten 
any material to the left of it.

Example 4:  Editing in a Clip With No Specified In or Out Points

If you don’t specify In or Out points for a clip in the Viewer prior to editing, Final Cut Pro 
edits in the entire clip either to the position of the playhead, or to an edit point specified in 
the Canvas or Timeline:

1 Open a clip in the Viewer, but don’t mark In or Out points.

The new clip with the 
Out point you specified 
in the Canvas.

No In or Out 
points marked
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2 In the Canvas, move the playhead to the location in your sequence where you want the 
clip to start (the sequence In point).

3 Now, if you do an overwrite edit, you’ll see that the entire clip in the Viewer has been 
edited into the sequence. Since you used an overwrite edit, any clips that were already on 
that track in the sequence have been overwritten by the source clip.

Move the playhead where you 
want the new clip to begin.

The playhead moves to the 
end of the new clip.

The new clip begins where 
the playhead was located.
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Three-Point Editing Rules in Final Cut Pro

Final Cut Pro uses the following rules to determine what constitutes an edit point:

If no edit points are specified:

m If no edit points have been set in the Viewer, then the In and Out points used are 
the beginning and end of the clip.

m If no edit points have been set in the Canvas or the Timeline, the playhead location 
in the Canvas is used as the sequence In point. 

If only one edit point has been specified:

m If only an In point is set for a source clip in the Viewer, Final Cut Pro uses the end 
of the clip as the Out point. Likewise, if only an Out point has been specified in the 
Viewer, Final Cut Pro uses the beginning of the clip as the In point.

m If you’ve only set an Out point in the Canvas or the Timeline, Final Cut Pro assumes 
you want to backtime the edit, matching the Out point of the source clip with the 
Out point specified in your sequence.

Exceptions to These Rules

There are two exceptions to Final Cut Pro’s three-point editing rule:

m Fit to fill edits:  This type of edit requires four specified points, because Final Cut 
Pro adjusts the speed of the source clip, slowing it down or speeding it up to fill the 
specified duration in the sequence.

m Replace edits:  For this type of edit, any In or Out points you set in the Viewer are 
ignored. If no In or Out points have been set in your sequence, Final Cut Pro uses 
the boundaries of the clip currently at the playhead’s location in the Canvas as 
sequence In and Out points. The replace edit is used to replace all or part of a 
single clip in your sequence.

Also, sequence In and Out points and target tracks don’t always apply when you drag a 
clip directly into the Timeline to perform an edit.
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Setting Up an Edit
Before you can perform an edit, you need to set it up by deciding how much of your source 
clip you want to use, and where in your edited sequence you want it to go. To do this, you 
follow three main steps:

Step 1: Define the edit points for a source clip in the Viewer

Step 2: Select your video and audio target tracks in the Timeline

Step 3: Set edit points in the Canvas or Timeline

See the instructions starting on page 548.

Preparing to Edit Multiple Clips at Once

Most edit types let you edit multiple clips into a sequence at once. You edit multiple items 
into your sequence by selecting them all in the Browser, then dragging them to a section of 
the Edit Overlay in the Canvas, onto an edit button in the Canvas, or directly into your 
sequence in the Timeline. How the clips appear in your sequence depends on how they’re 
organized in the Browser. 

Organizing Your Clips Using List View

If you organize your clips in list view in the Browser, you can sort your clips in a number of 
different ways using the Browser columns. Your edited clips go into your sequence using the 
current sort order.

Because you can sort clips in the Browser by any of the columns, you have several useful 
options when you’re preparing to edit a group of shots into a sequence. For example, if you 
entered scene and shot numbers when you logged your shots, you can sort by these two 
columns, then select all of these shots to edit into your sequence in the correct order. Or, if 
you use the Log Note or Comment columns to number your clips, you can sort by these 
columns, then drag a group of clips to put together a fast rough edit. 

For more information on sorting, see “Sorting Items in the Browser” on page 183.

Organizing Your Clips Using Large Icon View

If you organize your clips in large icon view in the Browser, you can also arrange the icons of 
your clips into a storyboard, and then move the whole group into the Timeline. Your source 
clips are laid out in a row in your edited sequence according to their position in the Browser.
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For example, a group that’s arranged like this:

will go into your sequence like this:

To create a storyboard:

1 Control-click in the Browser, then choose View as Large Icons from the shortcut menu.

2 Drag the clips where you want them. Keep your rows and columns relatively straight, so that 
Final Cut Pro can determine their order.

1 2 3

4 5 6

1 2 3 4 5 6

Arrange the clips in the 
order you want, from left to 
right and top to bottom.
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3 Select the group of clips you want to edit into your sequence by dragging a box around them 
in the Browser.

Setting In and Out Points for a Single Clip in the Viewer

To prepare for editing a single clip into your sequence, you can open it in the Viewer from 
the Browser to set In and Out points. More information on setting, modifying, and clearing 
edit points for clips in the Viewer can be found in “Setting and Modifying In and Out Points” 
on page 373.

To mark an In or Out point for a clip:

1 Open the clip in the Viewer.

2 Click the Viewer or press Command-1 to make it the active window, if it’s not already.

3 Use the Viewer controls to move the playhead to the point in your clip where you want to 
place the In or Out point.

4 Do one of the following:

m Press I to set an In point or press O to set an Out point.

m Click the Mark In or Mark Out button.

m Control-click in the scrubber bar, then choose Mark In or Mark Out from the shortcut menu.

m Choose Mark In or Mark Out from the Mark menu.

You can mark In and Out points while you’re playing a clip or when it’s stopped. Sometimes 
it’s easier to set edit points while the clip is playing, so you can set the In or Out point right 
when you hear or see the frame you want.

A boundary box surrounds the clips 
you want to edit into your sequence.
548 Chapter  14   



You can change In and Out points in the Viewer as often as you like. If you need to, you can 
also clear them completely:

To clear In and Out points in the Viewer:

1 Click the Viewer or press Command-1 to make it the active window, if it’s not already.

2 Do one of the following:

m Press Option-X.

m Control-click the In or Out point, then choose an option from the shortcut menu: Clear 
In, Clear Out, or Clear In and Out.

m Option-click the Mark Clip button.

m Choose Clear In, Clear Out, or Clear In and Out from the Mark menu.

m Click an In or Out point, drag up or down until the edit point disappears, then release the 
mouse button.
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Specifying Target Tracks in the Timeline

By default, new sequences are created with one video and two audio tracks. If you add 
additional tracks to your sequence, you must tell Final Cut Pro which tracks you want to edit 
new clips into. The tracks you select are called target tracks. You can set any one video and 
two audio tracks as target tracks at one time. Final Cut Pro then edits all new source clips into 
these tracks until you specify different target tracks.

Note:  You can change the default number of tracks for newly created sequences in the 
Timeline Options tab of the Preferences window. See “Setting Options for the Timeline” on 
page 894 for more information.

You specify target tracks for a source clip’s video, audio 1, and audio 2 tracks using the 
Timeline’s Target Track controls, located at the left of the Timeline inside each track’s header. 
Each of these target tracks corresponds to a media tab in the Viewer: one for video, one for 
audio 1, and another for audio 2. (There is only one audio tab in the Viewer for clips that are 
a stereo pair, although there are two tracks in the Timeline.)

Each control has two states:

m Gray:  A gray icon indicates an unselected track.

m Yellow:  A yellow icon indicates a selected track.

Repeatedly clicking a target track deselects that target altogether. For example, if video track 
V1 is already selected, clicking it again will deselect it, and until it’s reselected, there will be 
no video target track, even though there are still audio target tracks selected. You can 
deselect a target in preparation for editing split clips (such as the audio from a clip without 
its accompanying video) into your sequence. 

While editing, it’s very important to make sure that the correct target tracks are specified. If 
you don’t, your edits may end up on the wrong track, inadvertently overwriting or displacing 
other material. (Remember, if this happens, you can always undo.)

You can specify a 
maximum of three target 
tracks at a time: one for 
video and two for audio.

A speaker icon
indicates audio target

tracks.

A filmstrip icon indicates
video target tracks.
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To select a video target track in the Timeline:

m Click one of the video Target Track controls. Clicking the same control again will deselect 
it so that no video target track is selected at all.

m Press F6 and then quickly press the number of the video track you want to select as the 
target track (for tracks 1–9).

To select audio target tracks in the Timeline:

m Click the left or right speaker on the audio Target Track control to set that track as a 
channel 1 target or channel 2 target for your stereo audio. Clicking the same control twice 
will deselect it, so that no audio target track is selected for that channel.

m Press F7 and then quickly press the number of the audio track you want to select as the 
target track for audio channel 1 (for tracks1–9).

m Press F8 and then quickly press the number of the audio track you want to select as the 
target track for audio channel 2 (for tracks 1–9).

To swap the two selected audio target tracks:

m If the channel 1 and channel 2 targets are on adjacent tracks, click one of these track’s 
opposite channel controls to flip the channel 1 and channel 2 audio targets between 
these tracks.

For example, if audio track A1 is selected as the channel 1 target, and track A2 is selected 
as the channel 2 target, then clicking the channel 2 target of track A1 will make A1 the 
channel 2 target, and A2 the channel 1 target.

Click one side of the speaker 
icon to turn off the channel.

Before After
  Basic Editing 551



m To flip the channel 1 and channel 2 targets of two nonadjacent tracks, hold the Option key 
down while clicking.

If you don’t hold down the Option key, then clicking the opposite audio target track of a 
nonadjacent track will deselect the other audio target track with that assignment. 

Using Target Track Controls to Add a Split Clip to Your Sequence

To add a clip to your edited sequence, you have to select at least one target track, but you 
don’t necessarily need all three. You can take advantage of this to keep some media tracks in 
your source clip from being edited into your sequence. 

For example, let’s say you want to edit the video of a clip in the Viewer into your sequence, 
but you don’t want its audio. You can simply deselect both of your audio Target Track 
controls, leaving only the video Target Track control selected. Performing an overwrite edit 
will add the video portion of the selected clip to your sequence, omitting the audio 
completely.

Only V1 is selected as 
target track.

V1, A1, and A2 are 
selected as target tracks.
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To omit source media tracks using the Target Track controls:

Deselect the video and/or audio you want to exclude by doing one of the following:

m Click any selected Target Track control a second time to deselect it.

m Press Shift-F6 to deselect the current video target.

m Press Shift-F7 to deselect the current audio channel 1 target.

m Press Shift-F8 to deselect the current audio channel 2 target.

m You can also lock any track you don’t want source media edited into by clicking that 
track’s Lock Track control, located in the track header.

Protecting Timeline Tracks From Edits or Changes

If you want to set one or more tracks as temporarily “off limits” to edits or changes, you can 
lock them using the Lock Track control in each track’s header. While a locked track can be 
specified as a target track, no media will be edited into a locked track no matter which kind 
of edit you perform. Locked tracks appear cross-hatched in the Timeline. For more 
information, see “Locking Tracks” on page 479.

To prevent edits on a track:

m Lock a single track by clicking the Lock Track control at the left of the Timeline. 

The icon changes to a closed lock. No edits will be placed on the locked track until you 
unlock it.

m If it’s a video track:  You can also press F4 and the number of the track you want to 
lock (for tracks 1 through 9).

m If it’s an audio track:  You can also press F5 and the number of the track you want to 
lock (for tracks 1 through 9).

The control changes to
the locked position.

Click the control again
to unlock the track.
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m To lock all video tracks in your sequence, press Shift-F4.

m To lock all audio tracks in your sequence, press Shift-F5.

m To lock or unlock all other tracks except the one you’re selecting, press Option while 
clicking the Lock Track control of the desired track.

Exceptions to Normal Use of Target Tracks

There are two exceptions to the way you normally use target tracks to specify the destination 
of source clips:
m When using drag-and-drop editing

If you edit your clip by dragging it to a track in the Timeline, it is placed on that track, 
even if the track is not the target track. However, any currently selected target tracks will 
modify this behavior in two ways:

m If the video target is deselected, dragging a clip to an audio track will result in no video 
being edited into your sequence, and vice versa with any source audio.

m If you select nonadjacent audio and video target tracks, your source media will be 
edited in using the track separation defined by the targets, even though you might not 
be editing your media into the same tracks.

m When using the superimpose edit

If you edit a clip into your sequence using a superimpose edit, it will be edited into the 
track above the currently selected target track. Any clips that were already there will be 
moved up into other tracks, creating additional tracks to make room, if necessary.

The upper part of the 
track is cross-hatched to 
indicate it’s locked.

The Lock Track
control is locked.
554 Chapter  14   



Setting In and Out Points in the Canvas or Timeline

In and Out points in either the Canvas or the Timeline determine where source clips are 
edited into the current target tracks. It’s important to remember that the In and Out points 
in the Canvas and the Timeline are the same. They refer to the same timecode values and 
affect the same part of your sequence. 

You have three choices for how to set these points:
m Setting no edit points

If you don’t set any edit points in the Canvas or the Timeline, Final Cut Pro uses the 
playhead as an In point to determine the outcome of your edit.

m Setting one edit point

If you set only one edit point, either the In or the Out point, that point determines where 
the clip being edited into your sequence will start: 

The position of the 
playhead determines 
the In point if you 
haven’t set edit points 
in the Canvas or 
Timeline.

The new clip starts 
where the playhead 
was prior to the edit. 
After the edit the 
playhead moves to the 
end of the clip.
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m If you set an In point, the In point of the clip you’re editing into your sequence will 
match its location, and the rest of the edit will extend from the In point to the right for 
the duration of the source clip.

m If you set an Out point, the Out point of the clip you’re editing into your sequence will 
match its location, and the rest of the edit will be “backtimed” by the source clip’s 
duration, extending from the Out point to the left.

In point 

The new clip 
begins at the In 
point that you 
set.

Out point 

The new clip 
ends at the Out 
point that you 
set.
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m Setting both the In and Out points 

Setting both the In and Out points in the Canvas or Timeline limits the total duration of 
your source clip to the space between these two points. How the source clip lines up 
within this duration depends on which edit points have been set in the Viewer:

m If you set an In point in the Viewer, the In point of the clip you’re editing into your 
sequence will line up with the In point in your sequence.

m If you set an Out point in the Viewer, the Out point of the clip you’re editing into your 
sequence will line up with the Out point in the sequence, and the edit will be 
backtimed. In this case, the length of the clip being edited in will match the duration 
from the sequence Out point to the sequence In point.

m If you set both In and Out points in the Viewer, the In and Out points in the Timeline 
take precedence, and Final Cut Pro lines up the In point in the Viewer with the In 
point in the sequence. As long as there’s enough material in your source clip, the 
length of the clip edited into your sequence will be determined by the duration from 
the sequence In point to the sequence Out point. The Viewer Out point will be 
ignored. If your source clip in the Viewer is not as long as the duration between the 
sequence In and Out points, then you’ll get an “Insufficient content for edit” error.

In and Out points 
are set in the 
Timeline.

The new clip’s duration 
is defined by the In and 
Out points you set.
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Using the Playhead to Determine the In Point for Your Edit

The simplest way to set an In point in either the Canvas or the Timeline is to position the 
playhead at the position in your sequence where you want to edit in your source clip.

You can move the playhead anywhere you like in preparation for an edit by using the Canvas 
transport controls, the shuttle or jog control, the scrubber bar, or the Timeline ruler controls 
and their keyboard equivalents. You can also use some special controls for navigating among 
key points in your sequence. 

Often, you’ll want to position the playhead at the beginning or end of a specific clip in your 
sequence in preparation for the next edit. Final Cut Pro makes it easy to jump quickly 
between all of the edit points in your sequence.

To move the playhead to the nearest edit point in your sequence:

m Click the Previous Edit or Next Edit button in the Canvas.

m Choose Next or Previous from the Mark menu, then choose Edit from the submenu.

m Press the Up or Down Arrow key.

m Press Option-E (for the previous edit) or Shift-E (for the next edit).

You can also navigate to the nearest marker in your sequence, whether it’s in a clip or in 
the Timeline:

m Press Option-M (for a previous marker) or Shift-M (for the next marker).

Different Methods for Setting In and Out Points in the Canvas or 
Timeline

Setting edit points in the Canvas or Timeline is an extremely powerful way to edit clips into 
your sequence using specific durations. You can automatically define the In and Out points in 
your Canvas or Timeline based on the durations of clips already in your sequence, or on the 
durations of gaps in the Timeline. 

To set In and Out points anywhere in the Canvas or Timeline:

1 Select either the Canvas or the Timeline by doing one of the following:

m Click the appropriate window.

m Press Command-2 to select the Canvas.

m Press Command-3 to select the Timeline.

m Press Q to switch between the Viewer and the Canvas.
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2 Move the playhead to the point in your sequence where you want to place the In or Out point.

3 Do one of the following:

m Press I to set an In point or press O to set an Out point.

m Click the Mark In or Mark Out button.

m Control-click in the scrubber bar of the Canvas (or the ruler of the Timeline), then choose 
Mark In or Mark Out from the shortcut menu.

m Choose Mark In or Mark Out from the Mark menu.

You can mark In and Out points while the sequence is playing or when it’s stopped. 
Sometimes it’s easier to set edit points while your program is playing, so you can set the In 
or Out point right when you hear or see the frame you want.

Sometimes, you’ll want to move the playhead in the Canvas or the Timeline directly to an In 
or Out point so you can adjust or reset it.

To move the playhead to the current In point:

m Press Shift-I.

m Shift-click the In point in the Canvas scrubber bar.

m Choose Go To from the Mark menu, then choose In from the submenu.

To move the playhead to the current Out point:

m Press Shift-O.

m Shift-click the Out point in the Canvas scrubber bar. 

m Choose Go To from the Mark menu, then choose Out from the submenu.

You can also set In and Out points using the beginning and end of a clip in the Timeline. This 
is an easy way to set edit points when you want to replace one clip with another using exactly 
the same location and duration in the Timeline. It can also come in handy if you want to 
superimpose one clip directly over another, or to quickly set the In and Out points to fit the 
boundaries of a gap in your sequence. 
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To set In and Out points using the beginning and end of a clip in the Timeline:

1 Place the Timeline playhead over a clip (or gap) in your sequence.

2 Make sure that the tracks containing your selected clip or gap are the target tracks. 
Otherwise, you won’t get the expected result. 

If you want to leave either the audio or video track unselected so that the corresponding 
media from the source clip will not be edited in, you can deselect either the audio or video 
Target Track controls.

3 Do one of the following to mark In and Out points:

m Press X.

m Click the Mark Clip button in the Canvas.

m Choose Mark Clip from the Mark menu.

Make sure the track
that the selected clip is

on is the target track.

Move the playhead over 
the clip.

Mark Clip button 
in the Canvas
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In and Out points are automatically set at the clip’s (or gap’s) boundaries.

If either the audio or video target track is disabled, you’ll see modified In and Out 
markers indicating that a split clip will be edited in, excluding either the audio or video 
of your source clip.

Instead of using the duration of a single clip to set the In and Out points in your edited 
sequence, you can use Final Cut Pro’s selection tools to select a group of whole or partial 
clips in your Timeline, then use the duration of the selection to set In and Out points using 
the Mark Selection command.

Note:  If you do not have contiguous items selected in the Timeline, this command sets your 
edit points using the selected clips farthest to the left and farthest to the right as the outer 
boundaries.

To set In and Out points using a selected group of clips in the Timeline:

1 Select the desired items in the Timeline. 

You can select part of a clip, several clips, or parts of several clips using the Selection, Group 
Selection, or Range Selection tools and their modifier keys. For more information on how to 
use these, see “Tools Used for Selecting Items in the Timeline” on page 492.

If you want to set only video or only audio edit points, select only video or audio items in the 
Timeline. ( You can also deselect either the audio or video Target Track controls.)

In and Out points are 
set at the clip’s 
boundaries.
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2 Make sure that the tracks containing your selected clips are the target tracks. Otherwise you 
won’t get the results you expect.

3 Do one of the following:

m Press Shift-A.

m Choose Mark Selection from the Mark menu.

If either the audio or video target track is disabled, you’ll see modified In and Out markers 
indicating that a split clip will now be edited in. Otherwise, both In and Out points will be set 
using the boundaries of your selection.

You can change your In and Out points in the Canvas or Timeline as often as you like. If you 
need to, you can also clear them completely.

Make sure the selected
clip or clips are on the

target track.

Select the desired 
clips or sections.

In and Out points are 
set for your selection.
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To clear the current sequence In and Out points:

1 Click the Timeline (Command-3) or Canvas (Command-2) to make it the active window, if it’s 
not already.

2 Do one of the following:

m Press Option-X.

m Control-click the In or Out point, then choose an option from the shortcut menu: Clear 
In, Clear Out, or Clear In and Out.

m Option-click the Mark Clip button.

m Choose Clear In, Clear Out, or Clear In and Out from the Mark menu.

Performing an Edit
Now that you’ve set edit points for your source clip and you’ve set target tracks and edit 
points for the clip’s destination in your edited sequence, it’s time to perform your edit. Final 
Cut Pro gives you numerous ways to do this, depending on your editing style:

m Drag to the Canvas Edit Overlay:  The Edit Overlay appears when you drag a clip from 
either the Viewer or the Browser to the image area of the Canvas window. The overlay 
appears translucently over your image, and dragging your clip to one of its sections 
performs the corresponding edit.

m Use the Canvas edit buttons:  With a clip open in the Viewer, clicking an edit button in the 
Canvas performs that type of edit.

m Use keyboard shortcuts:  With a clip open in the Viewer, you can also use keyboard 
shortcuts to do each type of edit.

m Drag to the Timeline:  You can also edit clips by dragging them from either the Viewer or the 
Browser directly into the Timeline, placing them in your sequence exactly where you want.
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Performing Edits Using Canvas Controls or the Keyboard

There are three ways you can edit in the Canvas: using the Edit Overlay, edit buttons, or 
keyboard shortcuts.
m Edit Overlay

When you drag one or more clips from either the Viewer or the Browser to the image 
area of the Canvas, the Edit Overlay appears. Each of the seven different edit types is 
represented by a section of the Edit Overlay, and you drag your media clip to a section to 
edit it into your sequence.

The area to the left of the Edit Overlay is an extension of the Overwrite section. When you 
drag a clip to a specific section of the overlay, that section is outlined in its own color.

Edit Overlay with 
its seven sectionsDrag a clip to a section

of the Edit Overlay.

Edit buttons

Target track 
indicators
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m Edit buttons

With a clip open in the Viewer, click one of the edit buttons at the bottom of the Canvas 
to perform an edit. You can also drag a source clip to one of these buttons.

When you press the arrow to the right of the third edit button, additional edit types 
appear in a menu. If you choose one of these other edit types, that edit becomes the 
default function of the third button.

m Keyboard shortcuts

The keyboard shortcuts correspond to the seven edit types. All the keyboard shortcuts 
use the function keys along the top of the keyboard. (If you forget a keyboard shortcut, 
position your pointer over one of the edit buttons and pause for a moment. A tooltip will 
appear with that button’s function, as well as its keyboard shortcut.)

m F9:  Insert edit

m Shift-F9:  Insert with transition edit

m F10:  Overwrite edit

m Shift-F10:  Overwrite with transition edit

m F11:  Replace edit

m Shift-F11:  Fit to fill edit

m F12:  Superimpose edit

Performing the Seven Types of Edits

The following instructions tell how to perform each of the seven types of edits available in Final 
Cut Pro. All of these procedures assume that you’ve already marked In and Out points for your 
source media in the Viewer and for your destination sequence in the Canvas or Timeline.

Performing an Insert Edit

An insert edit places the source clip into your sequence so that all items after the insertion 
point in your sequence are moved forward in the Timeline, to make room for the clip being 
added. No clips are removed from your sequence. 

Drag a clip to one of the edit 
buttons. Press the arrow next to 
the third button to display the 
additional edit types.
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You can perform an insert edit with one or more clips. If you perform an insert edit in the 
middle of another clip, that clip is cut at the insertion point and the second half pushed, along 
with the rest of the footage in the Timeline, to the end of the newly inserted clip. This happens 
regardless of whether the track into which the source clip is edited has edited content or not.

Insert edit

For example, let’s say you’re cutting a documentary and you have a talking head clip of an 
engineer describing the launching of a rocket. She describes what the explosion of the 
rocket’s ignition looks like, then she talks about its graceful rise into the air. You have another 
clip that shows a rocket igniting and you decide you want to put it right after the engineer 
finishes describing the explosion. But you don’t want to eliminate the rest of her statement. 
Instead, you want to push her second comment to the end of the ignition footage. 

You can position the playhead at the frame after she finishes describing the explosion, then 
perform an insert edit with the rocket footage. This pushes the second part of the talking 
head clip to the end of the rocket clip, achieving the desired sequence.

To perform an insert edit:

m Specify the necessary edit points and target tracks, then do one of the following:

m Drag the clip from the Canvas to the Insert section of the Edit Overlay.

m Click the Insert button in the Canvas.

m Press F9.

A B CD

A B CD

Before edit

After edit

Insert section of
the Edit Overlay

in the Canvas.
Insert button
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After the edit, all clips on all unlocked tracks (including non-target tracks) are moved forward in 
time, from the playhead position to the right, to make room for the clip or clips being inserted.

Performing an Insert With Transition Edit

The insert with transition edit is a quick way to do an insert edit that includes the default 
transition between your new source clip and the clip before it in your edited sequence. When 
you first install Final Cut Pro, the default transition is a one-second dissolve. For more 
information on how to choose a new default transition, see “Modifying the Default 
Transition” on page 642.

Note:  You have to render transitions before you can play them back, unless you have a real-
time system.

An insert with transition edit is exactly the same as an ordinary insert edit, but it places the 
default transition into the Canvas, centered on the edit.

Insert with transition edit

You can also perform an insert with transition edit with multiple clips. If there are no other 
clips in your sequence at the In point, the first clip will make a default transition from black. 
Each successive clip will then use the default transition into the next one until all the clips 
you selected are laid out in a row.

Before an insert edit

After an insert edit

New clip inserted

A B C

B CA

DBefore edit

After edit D
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To perform an insert with transition edit:

m Specify the necessary edit points and target tracks, then do one of the following:

m Drag the clip from the Viewer to the Insert with Transition section of the Edit Overlay.

m Click the Insert with Transition button in the Canvas.

m Press Shift-F9.

Drag your clip to the 
Insert with Transition 
section to add a 
transition to your edit.

Insert with Transition button
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The source clip is inserted into the sequence with the default transition.

Performing an Overwrite Edit

Since this is one of the most commonly used edit types, it occupies the biggest overlay area 
in the Canvas. If you drag a clip into any part of the Canvas to the left of the Edit Overlay, an 
overwrite edit will be performed.

With this type of edit, the source clip overwrites any items at the insertion point for the 
duration of the edit you’ve specified. None of your other edited clips in the sequence are 
moved. If your insertion point is in the middle of a clip, any part of that clip from the 
insertion point on will be overwritten for the duration of the edit.

You can perform an overwrite edit with one or more clips.

Overwrite edit

Before an insert with
transition edit

After an insert with
transition edit

A BD

D

C

A C

Before edit

After edit
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For example, let’s say you’ve got a clip of a comedian making a joke. You edit it in, but there’s 
a pause after the joke as the comedian stands there waiting. You also have a reverse shot of 
an audience laughing, so you decide you want to cut to it immediately after the joke is 
finished, instead of the pause. You can position the playhead at the frame right after the joke, 
and then perform an overwrite edit to eliminate the pause in the comedian clip and replace 
it with the laughter of the audience.

To perform an overwrite edit:

m Specify the necessary edit points and target tracks, then do one of the following:

m Drag the clip from the Viewer to the Overwrite section of the Edit Overlay.

m Click the Overwrite button in the Canvas.

m Press F10.

Overwrite section of
the Edit Overlay

in the Canvas

Overwrite button
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The clip overwrites all items on the target tracks from the playhead position through the 
duration of your edit. No items are moved.

Performing an Overwrite With Transition Edit

The overwrite with transition edit is a quick way to do an overwrite edit that includes the 
default transition between your new source clip and the clip before it in your edited 
sequence. When you first install Final Cut Pro, the default transition is a one-second dissolve. 
For more information on how to choose a new default transition, see “Modifying the Default 
Transition” on page 642.

Note:  You have to render transitions before you can play them back, unless you have a real-
time system.

An overwrite with transition edit is exactly the same as an ordinary overwrite edit, but it 
places the default transition into the Canvas, centered on the edit.

Overwrite with transition edit

Before an
overwrite edit

After an
overwrite edit

A B C

CA

DBefore edit

After edit D
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When you perform an overwrite with transition edit, make sure that there is enough source 
media at the beginning of the new clip and at the end of the previously edited clip to create 
the transition. Each source clip must have enough unused frames outside the defined edit 
points to equal half the duration of the default transition. 

You can also perform an overwrite with transition with multiple clips. Each clip will use the 
default transition into the next one until all the clips you selected are laid out in a row.

To perform an overwrite with transition edit:

m Specify the necessary edit points and target tracks, then do one of the following:

m Drag the clip from the Viewer to the Overwrite with Transition section of the 
Edit Overlay.

m Click the Overwrite with Transition button in the Canvas.

m Press Shift-F10.

 

Drag your clip to the 
Overwrite with Transition 
section to add a transition 
to your edit.

Overwrite with 
Transition button
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The clip overwrites other items on the target tracks for the duration of the edit, and uses the 
default transition.

Performing a Replace Edit

A replace edit is a specialized form of overwrite edit. You can use a replace edit to

m quickly replace an entire shot that’s already in your edited sequence

m resynchronize a frame in one video or audio clip with a frame in another unlinked clip in 
an adjacent track

Replace edits follow a few special rules:

m Replace edits never use In and Out points specified in the Viewer. If these points have 
been set, they will be ignored. Instead, the source frame at the position of the Viewer 
playhead will be lined up with the sequence frame at the position of the Canvas/Timeline 
playhead.

m Replace edits do not require In and Out points to be set in the Timeline. If you don’t set 
In or Out points, the clip that intersects the position of the playhead in the current target 
track will define the In and Out points for the source clip (as it does when you use the 
Mark Clip command). 

Before an overwrite
with transition edit

After an overwrite
with transition edit
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If you do set In and Out points in the Timeline, they will be used even if they span 
multiple clips, as long as there’s enough media on either side of the playhead in your 
source clip.

m A replace edit places the clip in the Viewer into your sequence so that the frame at the 
playhead in the Viewer will be centered on the playhead’s position in the Timeline. So it’s 
important that you have enough media in your source clip to the left and to the right of 
the playhead in the Viewer to accommodate the space you’ll be filling in the Timeline. If 
you don’t, you’ll see an “Insufficient content for edit” error.

m If you perform a replace edit by dragging a clip directly from the Browser, Final Cut Pro 
uses the location of the Viewer playhead from the last time that clip was open in the 
Viewer. If the clip is newly imported and has never been opened in the Viewer, Final Cut 
Pro uses that clip’s starting frame instead.

m You can perform a replace edit with one clip at a time. If you selected multiple clips, only 
the first one will be used.

The most basic use of the replace edit is to quickly and easily replace one clip in your edited 
sequence with another. For example, let’s say you’re editing an action sequence of a man 
running through the jungle. In a previous edit, you cut away to a clip of a monkey sitting in a 
tree, but the director didn’t like it. You want to replace the clip of the monkey with a clip 
containing a helicopter shot of the jungle, but you don’t want to change the timings of any of 
the edits in this sequence, because you like the pacing and they’re timed to music. It’s a 
perfect time to use a replace edit.

In and Out points
spanning multiple clips
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To replace an entire clip in the Timeline from its In point:

1 In the Timeline, move the playhead to the In point of the clip you want to replace.

2 Make sure that the correct target tracks are set in the Timeline for the clip you want to replace.

3 Open the clip you want to edit in the Viewer, then move the Viewer playhead to the frame 
you want to use as the In point. Do not set any edit points in the Viewer.

Make sure that the duration from the Viewer playhead to the end of your clip in the Viewer is 
at least as long as the duration of the clip you want to replace in the Timeline. If it’s not, 
you’ll see an “Insufficient content for edit” error.

4 Do one of the following:

m Drag the clip from the Viewer to the Replace section of the Edit Overlay in the Canvas.

m Click the Replace button in the Canvas.

m Press F11.

Move the playhead to 
the In point of the clip 
you want to replace.

Replace button

Replace section
of the Edit Overlay

in the Canvas
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Another common use of the replace edit is to line up a frame in a clip that’s already in your 
edited sequence with an audio cue in an adjacent clip. 

For example, if you have a video clip of a man dancing playing over an audio clip in another 
track of music, you can use a replace edit to edit the same video clip into your sequence at 
the same location, but line up a frame with a particular movement of his foot to a particular 
beat of the music.

To use a replace edit to resync a video clip to an audio clip in another track:

1 In the Timeline, find the audio cue you want to sync your video clip to.

2 Make sure that the target tracks in the Timeline are set to the tracks containing your video 
clip, and not your music clip.

3 Without moving the Timeline playhead, press the F key to perform a match frame edit.

This will open the source clip that the video clip in your sequence came from in the Viewer, 
placing the playhead in the Viewer over the same frame that was under the playhead in the 
Timeline. For more information on match frame editing, see “Locating a Match Frame” on 
page 600.

4 Move the playhead in the Viewer to the new frame that you want to coincide with the audio 
cue that you selected in the Timeline.

Make sure that the duration from the Viewer playhead to the end of your clip in the Viewer is 
at least as long as the duration from the Timeline playhead to the end of the clip you want to 
replace in your sequence. If it’s not, you’ll see an “Insufficient content for edit” error.

5 Now that the Timeline playhead is lined up with your audio cue in your sequence and the 
Viewer playhead is lined up with a video frame that you want to sync to it in the source clip, 
perform the edit by doing one of the following:

m Drag the clip from the Viewer to the Replace section of the Edit Overlay in the Canvas.

m Click the Replace button in the Canvas.

m Press F11.

The original clip in your sequence will now be replaced with a new copy of the clip, which 
will be synchronized with your audio cue.
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Using a replace edit to replace a selection of one or more clips:

You can use the replace edit on more than one clip at a time to replace a section of your 
sequence. While In and Out points in the Viewer are ignored, In and Out points you set in 
the Timeline are treated in the same way they are for an individual clip (even if they span 
parts of more than one clip). When you do this kind of edit, it’s important to make sure you 
have enough media on either side of the playhead in the Viewer to cover the area you’ve 
specified in the Canvas or Timeline.

1 In the Canvas or the Timeline, set In and Out points for the section of your sequence you 
want to replace.

2 Move the playhead to the frame that you want the source clip to line up with. This frame can 
be at any point between the In and Out points.

3 Make sure that the tracks containing the items you want to replace are the target tracks in 
the Timeline.

4 In the Viewer, open the clip you want to use to replace the selected area, then move the 
playhead to the frame you want to line up with the playhead in the Timeline.

In and Out points define the 
area you want to replace.
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5 Do one of the following:

m Drag the clip from the Viewer to the Replace section of the Edit Overlay in the Canvas.

m Click the Replace button in the Canvas.

m Press F11.

The selected area in the sequence is replaced by the source clip. Final Cut Pro automatically 
calculates the clip duration needed.

Replace button

Replace section
of the Edit Overlay

in the Canvas

Before a replace edit

After a replace edit
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Performing a Fit to Fill Edit

If you have a clip in the Viewer that you want to edit into an area of the Timeline defined by a 
pair of In and Out points, and the duration of the source clip doesn’t match the duration of 
the area in the Timeline, you can use a fit to fill edit to force your source clip to fit.

A fit to fill edit changes the speed of the source clip, speeding it up or slowing it down to 
make it fit into the required duration in the Timeline. Because fit to fill changes the speed of 
the edited clip, you have to render it before it will play back. Also, any audio items associated 
with this clip will change pitch either higher or lower, depending on how dramatic the speed 
change is.

Fit to fill is the only edit type in Final Cut Pro that requires four edit points, instead of three. 
You need to set In and Out points for your clip in the Viewer, as well as In and Out points in 
the Canvas or Timeline for the destination in your edited sequence.

For example, let’s say you want to replace part of a talking head interview shot because the 
camera started wiggling. The audio is still usable, but you need to put something else into 
the video area of your sequence from the point where the wiggling starts to where it stops. 
You have one reverse shot of the interviewer sitting and nodding her head, but it’s one 
second shorter than the gap in your sequence. In this case, you can use the fit to fill edit to 
make your reverse shot clip fit into your sequence to cover the necessary area.

Fit to fill edit

You can also use the fit to fill edit with multiple clips. When you do so, each successive clip in 
your selected group will be edited using a fit to fill edit into each successive clip in your 
sequence, starting with the clip at the current position of the Timeline playhead. If you’ve 
selected more clips in the Browser than you have clips in your sequence, you’ll see an 
“Insufficient content for edit” error message.

To perform a fit to fill edit:

1 In the Canvas, set sequence In and Out points to define the part of your sequence you want 
to fill.

2 Make sure that the correct target tracks are set in the Timeline.

3 Open a clip in the Viewer.

A B C

A D C

DBefore edit

After edit
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4 Set In and Out points to define the portion of your source clip that you want to edit into 
your sequence to fill the duration set in step 1.

5 Do one of the following:

m Drag the clip from the Viewer to the Fit to Fill section of the Edit Overlay in the Canvas.

m Click the Fit to Fill button in the Canvas.

m Press Shift-F11.

Set In and Out 
points in the 
source clip.

Set In and Out
points in the

sequence.

Fit to Fill section of
the Edit Overlay

in the Canvas

Fit to Fill button
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The material in the Viewer overwrites any material already between the sequence In and Out 
points you specified. The speed of the source clip is changed to compensate for the 
difference in duration.

Before a fit to fill edit

After a fit to fill edit

Final Cut Pro changes 
the speed of the clip to 
fit the specified area of 
the sequence.
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Performing a Superimpose Edit

You can use a superimpose edit to quickly stack a source clip on top of any clips already 
edited into your sequence in the Timeline in preparation for further editing or compositing. 
If there isn’t an available track in your sequence, Final Cut Pro creates a new one for the 
source clip.

Superimpose edits obey the standard rules of three-point editing, except that if no In or Out 
points have been specified in the Canvas or Timeline, the position of the playhead in the 
Timeline is not used as a default In point. Instead, the clip that intersects the position of the 
playhead in the current target track will provide the In and Out points for the source clip (as 
it does when you use the Mark Clip command). 

You can set the In and Out points in the Canvas or Timeline so that the superimpose edit 
spans multiple clips, as long as there’s enough media in your source clip to cover the 
specified area.

If you perform several superimpose edits in the same location, all new source clips are edited 
into the video track directly above the current target track, and all other previously 
superimposed video clips are moved up one track to make room. If your superimposed clip 
contains audio, the source audio will be similarly placed on new audio tracks immediately 
below any occupied audio target tracks already in your sequence.

Likewise, if you perform a superimpose edit with several source clips at once, all of those 
clips will be stacked on top of one another. The first clip in your selected group will be on 
top, with each successive clip appearing underneath.

Superimpose edit

To perform a superimpose edit:

1 Do one of the following:

m Position the Timeline playhead over a clip where you want to superimpose your source 
media. The beginning and end of this clip will be used as edit points for your source clip.

m Set sequence In and Out points.

2 Set In and Out points in the Viewer to define the part of the source clip you want to edit into 
your sequence.

A B C

D

A B C

DBefore edit

After edit
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3 Do one of the following:

m Drag the clip from the Viewer to the Superimpose section of the Edit Overlay.

m Click the Superimpose button in the Canvas.

m Press F12.

The clip in the Viewer is placed on the track above the target track, starting at the beginning 
of the clip that intersects the Timeline playhead, or at the sequence In point. If there is no 
track above the target track, one is created.

Superimpose button

Superimpose section
of the Edit Overlay in

the Canvas

Before a
superimpose edit

After a
superimpose edit
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Editing Directly in the Timeline

You can also perform edits by dragging clips from either the Viewer or the Browser directly 
into a location in the Timeline. This form of editing limits you to insert or overwrite edits, 
although you can easily superimpose clips this way.

You can drag one clip at a time or multiple clips into the Timeline.

Doing Simple Insert and Overwrite Edits in the Timeline

Each track in the Timeline is divided into two areas by a thin gray line. When you drag a clip 
directly into the Timeline, the source clip darkens an area of the track in which you’re 
holding it by an amount equal to the duration of the source clip. Which region of the track 
you drag the clip into determines whether an insert or overwrite edit is performed.

m To do an insert edit:  Drag the clip to the upper third of a track in the Timeline.

m To do an overwrite edit:  Drag the clip to the lower two-thirds of a track in the Timeline.

As you move the pointer from one region of the track to the other, it changes to indicate the 
type of edit—a right arrow for an insert edit and a down arrow for an overwrite edit.The 
corresponding edit button is also highlighted in the Canvas window.

Note:  If you drag a clip that’s already been edited into a sequence to another location in the 
sequence, you perform an overwrite edit by default.

Insert edit area

Overwrite edit area

Drag a clip to the
upper third of the

track to do an
insert edit.

Drag the clip to the lower 
two-thirds of a track for 
an overwrite edit.
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About the Canvas Two-Up Display

As you drag your clip into the Timeline, a two-up display appears in the Canvas to show you 
the sequence In and Out points for the edit you’re performing. What appears in this display 
depends on the kind of edit.

m If you’re performing an overwrite edit, the two-up display shows a preview of the frame 
before (on the left) and the frame immediately after (on the right) the source clip being 
edited in. Clip names appear at the top of the display, and each frame’s timecode appears 
at the bottom. You’ll notice that the timecode value displayed in the right frame is the 
timecode value of the In point plus the duration of the source clip.

m If you’re performing an insert edit, the two-up display shows two adjacent frames, 
because the clip is cut in two at the place shown, and the remaining footage pushed to 
the rear of the source clip.

m If you’re editing a clip into an empty area of the Timeline, both of the frames in the two-
up display are black no matter what kind of edit you’re making.

Note:  If the Caps Lock key is engaged, the two-up display is disabled.

The first frame of the sequence 
after your source clip.

The last frame of the sequence 
before your incoming clip.
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Adding Tracks to Your Sequence While Dragging

You can drag a source clip to the unused space above or below the current tracks to create a 
new track for that clip. If you drag your clip above the tracks already in the Timeline, you’ll 
create a new video track. If you drag your clips below the tracks in the Timeline, you’ll create 
a new audio track. 

Clips with both audio and video create both kinds of tracks by default, unless either the video or 
audio target tracks are disabled. In this case, dragging a clip to the remaining enabled target 
tracks results in only that part of the source media being edited into your sequence.

Dragging a clip to the 
unused space above the 
target track creates new 
video and audio tracks.

After edit
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How Target Tracks Modify Dragging Operations

If you edit your clip by dragging it to a track in the Timeline, it is placed on that track, even if 
the track is not the target track. However, any currently selected target tracks modify this in 
two ways:

m If the video target is deselected and you drag your clip to an audio track, no video is 
edited into your sequence. If the audio target tracks are deselected and you drag your clip 
to a video track, no audio is edited into your sequence. 

On the other hand, if you drag your clip to a video track, even if the video target is 
deselected, you will edit in both the audio and video of your clip. The same applies to audio.

m If you select nonadjacent audio and video target tracks, your source media will be edited 
in using the track separation defined by your targets, even though you may not be editing 
your media into the same tracks specified by your targets. 

For example, if V3 is the current video target, and A1 and A3 are the current audio 1 and 
audio 2 target tracks, a clip that you drag in will always have one empty track between the 
two source audio tracks, and will keep the offset between the video and audio tracks, 
even if you move the items to other tracks.

Dragging a clip to this track 
will edit in both audio and video.

Target track is 
not selected.
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Setting Up and Performing Split Edits
With a basic edit, the video and audio cut in and out at exactly the same time. While many 
times this works fine, sometimes you’ll want to set the In or Out point of your audio at a 
different spot from that of your video. When you do this, it’s called a split edit.

A split edit is any edit in which the In and Out points for the video and audio of a clip are in 
separate positions. A split edit is useful for editing clips with dialog, where the audio of an 
actor in a shot starts or ends at a different time from the corresponding video, or for 
introducing the sound of a new scene before cutting the picture away to it.

Ordinarily, when you assign In or Out points to a clip in the Viewer, the scrubber bar looks 
like this:

The audio and the video of the clip are cut together, coming in and going out at the same 
points. When you edit this clip into a sequence, the result looks like this:

The audio and video of the first shot end when the next shot begins. If this is what you want, 
then you’re done. On the other hand, setting up a split edit can produce a smoother cut, 
giving your video a more sophisticated feel. 

Out pointIn point

Audio and video come in and 
go out at the same points.
588 Chapter  14   



For example, let’s say you’re cutting back and forth between two people having a 
conversation—a man talking, cutting to a woman talking. You can cut in on the audio of the 
woman first, while we’re still seeing the visual of the man. We see his face responding to what 
she says for about two seconds during the overlap. Then, when we’re used to the sound of 
the woman’s voice, we cut to her visual as well, and at that point are experiencing both the 
video and audio of the second clip. When this sequence plays back, the audio will cut from 
him to her first, and then two seconds later the video will follow. This kind of edit looks like 
this in the Timeline:

Split edits can be used in many different situations–in dialog scenes, like the one described 
above, when cutting to B-roll, or when going from one scene to another, for example.

Setting Up a Split Edit

You can set up a split edit in three ways:

m Set up separate edit points for the video and audio tracks of a clip in the Viewer before 
editing this clip into your Timeline.

m Set up separate edit points for video and audio in the Canvas and Timeline. The rules of 
three-point editing also apply to split edits.

m Set up a split clip by disabling either the audio or the video target track in the Timeline, 
so you only add media on a particular track. This is useful if you want to edit in video with 
no accompanying audio, or vice versa.

Note:  You can also edit your clips in simply, with matching In and Out points, and then 
modify your edit in the Timeline later. 

Audio for Rob Dialog 2 comes 
in before video for the clip.
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When you set up a simple edit, as described earlier in this chapter, the edit points in either 
the Viewer or Canvas look like this:

The edit points for a split edit look much different. Notice that the scrubber bar in both the 
Viewer and the Canvas is divided in half by a light gray line. The upper half of the scrubber 
bar contains the video In and Out points, and the lower half contains the audio In and Out 
points. When you mark simple In and Out points, each pair of audio and video In and Out 
points joins to form small, inward-pointing triangles, as shown above. 

When you mark different video edit points from the audio points, the upper half of each 
triangle marks a video In or Out point, and the lower half marks the separate audio edit 
point, like this:

The light area between each set of edit points in the Viewer indicates what footage will be cut 
into your sequence. The light area between each set of edit points in the Canvas indicates the 
destination for the source clip.

To mark split edit points in either the Viewer or the Canvas:

1 Open a clip in the Viewer or select a sequence in the Canvas.

2 Move the playhead to the frame where you want to set the audio In point.

3 Set a separate audio In point by doing one of the following:

m Press Command-Option-I. ( You can do this while your clip or sequence is playing.)

m Choose Mark Split from the Mark menu, then choose Audio In from the submenu.

In point Out point

Area of audio 
included in edit

Audio In

Area of video 
included in editAudio In Video Out

Audio 
Out

Excluded area 
of clip
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m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
Audio In.

Your edit in the scrubber should look something like this:

4 Move the playhead to where you want the video to start.

5 Set a separate video In point by doing one of the following:

m Press Control-I. ( You can do this while your clip or sequence is playing.)

m Choose Mark Split from the Mark menu, then choose Video In from the submenu.

m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
Video In to mark a split edit point at the position of the Viewer playhead.

Your edit in the scrubber should now look like this:

6 If necessary, reposition the playhead where you want the video to end.

7 Set a separate video Out point by doing one of the following:

m Press Control-O. ( You can do this while your clip or sequence is playing.)

m Choose Mark Split from the Mark menu, then choose Video Out from the submenu.

m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
Video Out.

Your edit in the scrubber looks like this:

Audio In

Video In

Video Out
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8 Reposition the playhead where you want the audio to end.

9 Set a separate audio Out point by doing one of the following:

m Press Command-Option-O.

m Choose Mark Split from the Mark menu, then choose Audio Out from the submenu.

m Control-click in the scrubber bar, choose Mark Split from the shortcut menu, then choose 
Audio Out.

Here is the final result as seen in the Viewer (the Canvas would look the same). The video In 
and Out points are separate from the audio In and Out points.

You can mix and match simple edit points with split edit points, depending on what kinds of 
edit you want to do. In fact, it’s very common to first mark a simple edit point, then change it 
to a split edit while your clip or sequence is still playing.

To change a simple edit to a split edit while playing:

1 Open a clip in the Viewer or select a sequence in the Canvas.

2 Play your media. 

3 At the frame where you want either your video or audio to start, press I to mark a simple 
In point.

A split edit
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4 As your media continues playing, do one of the following:

m To mark a split video In point later than the audio In point, press Control-I.

m To mark a split audio In point later than the video In point, press Command-Option-I.

5 As your media continues playing, mark a simple Out point at the desired point by pressing 
the O key.

6 If you want to mark an additional split edit at the end of your media, let playback continue 
and do one of the following:

m To mark a split video Out point, press Control-O.

m To mark a split audio Out point, press Command-Option-O.

7 Stop playback by pressing either the Space bar or the K key.

You can also set audio edit points in the Audio tab of the Viewer. For more information, see 
Chapter 17, “Working With Audio,” on page 727.

Modifying and Clearing Split Edits

If you’ve set up a split edit, but you want to adjust or remove any of the edit points, you have 
a number of options.

To move either the In or the Out points of a split edit at the same time:

m Drag either the video or audio In or Out point to a new position. 

By default, the video or audio edit points move together.

Drag either point
to a new location.
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To move either an audio or video split point individually:

m Option-drag just the split edit point you want to move.

That point will move independently of the others.

To move all split edit points at once:

m Shift-drag any of the edit points.

m Select the Slip Item tool in the Tool palette, then drag any of the edit points.

The positions of the different edit points you’ve selected don’t change relative to one 
another, but the selected area of your clip or sequence does. As it changes, you’ll see the 
first selected frame of video updated in the Viewer, and the last frame of video updated in 
the Canvas.

As you drag, a small box 
shows the number of frames 
between edit points.

The Viewer displays
the updated frame of

the In point with the
new timecode.

The Canvas displays 
the new Out point.
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To remove one or more split edit points:

m To clear both of your split In points, press Option-I.

m To clear both of your split Out points, press Option-O.

m Choose Clear Split from the Mark menu, then choose the edit points you want to remove 
from the submenu.

m Drag a split edit point up or down out of the scrubber bar until it disappears, then release 
the mouse button.

m Control-click the split edit point, choose Clear Split from the shortcut menu, then choose 
the edit point you want to remove from the submenu.

Performing a Split Edit

Once you’ve marked your split edit points, you can perform your edit. To do a split edit, 
you’ll use an overwrite edit or drag directly into the Timeline. 

The results of your split edit depend, like any other edit in Final Cut Pro, on which edit 
points you set in the Viewer and in the Canvas and Timeline. This section describes all the 
combinations of simple and split edit points you might set up, along with their results.

A split edit in the Viewer and a simple edit point in the Canvas:

If you mark a split edit in the Viewer and a simple edit point in the Canvas or Timeline (or if 
you simply use the position of the Canvas playhead), Final Cut Pro lines up the earliest audio 
or video split edit point marked in the Viewer (whichever appears first) with the 
corresponding media at the In point you’ve marked in the Canvas or Timeline.
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1 Mark a split edit in the Viewer, with the audio In point preceding the video In point.

2 Mark any Out point in the clip in the Viewer. 

The resulting edit points look something like this:

3 Mark a simple In point in the Canvas or Timeline at the place where you want the audio of 
your source clip to start.

4 Drag the clip in the Viewer to the Overwrite section of the Edit Overlay in the Canvas.

In point
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The resulting edit looks like this:

A split edit in the Viewer and a single split edit point in the Canvas:

If you mark a split edit in the Viewer and a single split edit point in the Canvas or Timeline, 
Final Cut Pro matches the appropriate split edit point in the Timeline to the corresponding 
audio or video split edit point in the Viewer; audio to audio, or video to video. The other, 
overlapping media extends before or after this edit point as necessary. This method can be 
used to backtime a split edit, as well.

1 Mark a split edit in the Viewer, with the audio In point preceding the video In point.

2 Mark any Out point in your clip in the Viewer. 

The resulting edit points look something like this:

Audio precedes the video 
of the Rob Dialog clip.
  Basic Editing 597



3 Mark a single split video In point in the Canvas or Timeline at the place where you want the 
video of your source clip to start.

4 Drag the clip in the Viewer to the Overwrite section of the Edit Overlay in the Canvas.

The resulting edit looks like this:

A simple edit in the Viewer and a split edit in the Canvas:

If you mark a simple edit in the Viewer and a split edit in the Canvas or Timeline, Final Cut 
Pro lines up the media at the In point in the Viewer with the corresponding split audio or 
split video In point that you marked in the Canvas or Timeline. This method can be used to 
backtime a split edit, as well.

1 Mark an In point in the Viewer.

2 Mark any Out point in your clip in the Viewer. 

Split video In point

Audio precedes the video.

Video begins at the In 
point you marked.
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The resulting edit points look something like this:

3 Mark a split edit in the Canvas or Timeline at the place where you want your source clip 
to appear.

4 Drag the clip in the Viewer to the Overwrite section of the Edit Overlay in the Canvas.

The resulting edit looks like this:

Split edit with 
audio preceding 
video

Audio precedes the 
video.
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Locating a Match Frame
You use the Match Frame command in the Canvas to put a copy of the clip at the current 
position of the playhead in your sequence into the Viewer. This is a temporary duplicate; 
changing it doesn’t affect the sequence clip from which it came, nor does it add any duplicate 
clips to the Browser. 

When you use the Match Frame command to copy a clip in your sequence into the Viewer, 
two things happen:

m The playhead position in the Viewer matches that of the playhead in the Canvas, so both 
the Canvas and the Viewer display the same frame. 

m The In and Out points of the clip in your sequence will be matched to those of the copy 
in the Viewer. All the original source material for this clip will also be displayed.

Match frame editing can be useful if you need to quickly reedit a clip that’s already been 
edited into your sequence, or if you need to quickly access a sequence clip’s source media to 
edit in an unused portion of the clip without opening it from the Browser.

To open a copy of a sequence clip in the Viewer using the Match Frame 
command:

1 Position the playhead in the Canvas or Timeline on the clip you want to copy into the Viewer, 
at the specific frame that you want to locate.

Move the playhead 
to the frame you 
want to match.
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2 Make sure the track that contains the clip you want to copy is the target track.

3 Do one of the following:

m Choose Go To from the Mark menu, then choose Match Frame from the submenu.

m Click the Match Frame button in the Canvas.

m Press F.

A copy of your sequence clip opens in the Viewer. Notice that there are no “sprocket holes” 
in the scrubber bar. This is because you’re seeing a duplicate of the sequence clip, not the 
sequence clip itself. The duplicate has the same In and Out points as the sequence clip, and 
the playhead is at the same frame you chose in your sequence. 

Note:  If you press Shift-F instead, you’ll open a copy of the sequence clip in the Viewer 
without the edit points set.

The current frame in the 
Viewer matches the 
frame in the Canvas.
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Removing Clips From a Sequence
A chapter on basic editing wouldn’t be complete if you hadn’t also learned how to remove 
the clips that you edit into your sequence. As you edit, you can remove items from your 
sequence at any time, provided that the track you want to remove them from is not locked. 

There are two ways you can remove items from a sequence:

m Lift delete:  Removes any selected items from the sequence and leaves a gap.

A lift delete is useful if you have a series of clips already edited into your sequence and 
you don’t want to move them (for example, if they’re all synchronized to a piece of 
music). If you want to remove one or more clips from the middle of such a sequence, the 
lift delete is the best way to do so.

m Ripple delete:  Removes selected items from the sequence and closes the resulting gap by 
moving all items on unlocked tracks to the left.

A ripple delete is useful if you want to remove one or more clips from your edit but you 
don’t want to leave a gap. For example, if you’re assembling a rough cut, and you decide 
that there’s a clip you don’t need in the middle, doing a ripple delete will remove it and 
move all the later clips in your sequence to the left to fill the gap.

Note:  For more detailed information about ripple edits, see “Doing Ripple Edits” on 
page 681.

To perform a lift delete:

1 Do one of the following:

m Select the clip or range of clips you want to remove using one of the selection tools.

m Set In and Out points in the Canvas or Timeline.

2 Do one of the following:

m Press Delete.

Important  Removing clips from a sequence does not delete the original master clips from 
the Browser, nor does it delete source media from your hard disk.

A B C

A C

Before edit

After edit

Gap

Selected clip

A B C

A C

Before edit

After edit
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m Press Command-X to cut the material (if you want to paste it somewhere else).

m Choose Lift from the Sequence menu.

The result looks something like this:

To perform a ripple delete:

1 Select the clip or range of clips you want to remove.

2 Do one of the following:

m Press Shift-Delete.

m Press Shift-X to cut the material (if you want to paste it somewhere else).

m Choose Ripple Delete from the Sequence menu.

m Control-click the selected clip or clips, then choose Ripple Delete from the shortcut menu.

The end result looks something like this:

A lift edit leaves a gap 
in the sequence.

A ripple delete removes the 
selected clip or clips, leaving 
no gap in the sequence.
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15 Adding and Editing Transition Effects

The most common way to move from one clip to the next in an edited program is to make a 
“cut.” A cut is a simple transition from one shot to the next.

Nearly all of the edits described in Chapter 14, “Basic Editing,” are performed using cuts. It’s 
fair to say that most edited programs rely upon cuts to go from one clip to the next in most 
scenes. Still, there’s a proper place for a well-timed transition, and there’s more to life than 
cuts-only editing.

The simplest transition 
is a cut.
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Using Transitions in Your Sequences
A transition is a visual effect used to change from one clip in your edited sequence to the 
next. Most movies and TV shows use two types of transitions. The most common is the 
dissolve, where one shot gently fades into the next. The second most common is the wipe, 
where the screen splits, moving from one side of the image to the other to gradually reveal 
the next shot. 

Final Cut Pro comes with a variety of transitions you can use in your programs, but you’ll 
probably use dissolves and wipes more than any others. For more information, see “Video 
Transitions That Come With Final Cut Pro” on page 646.

If cuts are the “glue” that holds the individual clips of a scene together, transitions are the 
devices that take us from one scene to the next. A cut registers immediacy, usually leading 
the viewer to believe that the next shot happens immediately after the previous one. 
Transitions, especially dissolves, generally give the viewer an impression of a change in time 
or location. When very long transitions are used, they become more of a special effect, useful 
in creating a different atmosphere in your sequence.

About Adding Transitions

Transitions are applied between two adjacent clips in the same track of a sequence in the 
Timeline. To be able to apply a transition, these two clips must have unused frames that 
overlap past the edit point. A transition is displayed as an overlay on top of the edit point 
between the two clips.

A transition between 
two clips
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By default, transitions have a total duration of one second. To change this, see “Making 
Precise Adjustments to Transitions” on page 622 or “Modifying the Default Transition” on 
page 642. A dark gray slope in the transition’s icon in your sequence indicates the speed, 
alignment, and direction of your transition.

You can add transitions to your edited sequence in two ways:  use a transition edit type, or 
add a transition to clips that have already been edited into a sequence in the Timeline.

Using a Transition Edit to Add a Transition

You can choose the insert with transition or overwrite with transition edit when you edit a 
clip into your sequence. This adds a transition at the In point of the incoming clip and the 
Out point of the outgoing clip. The default transition, a one-second cross dissolve, is used 
unless another transition is chosen as the default. 

For more information on performing edits with transitions, see “Performing an Insert With 
Transition Edit” on page 567 and “Performing an Overwrite With Transition Edit” on 
page 571. To change the transition used for the overwrite and insert transition edits, see 
“Modifying the Default Transition” on page 642. 

The gray slope provides visual 
information about the transition.
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Adding a Transition in the Timeline

You can also add transitions to clips in the Timeline after they’ve been edited into a 
sequence. You can place a transition so that it’s centered at the cut (or edit point), starts 
before the cut, or starts after the cut. 

A transition ending before the cut

A transition centered at the cut

A transition starting after the cut
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Transitions Need Overlapping Frames at an Edit Point

To apply a transition between two clips in the Timeline, you must have enough overlapping 
frames between the clips to cover the duration of your transition. 

For example, in the illustration below, the outgoing and incoming clips both have more than 
1 second of overlap. 

In this case, you can choose to add a one-second transition at, before, or after the cut. 
There’s enough room to accommodate all three placements of your transition.

If one clip or both clips have overlapping frames, but not enough for the entire duration of 
the transition, Final Cut Pro shortens the transition that’s added. The duration changes to fit 
that of the available frames. 

For example, if you have a one-second overlap to the left of the edit point, but only seven 
frames of overlap to the right, like this:

In this case, you will get three different results, based on where you add your transition:

m If you add a transition before the edit point, you can add a full one-second transition. 

m If you add a transition at the edit point, it will be shortened to a total duration of fourteen 
frames. The length of each half of a transition placed at the edit point is based on the side 
of the edit point with the least amount of overlap. 

m If you add a transition after the edit point, its total duration will be limited to seven frames.

Outgoing overlap

Incoming overlap

Outgoing clip Incoming clip

Outgoing overlap

Incoming overlap

Incoming clipOutgoing clip
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If one side or the other lacks overlapping frames completely, you can only place a transition 
on the side of the edit point that has the overlapping frames. In the illustration below, you 
can only add the transition before the edit point.

If there is no overlap at all (for example, if you’ve edited two clips into your sequence in their 
entirety), you can’t apply the transition. If you’re trying to perform an Insert or Overwrite 
with Transition edit, a message says “Insufficient content for edit.” To add a transition, you 
need to add more overlapping frames or change the duration of the transition to 
accommodate the available frames.

Incoming clip
Outgoing clip

Incoming overlap

Using Transitions in Projects to Be Exported as EDLs

Edit Decision Lists (EDLs) were developed for older tape-to-tape editing systems with 
limited capabilities. Therefore, they can only describe a narrow range of transitions. 
Typically, these transitions match standard transitions found on most broadcast video 
switchers, designated by codes that have been standardized by the Society of Motion 
Picture and Television Engineers (SMPTE). 

Although today’s nonlinear editing systems have introduced a much wider variety of 
transitions and effects, the EDL format continues to reflect the simplicity of older 
systems. As a result, not everything that you can do in a Final Cut Pro sequence will 
show up as expected in an exported EDL.

Keep the following in mind when creating a sequence that you may export as an EDL:

m EDLs don’t support transitions in any tracks other than V1. If you use transitions in 
other tracks, they won’t appear in the EDL.

m Anything other than a cross dissolve or simple wipe is mapped to the closest 
approximate SMPTE standard wipe pattern.

For more information on EDLs, see Chapter 29, “Working With Edit Decision Lists 
(EDLs) and Batch Lists,” on page 1191.

Incoming clipOutgoing clip
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Adding Transitions
There are several ways to add a transition between two clips in your sequence. To learn the 
specific steps for each method, see the next few sections.

m Select a video edit point, then press Command-T (adds the default video transition).

m Select an audio edit point, then press Command-Option-T (adds the default audio 
transition).

m Control-click an edit point, then choose the default transition from the shortcut menu.

m Select an edit point in your sequence in the Timeline, then choose Video Transitions or 
Audio Transitions from the Effects menu. For video transitions, choose the desired 
transition from a submenu.

m Drag a transition from the Effects tab in the Browser to an edit point in the Timeline.

m Copy and paste a transition from another edit point.

m Drag a transition already in your sequence in the Timeline to another edit point.

m Select an edit point in your sequence in the Timeline, and drag a transition from the 
Effects tab in the Browser to the Canvas.

Adding the Default Transition

You can quickly add the default transition between two clips in your sequence. (To change 
the default transition, see “Modifying the Default Transition” on page 642.)

To add the default video transition:

m Select an edit point between two video clips or position the Canvas or Timeline playhead 
at the desired edit point, then press Command-T.

m Control-click an edit point between two video clips in the Timeline, then choose Add 
Transition from the shortcut menu.

If there are enough overlapping frames on both sides of the edit point, the selected 
transition is added to your edit, centered at the edit point.

The shortcut menu shows the name of 
the current default video transition.
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To add the default audio transition:

m Select an edit point between two audio clips or position the Canvas or Timeline playhead 
at the desired edit point, then press Command-Option-T.

m Control-click an edit point between two audio clips in the Timeline, then choose Add 
Transition from the shortcut menu.

Final Cut Pro comes with two audio transitions:  a –3 dB cross fade (the default) and a 0 dB 
cross fade. You can use short cross fades to make audio cuts less noticeable. For more 
information on using cross fades while editing audio, see “Using Audio Transitions” on 
page 775.

Adding Any Type of Transition

You can add any type of transition, whether or not it’s the default transition, using the Effects 
menu or Effects tab in the Browser. 

To add a transition from the Effects menu:

1 Do one of the following:

m Click an edit point between two clips in your sequence to select it.

m Position the Canvas or Timeline playhead at the desired edit point or on a transition that’s 
already been edited into your sequence.

The shortcut menu shows the name of 
the current default audio transition.

Select an edit point where you want to 
add a transition.
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2 Do one of the following:

m To add a video transition:  Choose Video Transitions from the Effects menu, then choose 
the desired transition from a submenu. 

m To add an audio transition:  Choose Audio Transitions from the Effects menu, then 
choose the desired transition.

If there are enough overlapping frames on both sides of the edit point, the selected 
transition is added to your edit, centered at the edit point.

Note:  All of the transitions that shipped with Final Cut Pro will be centered at the edit point 
if applied from the Effects menu. If you instead add a favorite transition that you’ve 
customized to appear either before or after the edit point, than that’s what will happen, 
provided there’s enough overlap at the selected edit point.

Submenus show 
the categories of 
video effects.
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To add a transition from the Effects tab in the Browser:

m Drag a transition from the Effects tab in the Browser to an edit point in the Timeline.

Depending on the number of overlapping frames between the two clips, you can drag the 
transition to the start, center, or end of an edit point. 

A transition ending before the cut

A transition centered at the cut

A transition starting after the cut
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Transitioning To or From Black

You can strategically place transitions in your sequence if you want to transition to or from 
black in your edit, such as fading in or fading out to black. This is most often done with a 
cross dissolve, but you can use any transition. 

Note:  Any clips before a fade in from black end with a cut. Any clips following a fade to black 
begin with a cut.

To transition to or from black:

m Add the desired transition to one of the following:

m the beginning of the first clip in your sequence

m the end of the last clip in your sequence

m an isolated clip with empty frames to the left or right of it 

For more information, see “Adding the Default Transition” on page 611 or “Adding Any 
Type of Transition” on page 612.

m Press and hold the Command key as you drag the desired transition from the Effects tab 
in the Browser to an edit point between two clips in the Timeline. 

This lets you add the transition only at the start or end of the edit point.

If a transition is placed 
before the edit point, you’ll 
see a transition from black.

If placed after the
edit point, you’ll see
a transition to black.
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Moving, Copying, and Deleting Transitions
After you add a transition, you can move it or change its edit point. You can also copy 
transitions to quickly add the same transition at another point in your sequence (then modify 
its properties later, if desired). You can also delete the transition.

Replacing a Transition 

You can replace, or swap, a transition that you’ve already added to a sequence with a new 
transition. By default, the replacement transition uses the previous transition’s duration 
and alignment.

To replace a transition in your sequence:

m Click to select the transition you want to replace or position the Timeline playhead on the 
transition. Choose Video Transition from the Effects menu, then choose the new 
transition from a submenu.

m Drag a transition from the Effects tab in the Browser to the transition you want to change 
in the Timeline. 

Note:  If you replace a transition in your sequence with a favorite transition, the duration of 
the favorite transition is used instead of the duration of the replaced transition.

Drag the new transition to the 
transition you want to replace.
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Moving a Transition

You can move a transition from one edit point to another. The transition is removed from the 
previous edit point and located at the new edit point. If there is a transition at the new edit 
point, it’s replaced by the new transition.

To move a transition in a sequence:

m In the Timeline, drag a transition from its current edit point to the desired edit point. 

If there are enough overlapping frames on either side of the edit, you can drag it before 
the edit point, on the edit point, or after the edit point.

Changing the Edit Point After Adding a Transition

If you perform a ripple, roll, extend, or trim edit to modify the edit point between two clips 
that have a transition, the edit point moves, but the transition’s relationship to the edit point 
remains the same. (For more information on these types of edits, see Chapter 16, “Advanced 
Editing and Trimming Techniques,” on page 653.)

Applying a transition to these types of edits doesn’t change the way these edit tools work. 
However, the duration of the transition shortens the outer boundaries by which an edit point 
can be extended. 

Note:  You cannot extend an edit beyond the number of overlapping frames needed by a 
currently applied transition.

Drag a transition to the new edit point.

Before a roll edit

After a roll edit with the 
transition moved
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Copying and Deleting Transitions

To add the same transition quickly elsewhere within your sequence, you can copy and paste a 
transition to other edit points. This is helpful if you’ve changed a transition’s default settings 
and want to use the modified transition again. ( You can also make frequently used transitions 
“favorites.” For more information, see “Creating Favorite Transitions” on page 637.) 
Transitions that you’ve added to your sequence can easily be removed.

To copy a transition from one edit point to another:

1 Do one of the following:

m In the Timeline, select the transition you want to copy, then press Command-C.

m Control-click the transition, then choose Copy from the shortcut menu.

2 Control-click the edit point where you want to add this transition, then choose Paste from 
the shortcut menu.

To copy a transition by dragging it:

m Hold down the Option key while dragging an existing transition to another edit point.

To delete a transition from a sequence:

m Select the transition you want to remove in the Timeline, then do one of the following:

m Press Delete.

m Choose Clear from the Edit menu.

m Control-click the transition, then choose Cut from the shortcut menu.
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Modifying Transitions in the Timeline
You can perform some simple trimming operations on transitions in the Timeline to make 
them longer or shorter or to realign them in relation to their edit point. To make very precise 
adjustments to transitions, you can use the Transition Editor (see “Making Precise 
Adjustments to Transitions” on page 622).

Changing the Duration of a Transition in the Timeline

You can change the duration of a transition in the Timeline. How the duration will change 
depends on the alignment of the transition. 

m If the transition occurs before the edit point, the duration affects the clip to the left of this 
point, or the outgoing clip.

m If the transition is centered on the edit point, changes in duration extend in both directions.

m If the transition occurs after the edit point, the duration affects the clip to the right of this 
point, or the incoming clip.

To graphically change a transition’s duration in the Timeline:

1 Choose the Selection tool, then move the pointer to the beginning or the end of the 
transition in the Timeline. 

2 Drag the transition’s edit point to the desired duration.

Drag the Resize pointer to 
the duration you want.
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To numerically change the duration of a video transition in a sequence:

1 Control-click the video transition, then choose Duration from the shortcut menu. 

2 In the Duration dialog box, enter a new duration for the transition, then click OK. 

If you enter a duration that’s longer than the available amount of overlap between these two 
clips, you hear an alert sound and the maximum duration possible is displayed in the dialog 
box. You can change the duration or click OK to use the maximum duration.

To change the duration of an audio transition in a sequence:

1 Do one of the following:

m Double-click the audio transition.

m Control-click the audio transition, then choose Duration from the shortcut menu. 

2 In the Duration dialog box, enter a new duration for the transition, then click OK. 

If you enter a duration that’s longer than the available amount of overlap between these two 
clips, you hear an alert sound and the maximum duration possible is displayed in the dialog 
box. You can change the duration or click OK to use the maximum duration.

This menu shows the 
current timecode duration 
of this transition.

Enter the desired 
duration here.

This shows the current 
timecode duration of 
this transition.

Enter the desired 
duration here.
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Changing the Alignment of a Transition in the Timeline

To change the alignment of a transition in a sequence:

m In the Timeline, select the transition, choose Transition Alignment from the Sequence 
menu, then choose another alignment from the submenu.

m Control-click a transition, then choose another alignment from the shortcut menu.

m Select a transition, then do one of the following:

m To start the transition on the edit point:  Press Option-1.

m To center the transition on the edit point:  Press Option-2.

m To end the transition on the edit point:  Press Option-3.

The transition moves to the new alignment position.

A transition centered on the cut

A transition starting at the cut

A transition ending at the cut
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Making Precise Adjustments to Transitions
If you need to make more precise changes to a transition than editing in the Timeline allows 
or if you want to create custom settings for transitions that you use frequently, you can use 
the Transition Editor. 

The Transition Editor allows you to

m change the duration of a transition

m adjust the alignment of a transition

m trim the edit point between the two clips adjacent to the transition

m ripple edit each clip to either side of a transition’s edit point

m adjust the percentage of completion of a transition at its start and end points

m reverse the direction of a transition

m modify custom settings for a transition
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Controls in the Transition Editor

When you double-click a transition in the Timeline or the Effects tab of the Browser, a special 
tab for the transition opens in the Viewer. This Transition Editor window indicates the 
transition is “loaded,” or opened, so you can view and modify the transition’s settings.

The following is a list of all property and edit point controls common to all transitions.

Tab with the name
of the transition

Start slider
(with percentage

the right)

Effects
(specificto

each transition)

Current duration

Drag hand

End slider (with 
percentage to the right)

Reset button

Alignment buttons
Recent Clips 
pop-up menu

Reverse Transition 
button
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Duration Field

This timecode field displays the current duration of your transition. Changing the value in 
this field shortens or lengthens your duration up to the maximum amount of overlapping 
frames available at the edit point. (To change the duration in the Timeline, see “Changing the 
Duration of a Transition in the Timeline” on page 619.)

How the duration will change depends on the alignment of the transition. If the transition 
occurs before the edit point, the duration affects the clip to the left of this point, or the 
outgoing clip. If the transition is centered on the edit point, changes in duration extend in 
both directions. If the transition occurs after the edit point, the duration affects the clip to 
the right of this point, or the incoming clip.

Alignment Buttons

The selected button indicates the current alignment of your transition. You can change the 
alignment of a transition by clicking a button (if there are enough overlapping frames in the 
direction in which you want to realign the transition).

Recent Clips Pop-up Menu

This control lets you choose from a list of recently used clips. A clip is added to this list when 
another clip replaces this clip in the Viewer (not when the clip is opened in the Viewer). The 
last clip that was replaced in the Viewer appears at the top of the list. 

By default, the maximum number of clips shown in this list is 10; you can change this 
number in the General tab of the Preferences window (see “Setting General Preferences” on 
page 885). Once the maximum number of entries is reached, a clip is removed from the 
bottom of the list each time another clip is replaced in the Viewer. 
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Drag Handle

If you want to apply the current transition to another edit point in your sequence in the 
Timeline, you can drag this to the desired location in your sequence. This is true for 
transitions opened from the Browser and from a sequence in the Timeline.

Ruler

The ruler displays a closeup view of the frames surrounding the transition in your sequence. 
The ruler and playhead in the Transition Editor are locked to those in the Timeline. The scale 
of the ruler can be changed by using the Zoom In and Zoom Out tools or pressing 
Command-+ (plus) or Command-– (minus).

Outgoing and Incoming Clip Handles

A transition that appears as two overlapping clips on the same track in the Timeline is 
represented differently in the Transition Editor. The outgoing clip and its Out point appear 
on a top track, the incoming clip and its In point appear on a bottom track, and the transition 
itself appears on a track between the two. 

Both the Out point of the outgoing clip and the In point of the incoming clip are handles 
that you can drag to perform ripple edits, modifying the edit points of these clips in your 
sequence in the Timeline. (A ripple edit adjusts the length of a clip by changing the In or Out 
point of the clip. Ripple edits do not cause gaps in your edited sequence.) For more 
information, see “Doing a Ripple Edit to Adjust the Length of Clips in a Transition” on 
page 635.
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Transition Bar With Start, Stop, and Edit Handles

The transition appears as a bar with start and end points that you can drag. Depending on 
the alignment of your transition, the edit point appears to the right, in the center, or to the 
left of this bar. 

Dragging the transition bar from the middle results in a roll edit, which moves the edit point 
between two clips in a sequence. (A roll edit adjusts the location of an edit shared by two 
clips; the Out point of the first clip and the In point of the second clip are moved 
simultaneously, or rolled. This changes the location of the edit in the sequence, as well as the 
duration of each clip.) For more information, see “Doing a Roll Edit to Change the Location 
of a Transition” on page 634.

Dragging either of the transition edges results in a resize edit, resizing the clip by moving its 
In or Out point. This lets you change the duration of the transition, depending on how much 
clip overlap is available. For more information, see “Doing a Resize Edit to Change the 
Duration of a Transition” on page 634.

Start and End Percentages of Transition

These sliders allow you to set the starting and ending percentages of the transition’s visual effect. 
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For example, if you are using an edge wipe, the default starting percentage of 0% places the 
border of the wipe all the way to the left of the image, essentially revealing all of the outgoing 
clip. Halfway through the wipe, at the edit point, the wipe is at 50%, placing the border of the 
wipe in the middle of the picture. You can now see half of the incoming clip to the left and 
half of the outgoing clip to the right. At the end of the edit with the transition finished and 
the default ending percentage of 100%, the border of the wipe is all the way to the right, 
revealing the entire incoming clip. 

The start of an edge 
wipe transition

The middle of an edge 
wipe transition

The end of an edge 
wipe transition
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You can change the starting and ending percentages for the transition. For example, you can 
set both the starting and ending percentages to 50%. At the start of the transition, a split 
screen effect is created; half of the outgoing clip and half of the incoming clip are revealed 
simultaneously and throughout the duration of the transition. At the end of the transition, 
the image becomes the full screen picture of the incoming clip.

This is an excellent way of creating split screen effects if you plan to export your sequence as 
an EDL for import into another editing system. For more information on exporting EDLs, see 
Chapter 29, “Working With Edit Decision Lists (EDLs) and Batch Lists,” on page 1191.

The start of the transition 
in the Canvas

The start of an edge wipe 
transition, where the start 
percentage is 50%

The end of the transition 
in the Canvas

The end of an edge wipe
transition, where the end

percentage is 50%
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Reverse Transition Button

Some transition effects have a default direction. For example, a wipe goes from the left to the 
right, a clock wipe’s border travels in a clockwise direction, and the spin 3D transition spins 
the outgoing clip out to the right. 

To reverse the direction of an effect, click the Reverse Transition button. If you reverse the 
direction for the above examples, the wipe moves from right to left, the clock wipe moves in a 
counter-clockwise direction, and the spin 3D transition spins the incoming clip in to the left.

Reset Button

Click this to reset all of a transition’s properties to the default settings (those installed with 
Final Cut Pro).

Custom Settings

Many transitions have additional settings that you can use to further customize their effect. 
These settings appear below the controls for the above properties and may include such 
visual effects as the center point of the effect, the width of the transition border, and the 
color and feathering of this border. More complex transitions have more elaborate effects.
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Displaying Clips in the Transition Editor

The way clips are displayed in the Transition Editor depends on the current thumbnail 
displays setting for the sequence. (For information on changing this display in the sequence 
settings, see “Timeline Options Settings in the Sequence Settings Window” on page 409.)

You can also zoom in or out of the time scale displayed in the Transition Editor.

To zoom in on the time scale in the Transition Editor:

m Click the Transition Editor to make it active, then choose Zoom In from the View menu.

m Select the Zoom In tool, then click the time scale.

m Press Command-+(plus).

To zoom out of the time scale in the Transition Editor:

m Click the Transition Editor to make it active, then choose Zoom Out from the View menu.

m Select the Zoom Out tool, then click the time scale.

m Press Command-–(minus).

To zoom to fit the time scale in the Transition Editor:

m Press Shift-Z.

This zooms the time scale to a medium size in the Transition Editor.

This display option affects 
how you view clips in the 
Transition Editor.
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Opening and Modifying Transitions in the Transition Editor

When you open a transition from your sequence in the Timeline in the Transition Editor, you 
can modify and trim it much more precisely than you can in the Timeline. All the transitions 
that come with Final Cut Pro are different, but all of them share some essential properties 
and edit points that you can modify in the Transition Editor. 

m If you open a transition from a sequence in the Timeline:  Changes you make 
immediately alter that transition in your edited sequence. 

m If you open a transition from the Effects tab of the Browser:  This opens a copy of the 
transition. Changes you make have no effect until you apply the modified transition to an 
edit point in the Timeline or save the transition as a favorite. 

To open a transition from the Timeline:

m Double-click the transition.

m Control-click the transition, then choose Open from the shortcut menu.

m Select the transition’s icon, then choose Transition Editor from the View menu.

To open a copy of a transition from the Effects tab in the Browser:

m Double-click a transition in the Effects tab of the Browser.

m Select a transition in the Effects tab, then press Return.

m In the Browser, Control-click the transition, then choose Open from the shortcut menu.

This opens a copy of the transition. If you change settings and want to use the changed 
version, you need to save it as a favorite (see “Creating Favorite Transitions” on page 637) 
or apply it directly to an edit point in the Timeline by dragging its drag hand to an 
edit point. For more information, see the next section, “Applying a Modified Transition 
Directly to a Sequence in the Timeline.”

Applying a Modified Transition Directly to a Sequence 
in the Timeline

After you modify a transition’s settings in the Transition Editor, you can apply it directly to 
two clips in the Timeline. If you do this, the modified transition is only saved in the Timeline. 
To use this transition again, make it a favorite (see “Creating Favorite Transitions” on 
page 637) or copy it (see “Copying and Deleting Transitions” on page 618).
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To apply a modified transition directly to your sequence in the Timeline:

m Drag the transition’s drag hand to an edit point in the Timeline.

Trimming Transitions and the Surrounding Clips

Trimming is the process of modifying the edit points of clips that are already in your 
sequence. After you’ve opened a transition in your sequence in the Transition Editor, you can 
fine-tune your edit. This is done using the handles on the Out point of the outgoing clip and 
the In point of the incoming clip that meet to form your transition’s edit point, as well as 
those on the transition bar. 

Changes you make to a transition in the Transition Editor (if it’s opened from the sequence 
and not the Browser) immediately affect this transition in your sequence.

Drag the hand from the
Transition Editor to an edit

point in your sequence.

Out point of the 
outgoing clipTransition start point

Transition end point

Edit pointIn point of the
incoming clip

Green indicates there
is available overlap.

Purple indicates there
is no more available

overlap.
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About the Two-Up Display in the Canvas

You can drag the pointer in the Transition Editor to trim the transition and change the 
duration of the transition or the actual location, or edit point, where the transition occurs 
between two clips. When you do this, a dual frame display appears in the Canvas to show 
how your change affects the clips surrounding this transition. 

m The frame on the left:  This displays the current frame at the transition’s start point in the 
outgoing clip. 

m The frame on the right:  This displays the current frame at the transition’s end point in the 
incoming clip. 

The name of each clip is at the top of each display and the timecode for the Out point and In 
point for these frames is visible at the bottom of each display.

The start point of the
transition in the

outgoing clip.

The end point of the 
transition in the 
incoming clip.
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Doing a Resize Edit to Change the Duration of a Transition

When you move the pointer to either edge of a transition in the Transition Editor, it changes 
to a Resize pointer. You can then change the duration of the transition, depending on how 
much clip overlap is available. ( You actually perform a resize edit to one side of the clip, 
moving its In or Out point.)

To change the duration of a transition:

1 Open the transition in the Transition Editor.

2 Do one of the following:

m Enter a new duration in the Timecode Duration field, then press Return.

m Drag the beginning or end of the transition to the desired length. When you do this to a 
transition centered at the edit point, both sides of the transition change duration, but the 
edit point itself doesn’t move.

Doing a Roll Edit to Change the Location of a Transition

If you move the pointer over the middle of a transition in the Transition Editor, it changes to 
the Roll Edit tool. You can then move the entire transition to the left or to the right 
(performing a roll edit for the duration of the transition), as long as there is available overlap 
between the outgoing and incoming clips.

Drag either end of the transition 
to the desired length.
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To do a roll edit, changing the location of a transition:

1 Open the transition in the Transition Editor.

2 Place the pointer anywhere on the transition.

3 When the pointer changes to the Roll Edit tool, drag the transition in the edit to the 
desired frames.

Doing a Ripple Edit to Adjust the Length of Clips in a Transition

You can drag the Out point of the outgoing clip and the In point of the incoming clip to 
perform ripple edits, modifying the edit points of these two clips in your sequence. Ripple 
edits do not cause gaps in your edited sequence.

m Performing a ripple edit to the Out point of the outgoing clip:  This moves the transition 
and the edit point at the same time so that the outgoing clip is shortened or extended. 
The rest of your edited sequence moves forward or back to accommodate this change.

m Performing a ripple edit to the In point of the incoming clip:  This has no effect on the 
location of the edit point or the transition, but shortens or lengthens the incoming clip. 
All following clips are moved to the left or right so that there is no resulting gap.

Using the Roll Edit tool,
drag the transition to the

desired location in the clip.

Check the two-up display in the 
Canvas to help you determine 
where to place the transition.
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When you perform a ripple edit to the outgoing or incoming clip, the Canvas shows the 
current frame of the edit point you’re dragging, along with the clip’s name and the current 
timecode value of the clip in a single frame display. A tooltip is displayed at the location of 
the pointer in the Transition Editor to show the offset between the new edit point you’re 
selecting and the original edit point.

To do a ripple edit, adjusting the length of the transition:

1 Open the transition in the Transition Editor.

2 Place the pointer at the Out point of the outgoing clip or at the In point of the incoming clip.

3 When the pointer changes to the Ripple Edit tool, drag the edit point to another frame in 
your clip.

When you do a ripple edit, a tooltip 
shows the offset between the new 
and old edit points.

In the Canvas, the frame of 
the new edit point is shown.
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Creating Favorite Transitions
Each transition that comes with Final Cut Pro has its own default settings. You can modify 
settings for a transition after you’ve edited it into your sequence. If you frequently use a 
particular transition with specific settings, you can save it as a “favorite.” This lets you use the 
same transition again and again without recreating its settings. If you use one of your favorite 
transitions often, you can also select it as the default transition.

Favorite transitions are stored in the Favorites bin in the Effects tab of the Browser. You can 
also access these transitions by choosing Favorites from the Effects menu. You can organize 
transitions into bins within the Favorites bin. These bins appear as submenu items in the 
Favorites item in the Effects menu.

The Favorites bin holds
modified and frequently

used transitions and
can be organized with
bins, like the Browser.

Using Favorites to Store Transitions of Different Lengths

Many editors use a variety of frame durations as starting points for the transitions they 
add. You can do this by creating a series of favorites that are the same transition but 
with different durations, or lengths. To keep track of these modified transitions, you 
can rename each favorite to reflect its duration.
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Selecting Transitions to Be Favorites

You can create a favorite transition by modifying the settings for the transition from within 
the Effects tab of the Browser before adding it to a sequence. You can also save a transition as 
a favorite after adding the transition to a sequence.

To create a favorite transition from the Effects tab:

1 Select the desired transition in the Effects tab in the Browser.

2 Choose Make Favorite Effect from the Modify menu.

The transition is copied to the Favorites bin. If you want to rename this favorite transition, 
see “Organizing and Renaming Favorites” on page 640.

To modify a transition from the Effects tab, then save it as a favorite:

1 Open the transition in the Transition Editor by doing one of the following:

m Double-click a transition in the Effects tab of the Browser.

m Drag a transition from the Effects tab of the Browser to the Viewer.

2 Make any desired changes to the duration or settings of the transition.

For more information, see “Making Precise Adjustments to Transitions” on page 622.

3 Do one of the following:

m Choose Make Favorite Effect from the Modify menu.

m Drag the transition’s drag hand from the Transition Editor to the Favorites bin in the 
Effects tab in the Browser. 

To save a transition as a
favorite, you can drag it

from the Transition Editor
to the Favorites bin.
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To create a favorite transition using a transition already in a sequence:

m Drag a transition you’ve modified from its sequence in the Timeline to the Favorites bin in 
the Effects tab of the Browser. 

m If you want to modify the transition first:

1 Double-click a transition in a sequence in the Timeline to open it in the Transition Editor.

2 Make any desired changes to the transition. 

3 Drag the transition’s drag hand from the Transition Editor to the Favorites bin in the 
Effects tab in the Browser or choose Make Favorite Effect from the Modify menu.

You can drag a
modified transition

from a sequence
in the Timeline to
the Favorites bin.

Drag the drag hand in the
Transition Editor to the

Favorites bin in the Effects
window of the Browser.
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Organizing and Renaming Favorites

When you create a favorite transition, you may want to rename it, particularly if you modified 
it, to help keep track of your transitions.

To rename a favorite transition:

1 Select the transition in the Effects tab in the Browser.

2 Click the transition again to highlight its name field.

3 Enter a new name, then press Return.

To organize favorite transitions into sub-bins:

1 Select your project’s tab in the Browser.

2 Create a new bin and give it an appropriate name.

For more information, see “Creating New Bins” on page 185.

Enter the new name for 
your favorite transition.
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3 Drag the Effects tab out of the Browser so it opens in its own window.

4 Drag your new bin to the Favorites bin in the Effects window.

After you drag favorite transitions into a bin, the bin appears as an item in the Favorites submenu.

To help organize your
favorites, create a new

bin in the Browser,
then drag it to the

Favorites bin.
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Modifying the Default Transition
A one-second cross dissolve is the default video transition and a –3 dB audio cross dissolve is 
the default audio transition. The default transition is used whenever you do an insert or 
overwrite with transition edit in the Canvas (or press Command-T or Option-Command-T) or 
use the Timeline shortcut menu to add video or audio transitions to your sequence. You can 
change the default transition to be any transition. 

Note:  You set the video default transition and the audio default transitions separately.

To set the default video or audio transition:

m Select a transition in the Browser, then choose Set Default Transition from the Effects menu.

m In the Browser, Control-click the desired transition, then choose Set Default Transition 
from the shortcut menu.

Control-click the transition 
you want as the new 
default, then choose this.

The default transition is 
underlined.
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To clear the default video or audio transition:

m Choose Clear Default from the Effects menu.

There is now no default transition. If you do an insert with transition or overwrite with 
transition edit, no transition is added. If you choose Add Transition from the Timeline’s 
shortcut menu, a message says you need to set a default transition before you can add a 
transition using the shortcut menu.

For information on applying the default video or audio transition, see “Adding the Default 
Transition” on page 611.

Previewing and Rendering Transitions
Before you can play back your media smoothly in real time with the effects you’ve applied to 
it, you need to render. Rendering is the process of combining your video and audio with the 
applied effects, such as transitions or filters, one frame at a time. The result is a new file, 
called a render cache file, which can be played back in real time.

The render bar in the Timeline indicates the state of all transitions you’ve edited into your 
sequence (as well as other items in your sequence). This bar has two regions. 

m Upper region:  Indicates the presence and state of video items. 

m Lower region:  Indicates the presence and state of audio items.

The upper area indicates the 
render status of video items.

The lower area indicates the 
render status of audio items.
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Determining the Render Status of Transitions

Colors in the render bar above items (including transitions) indicate whether the items need 
to be rendered.

Note:  The colors shown in the render bar depend on your hardware configuration—in 
particular, whether you have a real-time card installed. For more information, see Chapter 24, 
“About Real-Time Effects,” on page 1091.

Some transitions may not need rendering. All transitions (and clips) that don’t require 
rendering appear as dark gray bars.

For more information on rendering, see Chapter 23, “Rendering,” on page 1065. 

Previewing Transitions Before Rendering Them

If you have to render your transitions, it’s a good idea to preview complex transitions first. 
You can preview transitions while you’re modifying them or any time before rendering them.

To preview a transition:

m Move the playhead in the Canvas, the Timeline, or the Transition Editor over a frame of 
the transition. 

That frame of your transition is rendered and displayed in the Canvas, on your external 
monitor, or both, depending on how your external video settings are configured. 

Note:  Make sure the Caps Lock key is not engaged.

Render bar colors Indication

Gray A normal clip that doesn’t require rendering.

Red A transition or effect that requires rendering but has not been 
rendered yet.

Blue A transition or effect that has been rendered. This item in the 
Timeline has a corresponding render file on the specified scratch 
disk.

Green A transition or effect that can be played back in real time using 
your setup.

Yellow A transition or effect that can be approximated in real time, so 
you can see what it will look like, but that requires rendering 
before it is output to tape at full resolution.
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m Move the playhead in the Canvas or Timeline to a frame just before your transition, then 
choose Play Every Frame from the Mark menu (or press Option-P).

Final Cut Pro plays every frame of your transition, although not in real time.

Rendering Transitions

If you need to render your transitions, you can render all the transitions and effects in your 
sequence or a subset. Transitions are rendered at the render quality level you choose in the 
Render Quality pop-up menu in the Timeline or in the Render Quality submenu of the 
Sequence menu. 

If you’re rendering as a test or rendering complex transitions for preview, use the Draft or 
Low Res setting. If you’re rendering material for final output, make sure you choose Hi Res 
for the highest quality setting. For detailed information on setting up and using render 
quality settings, see “Determining the Render Quality Levels You Want” on page 1070.

To render a single transition in your sequence:

1 Select one or more transitions in the Timeline.

2 Do one of the following:

m Choose Render Selection from the Sequence menu.

m Press Option-R.

To cancel rendering, click Cancel in the status box or press Esc.

To render all transitions and effects in your sequence:

1 Select or open a sequence in the Timeline.

2 Do one of the following:

m Choose Render All from the Sequence menu.

m Press Command-R.

To cancel rendering, click Cancel in the status box or press Esc.
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Video Transitions That Come With Final Cut Pro

3D Simulation

Cross Zoom Causes the video to zoom in on the first clip, switch to the second, and 
zoom out. You can specify the center point, the amount of magnification in 
the zoom, and the degree of blur applied during the zoom.

Cube Spin Creates a three-dimensional cube from each clip and spins it in the 
direction you choose. You can also view the cube from the inside or the 
outside.

Spin3D Spins the first clip around its center point, revealing the second clip. You 
can choose the angle of the spin axis.

Spinback3D Spins the first clip around its center point until the clip is viewed from its 
edge, and then switches to the second clip, which spins into view. You can 
choose the angle of the spin axis.

Swing Creates the effect of swinging the first clip in toward the viewer or out 
toward the second clip, which is revealed as the swing widens. You can 
choose the angle of the swing axis. 

Zoom Zooms the second clip in from a single center point to full-frame size, over 
the top of the first clip. You can specify the center point (relative to the 
first clip) where the zoom begins.

Dissolve

Additive Dissolve Adds the two clips so that the first clip fades out and the second fades in.

Cross Dissolve Blends the first clip into the second clip.

Dip to Color Blends the first clip into the plain color of your choice, and then blends the 
plain color into the second clip. You can adjust the speed of the blend.

Dither Dissolve Dissolves the first clip into the second by removing random pixels from the 
first clip to reveal the second clip.

Fade In, Fade Out Fades in the incoming clip as the outgoing clip fades out. Reveals the track 
below the current track in a transition.
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Non-Additive 
Dissolve

Compares the pixels in the two clips and displays the lighter of the two as 
the first clip fades out and the second fades in.

Ripple Dissolve Applies a pond ripple effect to the first clip, simultaneously blending it into 
the second. You can choose the number of ripples, their center point on 
the first clip, and their amplitude and acceleration. You can also apply a 
circle highlight to the ripples.

Dissolve

Iris

Cross, Diamond, 
Oval, Point, 
Rectangle, and Star

These effects are similar, but have different shapes. They all create the 
impression of an iris, which contains the first clip, opening to reveal the 
second. In each iris effect, you can specify the center point around which 
the opening is defined and feather the edges, which blends the edges of 
the clips together and gives a diffused iris.

Map

Channel Map Maps channels from the first and second clip, or fills the channels with 
black. You can invert individual channels.

Luminance Map Maps color using the luminance of a clip.

Page Peel

Page Peel Peels the first clip away to reveal the second clip. You can adjust the 
appearance of the peel.
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QuickTime

QuickTime includes a set of built-in video effects listed here, some of which are implementations of 
standard effects defined by the Society of Motion Picture and Television Engineers (SMPTE).

For more information, visit Apple’s QuickTime Web site at www.apple.com/quicktime

Alpha Compositor Combines two images using the alpha channels of the images to 
control the blending. It provides the standard alpha blending 
options and can handle pre-multiplying by any color, although 
white and black are most common and often run faster.

Chroma Key Combines two sources by replacing all the pixels of the first 
source that are the specified color with the corresponding pixels 
of the second source. This allows the second source to show 
through the first. This appears to put the second clip behind the 
first clip and make the selected color transparent.

Cross Fade Provides a smooth alpha blending between two video sources, 
changing over time to give a smooth fade out from the first 
source into the second.

Explode The second clip grows from a single point, expanding outward 
until it entirely covers the first clip. The center point of the 
explosion is defined in the effect parameters.

Gradient Wipe Uses a matte image to create a transition between two source 
images. The transition from the first clip to the second clip 
occurs first where the matte image is darkest, last where the 
matte image is brightest. 

Implode The first clip shrinks down to a single point, revealing the second 
clip. The center point of the implosion is defined in the effect 
parameters.

Iris The first clip opens like an iris to reveal the second clip.

Matrix Wipe These are a series of matrix reveal type effects that take place 
between two sources. 

Push One source image replaces another, both images moving at the 
same time. For example, the first clip occupies the entire frame, 
then the second clip pushes in from the right while the first clip 
slides out to the left. 

Unlike the slide effect, both sources are moving. The push effect 
executes from the top, right, bottom, or left.
648 Chapter  15  



Radial The first clip sweeps in a radial, or semi-circular way, to reveal the 
second clip.

Slide The second clip slides onto the screen to cover the first clip. The 
angle from which the second clip enters the frame is stored in a 
parameter, with 0 degrees being the top of the screen.

Wipe The first clip wipes to reveal the second clip.

Zoom One clip zooms in or out of the other clip.

QuickTime

Slide

Band Slide Bands of the first clip slide in parallel to reveal the second clip. You can 
adjust the number of bands and the slide direction.

Box Slide Bands of the first clip slide one at a time in perpendicular directions to 
reveal the second clip. You can adjust the number of bands and the slide 
direction.

Center Split Slide Reveals the underlying clip by splitting the current clip down the center 
and horizontally sliding the two halves away from each other.

Multi Spin Slide Boxes of the first clip spin and zoom out to reveal the second clip. You can 
adjust the spin about the center of the first clip and the spin about the 
center of the box, as well as the number of boxes.

Push Slide The second clip pushes the first clip out of view. You can adjust the push 
direction.

Spin Slide Boxes of the first clip spin and zoom out to reveal the second clip. You can 
adjust the spin about the center of the box and the number of boxes.

Split Slide The first clip splits at specific points and slides to reveal the second clip. 
You can adjust the orientation of the split. 

Swap Slide The first (top) and the second (bottom) clips slide in opposite directions, 
swap places, and slide back, revealing the second clip. You can adjust the 
slide direction. 
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Stretch

Cross Stretch The first clip is squeezed as the second clip stretches from the specified 
edge to the opposite edge. 

Squeeze The first clip is squeezed from the opposite edges toward the center to 
reveal the second clip. You can specify the squeeze orientation.

Squeeze and Stretch The first clip is squeezed from the opposite edges toward the center and 
stretches in a perpendicular direction to reveal the second clip. You can 
adjust the squeeze orientation.

Stretch The second clip stretches from the specified edge over the first clip.

Wipe

Band Wipe Wipes a band across the first clip to reveal the second. You can specify the 
number of bands and the wipe direction.

Center Wipe A linear wipe from a specified point on the first clip reveals the second clip. 
You can adjust the wipe direction.

Checker Wipe Checkered boxes appear on the first clip to reveal the second clip. You can 
adjust the number of boxes and the wipe direction.

Checkerboard Wipe Checkered boxes wipe individually on the first clip to reveal the second. 
You can adjust the number of boxes and the wipe direction.

Clock Wipe A rotational wipe over the first clip reveals the second. You can adjust the 
start and direction of the wipe and the center point of the rotation.

Edge Wipe A linear wipe from the edge of the first clip reveals the second clip. You can 
adjust the wipe direction. 

Gradient Wipe Uses a gradient wipe image to wipe across the first clip, revealing the 
second clip. You can adjust the softness of the wipe and invert the gradient 
wipe image. By default, the transition wipes horizontally from left to right. 
You can override this by dragging an image onto the gradient clip well.

Inset Wipe A rectangular wipe from the specified edge or corner of the first clip 
reveals the second clip.

Jaws Wipe A jagged-edged wipe from the center of the first clip reveals the second 
clip. You can adjust the wipe direction and the shape of the jagged edge.
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Random Edge Wipe A linear wipe with a random edge from the edge of the first clip reveals the 
second clip. You can adjust the direction of the wipe and the width of the 
random edge.

V Wipe A V-shaped wipe from the specified edge of the first clip reveals the second 
clip.

Venetian Blind Wipe Bands wipe across the first clip to reveal the second. You can adjust the 
angle and the number of bands.

Wrap Wipe Bands wipe in the specified direction across the first clip to reveal the 
second clip. You can specify the start and orientation of the wipe and the 
number of bands.

Zigzag Wipe Bands wipe in a zigzag pattern over the first clip to reveal the second clip. 
You can specify the start and orientation of the wipe and the number of 
bands.

Wipe
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16 Advanced Editing 

and Trimming Techniques
In this chapter, you’ll continue to explore ways to manipulate clips you’ve edited into 
your sequences.

Changing one or more edit points in a sequence is called trimming. This can involve moving 
an individual clip’s In or Out points, changing the location of an edit point between two clips, 
or simply moving a clip to a new location. Each trimming operation has a name: resize, 
ripple, ripple delete, lift, roll, slip, slide, extend, and swap. Final Cut Pro has specialized tools 
for performing some trim edits. 

Chapter 15 introduced some of these operations and explained how to move the edit point 
of a transition in the Transition Editor. Now you’ll learn how to apply the same principles to 
the rest of your edited sequence.
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Where You Can Perform Trim Edits
You can do trim edits in the Viewer, the Timeline, and the Trim Edit window, a specialized 
window for fine-tuning edits. In all of these windows, you can trim using a variety of methods: 
using tools from the Tool palette, entering timecode, and using keyboard shortcuts.

m Viewer:  From your sequence in the Timeline, you can open a clip directly in the Viewer 
to easily and precisely change its In and Out points at any time. How your edited 
sequence is affected depends on which tool you use.

m Timeline:  You can also trim clips directly in the Timeline. This allows you to work on 
several clips as at one time. Trimming is not limited to a single track; you can also trim 
multiple superimposed clips on multiple tracks.

You can adjust the level of precision of your editing by setting the zoom level in the 
Timeline. By zooming in, you can make changes all the way down to a clip’s individual 
frames. Conversely, you can also zoom all the way out to see the entire project and work 
on very large sections at once. 

m Trim Edit window:  This window provides very precise control while trimming. It displays 
both sides of an edit, the outgoing clip before the edit point, and the incoming clip that 
appears after, allowing you to adjust your edit as finely as necessary. You can also use this 
window to trim a group of edits in multiple tracks (only one edit per track) at once.
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About the Tool Palette
Many of the trimming tools discussed in this chapter are found in the Tool palette. The Tool 
palette (for most of the layouts that come with Final Cut Pro) is typically located to the right 
of the Timeline, near the edge of the screen. To hide and show it, choose Tools from the 
Window menu.

Choose Tools to view 
the Tool palette.

Edit, Group, and Range 
Selection tools

Track Selection tools

Roll Edit and Ripple Edit tools

Slip Item and
Slide Item tools

Razor Blade tools

Zoom In, Zoom
Out, Hand, and

Scrub Video tools
Crop and Distort tools

Selection tools

Pen, Pen Delete, and 
Pen Smooth tools
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Some tools are grouped together because they have similar functions. Tools that are grouped 
together are indicated by an arrow in the upper right of the tool button.

To select a tool from a group:

1 Move the pointer over a tool in the Tool palette, then press and hold down the mouse button. 

A pop-up menu shows the other tools associated with this function.

2 Move the pointer to the tool you want to select, then release the mouse button. 

The selected tool becomes the new default tool in that area of the Tool palette. To use 
keyboard shortcuts for these tools, see Appendix B, “Keyboard Shortcuts,” on page 1297.

Controls That Affect Trim Edits
Before you perform a trimming operation, make sure to check that the following controls are 
set properly:
m Linked selection

When you capture video and audio together, they’re linked by default, appearing in your 
sequence as three linked items (one video and two audio items per clip). When you 
enable linked selection in Final Cut Pro, it only affects what’s selected when you click an 
item that’s linked to another item. If enabled, it insures that if you select one linked item 
in the Timeline, all items linked to it are also selected. Any adjustments you make to one 
is applied to the others.

If you disable linked selection by clicking the linked selection control (or by pressing 
Shift-L, or holding down the Option key while selecting a single item), you can trim a 
single item at a time without also trimming any video or audio items linked to it. This is a 
good way to create split edits.

Click to select the desired tool.

The selected tool
becomes the

default shown in
the Tool palette.
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m Snapping

If snapping is on, when you drag an edit in the Timeline or Viewer, it snaps to markers, 
keyframes, the playhead, and edits on other tracks. This can help to line up edits with 
other items in the sequence. You can turn snapping on and off at any time, even in the 
middle of dragging edits and clips, by pressing the N key. You can also enable or disable 
snapping by choosing it from the View menu. For more information, see “Snapping in the 
Timeline” on page 500.

m Locked tracks

Trim operations ripple clips only on unlocked tracks. If there are certain tracks you don’t 
want to change inadvertently while trimming, you can lock all the tracks in your sequence 
except the ones with items you want to adjust. 

If you lock a track with an item that’s linked to an item you’re trimming, the fact that the 
track is locked will override its linked status. For example, if you select a video item to 
trim that’s linked to an audio item in a locked track, moving the video item out of sync 
with to the audio item. For more information, see “Locking Tracks” on page 479.

m Using the Command Key to “Gear Down”

The Command key is useful if you want to make very small changes to edit points or clips 
in your sequence. When you drag clips or edit points to perform trimming operations, the 
ratio between the motion of your mouse and the item you’re changing is determined by 
the zoom level of the Viewer, Canvas, or Timeline. If you have trouble trimming to a 
specific frame because you’re zoomed out too far, you can force this motion to be a more 
precise 1-to-1 ratio regardless of your zoom level by pressing the Command key after you 
start dragging.

Holding the Command key down after you start dragging an edit point with the roll edit 
tool, for example, makes the edit point move much more slowly as you drag.
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Selecting Edits and Clips to Trim
Regardless of where you perform your trim edits, you need to select one or more edits or 
clips to trim. When you select multiple edits in the Timeline, remember that you can select 
only one edit per track.

Tools for Selecting Clips

The following tools can be used to select one or more clips in your edited sequence:

Selection Tools for Trimming

There are several selection tools you can use for trimming: Selection, Edit Selection, Group 
Selection, and Range Selection.
m Selection tool

This is the default tool. You use this to select individual items, such as a clip, transition, 
edit point, or keyframe, or multiple linked items. As you select things in the Timeline, the 
pointer changes. The Selection tool can be modified in a variety of ways using modifier 
keys. You can choose the Selection tool by pressing the A key.

Selection tool

The Selection tool changes 
depending on the items you 
select to trim in the Timeline.

When you use the Selection 
tool to adjust an edit point, 
it turns into the Resize pointer.
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m Edit Selection

These tools are used to select edit points between clips. You can select edits on as many 
tracks as you want, but you can only select one edit per track. When you release the 
mouse button, the Trim Edit window opens so that you can precisely modify all the edit 
points simultaneously. You can choose the Edit Selection tool by pressing the G key.

.

m Group Selection

Selects multiple contiguous items. This tool selects an entire item in the Timeline even if 
you only drag over a part of it. Any items linked to it are selected as well. Use this tool to 
select several clips in their entirety. You can choose the Group Selection tool by pressing 
the G key twice.

m Range Selection

Selects a range across multiple contiguous items. This tool does not select the entire 
item; it selects only a part that you define with a bounding box. Use this tool to select only 
a part of a clip, or to create a selection that includes parts of several clips. You can choose 
the Range Selection tool by pressing the G key three times.

Keyboard Modifiers for the Edit Selection Tool

Press a key when you click the Edit Selection tool to add these functions:

m Command key:  Allows you to add and subtract edits from the currently selected range.

m Option key:  Turns linked selection on and off.

m Shift key:  Lets you use the Ripple Edit tool until you release the Shift key.

Group Selection

Range SelectionEdit Selection
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When you use the Range Selection tool, a two-up display in the Canvas shows the In and 
Out points of your selection, along with their frame numbers. This display is continuously 
updated as you drag.

Track Selection Tools for Trimming

m Select Track Forward

Selects the contents of a track from the selection point to the right. All items in that track 
are selected and ready for any group operation, such as moving or deleting. Items linked 
to selected items in this track are selected also. You can select the Select Track Forward 
tool by pressing the T key.

m Select Track Backward

Selects the contents of the track from the selection point to the left. You can select the 
Select Track Backward tool by pressing the T key twice.

m Select Track

Selects the entire contents of a single track, as well as any items linked to items in the 
track. You can select the Select Track tool by pressing the T key three times.

The two-up display shown in 
the Canvas when the Range 
Selection tool is used

Select All Tracks 
Forward

Select Track
Backward

Select All Tracks Backward

Select Track 

Select Track Forward
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m Select All Tracks Forward

Selects all of the contents of all tracks from the selection point to the right.
m Select All Tracks Backward

Selects all of the contents of all tracks from the selection point to the left.

Selecting Edit Points or Clips For Trimming

All trimming operations work on edit points or clips that you select in your sequence in the 
Timeline. If linked selection is enabled, any edit points or clips that are linked to the one you 
select will be selected as well.

Selecting Single Edit Points or Clips

To select a single edit point in the Timeline:

m Choose the Edit Selection tool in the Tool palette, then click the edit or clip in the 
Timeline. The Trim Edit window opens.

m Choose the Selection, Ripple Edit, or Roll Edit tool in the Tool palette, then double-click 
an edit to perform your edit in the Trim Edit window.
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m Press the V key. The playhead in the Canvas and Timeline jumps to the next edit point, 
which is selected.

m Press the Up or Down Arrow keys to jump to the next or previous edit point in your 
sequence and select it.

There is no menu command for selecting an edit.

To select a single clip in the Timeline:

m Choose the Selection tool in the Tool palette, then click a clip in the Timeline.

Before

After

The playhead moves 
to the edit point. 
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To select a single clip in the Timeline using keyboard commands:

1 Position the pointer over the clip you want to select in the Timeline. 

Make sure that the Target Track controls in the Timeline are set to the tracks that contain 
your clip.

2 Choose Mark Clip from the Mark menu or press X.

3 To select your clip, choose Select In to Out from the Mark menu or press Option-A.

V1 is the specified
target track.

Playhead in position

In and Out points will appear at the 
beginning and end of the clip at the 
position of the playhead in the Timeline. 
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Selecting Multiple Edit Points or Clips

To select multiple edit points in the Timeline:

m Choose the Selection tool in the Tool palette. Drag around the edit on one or more tracks. 

As you drag in the Timeline, this tool selects one edit per track. The edits don’t have to be 
aligned in time. When you release the mouse button, the Trim Edit window opens.

m Choose the Selection tool in the Tool palette, then Command-click the edge of each clip. 

m Choose the Ripple Edit or Roll Edit tool in the Tool palette and click the edge of the clip. 
Command-click to select multiple edits.
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To select multiple clips or parts of clips in the Timeline:

m Choose the Selection tool in the Tool palette. Drag a marquee around one or more clips. 
This operation selects whole clips only.

m Choose one of the track selection tools, then click the range of clips in the track or tracks 
you want to select. 

Note:  These tools only select whole clips.

m Mark the desired In and Out points, then choose Select In to Out from the Mark menu. 
This method allows you to select all or parts of clips in a group.

Note:  If you have trouble selecting specific edit points with the Selection tool, you may 
be zoomed out too far. Use the Zoom slider to get a more detailed view, then select your 
edit again.
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To select multiple clips in the Timeline using keyboard commands:

1 Set In and Out points for the range of clips you want to select.

2 Make sure that the Target Track controls in the Timeline are set to the tracks that contain the 
range of clips you want to select.

3 Choose Select In to Out (or press Option-A) to select your clips.

Opening Clips in the Viewer for Trimming

Before you can trim a clip, you must open it in the Viewer.

To open a clip in your sequence in the Viewer:

m Double-click the clip in the Timeline.

m Select a clip in the Timeline, then press Return.

m Double-click the clip in the Canvas.

m If the clip is in a nested sequence:  Select the clip. Hold down the Option key, then 
double-click the clip or press Return.
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If you just double-click the clip, it opens in the Canvas and Timeline, not the Viewer.

Note:  Make sure you open a clip from the sequence it’s in. If a clip is opened from the 
Browser, no dots appear in the scrubber bar.

When you open a clip from a sequence, the clip opens in the Viewer to the same frame 
where the playhead is positioned in the Timeline or Canvas. Once it’s opened in the Viewer, 
you can view it in different ways. 

m Click the Video tab to show the video track and its information.

m Click the Audio tab to show a waveform view of the audio, if the clip contains audio.

Both video and audio tabs have a scrubber bar near the bottom. This is where you do most 
of your trimming.

A clip opened from a 
sequence has two rows of 
small dots in the scrubber 
bar of the Viewer.

The title area shows the 
name of the clip and 
where the clip is located.

This is the frame marker for 
the Out point of this clip 
(which the playhead is on).
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Understanding Warning Messages When Trimming

If you try to perform a trim edit that isn’t possible, Final Cut Pro displays one of two 
warning messages:
m Insufficient content for edit

This message appears when there is not enough media in the source clip to allow the trim 
edit you’re attempting. 

For example, let’s say you select the edit point of the following clip in your sequence to 
do an extend edit. The total media available in the clip is ten seconds, but the current 
duration of the clip in your sequence is six seconds:

If you move the playhead in the Timeline to a position eight seconds away and press E to 
perform an extend edit, the “insufficient content” message appears. This is because there 
aren’t enough frames in the selected clip to cover the extend edit.

m Media limit

This warning indicates that there’s another clip or edit point in the way of the one you’re 
trying to move in your sequence. This error usually appears when you try to move items 
using timecode.

For example, let’s say you select one of two adjacent clips in your sequence that are two 
seconds apart. Using the keyboard, you type +500, which should move your clip 
00:00:05:00 seconds ahead, into the other clip. However, using the keyboard to move 
clips doesn’t allow you to overwrite other clips, so you see the media limit message.

Media limit warning
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How to Perform Trim Edits
In this section, you’ll learn how to perform the trim edits described earlier in the Timeline or 
the Canvas. For all of these editing operations, make sure that you have the right tool 
selected for the task you wish to perform. Especially when you perform trimming operations 
to sequence clips opened into the Viewer, the tool that’s selected determines how the other 
clips in your sequence behave. These tools can be selected in the Tool palette or with 
keyboard shortcuts.

Moving Clips in Your Sequence

If you drag a clip from one place in your sequence to another, you can perform either an 
insert or a replace (or overwrite) edit. This is the simplest change you can make to your 
edited sequence.

Dragging Clips

To drag a clip and perform an insert edit:

1 Do one of the following:

m Choose the Selection tool in the Tool palette.

m Press the A key.

2 Drag a clip from its current position in your edited sequence to a new position.

3 Holding the mouse button down, press the Option key. When the pointer changes to the 
swap edit tool, drop the clip into the middle of an existing clip on the Timeline to do an 
insert edit. 

Swap edit pointer
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All other clips in your sequence on all unlocked tracks are cut at this point and moved 
forward in your sequence by the duration of the clip you moved.

To drag a clip and perform an overwrite edit:

1 Do one of the following:

m Choose the Selection tool in the Tool palette.

m Press the A key.

2 Drag a clip from its current position in your edited sequence to a new position.

3 Release the mouse button.

Any material at the location of the pointer is overwritten for the duration of the clip you moved.
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Cutting and Pasting Clips

To cut and paste one or more clips and perform an overwrite edit:

1 Select a clip or clips in your sequence.

2 Do one of the following:

m Choose Cut or Copy from the Edit menu.

m Control-click one or more clips in the sequence and choose Cut or Copy from the 
shortcut menu.

m Press Command-X (cut) or Command-C (copy).

Cut removes the selected clip or clips from the current sequence, leaving a gap. Copy leaves 
the selected clip or clips where they were and places a duplicate on the Clipboard.

3 Move the playhead in the Timeline or Canvas to the place in your sequence where you want 
to paste the clips.

4 Select the target tracks for your paste operation.

5 Do one of the following:

m Choose Paste from the Edit menu.

m Control-click one or more clips in the sequence and choose Paste from the shortcut menu.

m Press Command-V.

Your clip or clips overwrite whatever is already in your sequence for the duration of what’s 
being pasted.
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To cut and paste one or more clips into your sequence using Paste Insert:

1 Select a clip or clips in your sequence.

2 Do one of the following:

m Choose Cut or Copy from the Edit menu.

m Control-click one or more clips in the sequence and choose Cut or Copy from the 
shortcut menu.

m Press Command-X (cut) or Command-C (copy).

Cut removes the selected clip or clips from the current sequence, leaving a gap. Copy leaves 
the selected clip or clips where they were and places a duplicate on the Clipboard.

3 Move the Canvas/Timeline playhead to the place in your sequence where you want to paste 
the clips.

4 Select the target tracks for your paste operation.

5 Do one of the following:

m Choose Paste Insert from the Edit menu.

m Control-click one or more clips in the sequence and choose Paste Insert from the 
shortcut menu.

m Press Shift-V.

Your clip or clips are pasted as an insert edit at the location of the playhead.

These clips move back to 
accomodate the new clip.
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Moving Clips Using Timecode

To move a clip in your sequence using timecode:

1 Select one or more clips in your sequence.

2 To move the clips forward, press + and type a timecode duration for the move. To move the 
clips backward, press – and type a timecode duration for the move.

3 Press Return.

You cannot overwrite an existing clip in your sequence using this method. If you try, you’ll 
see a media limit error message.

The timecode entry field 
appears when you type. 
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Doing Resize Edits

A resize edit changes the In or Out point of a clip in your edited sequence, leaving a gap. The 
total duration of your edited sequence is not changed. 

You cannot resize a clip so that it overwrites an adjacent clip.

Resize edits are useful for filling in gaps between two clips and for creating gaps in preparation 
for another editorial operation.

To resize a clip in the Timeline:

1 Do one of the following:

m Choose the Selection tool in the Tool palette.

m Press the A key.

2 Move the pointer to the In or Out point of a clip in the Timeline. The pointer changes to the 
Resize pointer.

3 Drag inward to create a gap in your sequence (by making the clip shorter) or outward to 
cover an existing gap (by making the clip longer). 

A B C

A B C

Before edit

After edit

Gap

Resize edits are done 
using the Selection tool.

During a resize edit, the 
Selection tool changes 
to the Resize pointer.

Before
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As you drag, you see the current frame at the edit point in the Canvas.

You can also perform this operation in the Viewer using the keyboard.

To resize a clip in the Viewer:

1 Open a clip from your sequence into the Viewer. The scrubber bar shows little “sprocket 
holes,” which indicate that the clip is from your sequence.

2 Do one of the following:

m Choose the Selection tool in the Tool palette.

m Press the A key.

3 Do one of the following:

m Use the playback controls or the J, K, and L keys to move the playhead in the Viewer to a 
new point in your clip. Then set a new In or Out point using the Mark In and Mark Out 
buttons or the I and O keys.

Clip being 
resized

Resulting gap

Later cllips in 
the sequence 
are unaffected.

After
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m Drag the In or Out point along the Viewer’s scrubber bar.

You can’t set an In point or drag a clip’s edit point so that it overlaps another clip. If you do, 
you see a media limit error message (see “Understanding Warning Messages When 
Trimming” on page 668). If you want to move a clip’s edit point so it overwrites an adjacent 
clip, you should perform either an extend edit or a roll edit.
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Doing Roll Edits

A roll edit moves the edit point where two clips in your sequence meet. Both the Out point 
of the outgoing clip (to the left) and the In point of the incoming clip (to the right) of the 
selected edit point move simultaneously. 

A roll edit changes the durations of the two adjacent clips as the edit point is moved, but the 
overall duration of your sequence stays the same.

Roll edits are useful when you want to match the action of one clip with the action of another 
and you need to find the right intersecting frames. For example, if one clip shows a woman 
opening a door and walking into a house, and a second clip from the inside shows the door 
opening and the woman walking in, you can edit these clips together so that the actions 
match as closely as possible. You can then do a roll edit to move the edit point between these 
two shots until you find the perfect frame for this cut.

To do a roll edit in the Timeline:

1 Do one of the following:

m Choose the Roll Edit tool in the Tool palette.

m Press the R key.

2 Select an edit point between two clips. 

If linked selection is on, the edits of linked items will also be selected.

A B C

A B C

Before edit

After edit

Roll edits are done 
using the Roll Edit tool.

Before
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3 Do one of the following:

m Drag the edit left or right. 

As you drag, the Canvas shows the two-up display with the Out point of the outgoing clip 
on the left and the In point of the incoming clip on the right (see also “About the Canvas 
Two-Up Display” on page 585).

m Type + (plus) or – (minus) followed by the number of frames to add or subtract from the 
current edit, then press Return.

Edit being rolled

After
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To roll multiple tracks simultaneously:

1 Do one of the following:

m Press the Command key while clicking to select multiple edit points.

m Select the Edit Selection tool in the Tool palette (or press the G key).

2 Use the Roll Edit tool to perform the roll edit across all of the tracks.

To do a roll edit in the Viewer:

1 Open a clip in the Viewer.

2 Select the Roll Edit tool in the Tool palette.

3 Drag the In or Out point along the Viewer’s scrubber bar to roll the edit.

Tips for Roll Edits

m If you can’t drag any further during a roll edit, you have reached the end of the media.

m With the Roll Edit tool selected, hold down the Shift key to switch temporarily 
between the Roll Edit and Ripple Edit tools.

m While dragging, press the Control key to gear down and make a more precise edit.
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Doing Extend Edits

Extend edits are performed using the playhead in the Timeline and Canvas. An extend edit 
moves an edit point to the position of the playhead in the Timeline. 

Unlike a resize edit, this edit overwrites any clips that come between the selected edit point 
and the playhead. It does not affect the overall duration of your sequence. 

Extend edits allow you to move an edit point between two clips quickly. You can use an extend 
edit to overwrite one or more clips, provided the clip you’re extending has enough material. 
When linked selection is disabled, extend edits are very useful for creating split edits.

To extend the duration of an edit in the Timeline:

1 Select the edit points for the clips you want to extend using either the Selection tool or the 
Edit Selection tool.

Note:  To create a split edit, disable the linked selection control in the Timeline or hold the 
Option key to disable linked selection temporarily. This allows you to select a single edit point.

2 Move the playhead to the position in your sequence where you want to put the selected 
edit point.

3 Do one of the following:

m Choose Extend Edit from the Sequence menu.

m Press E. 

Before edit

After edit

A B

Gap

A B

Playhead
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The selected edit is rolled over any gaps or clips to the position of the playhead. 

If you chose multiple edit points across clips on several tracks using the Edit Selection tool, 
all of these clip edit points are moved to the position of the playhead.

Note:  If you try to extend an edit farther than the total amount of media available in a clip, 
an alert sounds and the clip is extended as far as possible.

Doing Ripple Edits

A ripple edit moves the location of either the Out point preceding or the In point following 
an edit point. So the duration of the clip to the left or the right of the edit point is shortened 
or lengthened. 

Unlike a roll edit, this affects only one clip adjacent to an edit point. All other clips in your 
sequence are then moved to accommodate the new duration of this clip, changing the 
overall duration of your sequence.

For example, if two clips are adjacent, and you want to find a new Out point for the first one, 
you can use the Ripple Edit tool to move the outgoing clip’s Out point to the left or right. All 
clips that come after the edit point move to the left or to the right, so that none of them are 
overwritten and so there is no gap.

This clip lengthens as 
clip “C” shortens. 

A B C

A B C

Before edit

After edit

Ripple edits are done 
using the Ripple Edit tool.
  Advanced Editing and Trimming Techniques 681



To do a ripple edit in the Timeline:

1 Do one of the following:

m Choose the Ripple Edit tool in the Tool palette. 

m Press the R key twice.

2 Select an edit by clicking near the edge of the clip. 

If linked selection is on, the edits of linked clips are also selected.

3 Do one of the following:

m Type + or – followed by the number of frames to add or subtract from the current edit, 
then press Return.

m Drag the edit to lengthen or shorten the clip in the sequence.

m Markers:  If you drag a clip’s In point, you see two markers. One is a boundary 
showing the new duration of the clip you’re trimming. The other shows the position of 
the current frame you’ve trimmed to.

m Boundary:  If you drag a clip’s Out point, you see a boundary showing the new 
duration of the clip you’re trimming. 

Edit point being trimmed
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At the same time, the Canvas shows the two-up display with the Out point of the outgoing 
clip on the left and the In point of the incoming clip on the right (see also “About the Canvas 
Two-Up Display” on page 585).

The clips in your sequence after the edit point you’ve rippled all move either left or right to 
accommodate the new duration of your rippled clip. 

To do a ripple edit in the Viewer:

1 Open a clip in the Viewer.

2 Do one of the following:

m Choose the Ripple Edit tool in the Tool palette.

m Press the R key twice.

3 Do one of the following:

m Use the playback controls or the J, K, and L keys to move the playhead in the Viewer to a 
new point in your clip. Then set a new In or Out point using the Mark In and Mark Out 
buttons or the I and O keys.

m Drag the In or Out point along the Viewer’s scrubber bar.

Clip “G” is unaffected.Clip “B” shortens.

All these clips move 
back to fill the gap.
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About Ripple Edits and Sync Relationships of Clips

When you perform a ripple edit in your sequence, clips with start points located before the 
edit point you’re changing don’t move. All clips with start points located after the edit point 
being modified will be moved. This means that the sync relationship between the clips that 
have been rippled and those that haven’t will change. 

For example, if you have synced a group of clips to a piece of music and you perform a ripple 
edit that moves those clips, they will no longer be in sync with the music. It might be more 
appropriate to perform a resize or extend edit instead, filling in any resulting gaps with 
additional materials, or by extending one of the other edits.

If clips in adjacent tracks have edit points located after the edit point you’re rippling but are 
adjacent to other clips in that track with In points located before that edit point, you can’t 
perform a ripple edit unless you lock those tracks. After you lock the tracks, you can perform 
the ripple edit, but you’ll still change the sync relationship between clips.

Before the 
edit, clips are 
in sync with 
markers on 
the audio 
tracks.

After a ripple 
edit, the sync 
relationship 
has changed.
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Doing Ripple Edits on Multiple Tracks at Once

You can perform a ripple edit to selected edits in multiple tracks to modify several video and 
audio items simultaneously.

To ripple across multiple tracks simultaneously:

1 Do one of the following:

m Press the Command key while clicking to select multiple edit points.

m Choose the Edit Selection tool in the Tool palette.

2 Use the Ripple Edit tool to perform a ripple edit across all of the tracks.

Tips for Ripple Edits

m If you lengthen the clip, clips on the same track move forward in time. Clips on other 
unlocked tracks that begin after the playhead position also move forward in time.

m If you shorten the clip, clips on the same track move backward in time, as do clips 
after the playhead position on other unlocked tracks. 

m If you can’t ripple backward, it is because clips on other tracks can’t move back in 
time without bumping into other clips. 

m If you don’t want a ripple edit to affect another track in the sequence, lock that track. 

m With the Ripple Edit tool selected, press the Shift key to switch temporarily 
between the Ripple Edit and Roll Edit tools.
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Doing Lift Edits

To perform a lift edit, use any of the selection tools to select one or more clips or use In and 
Out points in the Timeline or Canvas to specify a range.

When you perform a lift edit to delete an item, a gap is left in your sequence. All other clips 
in your edited sequence remain where they are. This is useful if you want to leave all other 
clips in your edited sequence synchronized to a music clip in an adjacent audio track. 
Performing a lift edit does not affect the duration of your sequence. Performing a lift edit to 
delete a clip from your sequence does not delete it in the Browser, nor does it remove any 
source media from your hard disks.

To perform a lift edit, leaving a space in your sequence:

1 Do one of the following:

m Select one or more items using one of the selection tools.

m Set In and Out points in the Timeline or the Canvas. 

2 Click the Timeline to make it the active window.

3 Do one of the following:

m Press the Delete key. 

m Choose Lift from the Sequence menu. 

Clip “B” 
being lifted.
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m Press Command-X or choose Cut from the Edit menu to remove the selected clips from 
your sequence, in preparation for pasting them somewhere else.

Doing Ripple Deletes

You can also delete an item or items so that all items to the right move to the left, filling in 
the gap. This is called a ripple delete. Ripple deletes can be performed using any of the 
selection tools to select one or more clips or using In and Out points in the Timeline or 
Canvas to specify a range.

A ripple delete removes one or more items in the Timeline. All clips in unlocked tracks that 
follow the deleted item move to the left. This fills in the gap left by the deleted clip. 
Performing a ripple delete changes the duration of your sequence.

To perform a ripple delete:

1 Select an item or range of items to delete using one of the selection tools.

Gap 
remaining

Clip “B” being 
ripple deleted.
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2 Do one of the following:

m Choose Ripple Delete from the Sequence menu.

m Press Shift-Delete.

m Press the Forward Delete key.

m Control-click the item or region you want to delete, then choose Ripple Delete from the 
shortcut menu. 

Control-clicking only works when you’ve selected items with the mouse. It doesn’t work 
on a region defined by In and Out points.

m Press Shift-X to remove the selected clips from your sequence to the Clipboard.

Note:  There is no menu command to perform a ripple delete.

These clips move 
back to fill the gap.

Clip “G” is unaffected.
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About Ripple Deletes and Sync Relationships of Clips

When you perform a ripple delete in your sequence, clips with start points located before the 
clip you’re deleting don’t move. All clips with start points located after the edit point being 
modified will be rippled to the left to cover the gap created by deleting a clip in your 
sequence. This means that the sync relationship between the clips that have been rippled 
and those that haven’t will change.

For example, let’s say a piece of music begins before a group of video clips that are in sync 
with the music. If you perform a ripple delete that moves those video clips but leaves the 
audio clip in the same position, they will no longer be in sync with the music. It might be 
more appropriate to perform a lift edit instead, filling in any resulting gaps with additional 
material or by extending one of the other edits.

If clips in adjacent tracks have edit points located after the clips you’re deleting but are 
edited up against other clips in that track with In points that are located before that edit 
point, you can perform a ripple delete, but these clips won’t move. As a result, you’ll still 
change the sync relationship between clips.

Shot to be deleted.

Markers 
on audio 
tracks 
are in 
sync with 
the video 
clips. 

After a 
ripple 
delete, 
the sync 
relation-
ships 
change.
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Slipping Items

The Slip Item tool slips a clip, moving its In and Out points simultaneously while maintaining 
its duration and position in your edited sequence. 

The clip’s range of frames changes, while its location in your sequence stays the same. 
Surrounding clips are not affected, nor is the overall duration of your sequence. 

The Slip Item tool is good for adjusting B-roll footage that you’ve edited into your sequence. 
For example, suppose you have a four-second gap between two clips that are synced to an 
off-camera voiceover. You edit in another clip to fit the space, but you decide you don’t like 
the section of the clip you’ve chosen. Using the Slip Item tool, you can drag your clip within 
its place in your sequence to find a better section, without moving it in the Timeline.

To slip a clip in the Timeline:

1 Do one of the following:

m Choose the Slip Item tool in the Tool palette.

m Press the S key.

2 Click a clip, then drag it left or right. 

A B C

A B C

Before edit

00:00:10:00 00:00:30:00

00:00:17:00 00:00:37:00

After edit

You slip items using
the Slip Item tool.
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As you drag, an outline of the entire range of that clip is shown, indicating the amount of 
media available to the left and right of the current range selected in the clip.

At the same time, the Canvas displays the frames at the In point and the Out point. 

3 Release the mouse button when the clip is positioned at a range of frames that you like.

The duration and location of all clips in your sequence remains the same after this operation.

Drag point

This box shows 
the duration of 
the change in the 
clip’s position.

Outline of entire 
clip during slip.
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To slip a clip in the Timeline more precisely using timecode:

1 Choose the Slip Item tool in the Tool palette.

2 Select a clip in the Timeline, or hold the Shift key down to select multiple clips.

3 Type + or – and the number of frames to slip, then press Return. 

To slip a clip in the Viewer:

1 Open a clip in the Viewer.

2 Do one of the following:

m Select the Slip Item tool in the Tool palette (or press the S key), then drag either the In or 
Out point along the Viewer’s scrubber bar.

m If the Selection tool is selected, press Shift and drag one of the edit points in the scrubber 
bar to slip them both.

Sliding Items

The Slide Item tool moves an entire clip, along with the edit points to its left and right. The 
Out point of the clip to the left and the In point of the clip to the right roll simultaneously. 
The overall duration of these three clips does not change. 

The duration of the clip being moved stays the same, but the clips to the left and to the right 
of it change in duration. The overall duration of your sequence does not change.

The timecode entry 
field shows the 
duration of the slip.

A B C

A B C

Before edit

After edit

You slide items using 
the Slide Item tool.
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The Slide Item tool does the opposite of the Slip Item tool. For example, let say you have 
three clips in your sequence and you want to change the relationship of the middle one to 
the Out point of the clip to the left and the In point of the clip to the right. You can use the 
Slide Item tool to move the middle clip, while doing the equivalent of simultaneous ripple 
edits to the Out point of the left clip and the In point of the right clip. At the end of a slide 
operation, the total duration of these three clips in your edited sequence is exactly the same 
as it was before.

To slide a clip in the Timeline:

1 Do one of the following:

m Choose the Slide Item tool in the Tool palette.

m Press the S key twice.

2 Select the clip, then drag it left or right. 

All edit points around clip “B” 
move to the left along with the clip.
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As you drag, the Canvas displays the Out point frame of the clip to the left and the In point 
frame of the clip to the right.

3 Release the mouse button.

To slide a clip in the Timeline using timecode:

1 Do one of the following:

m Choose the Slide Item tool in the Tool palette.

m Press the S key twice.

2 Select a clip in the Timeline or hold the Shift key down to select multiple clips.

Adjacent clips are affected.

Clip B’s duration 
is the same.

All other clips are unaffected.
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3 Type + (plus) or – (minus) and the number of frames to slide, then press Return. 

Doing Swap Edits

A swap edit moves a clip from one position in your edited sequence to another, performing an 
insert edit wherever the clip is moved. All clips between these two positions are moved to the 
left or right to fill the space. Swap edits do not affect the overall duration of your sequence.

You can do a swap edit to move a clip from its current position in your sequence to another 
edit point on the same track. A swap edit moves all of the clips between the new edit point 
to the old position of the clip you’re moving. The swapped clips don’t change their duration, 
so the overall duration of your sequence is not affected. Superimposed clips on other tracks 
are unaffected.

You may want to turn snapping on to make it easier to align the clips you are swapping (see 
“Snapping in the Timeline” on page 500).

The timecode entry 
field shows the 
duration of the slide.

A B C D

A B CD

Before edit

After edit
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To do a swap edit:

1 Select a clip you want to move in the Timeline with the Selection tool. 

Note:  You can only do a swap edit on single clips.

2 Drag the clip to the beginning of the clip or clips you want to push over. If you have trouble 
aligning it with the edit point, press the N key to turn snapping on.

3 Press the Option key while holding down the mouse button.
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4 Release the mouse button to place the selected clip at the insert point.

Canceling Edits

To cancel an edit in the Timeline:

m If you were entering timecode to make a change, press the Esc key while the timecode 
field is visible. 

m Choose Undo from the Edit menu.

m Press Command-Z.

To cancel an edit in the Viewer:

m Press Esc while the timecode field is visible. 

m Press Command-Z.

Shots B, C, and D move.

Shot E moves. 
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Using Timecode to Trim Edits in the Viewer

If you’re performing a trimming operation in the Viewer, you use timecode to navigate to a 
specific frame rather than trying to find the frame you want using the playback controls or 
the J, K, and L keys. You then select the edit tool for the trimming operation you want to 
perform and click the Mark In or Mark Out button to make the change. For more 
information on navigating in the Viewer using timecode, see “Using Timecode in the Viewer” 
on page 355.

To use timecode to reset a clip’s In or Out point:

1 Open a clip in the Viewer.

2 Do one of the following:

m Enter a timecode where you want the new In or Out point of the clip, then press Return.

For example, to move the In point from 02:41:43:14 to 02:41:43:27, enter 02414327, then 
press Return.

m Press Shift-I or Shift-O to move the playhead to the In or Out point. Then enter a 
timecode to move the In or Out point.
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For example, to ripple the Out point back 2 seconds, press Shift-O, enter –2:00, then 
press Return.

Enter the timecode 
where you want 
the In or Out 
point to be, then 
press Return.
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3 Select an edit tool in the Tool palette.

4 Click the Mark In or Mark Out button.

The playhead 
moves to the 
new timecode 
location.

A ripple edit on the 
In point of the clip
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The Canvas and Timeline show the changes.

Cutting Clips in the Timeline

You can cut clips in your sequence into two or more pieces.

m Razor Blade:  Adds an edit point to your sequence by cutting a single clip, along with any 
items linked to it in the Timeline, into two pieces. This edit point is added at the frame of 
the clip in the Timeline that you click. 

The playhead moves to 
the adjusted In point.

The Canvas shows the new In 
point of this clip in the sequence.

Razor Blade AllRazor Blade
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This can be useful for quickly rearranging pieces of your sequence, for deleting a section 
of a clip, for applying an effect to a specific part of a clip, or for moving a piece of a clip to 
the same location on another track

Before

The Razor Blade tool lets you 
cut a clip into two items.

After
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m Razor Blade All:  Cuts all clips on all layers at the point where you click in the Timeline.

Using the Add Edit Command

The Add Edit command in the Sequence menu (Control-V ) works like the Razor Blade tool, 
adding an edit point at the current position of the playhead.

Finding and Closing Gaps

As you edit, cut, paste, and slip items in Final Cut Pro, empty spaces may be left between clips in 
your sequence. These are called gaps. Sometimes they are extremely small (one or two frames), 
which makes them difficult to see in the Timeline. When a sequence with accidental gaps plays 
back in the Canvas, however, even tiny gaps are apparent as black flashes. 

There are two types of gaps: gaps and track gaps.

Before

The Razor Blade All tool lets 
you cut clips across all tracks.

After
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m Gaps:   These are empty spaces to the left or right of any two clips in any tracks of 
your sequence.

m Track gaps:  These are empty spaces between two clips in the same track.

To find gaps in a sequence:

1 Move the playhead to the beginning of the sequence if you want to start from the beginning.

You can do this quickly by pressing the Home key.

2 Do one of the following:

m Choose Next from the Mark menu, then choose Gap from the submenu (Shift-G).

m Choose Previous from the Mark menu, then choose Gap from the submenu (Option-G).

The playhead moves to the beginning of the first gap found to the left or right of the playhead. 

To find track gaps in a sequence:

1 Decide which track to search and make it the target track.

2 Do one of the following:

m Choose Next from the Mark menu, then choose Track Gap from the submenu.

m Choose Previous from the Mark menu, then choose Track Gap from the submenu.

The playhead moves to the beginning of the first track gap found.

A gap across two tracks

Track gap Track gap
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To close a gap:

m Position the playhead anywhere within the gap, then choose Close Gap from the 
Sequence menu.

m Control-click anywhere within a gap, then choose Close Gap from the shortcut menu.

m Select the gap by clicking it, then press Delete. 

All clips to the right of the gap move left to close the gap. 

This command is not available if another clip on another track overlaps this gap, because this 
would change the relationship of the overlapping clip to the rest of your sequence (or its 
audio/video sync, if it’s an audio clip underneath a video clip).

If you don’t care about the sync relationship between the rest of your sequence and the 
overlapping clip, you can lock tracks containing overlapping clips, then use any of the above 
techniques to close the gap.

To close a track gap without affecting any other tracks in the sequence:

1 Click the Lock Track control of any tracks with clips that overlap the gap you want to close.

2 Do one of the following:

m Position the playhead anywhere within the gap, then choose Close Gap from the 
Sequence menu.

m Control-click anywhere within a gap, then choose Close Gap from the shortcut menu.

m Select the gap by clicking it, then press Delete. 

To close a track gap using the Select Track Forward tool:

1 Make sure snapping is turned on.

For more information, see “Snapping in the Timeline” on page 500.

2 Choose the Select Track Forward tool in the Tool palette.

3 Click the first clip to the right of the track gap.

All clips to the right are selected.

4 Drag the clips to the left until they close the gap and snap into place beside the earlier clip. 
This performs an overwrite edit.
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To determine the duration of a gap in the Timeline:

1 Select the track with the gap as the target track.

2 Position the playhead in the gap.

3 Do one of the following:

m Choose Mark Clip from the Mark menu.

m Click the Mark Clip Button in the Canvas.

m Press X.

The gap’s duration is shown in the Timecode Duration field in the Canvas.

The gap is marked, just as 
you would mark a clip.

The Timecode Duration field shows 
the duration of the marked gap.
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Trimming Edits Using the Trim Edit Window
You can trim edits very precisely in the Trim Edit window. This window shows a two-up 
display with the Out point of the outgoing clip on the left and the In point of the incoming 
clip on the right. Two green bars show which trimming functions are available. You can ripple 
edit either side of the selected edit point or roll edit both sides. 

To perform these edits, drag the handles in the Trim Edit window scrubber bars, or move the 
playhead (using the J, K, and L keys or typing timecode values) and set new Out and In 
points for the selected edit point. Finally, you can play back your edit to test how well your 
modified edit point works. 

Controls in the Trim Edit Window

m Track pop-up menu:  If you’ve selected multiple edits, this lets you choose the track that you 
want to view in the Trim Edit window. You can change the track you’re viewing at any time.

m Green bar:  Indicates what kind of trimming operation you’re about to perform:

m On the left side (over the outgoing clip):  A ripple edit to the outgoing clip’s Out point.

m On the right side (over the incoming clip):  A ripple edit to the incoming clip’s In point.

m Over both: A roll edit to the edit point between the clips.

Trim 
buttons

Playback controls for 
the incoming clip

Playback controls
for the outgoing clip

Current sequence timecode

Outgoing clip

Green bar

Transport
controls

Incoming clipTrack pop-up menu
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You can switch between these operations by pressing U or by clicking the relevant part of the 
Trim Edit window (as described in “Trimming an Edit in the Trim Edit Window” on page 712).

m Current sequence timecode:  Shows the timecode location of the currently viewed edit 
point in the sequence. You can type + or – and a timecode duration to adjust the edit 
forward or backward using the current mode (ripple or roll). 

Transport Controls

The Previous Edit and Next Edit buttons allow you to change which edit point in your 
sequence is shown in the Trim Edit window. Other controls allow you to play back only the 
edit you’re trimming to see how it works.

m Previous Edit:  Click to move the previous edit in your sequence into the active area of the 
Trim Edit window.

m Play In to Out:  Click to play from the beginning of the first clip to the end of the second clip.

m Play Around Edit Loop:  Click to play from a point before the current playhead position 
to a point following. The time intervals before and after the playhead position are 
determined by the preview pre-roll and preview post-roll settings in the General tab of the 
Preferences window.

m Stop:  Click to stop playback and position the playhead on the edit.

m Next Edit:  Click to move the next edit in your sequence into the active area of the Trim 
Edit window.

Playback Controls for Individual Clips

These controls allow you to move the playhead on either side of the edit point without 
modifying the edit point itself.

m Play, Previous Frame, and Next Frame:  Use the playback controls to play the clip, 
moving forward or backward one frame at a time.

Previous Edit Next Edit

Play In
to Out

StopPlay 
Around 
Edit Loop

Previous Frame Next Frame

Play
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The outgoing and incoming clips have separate playback controls. The play controls are 
for viewing only; they don’t change the position of an edit.

Trim Buttons

m Click the Trim Forward and Trim Backward buttons to add or subtract frames from the 
duration between the In and Out points. 

m Values for the –5 and +5 buttons can be set to trim a different number of frames by 
changing the Multi-Frame Trim Size setting in the General tab of the Preferences window. 
For more information, see “Setting General Preferences” on page 885.

Outgoing Clip Area

m Outgoing clip duration:  Displays the total time between the current In and Out points 
for the outgoing clip. This value changes to reflect any trim edits.

m Current timecode for the outgoing clip:  Displays the clip’s source timecode for the 
current position of the playhead.

m Out Shift:  Indicates the number of frames the Out point has been adjusted.

These buttons cannot 
be modified.

Trim Forward buttonsTrim Backward buttons

Outgoing clip name

Outgoing clip duration Current timecode for 
the outgoing clip

Out Shift

Mark In button

Edit point

Playhead
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m Mark In button:  Click this to set a new In point for the incoming clip at the current 
playhead position. This will perform a trim edit using the current mode (ripple or roll).

m Out Point:  Displays the current Out point for the outgoing clip.

m Playhead:  Playhead for the outgoing clip; lets you locate and jump to different parts of 
the clip quickly.

Incoming Clip Area

m Incoming clip duration:  Displays the total time between the current In and Out points 
for the incoming clip. This value changes to reflect any trim edits.

m Current timecode for the incoming clip:  Displays the clip’s source timecode for the 
current position of the playhead.

m In Shift:  Indicates the number of frames the In point has been adjusted.

m Mark Out button:  Click this to set a new Out point for the outgoing clip at the current 
playhead position. This will perform a trim edit using the current mode (ripple or roll).

m In Point:  Displays the current In point for the incoming clip.

m Playhead:  Playhead for the incoming clip; lets you locate and move or jump to different 
parts of the clip quickly.

Incoming clip nameIncoming clip duration
Current timecode for 
the outgoing clip

Mark Out button

In Shift

Edit point

Playhead
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Using the Trim Edit Window

You use the Trim Edit window to trim one or more edit points at a time. When trimming 
multiple edits at once, you can choose which edit point the Trim Edit window displays and 
trim each edit point differently. If you change the type of edit you’ll perform in the Trim Edit 
window, this change affects all of your selected edits.

Opening and Closing the Trim Edit Window

To open the Trim Edit window:

m Choose Trim Edit from the Sequence menu (or press Command-7).

The playhead jumps to the closest edit point on the target track. The Trim Edit window 
shows the clips surrounding this edit point. The Roll Edit tool is selected by default.

m Double-click an edit point in the Timeline with the Selection, Ripple Edit, or Roll Edit tool.

The Trim Edit window displays the clips surrounding the edit point. The selected tool and 
the part of the edit point you clicked determine the state of the green bars and the kind 
of edit you can perform. Press the U key to switch between the Ripple Outgoing, Roll, and 
Ripple Incoming trimming modes.

Selection tool

Roll Edit tool

Ripple Edit tool
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m Click an edit point or drag around one or more edits using the Edit Selection tool.

The Trim Edit window displays the clips surrounding the edit points you selected. If you 
selected multiple edit points, the clips located on the topmost video track are displayed. 
You can change this using the Track pop-up menu.

To close the Trim Edit window:

m Move the playhead in the Timeline or Canvas away from the edit.

m Click anywhere in the Timeline away from an edit to deselect all edits in the Timeline.

m Click the close box in the Trim Edit window or press Command-W.

Trimming an Edit in the Trim Edit Window

To trim an edit in the Trim Edit widow:

1 Select one or more edits to trim using the methods described above.

2 If you’re trimming multiple edits, choose the track you want to view from the Track 
pop-up menu. 

A two-up display shows the frames on either side of the selected edit point in the track 
you selected.

3 If you don’t want the selected trim edit, select a different one. 

As you change trimming modes, a green bar appears above the parts of the edit point 
selected for trimming. The pointer changes to indicate the type of trim edit.
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m Click the left image to trim the outgoing clip with a ripple left edit.

m Click the area between the images to do a roll edit.

m Click the right image to trim the incoming clip with a ripple right edit.

m Press the U key to switch between the trimming modes.

Ripple Edit tool

Trimming indicator bar 
only appears above 
the outgoing clip.

Trimming indicator 
bar appears over 
both clips.

Trimming indicator 
bar appears above 
the incoming clip.

Ripple Edit tool
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4 Trim the edit by doing any of the following:

m Click the trim buttons or use their keyboard equivalents to move the edit to the left or 
right in increments of frames.

m Press [ or ] to trim back or forward one frame.

m Press Shift-[ or Shift-] to trim back or forward five frames. The number of affected 
frames can be customized in the Multi-Frame Trim Size option of the General 
Preferences tab.

m Type + or – and a duration of frames to add or subtract, then press Return.

m Drag an edit in the scrubber bar to a new point. 

m Use the playback controls to play the clip. Mark a new Out point for the outgoing clip and 
a new In point for the incoming clip.

m Use the J, K, and L keys to shuttle the playhead within the outgoing or the incoming clip. 
Then mark new In and Out points by pressing I (set In point) and O (set Out point). 

Press L to move forward, press J to reverse playback, and press K to stop. Press L or K 
repeatedly to speed up and slow down playback. Press K and either L or J together to 
perform slow-motion playback.

Note:  As you use the J, K, and L keys, the audio shifts pitch smoothly, rather than stutter 
when you scrub.

The In Shift and Out Shift fields show the total number of frames that have been modified. 
The sequence in the Timeline reflects your changes.

5 Review your edit. 

See “Reviewing and Playing Back Your Edits in the Trim Edit Window” on page 715.

6 To trim another edit on the same track, use the Previous and Next Edit buttons to move to 
the next edit on the current track.

You can also select one or more edits in the Timeline, then go back to the Trim Edit window 
to perform additional trim operations.

7 When you are finished trimming, do one of the following:

m Move the playhead away from the edit in the Canvas or Timeline.

m Click in the Timeline to deselect all edits.

m Close the Trim Edit window.

To cancel an edit:

m Press Esc while the timecode field is visible. 

m Press Command-Z.
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Slipping a Clip in the Trim Edit Window

You can slip either clip displayed in the Trim Edit window. The Slip Item tool changes the 
clip’s In and Out points simultaneously while maintaining the clip’s duration. Surrounding 
clips are not affected.

To slip an edit in the Trim Edit window:

1 Double-click an edit in the Timeline to open the edit in the Trim Edit window.

2 Do one of the following:

m Shift-drag the edit on either scrubber bar to slip that clip. 

m Select the Slip Item tool in the Tool palette, then drag the edit.

As you drag, the display shows the In and Out point frames for the clip you are slipping.

3 Release the mouse button.

4 When you’re finished trimming, close the Trim Edit window.

Reviewing and Playing Back Your Edits in the Trim Edit Window

To play the edit using the transport controls:

m Click the Play In to Out button to play from the beginning of the first clip to the end of 
the second clip.

m Click the Play Around Edit Loop button to loop the playback of the edit with pre-and post-roll.

Extra frames surround your edit point, defined by the pre- and post-roll settings set in the 
Preferences window (see “Setting General Preferences” on page 885).

m Click the Stop button to stop playback and position the playhead on the edit.

To view an individual clip:

m Use the playback controls for the outgoing or incoming clip.

m Use the J, K, and L keys. These keys control playback of the incoming clip, if present. If 
there is no incoming clip, then they control playback of the outgoing clip.

Press L to move forward, press J to reverse playback, and press K to stop. Press L or K 
repeatedly to speed up or slow down playback. Press K and either L or J together to 
perform slow-motion playback.

Note:  As you use the J, K, and L keys, the audio shifts pitch smoothly, rather than 
stuttering, as it doeswhen you scrub. 
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Audio/Video Synchronization in Final Cut Pro
Final Cut Pro keeps track of the sync relationship between the audio and video portions of all 
QuickTime movie clips that you’ve captured or imported into your project. When you edit 
these clips into sequences within your project, this relationship is shown by the linking 
indicators for the audio and video items that make up a clip in the Timeline window.

If a clip in the Timeline has synchronized stereo audio and video, its video appears as an item 
in a video track and its stereo audio appears as items in two associated audio tracks. The 
names of the linked items are underlined. As long as linked selection is turned on, clicking 
one item selects all three.

The underlined clip name 
indicates the link between 
audio and video items.
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Moving Items Out of Sync

Even when linked selection is turned off, Final Cut Pro keeps track of the relationship 
between the audio and video items constituting a single clip. If you move the audio of 
a clip independently from the video, Final Cut Pro keeps track of the offset between the 
two, displaying it as a timecode duration in a small red box at the head of each clip called 
an out-of-sync indicator.

A linked clip before selection.

A linked clip with 
audio only selected.

A linked clip with audio out 
of sync with the video.

Out-of-sync indicator
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An out-of-sync indicator appears whenever audio and video items from the same media file 
on disk overlap in the Timeline so they are out of sync. 

Although there are ways to override a clip’s link and even disable it, the fundamental sync 
relationship between a clip’s audio and video elements is remembered by Final Cut Pro and 
can be used to resync these clips.

Final Cut Pro does this by continuously checking to see if any overlapping audio and video 
items in the Timeline come from the same media file on disk. If they do and they are not in 
sync, Final Cut Pro determines how far out of sync they are and displays this value in the 
out-of-sync indicator for each item. 

If an audio or video portion of a clip is isolated in the Timeline and doesn’t overlap any other 
clips from the same file on disk, this indicator doesn’t appear.

Important  Final Cut Pro always knows the proper sync between audio and video items from 
the same media file on disk (unless you’ve changed this with the Mark in Sync command). 

Two overlapping audio 
and video items with the 
out-of-sync indicator

A pair of audio items 
with no accompanying 
video item 
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No indicator appears if you split the audio and video of a clip so far apart that they no 
longer overlap.

If you move these items back together so they overlap, the indicators appear again.

This also works with multiple instances of clips from the same media file on disk. For example, 
let’s say you have three items in your sequence, all from different parts of the same clip.

Audio moved away 
from video clip 

Audio moved back 
under clip 
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If you move the audio item to the left, so that it overlaps the first video item, out-of-sync 
indicators appear. The same happens if you move the audio item to the right.

What if you move all three items so that they overlap, but all are out of sync with one 
another? The first two items show out-of-sync indicators relative to one another and the third 
item shows an out-of-sync indicator relative to the item it overlaps.
720 Chapter  16   



In this way, Final Cut Pro gives you full control of the sync relationships between all of the 
clips that appear in your sequence. You can move them out of sync at any time, without the 
fear that you won’t be able to resynchronize them if you later change your mind.

Getting Clips Back in Sync

There are three ways to get the clips back into sync. You can move or slide the clips into 
sync. Or you can mark out-of-sync clips as in sync, so Final Cut Pro doesn’t show the 
out-of-sync indicators.

When Would You Want to Break Sync?

There are many reasons you might deliberately edit the video and audio portions of a 
clip out of sync to one another:

m Moving the visuals of an actor reacting to an off-camera voice to change the timing.

m Reediting an actor’s audio from one take to match the visuals of a different take.

m Changing the sync of ambient sound behind an image with no hard sync visuals.

m Performing sophisticated audio edits to sweeten an actor’s dialog.

Many of these reasons involve changing the timing of your edit or creating detailed 
audio edits to address creative issues. For more information on useful audio editing 
techniques, see Chapter 17, “Working With Audio,” on page 727.
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Moving a Clip Into Sync

When you move a clip into sync, it repositions the selected item in your sequence so that it’s 
once again in sync with its corresponding audio or video item. You can only move a selected 
item into sync if there’s enough room on its track. If another clip is in the way, then the 
selected clip moves as far as it can and an error message says “Unable to put item in sync. 
Another item is in the way.”

To move a clip into sync:

1 In the Timeline, Control-click the out-of-sync indicator on a clip.

2 Choose Move into Sync from the shortcut menu.

Before syncing

The clip is moved so
the audio and video

are now in sync.

After syncing
722 Chapter  16   



Slipping a Clip Into Sync

This leaves the clip in the same position in your sequence but slips the In and Out points 
within the clip so that it comes into sync with its corresponding audio or video item. This 
works in the same way as the Slip Item tool.

To slip a clip into sync:

1 In the Timeline, Control-click the out-of-sync indicator on a clip.

2 Choose Slip into Sync from the shortcut menu.

Before syncing

The clip’s contents are
slipped so it is now in

sync with the audio.

After syncing
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Marking a Clip in Sync

If you’ve moved the selected item out of sync deliberately and you want to permanently 
change that item’s sync relationship to its corresponding audio or video items in the 
sequence, you can use the Mark in Sync command. Final Cut Pro will mark the items’ current 
arrangement in your sequence as being in sync. 

If you move one of these items out of sync again, the out-of-sync indicator shows the number 
of frames to resync to the new sync point. Using Mark in Sync does not affect the original 
master clip in the Browser, nor does it affect your source media on disk. It only affects 
sequence clips in the Timeline.

To mark a clip in sync:

1 In the Timeline, select up to three items that you want to mark in sync (one video and two audio).

 

2 Choose Mark in Sync from the Modify menu.

The items are now marked in sync without changing their positions in the Timeline. The 
out-of-sync indicators disappear.

Out-of-sync indicator.
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If you select just the audio and move it out of sync, out-of-sync indicators appear. The new 
out-of-sync indicators show the offset between the new sync points you’ve selected, not the 
original offset.

The Mark in Sync command permanently affects a clip in your sequence. Once you’ve used it 
on a clip, the only way to restore the original sync point is to move the clip by hand so that 
it’s in sync and use the Mark in Sync command again, or to delete it and reedit a new 
instance of that clip into your sequence from the Browser.

Note:  Using the Mark in Sync command on a clip in your sequence does not affect that clip’s 
master clip in the Browser, nor does it affect the source media on disk.
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C H A P T E R

17

17 Working With Audio

The quality of audio is crucial to the success of your program. Today’s audiences are used to 
visual tricks like jump cuts, flash frames, deliberately distorted imagery, and low-resolution 
Internet video, but they expect audio to be comprehensible, smooth, and free from glitches 
and distortion. You can still exercise some creativity in how you edit and mix your audio; just 
remember that audiences generally have a much lower tolerance for audio irregularities than 
for those in video.

When you first start editing your project, your primary concern will probably be the overall 
structure of the story behind your piece. If you’re editing a dialog-intensive program, you’ll 
also pay very close attention to the audio tracks, using split edits to find good places in the 
dialog to cut from one clip to the next, so that the audio sounds as natural as possible. If 
music is important to your edited sequence, you’ll probably edit it into your sequence as 
well, so you can cut your video clips to match musical sections.

Once you’re done with the majority of the editing, it’s time to evaluate what else you want to 
do with your audio.
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Evaluating the Audio in Your Program
In Final Cut Pro you can take the audio tracks that were recorded with your video and edit 
them further; add additional tracks of music, sound effects, or voiceover; fine-tune the sound 
using audio filters; and blend the volume levels of all these tracks together into an effective 
whole. This process is often referred to as sound sweetening. 

About Sound Sweetening

Sound sweetening has three main goals:

m Editing out mistakes and inconsistencies in the audio of a program

m Setting appropriate volume levels for all the audio clips in a sequence

m Adding audio filters to manipulate the aural quality of clips in a sequence

Editing Out Mistakes and Inconsistencies in a Program’s Audio

While it’s important to strive for the best location recording possible, you’ll usually need to 
do a certain amount of cleanup for every track recorded in the field. If you’re working with 
vocal tracks, you might find yourself editing out background noises between lines, deleting 
comments from the director, or even trying to replace words that the actors tripped over 
during an otherwise perfect take. Final Cut Pro gives you a fine degree of control when 
editing audio clips, so you can make these kinds of changes.

Setting Appropriate Volume Levels for Audio Clips in Sequences

You can adjust the volume level of all the clips in a sequence relative to each other so the 
audio blends together effectively. If you’re editing a narrator speaking over music in the 
background, you don’t want the music to overwhelm the sound of the narrator’s voice. 
Conversely, if you’re editing a dramatic piece, you might add a sound clip of a phone ringing 
in the background that wasn’t in the original recording and adjust its volume to obscure an 
actor’s lines for effect. You can achieve this by setting the volume levels of the different audio 
clips in your sequence appropriately. 

Adding Audio Filters to Manipulate the Aural Quality 
of Clips in Sequences

Along with setting volume levels for the audio clips in your sequence, you may need to apply 
audio filters. Some, like Compression and Equalization, can be used to improve already good 
audio, making the dynamic range of a clip more manageable or clarifying an actor’s voice 
further. For audio clips with distortions, interference, or unwanted sound, you can use filters 
such as Hum Remover or DePopper to try to make the clips usable. 
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Options for Mixing Audio

How do you plan to finish mixing your audio? This is an extremely important question, 
because it affects what you’ll do to the audio in your edited sequence. Essentially, you have 
two choices:

m Exporting your audio for sweetening at an audio post-production facility

m Completing your final mix using Final Cut Pro

Exporting Audio for Sweetening at an Audio Post-Production Facility

Most projects with a reasonable budget go this route. Although Final Cut Pro is a capable 
audio-editing environment, having your audio done at a specialized post-production facility 
means you’ll have a professional audio editor and mixer working on your soundtrack. 
Someone with years of experience making audio tracks sound great can help you to bring 
your project alive with a finely honed soundtrack.

Another, less obvious reason to use a post-production facility is to have your audio worked 
on in a room where acoustics have been especially designed for mixing. Good monitoring 
speakers and high-quality audio equipment will allow your editor to hear everything that’s in 
the audio, so you can be confident that the frequencies and levels being adjusted in your 
audio are accurate.

If you decide to use an outside facility, make sure that you leave the audio in your edited 
sequence alone, other than editing the audio clips you want for continuity and catching any 
obvious editorial fixes, such as mispronounced words. Don’t add any filters and don’t 
overedit your audio (that’s the audio editor’s job). You’ll export your edited audio tracks so 
the audio facility can import them into their system for further work. Any filtering, mixing, 
and fine editing can be done by them. 

The most common way to export your audio is to use an OMF file (see Chapter 30, “About 
Multi-Track and OMF Audio Export,” on page 1211). You can also export an EDL for the audio 
facility to use as a starting point for recapturing your audio from scratch (see “Exporting an 
EDL” on page 1202). If you plan to export an OMF file, make sure your audio recording levels 
are clear and clean, with no distortion. The best way to get a good mix is to start with clean 
source material and capture it using a high quality audio interface. 

Completing Your Final Audio Mix Using Final Cut Pro

If you can’t or don’t want to use an audio post-production facility, you can complete your 
final audio mix in Final Cut Pro. If you decide to go this route, look at the rest of this chapter 
for information on creating more detailed audio edits, setting good levels, and adding filters 
to audio clips in your sequence in order to make the audio portion of your program the best 
that it can be.
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Basic Audio Concepts
To effectively manage the quality of the audio clips in your edited sequence, it’s important to 
understand some basic audio concepts.

About Sample Rates and Bit Depth

Sound takes the form of compressions and rarefactions in the air molecules between the 
source of the sound and our eardrums. When these sound waves hit a microphone, they are 
converted into an analog waveform that creates a facsimile of the original sound.

When this analog waveform is recorded to a DV camcorder or DAT recorder, or directly into a 
computer, it must be converted into a digital signal that can be written either to tape or to 
disk. The process of taking smooth analog waveforms and converting them into the ones and 
zeroes that a computer understands is known as analog-to-digital conversion, sampling, 
digitizing, or in Final Cut Pro’s case, capturing. 

Captured digital audio is described by its sample rate and bit depth. These two attributes 
determine how much information is used to describe your audio recording. The more 
information used, the better your audio will sound.

Sample Rate

The sample rate is the number of times per second an analog signal is measured by the 
computer—that is, the number of electronic snapshots made of the sound wave. Higher 
sample rates result in richer sound quality. Which sample rate you choose to work with 
depends entirely on the source material you’re capturing and editing. 

Audio sample rates

8 kHz–22.225 kHz These lower sample rates are used strictly for multimedia files. 

32 kHz and 48 kHz Mini-DV, DV-CAM, and DVC-Pro all use these two sample rates. 
Of the two, 48 kHz is preferred. ( When choosing a rate in your 
camcorder’s menu, 32 kHz = 12 bit and 48 kHz = 16 bit.)

44.1 kHz This sample rate is used for music CDs.
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During capture, make sure that you always set Final Cut Pro’s sample rate to that of your 
recorded source material. Mismatched sample rates can result in pops and crackles in the 
audio, incorrect audio/video sync, and generally diminished sound quality. Use the following 
rates, depending on your source material:

m 32 kHz if you’re capturing media from a DV camera that was set to 12-bit recording

m 44.1 kHz if you’re using your microphone input or other audio interface

m 48 kHz if you’re recording from a DV camera set to 16-bit recording or if you’re recording 
from an audio interface capable of this rate

If you edit clips into your sequence that don’t match your sequence’s audio sample rate, 
Final Cut Pro resamples your audio during playback. Mixing 44.1 kHz audio and 48 kHz audio 
sounds acceptable, but if you want to do this, your audio will sound best with the audio rate 
of your edited sequence set to 48 kHz. Upsampling audio in Final Cut Pro sounds better than 
downsampling it.

Bit Depth

The bit depth represents the amount of information used to describe your audio recording. 
Low bit depths result in a noisy recording, as there’s not a lot of information included in the 
recording. Higher bit depths result in a wider dynamic range, with the sound quality you 
expect your edited program to have. The main thing to remember is that the higher the bit 
depth, the higher the quality of your audio. 

m 16-bit audio:  For video capture and output, 16-bit audio is almost always used, although 
most DV camcorders also allow you to record in 12-bit mode (recording in 12-bit mode is 
not recommended).

m 8-bit audio:  In the past, 8-bit audio was often used for CD-ROM and Web video. Today, 
16-bit audio is usually preferred, but available bandwidth and compatibility with your target 
user’s system are your chief considerations when outputting video for multimedia use.

No matter what your intended output, it’s important to edit your audio at the highest 
possible quality. You can always lower the quality for output, but leave that for last.

Warning  Do not mix 32 kHz audio (12-bit) and 48 kHz audio (16-bit) in the same 
sequence. Doing so may result in slight audio distortion. 
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Compressing Audio

It’s best not to compress audio (including MP3 files) before editing in Final Cut Pro. Audio 
compression reduces quality and can cause a loss of audio/video sync. Because audio files 
are so much smaller than most video files, compressing your audio in advance is almost 
always unnecessary. 

Once you’ve finished your edit, you can export the audio of your project using one of a wide 
variety of audio codecs. For details, see “Exporting Audio Only” on page 1176

About Dynamic Range

To properly mix the various volume levels in your project, you need to understand the 
concept of dymanic range. Simply put, dynamic range is the difference between the loudest 
and the softest sound in an audio clip.

m An actor giving a dramatic performance might have a lot of dynamic range, as he 
alternates between whispering and bellowing. Classical music also tends to have a lot of 
dynamic range, since a piece can go from a single violin solo at the beginning to the 
sound of the full orchestra at the climax of the piece.

m An example of an audio clip with less dynamic range might be a voiceover narration, since 
such clips are usually kept at a fairly steady level. Also, the majority of electronic music is 
mixed at consistent levels.

Examples of audio 
compressors you 
can use for output
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You can see the dynamic range of a clip by looking at its waveform. For example, here are 
two waveforms. The top one is a section from a well-known classical song. The bottom one is 
from a piece of electronic music. From the widely varied shape of the waveform, you can tell 
that the classical piece has the greater dynamic range.

Notice that the loud and soft parts of the top piece of music vary more frequently, as 
compared to the fairly consistent levels of the bottom one. The long drawn-out part of the 
waveform at the left end of the top piece is not silence—it’s actually a very long, low section 
of the music.

Sometimes you’ll want a lot of dynamic range. Sometimes you won’t. It all depends on the 
kind of project you’re working on and your planned method of distribution. 

About Signal-to-Noise Ratio

Signal-to-noise ratio indicates the ratio between the average loudness of the subject and the 
background noise in your recording. Background noise can be many things—tape hiss, the 
rustle of clothes, the rumble of traffic, even the noise floor of the recording equipment 
you’re using. Essentially, it’s everything you don’t want to hear. 

It’s important that the signal-to-noise ratio of your recorded clips be fairly high, so that actors’ 
voices are comprehensible and clear. If the signal-to-noise ratio of a captured clip is low, the 
actors’ voices will sound too quiet. If you mix up the clip’s level to compensate, you’ll mix up 
the level of all the background noise as well, resulting in poor audio quality. Microphone 
placement, the aural environment in which you’re recording, and the level adjustment of your 
recording equipment all affect the signal-to-noise ratio of your recorded clip.

Waveform from a well-
known classical piece

Waveform from an 
excerpt of electronic 
music
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Setting Proper Audio Levels
Before discussing how to adjust audio levels in Final Cut Pro, let’s take a closer look at one 
of the waveforms from the previous section, so you can better understand the different parts 
of an audio signal as well as how an audio clip’s waveform corresponds to what you hear 
during playback.

The most important distinction you should learn to make is the difference between an audio 
clip’s peaks and its average loudness:

m Peaks are short, loud bursts of sound that last a fraction of a second. In spoken dialog, 
letters like P, T, and K at the beginnings of words can result in little peaks if the person 
speaking is close to the microphone. In the musical example above, the peaks occur at 
the very beginning of handclaps and drum hits. Peaks occur frequently during the attack, 
or beginning, of percussive sounds in a clip. 

m The average loudness of a clip generally determines its overall perceived volume, and this is 
probably somewhat lower than the level of the peaks. In the example waveform, the level of 
average loudness appears as the densest, darkest part around the middle. If you mix the 
volume of a clip up or down in a sequence, it’s probably because you’re responding to the 
average loudness of that clip, rather than the brief peaks that occur throughout.

Because of the way analog audio is sampled into digital waveforms, it’s important to keep 
both of these features of an audio clip in mind. The goal of any audio recording is to 
maximize the quality of the sound, and while recording audio with a good strong signal-to- 
noise ratio is important, you don’t want to overdrive the audio peaks in your clips.

Waveform from 
an excerpt of 
electronic music

Peaks

Average loudness
of track

What Is Overdriven Audio?

Overdriving audio is simply recording it too loudly. When this happens, the electrical 
levels recorded to tape are too high and get cut off, resulting in a crackly, brittle- 
sounding clip that is unsuitable for use in most projects. The maximum audio signal you 
can record without overdriving is set at 0 dB on all digital systems, Final Cut Pro included.

If you record overdriven audio, the only solution is to record it over again. There is 
currently no effective way of fixing overdriven audio.
734 Chapter  17   



Setting Proper Levels While Recording

Recording devices such as analog Nagra recorders and analog multitrack decks allow a 
certain amount of overdriving before there’s noticeable audio distortion. Typically, this range 
is from 0 to about +3 dB. This doesn’t mean that analog recording levels are set between 0 
and +3 dB; it means that a few intermittent peaks of your audio signal can jump into this 
range from time to time. (The average loudness of the analog audio signal should remain 
under 0 dB). When sounds are overdriven on analog devices, they don’t sound distorted. 
This is one of the reasons the “warm” sound that some attribute to analog devices. 

Digital recording devices, such as DV camcorders, DAT decks, and digital Nagra recorders, 
work differently. An advantage to the analog-to-digital conversion process is that it allows for 
extremely clean recordings. Since the noise floor of the equipment itself is so low, analog 
problems like tape hiss are virtually eliminated. On the other hand, digital audio recording 
devices are completely unforgiving with overdriven signals. When you record audio digitally, 
any parts of the signal that go over 0 dB are clipped off harshly. There is no leeway above 0 
dB, not even for intermittent audio peaks. In addition, clipped digital audio sounds much 
worse than in analog devices.

As a result, the way you set your levels with digital devices, and with Final Cut Pro in 
particular, is different from how you’d set levels on an analog device. Let’s compare an analog 
Volume Unit ( VU) meter with the audio meters found in Final Cut Pro:

When setting an analog level, you should try to keep the majority of the audio signal (the 
average loudness) in the neighborhood of –3 to 0 dB, with momentary peaks in the +3 dB 
range. When setting levels on a digital system, since you can’t let any part of the signal go 
above 0 dB, you’ll adjust the levels for the average loudness of your audio much lower, 
generally between –20 and –12 dB, so that the momentary peaks in the signal register in the 
–12 to –6 dB range. Essentially, the digital –12 dB level that you use for reference (or –20 dB, 
depending on how you set up your equipment) is the equivalent of 0 dB analog.
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How you set levels also depends on the dynamic range of what you’re recording. If you’re 
recording a narrator doing a voiceover, you can probably bring the recording level close to 
–12 dB since the narrator’s voice consistently remains within a fairly small range. However, if 
you’re recording two actors having an argument, you’ll probably set the levels lower than you 
normally would. Since the peaks that occur when the actors are yelling at each other may be 
12 dB or more over the actors’ normal speaking voices, you might want to set your levels at 
around –18 dB, so there’s enough “headroom” to accommodate the peaks in the scene 
without distortion. You can get away with setting levels this low when using digital recording 
equipment because the signal is much cleaner.

Note:  Setting levels for audio capture isn’t important when you’re capturing audio into Final 
Cut Pro from DV camcorders and decks. Assuming proper levels were set on the DV 
camcorder when the audio was recorded, this process has already been done. When you 
capture audio and video into Final Cut Pro, you’re simply copying the existing data at the 
prerecorded signal strength. 

What Recording Level Should You Use for Reference?

The reference level you use for digital audio capture should be determined by the dynamic 
range in your recording. Since you won’t have very much control over the levels recorded in 
the field (other than trying to make sure that they aren’t distorted when you capture them 
into Final Cut Pro), you mainly need to make sure that the highest peak in the audio clip 
you’re recording reads less than 0 dB on Final Cut Pro’s audio meters.

More About Measuring in Decibels (dB)

The unit of measurement for audio levels is decibels, or dB. This is a logarithmic scale 
used to describe the loudness of sound as perceived by the human ear. This loudness, 
which is referred to as an audio clip’s level, is measured in units of dB ranging from 
–60 to 0 dB in Final Cut Pro. For the technically savvy, dB in this sense actually refers 
to dBfs. 

There are several dB scales: dBm (magnetic), dBv (voltage), dBa (acoustic), and dBu 
(power dissipation). All of these represent loudness differently for various purposes. 
For digital video, dBfs is the standard and is referred to as dB in Final Cut Pro 
documentation.

(It’s interesting to note that 1 dB corresponds to approximately the smallest volume 
change that the average human ear can perceive; and –6 dB corresponds to one-half 
the volume of a 0 dB signal.)
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To adjust your audio gain setting prior to capture:

1 With your camcorder or deck connected to the capture card, cue your videotape to the 
loudest section of the tape you’re going to be capturing from.

2 Play back your tape and use the Gain slider to adjust the audio level so that the visible bars in 
Final Cut Pro’s audio meters register at an average of around –12 dB (represented by the 
green section of the audio meter).

It’s OK for the audio to peak between –12 dB and –3 dB (in the yellow section of the audio 
meter). Try to keep the audio from going higher than 0 dB, as this results in distortion.

3 If you’re capturing material from different parts of a tape with widely varying levels, you may 
have to repeat these steps several times, logging different capture levels for different clips.

Using 0 dB as a Reference for Mixing and Output

Setting the recording levels of clips you’re capturing is only the beginning. Once you have all 
the audio from your video clips, music, voiceover, and sound effects captured to disk at good 
clean levels, you need to start thinking about what levels you’ll use to output them back to tape.

All programs edited for broadcast have their audio levels adjusted relative to a 1 kilohertz 
(kHz) reference tone that has an analog level of 0 dB. This reference tone, which sounds like 
a long beep, is set at either –12 dB, –18 dB, or –20 dB on a digital system, whichever 
standard you’ve settled on. When this tone is fed into the audio or video deck that you’ll be 
using for output, that device’s VU meter should read 0 dB. 
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What Reference Level Should You Use for Mixing?

The reference level you use for mixing depends on the amount of dynamic range you want in 
your program. In your mix, you have total control over all the levels in the program. By 
changing the levels of different clips and by using the Compression filter, you can pretty 
much limit or expand the dynamic range of the program to whatever you want.

The catch is that the playback equipment used to watch your final program must be able to 
handle the program’s dynamic range. For example, television stations normally accommodate 
only 6 dB of dynamic range in the programs they broadcast. That’s 6 dB between the average 
loudness and the top peaks of the soundtrack. If your program has a greater dynamic range, 
they’ll send your tape back complaining that it’s “too hot.” Dolby Digital feature film 
soundtracks, on the other hand, can accommodate up to 20 dB of dynamic range! That’s why 
those explosions seem so loud. If you’re not going to be submitting your program for 
broadcast, a dynamic range of about 12 dB is fine for most situations.

The amount of dynamic range you want (or are allowed) to use in your project determines 
the reference level you use. This is because you need to leave enough headroom above your 
reference level to accommodate the dynamic range in your mix.

Venue Acceptable amount of dynamic range

Theatrical Dolby Digital 20 dB

Average videotape 12 dB

Television broadcast 6 dB
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Headroom is the difference between the reference level and the loudest signal you can have in 
a mix without distortions. If you set the reference level in your project to –20 dB, you end up 
with nearly 20 dB of headroom, since 0 dB is the standard limit for your loudest sound. If you 
set the reference level in your project to –12 dB instead, you have less headroom. Even though 
the overall level of your audio is stronger, you won’t be able to have as much dynamic range. 

How much dynamic range you allow in your program depends, once again, on the ultimate 
destination of the project. If you’re editing a program for broadcast, a reference level of –12 
dB is fine, since you are only allowed 6 dB of dynamic range anyway. But if you’re working on 
a theatrical production with a lot of loud noises, consider using a reference level closer to 
–18 or even –20 dB (both of these are frequently used standards).

Remember that the ultimate goal is to insure that audio doesn’t peak over 0 dB in your mix 
(as displayed in Final Cut Pro’s audio meters) and won’t peak over +3 dB or so when you 
output it on analog equipment.
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As you mix the audio in a sequence, keep checking Final Cut Pro’s audio meters to ensure 
that the loudest sounds in your program don’t peak much over –3 dB, to prevent distortion 
on output. If you’ve set your deck’s average level to match Final Cut Pro’s average level, 
outputting to tape at a good level without distortion will be fairly easy. Remember, if your 
level in Final Cut Pro is under 0 dB, it’s okay to peak over 0 dB on your analog equipment, 
as long as

m you’ve calibrated your deck’s recording levels to match Final Cut Pro’s output levels

m the peaks on your deck don’t go over the level that causes distortion on your output 
equipment. What this level is depends on your equipment. You’ll learn over time how 
your program’s dynamic range, as displayed by Final Cut Pro’s audio meter, is displayed by 
your output device’s VU meter.

Note:  If the level does peak at or above 0 dB when playing back in Final Cut Pro, the “peak 
light” on Final Cut Pro’s audio meters will go on and stay on. So, if you see the “peak light” go 
on, you know that the signal is getting clipped.

To calibrate your output device:

1 In the Viewer, choose Bars and Tone from the Generator pop-up menu.

2 Click the Audio tab, then set the audio level of the 1 kHz tone to –12 dB, –18 dB, or –20 dB. 

3 Connect your output device to your computer or other output hardware and make sure 
external video is turned on.

4 Click the Play button in the Viewer so that you can see the audio level of your clip on the VU 
meter of your output device.

5 Adjust the recording levels of your output device such that the tone peaks at 0 dB exactly.

Level set to –12 dB
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Outputting Bars and Tone at the Head of Your Tape

When you output your program to a tape for duplication or delivery to a broadcast facility, 
you’ll typically include a 1 kHz reference tone at the beginning, or head, of the tape. It’s 
important to create a proper audio mix for your program relative to this 1 kHz reference 
tone. Here’s why: 

m If you are duplicating the tape:  Most tape duplication facilities cue your tape up to 
where the reference tone is, set the levels, and then run your job without checking levels 
elsewhere on the tape. If the mix is either too quiet or too loud relative to this tone, all of 
your duplicates will either be soft or distorted.

m If you’re delivering your program for broadcast:  Most broadcast facilities have very 
stringent requirements about what they’ll air. If your program’s audio levels are too hot 
(loud) or too soft, you might run into trouble with the broadcast engineer. In the worst 
cases, they’ll return your tape to you as unsuitable for broadcast, and require you to send 
them a new one with proper levels.

Label Your Tapes

If you’re outputting to a digital format, make sure you note what level your 1 kHz tone 
is set to on the label of your tape. If you’re outputting to an analog format, like Beta 
SP, you’ll always set your 1 kHz tone to 0 dB.

If you’re creating a digital master tape, it’s also a good idea to make a note of the level 
(in dB) of the highest audio peak in your program, so that if your reference level isn’t 
set to what the recipient expects, they’ll know how much dynamic range is in your 
program and won’t turn the levels up too high. 

For example, if you’ve decided to output your project with a –18 dB reference tone, 
and the highest peak in your program is at –7 dB, you’d write both these values on the 
label of your master tape.
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Settings That Affect Audio in Final Cut Pro
The following presets in the Audio/Video Settings window include settings that affect the 
audio in your project:

m Capture presets:  When you first install Final Cut Pro, the sample rate for capture from DV 
devices is set to 48 kHz. For information on creating an Easy Setup with the audio settings 
you need for your particular capture device, see Chapter 5, “Working With Easy Setups, 
Presets, and External Video Settings,” on page 99.

m Sequence presets:  These settings affect the sample rates for new sequences. See “Working 
With Easy Setups” on page 101 for information on creating an Easy Setup with the audio 
settings you need for your particular project. 

Once a sequence is created, you can change the sequence settings to modify the audio 
rate, if necessary. 

Ways to Import Audio Into Your Project
To bring audio into projects in Final Cut Pro, you can do any of the following:

m Capture a clip with audio:  See “Capturing Video and Audio” on page 265 for information.

m Capture audio from videotape without the accompanying video:  For information on 
how to do this, see “Creating a Preset to Capture Audio Only” on page 280.

m Capture audio alone using the microphone input of your computer:  Unless you’re 
working on a project where optimum sound quality is unimportant, it’s not a good idea to 
use the microphone input of your computer for recording the final audio for your 
program. For more information on setting up Final Cut Pro for capturing audio alone, see 
“Creating a Preset to Capture Audio Only” on page 280.

m Capture audio using a Sound Manager-compatible audio capture card:  If you’re 
capturing audio from DAT or other audio recording devices, using a third-party video or 
audio capture card is highly recommended. For information on setting up a capture 
preset for capturing audio by itself, see “Creating a Preset to Capture Audio Only” on 
page 280. For information on compatible capture cards, go to the Final Cut Pro Web site at 
www.apple.com/finalcutpro

m Import clips from an audio CD:  Importing clips and music directly from audio CDs is an 
easy way to import audio, and you don’t have to worry about setting levels. 
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m Import clips from a sound effects CD-ROM collection:  Importing audio clips from 
CD-ROM is even easier. All you have to do is copy your clips onto one of your scratch 
disks, and then import them into your project. 

Do not import clips from a CD-ROM directly into Final Cut Pro. These clips will go offline 
as soon as you eject the CD from the drive. For information on importing audio, see 
“About Importing Audio Files” on page 307.

Working With Audio in the Viewer
You can use the Viewer’s Audio tab to edit the audio of a clip opened from the Browser. The 
Audio tab lets you view the audio waveform, set In and Out points, markers, and keyframes, 
and change the volume level, and stereo pan or spread settings.

In Final Cut Pro, the smallest increment of video is a frame, but the smallest increment of audio 
is 1/100th of a frame, since audio is captured as samples. This means that audio keyframes, as 
well as the sync between the video and audio tracks of a clip, can be set with an accuracy of 
1/100th of a frame.

1/100th of a frame increments

1 frame
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Selecting Audio Tabs in the Viewer

When you open a clip with audio in the Viewer and click the Audio tab, or if you double-click 
an audio item in the Timeline to open that clip in the Viewer with the Audio tab selected, 
Final Cut Pro displays your audio as graphical waveforms. How stereo audio is displayed 
depends on whether it’s a stereo pair.

m If audio is a stereo pair, a single Audio tab contains the waveforms of both the left and 
right channels of audio. Level changes applied to one are also applied to the other, and the 
stereo control is set to Spread. Editing audio as a stereo pair is useful for intrinsically stereo 
material, such as music. You can perform a split edit between the video and audio of a clip 
that has stereo pair tracks, but you can only trim the two audio tracks together, as a unit.

Channel

Channel

Audio tab
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m If audio is not a stereo pair, there are two tabs in the Viewer, called Ch 1 and Ch 2. Each 
tab displays only the waveform for that audio track, and levels applied to one are totally 
independent of the other. The stereo control is set to Pan. This setting is useful for audio 
such as stereo field recordings, where a boom microphone may be on audio channel 1, 
and a lavalier microphone’s recording of the same material on channel 2. Using the level 
controls, you can enable or disable the tracks you want to use. You can also trim the In 
and Out points of each audio channel separately in the Timeline.

Ch 1 and Ch 2 tabs
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Enabling and Disabling Stereo Pairs in the Timeline

Although stereo pairs are meant to be used for intrinsically stereo audio like music or stereo 
sound effects, any two tracks of audio can be made into a stereo pair. This operation can only 
be performed in the Timeline.

To create a stereo pair:

1 Select one or more pairs of audio items in the Timeline. (Use the Command key to select the 
second item, if necessary.) If you click one of a linked pair of audio clips, the second one is 
selected automatically.

2 Do one of the following:

m Choose Stereo Pair from the Modify menu.

m Press Option-L.

The stereo pair indicators appear on the selected tracks in the Timeline. 

Stereo pair indicators
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If the In and Out points of two clips that you make a stereo pair don’t match, the edit points 
of both audio clips are trimmed back to fit whatever duration they originally overlapped. The 
levels, pan/spread settings, and filters that were applied to the top clip are applied to both. 
(Levels, pan/spread settings, and filters from the bottom clip in the Timeline are ignored.)

To separate a stereo pair, choose Stereo Pair from the Modify menu so that the menu item 
is unchecked.

Note:  If you select a stereo pair in the Timeline and apply panning to it, the stereo pair 
designation is removed from the two tracks.

Two tracks that are 
not a stereo pair; 
length and volume 
levels differ, top track 
has a filter.

Volume level indicators
(at a different level on

each track)

Audio filter indicator on top track

Stereo pair indicators

Stereo pair; only 
overlapping parts of 
the tracks remain, 
and volume and filter 
are copied from top 
track to bottom track.

Audio filter indicator 
(now on both tracks)

Volume level indicator
(the same on both tracks)
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Audio Tab Controls in the Viewer

When you click an audio tab in the Viewer, the transport controls, marking controls, jog and 
shuttle controls, and the Recent Clips and the Generator pop-up menus at the bottom of the 
window are the same as those in the Video tab. These controls allow you to navigate through 
your clip, set In and Out points, markers, split edits, and so on. In and Out points that you 
mark in an audio tab, whether simple edits or split edits, are also marked in the Video tab.

The following controls are specific to an audio tab:

m Level slider:  This slider adjusts the amplitude, or volume, of the currently selected audio 
clip between +12 and –60 dB. As you drag the slider, the number in the dB field and the 
volume overlay are both updated.

You can also adjust the volume by typing a number in the dB field to the right of the Level 
slider. The number you enter can include a decimal value, such as 6.23. 

If there are no level keyframes in the current clip, adjusting the Level slider affects the 
level of the entire clip. If there are level keyframes, using the slider will either

m adjust the level of a keyframe at the current position of the playhead

m add a new keyframe to the level overlay and adjust it to the new level

Level control
adjusts volume.

Dual waveforms
indicate a stereo track.

Spread control
adjusts stereo

sound placement.

Keyframe
buttons

Drag hand moves 
clip to the Canvas, 
Timeline, or Browser

Jog 
control

Line shows
sound level

Zoom control scales
the view of a clip.

Shuttle control

Reset 
button

Clip 
Duration

Current 
timecode

Transport 
controls
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A change in level between any two keyframes appears as a slope on the level overlay in 
the audio tab of the Viewer. Changes to the level overlay in the Viewer are mirrored by 
the level overlay on that clip in the Timeline. 

Note:  Hold down the Shift key while dragging the Level slider to adjust the volume 
within two decimal points of precision.

m Level Keyframe button:  The keyframe button to the right of the dB field places a 
keyframe on the level overlay at the current playhead location. You’ll place keyframes 
on the audio level in preparation for creating a dynamic change in level over time.

m Level keyframe navigation buttons:  These buttons, to the left and right of the Level 
Keyframe button, allow you to move the playhead forward or backward from one 
keyframe on the level overlay to the next.

m Pan/Spread control:  This control has two modes, depending on what kind of audio 
you’ve opened in the Viewer:

m Spread:  If the audio clips in the Viewer are a stereo pair, this slider lets you swap the 
left and right channels. The default setting of –1 sends the left audio channel of your 
clip to the left channel output and the right audio channel to the right channel output. 
A setting of 0 outputs the left and right audio channels equally to both speakers, 
essentially creating a mono mix. A setting of +1 swaps the channels, outputting the 
left audio channel to the right speaker and the right audio channel to the left speaker. 

m Pan:  If the audio clips in the Viewer are not a stereo pair, this slider lets you pan the 
audio channel in the currently selected audio tab between the left and right channels, 
the same as you would with any mono audio clip.

As with the Level slider, if there are no pan/spread keyframes in the current clip, then 
adjusting the Pan/Spread slider affects the pan or spread of the entire clip. If there are 
pan/spread keyframes, using this slider will either

m adjust the pan or spread of a keyframe at the current position of the playhead

m add a new keyframe to the pan/spread overlay and adjust it between the left and right 
output channels

Pan adjusts sound 
between channels. 
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A change in pan or spread between any two keyframes appears as a slope on the pan/spread 
overlay in the audio tab of the Viewer. Changes to the pan/spread overlay in the Viewer are 
mirrored in the Timeline. 

m Pan/Spread Keyframe button:  This button to the right of the Pan/Spread slider places a 
keyframe at the current playhead location on the pan/spread overlay. These keyframe 
markers can be used in preparation for dynamically panning or spreading an audio clip’s 
output from one stereo channel to another.

m Pan/Spread keyframe navigation buttons:  These buttons, to the left and right of the 
Pan/Spread Keyframe button, allow you to move the playhead forward or backward from 
one keyframe on the pan/spread overlay to the next. The left button moves the playhead 
to the next keyframe to the left of the playhead’s current position, and the right button 
moves the playhead to the next keyframe to the right.

m Reset button:  This button deletes all marked keyframes on both the level overlay and 
the pan/spread overlay of the currently selected audio track, and resets the level and 
spread values to their original captured states (0 dB for the audio level, and –1 for the 
pan/spread level).

m Drag hand:  Use this to drag the current audio clip to the Canvas, the Timeline, or the 
Browser. Clicking the waveform itself moves the playhead to the frame on which you clicked.

m Waveform display area:  A graphical representation of the audio clip, showing the peaks, 
valleys, and average loudness of the selected channel or channels. If you zoom in on the 
waveform’s display, you will see progressively more detail in your waveform. Clicking 
anywhere in the waveform area moves the playhead to that frame, and dragging scrubs 
the clip. 

m Ruler:  When you’re looking at the contents of an audio tab in the Viewer, you’ll see two 
playheads at work, both of which are locked together. The normal Viewer playhead is 
located in the scrubber bar below the waveform display area, but there’s also a second 
playhead within the waveform display area itself.

The ruler above the waveform display area shows the currently displayed range of your clip. 
If you zoom all the way out, this ruler shows the clip from its start point to its end point, and 
the movement of the Viewer playhead in the scrubber nearly matches that of the audio 
playhead in the waveform display area. Using the Zoom control, you can expand or contract 
this ruler, decreasing or increasing how much of the clip’s waveform is displayed. 

The playhead in the waveform viewing area lets you move around in an audio clip with 
more precision, using the waveform itself for reference as you perform edits or set 
keyframes for level and pan/spread (down to 1/100th of a frame, if necessary). Clicking 
anywhere on the ruler or in the waveform display area moves the playhead to that frame 
in your audio clip. You can also drag the playhead to scrub the clip, or shuttle through the 
clip using the shuttle control or the J, K, and L keys. If you hold down the Shift key while 
dragging the playhead, you can move the playhead in increments of 1/100th of a frame, 
which lets you do trim edits at a subframe level, or perform precision operations.
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The playhead in the scrubber bar works the same way it does in the Video tab of the 
Viewer. The whole length of the scrubber represents the entire length of the audio clip 
opened into it, and clicking or dragging the playhead in the scrubber bar immediately 
takes you to that part in your clip.

The markers and In and Out points for your clip also appear in the ruler.

m Level overlay:  Drag this line up or down to change the sound level. If you add keyframes 
to the overlay, you can create changes in level over time.

m Pan/Spread overlay:  Drag this line up or down to change the pan or spread for this clip. If 
you add keyframes to the overlay, you can create changes in panning or spreading over time.

m Zoom control:  This lets you zoom in and out on the waveform display area, expanding 
and contracting the audio ruler as you do so. Zooming in shows a more detailed look at 
the waveform, as a result showing much less of the audio clip as a whole. Zooming out 
shows less detail, but allows you to see more of your audio clip’s total waveform. When 
you use the Zoom control to zoom in or out, the area of the waveform visible when you 
click the control stays centered as you zoom in or out.

Using the zoom keyboard shortcuts will result in a slightly different behavior. Pressing 
Command- + (plus) or Command- – (minus) will zoom in or out of the waveform, with 
the view centered on the current position of the playhead.

m Zoom slider:  Like the Zoom control, this allows you to zoom in and out of the waveform 
displayed in the Viewer. Dragging the thumb tabs on either side of the slider zooms in or 
out of the waveform, moving its visible area in the direction you drag. Pressing the Shift 
key and dragging a thumb tab zooms both thumb tabs, and leaves the visible area of the 
waveform display area centered.

Once you’ve zoomed into a sequence, you can drag the Zoom slider to scroll along the 
entire duration of your audio clip. The In and Out points of your clip will also appear in 
the scroll bar of the Zoom slider.
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Opening Clips in the Viewer
There are several ways you can open an audio clip in the Viewer.

To open an audio clip from the Browser:

1 Select the clip by doing one of the following:

m Click the clip in the Browser.

m Use the arrow keys to move through your clips in the Browser.

2 To open it in the Viewer, do one of the following:

m Drag the clip to the Viewer. 

m Double-click the clip in the Browser.

m Press the Return key.

3 If the clip contains both audio and video, click its audio tab to see the waveform display.

To open a sequence audio clip from the Timeline:

1 Do one of the following:

m Double-click an audio clip in your sequence. If the clip contains both audio and video, 
double-clicking the audio track brings the audio tab to the front automatically.

m Drag the desired clip from your sequence to the Viewer.

m Move the Canvas or Timeline playhead over the clip you want to open, then press the 
Return key.

2 If the clip contains both audio and video, you may need to click its audio tab to see the 
waveform display.

Dragging an Audio Clip to the Canvas, Browser, or Timeline
If you want to drag the current audio clip to the Canvas, the Timeline, or the Browser, you 
must do so using the drag hand at the top of an audio tab. Clicking the waveform itself 
moves the playhead to the frame you clicked.

Use the drag hand to 
move an audio file.
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Zooming and Scrubbing Through Audio Clips
Navigating through audio tracks in the Viewer is largely the same as navigating in the Video 
tab. There are some additional features, however, that you should be aware of.

Zooming In or Out of the Waveform Display Area

When you navigate through a clip in the Video tab of the Viewer, you only see the frame at the 
location of the playhead. Zooming into this frame enlarges the visual image, but doesn’t change 
your position in time. Waveforms in an audio tab work differently. Since they represent your 
entire audio clip, you can navigate through a waveform as you would a clip in the Timeline. As 
you move through the waveform, you’ll notice that the playhead in the scrubber bar under the 
waveform display area moves in conjunction with the playhead in the waveform area.

The scrubber bar in the Viewer always represents the entire duration of the clip in the Viewer. 
The ruler above the waveform display area, on the other hand, is not so constrained. Using the 
Zoom control and the Zoom slider at the bottom of the waveform display area, you can zoom in 
and out on the waveform display area in the Viewer. This expands and contracts the audio ruler, 
allowing you to see more or less detail in an audio clip’s waveform. While the smallest unit you 
can see in the video track of a clip is a single frame, you can see a clip’s audio waveform in 
increments as small as 1/100th of a frame.

To zoom in and out of the audio waveform using the Zoom control:

m Click or drag the Zoom control to zoom in or out while keeping the material in the 
waveform display area centered. 

Clicking to the right of the control zooms out to show more of the duration of your clip; 
clicking the left zooms in to show more detail.

To zoom in and out of the audio waveform using the keyboard 
or menu commands:

1 Move the playhead to the position in the waveform display area where you want zooming to 
be centered. 
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2 Do one of the following:

m Choose Zoom In from the View menu, or press Command-+ (plus) to zoom in on the 
audio clip’s waveform. Pressing Command-+ (plus) repeatedly shows more and more 
detail, down to the individual frames of your audio clip. 

m Choose Zoom Out from the View menu, or press Command-– (minus) to zoom out, 
reducing the amount of detail but showing more of the audio clip’s waveform. Zooming 
out stops when the entire clip fits in the waveform display area.

Zooming in and out on an audio clip’s waveform using menu or keyboard commands keeps 
the visible area of the waveform display area centered as you zoom.

Waveform before 
zooming in

Waveform after 
zooming in

Playhead is still centered after zoom. 
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To zoom in and out of the audio waveform using the Zoom slider:

m Drag the thumb tab on the left or right side of the slider to zoom in or out of the 
waveform from the selected end of the slider, while keeping the other end locked in 
place. This moves the visible portion of the waveform in the direction you drag.

m Hold down the Shift key as you drag one of the thumb tabs to adjust both ends of your view 
at the same time, centering the visible area of the waveform display area while you zoom.

To zoom in and out of the Timeline using the Zoom tool:

1 Select the Zoom In or Zoom Out tool in the Tool palette.

2 Do one of the following:

m Click in the waveform area of a track in the Timeline.

Drag one of the 
thumb tabs to zoom. 

The position of the playhead 
moves after zooming.
  Working With Audio 755



m Drag to select a region to zoom in or out on.

Clicking or dragging repeatedly increases or decreases the zoom factor, depending on which 
tool is selected. When the Timeline is zoomed in or out to the maximum level possible, the 
+ (plus) and – (minus) signs on the Zoom tools disappear.

Note:  Pressing the Option key with either the Zoom In or the Zoom Out tool selected 
temporarily changes it to the opposite tool.

Scrolling Through a Zoomed-In Audio Clip

If you zoom into the waveform display area, you won’t be able to see all of the displayed 
waveform at once. There are three ways you can navigate through a zoomed-in audio clip:

m If you play back your audio clip, then stop playback, the waveform display area shows the 
section of your audio clip that the playhead moved to. 

m If you click or drag in the Viewer’s scrubber bar, the playhead and view inside the 
waveform display area matches the position where you clicked or dragged.

m If you want to move to another portion of the audio clip without moving the playhead, 
use the Zoom slider.

The length of the scroll bar under the waveform display area represents the total duration of 
your audio clip.

Before zooming 

Zoom In tool

After zooming
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To scroll horizontally through a zoomed-in clip in the Timeline:

m Drag the Zoom slider left or right. The displayed area of the audio waveform moves 
smoothly in the direction you drag.

m Click the scroll arrows at either end of the scroll bar to move the displayed area of the 
audio waveform incrementally to the left or to the right.

m Click inside the scroll bar to the left or right of the Zoom slider to move the displayed 
area of the audio waveform by one length of the Zoom slider’s current scale.

m Press the Up or Down Arrow keys to move the visible area of the audio waveform 
between the beginning, In point, Out point, and end of your clip.

Viewing an Audio Clip at Single-Frame Resolution

When you’re editing an audio clip in the Viewer, you can zoom in so far that the playhead is 
the width of a single video frame on the waveform. You can use this single-frame view, along 
with Final Cut Pro’s subframe syncing functionality, to match the beats of musical clips you 
edit together; or you can use it to set subframe keyframes to eliminate pops or clicks that 
occur at the audio edit points you’ve chosen. 

Subframe Audio Scrubbing

When an audio clip is displayed in the Viewer at maximum or near-maximum magnification, 
the playhead enlarges to cover the width of an entire video frame. At this level, you can move 
the playhead in increments of 1/100th of a frame, letting you make very minute adjustments 
to your audio.

To scrub an audio clip in subframe increments:

1 Zoom in on a clip in the Viewer to maximum magnification.

Scroll arrowCenter of Zoom slider

Scroll bar on either 
side of Zoom slider

Scroll arrow
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2 Hold down the Shift key as you drag the playhead.

If you do not hear audio from the monitoring speakers while scrubbing, you may need to 
turn up the volume.

Subframe audio scrubbing is primarily useful for several things:

m Setting keyframes within a single frame to eliminate pops and clicks in your edits 

m Setting keyframes within a single frame to fade from one audio clip to another. (This is 
not the same as adding a cross fade, or audio transition.)

m Adjusting the synchronization between the video and audio of a clip 

m Adjusting the sync of one audio clip in relation to another 

More About Audio Scrubbing

When an audio clip is displayed in the Viewer, you hear a somewhat fractured-sounding 
version of the sound as you drag the playhead (or scrub). You can drag the playhead in the 
ruler above the waveform in the Viewer or on the waveform graph to scrub through the clip. 
This can be extremely useful for quickly navigating through a clip, but will probably not be 
very helpful for making detailed audio edits.

Playhead is one frame 
wide; hold down the 
Shift key and drag to 
move in increments 
smaller than a frame.
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To really hear what’s going on in your audio, use the shuttle control or the J, K, and L keys to 
move around through your clip.

Playing Audio Using the J, K, and L keys

To hear audio more clearly as you move through it at different speeds, use the J, K, and L 
keys to play your clip in the Viewer. 

Unlike the scrubber bar, which skips samples to give the illusion of faster playback at the 
expense of stuttery-sounding playback, the J, K, and L keys actually shift the pitch of the 
audio you’re playing back, enabling you to hear all the subtle details of the audio at various 
speeds, both slower and faster than real time.

To shuttle through audio using the keyboard:

m To begin forward playback at normal (1x) speed, press the L key.

m To pause playback, press the K key.

m To begin reverse playback at normal (1x) speed, press the J key.

m Press either L or J again to double the current playback speed. You can play back up to 
eight times normal speed, toggling from 1x to 2x to 4x to 8x normal speed (pressing 
either key a total of four times). 

Knowing How to Use Final Cut Pro’s Waveform Displays

As you work in Final Cut Pro, waveform displays can be very useful for navigating 
around parts of your audio and seeing at a glance how the levels in a track indicate 
things like the words and pauses in dialog, and the beats in a piece of music. They 
should not, however, take precedence over the way an audio track sounds during 
playback. When you’re making editorial decisions, the waveform display is no 
substitute for your own ear. 

For example, even though a particular frame of a waveform may look like a good place 
to cut into a drumbeat or a spoken word, the only way you’ll know for sure is to play 
through the clip and listen carefully. Setting your edits even a few frames too late or 
too soon can make a big difference, and it’s time-consuming to zoom in and out of a 
waveform display repeatedly to see a high level of detail.

Use the J, K, and L keys to shuttle through your clips, and learn to listen for the edit 
points you want, set In and Out points, and then use the Play In to Out (Shift-\) and 
Play to Out (Shift-P) commands to preview your edits. As you do this, you’ll find 
yourself trimming one or two frames at a time and then setting new edit points, 
repeating the process until you’ve found the perfect audio editing points.
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m Press the key for playback in the opposite direction to halve the playback speed, slow 
playback in that direction until it reaches 1x, and then begin doubling playback in the 
other direction starting from 1x.

m To immediately reverse the direction of a clip that’s playing faster than 1x, press K to 
pause, and then press the key corresponding to the direction of playback you want.

m Hold down K while pressing L or J to move the playhead one frame at a time in the 
either direction.

m Hold down K while holding down L or J to play back in either direction at 1/3x speed.

m Press the L or J key to play at normal (1x) speed in the desired direction.

Note:  When using keyboard shortcuts for device control, the speed of forward (L) and 
reverse ( J) may differ depending on your video equipment.

Turning Off Audio Scrubbing

As you’re editing audio, you may find the sound of scrubbing audio distracting when you 
move the playhead from one location to another. You can turn off audio scrubbing in the 
Viewer, so you don’t hear any sound as you scrub a clip.

Note:  This control affects audio scrubbing in the Canvas and Timeline, as well as in the Viewer.

To turn audio scrubbing off and on:

m Choose Audio Scrubbing from the View menu to remove the checkmark.

m Press Shift-S.

The Goals of Audio Editing
The goal of audio editing is to make sure that there are no audible changes from one clip to 
the next. Especially in dialog, you don’t want any distracting jumps between audio clips. Most 
viewers are quite good at distinguishing audio changes from one clip to the next, and 
incorrect audio/video synchronization. As you work on refining the audio in your project, 
your edits will focus on eliminating these two major distractions to the viewer. In particular, 
keep in mind three important goals:
m Make sure your audio edit points aren’t noticeable.

Editing the audio tracks of clips in a sequence mainly involves finding good edit points 
that sound natural. Often, your audio edit points won’t be at exactly the same place as the 
video points. Although you may set your initial audio and video edit points in the same 
place to create a quick rough cut, editing your audio more finely may involve changing 
many of your edits points to split edits. Some of those split edits may have only a few 
frames offset between the audio and video edit points, but those frames will turn an 
otherwise obvious cut into a smooth transition that nobody notices. 
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Besides making clean-sounding cuts, there are other reasons to edit the audio edit points 
in your sequence separately from the video. You can edit mistakes in dialog, adjust the 
sync of off-camera or rerecorded dialog, or even replace the entire audio of a clip with 
another take of the same audio.

m Minimize differences in tone and quality between audio clips in the same 
scene.

All audio has some kind of background noise, often referred to as ambience or room 
tone. Sometimes you’ll find that the audio from the different shots you’re using in the 
same sequence has differences in the background ambience. For example, if you shoot a 
conversation in a city park, and the shoot lasts all day, you may notice that some shots 
have more traffic noise in the background because of rush hour. Assuming you don’t want 
to rerecord the dialog for the whole scene, you’ll need to edit more “rush hour” 
background noise into the clips that don’t have any so that all the clips sound the same 
within the same two-minute scene. Otherwise, the traffic noise in the background will 
pop in and out from one shot to the next, which will call attention to your edits and 
distract the viewer.

m You must make sure that your video and audio clips are in sync.

When Final Cut Pro is working properly, your audio and video are always in sync when captured. 

As you edit your audio, you’ll override the audio sync at times when you replace audio 
takes from one shot with those from another, and when you perform split edits. In these 
situations, it’s important to always check that the audio and video of clips that you’ve 
overridden is in sync. People are quick to notice sync that is off, so you need to be extra 
wary of it when you’re editing. Here’s a good rule of thumb: if you’re wondering whether 
the sync is good enough, it’s not, and you’ll want to make adjustments. 

Final Cut Pro keeps track of the sync between the audio and video of two clips from the 
same source media file on disk, so resyncing such clips is easy. However, if you use the 
Mark in Sync command, these indicators no longer show the original sync relationship. If 
you use an audio clip from one take with a video clip from another, the sync indicators 
will either be incorrect (if the two takes are from the same source media file) or will not 
appear at all (if they’re from two different source media files).

It’s also important to make sure that any music edits you make are in sync with the tempo 
of the rest of your music track.

This section provides an overview of how to edit audio separately from video, as well as some 
tips on how to tackle some of the common problems you’ll run into while cleaning up the 
audio of your project. Since we’re concentrating on audio sweetening in this chapter, we’ll 
focus on creating and trimming split edits in a sequence.
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Editing Audio in the Viewer
You set edit points in the audio tabs of the Viewer the same way you set edit points in the 
Viewer’s Video tab. See Chapter 12, “Working With Clips and the Viewer,” on page 327. 
Whether your clips have been opened from the Browser in preparation for editing into a 
sequence, or opened from a sequence in the Timeline for trimming, edit points work the 
same way.

Setting Edit Points for Audio

Setting edit points in an audio tab in the Viewer sets the same points for the video in your clip.

To set a simple In or Out point in the Viewer for both audio and video:

1 Open the clip in the Viewer, then click an audio tab to display the clip’s audio waveform.

2 Position the playhead in the scrubber bar or the ruler at the point where you want to set an 
edit point.

3 Press I to set an In point or O to set an Out point.

To set up a split edit point in the Viewer:

1 Open the desired clip in the Viewer, then click an audio tab to display the clip’s audio waveform.

2 Move the playhead in the scrubber bar or the ruler to the point where you want to set the 
video In or Out point separate from the audio.

3 To set a split video In or Out point, do one of the following:

m Press Control-I to set a video In point or Control-O to set a video Out point.

m Control-click in the scrubber, then choose Mark Split from the shortcut menu, then 
choose Video In or Video Out from the submenu.

m Choose Mark Split from the Mark menu, then choose Video In or Video Out from 
the submenu.

The resulting video edit points in your scrubber bar should look something like this:

Split video point
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4 Now move the playhead to the point of your clip where you want to place your audio In point.

5 To set a split audio In or Out point, do one of the following:

m Press Option-Command-I to set an audio In point or Option-Command-O to set an audio 
Out point.

m Control-click in the scrubber bar, then choose Mark Split from the shortcut menu, and 
from the submenu, choose either Audio In or Audio Out.

m Choose Mark Split from the Mark menu, then choose Audio In or Audio Out from 
the submenu.

The resulting combination of video and audio edit points in your scrubber bar should look 
something like this:

To move split edit points: 

m Drag the split edit point in the scrubber bar or the ruler to a new position. Both audio 
and video split points will move together.

By default, video or audio In and Out points move together.

To slip all edit points together:

m Press Shift while dragging any of the edit points in the scrubber bar or the ruler. All of the 
edit points will slip together.

m Select the Slip Item tool, then drag any of the edit points in the scrubber or the ruler 
where you want them.

To move a single split edit point:

m Press Option and drag the edit point for a video or audio track in the scrubber bar or the 
ruler. As you drag, a box indicates the number of frames between the edit points.

The scrubber bar in the Viewer updates to reflect the new edit points.

To remove a split edit point:

m Control-click the split edit point and choose an option from the shortcut menu.

m Drag the edit point you want to remove either up or down until it disappears, then 
release the mouse button.

To remove all edit points:

m Choose Clear In and Out from the Mark menu.

Video In Video Out

Audio In Audio Out
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Trimming Audio Clips in the Viewer

If you’re trimming just the audio of a clip in a sequence, or creating a split edit where there 
was only a simple edit before, you’ll want to disable clip linking before editing the clip, so 
you can change the clip’s audio without affecting edit points. You can do this by

m turning off the Linking control and selecting an audio item

m selecting the audio portion of a clip while holding down the Option key

When you open the sequence clip in the Viewer, only the audio from the clip will be opened, 
and any new edit points you set will not be applied to the video in the sequence clip.

To trim an existing audio clip to create a split edit:

1 Disable clip linking by doing one of the following:

m Click the Linking control (or press Shift-L) to turn linking off.

m Hold down the Option key and click the audio items of a clip.

2 Open the audio item from the sequence in the Viewer. 

The audio item opens in the Viewer by itself. If it’s a stereo pair, there is one Audio tab. If it’s 
not, you’ll see either a Ch 1 tab, a Ch 2 tab, or both, depending on what you selected. 

When linking is off, the 
Linking control will 
appear raised.

Audio selected 
independently of video
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The link between the audio and video in your clip has not been broken, but you can now 
trim the audio independently of the video that it’s linked to.

3 Select a trimming tool by clicking it in the Tool palette, or by using the appropriate 
keyboard shortcut.

4 Set new In and Out points as you would for any other clip.

The audio opens in 
the Viewer by itself.

New In point set
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Changes you make to sequence clips in the Viewer are mirrored in the Timeline. 

For more about techniques for trimming clips in your sequence, see Chapter 16, “Advanced 
Editing and Trimming Techniques,” on page 653.

Working With Audio in the Timeline
After editing a number of clips into a sequence, you can further trim the audio clips directly 
in the Timeline. While you can trim audio more precisely in the Viewer, trimming the audio 
in the Timeline has other advantages:

m You can see the audio item you’re trimming in relation to the rest of the clips in your sequence.

m You can work with multiple clips in your sequence, rather than just one.

To help you work with audio clips in the Timeline more efficiently, you can customize how 
audio clips appear.

Customizing the Display of Audio Tracks in the Timeline

There are several ways to customize how audio is displayed in a sequence in the Timeline. 
Each sequence in your project can have its own individual settings.
m Displaying audio tracks with waveforms on or off

When waveforms are displayed, Final Cut Pro must render these waveform views as you’re 
scrolling around your sequence. As long as you scroll in a previously rendered section of 
your sequence in the Timeline, Final Cut Pro doesn’t have to render the waveforms again. 
When you scroll to a previously undisplayed portion of your sequence, however, or when 
you change the size of your tracks, these waveforms have to be rendered again.

In point of audio changes 
to match that in the Viewer.
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Although waveform display can be useful in helping you to navigate around your clips, it 
can also be a distraction, and it takes time to render the waveforms as you scroll. You can 
turn audio waveforms on and off at any time by pressing Command-Option-W.

m Displaying overlays and adjusting the track height

m Keyframe overlays:  You can display or hide clip overlays at any time by clicking the 
Clip Overlays control at the bottom of the Timeline window. Audio level overlays 
appear as thin red lines that indicate the level of gain applied to each audio clip. Any 
keyframes added to the levels will appear as handles directly on top of the overlay. For 
more information on adjusting audio levels using overlays, see “Setting Audio Levels in 
the Viewer” on page 785.

Waveform on

Waveform off

Clip Overlays control

Track Height control
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m Track Height:  You can click the Track Height control to switch between four track 
display sizes—Reduced, Small, Medium, and Large. The current setting is highlighted 
in blue and has a small dot in the center.

Note:  When the track size is set to Reduced, thumbnails and audio waveforms are 
not displayed.

m Labeling audio tracks

You have two choices for how audio tracks are labeled in your sequence. Audio track 
labeling can only be changed in the Timeline Options tab of the Sequence Settings 
window for each sequence.

m Sequential:  Sequential labels number each audio track consecutively A1, A2, A3, and 
so on. Each audio track is identified individually by its number, which is useful if you 
want to maintain a one-to-one correspondence between your video and audio tracks.

m Paired:  Paired labels identify audio tracks in pairs: A1a, A1b; A2a, A2b; A3a, A3b; and 
so on. This labeling scheme is useful if you have a lot of stereo material, and you want 
an easy way to see the relationship between each stereo pair of tracks.

You can modify how tracks are displayed in the Timeline in the Sequence Settings window 
for a sequence.

To modify track display settings in the Sequence Settings window:

1 Select the sequence you want to modify in the Browser, then Control-click the sequence.

2 Choose Sequence Settings from the shortcut menu, then click the Timeline Options tab. 

3 Change any of the Timeline options you want, then click OK.

The changes you’ve made apply only to the selected sequence.

Timeline Options tab

This option displays 
a bar (green for 
filters, blue for 
motion effects) 
under clips that 
have motion effects 
or filters applied to 
them in the Timeline.

This option displays audio waveforms 
on audio tracks in the Timeline.

This option displays
keyframe overlays on

tracks in the Timeline.
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Zooming In on Audio Clips in the Timeline

Zooming into a sequence in the Timeline can be especially useful when you’re trimming audio 
edit points to fine-tune the audio in your sequence. Unlike the Viewer, the Timeline playhead 
cannot move in subframe increments when you’re zoomed in. The smallest change you can 
make to a clip in the Timeline is by a single frame. If you need to either change sync or move a 
keyframe in a subframe increment, you need to open that sequence clip in the Viewer.

The Zoom slider, Zoom control, and corresponding keyboard shortcuts allow you to set any 
zoom level you want. Once you’ve zoomed into a sequence far enough that you cannot see 
either the beginning or ending clips in the sequence, you can also use the Zoom slider as a 
regular scroll bar, to smoothly scroll forward or backward to another section of your sequence.

Editing in the Timeline

Editing and trimming clips in the Timeline is described in much more detail in Chapter 14, 
“Basic Editing,” on page 533 and Chapter 16, “Advanced Editing and Trimming Techniques,” 
on page 653. In this section, we’ll review a few basic editing techniques and how they apply 
to common tasks you’ll be performing to clean up your audio tracks.
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Fixing Awkward Audio Cuts in the Timeline Using Split Edits

Once you’ve edited a group of clips into a sequence in the Timeline, you can adjust the edit 
points between audio items without affecting their corresponding video items. To do so, you 
disable clip linking. For example, suppose you’re cutting between two people having a 
conversation. The first person says something, and then the second person pauses for a 
moment and replies. It might look something like this:

The timing of the video is what you wanted, but as the audio waveform shows, the last 
syllable of the last word of dialog in the first shot gets cut off, which sounds awkward. To fix 
this, you can create a small split edit right in the Timeline.

To create a split edit in the Timeline:

1 Disable clip linking by doing one of the following:

m Click the Linking control (or press shift-L) to turn it off.

m Click the edit point between the two audio items while holding down the Option key.

Second clip starts quietly. Audio in first clip gets cut off.
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2 Choose a tool from the Tool palette to perform the kind of edit you want. In this example, 
we’ll use the Roll Edit tool (press the R key).

3 Now, drag the audio edit point to the right so that the entire word plays at the end of the
first clip.

Replacing Unwanted Audio With Room Tone

As you edit dialog, you’ll often need to cut out pieces of audio that you don’t want in the 
sequence. For example, the director may have given directions in between an actor’s lines, or 
the sound recordist might have bumped into something while shooting on location for a 
documentary. As long as there’s no dialog happening at the same time, it’s pretty easy to cut 
out unwanted sounds. If you simply delete the sound, however, you’ll be left with a gap in 
your audio that sounds artificial. Since there’s always a low level of background noise, known 
as room tone, in any recording, a moment of complete silence is jarring.

In order to edit out unwanted sections of audio without creating obvious gaps, it’s common 
practice to record a certain amount of room tone during a shoot. The recordist simply has 
everyone stand quietly for thirty seconds or so, and records the ambient sound of the room. 
If you’ve recorded some room tone during your shoot, you can capture it so that, as you edit, 
you have a long piece of “silence” that you can edit in whenever you need to cover a gap in 
the location audio.
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If You Don’t Have Room Tone

Every location has its own room tone, so it’s important to record some room tone for every 
location in your program.

If, for some reason, room tone was not captured for a particular scene, but you have a gap 
you need to fill, you can try to copy a section from another clip in the same scene that has a 
pause in the dialog, and paste it to fill the gap. If you have no pauses that are long enough to 
cover your gap, you can try to copy and paste a short pause multiple times. But there’s a 
chance that it will end up sounding like a loop, which will be too noticeable. In this case, you 
can use the following method to obtain a long section of room tone from a short copied 
pause in the dialog.

To create a section of room tone from a short pause:

1 Find the longest pause you can in a dialog clip in the same scene, then copy the section that 
contains the pause. If you’re in the Timeline, you can use the Range Selection tool.

2 Create a new sequence, name it “Room Tone,” and paste the audio pause into it twice.
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3 Select the second pause, then choose Speed from the Modify menu. In the Speed dialog box, 
click the Reverse checkbox to select it.

4 Play the resulting clips. 

The looping sound should be gone, but if you hear a clicking at the edit point between the 
two clips, you may have to add a cross fade between them. 

5 Cut and paste as many pairs of these clips as you need to fill the necessary duration, adding 
cross fades between each pair. Render the Room Tone sequence, then edit the sequence into 
the gap in your program.

To replace an unwanted section of an audio clip with room tone:

1 Make the tracks that contain the unwanted audio the audio target tracks, then disable the 
video target track.

2 Play your clip using the J, K, and L keys, and set In and Out points right before and after the 
section of audio you want to replace. Move the Canvas or Timeline playhead to the In point.

Disabled

Enabled
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3 Open your room tone clip in the Viewer, and move the Viewer playhead to the start of the 
section of room tone you want to use.

4 Edit the room tone into your sequence by doing one of the following:

m Drag the room tone clip from the Viewer to the Replace section of the Edit Overlay in 
the Canvas.

m Click the Replace button in the Canvas.

m Press F11.

The section of unwanted audio is replaced with room tone.

Moving Audio Items From One Track to Another at the Same Frame

From time to time, you’ll want to move an audio clip up or down to an adjacent track, but 
keep its In and Out points at the same location in your sequence. You might do this to

m move a sound effect to another track to make room for another clip

m organize the audio clips you’ve edited into your sequence into separate dialog, music, and 
effects tracks

m place one actor’s dialog on one track and another actor’s dialog on another track

There’s an easy way to move an audio clip up or down to an adjacent track, without 
accidently moving it forward or backward in time.
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To move a clip to an adjacent track while keeping its In and Out points the 
same:

1 Press and hold the mouse button over the clip in the Timeline.

2 Press and hold the Shift key.

3 Drag the clip to an adjacent track.

As you move the clip up and down into other tracks in the Timeline, you’ll notice that it’s 
constrained from moving forward or backward in your sequence. It can only move up and 
down. This works for both audio and video clips.

Using Audio Transitions
Sometimes, a cut in the audio will sound too obvious. For one reason or another, it will be 
quite noticeable despite your best efforts to find just the right frame to do the edit on. In 
these cases, you can apply a cross fade to the edit point to try and smooth out the transition 
from one audio clip to the next. 

You can apply two kinds of cross fades in Final Cut Pro. Each results in a different audio level 
change as the transition plays:

Which one works better depends on the clips you’re transitioning between. Try one, then try 
the other to see which sounds better.

Cross Fade (0 dB) Fades the first clip out, while simultaneously fading the second clip in. This 
effect applies a linear ramp to the volume level.

As a result, introduces a volume dip in the middle of the cross fade.

Cross Fade (+3 dB) Performs the same operation as Cross Fade (0 dB), but applies an 
equal-power ramp to the volume level, rather than a linear ramp.

An equal-power ramp uses a quarter-cycle cosine fade-out curve and a 
quarter-cycle sine fade-in curve. As a result, the volume is maintained at a 
constant level throughout the cross fade.
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Adding Audio Transitions

There are several ways to add a transition between two audio clips in a sequence:

m Edit an audio clip into the sequence by doing an insert or overwrite with transition edit.

m Select an edit point and choose a transition from the Audio Transitions submenu of the 
Effects menu.

m Add the default audio transition by selecting an audio edit point and pressing 
Command-Option-T.

m Control-click an edit point and choose the default audio transition from the shortcut menu.

m Drag an audio transition from the Effects tab in the Browser to an edit point between two 
audio clips in the Timeline.

m Copy and paste an audio transition from one edit point to another.

m Drag a transition from one edit point in the Timeline to another.

To add a new audio transition from the Effects menu:

1 Do one of the following:

m Click an edit point between two audio clips in your sequence to select it.

m Position the Canvas or Timeline playhead at the desired edit point, or on top of another 
transition that’s already been edited into your sequence.

2 Choose Audio Transitions from the Effects menu, then choose a transition from the submenu.

The Cross Fade (0 dB) transition is shown in this example. Assuming there are enough 
overlapping audio frames on either side of the edit point, your transition, centered at the 
edit point, will be added on top of your edit.

You can also quickly add the default audio transition to your edit. When you install Final Cut 
Pro, the default transition is a one-second Cross Fade (+3 dB). For information on changing 
the default audio transition, see “Changing the Default Audio Transition” on page 781.
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To add the default audio transition:

m Control-click an edit point between two audio clips in the Timeline, then choose Add 
Transition from the shortcut menu.

The name of the current default transition appears next to the command in the shortcut menu.

Once a transition has been applied, you can change the type of cross fade it is (0 or +3) by 
Control-clicking it again and choosing the appropriate transition from the shortcut menu.

m Select an edit point between two audio clips or position the Canvas or Timeline playhead 
at the desired edit point, then press Command-Option-T to add the default transition.

To add a new audio transition from the Effects tab:

m Drag a transition from the Effects tab in the Browser to an edit point in the Timeline.

If there are enough overlapping frames, you can align the transition in one of three ways: 
before, at, or after an edit point. The transition snaps to one of these three areas as you 
drag it close to the edit point.

Aligned before the edit point 

Aligned at the edit point 

Aligned after the edit point 
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Modifying Audio Transitions in the Timeline

You can change the duration of an audio transition, as long as there are enough overlapping 
audio frames to accommodate your new duration. 

To change the duration of an audio transition:

1 Double-click the audio transition in the Timeline.

2 Type a new length for the transition and click OK.

To change the alignment of a transition in a sequence:

m Select the transition you want to modify in the Timeline, choose Transition Alignment 
from the Sequence menu, then choose another alignment from the submenu.

m Select the transition you want to modify and press Option–1, 2, or 3 to select a Start, 
Center, or End transition.

m Control-click the transition, then choose another alignment from the shortcut menu.

To swap a transition in your sequence with one of another type:

m In the Timeline, move the playhead over the audio transition you want to change (you 
can also click to select it), choose Audio Transitions from the Effects menu, then choose 
another transition from the appropriate submenu.

m Drag an audio transition from the Effects tab in the Browser onto the audio transition you 
want to change in the Timeline. When the pointer is over the old transition, it will be 
highlighted to show it’s about to be replaced.

Note:  If you replace a transition in your sequence with a transition you’ve saved as a 
favorite, the favorite transition’s duration overrides that of the transition it’s replacing. For 
more on favorite transitions, see “Saving a Customized Audio Transition as a Favorite” on 
page 780.

m Control-click an audio transition, then choose another transition from the shortcut menu. 
Since there are only two kinds of audio transitions, they both appear in this menu.

You can also move a single transition from one edit point to another.
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To move an audio transition from one edit point to another in the Timeline:

m Drag the audio transition from its current edit point in the sequence to another one. If 
there are enough overlapping frames on either side of the edit, you can drag the 
transition before, on, or after the edit point.

The transition is removed from the edit point where it previously was. If you dragged the 
transition to a cut between two audio clips, the transition is added to the new edit point. If 
there was already a transition at the new edit point, it’s replaced by the one you dragged.

If you add an audio transition or customize its settings and want to add the same transition to 
other edit points in your sequence, you can copy and paste the transition to other edit 
points. This is helpful if you’ve changed a particular transition’s settings and you want to use 
the same transition with the same settings multiple times in your sequence.

To copy an audio transition from one edit point to another:

1 In the Timeline, select the audio transition you want to copy, then press Command-C.

2 Control-click the edit point where you want to add the transition, then choose Paste from the 
shortcut menu.

Initial placement 
of audio transition.

New placement 
of audio transition.
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To copy a transition from one edit point to another by dragging it:

m Press the Option key and drag an existing transition to another edit point.

Transitions that you’ve added to your sequence can easily be removed.

To delete an audio transition from a sequence:

1 Select the audio transition you want to remove in the Timeline.

2 Do one of the following:

m Press the Delete key.

m Choose Clear from the Edit menu.

m Control-click the transition, then choose Cut from the shortcut menu.

Saving a Customized Audio Transition as a Favorite

You can save an audio transition with a particular duration as a favorite so you can quickly use it 
again in the future. Many editors use cross fade transitions with a variety of different frame 
durations. You can do this too, by saving a series of cross fades with different lengths as favorites. 
You can name each favorite to reflect its duration, so you can keep track of which is which.

To save a favorite audio transition:

m Drag a transition with a duration you’ve modified from a sequence in the Timeline to the 
Favorites bin in the Effects tab of the Browser. 

To rename a favorite transition:

1 Click the transition’s name in the Favorites bin in the Effects tab of the Browser.

2 Enter a new name, then press Return.
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Changing the Default Audio Transition

You can change the default audio transition to either of the two transitions that Final Cut Pro 
comes with, or to an audio transition favorite you’ve created.

To change the default transition:

m In the Effects tab of the Browser, Control-click the transition, then choose Set Default 
Transition from the shortcut menu.

m Select an audio transition in the Browser, choose Audio Transitions from the Effects 
menu, then choose Set Default Transition from the submenu.

About Mixing Volume and Stereo Levels in Final Cut Pro
As you edit more and more audio clips into a sequence, adding music, sound effects, 
voiceovers, and additional background ambience, you’ll find you need to adjust the volume 
levels of all these different elements to turn them into a harmonious whole. 

When you edit a new clip into a sequence, it’s set to 0 decibels (dB) by default. If you don’t 
adjust the levels of your clips to emphasize the sounds you want viewers to notice most, your 
program will become a cacophony of sound. 

Final Cut Pro allows you to set your audio levels to whatever you like, within a total range of 
–60 dB to +12 dB. The process of setting the levels of your audio clips relative to one 
another is known as mixing.

Guidelines for Achieving a Good Mix

The unbreakable rule of mixing audio levels is that nothing can peak louder than 0 dB on 
Final Cut Pro’s audio meters. As discussed in “Setting Proper Levels While Recording” on 
page 735, anything louder than 0 dB on Final Cut Pro’s audio meters will be distorted 
during playback.

While making sure that your levels don’t exceed 0 dB, you’ll also want to make sure that the 
average loudness of your mix is somewhere around the reference level you decided to use. 
Whether it’s –20, –18, or –12 dB, the “headroom,” or difference between your reference 
level and 0 dB, determines the difference between the average volume of a clip in your 
program, such as the speaking voice of your actors, and the loudest sound you can play, such 
as an explosion or a scream.
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Finally, you’ll want to make sure that the amount of headroom you allow in your program is 
acceptable for your planned distribution medium. Even though you have 20 dB of headroom 
available if you set your reference level to –20 dB, that doesn’t mean you’ll be able to use it in 
a program you want to broadcast on television. If you aren’t sure of the exact requirements 
for your intended distribution medium, try to allow about –12 dB of headroom between 
your reference level and the loudest sounds in your mix.

Determining the Dynamic Range of Your Program

As you mix audio levels, think about the amount of dynamic range you want to allow in your 
program. It’s important to allow only as much dynamic range as your audience’s 
environment can handle. For example, if you’re mixing audio for a program to be played 
back in a controlled environment, such as a theater, you can allow for a great deal of dynamic 
range, so you can have very soft as well as very loud sounds in your mix.

On the other hand, if you’re mixing a project to play back on a computer via the Internet, 
you’ll want to keep in mind that the high compression rate of the audio and the noise of the 
viewer’s environment (the computer fan, an air conditioner, street noise, other people in the 
office, and so on) will reduce the amount of dynamic range the viewer can hear. If the viewer 
turns up the volume because a part of your program is too soft, she’ll be blown away when 
the loud part of the program starts to play, and the sound will probably be distorted. For an 
Internet audience, reducing the difference between the softest and loudest sounds in the 
program will probably result in a better listening experience.
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About Monitoring Your Project’s Levels

When you set up your Final Cut Pro workstation, pay careful attention to the acoustic 
environment of the room you’ll be working in. Each room has its own set of acoustics 
and background noises, which can affect your decisions when you’re editing, mixing, 
and adding filters to your audio. You don’t need an expensive, acoustically perfect 
room to get your work done, but you do need to be aware of excessive reverberation, 
traffic noise, fans, air conditioners, and other sounds that might color your perception 
of the audio you’re working on.

If you plan to use monitoring speakers, be sure to get good ones, with an output curve 
that’s as flat as possible, so the speakers don’t introduce too much treble or bass. 
When using speakers, it’s especially important to work in as quiet a room as you can 
get, so that you can hear the subtleties in your program’s audio.

If you don’t use monitoring speakers, use a pair of high quality headphones. For most 
home studios, headphones are your best bet for two reasons:

m They isolate your listening environment, eliminating background noise.

m You can get much higher quality sound from a pair of good headphones than from 
a comparably priced pair of speakers. Better quality sound will enable you to make 
more accurate decisions while mixing your audio tracks.

Most importantly, once you’ve settled on a monitoring system, calibrated your 0 dB 
level in Final Cut Pro, and adjusted the volume of your speakers or headphones to a 
comfortable listening level, leave the volume alone. Since every decision you make in 
your mix is relative to your master monitoring volume, if you constantly change the 
monitoring volume, you may end up making different mixing decisions for different 
parts of your program. This will give you an uneven mix. Mark your monitoring volume 
with tape, and don’t change it.
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Mixing to Call Attention to Important Audio

In most programs, the most important audio (though not always the loudest) is the sound of 
people’s voices: the actors, the interviewees, or the narrator. What these people say is the 
point of your program, so it’s a safe bet that the average loudness of the program will be 
determined by the level you set these voices to. As a result, all other sound levels in your 
program will be adjusted relative to these voices. 

If, at some point in your program, the music becomes more important (such as during a 
montage that shows the passing of time), you’ll raise the levels of your music clip to the level 
of the average loudness, and set the voice clips to a lower level. As soon as the voices 
become important again, you’ll raise their levels, and lower those of the music.

To mix the levels of the various clips in your sequence, you must determine the loudest 
sound in your program, then set that as the highest level in your mix. You’ll set the average 
levels of the dialog in your program to match the reference level you chose, making sure that 
any peaks in the dialog do not exceed those of the loudest sound in the program. Finally, 
you’ll set the levels of all the other audio clips in your program (music, sound effects, 
background ambience) so that they do not interfere with the dialog.

The loudest
clip in your mix

The average level
of the voices of
your actors

The headroom in
your program

Average levels of
music, ambience,

 and sound effects
-30
-27

-21
-24

-18
-15
-12
-9
-6
-3
0

Mixing guidelines for a program with a reference
level set to –18 dB and a headroom of 12 dB

Learning How to Mix

To learn more about how to mix sound for film and video, watch movies with sound 
tracks you admire, and pay close attention to the audio. The expertise of others can be 
your best guide in learning how to edit and mix your own tracks.
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Using the Audio Meters

The most important tool for setting audio levels is Final Cut Pro’s set of audio meters. As you 
mix the audio in a program, watch the audio meters to make sure the peaks in the audio 
don’t exceed the level of your loudest sound. Also, carefully watch the amount of “wiggling” 
the meters show between peaks, and you’ll get a sense of the average level of your mix, so 
that you can set the levels of your clips to achieve the dynamic range you want.

Learning to read the audio meters takes time, so experiment with different audio clips at 
different levels to see how they correspond to the actual volume of your piece. Import a few 
music clips from CDs of different genres. Classical, jazz, and pop music are all mixed very 
differently, but all professional recordings have carefully controlled dynamic range, so you 
can see how a well-mixed piece looks in the audio meters.

Setting Audio Levels in the Viewer
You can control the volume (levels) and placement of sound (pan or spread) in a clip in the 
Viewer using the sliders at the top of the Audio tab, the number fields next to the sliders, or 
the overlays in the middle of the waveform display area. 

 

Drag the Level slider 
to change volume.

Level overlays

Numeric entry field (level)

Numeric entry field (pan)
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How these controls affect the level of your clip depends on whether or not you’ve set 
keyframes for either level or pan/spread.

m If no keyframes are set, moving the sliders or entering a numeric value changes the audio 
or stereo levels for the entire clip. Likewise, dragging one of the overlays changes the 
audio or stereo levels for the entire clip.

m If keyframes are set, moving the sliders or entering a numeric value modifies the value of 
whatever keyframe is at the current position of the Viewer playhead. If there is no 
keyframe at the current position of the playhead, one will be added. There must be at 
least two keyframes on an overlay to change the audio or stereo from one level to 
another. Changing keyframe values only affects the parts of the overlay immediately 
before and after that keyframe. 

Whether or not the audio clip in the Viewer is a stereo pair also affects how volume and pan/
spread levels are set. 

m If you opened a Ch 1 and Ch 2 audio clip, each channel is in its own tab in the Viewer, 
and is mixed separately from the other. 

m If you opened a stereo pair, both waveforms appear in the same tab, named Audio, and 
adjusting the levels of one channel adjusts the levels of the other.

As you adjust the volume and pan/spread levels of clips in Final Cut Pro, your changes can be 
played back immediately. Final Cut Pro mixes the audio levels in real time, so you don’t need 
to render your audio as long as your hardware can handle the number of tracks you’re 
working on. Real-time audio processing is covered in more detail in “Real-Time Audio Mixing 
in Final Cut Pro” on page 812.

Note:  Using effects like cross fades and filters reduces the total number of tracks your 
hardware can mix in real time. If you exceed the number of tracks your hardware can handle, 
you’ll need to render your tracks. Audio usually renders much faster than video, however, so 
it shouldn’t take too long. 

Adjusting the Level of an Entire Clip 

When you edit a new clip into a sequence, it’s set to 0 decibels (dB) by default. You can 
change the level to be any value you like, from –60 dB to +12 dB.

You can use three controls to adjust the audio level of a clip. Each of these controls is 
mirrored by the other controls as you make adjustments. If no keyframes are set in the clip in 
the Viewer, using these controls adjusts the level of the entire clip.
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To adjust the volume using the Level slider:

m Drag the Level slider to the left or right.

To adjust the volume by entering a numeric value:

1 Click in the Level field so that it’s highlighted.

2 Enter a value between –60 and 12. To enter a negative value, type – (the minus sign) and 
the number.

3 Press the Return key to apply this value to your clip.

Using the Command Key to “Gear Down”

In Final Cut Pro, items you drag onscreen normally move at the same speed you move 
your mouse across your work surface. When you’re using volume and spread/pan 
controls and overlays, this usually works just fine. However, you can drag even more 
precisely by pressing the Command key after you start dragging an item.

If you hold down the Command key after you start dragging the Level slider, for 
example, the slider moves much more slowly, and the numeric value changes in 
smaller increments.

You can use the Command key to slow down nearly any dragging operation in Final Cut Pro.

Level slider

Enter a value here.
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To adjust the volume by dragging the level overlay:

1 Place the pointer over the level overlay of your clip in the waveform display area of the 
Viewer (the overlay looks like a pink line, or lines for stereo). The pointer turns into an 
Adjust Line Segment pointer.

2 Drag the overlay up or down to change the level of the clip. As you drag, a box displays the 
new audio level.

To adjust the volume by using the Modify menu:

1 Select one or more clips in the Timeline, or place the Canvas or Timeline playhead over the 
clip whose volume level you want to modify.

2 Choose Audio from the Modify menu, then choose one of the Gain items from the submenu 
to indicate how much you want to modify the level. 

A box displays the new level.

Adjust the line segment pointer.
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The volume of your clip is increased or decreased from its current value by the increment you 
choose. If you selected multiple clips, all clips are modified relative to their current values.

Setting Stereo Pan or Spread in the Viewer
To adjust the stereo placement of your sound, you can change the pan (to move a mono 
audio clip between the left and right channels) or spread (to transpose the left and right 
channels of a stereo clip) of your audio clips.

The Pan/Spread slider is actually one control with two modes. What the control does 
depends on what kind of audio you’ve opened in the Viewer:

m Spread:  If the audio clips in the Viewer are a stereo pair, this slider lets you swap the left 
and right channels. The default setting of –1 sends the left audio channel of your clip to 
the left channel output and the right audio channel to the right channel output. A setting 
of 0 outputs the left and right audio channels equally to both speakers, essentially 
creating a mono mix. A setting of +1 swaps the channels, outputting the left audio 
channel to the right speaker and the right audio channel to the left speaker. 

Changing Volume Levels While a Sequence Is Playing

You can use keyboard shortcuts to change the volume levels of clips in a sequence 
while it’s playing. Your changes affect the level of the clip at the current playhead 
position. Use the following shortcuts:

m Control-+ to raise the level by 1 dB

m Control- – to lower the level by 1 dB

When you use the shortcut, you hear a brief pause, then playback resumes almost 
immediately.
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m Pan:  If the audio clips in the Viewer are not a stereo pair, this slider lets you pan the 
audio channel in the currently selected audio tab between the left and right channels. 
Pan is also the active control when you’re working with a single mono audio clip.

As with the Level slider, if there are no pan/spread keyframes in the current clip, adjusting 
the Pan/Spread slider affects the pan or spread of the entire clip. If there are pan/spread 
keyframes, using this slider will either

m adjust the pan or spread of a keyframe at the current position of the playhead

m add a new keyframe to the pan/spread overlay and adjust it between the left and right 
output channels

A change in pan or spread between any two keyframes appears as a slope on the pan/
spread overlay in the audio tab of the Viewer. Working with keyframes is explained in 
more detail in “Mixing a Clip’s Levels and Pan/Spread Dynamically Using Keyframes” on 
page 793.

Adjusting the Pan/Spread of an Entire Clip

When you edit a new clip into a sequence, the default stereo value depends on what kind of 
audio clip it is.

m If it’s a Ch 1 and Ch 2 clip or a mono clip, its stereo pan is centered with a value of 0 by 
default. You can change this level to whatever you like, from –1 to +1.

m If it’s a stereo pair, the spread value defaults to –1, putting the left audio track out of the 
left channel, and the right audio track out of the right channel.

You can use three controls to adjust the pan or spread of a clip. Each of these controls is 
mirrored by the other controls as you make adjustments. If no keyframes are set in the clip in 
the Viewer, using these controls adjusts the pan or spread of the entire clip.

Pan adjusts sound 
between channels.
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To adjust pan or spread using the slider control:

m Drag the Pan or Spread slider to the left or right to adjust the stereo placement of your clip.

m Dragging the Pan slider left moves the audio toward the left stereo output channel; 
dragging right moves it to the right stereo output channel.

m Dragging the Spread slider left or right transposes the left and right channels of a 
stereo pair clip.

To adjust pan or spread by entering a numeric value:

1 Click the Pan or Spread field so that it’s highlighted.

2 Enter a new value. To enter a negative value, type in – (minus sign) and the number.

m For pan, enter a value between –1 and 1. –1 moves the audio all the way to the left stereo 
output channel, 1 moves the audio all the way to the right stereo output channel.

m For spread, enter a value between –1 and 1. –1 is the original left and right stereo 
placement captured with your clip. 1 reverses the left and right channels. 

3 Press the Return key to apply this value to your clip.

Drag the Spread 
slider of a stereo clip.

Spread overlay

Enter a value here.
  Working With Audio 791



To adjust pan or spread by dragging the pan/spread overlay:

1 Place the pointer over the pan or spread overlay of your clip in the waveform display area of 
the Viewer (the overlay looks like a purple line, or lines for stereo). The pointer turns into an 
Adjust Line Segment pointer.

2 Drag the overlay up or down to change the pan or spread of your clip. As you drag, a box 
displays the new pan or spread level.

A box displays the new 
pan/spread value.
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Mixing a Clip’s Levels and Pan/Spread 
Dynamically Using Keyframes
Instead of setting the volume or pan/spread of an entire clip to the same level, you can mix your 
levels and stereo placement dynamically, raising and lowering the volume level or changing the 
stereo pan of a clip numerous times within the same clip. To do this, you use keyframes.

Keyframes can be used throughout Final Cut Pro with any feature whose parameters can be 
changed over time. Using keyframes, you can change volume levels, pan/spread levels, 
motion settings, and filters dynamically over time. Keyframes allow you to specify different 
volume or pan/spread levels in an audio clip at different points in the Timeline, and the level 
overlay in your clip automatically adjusts from one keyframed level to another using a 
smooth curve.

Keyframing is done the same way for both volume levels and pan/spread levels, although the 
end results are quite different.

Note:  Unlike the visual keyframes that you can set for motion settings, the shape of volume 
and pan/spread level curves can’t be altered.

Working with Keyframes in the Timeline

You can also add, modify, and delete keyframes directly in the Timeline. For more 
information, see “Adjusting Volume Levels and Pan/Spread in the Timeline” on page 805.
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Creating, Modifying, and Deleting Keyframes in the Viewer

The keyframe controls are located next to the slider controls in the Viewer.

m Level Keyframe button:  The keyframe button to the right of the dB field places a keyframe 
on the level overlay at the current playhead location. You’ll place keyframes on the audio 
level in preparation for creating a dynamic change in the level when you’re mixing.

m Level keyframe navigation buttons:  These buttons, to the left and right of the Level 
Keyframe button, allow you to move the playhead forward or backward from one 
keyframe on the level overlay to the next.

m Pan/Spread Keyframe button:  This button to the right of the Pan/Spread slider places a 
pan or spread keyframe at the current playhead location on the pan/spread overlay. These 
keyframe markers can be used in preparation for dynamically panning or spreading an 
audio clip’s output from one stereo channel to another.

m Pan/Spread keyframe navigation buttons:  These buttons, to the left and right of the 
Pan/Spread Keyframe button, allow you to move the playhead forward or backward from 
one keyframe on the pan/spread overlay to the next.

m Reset button:  This button deletes all marked keyframes on both the level overlay and the 
pan/spread overlay of the currently selected audio track, and resets the level and spread 
to their original values (0 dB for the audio level, and –1 for the pan/spread level).

Until you create at least one volume or pan/spread keyframe in your audio clip, changes you 
make affect the level or stereo placement of your entire clip. While you need two keyframes 
to do anything useful, once you set the first volume or pan/spread keyframe, any changes 
you make to the keyframed levels anywhere else in the clip will generate additional 
keyframes automatically.

Level keyframe 
navigation buttons

Reset button

Pan/Spread keyframe 
navigation buttons
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To set a keyframe:

m Move the playhead in the Viewer to the place where you want to set a keyframe, then 
click the Level or Pan/Spread Keyframe button.

m Press the Option key and move the pointer over the level overlay. It turns into the Pen 
tool. Click a level overlay with the Pen tool to add a keyframe at that point.

The keyframe appears as a small diamond on the overlay you added it to.

Click here to set a keyframe.

A keyframe appears at the 
location of the playhead.

Pen tool
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To set additional keyframes:

1 Move the playhead to another point in the clip where you want to set a keyframe.

2 Do one of the following:

m Drag the Level or Pan/Spread slider to set a new keyframe at that level or value.

m Type a number in the appropriate field to set a new keyframe at that level or value.

m Click a keyframe button to add a keyframe to the volume level or pan/spread overlay at 
the overlay’s current level.

m Press the Option key and click an overlay with the Pen tool to add a keyframe at that point 
without changing the level of the overlay. You can add as many keyframes as you want by 
clicking repeatedly with the Option key held down.

The keyframe appears as a small diamond on the overlay you added it to.

To move the Viewer playhead from one keyframe to another:

m Click the left and right level or pan/spread keyframe navigation buttons to move the 
playhead to the next keyframe to the left or right of the playhead.

m Press Option-K to move the playhead to the next keyframe to the left of the playhead.

m Press Shift-K to move the playhead to the next keyframe to the right of the playhead.

To adjust the level or pan/spread of a single keyframe:

m Move the playhead to the keyframe you want to adjust, then drag the appropriate slider to 
a new value.

m Move the playhead to the keyframe you want to adjust, type a new value in the 
appropriate field, and press the Return key.

m Move the pointer over the keyframe you want to modify. When it becomes a crosshair 
pointer, drag the keyframe you want to modify.

m Dragging a volume level keyframe up raises the volume; dragging down lowers it. As 
you drag, a box shows you the current level of the keyframe.

m Dragging a pan keyframe up moves the audio toward the left stereo output channel; 
dragging down moves it to the right stereo output channel. As you drag, a box shows 
you the pan setting of the keyframe.

m Dragging a spread keyframe vertically in the waveform display area transposes the left 
and right channels of a stereo pair.
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To adjust a section of an overlay in the middle of four keyframes:

m Move the pointer over the section you want to adjust. When it turns into the Adjust Line 
Segment pointer, drag the section up or down to modify it. The rest of the overlay before 
and after the four keyframes remains untouched. 

To move a keyframe forward or backward in time:

m Place the pointer over the keyframe you want to modify. When it becomes a crosshair 
pointer, drag the keyframe forward or backward along the overlay. 

As you drag, a box displays the timecode duration of the change you’re making.

Keyframe being moved 
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To delete a keyframe:

m Move the playhead to the position of the keyframe you want to delete, then click the 
Level or Pan/Spread Keyframe button to delete it.

m Place the pointer over the keyframe you want to delete. When it becomes a crosshair 
pointer, drag the keyframe up or down out of the waveform display area. When the 
pointer turns into a small trash can, release the mouse button.

m Press the Option key and move the pointer over an existing keyframe. The pointer turns 
into the Pen Delete tool. Click an existing keyframe with the Pen Delete tool to delete 
that keyframe.

m Control-click the keyframe you want to delete, then choose Clear from the shortcut menu.
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To delete all keyframes:

m Click the Reset button. All keyframes (both level and pan/spread) are deleted, and the 
volume level of your clip returns to 0 dB.

Examples of Using Keyframes to Mix Your Levels

You need at least two keyframes to make any dynamic change from one volume level to 
another in a clip.

In the example above, the section of the clip to the left of the keyframes is at –30 dB, and the 
rest of the clip to the right of the keyframes is at 0 dB. This is the simplest type of level 
change you can make.
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A more sophisticated change in levels— for example, introducing a slight boost in the level of 
a few notes in a music track— requires three keyframes:

In the preceding example, the volume level of the clip starts at –3 dB, then rises along a 
curve, peaking at +6 dB on the note that’s playing at that point. The volume level then 
lowers along another curve, ending back at –3 dB.

Three keyframes allow you to boost or attenuate (lower) a section of audio along a curve, but 
to effect less gradual changes to longer sections of audio, you’ll need to use four: 
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In this example, the volume level, instead of rising or lowering constantly, changes from 
–3 dB to –26 dB during the first two keyframes, then remains constant. The final two 
keyframes boost the level back to –3 dB, where it remains for the duration of the clip.

An Example of Using Keyframes to Control Pan and Spread

Setting keyframes to change pan or spread dynamically works the same as with levels. You 
need to set at least two keyframes to effect a change over time.

Changing pan over time is a little more common than changing spread, and is often used to 
achieve stereo effects such as making a car sound zoom from left to right, or putting a 
particular sound effect on one side or the other of a stereo image.

Let’s look at the car sound example to see how you’d adjust the pan dynamically. You have a 
car sound effect in your edited sequence, and you want it to zoom from the left to the right 
to match the movement of an onscreen car. Here’s what you’d do:

To set up a dynamic stereo pan using keyframes:

1 Open the car sound effect in the Viewer so you can see it in more detail.

The car effect is a mono sound file, so the Pan/Spread slider is set to Pan. 
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2 Move the Viewer playhead to the beginning of the car effect’s waveform, right before the car 
sound starts playing, and click the Pan Keyframe button to set a keyframe.

3 Drag the Pan slider all the way to the left, so that the sound starts playing out of the left speaker.
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4 Now, move the playhead to a position after the car sound effect has finished playing.

5 Drag the Pan slider all the way to the right, so that the sound ends playing out of the right 
speaker. Because you’ve already set a keyframe for this clip, dragging the Pan slider at 
another point in the clip automatically produces a new keyframe.

When you play back the clip, you’ll hear a stereo pan.
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Tips for Working With Stereo

Unlike setting volume levels, adjusting stereo pan is largely an aesthetic decision. Still, you 
should resist the temptation to create too many directional sound effects. Remember that 
there are a lot of viewers who’ll watch your program in mono, so they won’t be able to hear 
the fancy stereo effects you put into your program (this is especially true of video that’s 
compressed for Internet playback). If use of stereo is too important to an audience’s 
appreciation of your piece, you’ll have a lot of disappointed viewers. 

This doesn’t mean you should avoid stereo. Using stereo can be a great way to enhance the 
audience’s experience of your program. But it’s important to know your audience, and to 
take their listening experience into consideration. 

Even if your intended audience can hear stereo effects (with theatrical or DVD distribution, 
for example), excessive use of stereo can be tedious. You can use stereo panning, but don’t 
use it so much that viewers are distracted.

This holds doubly true for dialog. Even in feature films released on DVD with 5:1 surround 
sound, most dialog is centered. This is the equivalent, in stereo, of leaving the pan value at 0. 
Dialog that moves back and forth excessively between the right and left speakers can be 
incredibly distracting, taking the viewer’s attention away from the content of the program.

On the other hand, stereo works much differently in music. With music, stereo is used to fill 
the space around the audience, and to give a sense of openness to the sound. For this 
reason, it’s always a good idea to preserve the original stereo image of any music clips you 
capture or import, to utilize this quality in your mix.
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Adjusting Volume Levels and Pan/Spread in the Timeline
Instead of opening clips in a sequence in the Viewer to change their volume levels and pan 
or spread, you can adjust these values directly in the Timeline. Making simple adjustments to 
the volume of clips in a sequence is easy, but, using the pen tools and keyboard shortcuts, 
you can also add, adjust, and remove keyframes to mix your clips dynamically.

To use all the commands and tools described in this section, you must click the Clip Overlays 
control in the Timeline to display the volume and pan/spread overlays.

Using the Pen Tools

While the pen tools in the Tool palette have many uses throughout Final Cut Pro, in this 
chapter we’ll look at how you can use them to create keyframes on the volume level overlay 
of a clip in the Timeline.

m Pen tool:  The Pen tool allows you to add keyframes to the volume overlay (press the P key).

m Pen Delete tool:  The Pen Delete tool allows you to remove keyframes from the volume 
overlay (press the P key twice).

Important Keyboard Shortcuts
m Using the Option key to select the pen tools

When using the Selection tool, holding down the Option key and moving the pointer over 
the volume level overlay in the Timeline makes the Pen tool the active tool. This is a fast 
and easy way to create keyframes to mix your levels.

Holding down the Option key and moving the pointer to an existing keyframe will result in 
the Pen Delete tool being selected, so that you can quickly delete keyframes you don’t want.

Clip overlays control

Pen tool Pen delete tool
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m Using the Command key to “gear down”

In Final Cut Pro, items you drag onscreen normally move at the same speed you move 
your mouse across your work surface. When you’re dragging the volume level overlay, 
usually this works just fine. However, you can drag even more precisely by pressing the 
Command key after you start dragging an item.

If you hold down the Command key while dragging the volume level overlay, the overlay 
moves much more slowly, and its numeric value changes in much smaller increments. 
This is especially valuable when mixing levels in the Timeline, where the small height of 
clips can make precise level adjustment difficult.

The Command key works with nearly any dragging operation in Final Cut Pro.

Changing Volume in the Timeline

Changing the volume directly in the Timeline is fast, and especially useful when you need to 
mix the levels of clips relative to other clips playing at the same time. 

For example, if you want to raise and lower the volume of a music clip to correspond with 
the lines a narrator is speaking, you’ll be able to see how the narrator’s dialog lines up with 
the music clips if you turn on audio waveforms in the Timeline. That way you can easily see 
exactly where you need to set your keyframes to achieve the desired levels.

To adjust the volume of a single clip with no keyframes:

1 Click the Clip Overlays control at the bottom of the Timeline to display overlays.

2 Drag the volume level overlay up or down to adjust volume. The overlay is a red line if the 
clip is not selected, and a green line if it is.

The pointer changes to an Adjust Line Segment pointer when it’s directly over the volume 
level overlay, and a box displays the change in levels as you drag.

Volume level overlay

Clip Overlays control Change in volume level
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To add a keyframe to the volume overlay of a clip in the Timeline:

1 Do one of the following:

m Select the Pen tool in the Tool palette (press the P key).

m If you’re using the Selection tool, press and hold down the Option key.

2 Move the Pen tool to the point in your sequence where you want to set a keyframe, then 
click the overlay to set the keyframe.

The keyframe appears as a small diamond at the point where you clicked.

To select a range of keyframes to modify:

m Use the Range Selection tool to select a group of keyframes. You can then change the 
level, move, or delete just those keyframes.

To adjust keyframes in the Timeline:

m Place the Selection tool directly over a keyframe, so it turns into a crosshair pointer. You 
can then adjust a single keyframe by dragging it up and down to change its level, or from 
side to side to move it forward and backward in time. 

To adjust a section of a clip’s overlay in the middle of four keyframes: 

m Drag just that section up or down, as if you were dragging the entire overlay.
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To delete volume keyframes in the Timeline:

m Select the Pen Delete tool in the Tool palette (press the P key twice). Then place the Pen 
Delete tool on the keyframe you want to delete, and click to delete it.

m With the Selection tool selected, press and hold the Option key, then move the pointer to 
the keyframe you want to delete. When the pointer turns into the Pen Delete tool, click to 
delete it.

m Control-click the keyframe you want to delete, then choose Clear from the shortcut menu.

To adjust the volume of a group of clips simultaneously:

1 In the Timeline, select a group of audio clips whose levels you want to adjust.

2 Choose Levels from the Modify menu.

3 Use the slider to adjust the volume level and choose Relative or Absolute from the pop-up 
menu, then click OK.

m Relative adjusts each track’s volume relative to the current level. 

m Absolute changes all selected tracks to the value indicated next to the slider.
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Using Keyframes in the Timeline to Control Audio Levels

Let’s look at a practical example of how to use the techniques described in the previous 
section to mix levels. Suppose you’ve edited a music clip and a clip with a voice narration 
together in your sequence. 

There are long pauses between the narrator’s lines, during which you want the music to 
be the dominant audio track. So you set the overall level of your music to –4 dB, since 
that’s the level at which the audio sounds best between the actor’s lines. When the narrator 
speaks, however, you want the level of the music to drop so it doesn’t compete with the 
narrator for attention.

If you hold down the Option key and click the level overlay of the music clip with the Pen tool, 
you can place groups of four keyframes at each place where a line is spoken by the narrator:

Keyframes set
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Then, releasing the Option key, you can drag the area in the middle of each group of four 
keyframes down, to lower the level of the music while the narrator speaks.

Finally, you’ll want to move the outside pair of each group of four keyframes outward a bit, so 
the volume of the music doesn’t change too abruptly and startle the audience. Less steep slopes 
between keyframes result in more gradual fades from one volume level to the next.

Lowered levels

Adjust the slope of 
the level change.
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Changing Pan in the Timeline

You can also adjust the pan of one or more clips in the Timeline using the Audio command in 
the Modify menu, but you can’t make as many adjustments as you can in the Viewer. Using 
the menu, you can set a clip’s pan all the way to the left, the center, or the right of the stereo 
output channels.

Note:  If you use this method to change the pan for a clip that’s a stereo pair, you’ll disable it 
as a stereo pair. If you want, you can turn the clip back into a stereo pair using the Stereo Pair 
command in the Modify menu.

To change the pan for a clip or clips:

1 In the Timeline, select the clip or clips you want to pan.

2 Choose Audio from the Modify menu, then choose a pan option from the submenu. You 
have three choices:

m Pan Left:  Pans audio all the way to the left stereo output (Control-comma).

m Pan Center:  Centers audio evenly between both left and right stereo outputs 
(Control-period).

m Pan Right:  Pans audio all the way to the right stereo output (Control-/).

Pan controls
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Real-Time Audio Mixing in Final Cut Pro
Final Cut Pro can mix and play back multiple audio tracks in a sequence in real time, even 
when setting dynamic levels, stereo panning, and adding audio filters. The number of tracks 
that can be played back while being mixed and filtered depends on your hardware 
capabilities, including your computer’s processor speed, the seek time and sustained transfer 
rate of your hard disk, and the amount of RAM available to Final Cut Pro. 

Different filters and transitions affect real-time playback in varying degrees. For example, an 
audio cross fade or transition decreases the number of audio tracks you can play back in real 
time by one. Thus, if your hardware is capable of playing back eight audio tracks without 
rendering, adding a single cross fade will decrease the number of tracks you can play back 
without rendering to seven.

If Final Cut Pro can’t mix all the tracks in a sequence in real time, you’ll hear a series of beeps 
indicating that part or all of your sequence must be rendered before being output as a final mix.

Calculating the Number of Tracks Played Back in Real Time

The number of tracks Final Cut Pro attempts to mix in real time is determined by the 
Real-time Audio Mixing setting in the General tab of the Preferences window.

Enter the number of audio tracks 
Final Cut Pro mixes in real tim‘e.
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Since the number of real-time tracks you can play back largely depends on your hardware, 
performance will vary from system to system. Increasing the number of tracks in this field 
doesn’t mean they’ll all play. 

To determine the number of tracks your system can play back in real time:

1 Add a video clip with a typical data rate for your working environment to your sequence. 
Include transitions and filters that you’d likely use for such a clip.

2 Add 16 or more audio clips at the same point in time as your video.

3 Choose Preferences from the Edit menu and set the number in the Real-time Audio Mixing 
field to the number of tracks in the sequence.

4 Make sure the checkbox labeled “Report dropped frames during playback” is selected.

5 Play back the sequence.

If your system cannot support the number of tracks in the sequence, you’ll see a “dropped 
frames” warning.

6 If you have dropped frames, reduce the number of tracks in the sequence and play it back 
again. Repeat this step until the sequence plays without dropped frames.

7 Set the number of real-time tracks in the Preferences window to the number that played back 
without dropped frames.

Important  If the number of tracks is set too high, you may have dropped frames 
during playback.
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About Track Costs

Track costs refer to how much of your system’s resources an audio effect consumes. 
Different audio effects, such as filters and transitions, have different track costs.

If the track costs of all the effects you’re using in your sequence are higher than the number 
of tracks your system can play back in real time, you must render your sequence (or part of 
it) before playing back. “Render beeps” will alert you to the need for rendering when you try 
to play the sequence.

Effect Track cost

Mono track 1 track

Mono track with transition 2 tracks

Stereo pair 2 tracks

Most simple audio filters 3 tracks

Stereo pair referenced as a 
subsequence

4 tracks

Compressor/Limiter filter 6 tracks

Expander/Noise Gate filter 6 tracks

Vocal DeEsser 6 tracks

Vocal DePopper 6 tracks

Track with a subsequence Number of tracks in subsequence

Reverb and Echo filters Must always be rendered
814 Chapter  17   



The render bar has two regions. The upper region indicates the rendering status of video 
items in your sequence. The lower region indicates the rendering status of audio items in 
your sequence. A red line in the lower region means that the audio in your sequence must be 
rendered for playback; a gray bar means that rendering is not necessary.

Using Mixdown Audio to Prevent Dropped Frames

If you have a complex audio mix with numerous clips, keyframes, filters, and transitions, it 
may start to affect the playback of your sequence. You can use the Mixdown Audio command 
in the Sequence menu to render all of the audio tracks in a sequence, along with their 
accompanying transitions and filters, into a single render file.

Note:  This command has no effect on how your clips are edited. All audio clips remain on 
their own tracks in the sequence just as they were before. The Mixdown Audio command 
only consolidates the clips for playback in an invisible preview file.

Once you’ve applied mixdown audio to a sequence, the menu item is dimmed and a 
checkmark appears next to it to show that the audio in the sequence has been rendered as a 
preview file. If you move any audio clips afterwards, the preview file is discarded, and the 
Mixdown Audio command again becomes available in the Sequence menu.

The upper video bar (gray) 
shows that rendering is 
not needed.

The lower audio render 
bar (red) shows that 
audio must be rendered. 

Audio transition, which 
increases track cost
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To mix down audio in a sequence:

1 Select a sequence in the Timeline.

2 With the Timeline or Canvas active, choose Mixdown Audio from the Sequence menu.

Subframe Audio Operations
While the smallest unit of video is a single frame, the smallest unit of audio is a sample. There 
are 48,000 samples per second of audio, as opposed to 29.97 frames of video. Because of this, 
you can set keyframes and slip audio sync by as little as 1/100th of a single video frame.

Setting Subframe Keyframes to Eliminate Clicks

Sometimes, when you find the perfect edit point for cutting a clip into your sequence, you’ll 
notice a pop or click in the audio. This happens when you make a cut on an awkward sample 
that just happens to occur at a frame boundary.

You can eliminate pops and clicks by setting keyframes for your audio levels within 1/100th of 
a frame. Usually, changing an audio edit point by just a few hundredths of a frame will 
eliminate the clicking.
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To set and adjust subframe keyframes:

1 Open the clip in the Viewer and click the Audio tab.

2 Move the playhead to the edit point that’s causing the click by pressing Shift-I or Shift-O, or 
by using the Up and Down Arrow keys to move from point to point.

3 Zoom into the clip as far as possible.

When you’re zoomed in all the way, the playhead in the Viewer is the width of one video frame.

4 Hold the Shift key down as you drag the playhead to the exact place where the click occurs. 

Level Keyframe button
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5 Click the Level Keyframe button to mark four keyframes in a row. The two inner keyframes 
should surround the problem samples, while the two outer keyframes are placed a few 
100ths of a frame outside of these.

6 Drag the part of the level overlay between the two inner keyframes down until the box 
indicates –60 dB. The overlay should now look something like this:

The unwanted noise should be gone, and the rest of your clip’s audio is not affected. 
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Subframe Synchronization of Audio and Video

When you’re synchronizing audio and video, audio that’s as little as 300 samples off perfect 
sync can be noticeable. For this reason, Final Cut Pro allows you to resynchronize your audio 
in increments of 1/100th of a frame. There are several cases in which this will come in handy:

m When reediting music clips, it’s essential that you keep all subclips of the music 
synchronized to the rhythm of the piece. Even a subtle offset will be noticeable.

m Video and audio that were recorded from separate sources and resynchronized on tape 
for video capture may have a subtle offset in sync.

m Audio that was recorded with a microphone far away from the audio source might have 
an offset between the video and audio since sound moves through the air more slowly 
than images.

To resync audio and video by fractions of a frame, open a clip in the Viewer and hold down 
the Shift key while dragging the playhead within a single video frame. This allows you to 
move the playhead in increments of 1/100th of a frame. When you set a new edit point in the 
clip, the clip’s video track slips a fraction of a frame to synchronize with the audio.

To perform a subframe slip edit in an audio clip:

1 Open a clip with both video and audio in the Viewer, then click the Audio tab.

2 Move the playhead to the In or Out point of the clip, then press Command-+ to zoom in on 
the audio waveform as far as possible.

A wide playhead bar in the Viewer represents one video frame at full magnification.
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3 Press the Shift key and position the playhead within the frame to a new point with better sync.

4 Click the Mark In or Mark Out button.

Final Cut Pro slips the audio by the offset from the point where you moved the playhead to 
the boundary of the previous whole frame.
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Audio Filters
Final Cut Pro includes a number of filters that you can use to adjust your audio clips. Unlike 
many audio applications that are geared toward music production and include a variety of 
filters for creating fancy audio effects, Final Cut Pro’s filter set is more utilitarian. The goal of 
editing a video program is not to make things sound “neat,” but to make the audio as strong, 
clear, and noise-free as possible, so the audience can understand every word of dialog and 
appreciate every sound effect and note of music without distraction. Filters can also be used to 
blend the clips in your audio mix, to prevent the sound quality or tone of a particular clip from 
“sticking out.” In a well-edited mix, all the audio elements will work together in harmony to 
communicate the meaning of your program. For these reasons, Final Cut Pro features a large 
selection of equalization, compression, and noise reduction filters. 

Using Filters

Filters can be added to any audio clip in a project. You can add filters individually or in 
groups. When you add filters to a clip, they appear in the Filters tab of the Viewer when that 
clip is opened in the Viewer. How they appear depends on whether the audio clip in the 
Viewer is a stereo pair:

m If the audio in the Viewer is a stereo pair, every filter you add is applied to both channels 
equally, and only one set of controls appears.
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m If the audio in the Viewer is not a stereo pair, every filter you add is applied to both 
channels, but each channel can have individual settings.

All filters have several controls in common: 

m Parameter disclosure triangle:  This allows you to show or hide a filter’s parameters.

m Enable checkbox:  This allows you to enable or disable filters without removing them 
from the clip. You can use it to disable filters temporarily to preview a different filter.

m Reset button:  Resets a filter’s settings to the default values.

m Parameter pop-up menu:  Allows you to enable and disable specific settings for a filter.

Parameter disclosure triangle Reset button

Checkbox
Parameter 
pop-up menuName of filter
822 Chapter  17   



Each filter also has a unique set of controls. These controls usually include sliders, text fields, 
and checkboxes that let you adjust the filter’s parameters.

Final Cut Pro’s audio filters can be separated into four broad categories: equalization (EQ), 
compression and expansion, noise reduction, and effects.

Equalization (EQ) Filters

Equalization can be described as a specific kind of volume (or gain) control. Instead of raising 
or lowering the volume of an entire clip, however, it raises or lowers the volume of individual 
frequencies of sound in the clip. Just as a video image is made up of many different pixels, each 
one in a different frequency of light, audio recordings are made up of a vast collection of 
waveforms, using many different frequencies of sound. Each frequency is associated with an 
audio pitch. For example, the note generated by each key of a piano is at a specific frequency.

Particular kinds of sound—men’s voices, women’s voices, tape hiss, and traffic noise—all 
appear at different frequencies of the audio spectrum. EQ filters can be used for many things, 
from minimizing background noise in a recording to accentuating a narrator’s voice over 
background music. If used excessively, EQ can even create a telephone or loudspeaker effect 
on a spoken audio clip.

EQ filters are not perfect. Using them effectively requires experience, patience, a good ear, 
and a good listening environment. Because sound is extremely complex, lowering the 
volume of the frequencies you want to minimize, like traffic noise, can affect the quality of 
the sound that you’re trying to preserve, such as a narrator’s voice. Striking a balance 
between these two is part of the art of mixing.

Checkbox (allowing you to 
adjust the filter’s parameters)

Text and numeric 
entry fields

Sliders
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Using EQ filters

All of Final Cut Pro’s EQ filters use a combination of three controls. As an example, we’ll look 
at the Parametric Equalizer filter:

m The Frequency slider lets you select the audio frequency you want to boost or attenuate. 
The lowest available frequency varies from 10 Hz for the High Pass filter, to 80 Hz for the 3 
Band Equalizer. The highest available frequency for all EQ filters is 20,000 Hz.

m The Q setting, when available, allows you to select a wider or narrower range of 
frequencies to affect. The higher the number, the more frequencies will be affected.

m Gain controls how much you’ll be boosting or attenuating the specified frequency range.

When using EQ, follow the adage that less is more. It’s better to attenuate the frequencies 
you don’t want than to boost the ones you do and risk distorting the audio. Boosting EQ is 
the same thing as mixing the levels for your track, just in a very specific frequency range. If 
you’re not careful, these frequencies can be overdriven and distorted just like any other 
audio signal.

Above all, feel free to experiment. But if you’re not sure whether a filter is working for you 
or not, remove it and leave your signal alone. It’s better to have no EQ applied than to apply 
it poorly.

Compression and Expansion Filters

The compression and expansion filters allow you to adjust an audio clip’s dynamic range 
after it’s been captured.

Compression

A common problem when mixing a soundtrack with a limited dynamic range is what to do with 
individual clips that have too much of a range. Many common sources of unwanted dynamic 
range can’t be easily fixed by simply lowering the overall volume of the clip. Two examples are 
music and dramatic voice performances. In both cases, the volume of the clips can vary widely 
from one moment to the next, but any attempt to even out the levels by mixing dynamically will 
result in noticeable changes in volume in either the background of the music or the room tone 
of the voiceover. Neither of these is acceptable in a high quality mix.
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To solve this problem, Final Cut Pro’s Compressor/Limiter filter allows you to adjust the 
dynamic range of an audio clip so that the loudest part of the clip is compressed to within a 
specified range of the softest part of the clip. Compression can also be used, when applied 
very lightly, to increase the “warmth” of voices in your mix.

Using compression

The Compressor/Limiter filter has four controls:

m The Threshold parameter defines how loud the loudest portion of the clip can be before 
compression is applied. This is the first setting you’ll adjust. 

m The Ratio slider determines how much compression is applied. Don’t overdo the 
compression; a little goes a long way, and too much results in further distortion. 

m Attack Time is how quickly the filter reacts to changes in volume (the default is usually 
acceptable, but you can experiment).

m Release Time defines how slowly the filter lets go of the change in volume that it made 
(again, the default should work well, but feel free to experiment).
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Expansion

The expansion filter is the inverse of the compression filter. While compression lowers parts 
of an audio clip that are too high, the expansion filter raises parts of a clip that are too low. 
For example, if you have a voiceover recording in which the person speaking moves away 
from the microphone from time to time, causing his voice to lower, you can use the 
expansion filter to even out the level of his voice by boosting the parts that drop.

Using expansion

Expansion works in the opposite way to compression:

m The Threshold slider defines how low the lowest portion of the clip can be before 
expansion is applied. This is the first setting you’ll adjust. 

m Ratio affects how much expansion is applied to boost the signal.

m Attack Time defines how quickly the filter reacts to changes in volume (the default is 
usually fine, but you can experiment).

m Release Time defines how slowly the filter lets go of the change in volume it made (the 
default is usually fine, but you can experiment).

Noise Reduction Filters

Final Cut Pro has three noise reduction filters for use in specific situations.

Hum Remover

The Hum Remover lets you get rid of “cycle hum” that may have been introduced into your 
audio recording by power lines crossing your cables, or by a shorted ground wire in your 
setup. Hum from power sources generally sounds like a low buzzing and has a frequency that 
corresponds to the circuitry in your country (usually 50 Hz in European countries and 60 Hz 
in the United States). 
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Using the Hum Remover

m The Frequency slider lets you select the frequency of hum that this filter will attempt to 
remove. Different countries use different power frequencies, so you need to specify 
exactly what frequency to tune out. In general, most AC (alternating current) operates at 
either 50 or 60 Hz. 

m The Q slider allows you to select a range of frequencies to filter. If the important elements 
of your recording overlap into the frequencies that are being filtered out, you might want 
to narrow this value somewhat.

m The Gain filter lets you set how much of the signal you’re attenuating. By default, it’s set 
to the maximum –60 dB.

m The Harmonics checkboxes allow you to attenuate additional frequencies that may be 
introduced into your signal as a result of the primary cycle hum. These frequencies are 
automatically derived by the filter, and you can specify up to five.

Vocal DeEsser

The Vocal DeEsser allows you to attenuate the “ess” sounds produced by an actor with a 
“sibilant” voice (that is, someone whose “ess” sounds are very pronounced), or by a 
microphone that accentuates high frequencies. This filter is essentially a specialized EQ that 
reduces, not eliminates, these frequencies.

Vocal DePopper

The Vocal DePopper lets you attenuate the harsh “P” sounds that result from puffs of breath 
bursting into the microphone. Proper miking should prevent this in the first place, and if you 
have just one or two pops, you can use keyframes to reduce the level of the frames with the 
pop. (See “Setting Subframe Keyframes to Eliminate Clicks” on page 816.) Still, if you have a 
clip with a lot of pops, this filter may reduce these to an acceptable level.
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Effects

The only two “effects” filters in Final Cut Pro are the Echo and Reverb filters. They’re meant 
to help you match foreground audio clips to the background in which they appear. In most 
cases, you’ll use the Reverb filter to simulate a specific acoustic environment.

For example, if you have a video clip of a huge cave that your characters are exploring but the 
actors are actually being shot against a blue screen, you can make their voices sound as if 
they’re in the cave by adding some reverb. If they’re in a big space, such as a canyon, you 
might use an echo instead.

Using the Echo and Reverb filters

m The Effect Mix slider determines how much of the “dry,” or original, sound from the 
audio clip is mixed with the affected audio. By keyframing this parameter over time, you 
can make it sound as if someone is walking from far away in a room (where there would 
be more reverb) toward the microphone (where there would be less reverb the closer 
they came).

m The Effect Level slider defines how loud the reverb or echo effect will be.

m The Brightness slider affects the quality of the reverb or echo. Boosting this parameter 
makes the effect seem more intense.
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m The Type pop-up menu (Reverb only) lets you specify the kind of acoustic environment 
the filter will attempt to reproduce.

m The Feedback slider (Echo only) affects how long the echoes produced by the filter will last. 
As they repeat, they’ll interact with themselves to produce a complex series of echo effects.

m The Delay Time slider (Echo only) lets you determine the pause, in milliseconds, between 
each echo. The longer the pause, the bigger the apparent space of the environment.

Applying Filters to an Audio Clip

Applying audio filters to clips in Final Cut Pro is easy.

To apply an audio filter to a clip in a sequence:

m Drag an audio filter from the Effects tab in the Browser to a clip in a sequence in the 
Timeline. If you drag the audio filter to a video clip, it’s applied to any audio items linked 
to that clip.
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m Select one or more clips in a sequence in the Timeline, choose Audio Effects from the 
Effects menu, then choose a filter from the submenu. The filter is applied to all the clips 
you selected. If you selected video clips, the filter is applied to any audio items linked to 
those clips.

m If a sequence clip is open in the Viewer, you can either drag a filter from the Effects tab of 
the Browser directly to the Viewer, or choose a filter from the Audio Effects submenu of 
the Effects menu. The filer is applied to the clip in the Viewer.

If you apply more than one filter to an audio clip, the filters are applied serially. In other 
words, the first audio filter is applied, then the resulting audio signal is fed through the next 
audio filter, and so on.

If you apply multiple filters to a clip, the order in which they appear in the Filters tab for that 
clip in the Viewer determines how the clip sounds. Although the initial order of filters in the 
tab depends on when they were applied, you can change the order any time.
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To apply multiple filters to a clip in a sequence:

m Continue to apply more filters to the clip, one at a time, using any of the methods described 
previously. Filters are applied to your audio clip in the order in which they were added.

m Shift-click, or Command-click multiple filters in the Effects tab of the Browser, then drag 
them all to one or more selected clips in a sequence in the Timeline.

Filters can also be copied, along with all of their settings, and pasted into one or more clips in 
the same sequence, or in another sequence.

When you copy a clip in the Timeline, you also copy all of that clip’s settings. These settings 
include filters that have been applied to the clip. Instead of pasting the clip, you can paste 
only that clip’s filters into other clips that you’ve selected. To do this, you use the Paste 
Attributes command.

To copy and paste filters from one clip to another:

1 Select a clip in the Timeline with a filter applied to it.

2 Copy the clip.

3 Select one or more clips in the Timeline to apply the filter to.

4 Choose Paste Attributes from the Edit menu (or press Option-V ).
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5 In the Paste Attributes dialog box, select these options:

m Scale Attribute Times:  Shrinks or stretches the keyframes of your copied clip attributes to 
fit the duration of longer clips you may paste them into.

m Audio Attributes:  Determines which attributes of the audio clip are pasted.

m Filters:  Applies the parameter values and keyframes you have set for all filters in the 
clip you copied.

 

6 Click OK.

The filters are pasted into the clips you selected.

Warning  Pasting attributes into clips that have different frame rates will produce 
erratic results.
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Displaying Filters in the Timeline

Once a filter has been applied to an audio clip in a sequence, you can use the Clip Keyframes 
control in the Timeline to add additional space underneath each audio and video track in the 
Timeline to indicate which clips have filters applied, and which ones don’t. If a filter is added 
to an audio or video clip in the Timeline, a small green bar appears in this space for the 
duration of that clip. If a motion setting is modified for a video clip in the Timeline, a small 
blue bar appears in this space for the duration of that clip.

If you add keyframes to the filter or motion settings for a clip, those keyframes appear on top 
of the bar to which they apply. Filter and motion bars can be displayed or hidden at any time. 

You can show or hide clip keyframes using the Clip Keyframes control or the Timeline 
Options tab in the Sequence Settings window.

If you use audio transitions or filters, you must render the parts of the sequence to which 
you’ve applied them. In addition, you may have to rerender parts of your sequence before 
you can play back all tracks in a multitrack sequence. 

Modifying and Removing Filters

To modify filters in a sequence, you may have to open the clip to which the filter applies in 
the Viewer, depending on how many “Real-Time Audio Mixing” tracks you’ve set in the 
General tab of the Preferences window.

Note:  Filters can be added to clips even if the clips aren’t in a sequence. If you want to 
modify or remove a filter for a clip in a sequence, make sure the sequence clip is open in the 
Viewer, not the master clip from the Browser.

To view a clip’s filters in the Viewer:

m If your sequence clip is already open in the Viewer, click the Filters tab.

m Double-click the filter bar in the keyframes area of a clip in the Timeline. The clip opens 
in the Viewer with the Filters tab in front.

Clip Keyframes control
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m If a sequence clip was open in the Viewer with its Filters tab in the front, a new sequence 
clip opened in the Viewer will also appear with its Filters tab in front.

Using the Filters tab, you can make adjustments to the parameters of individual filters. Since 
filters vary widely, see “Using Filters” on page 821 for general guidelines on how to use them.

In addition to adjusting individual settings for each filter, you can also enable and disable the 
filters without removing them from your clip, rearrange their order to modify their effects, 
and remove them from your clips.

To enable or disable a filter:

m Click the checkbox by the filter name in the Filters tab. If you uncheck the box, the filter 
is disabled, but not removed from the clip. This is a useful way to preview different 
combinations of filters, without constantly applying and deleting the same filters.

Since filters are applied serially, if you apply multiple filters to a clip, the order in which they 
appear is very important. (See “Applying Filters to an Audio Clip” on page 829.)

To change the order of filters:

m Drag a filter in the Filters tab to change its place in the list of filters applied to that clip. 

Note:  To make it easier to drag the filter, click the disclosure triangle to the left of the 
filter’s name to hide the filter’s parameters.

To remove a filter from a clip:

m Select a filter in the Effects tab, then choose Clear from the Edit menu or press the 
Delete key.

m Click the filter category bar in the Filters tab to select all of the filters applied to a clip, 
then choose Clear from the Edit menu or press the Delete key.

Saving a Filter or Transition as a Favorite

If you’ve set up a filter with parameters that you know you’ll want to use again in the future, 
you can save that filter as a favorite for easy access.

To make a filter a favorite:

m Drag the filter you want to save from the Filters tab in the Viewer to the Favorites bin in 
the Effects tab in the Browser.

m Select the filtered clip in the Timeline and choose Make Favorite Effect from the Modify 
menu or press Option-F.

You can apply favorites in the same way as any other filter. Favorite audio filters appear in the 
Favorites bin in the Effects tab, and they also appear in the Audio Filters submenu of the 
Effects menu.
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To delete a filter saved as a favorite:

1 Select the filter in the Favorites bin of the Effects tab in the Browser.

2 Do one of the following:

m Press the Delete key.

m Choose Clear from the Edit menu.

Keyframing Audio Filters

Keyframing filters works the same way as keyframing volume levels or pan and spread. Unlike 
these other clip parameters, however, filters have many simultaneous settings you can adjust, 
all of which can be keyframed.

To the right of each control is a set of keyframing controls. Like volume levels or stereo pan 
or spread, filters can be keyframed to change their effect on your clip over time.

m Filter category bar:  The filter category bars group the video filters at the top, and the 
audio filters at the bottom. Clicking either the video filters bar or the audio filters bar 
selects all of the filters in that category.

m Name bar:  Each filter has a name bar that contains a disclosure triangle, Enable 
checkbox, and the name for that filter. The entire name bar can be used to drag a filter 
from one position in a list of multiple filters to another.

m Enable checkbox:  The Enable checkbox allows you to enable or disable a filter in the 
Filters tab. With this checkbox deselected, the filter will neither be applied nor rendered.

m Disclosure triangles:  Some effects have multiple parameters, all of which can be 
individually keyframed. To see these parameters, you can click the disclosure triangle next 
to the parameter.

m Parameter controls:  Each filter has its own set of parameter controls. For information on 
how to adjust the different kinds of controls available to a filter in Final Cut Pro, see 
“Audio Filters” on page 821.

Keyframe display area

Section of clip 
currently used

Sliders

Enable

Name bar

Audio filter keyframe
navigation buttons
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m Keyframe buttons:  Click the keyframe buttons to place keyframes on the corresponding 
overlay at the current playhead location in the keyframe graph, to prepare for creating a 
dynamic change in an effect.

m Keyframe navigation buttons:  These buttons, to the left and the right of the 
corresponding keyframe button, allow you to move the playhead forward or backward 
from one keyframe on the corresponding overlay to the next. 

m Reset buttons:  These buttons delete all marked keyframes for the corresponding 
parameter or parameters, and reset them to their default value.

m Keyframe graph:  The keyframe graph shows all of the overlays and keyframes associated 
with the parameters currently displayed in the Viewer. 

m Keyframe graph ruler:  The keyframe graph has a ruler that corresponds to either the 
duration of the clip, or the location of a clip in a sequence:

m If a clip is opened in the Viewer from the Browser, the keyframe ruler shows the 
duration of the clip itself. The playhead in the Viewer moves independently of the 
playhead in the Timeline or Canvas.

m If a clip is opened in the Viewer from a sequence in the Timeline, the keyframe ruler 
shows the section of the Timeline that the clip is edited into, and the playhead in the 
Viewer is locked to the playheads in the Timeline and the Canvas.

m Zoom control:  These controls let you zoom in and out on the area displayed in the ruler 
in the keyframe graph, expanding and contracting the keyframe graph ruler as you do so. 
Using the Zoom control will keep the area of the keyframe graph that was visible when 
you clicked the control centered as you zoom in or out.

Using the zoom keyboard shortcuts results in slightly different behavior. Pressing 
Command-+ (plus) or Command-– (minus) will zoom in or out of the duration displayed 
by the keyframe graph area, with the view centered on the current position of the playhead.

m Zoom slider:  Like the Zoom control, this allows you to zoom in and out of the area 
displayed by the keyframe graph ruler. Dragging the thumb tabs on either side zooms in or 
out, moving the visible area in the direction you drag. Pressing the Shift key and dragging 
one of these thumb tabs zooms both thumb tabs, and leaves the visible area centered.

Once you’ve zoomed into the keyframe graph ruler, you can use this control to scroll 
along the entire duration of your clip by dragging the slider to the left or right. 

m Timecode navigation field:  This field displays the position of the playhead in the 
keyframe graph area. You can enter a new timecode value to move the playhead to 
another time. 

m Section of clip currently used:  The frames of a clip in the Viewer Effects tab that are 
outside the duration specified by its In and Out points are grayed out. This is done so that 
you know where to apply your keyframes.
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To set a keyframe:

m Move the playhead in the keyframe display area of the Viewer to the time where you want 
to put a keyframe, and click the Keyframe button for the parameter you want to set.

m With the Option key held down, move the pointer over a parameter overlay. When it turns 
into a Pen tool, click the parameter overlay to add a keyframe to the overlay at that point.

The keyframe appears as a small blue diamond on top of the overlay you added it to.

To set additional keyframes for a parameter:

1 Move the playhead to another point in the Viewer’s keyframe display area where you want to 
set a keyframe.

2 Do one of the following:

m Drag the parameter slider to set a new keyframe with that value.

m Type a number into the appropriate field to set a new keyframe at that value.

m Click the appropriate Keyframe button to add a keyframe to the overlay of that parameter 
at the overlay’s current value.

m With the Option key held down, click anywhere on a parameter overlay with the Pen tool 
to add a keyframe at that point without changing the value of the overlay. You can add as 
many keyframes as you want by clicking repeatedly with the Option key held down.

The new keyframe appears as a small blue diamond on top of the overlay you added it to.

Click here to create a keyframe 
for that parameter.
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To move the playhead in the Viewer from one keyframe to another:

m Click the left and right keyframe navigation buttons for a parameter to move the playhead 
to the next keyframe to the left or right of the current position of the playhead.

m Press Option-K to move the playhead to the next keyframe to the left of the playhead.

m Press Shift-K to move the playhead to the next keyframe to the right of the playhead.

To adjust the value of a single keyframe:

m Move the playhead to the keyframe you want to adjust, then adjust the appropriate 
parameter control to a new value.

m Move the playhead to the keyframe you want to adjust, type a new value in the 
appropriate field, and press the Return key.

m Move the pointer over the keyframe you want to modify. When it becomes a crosshair 
pointer, drag the keyframe up or down to change its level, left or right to change its location.

To adjust a section of an overlay in the middle of four keyframes:

m Move the pointer over this section of overlay. When it turns into the Adjust Line Segment 
pointer, drag just that area up or down to modify it. The rest of the overlay before and 
after the four keyframes remains untouched. 

To move a keyframe forward or backward in time:

m Move the pointer over the keyframe you want to move. When it becomes a crosshair 
pointer, drag the keyframe forward or backward along the overlay. 

As you drag, a box displays the timecode duration of the change you’re making.

To smooth a keyframe:

m Control-click the keyframe and choose Smooth from the shortcut menu. Smoothing a 
keyframe makes its change from one value to another more gradual by applying a curve 
to the overlay.
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To delete a keyframe:

m Move the playhead to the keyframe you want to delete, then click that parameter’s 
Keyframe button to remove it.

m Move the pointer over the keyframe you want to delete. When it becomes a crosshair 
pointer, drag the keyframe up or down out of the keyframe display area. When the pointer 
turns into a small trash can, release the mouse button.

m Hold down the Option key and move the pointer over an existing keyframe. When the 
pointer changes to the Pen Delete tool, click an existing keyframe with the Pen Delete 
tool to delete that keyframe.

m Control-click the keyframe you want to delete, then choose Clear from the shortcut menu.

To delete all keyframes:

m Click that filter’s Reset button to clear all keyframes from all parameters for that filter and 
restore them to the default values.
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Rendering Audio Filters and Transitions
With a few exceptions, each time you apply an effect or transition to a clip, you’ll have to 
render that clip. While some filters can be played back in real time, they’ll hinder your ability 
to mix tracks in your sequence unless they’re first rendered.

The render bar, under the ruler in the Timeline, indicates the rendering status of all filters 
and transitions you’ve edited into your sequence. Depending on your hardware 
configuration, you’ll see different-colored bars in this area indicating whether the filters and 
effects in your sequence have been rendered, or if they even need to be.

The render bar has two regions. The upper region indicates the status of video items in your 
sequence. The lower region indicates the status of audio items in your sequence.

Video render bar

Audio render bar
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About the Colors in the Render Bar

All clips that don’t need rendering will display a dark gray bar in the render bar.

If items in your sequence have different transitions, filters, or other effects applied to them, 
colored bars indicating those areas appear in the render bar. The color of the bar shows the 
rendering status of the item at that part of the sequence.

The different indicator colors and their meanings are:

m Dark Gray:  A normal clip that doesn’t need rendering.

m Red:  A transition or effect that requires rendering, but has not been rendered.

m Steel Gray:  A transition or effect that requires rendering and has been rendered. This 
item in the Timeline has a corresponding render file on the specified scratch disk.

m Green:  A video transition or effect that can be played back in real time on your system.

m Yellow:  A video transition or effect that can be approximated in real time, so you can see 
what it will look like, but that requires rendering before it’s output to tape at full resolution.

For more information on rendering, see Chapter 23, “Rendering,” on page 1065. More 
information about real-time effects can be found in Chapter 24, “About Real-Time Effects,” on 
page 1091.

To render a single transition or filter in a sequence:

1 Select one or more clips with transitions and filters in the Timeline.
  Working With Audio 841



2 Do one of the following:

m Choose Render Selection from the Sequence menu.

m Press Command-R.

To render all transitions, filters, and effects in a sequence:

1 Select or open a sequence in the Timeline.

2 Do one of the following:

m Choose Render All from the Sequence menu.

m Press Option-R.
842 Chapter  17   



Avoiding the Loss of Audio Render Files

If you make a change to a transition or filter applied to a clip, to the overall duration of a clip, 
or to the visibility of the track a clip resides on, the clip’s render files may be lost, and you’ll 
have to rerender them.

To minimize the need for rerendering audio files, you can nest an audio clip in another 
sequence in the Timeline.

Nesting Audio Clips

When you nest an audio clip, the clip is treated as a subsequence, so it maintains the link to 
its render files even if you move or change the clip later.

To nest an audio clip or track:

1 In the Timeline, select the track or tracks you want to nest.

2 Choose Nest Item(s) from the Sequence menu (or press Option-C).

3 Select the checkbox labeled “Keep Effects, Markers, and Audio Levels with Clip.”

4 Click the Mixdown Audio checkbox, then name the new sequence.

5 Click OK.
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The audio clip in the Browser is replaced with a nested sequence that has its audio mixed 
down. (See “Using Mixdown Audio to Prevent Dropped Frames” on page 815 for more 
information on the Mixdown Audio command.) If you look in the Browser, there’ll be a new 
sequence with the name you specified. Your original audio clip is located inside that 
sequence. Changes you make to the nested sequence will not affect the render files for that 
sequence in the Browser.

Timeline before nest items

Timeline after nest items
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Final Cut Pro’s Audio Filters

3 Band Equalizer Divides the audio spectrum into three frequency bands, corresponding to 
treble, mid range, and bass. You can set the center frequency for each band 
and adjust the volume of each band relative to the others by changing the 
Gain setting.

This filter is especially versatile because it applies equalization in three 
bands of your clip simultaneously, rather than requiring you to apply three 
filters. This emulates the EQ controls that most mixing boards provide.

Band Pass Allows you to modify a single frequency band. By choosing its center 
frequency, you can modify the boost or cut level. 

You can modify the Q value to narrow or widen the frequency range that is 
heard and the level of accentuation at the center of the band. A low Q 
value gives less accentuation and wider audibility across the band. A high Q 
value focuses more sharply on the center of the band, screening out more 
of the frequencies above and below it.

The Band Pass can be used to quickly attenuate a range of frequencies in a 
clip. It’s good for creating extreme effects, like emulating the sound of a 
voice on a telephone.

Compressor/Limiter Smoothes out inconsistencies in volume levels over time, on all 
frequencies. Compression of volume reduces the dynamic range so that it 
does not become too loud. The more a sound exceeds the specified limit, 
the more it is decreased in volume, depending on the ratio setting. 

After making settings, use the Preserve Volume option to keep the overall 
level close to the original. The Threshold setting specifies the level at 
which the effect will be triggered. The Attack and Release settings specify 
how fast this effect should adjust the volume level in response to the 
beginning and end of a change in levels.

DC Notch Compensates for a specific type of signal artifact caused by DC current 
leakage by allowing you to remove a DC offset component introduced 
during recording.

Echo Adds a series of repeats to the selected audio. You can adjust the mix of the 
original source signal with the repeating echo. You can also set the level 
(amount) of the effect, brightness, feedback (duration of repeats), and 
delay (time between repeats.) Use the Echo filter to lend a “slapback” or 
“canyon” effect to the selected audio.
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Expander/Noise Gate Smoothes out inconsistencies in volume levels over time by increasing the 
volume if it drops below a specified level. The lower a level is relative to 
the highest level, the more it is increased to compensate, depending on 
the Ratio setting. Noise Gate is used to silence all sound below the 
specified volume threshold.

High Pass A Band Pass filter optimized to reduce low frequencies, leaving high 
frequencies alone. This filter is useful for reducing traffic rumble or 
airplane noise in a clip.

High Shelf Similar to a Band Pass filter, but the upper end of the frequency range is 
sharply cut off, while lower frequencies are allowed to pass. You can use 
the Gain setting to boost or cut the volume at the upper end of the 
frequency range.

Hum Remover A Notch filter that allows you to compensate for various types of hum 
interference by screening out a specific frequency. You can also specify up 
to five related harmonic frequencies to screen out.

Low Pass A Band Pass filter optimized to reduce high frequencies, leaving low 
frequencies alone. This filter is useful for dulling down a sound that is too 
“bright,” reducing things like tape hiss and machine noise from a clip.

Low Shelf Similar to a Band Pass filter, but the lower end of the frequency range is sharply 
cut off, while high frequencies are allowed to pass. You can use the Gain setting 
to boost or cut the volume at the lower end of the frequency range.

Notch Cuts out frequencies in a specific range. This works on a narrow range of 
frequencies. This effect is the converse of a Band Pass filter.

The Notch filter is useful for attenuating a specific frequency that is overly 
loud. For example, if you have a guitar recording in which the body of the 
guitar has a resonant frequency that accentuates a particular note, you can 
use the Notch filter to attenuate just that note, so it doesn’t stick out.

Parametric Equalizer Allows you to control various aspects of a single frequency band. It 
combines the features of the Band Pass, Notch, and Shelf filters. 

You can also set the Q value to narrow or widen the frequency range that is 
heard and the level of accentuation at the center of the band. A low Q 
value gives less accentuation and wider audibility across the band. A high Q 
value focuses more sharply on the center of the band, screening out more 
of the frequencies above and below it.

The Parametric Equalizer is the most flexible of Final Cut Pro’s EQ filters.
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Tips for Cleaning Up Your Audio Tracks
As you edit audio in Final Cut Pro, there are a few things you can do to make your audio 
sound more professional.

Tips for Cutting Dialog
m Use cross fades to smooth out problem edits.

If you’re having trouble finding an edit point between two audio clips that sounds 
smooth, try using a transition instead of a straight cut. More information on audio 
transitions can be found in “Using Audio Transitions” on page 775.

Reverb Allows you to simulate the natural ambience that occurs when sound is 
conducted within a physical acoustic space such as a concert hall or 
auditorium. You can adjust the mix of the dry (or original) signal and 
affected signal as well as the level (amount) and brightness of the effect. 

This effect provides a list of predefined environment types that can be 
applied to your audio clip.

Vocal DeEsser A special-purpose filter that controls and dampens sibilant (“ess”) sounds. 
Some vocal recordings overemphasize these sounds. The Vocal DeEsser 
will reduce them so that your actors don’t sound too “hissy.”

Vocal DePopper A special-purpose filter that controls and dampens plosive (“p”) sounds 
that result from bursts of wind hitting the microphone.
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m Use subframe keyframes to eliminate pops and clicks at edit points.

If there is a popping or clicking sound at an edit point that you can’t get rid of, you can 
eliminate it by opening the clip in the Viewer, setting audio level keyframes within the 
frame with the clicking, and fading those few audio samples all the way down to –60 dB. 
See “Setting Subframe Keyframes to Eliminate Clicks” on page 816 for instructions.

m Use keyframes to eliminate microphone pops in a voiceover recording.

Although you can use the Vocal DePopper filter in extreme problem cases, if you just have 
one or two pops in your audio resulting from words with the letter P, you can get rid of 
them by opening the clip in the Viewer, zooming in on the P sound, and setting four 
keyframes to lower the audio level and soften the sound.

m Use room tone to fill in audio gaps in a scene.

When you edit dialog, any part of a scene that doesn’t have dialog or clean source audio 
should be replaced with room tone from that scene, as described in “Replacing Unwanted 
Audio With Room Tone” on page 771. This includes the beginning and the end of a scene, 
even if nobody’s talking. If room tone only happens while people are speaking, it will 
sound odd. The entire scene should have the same background noise.

m If someone mumbles a single word, salvage the rest of the take.

If someone messes up part or all of a word, either by mumbling or swallowing part of it, 
you can sometimes take part or all of another instance of that word, or of another word 
that has the sound you need, and use it to replace part or all of the misspoken word.
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For example, suppose an actor was supposed to say, “Get those cats out of that tree,” and 
instead said, “Get dose cats out of that tree,” accidently swallowing the “th” sound in the 
word “those.” If you need to use that take, you could copy the “th” sound from the word 
“that” and paste it over the botched beginning of the word “dose.” The change is so small 
that nobody will notice the difference. The result in your sequence would look something 
like this:

When you do this kind of edit, watch out for the beginnings and endings of words. 
Sometimes people run words together if they speak quickly. If you’re replacing a word in 
clip 1 with the same word from clip 2, make sure the sound that comes before the new 
word in clip 2 is the same as the sound that comes before the word it’s replacing in clip 1.

m Cut away to another image to smooth cuts in dialog.

If you need to remove a word or phrase from someone’s speech, you can use a cutaway 
shot or B-roll footage at the same point so you can change the audio without viewers 
noticing an obvious jump-cut. 

One reason shots of the interviewer are included in documentary-style programs is to give 
the editor the freedom to edit the speaker’s dialog without introducing a jump-cut in the 
picture. That way, if the person on camera says the same thing twice, or says something 
stupid, you can cut it out without the audience knowing, and make the subject sound better.

You can also do this in narrative programs. If you decide to rearrange an actor’s lines, 
adding or removing dialog, you can cut to a reaction shot of the person who’s listening to 
smooth your changes to the speaker’s audio.

m Change the pace of off-camera dialog.

As long as the speaker is off camera, you can do other things as well. For example, you can 
easily change the pacing of what’s being said, making the sentence sound more or less 
dramatic. The key is to have footage you can cut away to that will seem pausible. An 
audience shot or another actor listening are two examples of plausible cutaway shots.

Remember, if you create any gaps as a result of editing your audio, fill them in with 
room tone.
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m Use the video from one take with the audio from another.

Sometimes you’ll have multiple takes of a particular shot, each with something good in it. 
For example, let’s say you have a series of takes of an actor saying “Wow! That’s a big 
piece of pie!” 

Each take is shot from a slightly different angle, and there’s one visual take that you like 
more than the others, even though the dialog in it isn’t that great. In another take, the 
actor said the word “wow” really well. A third take has the best version of the line “That’s 
a big piece of pie!” If the actor was good and the pacing of each of these takes is roughly 
the same, it’s fairly easy to combine all three clips into one good take.

m Be careful when combining dialog from different takes.

People use different intonations as they speak a sentence, and it’s important to listen for 
this. Sometimes, you’ll be unable to combine two different sentences because they won’t 
sound right together.

For example, let’s say you have two clips of someone talking. In one clip he says, “I’m 
going to throw that suitcase out the window!” In a second clip, he says “Should I put the 
box in the closet?” You want to cut from the actor to a shot of the closet when he says 
“that suitcase” so you can combine the line “I’m going to throw that suitcase” with “in the 
closet.” Unfortunately, the second sentence is a question, so the two pieces of dialog 
don’t really sound right together. Since the difference is jarring, you’ll have to try 
something else.
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m Edit in sound to handle a loud background noise at an edit point.

If you’re cutting from one clip to another, but there’s a loud sound, such as a car or a 
plane passing, right at the edit point, there’s something you can do to mask the cut. You 
won’t be able to eliminate the noise, but if you take another car or plane sound effect that 
sounds similar to the noise at your edit point, you can edit in just enough of the sound 
effect in an adjacent audio track to complete the noise of the car or plane passing that was 
cut off by your edit. You’ll need to play with the levels, mixing up the sound effect prior to 
the edit point and mixing it down afterward, but you’ll be able to mask it so that the cut 
sounds completely natural.

m Swap onscreen sound effects with new ones using a replace edit.

If you want to replace the sound of a door slamming in your source audio track with a more 
dramatic door-slam sound effect, you can easily and quickly line up the new sound effect 
waveform with the old one by doing a replace edit, so the new sound is perfectly in sync.

Tips for Cutting Music
m Use the natural beginnings and endings of music clips for your edits.

Instead of fading a piece of music in and out of a sequence at random points, try 
matching specific parts of the music with parts of the video clips in the sequence to create 
a dramatic impact. Then, at the points where you need to start and end this music in your 
sequence, edit in the beginning and the ending from that track, lining it up to match the 
rhythm and melody of the part of the track that you’re using.

Using a music track’s natural beginning and end sounds much better than just cutting into 
the middle of it, and you can usually create a series of edits using different pieces of the 
same musical track to make it work.

m Use subframe syncing to keep music on the beat.

Since music has a consistent rhythm, inconsistencies in the rhythm caused by edits to a 
music track can be painfully obvious. Since one-frame increments are rarely detailed 
enough to insure perfect sync of rhythm in a track, use subframe syncing for each 
segment that you edit to make sure the edit points between two clips from the same song 
are in rhythm.
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m Checkerboard the audio segments you’re using to create better cross 
fading.

Instead of using cross fades to transition between two edited clips from the same music 
track, edit them together across multiple tracks in your sequence:

Now, you can use the volume level overlay to create cross fades as long as you need, using 
whichever shape will make the transition from one clip to the next least noticeable.

m When you cut from a picture to music, don’t always cut on the beat.

Sometimes, lining up a video edit on a significant beat in the music can have fantastic 
results. Sometimes, however, it’s overused. Especially in music videos, remember to make 
some cuts that don’t match the beat of the music. Otherwise, your edits will be 
predictable, and ultimately tedious, to the viewer.

Instead of this

Do this
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Keep Your Tracks Organized

As you edit audio into your sequences, it’s important to keep your tracks organized. Not only 
will this make it easier for you to keep your tracks straight when you edit new clips in, it will 
make your job much easier when it’s time to mix your tracks together.

If you’re working on a project that may be distributed to an international audience, you 
should also keep your final mix separated into D, M, and E tracks (dialog, music, and effects). 
This will allow foreign distributors to dub over the voices of your actors without losing the 
music, ambience, and effects that you’ve edited into your program.

Categories of audio tracks

Dialog This includes most of the audio that was captured with your 
video. Whether you place each character’s lines on a separate 
dialog track is between you and your audio editor.

Voiceover Narration should be put on a separate track from dialog, as it will 
probably have different EQ settings.

Music Stereo music from any source could use up to four tracks, if 
you’re doing complicated music edits or cross fades.

Ambience Ambient tracks include background tones, atmospheric sound 
effects, and possibly room tone.

Sound effects Effects include material from effect libraries as well as effects clips 
you record yourself. If you’ve edited in Foley, it should occupy its 
own set of audio tracks.
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18 Using Media Tools

Final Cut Pro contains several utilities for managing the clips and sequences in your project, 
as well as the source media used on disk. Two commands and two specialized windows in 
Final Cut Pro help you manage the contents of your projects and media files.

m Analyze Movie:  The Analyze Movie command (in the Tools menu) allows you to examine 
the properties of clips in your project or media files on disk, including the data rate, frame 
rate, frame size, and video and audio compressors used.

m Reconnect Media:  If the links between the clips in your projects and the source clips on 
disk are broken, you can use the Reconnect Media command to reestablish them. This 
command (in the File menu) is applied automatically when you open a project or switch 
to Final Cut Pro from the Finder and Final Cut Pro detects a broken link.

m Media Manager:  The Media Manager (in the Tools menu) allows you to move or copy 
clips and sequences, along with their associated media and render files, into new project 
files and hard disk volumes. All links between the moved or duplicated media files on disk 
and your new project file are preserved. You can also use the Media Manager to remove 
unused media from clips and sequences in the current project. This deletes source media 
from disk. 

m Render Manager:  The Render Manager (in the Tools menu) allows you to remove 
unnecessary render files that are associated with the sequences in your projects, freeing 
disk space. 
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About the Analyze Movie Command
The Analyze Movie command is an extremely useful tool. You can

m troubleshoot your program

You can check the properties of your captured clips, including their frame rate, data rate, 
and whether the source media has any dropped frames.

m find the parameters of QuickTime clips created by others for your program

Once you’ve determined the codec, frame rate, frame size, and audio sample rate, you 
can create a sequence preset to match these parameters to use for editing the clips.

Using the Analyze Movie Command

The Analyze Movie command can be used to analyze both QuickTime clips on disk and clips 
you’ve imported into your project. The result is a movie analysis window that contains the 
clip’s information. (See the next section, “Information Reported by the Analyze Movie 
Command.”) The contents of this window can’t be printed from Final Cut Pro, but you can 
copy and paste them into any text-based application, such as a word processor or SimpleText.

To analyze a QuickTime clip on your hard disk:

1 Choose Analyze Movie from the Tools menu, then choose File from the submenu.

2 Choose a QuickTime file on your disk that you want to analyze, then click Open.

Choose File from this 
submenu to analyze a 
file on disk.

Locate the file you
want to analyze,
then click Open.
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To analyze a clip in your project:

1 Do one of the following:

m Select one or more video or audio clips in the Browser or Timeline.

m Open a clip in the Viewer, then make sure the Viewer is active.

2 Choose Analyze Movie from the Tools menu, then choose Clip from the submenu.

Information Reported by the Analyze Movie Command

The Analyze Movie command provides the following information.

Choose Clip from this 
submenu to analyze a 
clip in a project.

Video track information

Audio track information

Timecode track
information

File information
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For all QuickTime files:

m Filename:  The name of your QuickTime file on disk.

m Duration:  The total duration of the file.

m Average Data Rate:  The average data rate of all tracks in the file.

m Audio Shape:  Whether the audio is Ch 1 + Ch 2, stereo, or mono.

For files with a video track:

m Track Number and Size:  The track number of the video track (some QuickTime clips 
may have more than one video track) and its size.

m Duration:  The duration of the video track.

m Frame Size:  The frame size of the video track.

m Color Depth:  The color depth of the video track.

m Codec:  The compression codec used by the video track.

m Frame Rate:  The frame rate of the video track.

m Average Data Rate:  The average data rate of the video track alone.

For files with an audio track:

m Track Number and Size:  The track number of the audio track (some QuickTime clips 
may have more than one audio track) and its size on disk.

m Duration:  The duration of the audio track.

m Average Data Rate:  The average data rate of the audio track alone.

m Format:  The bit rate of the audio track and whether it’s stereo or mono.

m Sampling Rate:  The sample rate of the audio track in kilohertz (kHz).

For files with a timecode track:

m Track Number:  The track number of the timecode track.(Some QuickTime clips may 
have more than one timecode track.)

m Timecode:  The starting timecode value for this clip.

m Reel:  The reel number for this clip.
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About the Media Manager
You use the Media Manager to duplicate and move clips and sequences in a project, along 
with their associated source media and render files. With the Media Manager, you can

m move or copy all the source media and render files associated with a sequence in your 
project to another folder or disk, in preparation for longterm archiving

m create a duplicate of a sequence and put it into a new project

This duplicate can include only the clips that were used in the original sequence.

m remove all unused media from your project and from your hard disk

You can remove unused parts of clips that have been edited into sequences without 
recapturing them. This is a good way to free disk space in a pinch.

m create an offline duplicate of one or more sequences in your project to recapture only the 
clips necessary to output your program at a higher data rate

You can also use this feature to pare down the sequences in your project to the bare 
essentials, if you want to send them to an editor you’re collaborating with.

Using the Media Manager

The following information explains the general procedures to follow when using the Media 
Manager. For specific examples, see “Examples of Using the Media Manager” on page 864.

To use the Media Manager:

1 Do one of the following:

m To work on one or more clips or sequences in the Browser:  In the Browser, select the 
items you want to work with.

m To work on an individual clip in a sequence:  Open the clip in the Viewer.

m To work on a sequence in the Timeline:  Make sure that sequence’s tab is selected in the 
Canvas or Timeline.

m To work on part of a sequence:  In the Timeline, select the desired items.
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2 Do one of the following:

m Choose Media Manager from the Sequence menu.

m Control-click an item, then choose Media Manager from the shortcut menu.

If an item you selected contains no media (for example, if you selected an empty sequence), 
a message gives you the option to continue or cancel. If you choose to continue, the items 
that don’t contain any media will be ignored.

3 Select the desired options in the Media Manager window.

For detailed information, see “Options in the Media Manager Window” on page 862.

An error message 
appears if your selection 
does not contain media.

This option will create 
a duplicate sequence.

To save the files 
elsewhere, click here.

Specify the
desired options.

Description of
operations to

be performed.
Before and after 
comparison of 
media files affected 
by these operations.
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4 To save the files in another location, click Browse. Choose a location and enter a name for 
the file, then click Save.

5 When you’re ready to continue, click OK.

Final Cut Pro scans your selected clips and sequences and, if necessary, presents any 
warnings or requests for additional information before proceeding. 

A status message displays the progress of the entire Media Manager operation. For 
information on the order of operations, see “How the Media Manager Processes Selected 
Items” on page 863.

If an error occurs during the selected operations, the process stops and an error 
message appears. 

Choose a place
to save the file.

If you want, enter a
name for the file.
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Options in the Media Manager Window

Options in the Media Manager window that aren’t compatible with the currently selected 
settings are dimmed.

m Duplicate selected items and place into a new project:  This option creates a new project 
file with copies of the selected sequences and clips.

m Remove unused media from duplicated items:  This option examines any media files 
attached to the selected items and removes any media outside the In and Out points. 
Offline media files that don’t contain audio or video are not modified.

For example, if a clip in your project is ten seconds long, but only the first five seconds are 
used in all the sequences in which it appears, the last five seconds will be deleted.

m Use Handles:  This feature is only available if you’ve checked the “Remove unused media” 
option. Check this box to leave extra frames beyond the In and Out points of files that will 
have media removed. To set the duration of these handles, enter a timecode duration.

It’s a good idea to use handles so that you have flexibility later on if you want to add 
transitions to your sequence or extend the durations of existing transitions.

m Pop-up menu:  Choose how source media on disk that’s linked to the selected clips and 
sequences will be processed.

m Copy:  Copies the source media files associated with the clips in your sequence to the 
specified location. The original source media files are not touched. Make sure you 
have enough disk space available to use the Copy option.

m Move:  Removes the source media files from their current locations on disk and moves 
them to the specified location. Other projects that are not currently open may lose 
their links to source media if they contain clips that are moved.

Options for using the
Media Manager

Status area
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m Use existing:  New source media files are created and the old ones are deleted. Any 
clips in your project that weren’t selected will go offline as a result of this operation. 
This action is not undoable.

m Create offline:  New clips and sequences are made offline with no links to existing 
media files. This option creates an offline version of selected items in your project you 
can use to recapture your clips.

m Include render files:  Check this to include render files in any move or copy operation.

m Destination Folder:  The selected destination folder (in the Scratch Disks tab in the 
Preferences window) for move or copy operations on linked media or render files. To 
choose a new destination, click Browse, then navigate to the desired location.

m Status area:  As you choose options, this area displays a description. It also lists how 
much disk space is currently in use and how much is needed.

How the Media Manager Processes Selected Items

Operations in the Media Manager are done in the following order:

1 If you’re duplicating the selected items, you’re prompted for a name and location for the 
new project file.

2 If you’re removing unused media from existing media files, items outside the current 
selection are scanned to see if they use the same media files. 

If any are found, a message asks if you want to add these additional items to the current 
selection, make them offline, or cancel the operation altogether.

3 The destination disk is checked to see if there is enough available disk space, based on the 
options you’ve selected. 

If there isn’t enough disk space, a message asks you to specify a new destination or cancel 
the operation.

4 If items outside your selection are found and you choose to make them offline, they are 
taken offline.

5 Media files are copied or moved to the selected destination. If the “Remove unused media” 
option is selected, unused media is removed.

6 If you included render files, they’re copied or moved to the selected destination.

7 If you chose to create a new project, one is created and any selected clips or sequences are 
copied into it.

8 Items in your original or newly created project are relinked with any copied or moved 
media files.
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Examples of Using the Media Manager

The following examples show you three ways you can use the Media Manager. 

m The first example shows how you can remove unwanted media from your projects to free 
disk space. 

m The second example shows how you can move both sequences and their associated 
media files to a new volume.

m The third shows you how to create a project file with offline sequences that have had 
unused sections of the clips removed, in preparation for recapturing just the media you 
need for your program at a higher data rate.

Removing Unused Media From Your Project Without Recapturing

A common operation is to remove unused media from a project. For example, you’ve 
captured an hour’s worth of media from tape, but you only use 45 minutes of it in your 
project. There are 15 minutes of video taking up storage space on your disk. With the Media 
Manager, you can easily delete those 15 minutes of unused media without recapturing your 
source media.

To remove unnecessary media from a sequence:

1 In the Browser, select the desired sequence.

2 Do one of the following:

m Choose Media Manager from the Sequence menu.

m Control-click the selected sequence in the Browser, then choose Media Manager from the 
shortcut menu.

Select the desired
sequence.
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3 Select the following options in the Media Manager window:

a Make sure the “Duplicate selected items” option is not checked.

b Click the “Remove unused media” checkbox to select it.

c If you want to maintain handles beyond the In and Out points of your media, check the 
“Use Handles” option to select it, then enter a timecode duration. 

d Choose “Use existing” from the pop-up menu.

4 Click OK.

Your source media files are shortened to include only the media actually used in your 
sequence (plus handles, if you’ve selected that option). The corresponding clips in your new 
sequence are shortened by the same amount.

Choose “Use existing”
from the pop-up menu.

Make sure this
is not selected.

Click here to include
only media used
in the sequence.

If you check the 
Use Handles 
checkbox, enter 
a duration here.
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Moving and Copying Sequences and Media to a New Disk

Another common operation is moving a sequence to another volume. You do this in 
preparation for backing up your files, to give your project along with all its media to another 
editor, or to store the project on another disk.

To move or copy a sequence and its media to another location:

1 In the Browser, select one or more sequences to move or copy.

2 Do one of the following:

m Choose Media Manager from the Sequence menu.

m Control-click the sequence, then choose Media Manager from the shortcut menu.

3 Select the following options in the Media Manager window:

a Click the “Duplicate selected items” checkbox to select it.

b If you only want to include the media used in the selected sequences, click the “Remove 
unused media” checkbox to select it.

c Choose Move or Copy from the pop-up menu. To make a backup, choose Copy; to store 
the files in another location, choose Move.

d Click the “Include render files” checkbox to include any render files associated with 
your project.

Select the desired
sequence.
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e Click Browse, then navigate to the disk and folder where you want to move or copy the 
duplicated media files.

4 Click OK.

5 Enter a name and location for the new project file, then click Save.

Final Cut Pro scans the selection to make sure enough disk space exists in the target location. 

lick here to add render
files to the moved or

copied sequence.

Choose Move or 
Copy from the 
pop-up menu.

Click here to 
specify a location 
where the files will 
be moved or 
copied.

Make sure this
is selected.

Click here to include
only media used
in the sequence.

Choose a place
to save the file.

If you want, enter a
name for the file.
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When you perform a move operation, a dialog box appears if sequences are outside the 
selected range, or use source media files that will be shortened or deleted as a result of the 
“Remove unused media” option.

m Add:  Adds all clips that are used elsewhere in your project to the list of clips that will be 
processed by the “Remove unused media” option.

For example, if a clip in the Browser has its In and Out points at the very beginning and 
the very end, no part of this clip’s associated source media file will be trimmed if you 
click Add.

m Continue:  Continues with the operation, trimming the source media files that 
you’ve selected.

Unselected items in your project will be made offline if you use the “Use existing” or Move 
options, since these reference the original source media files. If you use the Copy option, 
all clips in your project will remain online, since no files are actually removed.

m Abort:  Cancels the operation completely. Nothing is changed.

A message may
appear with additional

items found and the
amount of space

required to include
them.

Click an option.
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Creating a Duplicate of Your Sequences to Use for Recapture

Another instance where you can use the Media Manager is to copy a sequence for 
recapturing clips. For example, let’s say you used a third-party capture card to capture a large 
amount of material at a low data rate, then finished your edit. You can use the Media Manager 
to recapture only the clips and portions of clips that you used in your sequence at a higher 
data rate for final output.

To duplicate a sequence in a new project file for recapture:

1 In the Browser, select one or more sequences.

2 Do one of the following:

m Choose Media Manager from the Sequence menu.

m Control-click the sequence, then choose Media Manager from the shortcut menu.

3 Select the following options in the Media Manager window:

a Click the “Duplicate selected items” checkbox to select it. 

It’s always a good idea to make changes to duplicates and preserve the original as a backup.

b Click the ”Remove unused media” checkbox to select it.

c Click the “Use Handles” checkbox to select it, then enter a timecode value for handles of 
at least one second (00:00:01:00) to provide extra space for additional adjustments to 
your edit.

Select the desired
sequence.
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d Choose “Create offline” from the pop-up menu.

4 Click OK to create your new project file with duplicate sequences.

5 Enter a name and location for the new project file, then click Save.

About Media Manager Errors

If errors occur during a Media Manager operation, the process stops and an error 
message appears.

Choose “Create
offline” from this

pop-up menu.

Click here to include
only media used
in the sequence.

Click the Use 
Handles checkbox, 
then enter a 
duration here.

Make sure this
is selected.

Choose a place
to save the file.

If you want, enter a
name for the file.

Important  If you’ve selected the “Use existing” option from the pop-up menu, be 
absolutely sure that you want to perform this operation before you click OK. Once this 
operation begins, source media files are deleted immediately; canceling this operation won’t 
restore them.
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About the Reconnect Media Command
If the links between clips in your project and the corresponding source media on disk 
are broken, you can use the Reconnect Media command to restore them without recapturing 
your material.

Why Links Between Clips and Source Media Can Be Broken

There are several reasons the links between the clips in your project and your source media 
on disk could become broken, causing the corresponding clips in your project to go offline.

m You renamed the folder your source media files were in.

m You moved your source media files to another disk.

m You renamed your source media files.

m You deleted your source media on disk. In this case, you have no option but to recapture 
these clips.

Offline clips have a red slash on top of their icon in the Browser:

These are offline clips.
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When a clip in your project goes offline, any render files associated with that clip are 
automatically discarded and the Offline Files window appears (see “When Final Cut Pro 
Reconnects Your Clips” on page 875). All instances of that clip in your project remain intact. 
When you play back offline clips, a Media Offline graphic appears until these clips are either 
reconnected or recaptured.

Using the Reconnect Media Command

Clips in your project don’t have to be offline for you to use the Reconnect Media command. 
You can reconnect files to clips in your project at any time. Reconnecting the links between 
missing or offline files is the most obvious reason for doing this, but there are other reasons 
to use the Reconnect Media command:

m To relink clips in your project to higher-resolution versions of the same clips.

m To replace multiple instances of a clip in a sequence with another clip.

This appears when
you play an offline clip.

Important  If you relink a clip in your sequence with an entirely new source file that has 
completely different media, the new source file must be at least as long as the current 
marked duration of the clip you’re relinking it to. Otherwise you’ll get an error.
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To use the Reconnect Media command:

1 Select the files you want to reconnect. 

If you have a lot of offline clips and you want to make sure you reconnect them all, press 
Command-A to select all clips in the Browser and make sure you choose the “Offline” option 
in step 3.

2 Do one of the following:

m Choose Reconnect Media from the File menu.

m Control-click a clip or sequence, then choose Reconnect Media from the shortcut menu.

3 Choose the type of files you want to reconnect, then click OK.

You can reconnect offline clips and online clips. If you’ve selected a sequence, you can also 
reconnect your render clips.

Select the files you
want to reconnect.

Choose the type of files
you want to reconnect.
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Final Cut Pro looks for the source media clips corresponding to each offline clip. 

Several options can help you find your clip.

m Show Preview:  Click this to view thumbnails of files.

m Create:  If the Show Preview option is selected, click this button to create a thumbnail of 
the selected item. 

m Show pop-up menu:  If this option is set to All Files, you see every file in the selected 
folder on your hard disk, whether or not it can be imported into Final Cut Pro. To limit 
the kind of files displayed in this list, choose a file type from the pop-up menu.

m Show Only Files that Match Name:  Click this option to make it easier to locate the file 
by matching filenames exactly. This is helpful if you’re looking through a long list of 
similar names.

m Reconnect All Files in Relative Path:  Click this option to automatically reconnect any 
other clips with broken links that are in the same folder as one that’s been found.

m Skip or Skip All:  Click these to skip clips that can’t be found or to abort the search.

m Find Again:  Click this to try to find the media again within the folder selected. This is 
useful if you choose a folder yourself.

4 When the correct source media file is found, click Select to reestablish the link. 

Locate the file,
then click Select.

Click a button to skip 
a file and begin linking 
the next file.Specify options to

help you locate files.

Click here to try the 
search again.

A preview thumbnail of
the clip may help you

find it more easily.
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When Final Cut Pro Reconnects Your Clips

In two instances, a message asks if you want to reconnect your files:
m When you open a project file.

If Final Cut Pro detects missing source media files that weren’t missing the last time you 
saved this project, the Offline Files window appears.

m When you switch from the Finder to Final Cut Pro.

If you switch from your project in Final Cut Pro to the Finder and move or delete source 
media files that will result in those clips going offline in your project, the Offline Files 
window appears when you switch back to Final Cut Pro.

About the Offline Files Window

The Offline Files window appears each time you open a project with missing files.

Missing movie files
The last known 
location of files.

You can click a button
to choose which
files to disregard.

Missing render files
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Information and controls in the Offline Files window

m The window lists all the source media files that are missing and the location and hard disk 
where they were located.

m Missing or invalid QuickTime reference movies:  Files whose referenced files were 
deleted from disk appear here. Spanned, or segmented, files that were captured in 2 
GB increments are actually QuickTime reference movies. If you’ve moved a reference 
file used by a spanned or segmented QuickTime file, you can relink it here. If you 
deleted the file, you have to recapture the entire clip.

m Lost render files:  This list appears for render files that were lost as a result of your clip 
going offline.

m Forget Files:  Use these buttons to disregard a set of media files in the list above. 

m Movie:  Click this to remove all of the movie files (source media from disk) from this 
list. These files will become offline clips in your project as a result. You can relink the 
files later.

m Render:  Click this to remove all of the render files from this list. 

m Reconnect:  Click this to have Final Cut Pro attempt to automatically reconnect all the 
items in this list.

m OK:  Click this to leave all files specified in this list as they are (missing or invalid).
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An Example of Reconnecting Source Media

The following is an example of how you can reconnect source media files that were moved 
on your disk.

When source media used by your project is missing:

1 Open a project file or switch back to Final Cut Pro from the Finder.

If media files are missing, the Offline Files window appears.

2 If desired, click Movie to remove the movie files from this list.

3 Do one of the following:

m Click OK to end the process and leave these clips missing (similar to offline) clips for 
relinking later. 

m Click Reconnect to begin reconnecting all of the clips in this list, then follow the 
remaining steps.

Missing movie files

Since no render files are
missing, only the Movie

button is available.
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4 Choose the type of files you want to reconnect.

5 Click OK to proceed.

Final Cut Pro looks for the source media clips corresponding to each offline clip in your list. 
There are several options to help you find your clip. For detailed information, see “Using the 
Reconnect Media Command” on page 872. 

6 When the correct clip is found, click Select to reestablish the link.

Making Your Clips Offline

You can deliberately make clips in your project offline. This breaks the link between a clip in 
your project and its source media file on disk. It also removes all references made to that 
source media file wherever the clip is used (in sequences, duplicates in the Browser, and 
subclips). This is useful if you want to delete all of your source material in preparation for 
recapturing at a higher data rate without closing and reopening your project.

To make files offline:

1 In the Browser or Timeline, select the clips or sequences you want to make offline.

Since you’re looking for
lost files, the only option

available is Offline.
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2 Do one of the following:

m Choose Make Offline from the Modify menu.

m Control-click a selected item and choose Make Offline from the shortcut menu.

3 Choose an option in the Make Offline dialog box, then click OK.

m Leave Them on the Disk:  Click this to break the link and leave the original media files on 
your disk.

m Move Them to the Trash:  Click this to break the link and move the source media files to 
the Trash. You must empty the Trash yourself, which gives you time for second thoughts 
(emptying the Trash is not undoable). If you decide to keep the files, you must drag them 
out of the Trash and use the Reconnect Media command.

m Delete Them from the Disk:  Click this to break the link and immediately delete the media 
files from the disk. This action is not undoable. If you need the media again, you have to 
recapture it.

4 If you choose to move or delete the files, a warning message tells you this action cannot be 
undone. To continue, click OK.

Click an option.

Differences Between Missing and Offline Clips

Clips that are missing and clips that are offline are identical in appearance in the 
Browser, Viewer, Timeline, and Canvas. These are the differences between them:

m Source files that are saved as missing files when you click OK in the Offline Files 
window are searched for again the next time you open that project.

m Source files that are removed from the Offline Files list are saved as offline files when 
you click OK. Final Cut Pro doesn’t look for them the next time you open that project.
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Deleting Render Files With the Render Manager
The Render Manager allows you to manage the render files associated with the sequences in 
your projects. Render files are created whenever you render transitions, effects, or multilayer 
composites in a sequence. They are stored in the scratch disk location specified in the 
Scratch Disks tab of the Preferences window (see “Setting Up Scratch Disks for Storing 
Media” on page 899 for more information).

You might choose to remove render files for your project

m to free disk space for sequences that you no longer need

m as a troubleshooting measure

To delete render files:

1 Choose Render Manager from the Tools menu.
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The Render Manager window appears. All projects that reference render files on the current 
render scratch disk are displayed. This includes all items in a sequence or project.

m Disclosure triangle:  Click this to show items within a project or sequence.

m Projects:  Click the triangle next to a project to display all sequences in the project that 
contain render files on the current render scratch disk.

m Sequences:  Click the triangle next to a sequence to display the render files for each 
render quality level.

m Type:  The type of item–bin or render file.

m Size:  The amount of disk space used by a single render file.

m Last Modified:  The date the render files were last updated.

2 Click in the Remove column to delete specific render files.

m Clicking an item that includes other items, such as a project, automatically includes all 
those items within it.

m Clicking a sequence selects all of the render quality files for the sequence. 

A checkmark appears next to each item you want to delete. The total amount of disk space 
that will be freed is displayed at the bottom of the window. 

3 When you’re ready to delete render files, click OK.

Finding Media Files
The Find command allows you to search for media, including used and unused media, in one 
or more sequences. For detailed information, see “Performing Searches in the Browser” on 
page 202.

Click the triangle next
to a project to show all

of its render files. Each entry shows the 
amount of disk space used 
on the render scratch disk.

The number of render
files to be deleted and
the disk space that will

be available.
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19 Viewing and Setting Preferences

The Preferences window is a repository for the various settings that affect how you use Final 
Cut Pro. The five tabs in this window store settings such as how many levels of undo are 
available, whether automatic save is enabled, the current editing mode, display options for 
new sequences, and which disks are set as the scratch disks.

Some of these settings are determined by the initial setup you selected when you first 
installed Final Cut Pro, while others start off with a standard default setting, which you can 
change at any time. The settings in the Preferences window are shared among all of the 
projects you create in Final Cut Pro.
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The preference settings are divided between five tabs:

m General:  Settings in this tab cover a broad spectrum of purposes. In general, all of them 
affect how you interact with Final Cut Pro’s interface, with settings such as levels of undo, 
number of audio mixing tracks, prompt for settings on new sequence, and so on. A 
description of the General preferences is in the next section, on page 885.

m User Mode:  This tab has two buttons that allow you to choose which user mode Final Cut 
Pro is in. The selected user mode affects which of Final Cut Pro’s features are available for 
your use—the full-featured Standard mode, or a streamlined, simplified set of features, 
called the Cutting Station mode. For more information, see “Setting the User Mode” on 
page 892.

m Timeline Options:  The settings in the Timeline Options tab determine the number of 
tracks and the Timeline options for new sequences that you create. These settings are 
explained in “Setting Options for the Timeline” on page 894.

m Labels:  In this tab, you can change the names associated with the different colored labels 
that are available within Final Cut Pro for identifying and sorting the clips and sequences 
within your project. For more information, see “Setting Label Names to Help Manage Your 
Media” on page 897.

m Scratch Disks:  This is one of the most important categories of preferences in Final Cut 
Pro and determines which of your connected hard disks is used to store captured clips, 
render files, and waveform and thumbnail files. If your scratch disks are set to a disk that 
doesn’t have the performance or the capacity for the kind of video you’re working with, 
you may experience problems. See “Setting Up Scratch Disks for Storing Media” on 
page 899 for more information.

To view or set preferences:

1 Choose Preferences from the Edit menu or press Option-Q.

2 Click a tab and specify its settings.

3 When you’re finished, click OK or press Return.
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Setting General Preferences
General preferences cover a wide range of items throughout Final Cut Pro, from levels of 
undo and automatic saving to reporting drops during playback and duration of still images.

To view and change general preferences:

1 Choose Preferences from the Edit menu. 

2 Set your desired preferences, then click OK or press Return.

About General Preferences

The General tab is
open by default.
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m Levels of Undo

Enter a value to specify the number of actions that can be undone. The maximum number 
of undos you can specify is 99. The default is 10, but many users use 20 levels of undo, so 
valuable memory is not used for undos. For information on undoing an action, see 
“Undoing and Redoing Changes” on page 97.

The total number of undos Final Cut Pro can perform depends on the amount of memory 
that you’ve assigned to Final Cut Pro. The more memory you’ve assigned, the more undos 
Final Cut Pro will be able to keep track of. For information on assigning memory to Final 
Cut Pro, see “Allocating Memory for Final Cut Pro” on page 49.

When an action is undone, the window where the action was performed becomes active, 
to indicate what occurred. For example, let’s say you deleted a clip in the Timeline, then 
deleted a clip in the Browser. Selecting Undo once restores the clip in the Browser, 
leaving the Browser active. Undoing a second time restores the clip in the Timeline and 
makes the Timeline active, instead of the Browser.

Note:  If you want to test numerous changes to your sequence without committing to 
them, try working with duplicates of your edited sequence, so your original is left alone 
as a safety copy. (That way you also won’t have to wear out your fingers pressing 
Command-Z to undo too many times.) For more information on using the Undo 
command to test different edits, see “Using Undo as a Tool” on page 534.

m List Recent Clips

Enter a value to set the number of recently accessed clips displayed in the Recent Clips 
pop-up menu in the Viewer. This pop-up menu shows a list of all media clips that you 
opened from the Browser, in the order they were opened (the most recently opened clip 
at the top of the list). Final Cut Pro defaults to 10 items, but you can set this list to be as 
high as 20. For more information on using the Viewer’s Recent Clips pop-up menu, see 
“Recent Clips and Generator Pop-up Menus” on page 339.
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m Automatic Save

This option directs Final Cut Pro to save your opened project to a backup file after the 
specified number of minutes. Your original project file is not touched until you use the 
Save command yourself. When you save your project file, the autosave backup file is 
deleted until the next autosave happens and a new backup file is created.

The autosave file is stored in the same folder as your project file and has a filename in the 
form Project name–auto. For example, an autosave version of Tutorial Project 1 would be 
Tutorial Project 1–auto.

The autosave feature doesn’t modify your original project file until you use the Save 
command yourself. When you do, your original project file is saved and the autosave file is 
discarded; your project file is the only version until an autosave version is created again. 
For information about opening autosave files, see “Opening Autosave Files” on page 176.

Note:  If you’re working on exceptionally long projects that are time-consuming to save, 
you may want to disable the autosave feature to prevent interruptions to your workflow.

m Multi-Frame Trim Size

Enter a desired number of frames; the maximum is 9. This number appears in the multi-
frame trim buttons in the Trim Edit window. This value determines how many frames are 
affected when using the Trim Back and Trim Forward buttons in the Trim Edit window (as 
well as the keyboard shortcuts for those buttons). For more information on using the 
Trim Edit window, see Chapter 16, “Advanced Editing and Trimming Techniques,” on 
page 653.

m Real-time Audio Mixing

Enter a number in this box to specify the number of audio tracks that can be mixed in real 
time. The default is 8 tracks, although you can set this number as high as 64. The 
maximum number of tracks that can be mixed without having to be rendered is affected 
by your computer’s processor speed, the number and types of filters used in your 
sequence, the data transfer rate of your hard disk, and the memory assigned to Final Cut 
Pro.

m Sync Adjust Movies Over

Many DV camcorders and decks record audio at sample rates other than the true sample 
rates of 32 or 48 kHz. Variations in equipment from different manufacturers result in 
slight, but significant variances from these standard sample rates.
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QuickTime expects the sample rate of incoming audio to be exactly 32 or 48 kHz. The 
discrepancy between the sample rate used by your DV video equipment and the expected 
sample rate in QuickTime may cause a drift in audio and video sync in your captured clips 
over many minutes of playback. How noticeable this drift is depends on the DV 
camcorder or deck you’re using.

To avoid this problem in Final Cut Pro and ensure you have accurate sync in all captured 
DV clips, make sure you enable this feature. When enabled, this option forces Final Cut 
Pro to count the samples of the audio tracks of all DV clips after they’ve been captured to 
determine the sample rate they were originally recorded at. With the original sample rate 
determined, Final Cut Pro can then ensure accurate sync no matter how long your 
captured clip. 

Since drifts in sync typically occur in clips with a long duration, you can specify the 
number of minutes in a clip when this feature should be used. The default value of five 
minutes is adequate in most cases. For information on your particular DV video 
equipment, see the Final Cut Pro Web site at www.apple.com/finalcutpro

When this feature is used by Final Cut Pro, the new sample rate information for your clip 
is stored in your Final Cut Pro project file, not in the source QuickTime file for this clip on 
disk. It does not alter the source file in any way. When looking at your clips in the 
Browser, you can tell if this feature has been used if the Aud Rate column displays an 
uneven value for your clip. For example, instead of displaying a sample rate of 48.0 kHz 
for your clip, a sample rate of 48.0258 is displayed.

As long as the Sync Adjust Movies Over checkbox is enabled, Final Cut Pro checks the 
sample rates of clips that you import, as well as those that you capture. If you accidently 
capture a series of long clips without having this feature enabled and you see a drift in 
their A/V sync as a result, you can correct it without having to recapture your clips. For 
more information, see “Adjusting A/V Sync of Clips” on page 891.

When Not to Enable the Sync Adjust Movies Setting

There are two types of items you shouldn’t use the Sync Adjust Movies setting with: 
non-DV clips and clips with timecode breaks.

m Non-DV clips:  Clips that you capture from non-DV sources, such as analog tape or 
from digital sources via SDI, don’t have varying sample rates. However, because lost 
A/V sync due to timecode breaks is still a risk, you should disable the Sync Adjust 
feature if you’re not capturing from a DV source.

m Clips with timecode breaks:  Any timecode break, or gap, in the signal recorded to 
tape results in an invalid sample count if the Sync Adjust feature is enabled. As a 
result, the A/V sync of this type of clip is lost. The only way to restore sync is to 
record the clips that come before and after a timecode break separately.
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m Show ToolTips

Check this box to automatically display short descriptions of interface elements and their 
corresponding keyboard shortcuts, called tooltips.

Tooltips appear in small yellow boxes when you move the pointer over a control and 
pause briefly (without clicking the control). When you move the pointer away from the 
control, the tooltip disappears.

m Warn if visibility change deletes render file

Making an entire track invisible automatically deletes any render files associated with that 
track. Make sure you enable this option to see a warning before this happens.

Note:  As an alternative to hiding a track and losing its render files, you can make 
individual items invisible, which preserves these render files. To find out how not to lose 
your render files when making a track in your sequence invisible, see “Making Tracks 
Invisible” on page 480.

m Report dropped frames during playback

If you enable this option, a message appears if any frames are dropped during playback 
from the Viewer, Canvas, and Timeline, or when outputting using Edit to Tape or Print to 
Video. Playback drops are almost always a hardware setup problem. When properly 
configured, Final Cut Pro should not drop frames. For information on what you can do if 
Final Cut Pro reports dropped frames, see Appendix A, “Solutions to Common Problems 
and Customer Support,” on page 1287.

This shows the tooltip (interface 
element and keyboard shortcut) that 
appears when you place the pointer 
over the Play button in the Viewer.
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m Abort capture on dropped frames

With this option enabled, a message appears when frames are dropped during capture 
and the capture process is stopped.

m Prompt for settings on New Sequence

Check this box to have a dialog box appear, asking you to choose a sequence preset 
whenever you create a new sequence. If you work on different projects using different 
codecs and resolutions, this is very useful to enable. If you always work with the same 
kinds of clips at the same resolution, you’ll probably want to disable this option.

m Pen tools can edit locked item overlays

If you enable this option, you’ll be able to modify keyframes and overlays in locked tracks 
or clips in the Timeline.

m Still/Freeze Duration

Enter a value in this field to determine the default duration for imported images. Still 
images are, by default, imported with 10 seconds of frames between the In and Out 
points. This number can be set to any value you want.

One reason you may want to change this value is if you’re going to import an image 
sequence. If you set the Still/Freeze Duration to one second, you can import an entire 
folder of numbered images in preparation for laying them all out in a sequence for use in 
your project.

This value also affects the duration of the freeze frame in the Viewer. When you open a 
clip in the Viewer, you can choose Make Freeze Frame from the Modify menu. The 
duration of the freeze frame is set to the Still/Freeze Duration specified here.

m Preview Pre-roll

The pre-roll preference is used by the Play Around Current control to determine how 
much material before the playhead should be played. The pre-roll value is also used by 
controls in the Trim Edit window. For more information, see Chapter 16, “Advanced 
Editing and Trimming Techniques,” on page 653.
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m Preview Post-roll

The post-roll preference is used by the Play Around Current control to determine how 
much material after the playhead should be played. The post-roll value is also used by 
controls in the Trim Edit window. For more information, see Chapter 16, “Advanced 
Editing and Trimming Techniques,” on page 653.

m Thumbnail Cache (Disk) and Thumbnail Cache (RAM)

Enter a desired cache size in these boxes to specify the sizes of the thumbnail caches. You 
may want to have large thumbnail caches if you’re working with a large number of clips 
and want to display thumbnails or if you are using the Browser’s large icon view. 

If you often scrub thumbnails in the Browser’s large icon view, you can optimize their 
playback quality by increasing the thumbnail RAM cache. To set a location for the 
thumbnail cache, see “Setting Up Scratch Disks for Storing Media” on page 899.

Adjusting A/V Sync of Clips

If you capture long clips in Final Cut Pro and the Sync Adjust Movies Over _ Minutes setting 
is not enabled, you can still correct the audio/video sync of clips.

To correct the A/V sync of clips captured with the Sync Adjust Movies setting 
disabled:

1 Open the project that contains the clips.

2 In the Browser, delete these clips from your project.

3 In the Timeline, delete these clips from any sequences they are edited in.

4 Enable the Sync Adjust Movies Over setting in the Preferences window. 

For more information, see “Setting General Preferences” on page 885.

5 Reimport your clips.

After reimporting, if your clips are longer than the length specified by the Sync Adjust Movies 
option, their samples are counted, and their sync is corrected.

Check the documentation that came with your equipment to see if you should enable this 
option. You can also go to the compatibility page on the Final Cut Pro Web site at 
www.apple.com/finalcutpro
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Setting the User Mode
Final Cut Pro has two user modes: Standard (the default) and Cutting Station (an abbreviated 
feature set). Which user mode you choose determines the feature set available to you for 
editing your project. 

m Standard:  This provides access to all of the editing and compositing features in Final Cut 
Pro. This is the mode that users of previous versions of Final Cut Pro are familiar with.

m Cutting Station:  This is an abbreviated feature set for doing the bare essentials of editing, 
rough edits and fine-tuning (not using keyframes or complex effects).

Here are the limitations of the Cutting Station user mode:

m Number and type of tracks:  Limited to two video and four audio tracks per sequence.

m Audio and video filters:  Limit of seven filters per sequence.

m Transition effects:  Limited to the Oval Iris, Edge Wipe, Page Peel, and Rectangle Iris.

m Keyframing of motion effects:  Not allowed, although you can make global changes to 
a clip.

m Speed settings:  None are available.

Although you select a user mode the first time you start Final Cut Pro, you can always change 
it later. Changing the user mode will not affect your edited project.

Why Use Final Cut Pro in Cutting Station Mode?

Three kinds of users will benefit from using the Cutting Station user mode:

m Experienced editors working on feature-length programs, news shows, and other 
programs where compositing and elaborate effects won’t come into play can use 
this mode to hide parts of Final Cut Pro’s interface they won’t be using.

m Editors working on projects that will be exported as EDLs can use the Cutting 
Station mode to eliminate some of Final Cut Pro’s features that don’t translate 
anyway, simplifying the process. (For more information on exporting EDLs from 
Final Cut Pro, see “Exporting an EDL” on page 1202.)

m Novice editors take advantage of the Cutting Station mode to simplify Final Cut 
Pro’s interface. This way they can focus on the essentials before jumping into more 
advanced features.
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Changing the User Mode

You can change the user mode any time. However, you’ll need to quit Final Cut Pro and open 
the application again for the new user mode to take effect.

To set the user mode:

1 Choose Preferences from the Edit menu, then click the User Mode tab.

2 Click the button next to Standard or Cutting Station, then click OK or press Return.

m Standard:  Choose this if you want to access all of Final Cut Pro’s features. This is the 
default mode.

m Cutting Station:  This restricts you to an abbreviated feature set streamlined for simple 
editing. This can be advantageous to new users just getting started with Final Cut Pro, or 
to editors who are working on cuts-only style projects not involving complex effects, such 
as those to be exported as EDLs. 

3 Quit Final Cut Pro, then open the application again.

Choose a user mode
to determine the

available features
in Final Cut Pro.
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Setting Options for the Timeline
The options you set in this tab only affect new sequences that you create. Most of these 
settings are also found in the Timeline Options tab of the Sequence Settings window of 
sequences that you create, where you can modify them at a later time, if necessary. (The 
exception is the default number of tracks, which is only found in Preferences.)

To set Timeline options for newly created sequences:

1 Choose Preferences from the Edit menu, then click the Timeline Options tab.

2 Set your desired preferences, then click OK or press Return.

About Timeline Options Preferences
m Starting Timecode

Enter a value to be the starting timecode for new sequences. This defaults to hour one 
(01:00:00:00).

m Drop Frame

Check this box if you want drop frame timecode displayed in the sequence Timeline. This 
is only applicable to NTSC format, and is the default for NTSC configurations.

m Track Size

Choose one of four track sizes—Reduced, Small, Medium, and Large—from the pop-up 
menu to specify a default track size for new sequences.

Note:  If track size is set to Reduced, thumbnails and waveforms will be completely 
disabled.
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m Thumbnail Display

Choose a setting from the pop-up menu to specify how clips will be displayed in the 
Timeline of new sequences.

m Name:  Displays the name of the clip and no thumbnail images. 

m Name Plus Thumbnail:  Displays the first frame of every clip as a thumbnail image and 
then the name of the clip. 

m Filmstrip:  Displays as many thumbnail images as possible for the current zoom level 
of the Timeline. 

m Audio Track Labels

Choose a setting from the pop-up menu to specify how the audio tracks of new 
sequences will be labeled.

m Sequential:  Sequential labels number each audio track consecutively: A1, A2, A3, and 
so on. Each audio track is identified individually by its number, which is useful if you 
want to have a one-to-one correspondence between your video and audio tracks.

m Paired:  Paired labels identify audio tracks in pairs: A1a, A1b, A2a, A2b, A3a, A3b, and 
so on. This is useful if you have a lot of stereo material, and you want an easy way to 
see the relationship between each stereo pair of tracks.

Paired audio 
track labels

Sequential audio 
track labels
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m Show Filter and Motion Bars

Check this box to determine whether filter and motion bars are displayed in newly 
created sequences. With this setting enabled, additional space is added below each audio 
and video track in the Timeline. If you add filters or motion settings to a clip, various 
colored bars appear in the Timeline for the duration of that clip.

m Green bar:  Indicates a filter has been added to an audio or video clip. 

m Blue bar:  Denotes motion settings have been modified for a video clip.

Note:  Filter and motion bars can be displayed or hidden using the Clip Overlays control 
at the bottom of the Timeline.

Keyframes that are added to the filter or motion settings for a clip appear on top of the 
bar to which they apply. These keyframes also serve as controls and can be edited or 
moved directly with the pointer. 

For more information, see Chapter 21, “Compositing, Applying Motion Effects, and Using 
Keyframes,” on page 907 and Chapter 22, “Working With Video Filters, Generators, and 
Speed Settings,” on page 1023.

m Show Keyframe Overlays

Check this box to display keyframe overlays in new sequences. When this setting is 
enabled, various colored lines appear over tracks in your sequences in the Timeline.

m Black line:  Displays opacity overlays (which indicate transparency) for your video tracks.

m Red line:  Displays audio level overlays (which indicate volume) for any clips in the 
audio tracks.

Note:  Clip overlays can be displayed or hidden by using the Clip Keyframes control at the 
bottom of the Timeline.

A green bar in this
upper area indicates

a filter was added
to a clip.

A blue bar in this lower area 
indicates motion settings 
were added to a clip.
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Keyframes added to these properties appear as handles directly on top of the overlay. 
Overlays and their related keyframe handles also serve as controls themselves and can be 
manipulated directly with the pointer. For more information on adjusting video opacity 
using overlays, see “Creating Transparency Effects in the Timeline” on page 912. For more 
information on adjusting audio levels using overlays, see Chapter 17, “Working With 
Audio,” on page 727.

m Show Audio Waveforms

Check this box to display audio clips for new sequences in the Timeline as waveforms, 
rather than plain bars. Audio waveform display is useful if you want a visual representation 
of the loud and soft parts of your audio to use as reference while you’re editing. The 
keyboard shortcut for displaying audio waveforms is Command-Option-W.

Note:  If the track size is set to Reduced (see “About Timeline Options Preferences” on 
page 894), audio waveforms aren’t displayed. 

m Default Number of Tracks

You can specify the default number of audio and video tracks for all newly created 
sequences. Enter a value for video and audio, up to a total of 99 tracks.

Setting Label Names to Help Manage Your Media
In Final Cut Pro, you can use labels to

m help organize your clips

m help identify items (except for bins) in the Browser

m mark a group of clips that you located with the Find command

m do any other task requiring you to divide your clips into identifiable groups

About Label Names and Colors

There are five labels, each with a specific color and name. You can change the names , but 
not the colors. The default label names and associated colors are:

m Good Take:  Orange

m Best Take:  Red

m Alternate Shots:  Blue

m Interviews:  Purple

m B-Roll:  Green

If no label is specified for a clip, the label is set to None and there is no color associated with 
this item. When you choose a label for a clip in the Browser, that clip’s icon takes on the 
color of that label and that label’s name appears in the Label column for the clip. 
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Changing Names of Labels

To change the label names:

1 Choose Preferences from the Edit menu, then click the Labels tab.

2 Click a text field to highlight it, then enter a new name for the label. 

3 When you’re finished, click OK or press Return. 

Sorting Clips by Labels

After you set labels for clips, you can sort your clips in the Browser by their labels or use the 
Find command to find clips based on the label you’ve applied. 

To sort clips by label:

m Click the Label column heading. 

All clips are sorted by label and alphabetically within each label name. Unlabeled clips, 
marked as None, are sorted at the end of the list.

For more information on sorting, see “Sorting Items in the Browser” on page 183.

If desired,
enter different or

more appropriate
label names for

your project.
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Setting Up Scratch Disks for Storing Media
The Scratch Disks tab in the Preferences window allows you to choose where you want to 
save your video, audio, render, and cache files. It also lets you specify other settings related 
to size of captured and exported files and minimum space allowed on scratch disks.

The scratch disk is where Final Cut Pro stores captured or rendered files. By default, Final 
Cut Pro uses the disk on which the application is installed. 

To specify one or more scratch disks and associated settings:

1 Choose Preferences from the Edit menu, then click the Scratch Disks tab.
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2 To specify a disk or a folder on a hard disk as a scratch disk:

a Click Set. 

b In the dialog box that appears, locate and select the disk you want to use.

Only connected external disks or installed internal disks are listed. If your hard disk 
doesn’t appear, make sure it’s connected properly and that it’s correctly initialized and 
mounted. For more information, see the documentation that came with your computer, 
your hard disk, or your disk-formatting software. 

c Click Select (the button includes the name of the disk you selected).

The specified disk is listed next to the Set button, along with the amount of available disk 
space. You can define up to five disks (they can be partitions or whole disks) where your 
captured video will be stored. Scratch disks specified in this list are used based on the 
amount of available disk space, so those with the largest available disk space are used first. 

Note:  Scratch disks are no longer used in the top to bottom order shown in the Scratch 
Disks tab, as they were in earlier versions of Final Cut Pro. After the first disk becomes full, 
Final Cut Pro captures to the disk with the next most available space, and then the next 
one, and so forth, until all disks are full. 

Locate and
select the disk.

Then click here.
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3 To capture video and audio to separate files, check the box next to “Capture Audio and Video 
to Separate Files.” 

On disk, each video clip captured references the contents of its corresponding audio clip. In 
Final Cut Pro, your video and audio will remain in sync and each pair of media files appears 
in the Browser and the Viewer as a single clip. 

Video and audio files captured as separate files have the same name with _v appended to 
video and _a appended to audio files. Separate files must be captured to different disks. The 
two files cannot be captured to different locations on the same disk.

By capturing your audio to another disk, you can maximize the performance of the hard disk 
you’re using for video so you can capture at the highest data rate possible. 

4 To specify the types of files to be stored on each disk, check the boxes next to each scratch 
disk: Video Capture, Audio Capture, Video Render, and Audio Render.

5 To set locations for the waveform and thumbnail cache:

a Click Set next to Waveform Cache or Thumbnail Cache.

b In the dialog box that appears, locate and find the disk you want to use.

c Click Select (the button includes the name of the disk you selected).

The specified disk is listed next to the Set button, along with the amount of available disk 
space. The amount of space that these caches use is determined by the Thumbnail Cache 
setting in the General tab of the Preferences window (see “Setting General Preferences” 
on page 885).

Important  Do not use this option when capturing video with the DV codec.

Warning  Video and audio files captured separately are linked QuickTime files and both 
must be available for the media to be used by Final Cut Pro. If either file is deleted, the 
remaining media becomes useless and the whole clip must be recaptured.
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6 Specify additional settings for capturing and exporting files.

m Minimum Allowable Free Space on Scratch Disks:  Enter a value to set the minimum 
space you’d like to keep available on a scratch disk. If you have limited scratch disk space, 
you may want to set this to the amount of disk space you want available for render files. If 
you use most of your disk space for captured clips, you may run out of space when 
rendering transitions, filtered clips, and clips with motion settings applied to them.

m Limit capture/export file segment size to:  Final Cut Pro no longer has a 2 GB size 
limitation on captured or exported files. However, if you’re capturing or exporting clips 
that may be used on other systems with a file size limitation, you may want to enable this 
option. Any files that are larger than the limit entered here (which defaults to 2 GB) are 
spanned, or written as two separate, but linked files.

m Limit Capture Now to:  This option is on by default and set to 30 minutes. With this 
feature enabled, Final Cut Pro can allocate disk space more efficiently when performing a 
Capture Now. On large disk arrays, it can take time to allocate disk space for very long 
captures. Since most tapes are only 30 minutes to 2 hours, you can set a limit that allows 
the capture to happen much faster, without allocating extra resources that you may not 
need. 

Note:  The limit set for this option is approximate. Extra time may be added.

To remove a scratch disk:

1 Choose Preferences from the Edit menu, then click the Scratch Disks tab.

2 Click Clear next to the scratch disk you no longer want to use.
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20 Overview of Effects
Once you’ve edited the main content of your program, it’s time to start looking at effects. 
Final Cut Pro has many tools you can use for compositing, titling, and manipulating your clips 
with filters and motion effects.

Final Cut Pro’s effects can be divided into five categories:

m Compositing:  Compositing is the process of combining multiple clips of video and 
graphics together to create a visual effect. Keying the blue out of a blue screen clip to 
superimpose a group of actors against a desert scene is one example of compositing. 
Another example is creating a multilayered sequence of video and graphics clips at various 
levels of opacity to use as a background for a title sequence. Final Cut Pro gives you many 
tools you can use to blend clips together in various ways. For more information about 
Final Cut Pro’s compositing capabilities, see Chapter 21, “Compositing, Applying Motion 
Effects, and Using Keyframes,” on page 907.

m Motion effects:  Every video and graphics clip has a set of motion parameters that can be 
adjusted to modify the geometry of the clip. Using motion settings, clips can be resized, 
moved, rotated, stretched, and made transparent. Motion effects can be used to create 
interesting compositions of layered clips or (in conjunction with keyframes) to achieve 
sophisticated animation. Motion effects are covered in Chapter 21, “Compositing, 
Applying Motion Effects, and Using Keyframes,” on page 907.

m Keyframing:  Nearly all of Final Cut Pro’s effects can be keyframed, allowing you to adjust 
their parameters over time. Using keyframes, you can animate the motion effects of clips 
in your sequence. You can also adjust the parameters of filters to produce dynamic visual 
effects that change over time. For more information about how to apply keyframes to 
effects in your sequence, see Chapter 21, “Compositing, Applying Motion Effects, and 
Using Keyframes,” on page 907.
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m Filters:  Filters are effects that can be applied to clips and sequences for a variety of 
purposes. Filters are often used for color correction and exposure correction. Filters are 
also used to create the blue screen keying effect mentioned in the “compositing” 
example. Final Cut Pro has a large collection of filters that you can use to create 
interesting distortion effects for use in elaborate visual sequences. Filters are covered in 
Chapter 22, “Working With Video Filters, Generators, and Speed Settings,” on page 1023. 
For information on using filters with audio, see “Audio Filters” on page 821.

m Generators:  Generators are computer-generated clips that Final Cut Pro can render from 
scratch. Using generators, you can synthesize different kinds of backgrounds, titles, and 
elements for visual design. Generators are covered in Chapter 22, “Working With Video 
Filters, Generators, and Speed Settings,” on page 1023.
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21 Compositing, Applying Motion Effects, 
and Using Keyframes
This chapter covers some of the most common effects operations used to create broadcast 
design sequences. These operations include the following:
m Compositing graphics and video clips together

The task of compositing, or layering clips together, refers to superimposing multiple 
video or graphics clips over one another in a sequence. For example, you can use Final 
Cut Pro’s ability to adjust the transparency of clips to put a semi-transparent image of a 
flag flying in the wind over the video image of a national monument for a title sequence. 

You can also import QuickTime files with preset alpha channels, which Final Cut Pro uses 
to automatically define their levels of transparency. Final Cut Pro can then use this alpha 
channel information to combine these clips with background imagery in a sequence. An 
example of this would be to edit a 3D animation clip of a spaceship over a video clip of a 
desert for a science fiction video.

Another example of superimposing clips with built-in transparency information is adding 
text, such as title graphics or text generator clips, over the video in a sequence. 

m Nesting sequences

You can edit sequences from the Browser into other sequences just like any other clip. 
This can be done for organizational reasons, or to isolate effects-intensive parts of a 
program to minimize rerendering. Nesting sequences is covered in “Nesting Sequences” 
on page 937.

m Applying and using motion effects

Every graphics and video clip in a project has a set of corresponding motion settings that 
can be edited in the Motion tab of the Viewer. These settings include scale, rotation, 
center point, and drop shadow, among others. By adjusting a clip’s motion settings, you 
can change its geometry to move, shrink, enlarge, rotate, and distort the clip in nearly any 
way you like, relative to your overall project. Motion effects are covered in “Motion 
Effects” on page 940.
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m Using keyframes to dynamically adjust effects over time

All of Final Cut Pro’s opacity settings, motion effects, filters, and generators can be 
keyframed over time, the same way a clip’s audio parameters can be. Using keyframes, 
you can animate a clip’s motion effects to make it move around the screen, change its 
opacity over time to make it fade in and out, and dynamically adjust any applied filter 
effects—for example, to make a clip go from a blur to sharp focus as a sequence plays. 
Keyframing is covered in “Animating Visual Effects Using Keyframes” on page 981.

m Working with high-resolution graphics

You can import high-resolution scans and graphics in preparation for creating 
sophisticated motion effects. Working with such files is covered in “Working With 
Graphics Clips of Different Resolutions” on page 1021.

Final Cut Pro allows you to superimpose up to 99 layers of video together. By individually 
adjusting the geometry of these clips in the Motion tab of the Viewer, including their relative 
levels of transparency, you can control how they combine so that they’re not just a jumble of 
confused imagery. Then, using keyframes, you can animate the motion parameters to create 
dynamic motion graphics for titles, bumpers, or anywhere you need to add a little pizzazz to 
your project.

Layering Clips
Simply put, layering clips involves stacking two or more video or graphics clips at the same 
point in a sequence on multiple video tracks.
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In this example, two video clips and one graphic are stacked together in a sequence. If none 
of these clips are set to be transparent (and none of them have alpha channels), then the clip 
on the highest track in the Timeline is the one that’s shown in the Canvas during playback.

This can come in handy for editing. For example, let’s say you want to edit in a cutaway shot 
to interrupt a clip in a sequence. If you’re not sure whether or not you want to use it, you 
can use a superimpose edit to put the shot into an adjacent video track over the track with 
your original clip. It will achieve the same visual result as using an overwrite edit to put the 
cutaway shot into the same track as the clip you’re interrupting, but it’s easier to remove 
later on. 

The “stock photo” clip on 
video track V3 in the Timeline

Warning  Using this technique in a sequence you’ll be exporting as an EDL is not 
recommended. In an EDL, the superimposed cutaway clip will appear as a key edit, which 
is not the result you want. Before you export an EDL, be sure to edit all superimposed 
clips that you’re using as cutaways back into track V1.
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Setting Up Clips for Compositing

It’s likely that you’ll layer clips in order to composite them together. There are several ways 
you can set up clips in a sequence to begin compositing. You can create a new track in a 
sequence with the Insert Track command in the Sequence menu, then edit clips into that 
new track as necessary.

You could also simply drag a clip into an empty area of the Timeline, and a track will be 
created to accommodate this new clip.

Using Superimpose Edits

Superimpose edits are another good way to quickly layer multiple clips together in 
preparation for further work. When you edit a clip into a sequence using a superimpose edit, 
it will automatically be edited into the next track above the currently selected target track. 
Any clips that were already there will be moved up into other tracks, creating additional 
tracks, if necessary, to make room.

To perform a superimpose edit:

1 Do one of the following:

m Position the Timeline playhead over a clip where you want to superimpose your source 
media. The beginning and end of this clip will be used as edit points for your source clip.

m Set sequence In and Out points.

2 Set In and Out points in the Viewer to define the part of the source clip you want to edit into 
a sequence.

3 Do one of the following:

m Drag the clip from the Viewer to the Superimpose section of the Edit Overlay.

m Click the Superimpose button in the Canvas.

Clip on a 
new track

Drag a clip to an empty
area of the Timeline.
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m Press F12.

The Viewer clip is placed on the track above the target track, starting at the playhead location 
or at the sequence In point. If there is no track above the target track, one will be created.

Rearranging Clips Between Tracks in the Timeline

Sometimes, you’ll find you need to move a clip vertically from one track to another, but you 
want to keep its location in time in a sequence from changing. You might do this to

m move a video clip on top of another one to make sure it appears in front

m move a clip to another track to make room for another one being edited in

There’s an easy way to move any clip up or down into an adjacent track, without accidentally 
moving it forward or backward in time.

Superimpose section
of the Edit Overlay

in the Canvas.

Superimpose button

Clip has been added 
on the track above the 
target track
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To move a clip to an adjacent track while keeping it at the same time:

1 Press and hold the Shift key.

2 Drag the clip up or down to another track in the Timeline. You’ll notice that it’s constrained 
from moving forward or backward in a sequence. It can only move up and down.

Note:  This works for both video and audio clips.

Creating Transparency Effects in the Timeline

Every visual clip in a project has an opacity setting. By using the opacity setting of one or 
more clips, you can create the effect of two or more clips blending together to create a single 
image.

In the example above, opacity is used to blend together clips of two cats. The resulting image 
could be used as the background of a title sequence, or simply as a creative way to build an 
interesting montage in your program.
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If you click the Clip Overlays control in the Timeline to turn on the clip overlays, every visual 
clip in the Timeline will have an opacity overlay. This overlay allows you to set all or part of a 
clip’s opacity anywhere from 0 percent (invisible) to 100 percent (completely solid).

For example, let’s look at the example shown on page 909. If you drag the opacity overlay of 
the “stock photo” clip to 60 percent:

Clip Overlays control
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The output in the Canvas will look like this:

It’s that simple! Now the image of satin cloth is blended with the headshot to create a 
“textured” effect. To blend all three clips together, you only need to drag the opacity overlay 
of the “headshot” clip to 40 percent. ( You decide on the percentage of opacity based on each 
clip’s content.)

The output in the Canvas now looks like this:

All three layered clips are now blended together. Since things are starting to look a little 
confused, let’s lower the opacity of the stock photo even more, down to 25 percent, and 
boost the opacity of the headshot to 75 percent.
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The output in the Canvas now looks like this:

The “Dancers.mov” clip has lots of motion, so it will be easier to see once this sequence 
plays, even though it’s much less visible than any of the other clips. The stock photo is only 
there to give a subtle texture to the overall image, so you don’t need to set its opacity very 
high. 

Note:  When blending multiple clips together using opacity, it’s important to be aware of the 
color range, the amount of movement, and the overall amount of contrast and texture in the 
images with which you’re working. Balancing all of these qualities is what separates a good-
looking composite from a confused jumble of images and motion.

To adjust the opacity of a single clip with no keyframes in the Timeline:

1 Click the Clip Overlays control at the bottom-left side of the Timeline to display overlays.

2 Drag the opacity overlay (a black line if the clip is not selected, a white line if it is) up or 
down to adjust volume.

The pointer changes to the Adjust Line Segment pointer when it’s directly over the overlay, 
and a box displays the change in the percentage opacity in the clip as you drag.

To Adjust Opacity Accurately

Changing the track height and holding down the Command key as you drag can both 
help you adjust the opacity of a clip with greater accuracy.
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You can also adjust the opacity of a clip by opening it in the Viewer and adjusting the opacity 
parameter in the Motion tab. The opacity parameter in the Motion tab and the opacity 
overlay displayed in the Timeline are linked. A change made to one is mirrored in the other.

Note:  When compositing clips in a sequence, be sure that you open clips from a sequence 
in the Viewer when you adjust their motion settings (including opacity). If you do a match 
frame edit or inadvertently open a clip in the Viewer from the Browser, you won’t be working 
on the clip in your sequence. As a result, the clip in the sequence will be unchanged.

To adjust the opacity of a single clip with no keyframes in the Motion tab:

1 Open the clip that you want to adjust in the Viewer. You’ll know that a sequence clip is 
opened in the Viewer when you see two rows of dots in the scrubber bar.

2 Click the Motion tab in the Viewer.

Note:  If clip keyframes are enabled and you’ve already adjusted the opacity overlay, or any 
other motion setting for that clip in the Timeline, double-clicking the motion bar under that 
clip will open that sequence clip in the Viewer with the Motion tab automatically selected.
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3 Open the opacity parameter by clicking the disclosure triangle next to its name. The opacity 
overlay is now visible in the keyframe graph.

4 Adjust opacity by doing one of the following:

m Drag the opacity slider to the right or left to adjust opacity.

m Type a percentage in the number field.

m Drag the opacity overlay at the right side of the Opacity section.

The pointer changes to the Resize pointer when it’s over the overlay, and a box shows the 
percentage of opacity as you drag the overlay.

Motion settings and the opacity overlay in the Timeline can also be keyframed, enabling you 
to dynamically change these parameters over time. Keyframing is covered in detail in 
“Animating Visual Effects Using Keyframes” on page 981.

Superimposing Video When Preparing for EDL Export

In an Edit Decision List (EDL), a Super or Key track is the equivalent of a single 
superimposed video track in Final Cut Pro. EDLs can only recognize one Key track, and so V2 
is the only video track other than V1 that will show up in an exported EDL. Transitions in V2 
are not allowed in EDLs and will be ignored. If you want to have a transition on V2, use 
keyframes in the opacity overlay to dissolve V2 up and down. (See “Using Keyframes to 
Change Parameters” on page 995.)
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The opacity overlay in the Timeline will show up as the “Key Level” in your exported EDL. 
Opacity keyframes, if they exist, will be translated into values for the Key Level, and will be 
calculated in the EDL in relation to the timecode of the Master tape. These numbers are for 
use by a video switcher. Some online systems can translate these for automatic use by some 
switchers, but more commonly they are only used as notes for the editor to use in an online 
session. These values and their locations will show up as notes in the EDL.

Using Video and Graphics Clips With Alpha Channels

If you import a QuickTime movie clip or a still image from another compositing and effects 
application, or one that’s been created by a 3D animation program, it may have an alpha 
channel in addition to its color channels. Ordinary video clips have three channels of 
information for red, green, and blue. An alpha channel contains additional information that 
defines areas of transparency in the clip or image.

When you import a QuickTime movie or an image file, its alpha channel is recognized 
immediately. When you add the movie or image file to a sequence, Final Cut Pro uses the 
alpha channel for compositing against background layers.

Final Cut Pro recognizes three kinds of alpha channels. (A fourth state indicates there’s no 
alpha channel available; you can use it to disable an alpha channel.) The kind of alpha 
channel that Final Cut Pro determines a clip is using appears in a pop-up menu in the Item 
Properties window for the clip, along with an additional option to reverse the available alpha 
channel.
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These properties include

m Straight:  Typically generated in a 3D animation or compositing program, straight alpha 
channels contain only the pixels rendered for an image with no background (although the 
background appears black). Because of this, movies with translucent effects, like 
volumetric lighting or lens flares, will appear distorted unless they’re composited with 
something in the background. Movies or images with a straight alpha channel are easy to 
composite, and will always have very clean edges when composited in a multilayer 
sequence.

m Black:  Most other alpha channels, especially ones that are hand drawn in Photoshop, are 
premultiplied. This means that, unlike a movie with a straight alpha channel that contains 
only the pixels that are turned on, movies with alpha channels premultiplied against black 
will always look right, even if they have translucent lighting effects. This is because the 
entire image is precomposited against black. It’s important that such a clip is correctly 
identified, because if a clip with a premultiplied black alpha channel is incorrectly 
identified as having a straight alpha channel, there will be a black fringe around the edges 
of your imported image. In this case, it’s simple to go into that clip’s item properties and 
change the way the alpha channel is used.

m White:  Works the same as the black alpha channel, except that the clip is precomposited 
against white.

m None/Ignore:  If a clip has no alpha channel, or if you want to disable the alpha channel of 
a clip so that it’s no longer used, you can use the None/Ignore setting.

m Reverse Alpha:  If you need to reverse the alpha channel of a clip that’s been imported 
into a project, a checkbox is available to do so. (Reverse Alpha is a checkbox under the 
pop-up menu.)

There are three reasons you might change the recognized type of alpha channel of a clip in 
Final Cut Pro:

m Sometimes Final Cut Pro misinterprets the alpha channel when it imports a clip, which 
can result in “fringing” around the edges of solid objects. 

m Some editing and compositing applications output alpha channels that are the reverse of 
what Final Cut Pro uses. When this happens, what’s supposed to be transparent is solid, 
and what’s supposed to be solid is transparent. 

m You might find that you want to use a different way of recognizing an alpha channel for 
the effect it creates.

In all these cases, you can change or reverse the alpha channel setting.
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To change or reverse the alpha channel type of a clip in the Item Properties 
window:

1 Do one of the following:

m Select a clip in the Browser and choose Item Properties from the Edit menu.

m Control-click a clip in the Browser and choose Item Properties from the shortcut menu.

m Select your clip and press Command-9.

2 In the Item Properties window, choose the alpha channel type you want this clip to use. If 
necessary, you can also check the Reverse Alpha checkbox.

To change the alpha channel type of a clip using the Alpha Type menu:

1 Select a clip in the Timeline, Browser, or Viewer.

2 Do one of the following:
920 Chapter  21   



  
m Choose Alpha Type from the Modify menu, then choose a new alpha channel type from 
the submenu.

m Control-click the Alpha column in the Browser, then choose a new alpha channel type 
from the shortcut menu.

To reverse a clip’s alpha channel:

1 Select a clip in the Timeline, Browser, or Viewer.

2 Do one of the following:

m Choose Reverse Alpha from the Modify menu.

m Control-click the Reverse Alpha column in the Browser, then choose No or Yes from the 
shortcut menu.

If the Reverse Alpha menu item is checked when a clip is selected, that means that its alpha 
channel is being reversed. If it’s unchecked, than the alpha channel is left alone.
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Viewer and Canvas Options for Displaying Alpha Channel Information

Several options in the View pop-up menus of the Viewer and Canvas allow you to display 
both the alpha channel and the background behind a clip with an alpha channel in different 
ways. These options can make it easier to see how the alpha channels of various clips will 
affect your sequence.

How to Create Alpha Channels for Use by Final Cut Pro

Alpha channels are simply grayscale images or frames, where levels of white and black 
determine varying degrees of transparency. If you look at a clip with an alpha channel 
in the Viewer with the alpha option in the View pop-up menu checked, you’ll see that 
the solid areas of the image are represented by 100 percent white, and that 
transparent areas of the image are represented by 100 percent black. Lighter to darker 
shades of gray indicate lesser to greater areas of transparency.

Other editorial applications may use white and black differently, so if you’re 
exchanging media with other editors and broadcast graphics designers, let them know 
how you need clips with alpha channels to be set up.
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m You can view your sequence in the Canvas with RGB, Alpha, or Alpha+RGB enabled. 
When doing compositing, it can sometimes be handy to have a quick look at the alpha 
channel of your clip. The alpha channel defines areas of transparency and can change if 
various filters are applied. Looking at the Canvas with Alpha or Alpha+RGB will show you 
exactly which areas of your frame have transparency. 

RGB view

Alpha view

Alpha+RGB view
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m When working with clips that have an alpha channel, you can choose different 
backgrounds to make it easier to see which areas of your picture are transparent. For 
example, translucent clips or generated text may be more visible if you choose a 
background that emphasizes them, such as checkerboard 1 or 2. There are seven different 
backgrounds to choose from.
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Using Clips With Alpha Channels

Using clips that have alpha channels is easy. Simply edit them into your sequence as you 
would any other clip, but make sure that a clip with an alpha channel is on a higher 
numbered video track than any clips that are supposed to be behind it.

For example, let’s say you have a title graphic that was created in Photoshop with an alpha 
channel already set up. When you import it into Final Cut Pro, the alpha channel is 
recognized automatically. To create your title sequence, you’ll be editing both your title 
graphic and a background image into your sequence so that the background image is on 
track V1, and the title graphic is on track V2.

The alpha channel automatically makes the area around the text in the graphic file 
transparent, without your having to set any opacity settings.

Alpha channels work the same whether they’re in video clips or still graphics clips.
  Compositing, Applying Motion Effects, and Using Keyframes 925



Compositing Modes

Final Cut Pro’s different compositing modes are simply settings that determine how the 
colors of one clip will visually interact with those of another clip in a sequence layered 
beneath it.

When you first edit a clip into your sequence, it defaults to the Normal compositing mode, 
meaning that it is a solid layer with no interactions with any layers underneath it. If you apply 
opacity settings to a clip using the Normal compositing mode, all parts of that clip will go 
transparent equally.

You can change this, however, by selecting your clip in the Timeline and choosing a new 
compositing mode from the Composite Mode submenu of the Modify menu.

Various composite modes
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Once applied, different compositing modes produce different visual results in your clips. 
Most combine the affected clip with selected parts of the clip beneath it. Some affect lighter 
parts of the clip differently than darker parts, and others create negative effects or change the 
color range of the affected clip, depending on how the layers interact.

Normal composite mode, with 
the opacity of the top clip at 
50 percent

Add composite mode
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How to Use Compositing Modes

No matter which composite mode you decide to use, applying different composite modes to 
layered clips in a sequence is easy. The main thing to remember is that composite modes 
affect the interaction between one layered clip and whichever clip is underneath it in the 
sequence. Clips that are above a layered clip using a composite mode will be unaffected.

The top clip has Normal 
composite mode and 
opacity; the middle clip 
has Add composite 
mode; the bottom clip 
is interacting with the 
middle clip.
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To apply a composite mode to a clip in your sequence:

1 With two layered clips in your sequence (on tracks V1 and V2, for example), select the 
topmost clip in the Timeline.

2 Choose Composite Mode from the Modify menu, then choose a composite mode.

If you move the playhead over these two clips, you’ll see the interaction between the two 
clips in the Canvas.

Compositing Modes and Opacity

Final Cut Pro’s compositing modes work with the opacity settings covered in “Creating 
Transparency Effects in the Timeline” on page 912. All compositing modes do is determine 
how the various color values in different pixels of one clip interact with those in the clip 
underneath. Adjusting the opacity of one of these clips modifies how much of an effect each 
layered clip has on the final result in your sequence.

The Screen composite 
mode is on the upper 
(“stock photo”) of two 
clips; no opacity is on 
either clip.
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Compositing Modes Available in Final Cut Pro

m Normal:  Displays the clip without any changes. This is the default of any new clip you 
edit into your sequence.

m Add:  Combines the color values of the selected clip with those of the clip below it on the 
Timeline, not exceeding absolute white. The resulting image is lighter. Where the added 
values are greater than one, absolute white is displayed.

m Subtract:  Subtracts the color values of the selected clip with those of the clip below it on 
the Timeline, not going below absolute black. The resulting image is darker. Where the 
subtracted values are zero, absolute black is displayed. 
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m Difference:  Subtracts the color values of the underlying clip from the selected clip, 
displaying the absolute color values. 

m Multiply:  Compares the color values for each pixel of the selected clip with those of the 
clip below it on the Timeline, and multiplies them together. If the image is already dark, 
there is little or no effect. If the image is light, Multiply darkens it.
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Multiply is a useful filter for knocking out the absolute white values of an image, and 
leaving all other values of the image alone, similar to a luminance key on white. For 
example, if you have a scanned image of text on the page of a book, you could use the 
Multiply compositing mode to knock out the white, leaving only the text itself 
superimposed over the other layers of your sequence.

m Screen:  Compares the color values for each pixel of the selected clip with those of the 
clip below it on the Timeline, and multiplies the inverse of each. If the image is already 
light, there is little or no effect. If the image is dark, Screen lightens it. 

Screen is a very useful filter to use for knocking out the absolute black of a layer and 
leaving everything else in the clip alone, similar to a luminance key on black. For example, 
if you have stock footage of an explosion, or of fire, you can apply the Screen compositing 
mode to it, and everything that was an even black will pop out, leaving only the explosion 
superimposed over the other layers of your sequence.
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m Overlay:  Wherever the color value is greater than 128, Screen is applied. Wherever the 
color value is less than 128, Multiply is applied.

m Hard Light:  Darkens or lightens the colors of the selected clip, depending on the color 
values for that clip. The effect is similar to shining a hard spotlight on the clip.
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m Soft Light:  Darkens or lightens the colors of the selected clip, depending on the color 
values for that clip. The effect is similar to shining a diffused spotlight on the clip.

m Darken:  Compares the color values for each pixel of the selected clip with those of the 
clip below it on the Timeline, and selects the darker of the two.
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m Lighten:  Compares the color values for each pixel of the selected clip with those of the 
clip below it on the Timeline, and selects the lighter of the two.

m Travel Matte - Alpha or Luma:  Applies a matte to the selected clip, using information 
from the clip immediately below it on the Timeline, that makes the area outside of the 
matte transparent, and displays the second layer underneath it on the Timeline. 

m The Alpha option ignores RGB values, using the alpha channel of the matte layer to 
create transparency information for the selected clip.

m The Luma option averages the RGB values of the matte layer to gray. The resulting 
grayscale image will then be used to create transparency information for the selected 
clip, with white equal to 100 percent transparent and black equal to 100 percent solid.

Travel mattes always involve three tracks. The foreground clip is on the upper track. The 
matte track goes on the middle track, and the background clip (or clips, if transparent) 
goes on the lowest track. The travel matte composite mode is then applied to the 
foreground clip on top of this stack. When the travel matte is on track V1, Final Cut Pro 
uses black as the default background.
  Compositing, Applying Motion Effects, and Using Keyframes 935



Using Travel Mattes

Because travel mattes are so useful, we’ll spend some extra time going over how they work. 
Travel mattes are useful when you want to use one clip to selectively hide or reveal part of 
another. For example:

m To show parts of a video layer selectively revealed by a round spotlight shape

m To partially reveal video images playing through a title or logo graphic

m To use an imported graphic to obscure part of a layer you don’t want to show

Because travel mattes use information in one layer to affect another, if the alpha channel, 
black, or white elements of that layer move, then the resulting matte will move also. This 
movement can be as a result of using a video or animation clip as your matte layer, or of 
moving that layer around with keyframed motion settings (see “Creating Keyframed Motion 
Paths in the Canvas” on page 1003). Either way, travel mattes are extremely versatile.

To create a travel matte:

1 Place the clip you want to appear in the background of your composite on video track V1 in 
the Timeline.

2 Place the clip you want to use as your matte layer above the background clip, on video track 
V2 in the Timeline. 

The matte layer used in this example is simply a Color Matte generator clip, with the Mask 
Shape and Mask Feather filters applied to create a soft oval matte.

If you plan on using the Travel Matte - Alpha mode, make sure that the clip has a properly 
formatted alpha track (see “Using Video and Graphics Clips With Alpha Channels” on 
page 918). If you plan on using the Travel Matte - Luma mode, make sure that the black and 
white areas of your clip are appropriately set.
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3 Place the clip you want to be masked (the main clip) on the track immediately above the 
mask clip, in this case on track V3.

4 Select the clip you want to be masked on track V3.

5 Choose Composite Mode from the Modify menu, then choose either Travel Matte - Alpha or 
Travel Matte - Luma, depending on the clip you’re using as your matte layer on track V2.

m The Alpha option uses the clip’s alpha channel, if one exists, as the mask.

m The Luma option uses the luminance, or grayscale image, of the clip as the mask. 

Note:  The matte clip’s RGB information won’t be seen in either case.

You can now select one of the clips and render the area (by choosing Render Selection from 
the Sequence menu) to view the affected area of the sequence.

Nesting Sequences
Final Cut Pro allows you to use sequences in your project as if they were clips. You can open 
them in the Viewer, set In and Out points, then edit the sequences into another sequence in 
the Timeline as you would any other clip. This is useful for a number of different reasons:

m If you like, you can edit a program using multiple sequences (a sequence for each scene, 
for example). You can then edit all of these sequences together as nested sequences to 
create a final sequence for video output.

m You can also use nested sequences to reduce the amount of rendering you need to 
perform when working with effects. You can place all of the effects-intensive audio or 
video sections of your program into separate sequences, and render them. When you 
then nest these sequences into your main program sequence, you can change the In and 
Out points of the nested sequences without having to rerender all of clips inside of them.
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m Finally, you can use nested sequences to control the rendering order of effects that you 
use in your project. By applying visual effects filters to clips inside a nested sequence, you 
can then apply additional effects to the sequence itself, and the contents of the nested 
sequence, effects and all, will be affected as if it were a single clip.

Note:  A sequence can’t be edited into itself.

Nested sequences can be used like any other clip. You can add audio and video filters to 
them, set their opacity and level overlays in the Timeline, work with their audio in the Audio 
tab of the Viewer, and adjust their motion settings in the Motion tab of the Viewer.

How to Nest Sequences

There are two ways you can nest sequences. One is simply to edit the contents of a 
sequence, render it, and then edit that sequence into another sequence of your choosing.

To nest a sequence using the Viewer:

1 Open the sequence you want to edit in the Viewer by doing one of the following:

m Drag it to the Viewer from the Browser.

m Hold down the Option key, then double-click a sequence in the Browser to open it in its 
own Viewer window.

2 Set In and Out points for that sequence in the Viewer.

3 Edit it into another sequence in the Timeline as you would any other clip. 

To nest a sequence by dragging it into another sequence:

m Drag the sequence from the Browser or Viewer to another sequence in the Timeline, as 
you would any other clip.

To copy and paste a sequence into another sequence:

1 Copy the sequence in the Browser by doing one of the following:

m Select a sequence in the Browser and then choose Copy from the Edit menu 
(Command-C).

m Control-click a sequence in the Browser and choose Copy from the shortcut menu.

2 Move the playhead to the location in another sequence where you want to paste the nested 
sequence (in the Canvas or Timeline).

3 Select the target tracks where you want the nested sequence to go.

4 Choose Paste from the Edit menu (or press Command-V ).

If you have a section of clips in a sequence, and you realize that you’d actually like those clips 
to be in a sequence of their own with that sequence taking their place in your current one, 
you can use the Nest Items command.
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To use the Nest Items command:

1 Select a range of clips that you want to replace with a nested sequence containing them in 
the Timeline. If the clips are linked, then any items that are linked to those clips in the 
Timeline will also be selected.

2 Choose Nest Items from the Sequence menu (or press Option-C).

3 In the Nest Items dialog box, enter a name for the new sequence into which these selected 
items will be placed. 

4 Choose a width and height for the new sequence that will be created to contain the selected 
clips.

5 Click “Keep Effects, Markers, and Audio Levels with Clips” to move all effects, markers, and 
audio levels associated with the selected clips into the new sequence.

6 Click the Mixdown Audio checkbox to render all of the audio in the new sequence. 

This will minimize the effect that the resulting nested sequence will have on the audio 
playback of your sequence. For more information on the real-time audio rendering 
capabilities of Final Cut Pro, see Chapter 17, “Working With Audio,” on page 727.

7 Finally, name the resulting sequence to be created.

8 Click OK.
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All the items in your sequence will be cut from the current sequence and placed in a new 
sequence with the name you specified in the Browser. This sequence now appears as a 
nested sequence where the clips you selected used to be.

The nesting operation can easily be undone, if you change your mind.

Motion Effects
When you first edit a clip into your sequence, assuming you didn’t change any of its motion 
settings in the Viewer, it will be positioned in the center of the Canvas, with a scale of 100, an 
opacity of 100, and a rotation of 0. These default settings can be changed by modifying a 
clip’s motion parameters.

Every video, graphics, and generator clip in Final Cut Pro has a set of corresponding motion 
parameters. These parameters affect the opacity and geometry of these clips, and can be 
used in two ways:

m By adjusting the opacity and geometry of layered clips, motion effects can be used to 
visually arrange the layers of your sequence. These layers can be resized, moved, rotated, 
and superimposed so that you can create any visual arrangement you like.

m By using keyframes, you can also use each clip’s motion parameters to animate clips in 
your sequence, making them move across the screen, rotate, and grow or shrink over 
time, among other possibilities. Keyframing these effects will be covered more extensively 
in “Animating Visual Effects Using Keyframes” on page 981.
940 Chapter  21   



Using the Motion Tab

Each clip’s motion settings are located in the Motion tab of the Viewer. Opacity is the only 
parameter besides volume level that can be adjusted in the Timeline. To view the motion 
settings for a clip, you must first open it in the Viewer, and then select the Motion tab.

The motion parameters are divided into six sets. Each set has a disclosure triangle, which you 
click to reveal the parameters for that particular set. Each parameter has its own graphical 
and numeric controls:
m Basic Motion

m Scale:  Changes the overall size of a clip without changing its proportions. Scale can be 
increased or decreased by dragging its slider, by entering a new value in the number 
field and pressing the Return key, or by dragging its overlay in the keyframe graph.

m Rotation:  Rotates a clip around its center axis without changing its shape. Clips can be 
rotated plus or minus 90 rotations. Rotation can be modified by dragging the Angle 
control, by entering a new value in the number field and pressing the Return key, or by 
dragging its overlay in the keyframe graph. When using the Angle control, the black 
hand indicates the current angle of the clip, and the small red dial indicates how many 
total rotations forward or backward have been specified.

Lower part of the 
Motion tab showing 
options for opacity, 
drop shadow, and 
motion blur

Upper part of the
Motion tab showing

options for basic
motion, crop,

and distort
  Compositing, Applying Motion Effects, and Using Keyframes 941



m Center:  Specifies the center point of the clip, allowing you to move a clip somewhere 
else in the frame. A new center point defining that clip’s location can be defined by 
clicking the Point control, then clicking with the crosshair pointer on a point in the 
Canvas window, or by entering new X and Y coordinates in the number fields to the 
right and pressing the Return key.

m Anchor Point:  Specifies the point that is used to center a clip’s position and rotation. 
A clip’s anchor point does not have to be at its center. The anchor point can be 
changed by entering new X and Y coordinates in the number fields to the right and 
pressing the Return key.

m Crop

m Crop:  Crops the clip from the specified side. You can crop the top, left, right, and 
bottom of a clip independently. You can crop on all four sides by dragging one of the 
sliders, entering a value (in pixels) in the number field corresponding to the border 
you want to crop and pressing the Return key, or by dragging one of the 
corresponding overlays in the keyframe graph.

m Edge Feather:  This option applies a soft border with its outer edge at the crop line. 
The higher you set the edge feather parameter, the further into your clip the 
feathering effect will go. You can adjust the edge feather of a clip by dragging its slider, 
by entering a new value in the number field and pressing the Return key, or by 
dragging its overlay in the keyframe graph.

m Distort

m Corners:  You can change the shape of a clip by moving each of four corner points 
independently of one another. The corner points defining the relative distortion of a 
clip will be offset relative to the center of the clip. To do this, enter new X and Y 
coordinates for the corner point you want to move in the number fields to the right 
and press the Return key.

m Aspect Ratio:  Allows you to squeeze a clip horizontally or vertically to change the ratio 
of its width to its height. This parameter will only make a clip narrower than the area 
of that clip’s frame; it will not make it wider. To squeeze a clip horizontally, drag the 
slider to the right. To squeeze a clip vertically, drag the slider to the left. You can also 
enter a value between –10,000 and 10,000 in the number field to the right and press 
the Return key. Negative numbers result in vertical squeeze; positive numbers result in 
horizontal squeeze. Finally, you can also drag the corresponding overlay in the 
keyframe graph.

m Opacity

m Opacity:  Increases or decreases the transparency of a clip. To increase the 
transparency of a clip, drag this slider to the left. To decrease the transparency, drag it 
to the right. You can also enter a number between 0 and 100 in the number field and 
press the Return key. Finally, you can drag the corresponding overlay in the keyframe 
graph.
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m Drop Shadow

m Drop Shadow:  Places a drop shadow behind a clip. To enable a drop shadow, click the 
checkbox by its name, and adjust its parameters:

m Offset determines how far away from the clip the drop shadow will fall. The offset can 
be changed by dragging its slider control, by typing a number in the number field and 
pressing the Return key, or by dragging the corresponding overlay in the keyframe 
graph.

m Angle determines which angle the drop shadow will fall towards. You can adjust the 
angle by dragging the Angle control, by entering a new value in the number field and 
pressing the Return key (negative values rotate left, positive values rotate right), or by 
dragging its overlay in the keyframe graph. When using the Angle control, the black 
hand indicates the current angle of the clip, and the small red dial indicates how many 
total rotations forward or backward have been specified.

m Color determines the color of the drop shadow. The color parameter has several 
controls. You can click a disclosure triangle to display sliders and number fields 
corresponding to the hue, saturation, and brightness of the chosen color for the drop 
shadow. You can also click the eyedropper, then move the pointer either to the image 
in the Viewer or the Canvas and click a color with the eyedropper tool to select it. If 
you’re keyframing changes in color, you can click the Hue Direction control to decide 
which direction on the color wheel Final Cut Pro will interpolate the color change. 
Finally, you can click the Color Picker control to pick a color using the standard Apple 
color picker.

m Softness determines how much the corresponding drop shadow will be blurred 
around the edges. You can adjust the softness by dragging its slider, by entering a new 
value in the number field and pressing the Return key, or by dragging its overlay in the 
keyframe graph.

m Opacity determines how transparent the drop shadow will be. You can adjust the 
opacity by dragging its slider, by entering a new value in the number field and pressing 
the Return key, or by dragging its overlay in the keyframe graph.

m Motion Blur

m Motion Blur:  When enabled (by clicking its checkbox) the motion blur setting blurs 
any clip with keyframed motion applied to it, using the specified sample rate and 
amount of blur.

Note:  In this version of Final Cut Pro, 1000% blurs over 10 frames; 100% blurs on one 
frame.

m Samples:  The number of samples affects how detailed the applied motion blur will be, 
depending on the speed of the motion effects applied to a clip.

m % of Blur:  Affects how smooth the motion blur will be.
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Note:  Motion blur is only applied to clips that are moving within the frame of your 
sequence due to keyframed motion effects. It does not affect video clips just because they 
have something moving in the frame, like a person waving his arms. Examples of 
instances where motion blur would be used include layers with keyframed Center, 
Rotation, or Anchor Point parameters which move that layer spatially over time. For more 
information on how to animate layers using keyframes, see “Animating Visual Effects 
Using Keyframes” on page 981.

Using Motion Settings

Here are two examples of how to use the motion settings in the Motion tab of the Viewer.

Motion Example #1

In the first example, we’ll create a layered interview segment using the Scale, Rotation, and 
Center Point parameters. This example will use a sequence created for DV clips, with a frame 
size of 720 x 480.

Modifiers for Effects Controls

When using an Angle control, there are three modifiers you can use when you select a 
value:

m You can hold down the Shift key to constrain the dial to 45-degree increments.

m You can hold down the Command key to slow the dial’s movement, to select a 
more precise value.

m Drag all the way out of the dial for that effect parameter to reset it to 0.

When using slider controls:

m You can hold down the Shift key to adjust its value by two decimal places of 
accuracy.

m You can hold down the Command key to slow the slider’s movement, to select a 
more precise value.
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1 First, edit in a background layer against which all of the other composited layers will appear. 
If you don’t edit in a background layer of some kind (a graphic, video clip, or Final Cut Pro 
generator clip would work) all of your layered clips will appear against black by default.

2 Use the Mark Clip command (the X key) to set the sequence In and Out points using the 
duration of this background clip.

3 You can now edit in the first clip you want to arrange in the background of your composition 
using a superimpose edit. A new track will automatically be created above the current V1 
video track, and your clip will be inserted into it.
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4 Double-click the sequence clip you’ve just edited into the Timeline to open it in the Viewer 
in preparation to edit its motion settings. Once it’s in the Viewer and you see the dots in the 
scrubber bar that indicate that it’s a sequence clip, click the Motion tab.

5 Drag the Scale slider to 38. ( You can also type the number 38 in the number field for Scale, 
and press the Return key.) This is a percentage of the clip’s total size. As you drag, the clip 
shrinks in the Canvas. 

Note:  The speech at which changes in the Motion tab are reflected in the Canvas depends 
on the speed of your system.

Dots in the scrubber
bar indicate the clip

is in a sequence.

Motion tab for the clip 
in the Viewer (at left)
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6 Now, drag the Angle control to the left so that it reads –28. This is the angle in degrees that 
your clip will be rotated by. A negative value rotates it to the left, while a positive value 
rotates it to the right. This change will also be reflected in the Canvas.

7 Now, to change the position of this clip in the Canvas, click the Point control for the Center 
parameter. 

With the Point control highlighted, move the pointer to the Canvas so it changes to a 
crosshair pointer. 

Clicking anywhere in the Canvas with the crosshair pointer will move the X and Y values of 
that clip’s center point to the pixel you clicked. More information on X and Y values for clip 
positioning will appear in step 12.
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Click with the crosshair pointer in the upper-left corner of the Canvas to position the clip 
there. You’ll see the coordinates of the clip’s new center point in the number fields of that 
clip’s Motion tab in the Viewer. In this case, the first (X) coordinate reads –218, and the 
second ( Y ) coordinate reads –119.

8 Now, using the same sequence In and Out points you set before, choose track V2 as the 
current target track (you can click the Target Track control, or press F6 and then the number 
1). Edit in a second clip you want to place in the background using a superimpose edit.
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9 Select the track you resized and repositioned on track V2 in the Timeline, and choose Copy 
from the Edit menu. You can now selectively apply its motion settings to the new clip you 
just edited in track V3 by selecting the new clip and choosing Paste Attributes from the Edit 
menu.

10 The Paste Attributes dialog box now appears. By checking various options in this window, 
you can selectively paste only the attributes you want to use from the clip you copied into 
the currently selected clip. This command is especially handy when you are applying similar 
motion settings, filters, and other parameters to a large group of clips. Apply the motion 
settings from the previous clip by checking the Basic Motion box, then click OK.
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11 The new clip you edited into track V3 now has exactly the same motion settings as the other 
one, so that they both occupy the same place in your sequence.
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12 Although you want to keep the size of this clip the same, you want to position it on the right 
corner, as a mirror image of your original clip. To set this up quickly, double-click the clip on 
track V3 to open it in the Viewer and open the Motion tab. In the left number field of the 
Center parameter (the X coordinate), delete the – from the number, changing it from 
negative 218 to positive 218. Press the Return key. The results appear immediately in the 
Canvas.

This works because the X and Y coordinates of a clip in the Canvas are based on the offset 
between that clip’s center point and the center point of the Canvas. 

Working with motion in Final Cut Pro is based on simple Cartesian geometry. The center 
point of a layer is always relative to the center point of the Canvas, and the center point of 
the Canvas is always 0,0. 
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For example, if you look at the coordinates of a 720 x 480 Canvas, you can see that:

m Entering a positive number in a clip’s X coordinate moves it to the right.

m Entering a negative number in a clip’s X coordinate moves it to the left.

m Entering a positive number in a clip’s Y coordinate moves it down.

m Entering a negative number in a clip’s Y coordinate moves it up.

In step 7, the center point you defined for your clip on track V2 was –218,–119. This put the 
clip 218 pixels to the left, and 119 pixels up from the Canvas center point.

Canvas center point
(0, 0)

-360 pixels +360 pixels

-240 pixels

+240 pixels

Y offset
(-119)

X offset
(-218)

Clip center point
(-218, -119)

Clip center point
(-218, -119)

Canvas center point
(0, 0)
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When you copied and pasted these coordinates to the clip on track V3, it appeared in exactly 
the same place. However, when you changed its X coordinate from negative 218 to positive 
218, you put that clip’s center point 218 pixels to the right of the Canvas center point, which 
flipped it to the other side.

13 Now, to make this clip rotate to the right rather than to the left, delete the – from the 
Rotation number field, and press the Return key.

X offset
(+218)

Y offset
(-119)

Clip center point
(+218, -119)

Clip center point
(+218, -119)

Canvas center point
(0, 0)
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You’ll see the result immediately in the Canvas.

14 Now that you have all of your background layers set up, it’s time to edit in the foreground 
clip that’s going to appear in front of all this. Using the same sequence In and Out points that 
you’ve been using, set the target track of your sequence to V3, and use a superimpose edit to 
put the foreground clip you want to use into track V4.
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15 Open this new clip in the Viewer and select the Motion tab. Using the Scale slider, adjust its 
size so that it’s 66 percent of its original size.

16 Now you’ll want to move this clip down so it doesn’t obscure the clips in the background that 
much. If this sequence is being created to play on television, you’ll want to choose Title Safe 
from the View menu to enable title safe boundaries as a guide for positioning your clips.
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17 The title safe indicators show you where the boundaries are for title safe and action safe. 
Televisions cut off the edge of the video frame to give the illusion that the picture takes up 
the entire TV screen. How much gets cut off, however, varies from manufacturer to 
manufacturer. Final Cut Pro’s title and action safe indicators allow you to see what parts of 
your composited sequence might get cut off, so you can arrange your composited clips and 
titles to take this into account.

18 Now move this clip down by +37 pixels to make way for the clips in the background. 
According to the action safe guide, you’re within the area that will be viewable on most 
television monitors.
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Motion Example #2

In this example, we’ll use the Crop, Feather, Opacity, and Drop Shadow parameters to further 
customize the sequence you created in example 1.

1 Open the clip on track V4 of your sequence in the Viewer, and click the Motion tab.

Don’t Be Afraid to Do the Math

Final Cut Pro’s compositing features utilize simple geometry to position clips within 
the frame defined by the Canvas. As shown in step 12, you can use this fact to make 
the process of symmetrically arranging layered clips easier and more precise. 

Even though it’s possible to eyeball a lot of compositions, a little math can go a long 
way, especially when you want to start creating more precise motion effects using 
keyframes.
  Compositing, Applying Motion Effects, and Using Keyframes 957



2 First, you’ll feather the edges of your foreground clip to give it a soft border. Click the 
disclosure triangle next to the Crop parameter.

3 Drag the Edge Feather slider to the right until it’s set to 64. A soft border appears around 
your clip in the Canvas.

4 Before you do anything else to the foreground clip, you’ll apply the same amount of 
feathering to the other two background clips. You can do this without opening them up. 
Select the foreground clip on track V2, and choose Copy from the Edit menu.

5 Now, drag a box around the two background clips on tracks V3 and V2 to select them both at 
once, and choose Paste Attributes from the Edit menu.

In the Paste Attributes dialog box, check the Crop box, leaving all other options except for 
the Scale Attribute Times box unchecked, and click OK.
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The feathering you set in the foreground clip is now applied to the background clips.

6 With this done, you’ll make two further adjustments to the foreground clip. To make this clip 
seem a little wider, and to allow the clips in the background to be more visible, drag the Top 
and Bottom sliders to the right until they are set to 5. The resulting change to the clip is 
displayed in the Canvas.

7 Now, you’ll add a drop shadow to these three layers. With the Motion tab of the foreground 
clip still open in the Viewer, click the checkbox next to the Drop Shadow parameter to 
enable it. Then click the Drop Shadow’s disclosure triangle to display its parameters for 
further editing.
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8 Using the appropriate controls, set the Offset to 10, set the Angle to 135, set the Softness to 
23, and set the Opacity to 65. The result appears in the Canvas.

9 To apply these settings to the other two clips, select this clip on track V4 in the Timeline and 
choose Copy from the Edit menu. Then select the clips on tracks V2 and V3 and choose Paste 
Attributes from the Edit menu.

10 In the Paste Attributes dialog box, click the Drop Shadow checkbox and click OK. Both 
selected clips now display a drop shadow.
960 Chapter  21   



11 Finally, you find you want to darken the background layer, as it’s competing with the 
foreground layers. To darken the background, adjust the opacity of the background clip. 
Since the default background is black, lowering the opacity of the clip in track V1 will darken 
it. Open the Opacity parameter’s disclosure triangle and set the opacity to 50 percent. The 
background clip now appears darker in the Canvas.

Displaying Filter and Motion Bars in the Timeline

You can show or hide filter and motion bars at any time by clicking the Clip Keyframes 
control at the bottom of the Timeline window. 

Using the Paste Attributes Command

As you composite multiple clips together in Final Cut Pro, it’s important to take 
advantage of whatever shortcuts you can to eliminate steps and save time. The Paste 
Attributes command is a valuable tool for selectively copying attributes from one clip 
to another without having to open clips in the Viewer, and eliminates the need to 
repeat steps when applying identical effects to multiple clips.

Clip Keyframes control
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With clip keyframes turned on, additional space is added under each audio and video track in 
the Timeline. 

m If a motion setting is modified for a video clip in the Timeline, a blue bar appears in this 
space for the duration of that clip. 

m If a filter is added to an audio or video clip in the Timeline, a green bar appears in this 
space for the duration of that clip.

If keyframes are added to the filter or motion settings for a given clip, those keyframes 
appear as diamonds on the bar to which they apply, where they can be edited or moved.

To selectively display which keyframes are visible in a motion or filter bar:

m Control-click a motion or filter bar, and choose a parameter with keyframes you want to 
isolate. You have three options:

m You can choose a single parameter from this list.

m Choose Show All to display all keyframes associated with a clip’s motion or filters 
parameters.

m Choose Hide All to hide all keyframes associated with a clip’s motion or filters 
parameters.

You can double-click a motion bar to open a clip with the relevant Viewer tab already open.

Video motion bar 
(blue)

Audio filter bar (green)
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To move a keyframe forward or backward on your clip in the Timeline:

m Drag a keyframe on a motion or filter bar to another position on that bar.

To open a clip in the Viewer using filter and motion bars in the Timeline:

m Double-click a blue bar to open that clip in the Viewer with the Motion tab selected.

m Double-click a green bar or keyframe to open that clip in the Viewer with the Filter tab 
selected.

Adjusting Motion Settings in the Canvas

The motion settings of clips in your sequence can also be adjusted graphically, by 
manipulating them directly in the Canvas. To do so, you must first put the Canvas into 
Image+Wireframe mode using the View pop-up menu, which appears in the Canvas and 
Viewer. This menu also gives you access to several other settings that make it easier to work 
with composited layers in your sequence.
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Image and Wireframe Modes

You can display your sequence in the Canvas in Image, Image+Wireframe, or Wireframe 
mode. 

m Image, the default, shows the video of your sequence as it plays back. 

m Image+Wireframe is the mode to use when adjusting motion effects directly in the 
Canvas. Each video layer in the Canvas will have a bounding box attached to it with 
handles, which can be used to adjust that clip’s size, rotation, and position graphically, 
using your mouse within the Canvas. 

m Wireframe mode shows only the bounding box and handles of each clip in your 
sequence, without the corresponding image. Wireframe mode is useful if you’re working 
on high-resolution clips and you want to make a lot of changes quickly, without having to 
wait for your image to update. Wireframe mode is also useful for quickly previewing 
motion you’ve created using keyframes.

RGB and Alpha Modes

You can also view your sequence in the Canvas with RGB, Alpha, or Alpha+RGB enabled. 
When doing compositing, sometimes it’s handy to have a quick look at the alpha channel of 
your clip to make sure that it’s set up properly for your purposes. The alpha channel defines 
areas of transparency and can change if various filters are applied. Looking at the Canvas with 
Alpha or Alpha+RGB shows you exactly which areas of your frame are solid or transparent. 

Background Modes

When working with clips that have an alpha channel, or with a series of small clips that you’re 
compositing against nothing, you can choose different backgrounds to make it easier to see 
which areas of your composition are transparent or in the background. For example, 
translucent clips or generated text may be more visible if you choose a background that 
emphasizes them, such as checkerboard 1 or 2. 
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To put the Canvas into one of the wireframe views:

m Do one of the following:

m Choose Image+Wireframe or Wireframe from the View menu.

m Press W to display the Viewer or Canvas in Image+Wireframe view. Press W again to 
display Wireframe view. Press W a third time to return to Image view. 

m Choose Image+Wireframe or Wireframe from the View pop-up menu at the top of the 
Viewer or Canvas.

When the Canvas is in Wireframe or Image+Wireframe mode, each clip in your sequence, 
whether there’s only one clip or a series of layered clips, has a bounding box which shows its 
scale, position, rotation, distortion, and cropping, if any are applied. The clip that’s currently 
selected in the Timeline has a pair of crossed lines indicating its center point and is outlined 
in turquoise.

Image+Wireframe mode
  Compositing, Applying Motion Effects, and Using Keyframes 965



When a clip is selected in the Timeline or Canvas, there are handles attached to it that allow 
you to perform different geometrical manipulations. A number at the center of the selected 
clip shows which track it’s from. The screenshot below is taken from “Motion Example #1” 
on page 944; it shows you the locations of the different handles on a selected clip in the 
Canvas.

m Center handle:  Dragging this handle of a clip’s wireframe with the Selection tool will 
reposition that clip in the Canvas, changing its Center parameter in that clip’s Motion tab.

m Rotational handle:  Dragging one of these four rotation handles with the Selection tool 
will rotate that clip in the Canvas, changing its Rotation parameter in that clip’s Motion 
tab.

m Scale/Distort handles:  Dragging one of the four corner points of a clip with the Selection 
tool will modify its Scale parameter. Dragging one of these four points with the Distort 
tool will instead move that point independently of the others, modifying the appropriate 
parameter for that clip.

m Crop handles:  Dragging one of a clip’s four sides with the Crop tool will adjust the 
appropriate Crop parameter in that clip’s Motion tab.

Crop handles

Center handle

Rotational handle

Scale/Distort handle
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Tools for Graphical Clip Manipulation in the Canvas

In addition to the Selection tool, you can use two other tools to manipulate the geometry of 
clips in the Canvas.

m Crop Tool:  Allows you to drag each of a clip’s four sides inward to crop just that side (the 
C key).

m Distort Tool:  Allows you to drag each of a clip’s corner points independently, in order to 
create perspective effects and other geometric distortion (the D key).

Zooming Into the Canvas Display

Using the Zoom pop-up menu in the Canvas, you can choose a magnification level to help 
you work with your clips as you drag them around. The zoom level you specify only changes 
the display size of the image and doesn’t affect the frame size of your edited sequence. 
Besides simply choosing a magnification level, you can

m choose Fit to Window to automatically increase or decrease the size of your sequence’s 
image to match any increase or decrease in the size of the Canvas window

m choose Fit All to zoom the image to fit the current size of the Canvas window. For 
example, if you’ve magnified the Canvas image to 800 percent but the Canvas window is 
only 320 x 240 pixels in size, you’ll only see a fraction of your image. When you choose Fit 
All, your image adjusts to match the size of the Canvas window. The Viewer’s image size 
isn’t affected by this change.

Distort toolCrop tool
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m choose Show as Sq. Pixels to display the image in simulated square pixels. The way 
standard definition (SD) video equipment and computer monitors display video are quite 
different. SD video equipment displays video using non-square pixels, whereas computer 
monitors display video with square pixels. Because of this discrepancy in the shape of the 
pixels, the same video image will look different on each kind of monitor. Final Cut Pro can 
simulate how your images will look on video using the computer’s display, so that your 
video images will all look correct as you edit. This does not permanently affect your 
picture; it’s only for display purposes.

Note:  With the Canvas selected, pressing Command-+ (plus) and Command-– (minus) 
zooms in and out of the area displayed in the Canvas, using the increments specified in the 
Zoom pop-up menu.

You can use zooming in the Canvas in one of two ways:

m By zooming in on the Canvas, you can get a more detailed look at your layers, which can 
help you make more precise positioning decisions.

m By zooming out of the Canvas and making the image smaller, it becomes easier to move 
clips out of the frame, in preparation for creating keyframed motion from the outside of 
the frame to the inside.

Warning  Clips will not play back smoothly if you zoom in to the point that part of the 
image is obscured, and you see scroll bars to the right and below the Viewer window. 
Other windows blocking the Viewer will also affect playback.
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Working With Wireframe Handles in the Canvas

In the previous section, you learned how to change a clip’s default parameters by modifying 
them in the Motion tab of the Viewer. In many instances, you may find that dragging the 
handles of a selected clip in the Canvas is faster and more intuitive than adjusting those same 
parameters in the Motion tab.

All of these examples assume that you are in either Image+Wireframe or Wireframe mode.

To scale a clip by dragging:

1 Select a clip in the Timeline.

2 Select the Selection tool in the Tool palette and do one of the following:

m To scale both dimensions proportionally, drag a corner handle.
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m To scale either dimension disproportionately, Shift-drag a corner handle.

m To scale and rotate the clip simultaneously, Command-drag a corner handle.
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To move a clip by dragging:

1 Select a clip in the Timeline.

2 Select the Selection tool in the Tool palette and drag the layer to a new position.

Note:  You can move a clip partially or completely outside the Canvas.

To rotate a clip by dragging:

1 Select a clip in the Timeline.

2 Select the Selection tool in the Tool palette and drag any edge of the selected clip’s border in 
an arc around the clip’s center point. 
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m The farther away you drag from the clip’s center point, the more precise control you have 
over the rotation. 

m To constrain the rotation of a clip to 45-degree increments, hold down the Shift key. 

m Dragging around a clip continuously will increase the total number of rotations to be 
performed, if you’re creating keyframed movement.

m To scale and rotate a clip simultaneously in the Canvas, Option-drag a clip’s corner handle 
in Wireframe mode.

To distort the shape of a clip:

1 Select a clip in the Timeline.

2 Select the Distort tool in the Tool palette and drag a corner handle of the wireframed clip. 
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Note:  Hold the Shift key down while dragging to shorten one side and lengthen the other 
side of your image, changing all four points simultaneously and giving the appearance of a 
change in perspective.

To crop a clip by dragging:

1 Select a clip in the Timeline.

2 Select the Crop tool in the Tool palette and do one of the following:

m Drag from one of the edges of the clip to crop in on that side.
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m Drag from one of the corners of the wireframe to crop in using the entire rectangle 
defined by that corner and the opposite corner of the wireframe.

m Press Shift while dragging a corner to constrain the rectangle’s aspect ratio.

m Press Option while dragging to move the clip symmetrically while cropping. 
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Using Wireframe Handles in the Canvas

In this example, we’ll show you how to put a graphic on the side of a building as if it were a 
sign. You’ll use the Scale, Center, and Distort parameters to match the perspective of the 
building with the perspective of the sign, using the Selection and Distort tools to manipulate 
the graphic directly in the Canvas. This example will use a sequence created for DV clips, 
with a frame size of 720 x 480.

1 Edit a shot of a building into track V1 of your sequence. In this example, the clip is a locked-
down shot of a building from a 3/4 angle (a locked-down shot is one where the camera does 
not move).
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2 Import a PICT file of a sign into your project. When you open it in the Viewer in preparation 
for editing, it looks something like this.

3 Place the Canvas or Timeline playhead over the clip you just edited into track V1, press the X 
key to mark In and Out points in your sequence using the duration of the clip in track V1, 
and perform a superimpose edit to superimpose the sign into track V2 for the duration of 
the shot.
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4 Now, instead of opening the sign graphic in the Viewer to change its settings in the Motion 
tab, simply select it in the Timeline.

5 Choose Image+Wireframe from the View pop-up menu of the Canvas. The selected layer in 
track V2 should be outlined in turquoise.
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6 With the Selection tool chosen, hold the Shift key down and drag one of the corners of the 
sign graphic to change its scale to match that of the building.
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7 Now, with the Selection tool, drag the sign graphic’s center point to move it so that its 
position matches that of the wall.
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8 Select the Distort tool in the Tool palette. Drag each of the four corners of the sign graphic 
until it appears to match the perspective of the side of the building.

It’s that simple. Using the Selection, Crop, and Distort tools, you can manipulate your clips 
directly in the Canvas to quickly create any sort of composite you like.
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Animating Visual Effects Using Keyframes
Until now, changes we’ve made to the opacity, position, or any other of a clip’s motion 
settings have been applied to the entire clip, with the result being a static change to that 
clip’s geometry.

All of these effects can be dynamically changed over the course of your sequence, however, 
to create many different kinds of animated effects. This is done using keyframes.

Keyframes are used throughout Final Cut Pro for any feature with parameters you can change 
over time. All the effects shown in this chapter can use keyframes to create sophisticated 
motion and transparency effects. In addition to motion parameters, however, there are many 
other clip properties and effects that can be keyframed as well. Things that can be keyframed 
include

m opacity

m motion settings

m volume level

m pan/spread

m generator controls 

m filters

Note:  Keyframes for transparency and keyframes for volume are the only ones that can be 
added, modified, and deleted directly in the Timeline.

How Keyframing Works

When you use two or more keyframes to create a change in an effect over time, Final Cut Pro 
automatically interpolates the values in between one keyframe and the next, so that there’s a 
smooth change in that parameter over time.

For example, when you look at the overlay of a clip with a change in opacity using two 
keyframes, you can see the gradual change from one keyframe to another in the slope of the 
overlay:
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This makes it easy to create animated motion, for example, as you only have to create two 
keyframes to move a clip from one part of the screen to another. Adding additional keyframes 
will simply add to the complexity of the animated effect, but the area in between each pair of 
keyframes in your clip will be smoothly interpolated:

Keyframing Controls in Final Cut Pro

Three tools in the Tool palette allow you to work with keyframes on an overlay.

m Pen:  Allows you to add keyframes to a parameter overlay by clicking it (press the P key).

m Pen Delete:  Allows you to delete a keyframe from an overlay by clicking the keyframe 
itself (press the P key twice).

m Pen Smooth:  Allows you to smooth a keyframe on an overlay by clicking the keyframe 
itself (press the P key three times).

Pen Smooth toolPen tool

Pen Delete tool
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Keyframing Controls in Viewer Tabs

Each motion, filter, and generator clip parameter has its own individual settings and controls. 
Each one, however, shares exactly the same keyframing controls: 

m Keyframe buttons:  When clicked, keyframe buttons place keyframes on the 
corresponding overlay at the current playhead location along the ruler in the keyframe 
graph, in preparation for creating a dynamic change in an effect.

When the playhead in the keyframe graph area of the Viewer is directly on top of a 
keyframe, the keyframe button for that parameter will be highlighted with a green 
diamond.

Pen Tool Keyboard Modifiers

To use the Pen tool quickly, you can use these keyboard modifiers:

m Press the Option key while the Selection tool is chosen to temporarily enable the 
Pen tool, then click any overlay in either a keyframe graph area or in the Timeline 
to add a keyframe at that point. 

m Hold down the Option key and click an existing keyframe to remove the keyframe 
with the Pen Delete tool.

m Control-click a keyframe and choose Smooth from the shortcut menu to add Bezier 
handles to the keyframe.

Opacity reset button

Center button adds a 
keyframe; arrow on 
each side moves the 
playhead to the 
next keyframe.

Keyframe graph area
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m Keyframe navigation buttons:  These buttons, to the left and the right of the keyframe 
button, allow you to move the playhead left or right from one keyframe on the 
corresponding overlay to the next.

m Reset buttons:  These buttons delete all marked keyframes for the corresponding 
parameter or parameters, and resets them to their default value.

m Keyframe graph:  The keyframe graph shows all of the overlays and keyframes associated 
with the parameters currently displayed in the Viewer. 

m Keyframe graph ruler:  The keyframe graph has a ruler that corresponds to either the 
duration of the clip, or the location of a clip in a sequence:

m If a clip is opened in the Viewer from the Browser, the keyframe ruler shows the 
duration of the clip itself. The playhead in the Viewer will move independently of the 
playhead in the Timeline or Canvas.

m If a clip is opened in the Viewer from a sequence in the Timeline, the keyframe ruler 
shows the section of the Timeline that the clip is edited into, and the playhead in the 
Viewer is locked to the playhead in the Timeline and the Canvas.

m Zoom control:  This control lets you zoom in and out on the duration displayed by the 
ruler in the keyframe graph area, expanding and contracting the keyframe graph ruler as 
you do so. Using the Zoom control will keep the area of the keyframe graph that was 
visible when you clicked the control centered as you zoom in or out.

Using the zoom keyboard shortcuts will result in a slightly different behavior. Pressing 
Command-+ (plus) or Command-– (minus) will zoom in or out of the duration 
displayed by the keyframe graph area, with the view centered on the current position of 
the playhead.

m Zoom slider:  Like the zoom control, this also allows you to zoom in and out of the 
duration displayed by the keyframe graph ruler. Dragging the thumb tabs on either side 
zooms in or out, moving its visible area in the direction in which you’re dragging. Pressing 
the Shift key and dragging one of these thumb tabs zooms both thumb tabs, and leaves 
the visible area centered.

Once you’ve zoomed into the keyframe graph ruler, this control also allows you to scroll 
along the entire duration of your clip by dragging the center of this slider to the left or to 
the right. 

m Timecode navigation field:  This field displays the position of the playhead in the 
keyframe graph area. You can enter a new timecode value to move the playhead to 
another time.

m Section of clip currently used:  The frames of a clip in the Viewer that are outside the 
duration specified by its In and Out points are dimmed. This is done so that you know 
where to apply your keyframes.
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Using Zoom Controls in a Keyframe Graph

For a more detailed view of the keyframes you’re setting and adjusting in the keyframe graph, 
you can use the following zoom controls and commands:

To zoom in and out of the keyframe graph using the Zoom slider:

m Drag the thumb tabs on the left and right sides of the Zoom slider to zoom in or out of 
the keyframe graph from the selected end of the Zoom slider while keeping the other end 
locked in place. This will also move the visible area of the keyframe graph in the direction 
you’re dragging.

m Holding down the Shift key while you drag one of the thumb tabs adjusts both ends of 
your view at the same time, leaving the visible area of the keyframe graph centered.

m Click or drag the Zoom control to change the keyframe graph to a different time scale 
while keeping the current area of the keyframe graph centered. Clicking to the right of 
this control will zoom out on the keyframe graph to show more of the duration of your 
sequence, while clicking the left side will zoom in to show more detail.

Zoom control
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To zoom in and out of the keyframe graph using the keyboard:

1 With the keyframe graph selected, place the playhead at the position in the keyframe graph 
where you want the center of your zooming to occur, or select one or more clips in the 
keyframe graph that you want to be centered as you zoom in or out.

2 Do one of the following:

m Press Command-+ (plus) to zoom in on the keyframe graph. 

m Press Command-– (minus) to zoom out of the keyframe graph.

Zooming in and out of the Timeline using the keyboard commands keeps the visible area of 
the Timeline centered on either the position of any currently selected clips or the current 
position of the playhead (if no clips are selected).

To zoom in and out of the keyframe graph using the zoom tools:

1 Select the Zoom In or Zoom Out tool.

2 Do one of the following:

m Click in the keyframe graph. 

m Drag to select a region to zoom in or out on. As you drag, the view will automatically snap 
to the percentages of zoom in the keyframe graph.

m Click or drag repeatedly to increase the zoom factor. When the keyframe graph is zoomed 
in or out to the maximum level possible, the + and – signs on the zoom tools disappear.

Note:  Pressing the Option key with either the Zoom In or Zoom Out tool selected will 
temporarily change it to the opposite tool.
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Creating, Modifying, and Deleting Keyframes

Until you create at least one keyframe on an effects parameter of your clip, changes you make 
to that parameter affect the entire clip. You need to have at least two keyframes to do 
anything useful, but once you set the first keyframe for any parameter, any subsequent 
changes you make to that parameter anywhere else in that clip will generate additional 
keyframes automatically.

To set a keyframe:

1 Move the playhead in the appropriate tab of the Viewer to the time where you want to put a 
keyframe.

2 Do one of the following:

m Click the Keyframe button for that parameter.
  Compositing, Applying Motion Effects, and Using Keyframes 987



m Click the Add Keyframe button in the Video tab of the Viewer or the Canvas to set 
keyframes for all of the selected clip’s motion settings at once.

m Control-click the Add Keyframe button in the Video tab of the Viewer or the Canvas to set 
a keyframe for a single motion parameter in the pop-up menu. 

The keyframe appears as a small diamond in the keyframe graph.

Add Keyframe button
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To set a keyframe using the Pen tool:

m Select the Pen tool in the Tool palette (the P key), and click a parameter’s overlay in the 
appropriate tab of the Viewer to add a keyframe at that point.

m Hold down the Option key and move the pointer over the overlay of the parameter you 
want to adjust so it turns into a Pen tool. Click an overlay with the Pen tool to add a 
keyframe to the overlay at that point. This is also a good way to create keyframes directly 
in the opacity and level overlays of a clip in the Timeline.

Note:  For some effects, you’ll need to click the disclosure triangle for the effect to access its 
overlay.

To set additional keyframes:

1 Move the playhead to another point in your clip where you want to set a keyframe.

2 Do one of the following:

m Drag the appropriate parameter control to set a new keyframe with that value.

m Type a number in the appropriate number field to set a new keyframe with that value.

m Click a parameter’s Keyframe button to add a keyframe to that parameter’s overlay at the 
overlay’s current value.

m Hold down the Option key and click anywhere on an overlay with the Pen tool to add a 
keyframe at that point, without changing the value of the overlay. You can add as many 
keyframes as you want by clicking repeatedly with the Option key held down.

The keyframe appears as a small diamond in the keyframe graph.

To move the playhead from one keyframe to another:

m Click the left and right keyframe navigation buttons for the appropriate parameter to 
move the playhead to the next keyframe on that parameter’s overlay to the left or right of 
the current position of the playhead.

m Press Option-K to move the playhead to the next keyframe to the left of the playhead’s 
current position.

m Press Shift-K to move the playhead to the next keyframe to the right of the playhead’s 
current position.

To adjust the value of a single keyframe:

m Move the playhead to the position of the keyframe you want to adjust, and drag the 
appropriate parameter control to a new value.

m Move the playhead to the position of the keyframe you want to adjust, type a new value in 
the appropriate parameter’s number field, and press the Return key.

m Move the pointer over the keyframe you want to modify on a parameter overlay. When it 
becomes a crosshair pointer, drag the keyframe you want to modify.
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m Dragging a keyframe up will raise that keyframe’s value; dragging down will lower it. As 
you drag, a box shows the new value of the keyframe.

To adjust a section of an overlay in the middle of four keyframes:

m If you have four keyframes set on an overlay of a clip, move the pointer over this section 
of overlay, and when it turns into the Adjust Line Segment pointer, drag that area up or 
down to modify it. The rest of the overlay before and after these four keyframes will 
remain untouched. 
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To adjust the level of the entire overlay with all keyframes simultaneously:

1 Press and hold the Shift key down.

2 Place the pointer over the parameter overlay you want to modify so that it turns into the 
Adjust Line Segment pointer. 

3 Drag the overlay up and down to change the value of the selected overlay. As you drag, a box 
displays the new values of the selected overlay.

As long as the Shift key is held down while you drag, that parameter’s entire overlay will 
move up and down, along with all the keyframes on that overlay. This will change the values 
for that parameter over the course of your entire clip, keeping the shape of the overlay and 
the levels of the different keyframes relative to one another intact.

To move a keyframe forward or backward in time:

m Move the pointer over the keyframe you want to modify. When it becomes a crosshair 
pointer, drag the keyframe you want to modify either forward or backward along the 
overlay. 

As you do so, a box shows the timecode duration of the change you’re making.

To delete a keyframe:

m Move the playhead to the position of the keyframe you want to delete, and click the 
Keyframe button for the corresponding parameter again to remove it.

m Move the pointer over the keyframe you want to delete. When it becomes a crosshair 
pointer, drag the keyframe you want to delete up or down out of the keyframe graph area. 
When the pointer turns into a small trash can, release the mouse button.

m With the Option key held down, move the pointer over an existing keyframe to change 
the pointer into the Pen Delete tool. Click an existing keyframe with the Pen Delete tool 
to delete that keyframe.

Note:  This is also a good way to delete keyframes directly in the opacity and level 
overlays of a clip in the Timeline.

m Control-click the keyframe you want to delete, then choose Clear from the shortcut menu.
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To delete all of a parameter’s keyframes:

m Press the Reset button that corresponds to the parameter with keyframes you want to 
clear.

Smoothing Keyframes With Bezier Handles

Some motion settings and filter controls (but not audio volume levels) allow you to apply 
smoothing to keyframes. When you apply smoothing to a keyframe, a Bezier handle is 
attached to it, which allows you to manipulate the velocity of change that takes place from 
one keyframe to the next.

That is not to say that this will cause the effect to occur faster or more slowly. The overall 
speed of an effect is determined solely by the distance on the Timeline from one keyframe to 
the next. For example, if you space two rotate keyframes two seconds apart, the resulting 
motion in your sequence will last two seconds.

The closer two keyframes are together, the faster the change will be. The farther they are 
apart, the slower the change will be.

If you apply smoothing to the same keyframe:

The total duration of the rotation will remain two seconds, but the rate at which the clip 
appears to accelerate up to full speed and then slow down to a stop will be different over the 
course of those two seconds.

Smoothed keyframes with Bezier handles change the acceleration and deceleration of a 
parameter’s change from one keyframe’s value to the next, according to the curve defined by 
the Bezier handle.
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One-Dimensional and Two-Dimensional Keyframes

Whether or not you can apply smoothing to an effect parameter in Final Cut Pro depends on 
what kinds of keyframes it uses. There are two kinds of keyframes in Final Cut Pro:

m One-dimensional keyframes:  Effects parameters that contain multiple values, like the X 
and Y values of Center and Anchor Point, or the multiple values of the Color parameter 
for the Drop Shadow, cannot be represented by an overlay in the keyframe graph. As a 
result, only the values of these keyframes can be modified, and not their velocity.

m Two-dimensional keyframes:  Effects parameters that contain a single value, like scale or 
rotation, can be animated with two-dimensional keyframes. Parameters that use two-
dimensional keyframes have corresponding overlays in the keyframe graph of the 
appropriate Viewer tab. This means that in addition to modifying their values, keyframes 
in these overlays can be smoothed, using Bezier handles to modify their rate of change.

Understanding Bezier Handles

When adjusting the Bezier handles that are attached to a smoothed clip, there are several 
kinds of curves you can create, all of which will result in different velocity curves.

The important thing to remember about Bezier curves applied to a keyframe is that the 
steeper the curve of the overlay, the faster the rate of change. The shallower the curve of the 
overlay, the slower the rate of change.

The kinds of curves you can apply to a keyframe depend on that keyframe’s location relative 
to other keyframes on that overlay.

m The beginning and ending keyframes on the outside of a group of keyframes will have 
one-sided Bezier handles. Since these keyframes begin and end any dynamic changes in a 
clip’s parameters, all they do is to accelerate into a change and decelerate out of it.

m Keyframes in between these outside keyframes have two-sided Bezier handles. These 
handles are normally locked together, so that an overlay curve will have a smooth 
transition into and out of the keyframe, with no sudden changes.
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A change to one of these handles will result in an equal change to both sides of the clip. 
For example, lengthening one of the handles will automatically lengthen the other.

Likewise, raising the height of the overlay curve on one side of the keyframe will lower it 
on the other, like a seesaw.

The link between these two handles can be suspended, however, to create different kinds 
of sudden changes in the overlay.

How to Work With Smoothed Keyframes

To smooth a keyframe, adding a Bezier handle to it:

m Control-click the keyframe and choose Smooth from the shortcut menu. Smoothing a 
keyframe makes its change from one value to another more gradual by applying a curve to 
the overlay.

To adjust a Bezier curve:

m Drag a Bezier handle to change the shape of its curve. 

m Holding down the Shift key lets you resize one side of a Bezier curve independently of the 
other. Releasing the Shift key will then lock the relative length of the two handles back 
together using the new unequal lengths you set.

m Holding down the Command key allows you to change the angle between one side of a 
Bezier curve and the other. Release the Command key locks the new relative angle of the 
two handles back together.
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m Holding down the Command and Shift keys at the same time allows you to change the 
lengths and the angle of the selected Bezier handle independently of the other, both at 
the same time.

Using Keyframes to Change Parameters

How extensive changes to keyframed effects applied to your clips will be depends on the 
number of keyframes that you add.

You need at least two keyframes to make any dynamic change from one value in an effects 
parameter to another in your clip.

In the example shown above, the size of the clip to the left of these keyframes is 25 percent, 
and the rest of the clip to the right of these keyframes is 75 percent. This is the simplest 
change you can make to create motion.

A more sophisticated change in levels (for example, creating motion by creating center 
keyframes for a video clip) requires three keyframes:
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In the example above, the position of the clip starts at the location specified by the first 
keyframe, then moves to the position specified by the second keyframe, and continues on its 
journey until it reaches the position specified by the third keyframe.

Note:  More information about creating motion paths in the Canvas can be found in 
“Creating Keyframed Motion Paths in the Canvas” on page 1003.

If you need to isolate a keyframe change to only a certain section of the entire overlay for 
that effect, you need at least four keyframes to do so. For example, if you have a 
superimposed clip that’s set to be at 50 percent opacity for the duration of the clip, but you 
need it to go to 100 percent for three seconds right in the middle of the clip because of a key 
action in the clip, you would create the following keyframes on that clip’s opacity overlay:

As a result of this keyframe, the opacity level of the clip will start at 50 percent, will then jump 
to 100 percent for the duration the keyframes specify, and will then drop back to 50 percent 
for the remaining duration of the clip.

Keyframe 2

Keyframe 1

Keyframe 3
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Practical Examples of Keyframing

In our first example, we’ll layer two clips together. The topmost clip will fade in, be 
superimposed for a few seconds, then will fade up to nearly obscure the underlying image 
before fading away completely. This illustrates Final Cut Pro’s ability to dynamically adjust 
opacity over time to create sophisticated multilayered effects.

To use keyframes to adjust a clip’s opacity over time in the Motion tab 
of the Viewer:

1 Edit two clips into your sequence of equal duration. Layer them so that one is in track V1, 
and the other is superimposed on track V2.

2 Open the clip on track V2 in the Viewer, and select the Motion tab.

3 Click the disclosure triangle for the Opacity parameter to reveal its overlay in the keyframe 
graph.

4 To adjust the opacity of the entire clip, do one of the following:

m Drag the Opacity slider to the left until the value in the number field reads 50.

m Type 50 in the Opacity number field, and press Return.

m Move the pointer over the opacity overlay in the keyframe graph area, and when it turns 
into the Adjust Line Segment pointer, drag it down until the value in the number field 
reads 50.
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The image in the Canvas should now be of both layers blended together.

5 Move the playhead so that it is at 01:00:02:00 by entering this value in the current timecode 
field of the Viewer.

6 Now, create a keyframe at the position of the playhead by clicking the Opacity keyframe 
button.

7 Since it takes at least two keyframes to create a dynamic change to a parameter over time, 
move the playhead to 01:00:03;00 on the Timeline and create another keyframe.
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8 Now move the pointer to the opacity overlay segment located to the left of the two 
keyframes we’ve just created. When it turns into the Adjust Line Segment pointer, drag it 
down until the number field reads 0. The opacity overlay in the keyframe graph should look 
like this:

The shape we’ve given to the overlay will now result in the top layer being completely 
invisible for the first two seconds of playback, then over the course of the next two seconds it 
will fade up until it reaches a total opacity of 50 percent, which will look like an even mix of 
both layers.

9 Move the playhead to 01:00:04:00 and add another opacity keyframe.

Segment at 50 percent 
opacity results in even 
mix of both layers.

Ramp shows fade up 
to top layer.

Zero percent segment
results in top layer

being invisible.
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10 Since you can’t move this keyframe without causing a ramp in the overlay segment, you’ll 
need to move the playhead again to 01:00:05:00, adding one more keyframe. Adjust the value 
of this last keyframe so that it’s at 90 percent.

The overlay shape will leave the opacity of the top layer at 50 percent for four seconds, and 
then the topmost layer will fade up, obscuring the clip on track V1, but not completely.

11 To complete this sequence, we’ll fade the topmost layer out again by adding one last 
keyframe at 01:00:06:00, and changing its value to 0.

The above example can also be done using the opacity overlay in the Timeline. This time, 
we’ll examine the fastest way to recreate the overlay shape we created above.
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To set keyframes to adjust a clip’s opacity over time using the opacity overlay 
in the Timeline:

1 Edit two clips of equal duration into your sequence. Layer them so that one is in track V1, 
and the other is superimposed on track V2.

2 Click the Clip Overlays control in the Timeline to display the opacity and level overlays of 
each clip in your sequence.

3 Move the pointer over the opacity overlay (located directly on top of the video item on track 
V2). When it turns into the Adjust Line Segment pointer, drag the entire overlay down so that 
it’s at 50 percent. A box displays the value of the Opacity parameter as you adjust it. 

Note:  If you’re having problems getting the value of the overlay to be exactly 50, hold the 
Command key down while you’re dragging to gear down the ratio between the movement of 
your mouse and the change of the opacity parameter, enabling you to adjust the overlay 
more precisely.

4 Now, use a shortcut to create all of the keyframes you need on the overlay at once. Hold the 
Option key down while you move the pointer on top of the opacity overlay on the clip in 
track V2. When it turns into the Pen tool, click the overlay to create five keyframes at 
01:00:02:00, 01:00:03:00, 01:00:04:00, 01:00:05:00, and 01:00:06:00 on the Timeline. 
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If you’re having trouble creating the keyframes at exactly the times you want, try zooming in 
on your clip in the Timeline using one of the zoom controls, or by pressing Command-+ 
(plus) to zoom in on the location of the playhead.

5 Now, to finish the job, all you need to do is to let go of the Option key and drag each of the 
opacity overlay segments between keyframes, or drag the keyframes themselves up or down 
to the values you want.

m To adjust an overlay segment using the Selection tool, move the mouse so that it’s directly 
over an overlay segment. When it turns into the Adjust Line Segment pointer, drag it up 
or down.

m To adjust a keyframe using the Selection tool, move the pointer so that it’s directly over a 
keyframe. When it turns into a crosshair pointer, drag the keyframe up or down.
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Creating Keyframed Motion Paths in the Canvas

You can create motion for a clip by repositioning it (using either the point control or by 
typing a value in the number field in that clip’s Motion tab), and setting keyframes and to 
change the clip’s center parameter over time. By setting enough keyframes, you’ll eventually 
be able to create the motion path you want using this method.

An easier method, however, which can produce more sophisticated results, is to set up your 
clip motion in the Canvas when in Image+Wireframe or Wireframe mode using a clip’s 
motion path. Once you set the first center keyframe for a clip in its Motion tab, all 
subsequent changes made to that clip at different points in time will introduce additional 
center keyframes. When you create two or more center keyframes, they’ll appear in the 
Canvas along a line called the motion path.

The simplest motion path is a straight line defined by two center keyframes. Once the first 
keyframe is defined in the Motion tab, any time you move the Canvas or Timeline playhead 
to another time and then move that clip’s wireframe somewhere else in the Canvas, another 
keyframe will be created automatically. 

For example, you define a center keyframe for a video clip at –160,100. You then move the 
playhead three seconds later in your sequence, and drag the clip by its center point to 160, 
–100. The result will be a diagonal motion path moving from the lower-left corner of the 
Canvas to the upper-right corner.

A simple motion path 
resulting from two 
center keyframes
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When your sequence plays, the clip will move along this path, with its anchor point following 
the motion path exactly. As you add additional keyframes, you can create more complex 
paths. For example, with the motion path above already defined, you move the playhead to a 
time in between these two keyframes. To move the playhead relative to these keyframes, you 
can view your clip’s keyframes in the Motion tab of the Viewer. To view these keyframes 
underneath your clips in the Timeline, you can enable the Clip Keyframes control as well. 
With the playhead in between these two keyframes, moving the clip to –90, –90 will add a 
third keyframe to this motion path:
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In this way, we can create as many keyframes as we like, changing the shape of the motion 
path accordingly:
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To create a motion path:

1 Open the clip you want to animate in the Viewer, and select the Motion tab.

2 Choose a wireframe view from the View pop-up menu in the Canvas.

3 Move the playhead in the Viewer, the Canvas, or the Timeline to the point on the Timeline 
where you want to begin that clip’s motion, as this is where you’ll set your first keyframe. 

Note:  Since all three playheads are locked together when you open a clip from your 
sequence in the Viewer, it doesn’t matter which one you use.

4 Position the clip in the Canvas at the starting point of the motion path you want to create by 
dragging on its center point in the Canvas with the Selection tool.
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5 To add a keyframe, do one of the following:

m Control-click the Add Keyframe button at the bottom of the Canvas or the Viewer, and 
choose Center from the shortcut menu. If you simply click the Add Keyframe button, 
you’ll create keyframes for all of that clip’s motion settings.

m In the Motion tab for that clip, display the Center parameter and click its Keyframe 
button.

6 Now, move the playhead to where you want to add your next keyframe.
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7 Use the Selection tool to drag the clip to the next desired position in the Canvas.

Final Cut Pro automatically adds a new keyframe, and creates the desired motion path in the 
Canvas. Repeat steps 5 and 6 to add as many keyframes as you want.

Adding, Moving, and Deleting Keyframes From Motion Paths

You can edit a motion path directly in the Canvas by adding, dragging, or deleting motion-
path keyframes. The playhead doesn’t need to be over a keyframe for you to be able to move 
or delete it, nor does the playhead location prohibit you from adding additional motion-path 
keyframes using the Pen tool.

To add a keyframe to a motion path without moving the playhead:

m Select the Pen tool (the P key) and click anywhere on a motion path to create a new 
keyframe.

m With the Selection tool chosen, hold down the Option key while clicking a motion path to 
temporarily select the Pen tool and create a new keyframe.

To move a keyframe in a motion path without moving the playhead:

m Using the Selection tool, drag a motion path keyframe anywhere within the Canvas.

Note:  You can drag a motion path keyframe outside of the visible area of the Canvas to 
move the clip offscreen. Zoom out of the Canvas to shrink the viewable area in order to make 
this easier.
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To delete a keyframe in a motion path without moving the playhead:

m Clicking an existing keyframe with the Option key held down will result in that keyframe 
being removed with the Pen Delete tool.

m Control-click any keyframe and choose Delete from the shortcut menu.

Creating Motion Paths Using Bezier Curves

So far, all of the motion paths we’ve created have been sharp and angular. Whenever you add 
a keyframe to a motion path, it is a corner point by default. You can change this using the Pen 
Smooth tool to add Bezier handles to these points to change them into curves, which the 
anchor point of the clip will follow.

For example, if you create a motion path with four keyframes, by default all of its keyframes 
will be corner points:
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If you add Bezier handles to them, the motion path will look much different:

Bezier handles in the Canvas work in exactly the same way as they do for keyframes in the 
Motion tab, except that they affect the spatial motion of the clip, rather than the velocity of 
the clip’s change over time. To change the acceleration or deceleration of a clip’s motion 
between two keyframes, you still need to create separate Bezier handles in the center overlay 
in the Motion tab.

Note:  When you use Bezier points to create curved motion paths in the Canvas, you won’t 
need to use as many keyframes to define complex motion paths.

To add Bezier handles to a keyframe:

m Control-click a keyframe in the Viewer and choose Ease In/Ease Out or Linear from the 
shortcut menu to create a Bezier handle to use to create a curved motion path (more 
information on the Ease In/Ease Out and Linear options is available in the next section).

m Choose the Pen Smooth tool (press the P key three times) and click a corner keyframe to 
make it curved. (Bezier curves created with the Pen Smooth tool automatically have their 
velocity set to Linear.)
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To remove Bezier handles from a keyframe:

m Control-click a keyframe in the Viewer and choose Make Corner Point from the shortcut 
menu.

m Choose the Pen Smooth tool (press the P key three times) and click a curved keyframe to 
make it a corner.

To create even more complex motion paths, you can use modifier keys to adjust the Bezier 
handles to each side of a keyframe independently of one another:

To adjust Bezier curves:

m Drag a Bezier handle to change the shape of its curve. 

m Hold down the Shift key to resize one side of a Bezier curve independently of the other. 
Release the Shift key to lock the relative length of the two handles back together using 
the new unequal lengths you set.
  Compositing, Applying Motion Effects, and Using Keyframes 1011



m Hold down the Command key to change the angle between one side of a Bezier curve 
and the other. Release the Command key to lock the new relative angle of the two 
handles back together.
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m Hold down the Command and Shift keys at the same time to change the lengths and the 
angle of the selected Bezier handle independently of the other, both at the same time.

Controlling Speed Along a Motion Path

The speed at which a clip travels along a motion path is determined by two factors:

m The physical distance between two keyframes in the Canvas. The farther a clip has to 
travel in a given duration, the faster its apparent movement. The less distance a clip 
moves, given the same amount of time, the slower it appears to go.

m The distance in time between two keyframes in the center overlay of that clip’s motion 
tab. Two keyframes one second apart will result in faster motion than two keyframes four 
seconds apart.
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In addition to the simple speed of a clip, the clip’s velocity can be modified to alter the 
quality of its movement. With no velocity adjustments, clips will move at full speed or full 
stop, with no speeding up or slowing down. This can result in rather abrupt, artificial-looking 
motion. Final Cut Pro gives you the ability to change the velocity of a clip’s motion over time, 
using velocity handles to modify the keyframes of a clip’s motion path in the Canvas.

By adjusting a keyframe’s velocity in the Canvas, inertia can be added to a clip’s motion. 
Instead of taking off at full speed from a complete stop, you can adjust the first keyframe of a 
motion path so that the clip starts off slowly, and speeds up over time. These speed changes 
are indicated by velocity tics along that clip’s motion path.

When a clip’s motion along a path is fast, the tic marks are farther apart:
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When a clip’s motion along a path is slow, the tic marks are closer together:
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In both cases however, the motion is at a single constant speed. To vary the acceleration of 
this clip along its motion path, you must first turn the keyframes you want to adjust into 
curved keyframes so that you can adjust the acceleration handles that are attached to the 
keyframe’s Bezier handles.

The velocity of a clip’s motion from one keyframe to the next can be modified by dragging 
the velocity handle in and out along the Bezier handle:

Velocity handle

Velocity handle
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m Dragging in towards the selected keyframe slows down the clip’s motion at the beginning 
and speeds it up as it nears the next keyframe. 

Tic marks closer
together indicate

slower motion
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m Dragging out away from the selected keyframe speeds up the clip’s motion at the 
beginning and slows it down as it nears the next keyframe.

When you add Bezier handles to a keyframe using a shortcut menu in the Canvas, you can 
create them with two kinds of acceleration. Both the Ease In/Ease Out and Linear commands 
in the shortcut menu create Bezier handles with exactly the same controls. The difference is 
that

m Curved keyframes created using the Ease In/Ease Out command are created with the 
velocity handle set for the motion to begin slowly and speed up over time as the clip 
moves from that keyframe to the next one on the motion path.

m Curved keyframes created using the Linear command are created with the velocity handle 
set to provide a steady rate of speed as the clip moves from that keyframe to the next one 
on the motion path.

It’s important to remember that the velocity at which clips speed up into or slow down out of 
keyframed motion in the Canvas has no effect on the overall speed of the clip’s motion.

Tic marks farther apart
indicate faster motion
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Creating Motion Favorites

If there’s a particular set of keyframed motion effects that you need to use again and again, 
you can create a motion favorite. For example, if you’re working on a documentary that 
always moves a lower-third graphic with the name of the current speaker into the video 
frame along a particular motion path, you can save this motion path as a favorite so that you 
can apply it to all of the lower-third titles in your project without having to recreate it from 
scratch every time.

To create a motion favorite:

1 Select a clip in the Timeline that has a series of motion effects keyframes that you want to use 
as a favorite. This clip can have as many keyframes in as many motion parameters as you 
want.

2 Choose Make Favorite Motion (Command-F) from the Modify menu.

All keyframed motion effects from that clip will be saved as a motion item in the Favorites bin 
of the Effects tab in the Browser. 

By default, it will have the name of the clip the effects were copied from, but you can change 
this name to anything you want.

To change the name of a motion favorite:

1 Select the motion item in the Favorites bin of the Effects tab.

2 Click its name.

3 When its name is selected, type a new one.

4 Press the Return key.

When you apply a motion favorite to a clip in your sequence, it’s not like applying a filter. 
There is no special motion favorites object that is attached to your clip. Instead, applying a 
motion favorite applies all of the motion keyframes in that favorite to the parameters inside 
of that clip’s Motion tab. These keyframes can then be further modified at any time.
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To apply a motion favorite to a clip in your sequence:

m Select one or more clips in the Timeline, and then choose the motion favorite you want 
to apply from the Motion Favorites submenu of the Effects menu.

m Click the video Target Track control for the track with the clip you want to apply it to, and 
put the Timeline playhead directly over that clip. Choosing the motion favorite you want 
to apply from the Motion Favorites submenu of the Effects menu will not apply it to that 
clip.

m Drag a motion favorite item from the Favorites bin of the Effects tab in the Browser onto a 
clip in your sequence.

m Drag a motion favorite item from the Favorites bin of the Effects tab in the Browser onto a 
selected group of clips in your sequence.

Since motion favorites simply apply keyframes to a clip’s motion settings, to remove the 
effect from your clip you need to reset the motion parameters that were modified in that 
clip’s Motion tab. You can, however, remove unused favorites that you no longer want to 
appear in the Motion Favorites submenu.

To remove a motion favorite from the Motion Favorites submenu:

1 Select the motion effect item you want to remove in the Favorites bin of the Effects tab in the 
Browser.

2 Do one of the following:

m Press the Delete key.

m Choose Clear from the Edit menu.
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Working With Graphics Clips of Different Resolutions
If you import a graphic or still image with a frame size that doesn’t match the frame size of 
your edited sequence, you have two choices.

m You can resize the image, enlarging or reducing it to fit the frame size of your image

m You can leave it be, with the result of only being able to see a small part of it if the image is 
too big, or of the image being surrounded by black if it’s too small.

If you’ve imported a high resolution image that’s significantly larger than the frame size of 
your project, Final Cut Pro will allow you to take advantage of the image’s increased 
resolution to create sophisticated motion effects. 

Images that were scanned at high resolution, at 300 dpi for example, will look huge when 
imported into Final Cut Pro. This is because video works at a resolution of 72 dpi. As a 
result, a 300 dpi image out of Photoshop will simply look like a really big 72 dpi image in 
Final Cut Pro. 

Using High Resolution Graphics for Animation

Importing high resolution images from megapixel digital cameras and scanners can be 
extremely useful for creating motion effects. You can use keyframed motion parameters such 
as the Center, Anchor Point, and Scale parameters in that clip’s Motion tab to pan around or 
zoom in and out of a scanned map or photograph. As long as you’re using a high resolution 
image file, there will be no image degradation so long as you don’t zoom too much past 100 
percent.

Enlarging Low Resolution Graphics

If you try to enlarge an image that was originally shot on video, or a graphic that is smaller 
than the frame size of your sequence, you’ll find that scaling it up past a certain point creates 
noticeable artifacts that you may not want. This is because you’re enlarging a 72 dpi image 
larger than 100 percent.

Relative frame sizes of the 
same image at 72 dpi and 
300 dpi when imported 
into Final Cut Pro
  Compositing, Applying Motion Effects, and Using Keyframes 1021



Using the Scale to Sequence Command

If you want your imported graphic to fit entirely into your image frame, you can select the 
clip once it’s edited into your Timeline, and use the Scale to Sequence command to 
automatically set the scale of your graphic so that it fits as neatly as possible into your frame 
size.

To use scale to sequence:

1 Select a clip in your sequence to rescale.

2 Choose Scale to Sequence from the Modify menu.

If the aspect ratio of your imported graphic doesn’t match that of your edited sequence, 
you’ll end up with black borders either horizontally or vertically.

m If your graphic is wider than it is tall, then there will be black borders at the top and 
bottom of the image in the Canvas.

m If your graphic is taller than it is wide, then there will be black borders to the right and left 
of the image in the Canvas.
1022 Chapter  21   



C H A P T E R
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22 Working With Video Filters, 

Generators, and Speed Settings
You can apply filters, generator clips, and speed settings to further enhance your edited 
sequences. You can combine the compositing and motion features covered in the last 
chapter to create very sophisticated motion graphics and visual effects sequences.
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Video Filters
Final Cut Pro includes 64 video filters, grouped into 11 categories. You can use video filters to 
m Adjust a clip’s image quality

Use filters to adjust qualities of your clip, such as color, brightness and contrast, 
saturation, and sharpness. These filters allow you to compensate for mistakes in exposure 
by manipulating the color balance and exposure of clips after shooting. You can fine-tune 
the clips in your edited sequence, making sure that the color and exposure of all the clips 
in a scene match as closely as possible. You can also use image quality filters to stylize the 
clips in your project, manipulating color and exposure to create specific effects.

m Create visual effects

Use filters to create elaborate visual effects. You can apply and combine these filters to 
create effects ranging from spinning your clip in simulated 3D space to blurring, rippling, 
and flipping a clip’s image in the Canvas.

m Create and manipulate transparency effects

Use filters to create and manipulate alpha channel information for clips in your project. 
Keying filters create alpha channels based on blue, green, white, or black areas in the 
image. Other filters allow you to further manipulate the areas of transparency in a keyed 
clip, expanding, contracting, and feathering the area of transparency to fine-tune the 
effect.

Other filters generate a new alpha channel based on simple geometric shapes or apply an 
alpha channel from one clip to another. 
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These filters can be applied singly or in groups to any video clip. You can add as many filters 
as you like to a clip; the order in which they’re applied determines the final result. For 
example, if you apply a blur filter and then a pond ripple filter to a clip, the clip will be 
blurred, then the blurred image will be rippled. The result in the Canvas will look like this:

If you apply the pond ripple first and the blur second, the result in the Canvas will look like 
this:

Blurring the clip after rippling makes the ripple harder to distinguish.

Once multiple filters are applied to a clip, you can change the order in which they take effect 
in the Filters tab.
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Using the Filters Tab of the Viewer

Each filter has its own settings and controls. They all have some controls in common.

m Filter category bar:  Video filters appear at the top and audio filters at the bottom of the 
Filters tab. Click the Video Filters bar or the Audio Filters bar to select all the filters in that 
category.

m Name bar:  Each filter has a name bar that contains a disclosure triangle, on/off checkbox, 
and the filter’s name. Drag the name to change a filter’s position in the list.

m Filter start and end points:  If a filter is applied to part of a clip, filter start and end points 
appear in the clip’s keyframe graph area. For information on how to apply a filter to a 
section of a clip, see “To apply a filter to part of a clip in a sequence:” on page 1033.

m On/off checkbox:  Turn a filter on or off. When the checkbox is off, the filter will not be 
applied or rendered.

m Parameter controls:  Each filter has its own set of parameter controls. For information on 
how to adjust the controls for a filter, see “Tips for Using Filter Controls” on page 1028.

m Keyframe button:  The keyframe button places a keyframe on the corresponding overlay 
at the playhead location in the keyframe graph, in preparation for creating a dynamic 
change in an effect.

Filter category

On/off checkbox
and filter name

Timecode field

Parameter controls

Filter start and 
end points

Zoom control and slider

Keyframe graph ruler 
and graph area

Keyframe button and 
navigation buttons

Part of clip not used

Reset button
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m Keyframe navigation buttons:  These buttons jump the playhead from one keyframe to 
the next on the corresponding overlay. 

m Reset button:  This button deletes all keyframes for the corresponding parameter or 
parameters and resets those parameters to their default value.

m Keyframe graph:  The keyframe graph shows all the overlays and keyframes associated 
with the parameters displayed in the Viewer. 

m Keyframe graph ruler:  The keyframe graph ruler corresponds to either the duration of 
the clip or the location of the clip in a sequence:

m If a clip is opened in the Viewer from the Browser, the keyframe ruler shows the 
duration of the clip. The playhead in the Viewer moves independently of the playhead 
in the Timeline or Canvas.

m If a clip is opened in the Viewer from a sequence in the Timeline, the keyframe ruler 
shows the section of the Timeline that the clip is edited into. The playhead in the 
Viewer is locked to the playhead in the Timeline and Canvas.

m Zoom control:  This control zooms in and out on the duration displayed by the ruler in 
the keyframe graph area, expanding and contracting the keyframe graph ruler. 

The Zoom control changes the scale of the visible area in the keyframe graph. In contrast, 
the zoom keyboard shortcuts, Command-+ (plus) and Command-– (minus), center the 
view on the playhead’s position when zooming in or out.

m Zoom slider:  The Zoom slider zooms in and out of the duration displayed in the 
keyframe graph ruler. Dragging a thumb tab at either end zooms in or out, moving the 
visible area in the direction you drag. Shift-dragging a thumb tab zooms both tabs and 
leaves the visible area centered.

Once you’ve zoomed into the keyframe graph ruler, drag the center of the slider to the 
left or right to scroll through your clip. 

m Timecode navigation field:  This field displays the position of the playhead in the 
keyframe graph area. Entering a new timecode value moves the playhead to that time. 

m Section of clip not currently used:  The frames of a clip displayed in the Viewer’s Filters 
tab that are outside the duration specified by its In and Out points are darker gray than 
the part in use. This is done so you know where to apply keyframes.
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Tips for Using Filter Controls

Here are tips for using controls to adjust video and audio filters, motion effects, and 
generators.

m Slider:  By default, sliders only show whole integer values. Hold down the Shift key while 
dragging a slider to adjust the corresponding value to within two decimal places of 
precision. 

Hold down the Command key to gear down the slider, allowing you to make more precise 
changes to the parameter.

m Logarithmic sliders:  In a logarithmic slider, the rate of change as you move the handle 
increases faster in one part of the slider than in other parts. Final Cut Pro uses both a 
logarithmic slider, which increases change faster at one end, and a double-sided 
logarithmic slider, which increases change faster at the center and more slowly at the 
ends.

Logarithmic sliders are useful for parameters that have a huge range of possible values, 
with a particular range at the top or at the bottom being more useful than the others. The 
tic marks for logarithmic sliders are unevenly spaced. Where they’re closer together, the 
change in the parameter’s value occurs more slowly. 

m Point control:  Point controls are used to specify locations in the Canvas. Click the point 
control (a crosshair) to define a new location with X and Y coordinates. Drag into the 
Canvas and release the mouse button to select the coordinates of a pixel in the Canvas.

Logarithmic slider

Double-sided 
logarithmic slider
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If you drag instead of clicking, the values update as the crosshair moves. When you 
release the mouse button, the X and Y coordinates are selected.

All points defined in a frame are relative to the center point of the Canvas, which has the 
coordinates 0,0. 

m If a clip’s X coordinate is a positive number, it will be to the right of the center point.

m If a clip’s X coordinate is a negative number, it will be to the left.

m If a clip’s Y coordinate is a positive number, it will be to the bottom.

m If a clip’s Y coordinate is a negative number, it will be to the top.

m Angle control:  This control specifies angles and rotations. The longer, black hand of the 
dial indicates the angle. The smaller, red hand indicates how many total rotations forward 
or backward are specified.

Point control and 
coordinates

Canvas center point
(0, 0)

-360 pixels +360 pixels

-240 pixels

+240 pixels
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You can use modifier keys to help select a value. The Shift key constrains the dial to 45-
degree increments; the Command key gears down the dial’s movement for a more 
precise value. Drag all the way out of the effect parameter to reset it to 0.

m Color control:  The color control gives you several ways to select a color value. 

m A disclosure triangle displays sliders and number fields corresponding to the hue, 
saturation, and brightness of the range of colors available. Hue determines which color 
is chosen. Saturation determines how vivid the color will be. If saturation is 0, the 
resulting color is always white. Brightness determines how bright or dark the color will 
be. If brightness is 0, the resulting color is black; if brightness is 100, the color will be 
the lightest possible value.

m Click the Eyedropper button, then click an image in the Viewer or the Canvas. The 
eyedropper selects the color you click.

m If you’re keyframing changes in color, click the hue direction control to indicate the 
direction on the color wheel Final Cut Pro will use to interpolate the color change.

m Click the color picker to choose a color using the standard color picker.

Angle control

Color picker

Eyedropper

Hue, saturation, and 
brightness sliders

Hue direction control
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m Clip control:  You can use the image from one clip in a filter to change another clip. Drag 
any clip from your sequence to this control to apply it to the filter.

To clear a clip that’s currently attached, Control-click directly on the Clip control, and 
choose Clear from the shortcut menu.

m Font:  You can choose a font from the pop-up menu of fonts in your system and adjust 
size, style, color, and tracking for text. Final Cut Pro currently uses only TrueType fonts.

Clip control

Font selection and 
adjustments

Creating Filters With FXScript

All of the controls described here are available when you use FXScript to create 
custom filters. For more information, see Chapter 31, “Using FXBuilder to Create, Test, 
and Modify Effects,” on page 1225.
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Applying a Video Filter to a Clip

You can apply video filters to a single clip in a sequence or in the Browser. It’s very important 
to make a distinction between filters added to a sequence clip and filters added to a master 
clip in the Browser.

When you add filters to a sequence clip, they are applied only to that clip. The master clip in 
the Browser remains untouched.

When you add filters to a master clip in the Browser, instances of that clip already in other 
sequences are untouched. If you edit the master clip into a sequence after adding a filter in 
the Browser, the new filter is applied to the clip in the sequence.

To apply a video filter to a clip in a sequence:

m Drag a video filter from the Effects tab in the Browser to a clip in the Timeline.

m Select one or more clips in the Timeline, then drag a video filter from the Effects tab in 
the Browser to one of the selected clips to apply it to all.

m Select one or more clips in your sequence in the Timeline, then choose a video filter from 
the two Video Filters submenus of the Effects menu.
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m If your sequence clip is loaded into the Viewer, drag a filter from the Effects tab of the 
Browser directly into the Viewer, or choose a filter from the Video Filters submenu of the 
Effects menu to apply it to that clip.

You can apply a filter to an entire clip in the Timeline or just part of a clip.

To apply a filter to part of a clip in a sequence:

1 Select the Range Selection tool in the Tool palette (or press the G key three times).

2 Drag across the part of the clip you want in the Timeline.
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3 Do one of the following:

m Drag a video filter from the Effects tab in the Browser to the selected portion of your clip.

m Choose a video filter from the Video Filters submenus of the Effects menu.

The filter is applied only to the selected part of the clip. When the clip is loaded into the 
Viewer, filter start and end points appear in the keyframe graph area.

You can reposition the filter start and end points by dragging them.

If you apply more than one filter to a clip, the filters are applied sequentially. The first video 
filter is applied, then the next filter is applied, and so on.

The order in which multiple video filters to a clip appear in the Filters tab for a clip in the 
Viewer determines how that clip looks. You can drag filters to changes their order.

To apply multiple filters to a clip in your sequence:

m Apply filters to a clip one at a time, as described above.

m Shift-click or Command-click to select multiple filters in the Effects tab of the Browser and 
drag them to one or more selected clips in the Timeline.

m Select a filter in the Effects tab of the Browser, copy it, and then paste it into the Filters tab 
of a video clip in the Viewer.

m Copy filters from one clip’s Filters tab and paste them into another clip’s Filters tab, 
whether it’s a sequence clip or a master clip in the Browser.
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To use the Paste Attributes command to paste filters into a clip:

When you copy a clip from the Timeline, you also copy all of that clip’s settings. These 
settings include filters applied to that clip. Instead of pasting duplicates of the clip you’ve 
copied, you can paste only that clip’s filters into other clips by using the Paste Attributes 
command.

Warning  Pasting attributes into clips that have different frame rates will give erratic results.

1 Select a clip in the Timeline that has a filter applied to it.

2 Copy the clip.

3 Select one or more clips in the Timeline to apply the filter to.

4 Choose Paste Attributes from the Edit menu (or press Option-V ).

5 In the Paste Attributes dialog box, select the desired options:

m Scale Attribute Times:  Shrinks or stretches the keyframes of your copied clip attributes to 
fit the duration of longer clips.

m Video Attributes:  Determines which attributes of the video clip are pasted.

m Filters:  Applies the parameter values and keyframes you have set for all filters in the 
clip you copied from.

The filters are pasted onto the clips you selected.
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Displaying Filters in the Timeline

Once a filter has been applied to a clip in your sequence, you can use the Clip Keyframes 
button in the Timeline to add additional space underneath each video and audio track to 
indicate which clips have filters applied. If a filter is added to an audio or video clip in the 
Timeline, a small green bar appears in this space for the duration of that clip. If a motion 
setting is modified for a video clip in the Timeline, a small blue bar appears in this space for 
the duration of that clip.

If keyframes are added to the filter or motion settings for a clip, those keyframes appear on 
top of the bar to which they apply. Filter and motion bars can be displayed or hidden at any 
time. 

This setting is adjustable in the Timeline Options tab of the Sequence Settings window (in 
the Sequence menu).

If you use video filters, you must render the parts of the sequence to which you’ve applied 
them.

Modifying and Removing Filters

To modify filters in your sequence, you open the clip with the applied filters in the Viewer.

Note:  If you want to add or modify a filter to a clip in your sequence, make sure that your 
sequence clip is opened into the Viewer, rather than the master clip from the Browser.

To open a clip with filters into the Viewer:

m If your sequence clip is already open in the Viewer, click the Filters tab.

m Double-click the filter bar in the keyframes area of an item in a video track of the 
Timeline. The clip is opened in the Viewer with the Filters tab open.

m If a sequence clip is already open in the Viewer with the Filters tab open and you open 
another sequence clip, the new clip appears with the Filters tab open as well.

Clip Keyframes button

Filter indicators for 
stereo tracks
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You make adjustments to the individual parameters of filters in the Filters tab of the Viewer. 
See “Tips for Using Filter Controls” on page 1028 for some information on how to use the 
controls. Some guidelines for using Final Cut Pro’s filters appear in “Final Cut Pro’s Video 
Filters” on page 1041.

You can turn a filter on or off without removing it from a clip, rearrange the order in which 
filters appear to modify how they work together, and remove filters from your clip entirely.

To turn individual filters on or off:

m Click the checkbox by the filter’s name. This is useful for previewing different 
combinations of filters in a clip without having to repeatedly apply and delete the same 
filters.

To rearrange the order of filters in the Filters tab:

m Drag a filter up or down in the list to change the order in which filters are applied.

Note:  Rearranging filters may be easier if you collapse the filters’ settings before 
dragging. Click the small disclosure triangle to the left of the filter’s name.

To change a filter’s start and end points:

m Select the start or end point in the keyframe graph area and drag it to a new time.

To remove a filter from a clip:

m Select the filter in the Filters tab and press Delete.

m Select the filter and choose Clear from the Edit menu.
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m Select the filter and choose Cut from the Edit menu or Control-click a filter and choose 
Cut from the shortcut menu.

m To remove all of a clip’s video filters, click the Video filters category bar in the Filters tab. 
Then press Delete or choose Clear from the Edit menu.

Saving a Filter as a Favorite

You can save a video filter with specific parameters as a favorite so you can use it again.

To make a filter a favorite, do one of the following:

m Drag the filter from the Filters tab of the Viewer to the Favorites bin in the Browser.

m Select the filtered clip in the Timeline and choose Make Favorite Effect from the Modify 
menu (or press Option-F).

To use favorites:

You can apply favorites in exactly the same way as any other filter. Favorite video filters 
appear in the Favorites bin in the Effects tab of the Browser and in the Favorites submenu in 
the Effects menu.
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To delete a clip saved as a favorite:

1 Select the filter in the Favorites bin of the Effects tab in the Browser.

2 Do one of the following:

m Press Delete.

m Choose Clear from the Edit menu.

Keyframing Video Filters

Like most effects in Final Cut Pro, filters can be keyframed to change their effect on a clip 
over time. Keyframing filters works the same way as keyframing motion settings. For more 
information, see “Animating Visual Effects Using Keyframes” on page 981.
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Nesting Clips With Filters to Minimize Rerendering

Nesting a clip with filters treats that clip as a subsequence. This maintains the link to its 
render files even if you move or change the clip later.

To nest a filtered clip or group of clips:

1 In the Timeline, select the clip or clips you want to nest.

2 Choose Nest Item(s) from the Sequence menu (or press Option-C).

3 Type a name for the nested sequence.

4 Choose a frame size from the pop-up menu, if desired.

5 Click “Keep Effects, Markers, and Audio Levels with Clip.”

6 Click the Mixdown Audio checkbox, if it’s available, for clips with audio.

7 Click OK.

The clips you selected are replaced with a nested sequence. A new sequence with the name 
you specified appears in the Browser; your original sequence clips are in that sequence. 
Changes that you make to the nested sequence will not affect the render files located in that 
sequence in the Browser.

Selected clips to nest Nested sequence
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Final Cut Pro’s Video Filters
Blur filters are commonly used to make stylized background graphics out of video clips in 
your project. With enough blur applied, you can turn almost any video image into a stylized 
blend of colors and shapes.

Border filters create borders using the total frame size of your clips.

Blur

Gaussian Blur Blurs the entire frame of a clip. A pop-up menu allows you to choose 
which channel to blur. You can blur one or all of the color and alpha 
channels together or separately. A radius slider allows you to select how 
much to blur the clip.

Radial Blur Creates the illusion that the image is spinning about a center point. An 
angle control allows you to adjust the maximum amount of blur. A steps 
slider determines how smooth the blur appears. You can also specify the 
center point in the frame about which the blur rotates. 

Wind Blur Creates the illusion that the image is moving in a linear direction. You can 
adjust the direction in which the blur travels using an angle control and the 
distance between each increment of blur with the amount slider. The steps 
slider determines how smooth the blur appears.

Zoom Blur Creates the illusion that the image is moving toward you or away from you. 
A pop-up menu allows you to select whether the blur moves in or out. The 
radius slider determines the distance between increments of blur, and the 
steps slider determines how smooth the blur appears.

Border

Basic Border Draws a border around the edges of the clip. Basic border ignores any 
alpha channel information associated with that clip. A border slider adjusts 
its width and a color control lets you select its color.

Bevel Draws a beveled border around the edges of the clip. An angle control lets 
you specify the direction of the light. The bevel width slider lets you adjust 
the width of the border, the opacity slider allows you to adjust the relative 
strength of the bevel effect on the border, and a color control lets you 
specify the color of the light that gives the border its beveled look.
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Channel filters allow you to manipulate the color and alpha channels of clips in your 
sequence to create effects.

Channel

Arithmetic Performs an arithmetic operation, blending a specific color channel of your 
clip with another color. 

You can choose the operator used and the channel it’s applied to from 
pop-up menus. A color control allows you to specify the color with which 
the channel interacts.

Channel Blur Allows you to apply varying amounts of blur to each of the color and alpha 
channels of your clip simultaneously. Sliders control how much blur is 
applied to each channel.

Channel Offset Offsets the position of one or all of a clip’s channels. You can specify the 
channel to be offset from the Channel pop-up menu, the amount of offset 
using a center control, and the type of edge to be used from the Edges 
pop-up menu. 

Color Offset Offsets the color of individual channels in the clip. Using this filter, you can 
create posterizing style effects. Sliders control the offset value for each 
color channel in your clip. You can invert the image or wrap the colors.

Compound 
Arithmetic

Performs an arithmetic operation on the clip and a second specified clip. 

You can adjust the operator and the channel. 

Invert Inverts one or all channels of the selected clip. A Channel pop-up menu 
allows you to select which channel or channels to invert, and an amount 
slider allows you to adjust the amount of inversion to apply.
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Final Cut Pro’s Distort filters are design-oriented filters that create texture effects.

Distort

Bumpmap Offsets pixels in a clip using the luminance of a second selected image, 
called the map. A clip control allows you to specify the clip to use as the 
map image. You can use the luma scale slider, direction angle control, 
outset slider, and repeat edges checkbox to customize the effect. 

The direction and outset controls define the direction and amount of the 
offset. The luma scale and repeat edges controls define the appearance of 
the offset.

Cylinder Distorts the clip as if it were wrapped around a cylindrical object. You can 
adjust the radius and center sliders and the vertical checkbox to affect the 
appearance of this filter. The amount slider controls the effect this filter has 
on your image.

Displace Distorts the clip by offsetting pixels using the red and green channels. You 
can adjust the horizontal offset using the red channel and the vertical 
offset using the green channel. Horizontal and vertical scale define the 
direction and amount of the offset. Luma scale and repeat edges define the 
appearance of the offset.

Fisheye Distorts the clip as if it were bulging outward. You can adjust the amount 
and radius of the effect using slider controls and the center of the bulge 
using a point control.

Pond Ripple Distorts the clip as if it were mapped onto a pond ripple. A center point 
control allows you to set the center of this effect in the frame of your clip. 
You can adjust the number and size of the ripples using the radius, ripple 
amplitude, acceleration, highlight, and decay sliders.

Ripple Distorts the clip in a wave pattern, both horizontally and vertically. You can 
adjust both parameters independently using the amplitude, wavelength, 
horizontal, and vertical sliders. The repeat edge checkbox ensures that no 
black appears at the edges of the frame.

Wave Distorts the clip in a simple zigzag pattern, either horizontally or vertically. 
You can adjust the amplitude, wavelength, and speed of this effect using 
sliders. The vertical checkbox defines the orientation of the effect. The 
repeat edge checkbox ensures that no black appears at the edges of the 
frame. 

Whirlpool Distorts the clip in a swirling, whirlpool pattern. You can adjust the center 
of this effect with a point control. The amount angle control defines the 
rotation of the whirlpool. The repeat edge checkbox ensures that no black 
appears at the edges of the frame.
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Image Control filters manipulate the levels of black, white, and color in your clips. They can 
be used to correct clips with color or exposure problems, to even out the color balance and 
brightness of a group of clips in a scene so that they all have the same image quality, or to 
create other, more extreme color effects.

Note:  The range of colors that can be displayed on a broadcast video monitor is much 
smaller than that which can be displayed on your computer. Colors that appear to be bright 
and clean on NTSC or PAL video can seem duller when viewed on your computer. Resist the 
temptation to overcorrect for this. Perform color correction only while viewing your output 
on an NTSC or PAL monitor. Otherwise, you won’t really know how the corrections you’re 
making will look, and you may accidentally oversaturate your image, causing bleeding into 
other areas of the frame and a color range that is too “hot” for broadcast.

Image control

Brightness and 
Contrast

You can change the brightness and contrast of a clip by –100 to 100 
percent to darken or lighten the image. Brightness and contrast affect all 
colors and luminance values of a clip at once, and if used to extremes they 
can give a washed-out appearance to your clip.

Color Balance Allows you to adjust the amounts of red, green, and blue in a clip 
independently. Select whether this filter affects the highlights (bright 
areas), midtones, or shadows (dark areas) of your clip.

Color balance can be used to correct for inaccurate white balance on video 
footage or to create color effects.

Desaturate Removes color from a clip by the specified amount. 100 percent 
desaturation results in a grayscale image.

Gamma Correction Changes the gamma of a clip by the specified amount. The gamma 
correction filter can be used to pull detail out of underexposed footage or 
to bring overexposed footage down without washing out your clip.

Levels Like the Gamma Correction filter, but allows for greater control. You can 
specify a particular alpha or color channel of your clip. Sliders allow you to 
change the input, input tolerance, Gamma, Output, and Output tolerance 
individually.

Proc Amp This filter gives you excellent control over the black levels, white levels, 
chroma, and phase of your clip.

The setup slider adjusts how dark the black level of your clip is. The video 
slider adjusts how light the white level of your clip is. The chroma slider 
allows you to cut or boost the levels of color in your clip, and the phase 
angle control lets you adjust the hue of your selected clip.

This is one of the best filters you can use to correct improperly exposed 
video.
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Keying filters are generally used to key out background areas of video in order to isolate 
foreground elements to composite against a different background. Keying technology makes 
weather forecasters appear to be standing against an animated map, when in reality they’re 
standing in front of a blue or green wall. Keying filters are commonly used with the Matte 
Choker filter. 

To achieve a good key, it’s important to use footage that has been exposed properly and shot 
in as high quality a video format as possible.

Sepia Tints the clip with a sepia color by default. You can adjust the amount of 
tint and the brightness of tint using the amount and highlight sliders. You 
can also select another color with the color control.

Tint Tints the clip with the specified color. Only the amount of tinting is 
adjustable with this filter.

Image control

Video Compression and Keying Quality

For the best quality keying, use video clips with as little video compression as possible. 
Compression discards color information from a clip and can add artifacts around high-
contrast edges in the picture (such as the edges surrounding the image to be keyed). 
Using compressed video to create keying effects generally results in lost detail around 
the edges of the keyed image, including hair, translucent cloth, reflections, and smoke.
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Key

Blue and Green 
Screen

Keys the blue or green area of a clip and uses the selected color as a 
transparency mask for compositing foreground elements against a 
background scene. 

A view pop-up menu allows you to look at the source of the clip (with no 
key applied), the matte created by the filter, the final matted image, or a 
special composite of the source, matte, and final image for reference. A key 
mode pop-up menu allows you to select blue, green, or a blue/green 
difference as the key color. The color level slider allows you to select the 
amount of blue or green in your clip to key out, and the color tolerance 
slider allows you to expand the key into adjacent areas containing other 
shades of the key color. 

The edge thin slider allows you to expand or contract the matte area to try 
and eliminate fringing, and the edge feather slider lets you blur out the 
edges of the matte to create a smoother key. Before you use these sliders, 
try using a Matte Choker filter instead. 

An invert checkbox allows you to invert the matte, making what was 
masked solid and what was solid masked.

Color Key Keys on any color in a clip. A color picker control allows you to select a 
color from your clip as the specified key color.

Difference Matte Compares two clips and keys out areas that are similar. A view pop-up 
menu allows you to look at the source of the clip (with no key applied), 
the matte created by the filter, the final matted image, or a special 
composite of the source, matte, and final image for reference. A clip 
control allows you to specify another clip to compare the current image to 
for keying, and threshold and tolerance sliders allow you to adjust the key 
to try and isolate the parts of your image that you want to keep.

For example, use video footage of a man walking next to a wall. If you use a 
video clip of the wall by itself shot before the man walked by as the 
specified difference layer, you can adjust the threshold and tolerance 
sliders to isolate the man as he walks, since he’s the only element that’s 
different.
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Luma Key Similar to a color key, except that a Luma key creates a matte based on the 
brightest or darkest areas of an image. Keying out a luminance value works 
best when your clip has a large discrepancy in exposure between the bright 
or dark areas in the frame that you want to key out, and the foreground 
images you want to preserve.

A view pop-up menu allows you to look at the source of the clip (with no 
key applied), the matte created by the filter, the final matted image, or a 
special composite of the source, matte, and final image for reference. A key 
mode pop-up menu allows you to specify whether this filter will key out 
brighter, darker, similar, or dissimilar areas of the image. A matte pop-up 
menu allows you to create either alpha channel information for that clip, 
or to create a high-contrast matte image applied to the color channels of 
your clip, based on the matte created by this filter.

Spill Suppressor, 
Blue

When you use the blue and green screen key to key out the blue in a clip, 
sometimes there will be residual blue fringing, referred to as spill, around 
the edge of the foreground image. This filter removes this blue fringing by 
desaturating the edges where the fringing appears. 

This filter should always appear after a color key in the filter list that 
appears in the filter tab of the Viewer. It may have a slight effect on the 
color balance of your image.

Spill Suppressor, 
Green

Works like the Spill Suppressor, Blue, on green fringing.

Key
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Matte filters can be used by themselves to mask out areas of a clip, or to create alpha channel 
information for a clip to make a transparent border around your clip in order to composite it 
against other layers. Matte filters can also be used to make further adjustments to layers with 
keying filters applied to them. 

Matte

8-Point Garbage 
Matte

Generates an 8-point polygonal you can use to crop out portions of a clip. 
Eight-point controls allow you to define the polygonal matte. A smooth 
slider rounds off the corners of the polygon to create rounder mattes. The 
choke slider allows you to expand or contract the matte, and the feather 
edges slider allows you to blur the edges of the matte. The invert checkbox 
reverses what’s matted and what’s transparent, and the hide label 
checkbox hides the number labels, which indicate which point of the 
matte corresponds to which point control of the filter. 

Extract Produces a luminous matte around the clip, similar to a Luma key. A view 
pop-up menu allows you to look at the source of the clip (with no key 
applied), the matte created by the filter, the final matted image, or a special 
composite of the source, matte, and final image for reference. You can 
adjust the threshold, the tolerance, and the softness of the matte using 
slider controls. The Copy Result pop-up menu allows you to copy the 
luminance result to either the RGB or alpha channel of your clip, and the 
invert checkbox allows you to invert the result of this filter.

4-Point Garbage 
Matte

Similar to the 8-point Garbage matte, but it creates a four-point polygonal 
matte.

Image Mask Takes the alpha channel or luminance from another clip and uses it to 
create a matte for the current clip. A clip control allows you to select which 
clip to take the alpha channel or luminance values from. A Channel pop-up 
menu determines whether to use its alpha channel or luminance level. A 
checkbox allows you to invert the resulting matte.

This filter is especially useful for taking custom edge masks that you can 
create with any image editor and applying them to clips in your sequence 
that you want to matte the edges out of. Unlike the travel matte composite 
mode, the image mask filter attaches a matte to the selected clip. You can 
use motion effects to move the affected clip around, and the matte will 
follow.

Mask Feather Blurs the alpha channel of the clip by an amount specified by the soft 
slider.
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Mask Shape Generates a mask shape to use to matte out the clip. You can choose a 
diamond, oval rectangle, or round rectangle from the shape pop-up menu. 
The horizontal and vertical sliders adjust the size and aspect ratio of your 
mask shape. A center control allows you to specify the center of the mask, 
and an invert checkbox lets you reverse what’s transparent and what’s 
solid.

Matte Choker The matte choker is usually used in conjunction with a keying filter to 
manipulate the edges of the key. It’s often used instead of the edge thin 
slider in the keying filter. This is because when you use the edge thin slider 
of a key filter to force the edge of the resulting matte in or out, the result 
can be harsh and artificial looking. 

When you use the matte choker instead, moving the edge thin slider to the 
right gradually eats into marginally keyed areas of a filter, eliminating fringe 
and smoothing out the edges of your matte in a more realistic fashion. 
When you move the edge thin slider to the right, marginally keyed areas of 
a clip will be expanded, spreading out the matte and filling in holes in your 
foreground image that may have been created by the keying filter you’re 
using.

Matte chokers always appear after the keying filter in the Filters tab. Matte 
chokers are also commonly used in groups. The first matte choker 
eliminates the fringing in the areas you want to key out, but may create 
holes in your foreground image. The second matte choker, applied in 
reverse, fills in these holes to make your foreground image as solid as 
possible. More matte chokers can further fine-tune your key.

Soft Edges Blurs the four edges of the clip individually by the specified amount to 
create an old-fashioned vignetting effect. Each of the four edges of your 
clip can be individually adjusted using the left, right, top, and bottom 
sliders. The dither and gaussian checkboxes are used to modify the quality 
of the blurred edge, and the invert checkbox allows you to toggle between 
masking out the edges, and creating a hole in your image.

Wide Screen Generates a widescreen matte in the clip to create a letterboxed image. 
The type pop-up menu allows you to adjust the aspect ratio of the top and 
bottom mask using standard academy ratios. The offset slider allows you to 
move the affected clip up or down in order to display the area that’s most 
important. The border slider moves the top and bottom of the letterbox 
inward by up to ten pixels. A color control allows you to specify a color for 
the letterbox other than black, and a feather edge checkbox blurs the 
edges of the letterbox.

Matte
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Perspective filters allow you to move your clips spatially within their frames. To move a filter 
spatially using the entire frame of the Canvas, use motion effects instead.

Sharpen filters manipulate the contrast of clips in your sequence.

Perspective

Basic 3D Creates the illusion that your clip is suspended in 3D space. You can adjust 
the rotation around the x, y, and z axes using angle controls. A center 
control allows you to set the center of transformation, and the scale slider 
enlarges and reduces the side of the entire effected layer.

You cannot enlarge a clip past the frame size of that clip.

Curl Curls the clip as if it were a piece of paper. You can adjust the direction, 
radius, and amount of curl. The peel checkbox toggles the effect between 
curling up in a roll and peeling up like a sticker. A clip control allows you to 
use a different clip as the back side of the curled object.

Flop Allows you to flop a clip horizontally, vertically, or both.

Mirror Reflects a mirror image of the clip. You can adjust the center of the 
reflection using the point control, and the angle of the mirror effect using 
the reflection angle control.

Rotate Rotates the clip by 90 degrees or by 180 degrees. Choose the angle of 
rotation from the Rotate pop-up menu. This filter scales the result to fit the 
frame size, distorting the clip.

Sharpen

Sharpen Increases the contrast between adjacent pixels to increase the perception 
of sharpness in the image. When overused, can result in a harsh, grainy 
look.

Unsharp Mask Increases the contrast of adjacent pixels with greater control than the 
Sharpen filter. You can adjust the amount, radius, and threshold of 
sharpness to soften this filter’s effect.
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Stylize filters can be used to create extreme changes to the appearance of clips.

Stylize

Anti-Alias Blurs the high-contrast areas in the clip to soften the borders between 
elements in the frame. Use the amount slider to soften “stair-stepping.”

Diffuse Randomly offsets pixels in the clip to create a textured blur. An angle 
control allows you to adjust the direction of diffusion. The radius slider 
adjusts how extreme the diffusion will be. A direction pop-up menu allows 
you to specify whether the diffusion should be unidirectional (random on 
one axis), bi-directional (random on two axes), or non-directional (all 
directions). The random checkbox increases the amount of chaos in the 
effect, and the repeat edge eliminates any black that might appear around 
the edge of the frame.

Emboss Produces the illusion of raised edges where there is high contrast in the 
clip. An angle control allows you to specify the direction of the emboss 
effect. The depth slider allows you to raise or lower the apparent depth of 
the embossing. The amount slider controls the blend between the original 
clip and the emboss effect.

Find Edges Creates an effect of extreme contrast used to outline the edges in the clip. 
The invert checkbox toggles between using a light-on-dark and dark-on-
light effect. The amount slider controls the blend between the original clip 
and the find edges effect.

Posterize Maps the colors in the clip to a specified number of colors, creating an 
image with limited color range, which produces banding in areas of 
graduated color. Red, Green, and Blue sliders allow you to adjust the 
amount of posterization.

Replicate Tiles the clip to create a duplicate video wall effect. You can adjust the 
number of tiles independently for the horizontal and vertical axes, up to 16 
repetitions.

If the horizontal and vertical repetitions are not the same, the repeated 
images appear distorted.

Solarize Minimizes the midtones and maximizes the highlights and shadows in the 
clip, like the photographic solarizing effect. This effect can be inverted 
using a checkbox and adjusted using the amount slider.
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Video filters are generally used to create more utilitarian effects to clips in your sequence, 
although there are design-oriented filters in this category as well.

Video

Blink Flashes the clip on and off. You can adjust the frequency independently 
using the on duration and off duration sliders, and the maximum dip in 
opacity using the opacity slider.

Image Stabilizer Stabilizes motion in a jittering clip. It is best used on a clip that’s supposed 
to have no camera movement, but has wiggling from an unsteady tripod 
mount or from handheld operation.

The source pop-up menu allows you to view the clip before and after 
image stabilization has been applied. A center control allows you to select a 
particular element in your video clip to use as the target for stabilization. 
The selected target should be a high-contrast element with a clearly 
defined shape.

The scan range slider allows you to define the area of your clip that will be 
analyzed to track the motion of the selected target. Clips with greater 
motion should use a larger scan range; clips with more subtle motion can 
use a smaller one. The show scan checkbox shows and hides the image 
stabilization target.

De-Interlace Removes either the upper (odd) or lower (even) field from an interlaced 
video clip. The remaining fields are interpolated to create a whole image, 
with marginal softening of the image as a result. A pop-up menu allows you 
to remove either the upper or lower field.

The de-interlace filter is useful with video images of people or objects 
moving at high speed. Since interlaced fields are created sequentially over 
time, this can result in “banding” artifacts. If you output a QuickTime 
movie for computer playback, or for streaming over the Web, interlacing 
can make your image look blurred.

Stop Motion Blur Blends frames in the clip. You can adjust the time, steps, opacity, and 
operation used to blend the frames.

Strobe Lowers the apparent frame rate of a clip in your sequence by freezing the 
frames of the clip for a specified amount of time. The strobe duration 
slider allows you to define the duration of each freeze frame.
1052 Chapter  22  



Using After Effects Filters

In addition to the filters that come with Final Cut Pro, you can also use various After Effects 
filters.

To install After Effects filters:

m Copy the filters into Final Cut Pro’s Plugins folder, located in the Final Cut Pro folder.

After Effects filters use more memory than Final Cut Pro filters. Increase Final Cut Pro’s RAM 
allocation accordingly (see “Allocating Memory for Final Cut Pro” on page 49).

Not all After Effects filters are supported. If you install a set of filters and then begin to have 
problems, take them out of the Plugins folder.

Timecode Print Displays the clip’s timecode to create a “window burn.” You can adjust the 
appearance and the timecode created.

View Finder Displays a simulated camcorder viewfinder overlay. Various elements can 
be included, such as rec/play/pause mode (or custom text), title/action 
safe, and a blinking lamp. You can adjust the text and color of the mode 
text.

Video

Important  After Effects filters don’t take advantage of Final Cut Pro’s ability to render video 
using YCrCb. All After Effects filters render only in RGB color space
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Video Generators
Unlike filters or motion settings, video generators are not effects that you apply to clips in 
your project. Instead, video generators are clips, but they’re synthesized clips created by 
Final Cut Pro.

Generators serve a wide range of functions. Bars and tone generators allow you to put 
standard SMPTE color bars and tone into your sequence to use for reference or as an effect. 
Gradients and color mattes allow you to create background layers for use in your composite. 
Text generators allow you to create title effects in your project.

Some video generators, such as the slug, matte, and particle noise generators, fill the entire 
frame size of your sequence. Others, like the text filters, are created with an alpha channel 
that allows your text to be quickly superimposed against an image, or black.

Generators can have filters and motion settings applied to them. For example, you can use a 
color matte in conjunction with a garbage matte or mask shape filter to quickly create shape 
layers with alpha channels of their own. You can then use these shape layers as design 
elements or as layers when creating track matte effects.
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Working With Video Generators

Choose a generator from the Generator pop-up menu.

All of Final Cut Pro’s text generators can be accessed from the Text submenu of the 
Generators pop-up menu in the Viewer. This pop-up menu is available only when the Video 
tab in the Viewer is displayed.

When you choose a generator, it appears in the Video tab of the Viewer.

Note:  With the exception of the bars and tone generators, generator clips always adopt the 
frame size of the sequences they’re edited into.

The Particle 
Noise generator
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All generators have parameters that can be used to customize their effects. These parameters 
can be edited in the Controls tab of the Viewer. Clicking the Controls tab with the Particle 
Noise generator open in the Viewer reveals its parameters.

The controls used by the generators are exactly the same as those used by all other effects, as 
covered in “Tips for Using Filter Controls” on page 1028. 

Once you’ve adjusted the controls of the generator you want to use to suit your purposes, go 
back to the Video tab. The generator currently loaded into the Viewer can be edited into 
your sequence just like any other clip.

Keyframing Generators

The parameters of some generators can be keyframed to change their output over time. 
Keyframing generators works the same way as keyframing motion settings and filters. For 
more information about how to keyframe effects in Final Cut Pro, see “Animating Visual 
Effects Using Keyframes” on page 981.
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Using Generators
Final Cut Pro has two kinds of generators. Those that don’t require rendering are called real-
time generators. Those that require rendering are called graphical generators or titling 
generators. 

Graphical Generators

Graphical generators need to be rendered before they play back in real time in your 
sequence. Of these, there are graphical generators, and titling generators. Graphical 
generators can be used to create background screens, textures to superimpose over other 
clips, and patterns to use in conjunction with other filters to create even more varied effects. 

For example, you can drag a generator into the clip control of a filter that blends two clips 
together. Other interesting effects can be obtained by limiting these generators to shades of 
gray and using them with the track matte composite mode, or with filters that perform Luma 
key operations.

Real-time generators Description

Bars and Tone (NTSC) Generates reference video color bar and tone for NTSC systems.

Bars and Tone (PAL) Generates reference video color bar and tone for PAL systems.

Slug Generates a video clip consisting of a black image with an empty 
pair of audio tracks. Slug is used primarily as a placeholder in 
areas of your edit where you want to keep a gap between two 
clips.
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Graphical generators Description

Color Matte Generates a frame of solid color. A color control allows you to 
specify which color. 

Color mattes are extremely versatile. They can be used as 
containers for special effect filters that create visual images. In 
conjunction with filters such as Mask Shape, they can be used to 
create different shapes for use as design elements or for use as 
track matte layers. Color mattes can also be used to create 
colored backgrounds behind other layered clips in your 
sequence.

Custom Gradient Generates a gradient layer that you can customize. A pop-up 
menu allows you to specify a linear or radial gradient. A point 
control allows you to set the point in the frame where the 
gradient begins. An angle control defines the gradient’s direction, 
and a slider controls the gradient’s width. Two color controls 
define the start and end colors of the generated gradient. The 
dither and gaussian checkboxes allow you to modify the quality 
of the gradient you create. 

Gradient Generates a predefined gradient based on a direction you select 
from the gradient type pop-up menu. You can adjust the start 
and end colors of the gradient using color controls. The dither 
and gaussian checkboxes allow you to modify the quality of the 
gradient you create. 

Highlight Generates a simulated specular highlight band. A center control 
determines the location of the highlight. An angle control defines 
its angle. The width and softness of the highlight is determined 
by two sliders, and the highlight color and background color can 
be modified using color controls. The dither and gaussian 
checkboxes allow you to modify the quality of the gradient you 
create.
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Titling Generators

All of Final Cut Pro’s titling generators use TrueType fonts. Most professionally created fonts 
come in both PostScript and TrueType versions. Be sure to install the TrueType version of 
fonts that you want to use in Final Cut Pro. Titling generators must be rendered.

Noise Generates random pixel noise, similar to static. This random 
noise can be adjusted to appear in varying levels across every 
channel of the clip, including the alpha, red, green, and blue 
channels, using the appropriate slider controls. You can animate 
the noise with the random checkbox and create color static with 
the color checkbox.

A noise generator, when superimposed over a video image with a 
very low opacity level, can be used to simulate grain, similar to a 
film image or clip shot with a video camera with its gain turned 
all the way up.

Particle Noise One of Final Cut Pro’s more graphical filters. The particle noise 
filter, unlike the noise filter, creates random patterns of different 
shapes. By adjusting its controls, you can create all kinds of 
effects. 

You can adjust the size slider to set how large the shapes are. The 
shape pop-up menu allows you to choose what shapes to use 
(circle, square, diamond, or random). The soft slider lets you 
blur the edges around these shapes, and the density slider lets 
you adjust how many are on the screen, evenly distributing them 
across the frame. A color control allows you to specify the color 
of the shapes, and a random color checkbox gives you the option 
to make them all different. The time lapse slider lets you adjust 
the apparent frame rate of the particle animation.

Graphical generators Description
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When selecting a font to use for a title, avoid fonts that are thin or small. Because video is 
interlaced, one-pixel lines flicker unacceptably as the field on which they appear alternates 
on and off. This will result in “buzzing” text that is difficult to read.

Titling generators Description

Crawl Generates a single line of text that moves horizontally across the 
screen. A text entry field allows you to type the text you want to 
animate. Carriage returns will be ignored and all text will appear 
on a single line, like a ticker tape display. 

You can pick a font with the font control, change the size of the 
font used with a slider, and choose a style for the font using a 
pop-up menu. The overall spacing of the text can be adjusted 
with the spacing slider, and the location of the text as it crawls 
across the screen can be modified using the location slider. A 
pop-up menu allows you to set the direction in which the text 
will move.

By keyframing the spacing and location parameters, you can 
animate the width of your text as well as its horizontal position 
over time. If no locations keyframes are set, then the In and Out 
points of the generator clip determine the duration of the 
movement from one edge of the screen to the other. The longer 
the clip, the slower the movement of the crawl.

Lower 3rd Creates lower-third titles, such as those used to introduce talking 
heads in documentary programs. 

This generator creates two lines of text in the lower third of the 
frame, with an optional background. You can adjust the font, 
style, size, tracking, and color of each line of text. You can also 
choose the type of background from a pop-up menu, as well as 
its opacity and color.
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Scrolling Text Generates text that scrolls up the screen, like credits at the end 
of a movie. The scrolling text generator allows carriage returns.

The font, size, style, alignment, and color of the text in your list 
can be adjusted. The spacing slider can be used to adjust the 
spaces between letters of text, and the leading slider can be used 
to adjust the space between the lines of text. 

The indent slider only works with left- or right-aligned text. It 
moves the entire scrolling column to the right or left. The fade 
size slider narrows the vertical display area of your scrolling text 
in the frame, fading the text in and out at the bottom and the 
top. The direction pop-up menu allows you to specify the 
direction in which the generated text will scroll.

The In and Out points of the edited generator clip will determine 
the duration of the scroll from the bottom to the top of the 
screen (or vice versa). The longer the clip, the slower the 
movement of the scroll.

Text Creates a static element of text. This generator allows carriage 
returns. 

The font, size, style, alignment, and color of the generated text 
can be modified. These controls modify the entire text element 
at once. A point control allows you to adjust the position of the 
text within the frame of the generator. Tracking, leading, and 
aspect sliders allow you to control the layout of the generated 
text and can be keyframed to create interesting effects. 

The auto kerning checkbox allows Final Cut Pro to kern your text 
automatically so that the spacing between the individual letters 
of your text is correct. The use subpixel control allows Final Cut 
Pro to render your text with subpixel accuracy.

Typewriter Generates text that appears as if typed onto the screen, one 
character at a time. This generator allows carriage returns. The 
font, size, style, alignment, and color of the generated text can be 
modified. These controls modify the entire text element at once.

The spacing slider allows you to adjust the spacing of the 
individual characters in your text. The location slider moves the 
text element up and down in the frame, and the indent slider 
moves it from side to side. 

The pause slider increases or decreases the amount of time it 
takes for each character to appear onscreen.

Titling generators Description
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Speed Settings
The Speed command (Command-J) allows you to speed up or slow down a clip in your 
sequence to create fast or slow-motion effects. The duration of your clip will also change.

For example, if you create a slow-motion effect by setting a 10-second clip to play back at 50 
percent (slow motion), Final Cut Pro duplicates its frames so that the clip becomes 20 
seconds long.

If you increase the clip’s speed to 200 percent (fast motion), Final Cut Pro skips frames and 
makes the clip 5 seconds long.

Duplicating frames to create slow motion can result in a strobe effect. To reduce this, you can 
enable the Frame Blending option in the Speed dialog box. Frame blending takes all of the 
adjacent frames in a clip that has been slowed down and interpolates them to create new 
intermediate frames that play in between the original frames. These intermediate frames 
reduce the strobing of the image, resulting in extremely smooth slow-motion effects.

You can also use the Reverse checkbox to reverse a clip’s direction of playback, combining it 
with a new speed setting to create many different temporal effects.

A clip’s speed can be changed at any time. Speed settings you apply are not applied to that 
clip’s source media on disk.

Note:  If you change the speed of a clip, it must be rendered before it can be played.

Selected 
10-second clip

Same clip with speed
changed to 50 percent
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To change the playback speed of a clip:

1 Select a clip in the Timeline.

To select only a portion of a clip, select the Razor Blade tool and divide the clip into sections, 
then select the section you want to modify.

2 Choose Speed from the Modify menu (or press Command-J).

3 Select the desired speed options, then click OK.

The clip’s duration in your sequence changes based on the new speed.

m Speed or Duration:  You can modify the clip speed percentage or the marked duration. 
Unmodified clips have a clip speed of 100 percent. 

m Reverse:  Click this box to make the clip play in reverse, using any speed specified by the 
above controls.

m Frame Blending:  Click this box to smooth the apparent motion of a clip playing back at 
slow or fast speeds.

Changing the clip speed or 
duration automatically changes 
the other value.

Using the Fit to Fill Edit

When you use the fit to fill edit (see “Performing a Fit to Fill Edit” on page 579), it 
changes the speed setting applied to the edited clip. These speed settings can be 
modified or removed at any time.
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23 Rendering

Before you can play back your sequences smoothly with the effects you’ve applied to them, 
you need to render them. Rendering is the process of combining your video and audio with 
the applied effects, such as transitions or filters, one frame at a time. The result is a new file, 
called a render cache file, which can be played back. Depending on the complexity of audio 
effects used, audio rendering may not be necessary. See “Rendering Audio” on page 1079.

Most sequences you create will need to be rendered. However, sequences consisting of cuts 
only can be played back without rendering. For more information, see “Avoiding Unnecessary 
Rendering” on page 1069.

Real-time systems have sophisticated and powerful hardware that lets you play back video 
effects in real time as you add them to clips or sequences. This eliminates the need to render 
those effects before viewing them and can save you a great deal of time, as well as disk space. 
For more information, see Chapter 20, “Overview of Effects.” 

The Basics of Rendering
Since rendering is an important part of the video creation process, it’s helpful to understand 
basic rendering concepts. These include

m determining what needs to be rendered in your sequence

m interpreting rendering indicators in the interface

m learning what items are rendered before others

m figuring out how long rendering will take

What Needs to Be Rendered?

Several items require rendering in Final Cut Pro:

m video clips or sequences with transitions, effects, and composited layers
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These include still frames (graphics), video filters, motion applied to a clip, and effects 
applied by generators, such as text over video.

m clips whose speed has been modified

m audio tracks with transitions or filters exceeding the real-time audio mixing limit

m multiple audio tracks that exceed your real-time playback limit 

You can set the Real-time Audio Mixing option in the General tab of the Preferences 
window. For more information, see “Setting General Preferences” on page 885.

m video that doesn’t match your sequence settings

You need to render any source media that has a frame rate, frame size, or audio or video 
compression method that is different from those in your sequence. To see a clip’s 
settings, select it in the Timeline and choose Item Properties from the Edit menu. To see 
the sequence settings, choose Settings from the Sequence menu or select the sequence 
in the Browser and choose Item Properties from the Edit menu.

You don’t have to render the following:

m sequences consisting of cuts only (if the frame size, frame rate, and compression settings 
match those of the original source media)

m multiple audio tracks or audio effects that are within your real-time playback limit (set in 
the General tab of Preferences)

Final Cut Pro shows you which items need rendering by using render bars in the Timeline, as 
described in the next section, “About the Render Status Bars.”

About the Render Status Bars

There are two render status bars in the Timeline, above the ruler: the upper one is for video 
and the lower for audio. As you create a sequence, indicators show which sections of the 
sequence require rendering to play back smoothly at the selected render quality.

m Red:  Needs to be rendered.

m Dark Gray:  No rendering is required.

The render bars appear 
here in the Timeline.
1066 Chapter  23  



m Green:  Does not need rendering and can be played in real time. However, if you are 
exporting or sending output via FireWire, then rendering may be required (depending on 
your real-time hardware).

m Yellow:  When you play back, Final Cut Pro shows a real-time approximation of the final 
effect. To get the true final effect, you still need to render the material. The final effect is 
shown when play is stopped or when scrubbing. 

m Steel Gray:  The material has already been rendered.

Other indicators include the following:

m “Unrendered” message in the Viewer or Canvas:  When video material that requires 
rendering is playing in the Viewer or Canvas, and the Play Base Layer Only option in the 
Render Quality Editor is not selected for the current render quality, a blue background 
with the word “Unrendered” appears, indicating that the video can’t play in real time. If 
the Play Base Layer Only option is enabled, the base tracks play, but without any 
transitions or other special effects. 

m Beep in the Viewer or Canvas:  When audio material that requires rendering is played in 
the Viewer or Canvas, a steady beep occurs, indicating that the material can’t play in real 
time. For more information, see “Rendering Audio” on page 1079.

The upper render bar is 
for video, the lower for 
audio.
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What Is the Order of Rendering?

Video is rendered in the following order:

m The top-layer video track (the highest numbered track) is rendered first, and then 
composited onto the track below.

m Within each track, effects are rendered as follows: speed, filters, motion, motion blur, 
opacity, and transitions.

You can change the order of rendering by using nested sequences. For more information, see 
“Nesting Sequences” on page 937.

How Long Does Rendering Take?

A progress bar shows the percentage of rendering that has been completed. This percentage 
is based on the number of frames left to render.

If you have a real-time system, rendering time depends on the capabilities of your real-time 
card, your computer, and the kinds of media you are rendering.

Planning for Rendering
Rendering is an important step in the creation process in Final Cut Pro since it lets you ready 
your finished product for playback and then distribution. You’ll also probably render your 
sequences, or parts of them, as you work on your project. This gives you a chance to evaluate 
your work, then go back and make changes.

Think about rendering as part of your overall creation process and then think about ways 
you can

m avoid unnecessary rendering

m reduce rendering time

m temporarily disable rendering
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Avoiding Unnecessary Rendering

You can do several things to avoid rendering. 

In general:

m Create sequences with cuts only; don’t add transitions, effects, or filters.

m Nest sequences within other sequences.

This approach must be used carefully. For more information, see “Nesting Sequences” on 
page 937.

m Temporarily disable rendering.

For more information, see “Disabling Rendering” on page 1078.

For sequences with cuts only:  

m Compare the settings in your source media with the sequence settings. 

Make sure that the sequence’s editing timebase, frame rate, and compression settings are 
the same as the frame rate, frame size, and compression settings of your source media. If 
media appears normal when opened in the Viewer, but not when you add it to your 
sequence, there’s likely a difference in settings.

Reducing Rendering Time

You can reduce the amount of time used for rendering in several ways:
m Use a lower render quality level.

This approach can be useful at any point in a project before you do your final output. 
m Test-render short sections.

Before you apply effects to all parts of a sequence or to a lengthy part of a clip, apply the 
effect to a small section of a clip. Render this selection and check the results. You can then 
adjust the settings and apply the effects to more of your media.

m Batch render while you take a break or do other work.

Rendering time isn’t actually reduced, but you can make efficient use of your time by 
turning your attention to other things as the computer renders your media.

m Use a real-time system.

With a real-time system, many effects and other items that need to be rendered can be 
rendered in real time. For more information, see Chapter 20, “Overview of Effects.”
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Working With Render Quality Settings
Final Cut Pro has four default render quality levels. The render quality influences the time it 
takes to render and the quality of the rendered result. There’s a separate render cache file for 
each render quality level. Render files are stored in the location you specified in the Scratch 
Disks tab of the Preferences window (see “Setting Up Scratch Disks for Storing Media” on 
page 899).

Note:  Each render quality generates a separate render file that applies to the specific item 
rendered and the sequence in which it appears. For example, if you render a transition at the 
highest quality (Hi Res) and then change the render quality for that transition to lower 
quality (Low Res), you must render the transition at the new quality level. If you switch back 
to the original high quality for the transition, it does not have to be rendered again.

As you change render quality levels, the render bar changes to indicate areas that require 
additional rendering at the current render quality.

It’s important to develop some strategies for using render quality levels when you’re working 
on your project. 

m When you render your final output, you’ll want high-quality footage that looks just as 
good as the rest of your final product in whatever medium you distribute it in. 

m While you’re working on a project, applying different render qualities can be especially 
useful when you want to get a quick idea of how something looks. You can render a brief 
section that’s heavily composited at high quality to see if the images work as you expect, 
or you can render longer sections at lower quality to do a quick check of effects or the 
overall flow of a sequence.

m Creating a plan for when to render, how often, and at what levels can greatly speed up 
your production process. For more information, see “Planning for Rendering” on 
page 1068.

Determining the Render Quality Levels You Want

The following are the default render quality settings:

m Hi Res (1):  This level creates a render cache file that has the same frame rate and 
resolution as your sequence settings. The highest image and motion quality are produced, 
including field rendering, frame blending, and motion blur, and all filters are enabled. 

Use this level when you’re ready to produce your final version or if you want to check the 
image quality in selected places.

m Low Res (2):  This level produces a file that has the same frame rate and half the 
resolution of your sequence settings. Filters are applied, but field rendering, frame 
blending, and motion blur are not.
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Select this level when you want to see how filters look in your media, when you’re doing 
basic compositing, when you want to render relatively quickly, and when you don’t need 
to see final output (a close approximation is good enough).

m Draft (3):  This creates a file that has half the frame rate and half the resolution of your 
sequence settings. Filters are applied, but field rendering, frame blending, and motion 
blur are not.

Select this level to review and adjust basic design characteristics, such as the positioning 
of elements, scaling, and motion paths.

m Cuts Only (4):  This is a high-resolution render mode, used when the Play Base Layer 
Only option is selected. The base tracks play, but without any transitions or other special 
effects. For more information, see the next section, “About Render Quality Settings.”

Use this level when you want to render at the full quality, but while playing back you want 
to see transitions as cuts only and ignore composited elements.

Note:  In some instances, such as when doing a batch export, you may see render quality 
levels abbreviated RQ1, RQ1-4, and so on. 

You can also customize the settings for each render quality. For more information, see the 
next section, “About Render Quality Settings.”

About Render Quality Settings

You can customize the definition of each render quality setting in the Render Quality Editor. 
Each quality level has a different set of options preselected; you can change them as desired 
based on the needs of your project.

Note:  Render quality settings are applied only to rendered output and are independent of 
the sequence settings.

Each setting
has its own tab.

Change render 
settings as desired.
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m Quality Name:  This displays the current name for the render quality level and appears in 
the Render Quality submenu, pop-up menu, and tab. You can edit this.

m Draft Render:  Check this box to render filters at the lowest possible quality. This option 
is useful to speed up previewing, but you should deselect it before final rendering and 
export.This setting applies only to third-party filters, such as those from After Effects, that 
take advantage of this low-quality setting.

m Field Rendering:  Check this box to turn field rendering on. Motion effects rendered with 
field rendering on appear smoother during playback but take longer to render. When 
doing a rough cut, turn this off for faster rendering.

m Motion Blur:  Check this box to apply motion blur to specified clips when rendering. 
Turning this off speeds up the rendering process. 

m Include Filters:  Check this box to render filters on clips that have them. Turning this off 
speeds up the rendering process.

m Enable Frame Blending:  Check this box to enable motion smoothing effects where the 
speed of the video has been changed. You must have previously applied frame blending 
on one or more clips.

m Play Base Layer Only:  Check this box to play the base video track only ( V1), all audio 
tracks, and cuts only. No transitions are rendered; cuts are substituted for unrendered or 
non-real-time effects. Motion is not applied to clips or sequences when played back in the 
Viewer and motion applied to the base track is ignored. 

Use this option when you want to play back your sequences with minimal rendering. 
These options affect playback only. The render bar for all unrendered items stays red, 
indicating that they still must be rendered for final output.

m High Quality Playback:  This option renders the playback of DV clips at the highest visual 
quality available on a particular system, but at the expense of frame rate. This option 
affects only the display of video when played back on the computer monitor: it does not 
affect render quality or speed of playback to a camcorder or deck. Use this option to 
check the visual quality of filtered or composited clips. Individual frames appear in high 
quality when playback is paused.

How well your system performs during high-quality playback depends on your 
computer’s processing power. If your system has difficulty handling high-quality playback, 
you may have dropped frames.

m Frame Rate:  Choose an option from the pop-up menu to set the frame rate to a 
percentage of the sequence editing timebase. For example, choosing a frame rate of 50% 
renders half the frames, and so cuts render time in half.

m Resolution:  Choose an option from the pop-up menu to set the resolution, or frame size, 
to a percentage of the sequence’s frame size. At a lower percentage, fewer pixels are 
processed, so rendering time is reduced.
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Saving Render Quality Settings

Once you’ve adjusted the render quality settings, you can save them with the default name 
assigned by Final Cut Pro, or you can give your custom settings a different name. You can 
make other choices when saving these settings:

m Save as Default Set:  Making your settings the default stores them as preferences for 
the application. Whenever you create a new project or sequence, it will use these 
render settings.

m Reset:  If you’ve changed some settings and you want to restore the default settings for 
that render quality level, choose Reset.

It’s a good idea to rename a render quality level that you’ve modified to remind you that it’s 
not a default setting. Give this modified quality level a distinctive name that will remind you 
of its primary purpose.

Editing Render Quality Settings

To modify the render quality settings:

1 Do one of the following:

m Choose Render Quality from the Sequence menu, then choose Edit Render Qualities from 
the submenu.
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m Choose Project Properties from the Edit menu, then click the Edit Render Qualities button.

m In the Timeline, click the desired sequence tab, then choose Edit Render Quality from the 
Render Quality pop-up menu.

2 Click a render level tab, specify settings for that level, then click OK.

For information on specific settings, see the earlier section, “About Render Quality Settings,” 
on page 1071.
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Making Render Quality Settings Defaults for New Projects

Instead of choosing different render quality levels for various projects, you can set a 
default level. This level will be applied to all new projects. This can save you time as well as 
potential confusion, if you’re working on several projects and forget which render quality 
levels you’re using.

To set a render quality level as the default:

1 Do one of the following:

m Choose Render Quality from the Sequence menu, then choose Edit Render Qualities from 
the submenu.

m Choose Project Properties from the Edit menu, then click the Edit Render Qualities button.

m In the Timeline, click the desired sequence tab, then choose Edit Render Quality from the 
Render Quality pop-up menu,.

2 Click the desired render level tab and change any settings you want.

3 Click Save as Default Set, then click OK.

When you make a set of options the default for a level, those settings are always in effect 
for that level. You can check or change the options or set a new default in the Render 
Quality Editor.

These custom default settings can be tailored to your work style. For example, you like to 
render effects while working, but at only half the frame rate, to save rendering time. You 
could establish these settings as the default for the Draft render quality and use it as you 
develop any project.

Note:  If you have a group of render quality settings that you like, you can preserve it by 
creating a new project, adjusting the settings as you want them, and saving those settings as 
the default. If your Final Cut Pro preferences are lost or damaged, or you need to use the 
application on a different computer, you can open a copy of that project to restore your 
custom settings.
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Rendering
Before you can play back your media smoothly with the effects you’ve applied, you need to 
render. You can render all of a sequence or select specific clips or parts to render. If you don’t 
select anything, Final Cut Pro will render everything.

m To render audio only, see “Rendering Audio” on page 1079.

m To render real-time effects only, see “Rendering Real-Time Effects” on page 1082.

Seeing a Preview Before Rendering

You can see a quick preview of an effect or transition before actually rendering it. This can 
save you time if the effect or transition doesn’t turn out the way you anticipated.

To preview an effect:

m Scrub (drag the playhead through the scrubber bar) in the Canvas, or use the Right and 
Left Arrow keys to move through the media frame by frame.
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Rendering a Sequence

The Render All command lets you render an entire sequence and creates render files for all 
of the video and audio tracks in the current sequence.

To render an entire sequence:

1 Open the sequence (and select its tab in the Timeline, if necessary).

2 Specify the render quality level you want:

m Choose Render Quality from the Sequence menu, then choose a render quality level from 
the submenu.

m In the Timeline, choose a render quality level from the Render Quality pop-up menu.

3 Choose Render All from the Sequence menu.

A progress bar is displayed while the sequence is being rendered. 

Click Cancel to stop rendering. All rendered frames are saved, even if rendering is canceled.

Rendering Part of a Sequence

If you’ve added a transition or an effect to a clip and want to render just that part of your 
sequence, use the Render Selection command.

To render a section of a sequence:

1 Do one of the following:

m In the Timeline, select one or more clips or transitions.

m In the Timeline or Canvas, set In and Out points for the area that you want to render.

If you don’t select anything, Final Cut Pro will render everything.

2 Specify the render quality level you want:

m Choose Render Quality from the Sequence menu, then choose a render quality level from 
the submenu.

m In the Timeline, choose a render quality level from the Render Quality pop-up menu.
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3 Choose Render Selection from the Sequence menu. 

A progress bar is displayed while the selection is being rendered. 

Click Cancel to stop rendering. All rendered frames are saved, even if rendering is canceled.

Batch Rendering Sequences

If you have more than one sequence to render, you can do a batch render. This can save 
time, particularly if you have many sequences. You can start the batch render process, then 
have Final Cut Pro render overnight or while you’re taking a break. This process is similar to 
regular rendering, where selected sequences are rendered sequentially. 

To batch render:

1 Select the sequences you want to render in the Browser.

2 Choose Render All from the Sequence menu.

Final Cut Pro begins the render process, showing a progress bar for each sequence as it’s 
being rendered.

To stop rendering at any point, click Cancel. If there are any sequences left to render, another 
progress bar appears. All rendered frames are saved, even if rendering is canceled.

Disabling Rendering

Sometimes you may want to disable rendering temporarily while you make changes to 
settings. Although disabling rendering does not speed up final rendering, it allows you to 
work faster without wasting your computer’s processing power on background rendering. In 
essence, disabling rendering turns off the view of a rendered clip you would otherwise see 
while scrubbing (dragging the playhead through the clip in the Canvas or Timeline).
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To temporarily disable rendering:

m Press the Caps Lock key when the playhead is over an area that needs to be rendered.

Press the Caps Lock key again to enable rendering.

Rendering Audio
Final Cut Pro can mix and play back up to eight tracks of audio in a sequence in real time. In 
most cases, however, audio can be played in real time without rendering. You can have more 
than eight audio tracks in a sequence, but the maximum number of tracks you can mix and 
play back before rendering is required depends on

m your computer system’s configuration (processor speed, number and types of filters 
used, data transfer rate of your hard disk, available RAM, and so on)

m the number of tracks specified in the Real-time Audio Mixing option in the General tab of 
the Preferences window

For more information, see “Setting General Preferences” on page 885.

Not all audio tracks have the same rendering needs. If you apply filters or transitions to an 
audio track, Final Cut Pro calculates the amount of processing power required to render 
those effects and play them back in real time, called track costs.
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Determining Track Costs

Final Cut Pro’s audio capabilities are based on the concept of track costs. Track costs indicate 
the total processing power needed to play back multiple audio channels. Track costs can 
accumulate quickly when you’re combining various audio elements. When you surpass the 
maximum track costs (typically eight), you have to render, otherwise you’ll hear beeps 
instead of your audio when you play back in real time.

For example, an audio cross fade or transition increases the track count by one. Thus, if a 
sequence contains eight audio tracks, adding a single cross fade increases the count to nine 
tracks and requires rendering to preview.

Rendering a Single Audio Clip in a Sequence

If necessary, you can render an audio clip.

To render a single audio clip within a sequence:

1 In the Timeline, select the desired audio clip.

2 Choose Render Selection from the Sequence menu.

Element Type Track cost

Each mono track Track 1

Each mono track with transitions 
applied

Transitions 2

Pair of stereo tracks Track 2

Each track referencing a 
subsequence

Track Total number of audio tracks 
in the sequence

Compressor/Limiter Filter 6

Stereo track referenced as a 
subsequence

4

Expander/Gate Filter 6

Vocal DeEsser Filter 6

Vocal DePopper Filter 6

Reverb/Echo Filter Must be rendered

All other filters Filter 3
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All audio tracks, including effects that have been applied, are processed into one render 
cache file for the area covered by the clip.

Rendering All the Audio in a Sequence

You can use the Mixdown Audio command to render all the audio tracks in a sequence. 
This procedure improves performance because sections that have multiple tracks or effects 
that fit within the specified real-time audio mixing limit will be reduced to a simple stereo 
pair in the render file. This method of rendering audio does not change any of the audio 
clips in the sequence.

To render all the audio in a sequence:

m Choose Mixdown Audio from the Sequence menu.

All audio tracks, including effects that have been applied, are processed into one render 
cache file. 

Once mixdown audio has been applied to a sequence, the menu item is dimmed and a 
checkmark appears next to it, indicating that the sequence has been rendered. If files are 
moved within the sequence after being rendered, the Mixdown Audio command will again 
become available.

Note:  If you move, copy and paste, or otherwise change audio material after rendering it, 
the render file for that material is lost and the audio must be rendered again.

To create a single audio file for a sequence:

You can create one render file for all audio in a sequence by nesting the entire sequence and 
then using the mixdown audio command for this nested item in the parent sequence. For 
more information about nesting sequences and rendering, see “Using Nested Sequences to 
Preserve Render Files” on page 1090.
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Rendering Real-Time Effects 
Final Cut Pro has built-in support for real-time effects. If you’ve got a real-time system, you 
can play transitions and other effects in real time, if they are available in real time. For more 
information, see Chapter 20, “Overview of Effects.”

To render just real-time effects:

1 Do one of the following:

m In the Timeline, select one or more clips or transitions.

m In the Timeline or Canvas, set In and Out points for the area that you want to render.

If you don’t select anything, Final Cut Pro will render all real-time effects.

2 Specify the render quality level you want:

m Choose Render Quality from the Sequence menu, then choose a render quality level from 
the submenu.

m In the Timeline, choose a render quality level from the Render Quality pop-up menu.

3 Choose Render Realtime Effects from the Sequence menu.

A progress bar is displayed while the sequence is being rendered. 

Click Cancel to stop rendering. All rendered frames are saved, even if rendering is canceled.

Note:  The Render All command in the Sequence menu renders all effects, whether real-time 
or non-real-time. The Render Selection command renders both real-time and non-real-time 
effects for the selected item, but if nothing is selected, this command renders only non-real-
time effects on a computer with a real-time card installed.
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Rendering in YCrCb (YUV) Color Space
Final Cut Pro supports image processing, or rendering, in the YCrCb color space (sometimes 
referred to as YUV ), in addition to the RGB color space. There are also options for white level 
processing. Both of these options let Final Cut Pro preserve the maximum color fidelity for 
processed images.

Working in the YCrCb and RGB Color Spaces

Many digital video formats store data in a color space known as YCrCb. Three components 
are stored for each pixel: one for luminance ( Y ) and two for color information (Cr and Cb). 
Typically, computers store data in RGB color space, which also has three components for 
each pixel: one each for the red, green, and blue parts of the image.

Information can be converted from one color space to the other. However, since the color 
spaces are not identical, there are many colors in each space that cannot be described in the 
other. These colors get “clipped” to the nearest value during conversion. This can cause very 
saturated colors to become less intense and is referred to as “chroma clamping.”

Another problem between the two color spaces occurs because of the levels at which some 
DV cameras produce Y values. In YCrCb color space, values are typically defined from 16 to 
235, while in RGB they range from 0 to 255. Some cameras produce Y values above the 235 
range, even as high as 254 (also known as superwhite). When these values are converted to 
RGB, they can’t go higher than 255. When the RGB value is converted back to YCrCb, it will 
have a maximum value of 235, less than the original value, causing viewing differences in the 
media. This is known as “luma clamping.”

Final Cut Pro eliminates these two problems by processing in YCrCb when appropriate and 
eliminating the conversion to and from RGB color space.

Compositing and the YCrCb and RGB Color Spaces

Many compositing operations in Final Cut Pro operate the same way in YCrCb and in RGB. 
However, in some cases, slightly different results may be obtained by YCrCb rendering and 
RGB rendering. This is because the RGB and YCrCb color spaces are not identical, and some 
compositing operations that generate highly saturated colors may show different clamping 
behavior in RGB and in YCrCb. 

For example, using the Add composite mode to combine 75% cyan and 75% white will 
“clamp” to white in RGB, but to a bright cyan color in YCrCb. For this reason, it is important 
to verify the results of the composite by doing a test render in the color space you will do the 
final render in.
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Setting Up for YCrCb Rendering

You can specify settings to take advantage of the new YCrCb color space rendering. These 
options are in the Sequence Preset Editor.

Note:  To use projects created in earlier versions of Final Cut Pro, you need to update them 
for the new color space. For more information, see “Updating Projects Created With an 
Earlier Version of Final Cut Pro” on page 1085.

To select settings for rendering in YCrCb color space:

1 Choose Settings from the Sequence menu, then click the Video Processing tab.

2 Select the desired options, then click OK.

Note:  These options are available for codecs (compression/decompression standards) that 
support YCrCb color space. To find out which codecs support this, go to the Final Cut Pro 
Web site at www.apple.com/finalcutpro

m Always Render in RGB:  This forces codecs (compression/decompression standards) to 
be processed in the RGB color space (instead of the YCrCb color space). Choosing this 
option may cause color or intensity shifts in rendered material.

m “Process maximum white as”:  This option appears only if Always Render in RGB is not 
selected. 

Two white settings are available, White and Super-White. These determine how RGB 
colors are mapped into the YCrCb color space for imported graphics files (such as 
Photoshop files) and Final Cut Pro generators (such as the Text generator). You can also 
use it to match cameras that produce video that is brighter than the standard white (also 
known as superwhite). 

m White:  Choosing this causes an imported or generated RGB graphic to map “white” to 
CCIR-601 “white,” a luma value of 235.
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m Super-White:  Choosing this causes imported graphics and generators to map “white” 
to CCIR “superwhite,” a luma value of 254.

For broadcast in the United States, outputting values brighter than CCIR white (luma of 235) 
is illegal. Therefore, if your final product is for broadcast use, choose White. However, many 
consumer DV camcorder devices regularly generate “broadcast-illegal” luma values, such as 
whites brighter than 235. If you want Final Cut Pro to make the “white” in imported graphics 
and Final Cut Pro generators match the brighter whites that these cameras generate, you may 
want to choose Super-White, even though the result is not broadcast-legal.

If YUV rendering is supported by the codec used in a sequence, Final Cut Pro generates color 
bars with a “pluge” area that includes a superblack (4 IRE in NTSC, 2 IRE in PAL) signal for 
calibration. If any image processing (such as motion or filter) is applied to the Bars and Tone 
generator, the superblack portion of the pluge becomes black.

Updating Projects Created With an Earlier Version of Final Cut Pro

You can open and use projects created with a version of Final Cut Pro earlier than version 1.2.5, 
but you need to specify how Final Cut Pro handles these files in terms of the color space. Before 
updating projects from earlier versions of Final Cut Pro, consider these things:

m Third-party scripts or scripts that you’ve already written or customized may need to be 
modified to take full advantage of the YCrCb color space. For more information, go to the 
Final Cut Pro Web site at www.apple.com/finalcutpro

m All Final Cut Pro effects take advantage of the new color space. If you used any of the 
effects listed below in previous projects, they may look slightly different when you 
recreate the render files.

m Video Transitions:  Map/Luminance Map, Wipe/Gradient Wipe

m Video Filters:  Blur/Gaussian Blur; Channel/Invert; Image Control/Brightness and 
Contrast, Gamma Correction, Levels, Proc Amp, Sepia, Tint; Key/Blue and Green 
Screen, Color Key, Difference Matte

m Video Generators:  Matte/Color

m Adobe™ After Effects filters and QuickTime transitions and filters do not take advantage of 
this new color space.

To update earlier projects:

1 Open a project created using an earlier version of Final Cut Pro. A message says the file’s 
format is outdated and asks if you want to update the format. Click Yes.

2 Click the appropriate checkboxes, then click OK.

Note:  These options are available for codecs (compression/decompression standards) that 
support YCrCb color space. To find out which codecs support this, go to the Final Cut Pro 
Web site at www.apple.com/finalcutpro
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Choosing these options will not rerender any material immediately. To render material 
that requires rendering, you need to open the sequence and render it or use the batch 
render process.

m Update sequences for improved color fidelity:  This selects YCrCb rendering and also sets 
the maximum white value to superwhite in the Video Processing tab of the Sequence 
Settings or Sequence Preset Editor windows. All future rendering in the sequence will be 
done in YCrCb in superwhite.

Note:  If you check this option, the Always Render in RGB option in the Sequence 
Settings or Sequence Preset Editor window is not selected (see “Setting Up for YCrCb 
Rendering” on page 1084).

m Remove existing render files:  This deletes all render files on the scratch disk for the 
sequences in this project. You cannot undo this action.

Keep existing render files if the quality difference between old and new files is not a 
problem for your projects, or if you need to get a project done fast and don’t want to 
rerender files. If you keep existing render files and want consistent-looking media, you’ll 
have to rerender the files, because sequences in previously rendered media may have 
color or intensity shifts.

Important  Deleted render files cannot be restored with the Undo command.
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Managing Your Render Files
Rendering produces render cache files that are actual media files stored on your hard disk, 
just like your captured media. Render files are very important in Final Cut Pro. You can spend 
hours of valuable time rendering and creating these files over the course of a project. To help 
manage these files and work smarter, make sure you specify disk locations for storing render 
files and periodically delete old or unnecessary render files.

Specifying Storage Locations for Render Files

You specify the disk locations where render files are stored using the Scratch Disks tab in the 
Preferences window. For more information, see “Setting Up Scratch Disks for Storing Media” 
on page 899. 

If you run out of disk space during the rendering process, a dialog box opens where you can 
delete old render files to free disk space.

When you’re working on multiple projects or a highly complex project, render files can 
accumulate very quickly. It’s important to manage your render files to maximize your disk space.
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Locating Render Files

Final Cut Pro stores render files in the Final Cut Pro Documents folder, which is inside the 
Documents folder on your scratch disk. The Final Cut Pro Documents folder contains folders 
for render files, captured media, and caches for waveforms and thumbnails.

Inside the Render Files folder, Final Cut Pro creates a folder for each project with render files. 
The application automatically generates names for render files, using the relevant sequence 
as the first part of each name.

Using the Render Manager

The Render Manager allows you to manage your render files by deleting unwanted render 
files and freeing disk space. Periodically, you may want to remove

m render files from deleted or old projects

m unnecessary render files for existing projects, such as those at render quality levels that 
you no longer need

The Render Manager finds files from unopened projects as well as open projects. (It doesn’t 
search disks that aren’t specified as scratch disks.) You can use the modification dates for files 
displayed in the Render Manager to help you determine which files you no longer need. If you 
delete render files for projects you’re still working on, some rerendering may be required.

Important  Do not delete render files when you’re working in the Finder. Instead, use Final 
Cut Pro’s Render Manager to delete render files.
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Viewing or Deleting Render Files

In the Render Manager, files are organized into folders by project and sequence; filenames 
show the render quality level. The Last Modified date column shows the last time a render 
file of that quality was written into that folder.

To view or delete render files:

1 Choose Render Manager from the Tools menu.

The Render Manager displays a list of all Final Cut Pro render files on designated scratch disks. 

2 Click in the Remove column next to each file you want to delete, then click OK.

All files tagged for removal (checked) are deleted from the scratch disk.

Preserving Render Files

When you make changes to effects, composited media, and other edits that have already 
been rendered, the render file for the affected item is no longer valid. If the project has been 
saved with the render file, then the render file will be deleted either when the project is 
saved again or when the change falls off the “Undo queue” (the series of changes that can be 
reversed with the Undo command in the Edit menu), whichever is later. If the project has not 
been saved since the render file was created, then the render file will be deleted when the 
new change falls off the Undo queue.

You can keep your important render files by nesting sequences.

Important  Deleted render files cannot be restored with the Undo command.
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Using Nested Sequences to Preserve Render Files

You can preserve render files for a sequence or for audio clips within a sequence by nesting 
that sequence within another sequence. A nested sequence takes on the render quality of the 
main sequence (also called the parent). Nesting is particularly useful for protecting the 
render files for audio clips.

Before nesting one sequence into another, make sure that the nested sequence has the same 
render settings (frame rate, frame size, and compression settings) as the parent sequence.

Note:  Nested sequences may require separate rendering in these instances:

m If the parent sequence modifies a nested sequence, the nested sequence must be 
rerendered in the parent sequence. Modifications include any compositing, speed 
changes, or changes in filters, transitions, or other effects.

m If a nested sequence is on the base track, the alpha channel type is set to none. If it is on a 
higher track, the alpha channel type is set to straight. If the alpha channel for the nested 
sequence is set to none, the clips it contains do not need to be rerendered. The rendered 
files will be retained as long as they do not need to be combined with other tracks in the 
sequence, but the clip will be opaque.

For more information, see “Nesting Sequences” on page 937.

Saving Render Files When Turning Off Track Visibility

When you turn off a track’s visibility in the Timeline, any render files associated with that 
track are lost. You can avoid losing the track’s render files by undoing the change of track 
visibility before making enough changes that you exceed the levels of undo allowed in your 
preferences settings.
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C H A P T E R

24

24 About Real-Time Effects

Rendering is the process of combining your video and audio with effects you’ve applied, 
such as transitions or filters, one frame at a time, and creating a new render file on disk. 
Depending on the sequence, rendering can take quite a bit of time. However, Final Cut Pro 
includes real-time editing features that can be used in conjunction with a real-time PCI card. 
Real-time editing lets you see your effects played back in real time, on the fly, without waiting 
for rendering first.

For example, if you have a real-time PCI card, when you apply a wipe dissolve between 
two clips, you can instantly play back the transition to see how looks. Without the real-time 
hardware, you’d have to spend time rendering the transition before playing it back to see the 
final effect. 

Using a real-time system for editing, effects, and compositing can be a great advantage for 
professionals. Because you don’t have to render, you can spend your time creating, 
experimenting, and being more productive.

The specific real-time effects and features that are available in Final Cut Pro depend on the 
capabilities of your real-time card. For detailed information and installation instructions, see 
the documentation that came with your computer and real-time card.

What Do I Need for Real-Time Editing in Final Cut Pro?

Final Cut Pro’s built-in real-time capabilities work in conjunction with your computer 
hardware to process effects. You need a real-time PCI card installed in your computer to take 
advantage of these benefits. The real-time card processes some of the effects that are 
normally handled by your computer, only in much less time.

m Typical recommended processor and bus speed:  G4 400 mHz with 100 mHz PCI bus

m Typical recommended RAM:  256 MB
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m Required:  real-time PCI card installed in your computer

For more information about real-time PCI cards that work with Final Cut Pro, see the Final 
Cut Pro Web site at www.apple.com/finalcutpro

For specific information about what your real-time card can do in Final Cut Pro, see the 
documentation from the card’s manufacturer.

What Effects Are Available in Real Time?

If you have a real-time PCI card installed in your computer, Final Cut Pro detects the card and 
shows all available real-time effects in boldface. 

This includes effects available in the Effects tab in the Browser (above) and the Effects menu. 

Note:  The effects shown in boldface are based on the current sequence presets and will play 
back in real time in sequences created with those presets (shown in the Sequence Presets tab 
of the Audio/Video Settings dialog box, which you open by choosing Audio/Video Settings 
from the Edit menu). If you have sequences open that were created with different sequence 
presets, the effects shown in boldface may not play back in real time in those sequences. For 
detailed information about what effects are available in real time, see the documentation that 
came with your PCI card.

Real-time effects 
appear in boldface.

Real-time effects are 
listed in boldface.
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What About Rendering and Real Time?

There are two render status bars in the Timeline above the ruler: the upper one for video and 
the lower for audio. As you create a sequence, indicators appear so you know which sections of 
the sequence require rendering to play back smoothly at the selected render quality.

If your system has a real-time PCI card, the render bar shows one of two colors for 
real-time effects:

m Green: This indicates that the media does not need rendering; your sequence contains 
the exact effect you see. If you export the sequence or output it via FireWire, however, 
rendering may be required. 

m Yellow: This means that the effect you see during real-time playback is an approximation 
of the effect you’ve specified. For example, you may have added a wipe transition and set 
its angle for 37 degrees. If your real-time PCI card can only display the wipe angle at 45 
degrees, you’ll see the card’s approximation during real-time playback. You can see the 
effect as you specified it (the 37-degree angle) by putting the playhead over a frame of the 
effect in the Canvas or Timeline or rendering the effect before playing it back.

For more information about rendering and other indicators in the render bar, see Chapter 23, 
“Rendering,” on page 1065.

The render bars 
appear near the 
top of the Timeline.
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25 Choosing an Output Method 
for Final Distribution
Once you’ve captured and edited your project, you’re almost finished. Now you need to 
determine how to distribute your work and choose an appropriate output method. Digital video 
provides many options, depending on your audience and how you plan to use your media.

About Options for Distribution
There are many ways to export or distribute your media from Final Cut Pro, each with 
advantages and disadvantages. This section provides an overview to help you decide which 
method is most appropriate for your situation.

m Analog or digital videotape

m Video to film transfer

m DVD

m CD-ROM

m QuickTime Fast Start or QuickTime streaming movies for the Web

m Digital delivery of QuickTime files

m DV stream files for use with iMovie

m Digital delivery of numbered image sequences

m Digital delivery of audio tracks only

m EDL export

m OMF audio export
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Many of the types of output you can create in Final Cut Pro use a codec, a compression/
decompression method that mathematically describes how an uncompressed video signal can 
be compressed. Codecs are used by QuickTime to create and play back different formats of 
digital video. For detailed information, see “More About Video Compression” on page 1110.

Analog or Digital Videotape

Output to analog or digital videotape is the lowest common denominator for video 
distribution. Final Cut Pro makes it easy to export your edited sequence back to tape, 
regardless of the format of videotape you captured from. You need to consider the tape 
format for your output.

m VHS:  If you plan to send a copy of your product to someone who doesn’t work at a video 
facility, it’s best to output to VHS, since you can’t guarantee that the recipient will have 
the same video equipment that you used. For captured DV material, you send the output 
through your DV camcorder or deck or your DV-to-analog converter box to a VHS deck 
for recording. See Chapter 2, “Setting Up Your System,” for more information.

m DV videotape:  If DV is your main acquisition format and you’re simply outputting your 
final sequence to tape for your own use, send your edited sequence back to DV 
videotape. 

m Other formats:  If you plan to send your tape to a tape duplication facility to have dubs 
(duplicates) made or for long-term archival use, consider other tape formats such as Beta 
SP and Digital Betacam. Consider these questions:

m How durable is the media?  Can it take the strain of repeated play, rewinds, and 
physical abuse? 

m How popular is the format?  Will the tape duplication facilities and post houses you 
use be able to play your tape on one of their machines, or will they have to rent 
something special?

For more information about the output to tape options in Final Cut Pro, see “Outputting to 
Tape” on page 1108. Also see Chapter 26, “Recording to Videotape,” and Chapter 27, “Editing 
to Tape.”
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Video to Film Transfer

Consider transferring your edited sequence from video to film if you intend to show 
your project at film festivals that don’t project video, or you want your project to have 
theatrical distribution.

Most festivals accept submissions on videotape, so you can output your project to tape to 
submit it and then do the film transfer after it’s been accepted. An increasing number of 
festivals are projecting video, however, so check to see what their requirements are before 
deciding how to output your video.

For theatrical distribution, you should transfer to film. Although some metropolitan theaters 
have begun limited digital projection, theatrical distribution on film is still the reality for most 
of the world. 

Choosing video equipment and settings acceptable to your transfer facility

Research the film transfer facility you want to use before you start shooting. There are many 
transfer facilities available worldwide that use different equipment and methods. Check a 
facility’s track record and demo reel. Once you’ve found a place you like, ask questions such 
as these:

m When shooting your video, how should you light your scene? What gain settings should 
you use on your video camera? Do you need to avoid excessive contrast?

m Should you shoot 25 fps (frames per second) PAL or 29.97 fps NTSC? 

m Should you set your video camera to record progressive scan or interlaced video?

m Will you have a sound recordist using a separate DAT recorder? How should you 
resynchronize your audio to match your video?

m Should you use a special camera capable of shooting high-resolution 16:9 using 
widescreen CCDs, or a standard camcorder with an anamorphic lens?

m Will the transfer facility require you to edit using standard effects at standard settings (for 
example, using 50% slow motion instead of 57%)? 

m Should you do your own filtering, effects, and color correction, or should you do it all at 
their facility with their equipment?

As an editor, your primary responsibility is to deliver your edited sequence to the film 
transfer facility in a format they can use. Some facilities prefer digital files, in the form of 
QuickTime files or numbered image sequences, especially with shorter projects. Others will 
accept your finished project on a digital tape format, such as DV or Digital Betacam.
 Choosing an Output Method for Final Distribution 1099



                     
Technologies used to transfer video to film

There are three technologies used to print video to film.

m Electronic Beam Recording (EBR):  Generally the most inexpensive method.

m Digital CRT Transfer:  Costs more than EBR but produces higher-quality transfers.

m Digital Laser Transfer:  The most expensive. Considered to provide the highest quality.

Despite these qualifications, a particular project may look better when transferred using a 
less expensive method. Ask the transfer house which transfer method will work best for you.

DVD

DVDs are high-density optical discs that can store more than 4 gigabytes (GB) of data. When 
a DVD is authored for use in a DVD video player, a special file system (microUDF) is used to 
store the video, audio, and interactive streams of data in a way that any standard DVD video 
player can read. 

There are two ways to prepare your sequence for DVD playback:

m Convert to an MPEG-2 file:  All DVD video is compressed using MPEG-2, which is a codec 
for creating highly compressed, high-quality digital video. An MPEG-2 encoder doesn’t 
come with the standard QuickTime installation, but if DVD Studio Pro is installed, an 
MPEG-2 encoder will appear in the list of QuickTime codecs. Otherwise, there are third-
party MPEG-2 encoders available.

m Export as a QuickTime file:  You can export your edited sequence as a broadcast-
resolution QuickTime clip and then either import it into iDVD or compress it using a 
compression tool from another manufacturer. 

For more information, see “Outputting QuickTime Files” on page 1109.

DVD audio is usually converted to AC-3. AC-3 is a method of mixing and encoding surround 
sound from Dolby Laboratories. If DVD Studio Pro is installed, it’s fairly easy to export the 
stereo mix from your sequence to it for AC-3 conversion. Otherwise, you can use the OMF 
Audio Export command to deliver all of the audio from your edited sequence to a capable 
audio post-production facility. For more information, see Chapter 30, “About Multi-Track 
and OMF Audio Export,” on page 1211.

After you compress your video, you need to create the overall DVD file structure using a 
DVD authoring application such as iDVD or DVD Studio Pro. For more information, see the 
documentation of the authoring application.
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CD-ROM Videos

As for DVDs, video for CD-ROM discs is highly compressed. However, video for CDs can 
take advantage of a greater variety of codecs. The disadvantage is that you can’t be sure what 
kind of CD-ROM drive your audience will have. Therefore bandwidth requirements tend to 
be smaller than with DVDs and the maximum volume size of a CD is 650 megabytes. 

There are three popular codecs for CD-ROM compression—MPEG-1, Sorenson, and Cinepak.

m MPEG-1:  MPEG-1 is the codec used for the Video CD format. Video CDs are not related to 
DVDs or DVD-ROM discs but are closer to the CD-ROM format. MPEG-1 files can be used 
on regular CDs formatted for either the Mac OS or Windows. MPEG-1 was designed for 
optimum playback at smaller data rates and is primarily used to produce non-interlaced 
320 x 240 video files. 

MPEG-1 files are supported on a wide variety of systems and are compatible with 
QuickTime. MPEG-1 requires a fair amount of processor power to play back in real time, but 
most current Macintosh computers are capable of MPEG-1 playback using QuickTime Player.

m Sorenson:  Sorenson compresses video down to extremely low bandwidths, while at the 
same time displaying an exceptionally high-quality image for the size. Sorenson replaces 
the once popular Cinepak on computers with QuickTime version 3 and higher. Sorenson 
is good for CD-ROM video and is also used to compress video for the Web.

m Cinepak:  This was one of the first codecs that could compress acceptable-looking video at 
data rates small enough to play back from 1x and 2x CD-ROM drives. Until the development 
of the Sorenson codec, Cinepak was the codec of choice for CD-ROM delivery. If your 
audience may not have QuickTime version 3 or higher, you may need to use this codec. If 
you have a choice, use the Sorenson codec because it produces better results.

For more information about codecs, see “More About Video Compression” on page 1110. For 
information about exporting QuickTime files, see “Outputting QuickTime Files” on page 1109.

QuickTime Movies for the Web

This type of output is the most highly compressed of all. Clips compressed for Web playback 
generally use the Sorenson codec because of its high quality and low bandwidth. There are 
two ways to distribute QuickTime video on the Web—as QuickTime Fast Start movies or 
QuickTime streaming movies.
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About QuickTime Fast Start Movies

QuickTime Fast Start movies can easily be added to any HTML page using the standard 
<embed> tag. (For more information on the syntax of the embed tag, go to 
www.quicktime.com/quicktime/authoring/embed.html) When a page containing a Fast Start 
movie is accessed, the QuickTime movie downloads like any other graphic or media file.

When enough of the movie has downloaded so that it can play without running into the end 
of what’s been downloaded already, it starts playing automatically. The speed of this process 
depends on the end user’s connection speed. 

To create this type of movie, select the Fast Start movie setting when you export your edited 
sequence as a QuickTime file. Fast Start movies are most effective with shorter clips when 
quality is more important than download speed. 

About QuickTime Streaming Movies

A QuickTime streaming movie begins playing within a few seconds of being accessed, if the end 
user has the appropriate bandwidth. Because more compression is required to keep the video 
stream real-time, streaming movies usually have lower frame rates and smaller frame sizes.

Streaming movies must be hinted, a process that defines how a movie will be broken down 
into streamable pieces. That information is stored in a special track within the QuickTime 
file. Choose the Hinted Streaming option when you export your edited sequence as a 
QuickTime file. 

Note:  QuickTime Streaming Server software must be installed on the server that hosts your 
hinted QuickTime files.
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For information about exporting QuickTime files, see “Outputting QuickTime Files” on 
page 1109. 

Digital Delivery of QuickTime Files

In today’s post-production environment, it’s common for several editors, compositing artists, 
and animators to contribute material to a single project. If you’re handing off a clip to 
someone else for use on another editing or compositing system, the easiest thing to do is to 
output and send a full-resolution QuickTime file.

Three important considerations are file size, image quality, and file compatibility. You can use 
several video codecs to export your QuickTime movie—Uncompressed, Animation, Apple M-
JPEG, JPEG, and third-party codecs.

Uncompressed

This isn’t a codec, but a way of storing QuickTime movies with no compression at all. Since 
applying compression generally results in video artifacts, this guarantees the highest quality. 
Unfortunately, this also guarantees enormous file sizes. Uncompressed movies can consume 
up to 32 MB per second of video. Also, uncompressed movies will not play back in real time 
on most systems, making them useful primarily for file exchange. 

More on QuickTime Movies

DVDs, CDs, and streaming Web videos all start out as QuickTime movies. With the 
appropriate QuickTime codecs (available from other manufacturers) installed on your 
computer, you can turn your edited sequence into a compressed digital movie 
appropriate for any of these purposes. There are two ways to do this.

m You can compress your edited sequence right out of Final Cut Pro using the 
appropriate QuickTime codec and the Export QuickTime command.

m You can export a full-resolution version of your edited sequence as either a self-
contained or a reference QuickTime movie for import into a dedicated video 
compression application using the Export Final Cut Movie command.

DVDs, CDs, and streaming Web videos are all highly compressed, but to look their 
best, they need to start out with the highest quality video possible. Don’t digitize your 
video at a lower quality setting or a smaller frame size because “it’s going to be 
compressed anyway.” For a video codec to do its best work, it needs as much quality 
and as little noise as possible. Broadcast-quality video, whether from DV or an analog 
source, is the best source.
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Uncompressed movies can have an alpha channel. Alpha channels define levels of 
transparency in your movie and are useful if you’re delivering an effects shot for use in 
someone else’s composition. For more information on alpha channels, see “Using Video and 
Graphics Clips With Alpha Channels” on page 918.

Animation

The Animation codec was developed for computer-generated imagery, which often has large 
areas of uniform color and little, if any, noise. It is a lossless codec, which means it doesn’t 
degrade quality or add artifacts to your video when it applies compression. For more 
information, see “More About Video Compression” on page 1110.

Video footage, which generally has more grain, noise, and variations of texture and color 
than animated material, may not compress as much as with other methods. This codec is 
used more frequently than Uncompressed. 

Animation movies will not play back in real time on most systems. Animation movies can also 
have an alpha channel.
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Apple M-JPEG

There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. These are variable data rate 
codecs similar to the ones used by video capture cards, such as the Pinnacle Targa and 
Aurora Igniter. If you need to deliver heavily compressed material to keep files small, 
consider using these codecs. M-JPEG is a lossy codec and will result in artifacts in your final 
video. The severity of these artifacts depends on the data rate you choose. 

Several capture and playback cards on the market can play back either M-JPEG A or M-JPEG B 
in real time with little or no rerendering. This makes file interchange very fast. Consult the 
manufacturer of the capture card you’re delivering to find out whether you should use
M-JPEG A or B.

Apple M-JPEG movies cannot have alpha channels.

JPEG

JPEG is similar to M-JPEG, except that the compression artifacts can be less severe at similar 
data rates. JPEG movies may play back in real time on most systems, depending on the 
system’s speed and the data rate of the movie.

JPEG movies cannot have alpha channels.

Apple DV-NTSC and DV-PAL

The Apple DV codec is used to capture video digitally from FireWire-enabled devices such as 
camcorders, decks, or analog to DV converter boxes. The Apple DV codec imports DV and 
Final Cut Pro processes it as YUV encoded video, so that what you output has the same color 
and brightness levels as what you captured. There are separate codecs for NTSC and PAL.

Third-party codecs

There are several manufacturers of video editing solutions, most of which use variations of 
the M-JPEG codec. Many of them make software-only QuickTime codecs that you can install 
in your System Folder, which enables you to render movies that can be played back on these 
systems with little or no rerendering. For more information, contact the manufacturer of the 
editing system.

Most third-party codecs cannot have alpha channels.
 Choosing an Output Method for Final Distribution 1105



              
DV Stream Files

If you want to output video files for use with iMovie, you can export your movie using the 
DV Stream format. DV Stream files encode the audio and video together digitally, just as 
they appear on a DV videotape. For more information, see “Outputting QuickTime Files” on 
page 1109.

Note:  DV Stream files are not the same as QuickTime files using the Apple DV codec. 

Digital Delivery of Numbered Image Sequences

If you need to output a shot that you’ll hand off for use on an editing or compositing system 
that doesn’t recognize QuickTime files, you can export your edited sequence as an image 
sequence. An image sequence is a series of numbered image files, all stored in a folder. Each 
image file contains one frame of your video. If your frames are interlaced, both fields are 
sandwiched together in one file. 

Most image sequences are exported uncompressed, so the resulting size of all these files 
together may be quite large. Because of this, it’s common practice to deliver the files using a 
streaming tape backup system. 

Several graphics file formats are commonly used when creating image sequences for cross-
platform delivery, although Final Cut Pro is capable of exporting many more, including Targa, 
PICT, TIFF, and SGI. Check to see which one is preferred in your situation. 

Since an image sequence is simply a folder full of image files, there is no audio automatically 
associated with them. You need to export your audio as a separate audio file (in AIFF, Wave, 
or Sound Designer II format, for example).

Note:  Most image sequence formats accommodate alpha channels.

For more information, see “Outputting QuickTime Files” on page 1109.

Delivery of Audio Tracks Only

You can export just the audio portion of your clip or edited sequence. The two most popular 
audio formats for cross-platform file exchange are AIFF and Wave files. 

For more information on exporting audio-only tracks using the Export QuickTime command, 
see Chapter 28, “QuickTime Export of Video, Images, and Sound.” For more information 
about exporting audio OMF files, see Chapter 30, “About Multi-Track and OMF Audio Export.”

Important  Be sure to tell the recipient of your numbered image sequence what the original 
timebase of your exported program was, especially if you’re sending a sound file with 
synchronized audio along with it. If it was 29.97 fps, the NTSC broadcast standard, they need 
to know that so that they can correctly resync the audio track you provide.
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EDL Export

If you want to recreate your edited sequence in an online editing suite or using another 
nonlinear editing program, you can export an EDL, or Edit Decision List. This list is a text file 
that describes your edited sequence, shot by shot. 

EDLs originated as a way for linear edit controllers in online editing suites to keep track of all 
of the edits used to put a master tape together. Over time, EDLs evolved into a way for offline 
editors using less expensive equipment to reproduce their edits when they went back to 
their original tapes in an online editing session, known as the offline/online process. Today, 
EDLs can also be used for moving a project from one manufacturer’s nonlinear editing 
application to another’s, even if their project files are incompatible. 

Final Cut Pro can export and import EDLs in a variety of formats. For more information about 
EDLs and how to export them, see Chapter 29, “Working With Edit Decision Lists (EDLs) and 
Batch Lists.”

OMF Audio Export

When you export audio to OMF, only the audio tracks in your edited sequence are exported. 
This method is used to deliver your edited audio tracks to OMF-compatible digital audio 
workstations (DAWs). EDL export generally limits you to a maximum of four tracks of audio 
and only describes audio that was captured via a timecode-controllable device. OMF export, 
however, allows you to export as many tracks of audio as you have enabled in your edited 
sequence.

An OMF file also contains all the audio clips you used in your edited sequence, including all 
synced sound, music, and sound effect clips. You can send your edited and synchronized 
audio tracks to an audio post-production facility quickly and easily, maintaining all track 
separations, edit points, and video sync. 

Note:  OMF audio does not export audio overlay levels or audio filters. 

For more information about exporting audio OMF files, see Chapter 30, “About Multi-Track 
and OMF Audio Export.”

Important  Maintaining high quality in your captured audio is critical if you plan to export 
audio as OMF files. Since you’re delivering audio that you’ve captured, instead of having your 
audio post-facility recapture audio for you, this is your only chance to make sure that your 
audio is recorded properly, with good levels and no distortion. For more information on 
importing audio, see Chapter 9, “Importing Graphics, QuickTime, and Audio Files.”
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Outputting to Tape
There are three ways to output your video clip or edited sequence to tape in Final Cut Pro—
playing back from the Timeline while you record, printing to videotape, and editing directly 
to videotape.

Playback from the Timeline

With all your transitions and effects rendered in the Timeline, the easiest way to output your 
sequence is to press the Record button on your connected camcorder or deck, then play 
your clip or edited sequence in the Timeline. Make sure that you enable external video 
before playing back. For more information, see “Recording From the Timeline” on page 1116.

Printing to videotape

A more controlled but flexible way to output your clip or edited sequence is to use the Print 
to Video command. This method automatically renders everything that needs to be rendered 
before outputting. It also allows you to add elements, such as black, color bars, tone, a slate, 
and a black trailer, along with your video. You can also loop playback of your video to tape 
multiple times. For more information, see Chapter 27, “Editing to Tape.”

Editing to tape

If you’re using a device-controllable camcorder or deck, you can use the Edit to Tape 
command to perform precise insert and assemble edits onto a timecode striped tape. This 
method uses the standard rules of three-point editing, so you can pick either a start or an 
end point on your destination tape, then place your clip or sequence forward or backward 
from that point.

This method is useful for editing a project in sections, then editing all the sections together 
onto one tape. It can also be used to reedit a section of a program already on tape without 
outputting the entire program again. Editing to tape also allows you to add the same black, 
color bars, and slate elements that the Print to Video command does. 

Note:  Insert edits work only on video devices that support them. For more information, see 
the documentation that came with your video device.

For more information, see Chapter 27, “Editing to Tape.”
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Outputting QuickTime Files
To output QuickTime movies for file exchange or multimedia use, you can export your video 
clip or edited sequence as a Final Cut Pro Movie or as a QuickTime movie. If you have several 
clips and sequences, you can also export them all at one time, called a batch export.

Exporting a Final Cut Pro movie

The Export Final Cut Movie command creates a QuickTime movie of your selected clip or 
sequence, based on the sequence settings currently selected. Use this command if you want 
to create a full-resolution version of a selected clip or sequence. You can output this type of 
movie as a self-contained version of your sequence or a reference movie.

m Self-contained movie:  If you choose the Make Movie Self-Contained option, the entire 
edited sequence will be rendered, if necessary, and copied into a completely self-
contained QuickTime file. This is ideal if you want to send the QuickTime movie to 
someone else without sending all the source clips as well. 

m Reference movie:  A reference movie contains pointers to the source QuickTime files 
that it uses. Since it doesn’t contain any actual video (except for the parts of your edited 
sequence that still need to be rendered), it takes very little disk space and is fast to create. 
To any other application, a reference movie looks and acts exactly like a self-contained 
QuickTime movie. This makes it ideal for use with third-party compression applications 
that are installed on the same workstation as your project.

Exporting a QuickTime movie

The Export QuickTime Movie command allows you to create variously compressed versions 
of your selected clip or sequence using one of a variety of codecs and settings. This option 
lets you specify what you want to export—a QuickTime movie, a DV Stream file, or a 
numbered image sequence. If you want to create a highly compressed QuickTime movie, you 
can choose from a list of settings or make your own settings using the Options button.

Doing a batch export

You can use the Batch Export command to export multiple clips or sequences as QuickTime 
movies. This is particularly useful if the clips or sequences are long and will take a while to 
export. You can set up a batch export, give each clip or sequence the QuickTime settings you 
want it to have, and let Final Cut Pro do all the work while you take a break and go out to see 
someone else’s movie.

For detailed information about these options, see Chapter 28, “QuickTime Export of Video, 
Images, and Sound.”
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More About Video Compression
Video compression is used by nearly every computer-based editing system. Many systems can 
edit uncompressed digital video. But because of storage space requirements and equipment 
expenses, the vast majority of desktop editing systems use compression.

Compression also allows video to find its way into many lower-bandwidth applications. For 
example, Web-based video and CD-ROM video would be impossible without sophisticated 
forms of video compression that dramatically reduce file sizes while maintaining acceptable 
levels of quality.

The enabling technology of video compression is the codec. Codecs are extensions used by 
QuickTime to create and play back different formats of digital video. A codec mathematically 
describes how a video signal can be squeezed down into less space. 

Uncompressed video can be as much as 32 MB per second (including an alpha channel, 
which is not normally used for regular video playback). However, video compressed with the 
M-JPEG codec, at a ratio of approximately 2:1 (considered to be exceptionally high quality), is 
as little as 10 MB per second, depending on the capture card being used. Offline quality M-
JPEG video can be as little as 1 MB per second and Web video, compressed with the 
Sorenson codec, is often 300K per second or smaller.

Note:  The expression of megabytes (MB) or kilobytes (K) per second or per frame is 
referred to as the video clip’s data rate. Knowing the data rate and codec of a QuickTime 
movie gives you some idea of how much it has been compressed.

Codecs are either lossless or lossy. Lossless codecs reduce the file size of a video clip without 
affecting the image quality. Lossy codecs reduce the file size of a video clip by discarding 
actual bits of information from the video clip, reducing image quality by an extent that 
depends on the data rate of the clip and the codec used.

Codecs use different mathematical models of video compression. Different codecs may have 
different perceived visual quality at the same data rate. The two primary ways to compress 
video are using spatial compression and temporal compression. Most codecs use variations 
of both of these compression methods in combination. 
m Spatial compression

This type of compression compresses every frame in the video clip by a given rate. The 
most obvious sign of spatial compression is either a fringing around the edges of high- 
contrast objects with subtle compression, or a blockiness to the picture when more 
extreme compression is applied. You can adjust spatial compression using the Quality 
slider in the QuickTime Compression Settings dialog box.
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m Temporal compression

This type of compression is applied by comparing one frame of video to the next one in 
time. If there is little motion, resulting in no variation from one frame to the next, then 
temporal compression is more easily applied. Lots of motion, frequent cuts, or noise in 
the image makes temporal compression more difficult to apply. For example, a subtle 
strobing in the moving part of a video images is a sign of excessive temporal compression.

Temporal compression is represented by the keyframe rate set in the QuickTime 
Compression Settings dialog box. Keyframes are compressed using spatial compression 
only and are used as reference frames. During compression, the codec compares the 
interframes, which are all the frames between two keyframes, to the previous keyframe 
and discards any visual data that appears to be similar to the keyframe. Strobing is a result 
of keyframes showing up as strong, clear images, with interframes fading together into a 
blurred image.

A high number of keyframes ensures a higher quality and larger file size, while fewer 
keyframes reduce the quality and dramatically reduce the file size. A good codec can make 
intelligent decisions about where more or fewer keyframes are needed, based on the 
amount of change from one frame to the next. The Cinepak and Sorenson codecs rely 
heavily on interframes to achieve small video file sizes.

Different codecs require different amounts of processor power to decompress a digital video 
file into viewable form in real time. Some codecs use your video capture and playback 
hardware to help with this decompression. Other codecs are optimized to play back in real 
time using only software and your computer’s built-in processor.

QuickTime comes with a variety of codecs useful for different purposes. By purchasing or 
downloading additional codecs, you can expand QuickTime’s ability to encode and decode 
video clips using different kinds of video compression to new formats. In Final Cut Pro, 
QuickTime capabilities are available within the Export to QuickTime compression settings. 
For more information, see Chapter 28, “QuickTime Export of Video, Images, and Sound.”
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26 Recording to Videotape

When you’re ready to send your clip or edited sequence to videotape, you have two 
options:  You can record directly from the Timeline or you can use the Print to Video 
command.

m Record from the Timeline:  The easiest way to output to tape is to play the sequence in 
the Timeline as you record it on your connected video equipment. If you want to show 
black before and after your program, you edit it into the Timeline using the Slug 
generator. For more information, see “Using Generators” on page 1057.

m Print to Video:  The Print to Video command lets you send an entire edited sequence or 
clip to videotape with more control of its elements. You can also output a section of a 
sequence or clip by defining it with In and Out points. You can include elements on the 
tape such as color bars and tone, a countdown, a slate, and a black trailer, along with your 
sequence or clip. You can also loop your footage if you want to output your program 
multiple times on the same tape.

Note:  You can use the Print to Video command even if your video equipment does not 
have device control. 

If you need to output your clip or sequence to tape more precisely using device control, you 
can edit directly onto videotape. For more information, see Chapter 27, “Editing to Tape.”
 1113



Setting Up to Record to Videotape
Before you can record from the Timeline or use the Print to Video command, make sure that 
your target video device is connected properly and your software settings are correct. 

Step 1: Connect your video equipment and set it to VCR mode

Make sure your video equipment is connected to your computer and turned on. For more 
information, see Chapter 2, “Setting Up Your System.” 

Make sure your camcorder or deck is set to VCR (sometimes labeled VTR) mode. Final Cut 
Pro cannot record to video equipment that is in Camera mode. If your video device has 
multiple inputs (for example TV, Line 1, and Line 2), make sure the input that’s connected to 
your computer is the one that is selected. 

Step 2: Make sure Final Cut Pro is set to output video

Make sure that your Easy Setup is set to output external video to your video configuration. 

If you’re using a customized Easy Setup, make sure that you choose the correct settings in 
the External Video Settings tab of the Audio/Video Settings window. The two pop-up menus 
let you send video out of the appropriate video interface, whether it’s the FireWire port or an 
approved third-party capture card.

 

Make sure the 
external video 
settings in your 
Easy Setup are 
appropriate for your 
video equipment.

If you’re using a 
customized Easy 
Setup, choose 
the external video 
options from these 
pop-up menus in the 
Audio/Video Settings 
window.
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m View During Playback Using:  Choose how you want to view video when playing 
sequences and clips from the Viewer or Timeline.

m View During Print to Video Using:  Choose a different video capture interface from the one 
you’re viewing the Timeline with when using the Print to Video and Edit to Tape commands. 
Choose “Same as Playback” if you always want to output using the same interface.

For more information on configuring custom external video settings, see “Specifying External 
Video Settings” on page 132.

It’s a good idea to turn on “Report dropped frames during playback” in the General tab of 
the Preferences window. Final Cut Pro then warns you of any dropped frames so you can find 
and correct whatever’s causing them before you output all of your program to tape. For 
more information, see “Setting General Preferences” on page 885.

Step 3: Cue the videotape

Cue the videotape to the point where you want to start recording. If you’re outputting to a 
tape that has previously recorded material on it, make sure that the write-protection tab is in 
the write, or unlocked, position. Double-check to be sure you don’t copy over a tape that has 
source media for your program or anything else you don’t want to lose.

If you’re using a consumer mini-DV device and you fast-forward past prerecorded material 
(so there’s some blank tape between it and what you’ll output), the DV timecode resets to 
00:00:00:00.

Step 4: Set the appropriate render quality

Make sure the render quality is set to the desired level. Better render quality settings will 
improve the quality of your output, while lengthening render times and increasing the size of 
the rendered files. For more information, see Chapter 23, “Rendering.”

To change the render quality:

m Open the sequence or clip in the Timeline, then choose an option from the Render 
Quality pop-up menu. 

Choose the render quality 
setting from the Render Quality 
pop-up menu in the Timeline.
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Step 5: Test your playback

Make sure everything is working properly before you start recording. Move the playhead to 
the desired position in the Timeline, then press the Space bar to play back your clip or 
sequence. If you have an external monitor connected to your video device, the clip or 
sequence will play on it, as well as on your computer’s monitor.

Recording From the Timeline
Once your equipment is set up and Final Cut Pro is configured for recording to videotape, 
you’re ready to record. The simplest way to output your video to tape is to press Record on 
your camcorder or deck and play back your sequence in the Timeline. This method will only 
record what’s in the Timeline.

If you want to have black, color bars, or tone before your program starts and black after it 
ends, edit these into the Timeline using the Generator pop-up menu. For more information 
on using generators, see Chapter 22, “Working With Video Filters, Generators, and Speed 
Settings.” 

To record directly from the Timeline:

1 If necessary, render any unrendered effects.

Press Command-R or choose Render All or Render Selection from the Sequence menu. For 
more information, see Chapter 23, “Rendering.”

If you don’t render, all unrendered effects will appear as blue “Unrendered” graphics and 
unrendered audio sections will output as a series of beeps.

Choose options in the Generator pop-up 
menu in the Viewer to add elements 
before or after your program.
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2 In the Timeline, move the playhead where you want to start recording in your sequence. 

The first frame will be recorded immediately after you press Record on your camcorder or 
deck. To avoid an awkward freeze frame at the beginning of your sequence, you may want to 
move the playhead to an initial frame of black. If there’s no black where you want to begin 
your recording, you can edit in a black color matte temporarily. For more information, see 
Chapter 22, “Working With Video Filters, Generators, and Speed Settings.”

3 If you want to loop your sequence, choose Loop Playback from the View menu so there’s a 
checkmark next to it.

When looping is enabled, your sequence will loop endlessly without stopping. There may be 
a slight pause after each loop. If you need a smooth loop, use the Print to Video command 
with looping enabled instead (see “Printing to Video” on page 1119).

Move the playhead 
where you want to 
start recording.

Choose the desired 
render quality.

Choose Loop Playback if you 
want to loop your playback.
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4 Press Record on your camcorder or deck to start recording, then wait a few seconds.

This allows your camcorder or deck to reach a smooth recording speed. Otherwise, you 
could end up with unwanted video artifacts at the beginning of your tape.

5 Choose Play from the Mark menu, then choose an option from the submenu to control how 
your sequence plays back.

m In to Out:  Plays back the sequence from the In point to the Out point. If you haven’t set 
an In or Out point, the sequence plays from the beginning to the end.

m To Out:  Plays from the current position of the playhead on the Timeline to either the 
defined Out point or the end of the sequence.

m Around:  Plays a specified amount of time before and after the position of the playhead, 
based on the pre-roll and post-roll settings in the Device Control Presets tab in the Audio/
Video Settings window. To change these settings, see Chapter 5, “Working With Easy 
Setups, Presets, and External Video Settings.”

m Every Frame:  Plays back every frame of the sequence, whether or not rendering is 
required. If there are transitions or effects in your sequence that haven’t been rendered, 
your sequence will not play back in real time, but every frame will be recorded on tape. 

m Forward:  Plays from the current position of the playhead forward to the end of the 
sequence in the Timeline.

m Reverse:  Plays from the current position of the playhead back to the beginning of the 
sequence in the Timeline. 

Choose an option 
for playing from 
this submenu.
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6 Press the Stop button on your camcorder or deck when the sequence is finished playing in 
the Timeline.

Printing to Video
The Print to Video command is a much more sophisticated way to send your clip or 
sequence to tape. The Print to Video command allows you to include elements in your 
program such as color bars and tone, a countdown, a slate, and a black trailer. These 
elements are then created and recorded to video, along with your sequence or clip, without 
being included in the Timeline. You can also loop your footage as many times as you want, if 
you want to output your program multiple times on the same tape.

Using the Print to Video command requires the same steps to set up as recording from the 
Timeline (see “Setting Up to Record to Videotape” on page 1114). The currently selected 
render quality is used to render any added elements, as well as to render any transitions, 
filters, or effects in your edited sequence. For more information on render quality settings, 
see “Determining the Render Quality Levels You Want” on page 1070.

To print to videotape:

1 Select the desired sequence or clip in the Browser, or open your sequence and make the 
Canvas or Timeline active.

To output part of a sequence or clip to video, open it, then set In and Out points to designate 
the part you want to record to videotape. For more information, see Chapter 12, “Working 
With Clips and the Viewer.”

2 Choose Print to Video from the File menu.

Important  The last frame in your sequence will be held as a freeze frame when playback 
stops. This may be awkward if this frame is not black. To avoid this, use the Slug generator to 
place one second of black at the end of your sequence. For more information, see “Using 
Generators” on page 1057.

Mark In and Out 
points, if desired.
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3 Select elements you want to print along with your sequence or clip.

All selected elements are sent to tape in the order listed. Make sure elements you don’t need 
are not selected. Some of these items may require rendering before you can start recording. 
For a complete explanation of the options available, see “About Print to Video Settings” on 
page 1121.

The Duration Calculator displays the total duration of the program you are outputting, 
including all of the selected elements and their durations. Make sure there is sufficient time 
on your tape before proceeding.

4 When you’re finished setting options, click OK. 

Transitions and effects that require rendering, along with any added elements, are rendered 
at the current render quality level.

5 When a message tells you start recording, press Record on your camcorder or deck. Wait a 
few seconds for your video device to reach a smooth recording speed, then click OK to begin 
recording.

6 When playback is finished, press the Stop button on your camcorder or deck.

Note:  The last frame of your clip or edited sequence is held as a freeze frame until you stop 
your recording device.

In this section, select all of the 
options you want to add before 
the clip or sequence.

Enter options to add a trailer at 
the end of the clip or sequence.

In this section, select
the media you want
to print and choose

looping options.

This shows the total duration of the 
media you’re printing to tape, including 
all of the selected elements.
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About Print to Video Settings

The elements available when using Print to Video have very specific uses to your client, tape 
duplication facility, or broadcaster. It’s important to understand the correct use of these 
elements to avoid confusion.

Note:  All element durations are specified in whole seconds.

Leader elements

m Color Bars:  Adds color bars and a 1 kilohertz (kHz) reference tone, preset to –12 
decibels (dB). Color bars at the beginning of your tape allow the recipients to calibrate 
their equipment to match the color levels and values that your system used when 
outputting your program. The reference tone lets the recipients adjust their playback 
audio to prevent an audio signal that’s too soft or too loud.

If you’re using DV to output to tape, you may not need these elements. If you’re using a 
third-party capture card and you add color bars, your system must be accurately calibrated 
for color. Otherwise, your color bars may be off. If your tape has inaccurate color bars, the 
recipient may do an automatic adjustment without checking the rest of the program, and 
your resulting video will look different from what you intended. For more information on 
color calibration and how to use color bars, see Appendix F, “Video Calibration Using 
Color Bars,” on page 1357.

Make sure that your audio tracks are mixed properly, so the levels are not too soft or too 
loud relative to the 1 kHz reference tone. Audio that’s significantly louder than your 
reference tone may sound distorted when your tape is duplicated. For more information 
on creating a proper mix, see Chapter 17, “Working With Audio.”

m Black:  Adds the specified number of seconds of black between the color bars and slate, 
or at the beginning of the clip or sequence if you aren’t adding color bars.

m Slate:  Allows you to add a slate with information about your program. You select the slate 
source in a pop-up menu. The slate can be the clip or sequence name, text you type in a 
field, or a specified text, PICT, or QuickTime file on disk. A slate should contain 
information such as

m the title of your program

m relevant production credits indicating ownership of the content (such as the producer, 
director, editor, and post-production facility)

m total run time (TRT) of your program

m the starting timecode if it’s not hour 01. This is useful if you’re using a high-end video 
deck to do an insert edit of your program onto a tape with pre-striped timecode. 
In this case, also indicate whether drop frame (DF) or non-drop frame (NDF) 
timecode is being used.

m the date on which the tape is output

m Black:  Adds the specified number of seconds of black between the slate and countdown.
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m Countdown:  Adds a countdown before your sequence or clip. You can use the 10-second 
built-in SMPTE standard countdown or a custom one from a file you select. Countdowns 
are generally used when delivering a tape to a television or cable station for broadcast. If 
the tape is for archival purposes or delivery to a tape duplication facility, a countdown is 
not usually necessary.

Note:  If you choose a custom QuickTime file as your countdown, it will not be changed 
to conform to SMPTE specifications and its duration will be left as is.

Media options and elements

m Print:  Lets you print the entire clip or sequence or just the part specified by the In and 
Out points.

m Loop:  Prints the sequence or clip to tape a specified number of times.

m Black:  Adds the specified number of seconds of black frames to the end of your clip or 
sequence after each loop.

Trailer

m Trailer:  Adds a black trailer at the end of your sequence or clip or at the end of the last 
loop of your clip or sequence. It’s good practice to put a 30-second black trailer at the end 
of your tape so viewers don’t hear loud static as soon as your program ends.

About Standard Element Timing

If you’re outputting your clip or sequence for delivery to a post-production house, tape 
duplication facility, or television station, there are accepted conventions for how leader 
elements are placed on tape. Here is one common way to lay out elements, although 
different facilities have their own standards. When in doubt, ask ahead for what is preferred.

m 60 seconds of color bars and tone

m 10 seconds of black

m 10 seconds of your slate

m 10 seconds of countdown if this is for broadcast, or 10 seconds of black if it’s for duplication
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27 Editing to Tape

The Edit to Tape command is used to edit clips and sequences directly to tape. The Edit 
to Tape window is equivalent to the Canvas, but instead of placing your edited clip or 
sequence into the Timeline, it records it to tape. The Edit to Tape and Print to Tape 
commands handle tracks on a videotape differently. Read the next section to make sure 
you understand the differences.

About Tracks on Videotape
Each videotape has a video track, at least two audio tracks, and a control track. Device-
controllable camcorders and decks also have a timecode track that’s recorded on the tape. 
The video and audio tracks are the same for the Edit to Tape and Print to Tape commands. 
However, the control and timecode tracks are different. 

About the control and timecode tracks

The control track is a series of electronic pulses on your videotape that keep the tape’s 
playback constant as it plays, similar to how sprocket holes regulate film playback. The 
control track does not measure time, but tells your video equipment how fast to play the 
tape. When you record continuous video to tape using the Print to Video command, the 
control track records along with it on a separate track. When you stop recording, the control 
track stops as well. If recording resumes, the control track resumes. 

When the control track is broken by a pause in recording, you may see a slight flaw on the 
video if you’ve used non-DV video equipment. This flaw is caused by a temporary loss of 
timing as the video deck tries to sync with the control track after the pause. Control track 
breaks may not always be noticeable, but they are unprofessional and can be troublesome.

A control track break may also occur if you use the Edit to Tape command to do an assemble 
edit with non-DV video equipment. An assemble edit outputs a clip or sequence to tape so 
that all tracks are recorded simultaneously. When you pause or stop the tape, a break occurs 
across all the tracks on the tape, including the control track.
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Timecode is also recorded onto a separate track on non-DV tape formats. Timecode allows 
your computer to control your camcorder or deck and import or export frame-accurate video 
clips. When you’re recording to tape (using the Print to Video command), abrupt breaks can 
cause subtle gaps in the timecode track. Although these happen less often than control track 
breaks, they can be just as troublesome. 

Avoiding breaks in the control and timecode tracks

To avoid breaks in both the control track and timecode track of a non-DV videotape, you can 
do an insert edit on camcorders and decks that support that feature. An insert edit lets you 
record the video track or audio tracks of a tape using frame-accurate timecode without 
recording onto the control or timecode tracks. This lets you edit different clips onto the 
same non-DV tape without creating breaks in the timecode.

About the Different Edit to Tape Operations
There are two ways to output your material using the Edit to Tape window:  with an assemble 
edit or an insert edit. Which type of edit you can do depends on the equipment you’re using. 
If you’re using a DV device, you can only do assemble edits. If you have other equipment, 
you may be able to do insert edits.

About Assemble Editing

This is the only type of editing available for DV devices. Assemble edits are useful if you’re 
laying down a number of clips or sequences in order, one after the other, from the beginning 
of the tape to the end. It’s generally not a good idea to use an assemble edit if there’s 
material on your tape past the assemble edit’s Out point that you want to preserve. 

An assemble edit overwrites both the control and timecode tracks on your tape, causing a 
control track break and possibly a timecode break as well. In points are frame-accurate, but 
to avoid timecode breaks at the Out point, your edit is extended 2 to 15 frames beyond the 
Out point on the tape, overwriting any material already on the tape. ( With DV equipment, 
this value may vary from .5 to 1.5 seconds). This is considered “clean in, dirty out.”

To perform an assemble edit onto a blank tape, you must have at least six seconds of black at 
the beginning of your selected In point. For more information, see “Prepare your videotape 
with black and code” on page 1133.

For more information on performing assemble edits, see “Performing an Assemble Edit” on 
page 1136.
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About Insert Editing and Previewing

An insert edit allows you to selectively edit video and audio to tape without affecting the 
control or timecode tracks. You can select which elements to output—video, audio 1, audio 
2, or any combination. Unlike an assemble edit, the edit begins and ends at the specified In 
and Out points frame-accurately.

Note:  You cannot perform insert edits or preview edits if you’re using a DV-format 
camcorder or deck. 

Insert edits can only be applied to a tape that has control and timecode tracks already written 
to it. If you’re outputting to a blank tape, you can black and code the tape to prepare it for a 
series of insert edits. For more information, see “Prepare your videotape with black and 
code” on page 1133.

You can preview insert edits on your output monitor. This lets you spot errors before 
recording your tracks to tape. 

For more information on insert edits and previewing, see “Performing an Insert Edit” on 
page 1139.

What You Need to Edit to Tape

The Edit to Tape window allows you to do assemble and insert edits to edit clips and 
sequences onto tape. There are several requirements:

m Your video equipment must support either DV or serial device control.

m Your deck must support recording; you cannot perform edits on play-only decks.

m If you’re going to perform insert edits, your camcorder or deck must support this feature.

About using DV devices

DV devices only support assemble editing. Assemble edits with DV video are “clean in, dirty 
out.” There are no flaws at the edit In point, but there may be some at the Out point. You 
usually won’t get any breaks as long as you assemble sequence by sequence, starting from the 
beginning of the tape and laying down each sequence in order. Also, DV devices cannot 
selectively record onto video and audio tracks individually; you can only record onto all 
tracks at once.

About insert editing

If you’re performing an insert edit with a deck that supports it, you must make sure that both 
your deck and video output card are synced to the same video reference signal (also called 
“house black”). Otherwise your edit might not be frame-accurate.
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About the Edit to Tape Window
In most layouts, the Edit to Tape window appears on top of the Canvas. The Edit to Tape 
window has three tabs.

m Video:  Do your editing here.

m Mastering Settings:  Add settings for elements before and after your edit, such as black, 
slate, or a countdown, and loop your edit.

m Device Settings:  Choose options for your video equipment and how you show video in 
the Edit to Tape window.

Video Tab

m Mode: Choose an option—Mastering or Editing.

Timecode
Duration field

Tabs provide access
to functions.

Current Timecode field

Mode pop-up
menu

Black and 
Code button

Edit Overlay 
(with clip shown)

Device status

Edit buttons

p
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m Mastering:  This is the default mode. Mastering is useful if you want to output an 
entire program with leader, media, and trailer elements, as you can do using the Print 
to Tape command. In Mastering mode, you can only set an In point on the tape. The 
Out point depends on the mastering options you select (which determine the length 
of your material) and the selected In and Out points of the clip or sequence.

m Editing:  In Editing mode, only the selected clip or sequence is recorded to tape. You 
cannot add leader, media, or trailer elements. You can set In and Out points using 
three-point editing. You can also place a shot into a sequence that’s already on tape 
frame-accurately.

m Black and Code:  Lets you record pure black to a videotape, with no audio and 
continuous control and timecode tracks, from the beginning to the end of the videotape.

m Timecode Duration:  Displays the entire time between the In and Out points marked in 
the clip or sequence. If there are no edit points, the beginning and end of the clip or 
sequence are the In and Out points.

m Current Timecode:  Displays the current position of the tape. If you enter a timecode, the 
tape will move to that position.

m Edit Overlay:  Appears when you drag a clip or sequence to the Edit to Tape window. Lets 
you edit and preview your edit.

m Edit buttons:  Click to do an insert or assemble edit or preview your insert edit.

m Device status:  Shows the status of the connected video equipment.

Navigation and marking controls

m Shuttle control:  Drag the tab to the right to fast-forward and to the left to rewind the 
tape. The speed depends on the distance of the tab from the center. When the tab is 
green, playback speed is normal. This control is useful for playing clips at different 
speeds. It also shifts the pitch of audio at variable speeds.

m Jog control:  Use this to move forward or backward a few frames at a time on the tape. 
This is useful for visually locating a specific frame.

m Mark In:  Click to set the frame on your tape where recording will start. 

m Mark Out:  Click to set the frame on your tape where recording will stop.

m Go to In:  Moves the tape to the In point you set.

Jog control

Go to Out

Mark In 
button

Mark Out
button

Go to In

Timecode
for the

In point

Timecode 
for the 
Out point

Shuttle control
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m Go to Out:  Moves the tape to the Out point you set.

Transport Controls

Transport controls let you navigate the videotape.

m Rewind:  Rewinds the videotape.

m Play In to Out:  Rewinds the tape to the current In point you set and then plays forward 
from that point to the Out point you set. If there is no Out point, it plays to the end of 
the tape.

m Stop:  Stops the videotape.

m Play:  Plays the tape.

m Play Around Current:  This is based on the preview pre-roll and preview post-roll 
settings in the General tab of the Preferences window. The tape plays from the playhead 
position at the pre-roll setting and continues through the amount of time specified by the 
post-roll setting.

m Fast Forward:  Moves the videotape forward.

Insert Settings Tab

The elements available when using Edit to Tape have very specific uses to your client, tape 
duplication facility, or broadcaster. It’s important to understand the correct use of these 
elements to avoid confusion.

Fast ForwardRewind

PlayStop Play Around CurrentPlay In to Out
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Note:  All element durations are specified in whole seconds.

Leader elements

m Color Bars:  Adds color bars and a 1 kilohertz (kHz) reference tone, preset to –12 
decibels (dB). Color bars at the beginning of your tape allow the recipients to calibrate 
their equipment to match the color levels and values that your system used when 
outputting your program. The reference tone lets the recipients adjust their playback 
audio to prevent an audio signal that’s too soft or too loud.

If you’re using DV to output to tape, you may not need these elements. If you’re using a 
third-party capture card and you add color bars, your system must be accurately calibrated 
for color. Otherwise, your color bars may be off. If your tape has inaccurate color bars, the 
recipient may do an automatic adjustment without checking the rest of the program, and 
your resulting video will look different from what you intended. For more information on 
color calibration and how to use color bars, see Appendix F, “Video Calibration Using 
Color Bars,” on page 1357.

Make sure that your audio tracks are mixed properly, so the levels are not too soft or too 
loud relative to the 1 kHz reference tone. Audio that’s significantly louder than your 
reference tone may sound distorted when your tape is duplicated. For more information 
on creating a proper mix, see Chapter 17, “Working With Audio.”

m Black:  Adds the specified number of seconds of black between the color bars and slate, 
or at the beginning of the clip or sequence if you aren’t adding color bars.

m Slate:  Adds a slate with information about your program. Choose the slate source from 
the pop-up menu. The slate can be the clip or sequence name, text you type in a field, or a 
specified text, PICT, or QuickTime file on disk. A slate should contain information such as

Select the options 
you want to add 
before the clip 
or sequence.

Enter options to 
add a trailer at 
the end of the clip 
or sequence.

Select the media you want to 
record and choose looping options.
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m the title of your program

m relevant production credits indicating ownership of the content (such as the producer, 
director, editor, and post-production facility)

m total run time (TRT) of your program

m the starting timecode if it’s not hour 01. This is useful if you’re using a high-end video 
deck to do an insert edit of your program onto a tape with pre-striped timecode. In this 
case, also indicate whether drop frame (DF) or non-drop frame (NDF) timecode is used.

m the date on which the tape is output

m Black:  Adds the specified number of seconds of black between the slate and countdown.

m Countdown:  Adds a countdown before your sequence or clip. You can use the 10-second 
built-in SMPTE standard countdown or choose a custom countdown. Countdowns are 
generally used when you deliver a tape to a television or cable station for broadcast. If the 
tape is for archival purposes or delivery to a tape duplication facility, a countdown is not 
usually necessary.

Note:  If you choose a custom QuickTime file as your countdown, its duration will not be 
changed to conform to SMPTE specifications.

Media options and elements

m Print:  Prints the entire clip or sequence or just the part specified by the In and Out points.

m Loop:  Prints the sequence or clip to tape a specified number of times.

m Black:  Adds the specified number of seconds of black frames to the end of your clip or 
sequence after each loop.

Trailer

m Trailer:  Adds a black trailer at the end of your sequence or clip or at the end of the last 
loop of your clip or sequence. It’s good practice to put a 30-second black trailer at the end 
of your tape so viewers don’t hear loud static as soon as your program ends.

Duration calculator

m Media:  Enter the duration of your source media here to be used in calculating the total 
duration, including other elements and looping.

m Total:  Displays the total duration of the program you are outputting, including all of the 
selected elements and their durations. Make sure there is sufficient time on your tape 
before proceeding.

About Standard Element Timing

If you’re outputting your clip or sequence for delivery to a post-production house, tape 
duplication facility, or television station, there are accepted conventions for how leader 
elements are placed on tape. Here is one common way to lay out elements, although some 
facilities have different standards. When in doubt, ask ahead for what is preferred.
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m 60 seconds of color bars and tone

m 10 seconds of black

m 10 seconds of your slate

m 10 seconds of countdown if this is for broadcast (use a standard SMPTE countdown), or 
10 seconds of black if it’s for duplication

After all these elements have played, your program should start at hour 01:00:00:00, unless 
you are given specific instructions otherwise.

m If you’re striping tapes in advance to do a video deck insert edit, start the timecode at 
00:58:00:00 so you can start the leader elements at 00:58:30:00.

Device Settings Tab

m Device Control:  Choose the option for your particular video equipment. For more 
information, see “Viewing Settings for a Preset” on page 106.

m Capture/Input:  Choose a capture preset for how you want Final Cut Pro to show video in 
the Edit to Tape window. If this is set to DV, you preview via FireWire; if you’re using an 
approved analog-to-digital capture card, you may have choices—Composite, S-Video, or 
Component In—based on capture presets in the Audio/Video Settings window. For more 
information about presets, see “Creating a New Preset” on page 108.

Despite the name of this pop-up menu, you are not actually capturing material and 
digitizing it to your computer. When you edit to tape, you’re using material that’s already 
on tape. The only way to preview your edits with material before and after your edit is to 
view, or “capture,” material that’s on the tape.

Setting Up Before You Edit to Tape
Follow these steps before you use any of the Edit to Tape operations.

If necessary, choose device 
control and capture settings 
from the pop-up menus.
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Step 1: Calibrate your timecode

You must calibrate your timecode before editing. This insures that the timecode and video 
device work properly together so your edits are frame-accurate. For more information, see 
“Calibrating the Timecode Signal” on page 249.

Step 2: Connect your video equipment and set it to VCR mode

Make sure your video equipment is connected to your computer and turned on. For more 
information, see Chapter 2, “Setting Up Your System.” 

Make sure your camcorder or deck is set to VCR (sometimes labeled VTR) mode. Final Cut 
Pro cannot record to video equipment that is in Camera mode. If your video device has 
multiple inputs (for example TV, Line 1, and Line 2), make sure the input that’s connected to 
your computer is the one that is selected. Also make sure that your VCR is set to remote 
rather than local so it’s controllable by Final Cut Pro.

Step 3: Make sure Final Cut Pro is set to output video

Make sure that your Easy Setup is set to output external video to your video configuration. To 
view a summary of your Easy Setup, choose Easy Setup from the Edit menu.

If you’re using a customized setup, make sure that you choose the correct settings in the 
Audio/Video Settings window. For more information, see “Specifying External Video Settings” 
on page 134.

Make sure the External 
Video settings in your 
Easy Setup are 
appropriate for your 
video equipment.

For customized 
setups, choose the 
external video 
options from these 
pop-up menus in 
the Audio/Video 
Settings window.
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It’s a good idea to turn on “Report dropped frames during playback” in the General tab of 
the Preferences window. Final Cut Pro then warns you of any dropped frames so you can 
correct what’s causing them before you output all of your program to tape. For more 
information, see “Setting General Preferences” on page 885.

Step 4: Choose device control and capture settings

If necessary, choose device control and capture settings in the Device Settings tab of the Edit 
to Tape window.

To choose device settings:

1 In the Edit to Tape window, click the Device Settings tab.

2 Change your device control and capture settings.

For more information, see “Device Settings Tab” on page 1131.

Step 5: Prepare your videotape with black and code

If your tape doesn’t have preexisting material, you need to “black” your tape. Blacking a tape 
is the process of recording pure black to a videotape, with no audio and continuous control 
and timecode tracks, from the beginning to the end of the tape.

Most blacked tapes start at 00:58:00:00 to allow two minutes of header elements before your 
program. Programs usually start at 01:00:00:00. (This is not true of most consumer DV 
cameras. They will only start recording at 00:00:00:00.) This is set in the Initialize Tape dialog 
box. You will only see it if your deck has a settable timecode generator. You may want to black 
several tapes at a time so they are available when needed.

If you plan to do a series of insert edits to output your whole program onto tape, you must 
use a tape that’s blacked from beginning to end. If you’re assemble-editing a long program to 
a new tape, you don’t have to black the entire tape, but it’s a good idea to black at least 30 
seconds of the tape so you can set an In point in Final Cut Pro. 

Make sure this setting is 
enabled so you are warned 
about dropped frames.
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To prepare a tape with black and code:

1 Insert a videotape into your camcorder or deck.

2 Choose Edit to Tape from the Tools menu.

3 In the Edit to Tape window, click the Black and Code button.

4 If your video equipment supports timecode generation, make sure your deck is set to 
regenerate timecode. Enter the starting timecode in the dialog box, then click OK.

This defines the starting timecode number that appears on your tape. For more information, 
see “Customizing the Timeline Display” on page 453.

5 In the Black and Code dialog box, choose an option from the Settings pop-up menu, then 
click OK.

Current settings are based on the sequence preset in your current Easy Setup. If you select 
Custom, the Sequence Preset Editor appears and you can edit these settings. For more 
information, see “About Sequence Presets” on page 113.

6 When a message appears saying your tape will be erased and rewritten with black frames and 
timecode, click OK.

The tape rewinds to the beginning and the entire tape is blacked. If your video equipment 
supports timecode generation, timecode is also recorded, starting from the timecode 
specified. To cancel the black and code process, press the Esc key.

Click this button to 
black your tape.

Click OK if you’re sure 
you want to erase 
your entire tape.
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Step 6: Set the appropriate render quality

Make sure the render quality is set to the desired level. Better render quality settings will 
improve the quality of your output, while lengthening render times and increasing the size of 
the rendered files. For more information, see Chapter 23, “Rendering.”

Note:  When you perform the edit, any material that hasn’t already been rendered is 
rendered. Then the source material is recorded on tape at the selected render quality.

To change the render quality:

m In the Timeline, choose an option from the Render Quality pop-up menu. 

m Open the sequence or clip in the Viewer, choose Render Quality from the Sequence 
menu, then choose an option from the submenu.

Performing Insert and Assemble Edits 
Once you’ve set up Final Cut Pro with your connected video equipment, you can perform 
insert and assemble edits to tape. You can also preview insert edits before recording them to 
videotape, if this is supported by your deck. If you’re unsure which type of edit to perform, 
see “About the Different Edit to Tape Operations” on page 1124.

Choose the desired setting from 
the Render Quality pop-up menu 
in the Timeline.
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Performing an Assemble Edit

1 Choose Edit to Tape from the Tools menu. 

In most layouts, the Edit to 
Tape window appears on 
top of the Canvas.

The preview option is 
disabled if you are using 
DV equipment.
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2 Choose Editing or Mastering mode from the pop-up menu in the top center of the window.

3 Open your clip or sequence in the Viewer or select it in the Browser.

4 If you haven’t already done so, set In and Out points for your clip or sequence in the Viewer, 
if you don’t want to output the entire clip or sequence.

Use three-point editing to set your In and Out points. For more information on three-point 
editing, see “About Three-Point Editing” on page 538.

Choose a mode from 
this pop-up menu.

If desired, set In and Out points 
for the part you want to record.
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5 Set In and Out points for your tape where you want your clip or sequence recorded.

If you’re in Mastering mode:  Use the transport controls in the Edit to Tape window to cue 
the tape where you want to start your initial edit. Then press I or click the Mark In button to 
set the In point. ( You don’t set an Out point in this mode.)

If you’re in Editing mode:  Use the transport controls in the Edit to Tape window to cue the 
tape and set an In point, an Out point, or both, depending on the type of three-point edit 
you’re doing.

m To set an In point:  Cue the tape where you want to start your initial edit. Then press I, 
click the Mark In button, or type a value and press Return.

m To set an Out point:  Cue the tape where you want your clip or sequence to end. Then 
press O, click the Mark Out button, or type a value and press Return.

6 If you’re in Mastering mode and want to add production elements to your edit, click the 
Mastering Settings tab. Then select the elements you want to record along with your 
sequence or clip.

All selected elements are sent to tape in the order listed. Make sure any elements you don’t 
need are not selected. Some elements may require rendering before you can start recording. 
For an explanation of the options, see “Insert Settings Tab” on page 1128.

Note:  If you’re in Editing mode, these settings are ignored.

7 Now do one of the following

m Drag your clip or sequence from the Viewer or Browser to the Assemble section of the 
Edit Overlay.

Mark In button

Timecode for the In 
point on the tape

Timecode 
for the 
Out point on 
the tape

Mark Out
button

Timecode
for the

In point on
the tape

Mark In 
button
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m Open your clip in the Viewer, then click the Assemble Edit button.

m Drag the clip or sequence to the Assemble Edit button.

A dialog box shows you the progress of the rendering of your sequence or clip, if necessary.

A feedback window will appear when the edit is done.

To cancel an edit in progress, press Esc or click Cancel.

Performing an Insert Edit

1 Choose Edit to Tape from the Tools menu. 

Drag the clip or 
sequence here to do 
an assemble edit.

Or click the
Assemble Edit button.
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Note:  Insert edits cannot be performed with the Edit to Tape window if you’re outputting 
to DV.

2 Choose Editing or Mastering mode from the pop-up menu in the top center of the window.

3 Open your clip or sequence in the Viewer or select it in the Browser.

In most layouts, the Edit to 
Tape window appears on 
top of the Canvas.

Choose a mode from 
this pop-up menu.
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4 If you haven’t already done so, set In and Out points for your clip or sequence in the Viewer, 
if you don’t want to output the entire clip or sequence.

Use three-point editing to set your In and Out points. For more information on three-point 
editing, see “About Three-Point Editing” on page 538.

5 Set In and Out points for your tape where you want your clip or sequence recorded.

If you’re in Mastering mode:  Use the transport controls in the Edit to Tape window to cue 
the tape where you want to start your initial edit. Then press I or click the Mark In button to 
set the In point. ( You don’t set an Out point in this mode.)

Set In and Out points for the 
part you want to record.

Mark In button

Timecode for the 
In point on the tape
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If you’re in Editing mode:  Use the transport controls in the Edit to Tape window to cue the 
tape and set an In point, an Out point, or both, depending on the type of three-point edit 
you’re doing.

m To set an In point:  Cue the tape where you want to start your initial edit, or type a value. 
Then press I or click the Mark In button.

m To set an Out point:  Cue the tape where you want your clip or sequence to end, or type a 
value. Then press O or click the Mark Out button.

6 Make sure the target track control in the Timeline is on for each track you want to record on 
tape—video, audio 1, audio 2, or any combination.

When you play the sequence in Final Cut Pro, you hear and see all three tracks, but only the 
selected tracks are recorded on tape. You can select individual target tracks only on 
camcorders and decks that support recording to individual tracks. For more information, see 
the documentation that came with your video equipment. 

Note:  Final Cut Pro supports output of up to two audio tracks at a time.

7 If you’re in Mastering mode and want to add production elements to your edit, click the 
Mastering Settings tab. Then select the elements you want to record along with your 
sequence or clip.

All selected elements are sent to tape in the order listed. Make sure any elements you don’t 
need are not selected. Some elements may require rendering before you can start recording. 
For an explanation of the options, see “Insert Settings Tab” on page 1128.

Note:  If you’re in Editing mode, these settings are ignored.

Mark In 
button

Timecode 
for the 
Out point 
on the tape

Mark Out
button

Timecode
for the

In point on
the tape

Make sure to select the
tracks you want to

record (so the target
track control is green).
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8 To preview your edit, drag your clip or sequence to the Preview section of the Edit Overlay in 
the Edit to Tape window, or click the Preview Edit button.

Previewing lets you see how your insert edit looks on tape before you actually record it. This 
is especially useful when you’re doing an edit in the middle of an existing program on tape.

To cancel the preview, press Esc.

9 Drag your clip or sequence from the Viewer or Browser to the Insert section of the Edit 
Overlay in the Edit to Tape window or click the Insert Edit button.

Drag the clip or 
sequence here to 
preview your insert edit.

Or click the Preview Edit button.

Drag the clip or 
sequence here to do 
an insert edit.

Or click the Insert Edit button.
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Any leader elements and unrendered transitions, filters, and effects are rendered.

10 In the dialog box that appears, click OK to start recording.

The videotape moves to the pre-roll point, starts to play, then begins recording. To cancel an 
edit in progress, press Esc or click Cancel.
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C H A P T E R

28

28 QuickTime Export of Video, Images, 

and Sound
In Final Cut Pro you can export QuickTime, graphics, and audio files from your edited 
sequences or clips. There are two export options, Export Final Cut Pro Movie and Export 
QuickTime. The option you choose depends on the type of digital media files you want and 
how you’ll use them.

Types of QuickTime Output
There are several types of QuickTime output:

m broadcast-quality compressed or uncompressed QuickTime files

m highly compressed QuickTime files for multimedia or Web use

m still images

m numbered image sequences

m audio only
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Broadcast-Quality Compressed or Uncompressed QuickTime Files

To create a full-resolution QuickTime file of your clip or edited sequence using the current 
settings, use the Export Final Cut Pro Movie command. This is useful if you’re exchanging 
media with an editor using the same method of video capture. Also use this command to 
export a full-resolution version of your edited sequence for import into a third-party 
compression utility. For more information on creating compressed QuickTime files at 
broadcast quality, see “Exporting a Final Cut Pro Movie” on page 1151.

If you’re working on a graphics-intensive composited sequence, or with video captured 
either uncompressed or using lossless compression, you can export it in a similarly 
uncompressed or lossless fashion for use by other editors or compositing artists. The Export 
QuickTime command gives you several methods. You can export QuickTime files using the 
Uncompressed or Animation codecs, or you can export uncompressed numbered image 
sequences of all kinds. For more information on exporting uncompressed digital video files, 
see “About Export Formats for a QuickTime File” on page 1157.

Highly Compressed QuickTime Files for Multimedia or Web Use

To create highly compressed QuickTime video for CD, the Web, or any computer-based 
multimedia project, such as a video kiosk, use the Export QuickTime command. When you 
use this option with third-party codecs designed for high-quality, low-bandwidth playback 
(such as Sorenson Pro Developer edition), you can compress movies for use in nearly any 
venue. Final Cut Pro can also export digital video formats other than QuickTime, such as the 
AVI format for Windows-based computers. For more information, see “Video File Formats 
Supported” on page 1148.

Still Image or a Numbered Image Sequence

You can export single video stills or numbered image sequences in various formats using the 
Export QuickTime command. For more information, see “Image File Formats Supported” on 
page 1150.
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Audio Only

To export just the audio portion of your clip or sequence, use the Export QuickTime 
command. QuickTime accommodates a variety of digital audio file types. For more 
information, see “Audio File Formats Supported” on page 1149.

Use the command to export the desired output:

m Export Final Cut Pro Movie:  Choose this to export a broadcast-quality, full-resolution, 
compressed QuickTime file.

m Export QuickTime:  Choose this to export

m a broadcast-quality, full resolution, uncompressed QuickTime file

m a still image or numbered image sequence

m a highly compressed QuickTime file for multimedia or Web use

m audio only

Differences Between a File Format and a Codec

Codecs are mathematical models for compressing the data of a digital video file so it 
takes up less disk space, sometimes at the expense of quality (see “More About Video 
Compression” on page 1110). A file format is a way of structuring the data so that the 
file is compatible with a particular operating system or application. Different file 
formats can use the same codecs.

QuickTime is a cross-platform technology. You can create QuickTime files for delivery 
on Mac OS and Windows-based computers that have the QuickTime software installed.
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Supported File Formats for Distribution
The following are the video, audio, and image file formats supported by Final Cut Pro.

Video File Formats Supported

Final Cut Pro can export most digital video file formats available in QuickTime and use the 
numerous codecs supported by QuickTime. For more information on commonly used 
codecs, see Chapter 25, “Choosing an Output Method for Final Distribution.”

m FLC:  The FLC (also called FLIC) format was originally developed to store computer-
generated animation. Frames are stored at 8-bit resolution and use a Mac OS or Windows 
color table to remap the color range. This format does not support 24-bit graphics and is 
not recommended unless your client specifies it.

m QuickTime Movie:  QuickTime is a cross-platform multimedia technology that allows Mac 
OS and Windows applications to capture and play back video, audio, and still image files. 
QuickTime supports a wide variety of codecs and can be extended with third-party codecs. 

m AVI:  AVI is a PC-compatible standard for digital video. This file type is no longer officially 
supported by Microsoft, but it’s still frequently used. The AVI format supports fewer 
codecs than QuickTime for video and audio and is mainly useful for Windows delivery of 
video for multimedia use.

m DV Stream:  DV Stream files encode synchronized audio and video together digitally on a 
DV videotape. These files are primarily for use with iMovie. They are not the same as 
QuickTime files that use the Apple DV codec.

You can use a variety of codecs with QuickTime movie and AVI files, depending on what 
you’re compressing your video for. For more information, see “Digital Delivery of QuickTime 
Files” on page 1103.
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Audio File Formats Supported

Final Cut Pro supports the most popular audio formats so you can exchange digital audio 
files with other digital audio editing applications. However, you should avoid audio 
compression unless you are specifically required to use it for multimedia projects or the Web. 
Uncompressed audio doesn’t require a lot of disk space (typically 10 MB per minute of 
uncompressed stereo audio). Your program is also more likely to be compatible with other 
systems and applications if no compression is applied.

Note:  Final Cut Pro only supports audio compression using QuickTime. 

m AIFF:  AIFF (Audio Interchange File Format) is a cross-platform file format supported by a 
wide variety of video and audio digital editing applications. If you need to give someone a 
digital audio file and you don’t know what format to use, choose AIFF. Like QuickTime 
and AVI, AIFF files can use a variety of compressors to reduce their file size, though this 
will reduce the quality. AIFF audio can be either 8-bit or 16-bit and uses sample rates from 
8 to 48 kHz.

m Wave:   This is the primary audio file format used by Windows-compatible computers. 
Wave files can be either 8- or 16-bit and use sample rates from 8 to 48 kHz.

m System 7 Sound:  This file format is used on Mac OS computers. System 7 Sound files can 
use compressors, but they have fewer options than AIFF files. They can be either 8-bit or 
16-bit and use sample rates from 8 to 48 kHz.

m µLaw:  Also known as au, NeXT, or Sun Audio, µLaw audio files are used on UNIX 
operating systems. They are not a mainstream method of exporting your audio for post-
production. µLaw also uses a limited number of compressors and can be either 8- or 16-
bit and use sample rates from 8 to 48 kHz.
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Image File Formats Supported

You can export single video stills or numbered image sequences in various formats based on 
image formats supported by QuickTime.

m BMP:  Windows bitmap format. This is a simple bitmap file format that allows color depths 
from dithered black and white to millions of colors.

m JPEG:  An extremely popular file format because it can create highly compressed yet 
good-looking graphics files. You can choose grayscale or color as well as the amount 
of compression.

m MacPaint:  Supports only black-and-white dithered images.

m Photoshop:  Supports color and grayscale 8-bit graphics, millions of colors, and alpha 
channels.

m PICT:  A common image format used on Mac OS-based computers. PICT files can use any 
of the standard QuickTime codecs for compression in color or grayscale.

m PNG:  (Portable Network Graphics) Allows color depths from black and white to millions 
of colors+. Also allows you to use filters to fine-tune your output.

m QuickTime Image:  An image format similar to PICT.

m SGI:  An uncompressed file format popular on the IRIX operating system on SGI 
workstations. Stores images with millions of colors+.

m TGA:  The Targa file format. An uncompressed file format that stores images with millions 
of colors+. Targa files are supported by nearly every platform and media application.

m TIFF:  Common on Mac OS and Windows-based systems. Allows color depths from 
dithered black-and-white to millions of colors+ and one form of compression.
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Exporting a Final Cut Pro Movie
To export your edited sequence as a QuickTime movie using your clip or sequence’s current 
settings, use the Export Final Cut Pro Movie command. This quickly creates broadcast-quality, 
full-resolution, compressed QuickTime files. For example, if you’ve edited DV compressed 
video, you can use this command to output your program as a DV QuickTime file.

About Self-Contained and Reference Movies

You can create two kinds of QuickTime files with the Export Final Cut Pro Movie 
command:  a self-contained movie and a reference movie. 

m Self-contained movie:  A self-contained movie contains every frame of video and audio in 
one file. A self-contained file stored on a CD can be played without any problems.

m Reference movie:  A reference movie is a much smaller file that contains pointers, or 
references, to all of the captured clips used in your sequence. The actual video is located 
in other files.

If you rendered your transitions and effects before creating the reference movie, then 
there are pointers to your render files as well. Otherwise, all of your transitions and 
effects are rendered using the current level of compression, then embedded inside the 
resulting reference movie, increasing its size.

All audio tracks, mixing levels, cross fades, and audio filters are rendered and the resulting 
stereo or mono audio tracks are embedded in the reference movie.

Exporting a reference movie saves time, since you don’t have to wait for every frame of your 
edited sequence to be duplicated. It also saves hard disk space, since pointers to other files 
require little space. However, you have to give the end user the original video files, otherwise 
the reference movie won’t be able to play back anything. Reference movies are particularly 
useful when outputting your sequence for compression using a third-party compression utility.
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To export a Final Cut Pro Movie:

1 Select a clip or sequence in the Browser or open a sequence in the Timeline.

2 Choose Export from the File menu, then choose Final Cut Pro Movie from the submenu.

3 Choose a location and enter a name for the file.

4 Choose the compression setting you want to use from the Setting pop-up menu.

m Current Settings:  This uses your clip’s current compression settings (found in the Item 
Properties window) or, if you’re exporting a sequence, the current sequence settings 
(found in the Sequence Settings window). 

m Other sequence presets:  Choose a new sequence preset to recompress your clip or 
sequence in another format. 

m Custom:  Choose this to customize the existing sequence preset.

5 Choose a render quality from the Quality pop-up menu.

This determines the render specifications used, such as field rendering, motion blur, filters, 
and frame blending. Lower render quality levels process more quickly but do not provide a 
high visual quality. For more information, see “Working With Render Quality Settings” on 
page 1070.

6 Choose Audio and Video, Audio Only, or Video Only from the Include pop-up menu.

An audio track with nothing in it can still take up disk space. If your Final Cut Pro movie 
doesn’t need an audio track, choose Video Only.

To create a reference
movie, make sure

there is no X in
this checkbox.

Specify the settings for 
the exported movie.

Choose a place
to save the file.

If you want, enter a
name for the file.
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7 To export a QuickTime movie with all video, audio, and render material self-contained in one 
file, click the Make Movie Self-Contained checkbox.

Leave this box unselected to export a reference movie, which is a small movie that contains 
pointers to audio and render files located elsewhere. For more information, see “About Self-
Contained and Reference Movies” on page 1151.

8 To rerender every frame of your clip or sequence before exporting the new file, click the 
Recompress All Frames checkbox.

Note:  This option is available only if the Make Movie Self-Contained checkbox is checked.

This is useful if you’ve edited a sequence using clips with very different data rates and you 
want your final rendered movie to have one uniform data rate. However, the rerendering 
process takes time.

Leave this box unchecked to export a file using the current capture and render files on disk. 
Final Cut Pro copies frames from existing clips into the new file with no rerendering. If you 
have DV clips or sequences, leave this unselected because the DV NTSC and DV PAL codecs 
have a fixed data rate and rerendering frames is unnecessary.

9 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.
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Exporting a QuickTime File
The Export QuickTime command is more flexible than the Export Final Cut Pro Movie 
command because you can choose the format and resolution and use any method of 
compression that’s available on your system. Use this command to output an uncompressed 
or highly compressed version of your clip or sequence. 

To export a highly compressed QuickTime file, see the next section, “About Highly 
Compressed QuickTime Files.” To export an uncompressed file, see “About Export Formats 
for a QuickTime File” on page 1157.

About Highly Compressed QuickTime Files

If you plan to create a highly compressed QuickTime video file for the Web or CD, determine 
what your audience needs.

m Are you creating content for an in-house intranet? 

m Are you creating video for broadband customers that must be downloaded using a cable 
modem, DSL connection, or T1 line? 

m Are you creating content for the lowest common denominator—people using a home 
computer and a 56K modem? 

For some, image quality is more important than smooth frame playback or frame size. Others 
put a premium on frame size and sacrifice clarity. Still others feel that smooth playback is the 
most important thing, and they reduce their frame size accordingly. If you have a clear idea of 
your goals when you begin, you can experiment with different settings to find what works 
best for you.

Four factors determine video quality and file size:

m frame size

m frame rate (frames per second)

m image quality

m audio compression

Important  Once compression is applied to a clip, it can’t be undone. While you can 
recompress a DV movie clip using the Uncompressed codec, the resulting file won’t look 
better than a DV clip that was never compressed, and it will take up as much hard disk space 
as an uncompressed file.
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Choosing the Appropriate Frame Size

Most videos on the Web are 320 x 240 or smaller. Reducing the frame size of your video is the 
first thing you can do to make your video file smaller. Broadcast video is an overscan medium 
so there’s more picture around the edges of the signal than you see on your video monitor. 

This doesn’t always mean that you have to make your entire video smaller. Just because Final 
Cut Pro captures the entire frame doesn’t mean you have to use it. As long as you keep 
everything to the same screen ratio in your edit, you can remove the overscanned area, then 
reduce the file size as much as you need to reach the necessary data rate. 

This also applies if you’re editing 16:9 video. If you letterbox your video, the black bars at the 
top and bottom of the screen take up valuable disk space. You can crop your video to remove 
the bars and maintain the longer width because of the pixels saved. For more information 
about 16:9 video, see Appendix D, “Working With Anamorphic Media.”

To crop your video frame:

1 Create a new sequence with the amount of cropping you want at the aspect ratio you want 
to use. 

This gives you the opportunity to crop the top and bottom of a 4:3 frame to fit into a 16:9 
aspect ratio or any other ratio you choose. 

2 Edit the clip or edited sequence that you want to crop into this new sequence. 

3 In the new sequence, reposition the frame using the Center property in the Motion tab.

The original clip or sequence has a larger frame size than the new sequence, so you need to 
reposition it. For more information on using Motion tab settings, see “Using the Motion Tab” 
on page 941.

Note:  If you use a custom frame size, make sure that the horizontal and vertical pixel 
dimensions are divisible by 4 to insure higher image quality.

Frame size (pixels) Type of video

720 x 486 Standard Definition, 4:3, Non-Square Pixel for NTSC

720 x 480 Standard Definition DV, 4:3, Non-Square Pixel for NTSC

720 x 576 Standard Definition, 4:3, Non-Square Pixel for PAL

640 x 480 Multimedia, 4:3, Square Pixel

480 x 360 Multimedia, 4:3, Square Pixel

320 x 240 Multimedia, 4:3, Square Pixel
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Determining the Frame Rate (Frames Per Second)

You can dramatically reduce the file size of your QuickTime movie by reducing the frame 
rate, also known as the frames per second, or fps. 

For best results, use a frame rate evenly divisible into your timebase. For example, if you 
captured and edited your sequence at 29.97 fps, dividing that frame rate by two equals 
approximately 15, so you can output your compressed QuickTime movie at 15 fps. 

On the other hand, higher frame rates provide better quality. Compressionists use frame 
rates from 10 fps for streaming Web movies to 30 fps for broadband content.

About Image Quality and Codecs

The quality of your image depends on the codec you use. Some codecs put a premium on 
image quality, others on small file sizes. The Sorenson codec is an excellent compromise and 
produces great-looking video at incredibly small file sizes, making it one of the most popular 
QuickTime codecs for CD-ROM and Web video compression. 

Other codecs may be better suited for your application. For more information about 
compression, see “Digital Delivery of QuickTime Files” on page 1103 and “More About Video 
Compression” on page 1110.

Compressing Audio

Although audio doesn’t take nearly as much disk space as video, it can be made smaller. You 
can do this by reducing the sample rate and applying compression. Reducing the sample rate 
significantly lowers the quality of your audio and should be used when you have to shrink 
your file size, such as for streaming on the Web. You don’t need to change the bit rate. For 
example, exporting a 16-bit, 22 kHz audio track saves space and sounds significantly less 
noisy than a track exported at 8-bit.

A good way to compress audio is to use an audio compressor such as IMA, µLaw, QDesign 
Music, or Qualcomm Purevoice. These codecs reduce the amount of space while minimizing 
quality loss.

Note:  An audio track with nothing in it can still take up disk space. If your QuickTime movie 
doesn’t need an audio track, turn audio off when you compress your video to save space.

240 x 180 Multimedia, 4:3, Square Pixel

160 x 120 Multimedia, 4:3, Square Pixel

Frame size (pixels) Type of video
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About Export Formats for a QuickTime File

When you export in QuickTime format, you can create an uncompressed file or a 
compressed file in several formats—FLC, QuickTime Movie, AVI, or DV Stream. Each format 
has its own settings and options.

m QuickTime Movie:  See “Exporting a QuickTime Movie” on page 1157.

m FLC file:  See “Exporting a QuickTime File in FLC Format” on page 1165.

m AVI file:  See “Exporting an AVI QuickTime File” on page 1167.

m DV Stream file:  See “Exporting a DV Stream QuickTime File” on page 1170.

For general information about these formats, see “Video File Formats Supported” on 
page 1148.

Exporting a QuickTime Movie

QuickTime is a cross-platform multimedia technology that allows Mac OS and Windows 
applications to capture and play back video, audio, and still image files. QuickTime supports 
a wide variety of codecs and can be extended with third-party codecs. 

To export a QuickTime Movie file:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose QuickTime Movie from the Format pop-up menu.

Choose a place
to save the file.

If you want, enter a
name for the file.
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5 To export a highly compressed QuickTime movie, choose a setting from the Use pop-up menu. 

6 To set additional video, audio, and Internet streaming settings, click Options. 

See the appropriate section for detailed information on settings.

m Video settings:  See “QuickTime Video Settings” on page 1159.

m Sound settings:  See “QuickTime Sound Settings” on page 1162.

m Internet streaming settings:  See “Prepare for Internet Streaming” on page 1163.

Settings are shown by their data rate, 
primary type of audio in the source clip 
or sequence, and type of motion in the 
source clip or sequence.

Click here to include
video in your exported

QuickTime file.

Click here if your
program is to be

streamed on
the Internet.

Click here to include
audio in your exported

QuickTime file.
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7 When you’re finished selecting your options, click OK.

8 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.

QuickTime Video Settings

You can choose the following settings for the video portion of your exported QuickTime movie.

m Settings:  Click this to adjust the compression used to export your video track.

m Filters:  Click this to add and adjust additional video filters.

m Size:  Click here to set a size for the movie. 
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Settings

m Compressor:  Select a codec to compress the video. All the standard Final Cut Pro and 
third-party video codecs installed on your system are available. Some codecs let you 
choose additional options, such as bit depth or color versus grayscale. 

m Quality:  Adjust the slider for the level of spatial compression you want. Some codecs may 
not allow you to choose this setting.

m Frames per second:  Define the frame rate of your exported movie. This doesn’t need to 
match the frame rate of the clip or sequence you’re exporting. The file quality is improved 
if your new frame rate is evenly divided into the original one.

m Key frame every_ frames:  If your selected codec uses temporal compression, you can 
select the rate. Increasing the number of frames between keyframes increases the amount 
of compression and makes the final file size smaller. 

Depending on the codec you use, the movie file’s quality, especially for clips and 
sequences with a lot of motion, may decrease based on the number of keyframes 
specified. Other codecs, such as Animation, are lossless, and there is no loss of quality. A 
setting of one keyframe every ten frames is a good starting point. 

Note:  If you’re exporting a high-resolution movie for broadcast, consider avoiding the 
Keyframes option since it’s generally not used with material for editorial purposes.

m Limit data rate to:  With some codecs, you can enter a target data rate for your compressed 
QuickTime file. The codec uses a combination of spatial and temporal compression to try to 
reach your target. Be aware of your frame size and frame rate so you don’t set an impossible 
goal and possibly get disappointing quality in the visual image.

m Options:  Click here to set additional options, if the selected codec supports them.
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Filters

QuickTime filters apply to your entire exported clip or sequence. This is different from 
applying a filter within Final Cut Pro, where a filter is applied only to selected clips or parts of 
a clip. For more information on QuickTime filters, visit Apple’s QuickTime Web site at 
www.quicktime.com/

m Load:  Click here to use a filter you’ve saved, such as one used in an earlier project.

m Save:  Click here to save a filter’s settings, if you might use them again.

Select a filter in this list.

Click here to see
more filters.

Adjust the settings 
with these sliders.

Choose a place
to save the file.

If you want, enter
a name for the file.
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Size

You can use the current frame size of your clip or sequence or specify a custom size. 

Note:  It’s a good idea to keep your frame sizes divisible by four if you’re using highly 
compressed codecs such as Sorenson or Cinepak.

QuickTime Sound Settings

Click Settings to adjust the compression, bit depth, and sample rate used for the audio 
portion of your exported QuickTime movie.

Note:  If there is no audio in your clip or sequence, uncheck the Sound Settings checkbox. A 
blank audio track still takes up space in your output file. 

m Compressor:   To reduce file size and download bandwidth, select a codec to compress 
the audio tracks. If you’re outputting high-resolution material, choose None. All the 
standard Final Cut Pro and third-party audio codecs installed on your system are available. 

Some codecs let you choose additional options, such as bit rate.

Choose the size
for your movie.

If you’re using a custom 
size, enter it here.
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m Rate:   Choose a standard sample rate from the pop-up menu or enter a value to specify 
the output rate for the audio. Lower sample rates take less bandwidth but have lower 
quality. Make sure your sample rate is compatible with your target users.

m 8-22.225 kHz:  These lower sample rates are used mainly for multimedia.

m 32 and 48 kHz:  Mini DV, DVCam, and DVCPro use these sample rates. 48 kHz is 
preferred. (32 kHz is equivalent to 12-bit and 48 kHz is equivalent to 16-bit.)

m 44.1 kHz:  This is the sample rate of music CDs.

m Size:   Choose a bit resolution for the audio. For video, 16-bit audio is always used. For 
multimedia work, 16-bit audio is preferred, but choose a setting based on bandwidth and 
compatibility with your target user.

m Use:  Select Mono or Stereo output for your exported audio tracks. If you’re delivering 
material for the Internet, you may want to choose Mono because it cuts your audio file 
size in half.

m Options:  Click here to set additional options, if the selected codec supports this.

Prepare for Internet Streaming

If you’re outputting QuickTime files for streaming over the Internet, there are three 
format options. 

m Fast Start:  The QuickTime movie is downloaded like any other graphic or media file. 
Once enough of the movie has downloaded, the movie begins to play automatically.

m Fast Start - Compressed Header:  This works the same way as a Fast Start movie, except 
that the header information is compressed, so the movie takes up less disk space. The 
user must have QuickTime 3.0 or later.

m Hinted Streaming:   If the movie is hosted with QuickTime Streaming Server software, it 
begins playing within a few seconds after access. “Hinting” a QuickTime movie is the 
process of defining how it’s divided into streamable pieces and storing that information as 
a special track within your QuickTime file. 

If you’re not sure you want this option or don’t want to do this now, you can do this later 
by importing your QuickTime file into QuickTime Player Pro and applying hinting there.
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If you select Hinted Streaming, click Settings to specify additional export settings.

m Make Movie Self-Contained:  Check this box to export a QuickTime movie with all video, 
audio, and render material contained in one file. Leave this box unselected to export a 
reference movie, which is a small movie that contains pointers to audio and render files 
located elsewhere. For more information, see “About Self-Contained and Reference 
Movies” on page 1151.

m Optimize Hints for Server:  Check this box to analyze your movie and create hinting 
information that can be used to stream your movie on the Internet using the QuickTime 
streaming server.

m Track Hinter Settings:  Click this to specify options for encoding, packets, and data rate.

m RTP Payload Encodings:  Choose the type of encoding to use.

m Packet Size Limit:  Enter a value or choose an option from the pop-up menu to specify 
the largest file size for a packet.

m Packet Duration Limit:  Enter a value or choose a size from the pop-up menu to 
specify the longest duration for a packet.
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m Sending tracks:  Specify the type of tracks to send—Music or Text. Then specify the 
number of packets to send—0 to 10—and how often to send them.

m Options:  Click here, then enter a value in the Interval field to specify the time interval 
for the sample.

Exporting a QuickTime File in FLC Format

The FLC (also called FLIC) format was originally developed to store computer-generated 
animation. Frames are stored at 8-bit resolution and use a Mac OS or Windows color table to 
remap the color range. This format does not support 24-bit graphics and is not 
recommended unless your client specifies it.

To export a QuickTime file in FLC format:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose FLC from the Format pop-up menu.

Choose a place
to save the file.

If you want, enter a
name for the file.
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5 Choose an option from the Use pop-up menu.

6 To customize settings, click Options. In the dialog box that appears, choose your settings, 
then click OK.

m Color table:  Choose Best, Windows system color table, or Mac OS system color table. 

m Frames per second:  Enter a value or choose a setting from the pop-up menu.

7 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.

Your choice automatically sets the 
color table and frame rate (frames 
per second).
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Exporting an AVI QuickTime File

AVI movies are a PC-compatible standard for digital video. This file type is no longer officially 
supported by Microsoft, but it’s still frequently used. The AVI format supports fewer codecs 
than QuickTime for video and audio. It is useful mainly for Windows delivery of video for 
multimedia use.

To export a QuickTime file in AVI format:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose AVI from the Format pop-up menu.

5 Choose a setting from the Use menu.

Each setting in this list is a predefined group of codecs and settings. If your needs are more 
specific, skip ahead to step 6.

6 To customize settings, click Options.

Choose a place to
save the file.

If you want, enter a
name for the file.
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7 Click the checkbox next to Video and Sound to include these in your exported file.

If there is no audio in your clip or sequence, make sure the Sound checkbox is not selected. 
Otherwise, a blank audio track will take up space in your output file.

8 Click Settings in the Video section to adjust compression settings used for the video tracks.

m Compressor:  Select the codec to compress the video track. All the standard Final Cut Pro 
and third-party audio codecs installed on your system are available, including BMP, 
Cinepak, DV NTSC, and DV PAL. Some codecs let you choose additional options, such as 
bit depth or color versus grayscale.

m Quality:  Adjust the slider for the level of spatial compression you want. Some codecs may 
not allow you to choose this setting.

m Frames per second:  Defines the frame rate of your exported movie. This doesn’t need to 
match the frame rate of the clip or sequence you’re exporting. The file quality is improved 
if your new frame rate is evenly divided into the original one.

To include video in
the exported file, make

sure this is checked.

To include audio in
the exported file, make

sure this is checked.

Click here to adjust 
compression used 
for the audio track.

Click here to adjust 
compression used 
for the video track.
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m Key frame every_ frames:  If your selected codec uses temporal compression, you can 
select the rate. Increasing the number of frames between keyframes increases the amount 
of compression and makes the final file size smaller. 

Depending on the codec you use, the movie file’s quality, especially for clips and 
sequences with a lot of motion, may decrease based on the number of keyframes 
specified. Other codecs, such as Animation, are lossless, and there is no loss of quality. A 
setting of one keyframe every ten frames is a good starting point. 

Note:  If you’re exporting a high-resolution movie for broadcast, consider avoiding the 
Keyframes option since it’s generally not used with material for editorial purposes.

m Limit data rate to:  With some codecs, you can enter a target data rate for your 
compressed QuickTime file. The codec uses a combination of spatial and temporal 
compression to try to reach your target. Be aware of your frame size and frame rate so you 
don’t set an impossible goal and possibly get disappointing quality in the visual image.

m Options:  Click here to set additional options, if the selected codec supports them.

9 Click Settings in the Audio section to adjust compression settings used for the audio tracks.

m Compressor:  To reduce file size and download bandwidth, choose an audio compression 
method from this pop-up menu. All the standard Final Cut Pro and third-party audio 
codecs installed on your system are available, including ALaw and µLaw. If you’re 
outputting high-resolution material, choose None. 

m Rate:  Choose a standard sample rate from the pop-up menu or enter a value to specify 
the output rate for the audio. Lower sample rates take less bandwidth but have lower 
quality. Make sure your sample rate is compatible with your target users.

m Size:  Enter a value or choose an option from the pop-up menu for bit resolution. For 
video, 16-bit audio is always used. For multimedia work, 16-bit audio is preferred, but 
choose a setting based on bandwidth and compatibility with your target user.

m Use:  Select Mono or Stereo output for your exported audio tracks. If you’re delivering 
material for the Internet, you may want to choose Mono because it cuts your audio file 
size in half.

m Options:  Click here to set additional options, if the selected codec supports them.
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10 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.

Exporting a DV Stream QuickTime File

DV Stream files encode synchronized audio and video together digitally as on a DV 
videotape. These files are primarily for use with iMovie. They are not the same as QuickTime 
files that use the Apple DV codec.

To export a QuickTime file for DV streaming:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose DV Stream from the Format pop-up menu.

5 Choose a setting from the Use menu, based on the format and frame rate.

Choose a place
to save the file.

If you want, enter a
name for the file.
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6 To customize settings, click Options.

m Video Format:  Choose the system to use for the exported file.

m Audio Format:  Choose your options.

m Locked:  Click this checkbox to lock the audio tracks so they cannot be changed.

m Rate:  Choose a sample rate for the exported file from this pop-up menu.

7 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.
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Exporting Numbered Image Sequences
A numbered image sequence exports your edited sequence as a series of numbered image 
files stored in a folder. Each image file contains one frame of your video. If your frames are 
interlaced, both fields are together in this file. 

Most numbered image sequences are exported uncompressed, so these files can be quite 
large. Because of this, it’s common practice to deliver numbered image sequences to your 
client on a streaming tape backup system.

To export a numbered image sequence:

1 Select a clip or sequence in the Browser or open a sequence in the Timeline.

2 Do one of the following:

m To export the entire clip or sequence, clear all In and Out points.

m To export part of the sequence or clip, set In and Out points.

For more information about In and Out points, see “Setting and Modifying In and Out 
Points” on page 373.

3 Choose Export from the File menu, then choose QuickTime from the submenu.

4 Choose a location and enter a name for the file.

Choose a place
to save the file.

If you want, enter a
name for the file.

If you want, create a new 
folder for your image files.
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5 Choose Image Sequence from the Format pop-up menu.

6 Choose a setting from the Use pop-up menu. 

7 To select custom video, audio, and Internet streaming settings, click Options. In the Export 
Image Sequence Settings window, choose your settings, then click OK.

m Format:  Choose an image format from the pop-up menu. For more information, 
see “Image File Formats Supported” on page 1150. Some formats let you choose 
additional options. 

m Frames per second:  Enter a value or choose an option from the pop-up menu for the 
frame rate for the images.

m Options:  Click here to set additional options, such as alternate bit depth or compression 
settings, if they are available for the selected format.

Choose an export setting 
from the pop-up menu.

Choose a format type 
from this pop-up menu.

Enter the desired frame rate, 
or choose an option from the 
pop-up menu.

Click here to set additional 
options, if available.
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8 When you’re ready to export, click Save.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.

Each file of the image sequence is named in the form of “Filename 001.ext,” where “Filename” is 
the name you gave, the number (001) is the number of the frame, and ”.ext” is an extension 
indicating the format.

Exporting a Single Still Image
Instead of exporting an entire sequence, you can export just the frame that’s currently 
displayed in the Canvas or Viewer as a still image. For more information, see “Image File 
Formats Supported” on page 1150. 

Note:  Exported still images are 72 dpi, relative to print. This is the approximate resolution of 
standard definition video.

A file is saved for 
each frame of video.
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To export a still image:

1 In the Canvas or Viewer, position the playhead at the frame you want to export.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose Still Image from the Format pop-up menu.

Move the playhead 
to the frame you 
want to export.

Choose a place
to save the file.

If you want, enter a
name for the file.
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5 Choose a setting from the Use pop-up menu. 

Disregard the frame rate (frames per second or fps), because it doesn’t apply to one frame only.

6 To set custom settings, click Options. In the Export Image Sequence Settings dialog box, 
choose your options, then click OK.

m Format:  Choose the image format you want to use from the pop-up menu. For more 
information, see “Image File Formats Supported” on page 1150. Some formats let you 
choose additional options. 

m Frames per second:  Frame rate doesn’t apply for a still image because you are exporting 
one frame only.

m Options:  Click here to set additional options, such as alternate bit depth, if they are 
available for the selected format.

7 When you’re ready to export, click Save.

Exporting Audio Only
You can export just the audio portion of a clip or sequence in a QuickTime compressed 
format, including AIFF, Wave, µLaw, and System 7 Sound formats. For more information, see 
“Audio File Formats Supported” on page 1149.

Choose a setting from 
the pop-up menu.

Choose a format. 

Click here to set additional 
options, if available.
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To export audio from a clip or sequence:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose an audio format from the Format pop-up menu.

AIFF is the format most users can use. If you’re delivering audio files to Windows users, you 
may want to use the Wave format. For more information on audio formats, see “Audio File 
Formats Supported” on page 1149.

5 Choose sample and bit rates from the Use pop-up menu. 

These options depend on the export format you selected.

Choose a place
to save the file.

If you want, enter a
name for the file.

Choose an audio 
format for your file.

Choose a sample 
rate and bit rate.
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6 To set custom settings, click Options. In the Export Settings dialog box, choose your options, 
then click OK.

m Compressor:  To reduce file size and download bandwidth, select a codec to compress the 
audio tracks. If you’re outputting high-resolution material, chose None. All the standard 
Final Cut Pro and third-party audio codecs installed on your system are available. Some 
codecs let you choose additional options, such as bit rate. 

m Rate:   Choose a standard sample rate from the pop-up menu or enter a value to specify 
the output rate for the audio. Lower sample rates take less bandwidth but have lower 
quality. Make sure your sample rate is compatible with your target users.

m 8-22.225 kHz:  These lower sample rates are used mainly for multimedia.

m 32 and 48 kHz:  Mini DV, DVCam, and DVCPro use these sample rates. 48 kHz is 
preferred. (32 kHz is equivalent to 12-bit and 48 kHz is equivalent to 16-bit.)

m 44.1 kHz:  This is the sample rate of music CDs.

m Size:  Choose a bit resolution for the audio. For video, 16-bit audio is always used. For 
multimedia work, 16-bit audio is preferred, but choose a setting based on bandwidth and 
compatibility with your target user.

m Use:  Select Mono or Stereo output for your exported audio tracks. If you’re delivering 
material for the Internet, you may want to choose Mono because it cuts your audio file 
size in half.

m Options:  Click here to set additional options, if the selected codec supports this.

7 When you’re ready to export, click Save.
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Batch Exporting Clips and Sequences
You can export several clips or sequences at one time with the Batch Export command. This 
is particularly useful when you know that exporting will take a lot of time.

Drag the clips and sequences you want to export from any open Final Cut Pro project to the 
Export Queue tab in the Batch Export window. Items are organized into bins and each bin 
has its own export settings. You can set up several bins with different settings so you can 
export different types of files. 

After you set up bins with the clips and sequences you want to export, you can specify items 
to be exported at different times. This way, everything is not exported in one batch operation.

Setting Up for a Batch Export

Follow these steps before you do a batch export.

Step 1: Select the items you want to batch export

For more information, see “Selecting Items to Batch Export” on page 1180.

Step 2: Select export settings

Items in the Export Queue tab do not have individual settings. All the items in a bin are 
exported using that bin’s settings. To export clips or sequences using different settings, 
organize them into separate bins and assign different settings to the bins using the Settings 
button. For more information, see “Selecting Batch Export Settings” on page 1181.

Step 3: Batch export the desired items

Once you’ve imported your clips and sequences and organized them into bins with your 
desired settings, you need only click the Export button. For more information, see “Doing a 
Batch Export” on page 1189.

Step 4: Open exported items in the Viewer

After your sequences and clips have been exported, you can see them in the Viewer by 
selecting the desired item and clicking the View Exported button. For more information, see 
“Opening Batch Exported Files in the Viewer” on page 1190.
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Selecting Items to Batch Export

You can export clips and sequences. To export part of a clip or sequence, set In and Out 
points. For more information, see “Setting and Modifying In and Out Points” on page 373.

To select items to batch export:

1 In the Browser, select the items you want to export.

For more information, see “Selecting Items in the Browser” on page 179.

2 Choose Batch Export from the File menu.

The Export Queue window shows the Export Queue tab with the selected items. A bin named 
“Batch X” is automatically created with your selections, where X is the bin’s number. 

3 To change the name of a bin, click the bin’s name until a text box appears, then type a 
new name. 

Select the items you
want to export.

You can select items
from more than one

open project.

A bin is automatically
created with the
selected items.

Items selected from
different projects

or at different times
are in separate bins.

Items waiting to be 
exported have a 
Queued status.

If you want, enter a 
new name for the bin.
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4 To create a new bin, do one of the following:

m Choose New from the File menu, then choose Bin from the submenu.

m Press Control-B, then choose New Bin from the shortcut menu.

m Press x-B.

Since each bin has its own export settings, you may want to reorganize items into different 
bins to keep items with the same settings in the same bin.

5 To add additional items:

m Drag items from the Browser to a bin in the Batch Export window.

m Select additional items, then choose Batch Export again.

To select batch export settings, see the next section, “Selecting Batch Export Settings.”

If you don’t want to select settings now, you can close the Export Queue window. To select 
export settings later, choose Export Queue from the Window menu. However, make sure you 
export these items before you quit Final Cut Pro. If you don’t, all items will be deleted from 
the Export Queue window and you’ll have to select them again.

Selecting Batch Export Settings

All items in a bin are exported using that bin’s batch export settings. These settings are based 
on the type of output you want, such as a QuickTime AIFF file or audio only. To export clips 
or sequences using different settings, select the settings for each bin. Then create multiple 
bins and organize your clips and sequences into the appropriate bins.

The export settings are based on the type of output you choose. For detailed information on 
settings for different formats, see other sections in this chapter.

You can select export settings by clicking the Settings button or by selecting settings in 
individual columns in the Export Queue window. 

m To use the Settings button, see the next section, “Choosing Export Settings With the 
Settings Button.” 

This is convenient since you can select all settings from one main window.

m To choose settings from columns in the Export Queue window, see “Selecting Batch 
Export Settings From Columns” on page 1185. 

This is useful when you want to change just a few settings.
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Choosing Export Settings With the Settings Button

To select settings for batch export items using the Settings button:

1 Select the bin in the Export Queue window, then click the Settings button.

In the window, you can select settings for all items in the bin.

Select the desired bin.

Then click Settings.
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2 Click Set Destination, then choose a location to save the exported file.

3 Choose a format from the Format pop-up menu.

4 Choose an export compression setting from the Settings pop-up menu.

5 Click Options, if available, to set additional settings, then click OK.

Some codecs let you choose additional options, such as bit rate. The Options button is 
dimmed if no options are available.

Choose a place
to save the file.

Select the desired format.

Choose the desired setting. 
The settings you see 
depend on the format 
you’ve selected.
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6 Click Set Naming Options, choose the type of file extensions you want, then click OK.

m Strip Existing Extension:  Specifies whether an existing extension is removed from the 
base filename when the export filename is created. This is useful if you’re adding your 
own extension.

m Add Custom Extension:  Type a custom extension to be applied to the filename. Typical 
extensions are

m .mov for QuickTime files

m .pct for PICT files

m .tif for Tiff files

m .wav for Wave files

m .aif for AIFF files.

m Add File Type Extension:  Specifies whether the default extension for the specific export 
file type is automatically appended to the filename.

7 Choose a render quality level from the pop-up menu.

Because clips may be exported from several projects with different render quality names, the 
numbers 1–4 are used to specify render qualities. Render Quality 1 is used by default. This 
setting only applies if the output format is Final Cut Pro Movie. For more information, see 
Chapter 23, “Rendering.”

Click the checkbox
next to the extensions

you want to add to
the exported files.

To add a custom extension, 
enter it here.

Choose a render quality 
from this pop-up menu.
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8 Choose the tracks you want to export from the Include pop-up menu—Audio and Video, 
Audio Only, or Video Only.

An audio track with nothing in it can still take up disk space. If your exported file doesn’t 
need an audio track, choose Video Only.

9 Select additional options, then click OK.

m Recompress All Frames:  Check this box to rerender every frame of your clip or sequence 
before exporting the new file. This is useful if you’ve edited a sequence using clips with 
very different data rates and you want your final rendered movie to have one uniform 
data rate. However, rerendering takes time.

Leave this box unselected to export a file using the current capture and render files on 
disk. Final Cut Pro copies frames from existing clips into the new file with no rerendering. 
If you have DV clips or sequences, you can leave this unselected because the DV NTSC 
and DV PAL codecs have a fixed data rate and rerendering frames is unnecessary.

m Make Movie Self-Contained:  Check this box to export a QuickTime movie with all video, 
audio, and render material self-contained in one file. Leave this box unselected to export a 
reference movie, which is a small movie that contains pointers to audio and render files 
located elsewhere. For more information, see “About Self-Contained and Reference 
Movies” on page 1151.

m Use Item In/Out:  Check this box to export the sequence or clip using the current In and Out 
points. If this is not selected, all of the media in the clip or the entire sequence is exported. 

After you select your settings, you’re ready to export. For more information, see “Doing a 
Batch Export” on page 1189.

Selecting Batch Export Settings From Columns

The columns in the Export Queue window display details about each bin. You can change 
settings directly from these columns.

Click the checkbox
next to the options

you want.
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To change batch export settings from the Export Queue window:

m Control-click in a column for a bin, then choose a setting from the shortcut menu.

If the message “No shortcut” appears, the information in that column cannot be changed 
from the Export Queue window.

Columns in the Export Queue window

m Name:  Displays the name of the item. The Name column always appears on the left.

m Type:  Displays the type of item—clip, subclip, merge clip, sequence, bin, or effect.

m Status:  Displays the current export status for the item. If there’s an error during export, a 
message explaining the problem appears. 

m Queued:  An item is ready for export. This appears when an item is first added to the 
batch queue.

m Done:  An item was successfully exported. These items are ignored if you start another 
batch export process.

m Canceled:  The export process was canceled.

m Error:  This appears when a problem prevented the item from exporting successfully.

m Base Output Filename:  Lets you specify new filenames for clips and sequences. If nothing 
is specified in this column, the item name is used as the output filename. Naming options 
specified in the Export Settings dialog box are also applied to the filename specified here. 

m Length:  Displays the total length of the clip or sequence.

m Destination:  The folder where the exported files will be saved. The Render Files folder is 
used by default. To change the folder, double-click in this column. In the dialog box, 
choose a location to save the file.

m Format:  Displays the current export type.

Move the slider to
view more columns.

Control-click 
in a column 
and choose a 
setting from the 
shortcut menu.
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m Settings:  Defines the compression settings and other movie options for the exported 
sequence or clip. 

m Item Settings:  Uses the current settings for each item in a batch.

m Existing sequence presets:  Choose a sequence preset from the shortcut menu.

m Quality:  Specifies the render quality level to be used for the items in this batch. Because 
clips may be exported from several projects with different render quality names, the 
numbers 1–4 are used to specify render qualities. Render Quality 1 is used by default. 
This setting only applies if the output format is Final Cut Pro Movie. For more 
information, see Chapter 23, “Rendering.”

m Include:  Specifies which tracks should be included in the exported media file—Audio 
and Video, Audio only, or Video only. For output types that contain only a single media 
format (such as an audio clip or an image sequence), the correct media type is 
automatically selected. 

An audio track with nothing in it can still take up disk space. If your exported file doesn’t 
need an audio track, choose Video Only.
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m Recompress All Frames:  If there’s a checkmark in this column, Final Cut Pro rerenders 
every frame of your clip or sequence before exporting the new file. This is useful if you’ve 
edited a sequence using clips with very different data rates and you want your final 
rendered movie to have one uniform data rate. However, the recompressing process 
takes time.

Leave this column unchecked to export a file using the current capture and render files on 
disk. Final Cut Pro copies frames from existing clips into the new file with no reprocessing. If 
you have DV clips or sequences, you can leave this unselected because the DV NTSC and DV 
PAL codecs have a fixed data rate and recompressing frames is unnecessary.

m Make Movie Self-Contained:  Make sure there is a checkmark in this column to export a 
QuickTime movie with all video, audio, and render material contained in one file. Leave 
this column unchecked to export a reference movie, which is a small movie that contains 
pointers to audio and render files located elsewhere. For more information, see “About 
Self-Contained and Reference Movies” on page 1151.

m Use In/Out:  Make sure there is a checkmark in this column to export the sequence or clip 
using the current In and Out points. If this column is not checked, all of the media in the 
clip or the entire sequence is exported. 

m Strip Existing Extension:  Specifies whether an existing extension is removed from the 
base filename when the export filename is created. This is useful if you’re adding your 
own extension.

m Add Custom Extension:  Type a custom extension to be applied to the filename. Typical 
extensions are

m .mov for QuickTime files

m .pct for PICT files

m .tif for Tiff files

m .wav for Wave files

m .aif for AIFF files.

m Add File Type Extension:  Specifies whether the default extension for the specific export 
file type is automatically appended to the filename.

After you select your settings, you’re ready to export. For more information, see the next 
section, “Doing a Batch Export.”
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Doing a Batch Export

After you’ve selected the clips and sequences you want to export and organized them into 
bins with your desired settings, you can batch export them. 

To batch export items:

1 In the Export Queue, select the bins you want to export.

If you want to export all items in the Export Queue, deselect all items. For more information, 
see “Selecting Items to Batch Export” on page 1180.

2 Click Export.

A dialog box shows you the progress of the export. To cancel your export, press Esc or 
click Cancel.

Once items have been exported, the message changes to “Done” in the Status column for 
each exported item.

Select the bin you
want to export.

Then click Export.

The status of an item 
changes to Done when it 
is successfully exported.
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Redoing Batch Exports

If items in the Export Queue were canceled or stopped because of an error, they can be 
re-queued using the shortcut menu.

An item’s status can be changed at any time, from Queued to Done or from Error to Queued. 
For example, an item that was canceled before it finished exporting can be set back to Queued 
and exported again.

To change the status of items in the Export Queue:

m Control-click in the Status column of the item you want to change, then choose a status in 
the shortcut menu.

Opening Batch Exported Files in the Viewer

After an item has been batch exported, you can open it in the Viewer. 

To open batch export files in the Viewer:

m In the Export Queue window, select an item, then click View Exported.

The status of the selected item must be “Done.”

Each item appears in a separate Viewer window.

Select an item to view.

Then click View Exported.
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C H A P T E R

29

29 Working With Edit Decision Lists (EDLs) 

and Batch Lists
To help you re-create your edited sequence on other systems, you can use an Edit Decision 
List and a batch capture list. To understand these two lists and how they are used, you need a 
brief overview of the editing process.

Overview of the Editing Process

Traditionally, video editing consisted of two steps—offline editing and online editing. Most of 
the editing was done offline on low-quality, affordable systems, often using VHS tape-to-tape 
systems where window burns represented the timecode on the original source tapes. Most of 
the time-consuming editorial decisions were performed inexpensively and then written 
down on paper using the timecode window burns on the video. This paper copy was called 
an Edit Decision List, or EDL.The project then moved into the online editing phase. Here, an 
online editor recreated the “paper edit” on higher-quality, more expensive equipment using 
the original source tapes.

With the early computer-based, nonlinear editing systems, offline editing became easier. 
These systems made editing more flexible and automated the process of maintaining the 
timecode necessary to create the final Edit Decision List. This made it easier to go from 
offline to online, but it didn’t eliminate the step of recreating the edit from the original 
source tapes.

Today, a two-step editing process is often not necessary since both steps can be done on 
computer-based editing systems. The visual quality produced by today’s nonlinear editing 
systems, including Final Cut Pro used with a compatible video capture card, is often good 
enough for a final product to be output directly to tape from a computer. Despite this, there 
still may be situations where you want to export an EDL to recreate your Final Cut Pro 
sequence using another editing system.
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Differences Between EDLs and Batch Capture Lists

An EDL describes an entire edited sequence. After you import an EDL in Final Cut Pro, the 
sequence described in the EDL is automatically created. For more information, see the next 
section, “Understanding the Edit Decision List.”

A batch list is a simpler list that describes the clips used in your project. After you import a 
batch capture list in Final Cut Pro, your project contains a series of offline clips, one for each 
entry in the batch capture list. You then need to recapture or relink the clips to use the 
media. For information on importing and exporting batch capture lists, see “Using Batch 
Lists” on page 1207.

Understanding the Edit Decision List
EDLs describe an edit in the simplest possible way. An EDL is a plain ASCII text file with every 
shot in your edited sequence represented as two pairs of In and Out points. One pair 
describes the location of the edit points on the source tape. The other pair describes where 
that edit goes on the master tape. 

The source tape refers to the original tapes that you’ve captured from (similar to clips in 
Final Cut Pro). The master tape refers to the final tape produced in the online editing session 
(similar to a sequence in Final Cut Pro). Tape-to-tape systems cue the next shot to be edited 
from the source tape on the source deck, then copy it to the designated place on the master 
tape on the record deck.

The EDL is designed to be used by edit controllers in tape-to-tape edit suites and in other 
nonlinear editing systems that may not recognize the Final Cut Pro project file format. Using 
an EDL is one way for editors to move their sequence from one editing system to another so 
they can finish or “online” their edit or continue work on another system.

EDLs were developed for use on older tape-to-tape editing systems that had limited 
capabilities. Therefore, they describe only a narrow variety of edits, transitions, and tracks. 
Although today’s nonlinear editing systems have introduced a wide variety of transitions, 
filters, and special effects, the EDL format reflects the simplicity of older systems.
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Because of the inherent simplicity of EDLs, not everything that can be done in a Final Cut Pro 
sequence shows up as expected in an exported EDL. Filters, Motion tab settings, multiple 
composited video tracks, and non-standard transitions don’t appear in an EDL except as 
notes for reference. For example, anything other than a cross dissolve or simple wipe is 
mapped to the closest approximate SMPTE standard wipe pattern. 

About EDL Formats

One of the most common formats is CMX 3600. Check with the facility where you’ll online 
your project to find out what format will work best for your program. 

The EDL format you choose affects how you name your reels, lay out your audio, and 
organize your edited sequences. Final Cut Pro supports the following EDL formats:

m CMX 340

m CMX 3600

m Sony 5000

m Sony 9100

m GVG 4 Plus

Keeping Sequences Simple for EDL Export

It’s best to keep a sequence relatively simple if you plan to export it as an EDL. Many effects 
won’t appear as expected in the EDL. Effects that can complicate matters include

m nested sequences

Important  If you name disks and folders with double-byte characters, Final Cut Pro may 
not be able to export or import EDLs. To avoid this problem, export to or import from disks 
and folders with names that do not contain double-byte characters.

This is part of 
an EDL.

This represents an edit
in a sequence.
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m multi-layered sequences

m motion tab settings

m filters

m non-SMPTE standard transitions

Note:  One way to keep things simple is to use the Cutting Station mode. This mode disables 
many advanced options that don’t translate well into an EDL. 

To see what your EDL will look like, you can create a copy of your final edited sequence and 
simplify it. Remove motion settings, filters, non-standard transitions, and multi-layered 
segments from the copy. Then export an EDL and open it to see how things are exported.

You should also render and output to tape your original, unsimplified sequence. Bring this 
tape to your online session along with your EDL as a reference. The online editor can use the 
original sequence to double-check the edit and recreate things that the EDL can’t describe.

Information in the Edit Decision List

EDLs are created to be used in tape-to-tape editing rooms that use an edit controller to 
coordinate up to three decks and a video switcher. This ASCII text file lists the starting and 
editing points of each clip or source used and where that clip should be in time on the 
master tape. Transitions are also noted. Only two video tracks ( V1 and a super track) can be 
exported, along with either 2 or 4 audio tracks, depending on the selected format. Final Cut 
Pro can only export one EDL at a time, which represents a single sequence.

Each line in the EDL may contain the following information in this order.

Title and drop frame information

The first two lines of an EDL contain the title of the sequence and the type of timecode, drop 
frame or non-drop frame.
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Event number

The first informational number is the event number, which makes sure that all edits are 
performed in the order listed.

Reel name

The second number is a reel name that describes the reel the clip is on. If a clip has no reel 
name, AX is used. This stands for auxiliary and shows that this comes from a source other 
than a tape.

Track type

The third element lists the tracks used on the record deck.

m V:  Video

m A:  Audio (Some EDL formats label this 1 or 2.)

m A2:  Audio 2

m AA:  Both channels of audio

Only one video track is exported. A second track can be exported as a key track and is always V2.

Transition

The fourth element is a letter representing the transition type, followed by the duration of 
the transition in number of frames.

m C:  Cut. A straight cut from one shot to the next.

m D:  Dissolve. A cross dissolve from the previous shot to the current one.

m W:  A wipe. This is followed by a wipe code that indicates the type of standard wipe.

m K:  A key edit. This is how clips on Track 2 are represented.

Timecode numbers

m Cuts Only Edits:  These numbers represent the In and Out out points of the clip on the 
original source tape, followed by the In and Out points of the clip to be edited onto the 
final master tape in the record deck. For a standard cuts only edit:

m 1st number:  Start timecode on the original source tape

m 2nd number:   End timecode on the original source tape

m 3rd number:   Start timecode on the master tape 

m 4th number:  End timecode on the master tape

m Edits with Transitions:  Edits that use a transition instead of a straight cut occupy two lines 
in the EDL. The first line describes the shot used at the beginning of the transition, typically 
the last part of the previous shot. The second line is the shot you’re transitioning to.
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On tape-to-tape edit systems, the tapes containing the two shots are loaded in two video 
decks—deck A and deck B. To perform a dissolve or wipe, the edit controller plays both 
decks simultaneously and uses a hardware video switcher to create the transition effect as 
it’s recording on the final master tape. 

When two shots that make up a transition are on the same reel, Final Cut Pro generates a 
B-Reel list. This list is a mini-EDL that edits all the second shots used in transitions onto a 
new master tape. This new tape is referenced whenever this transition occurs.

Line one shows one edit up to the point where the transition to clip 2 will start. There are 
two lines, each with the same event number. There are also notes for the transition. The 
first clip name note refers to the outgoing clip and the second clip name note refers to 
the incoming clip.

m Split Edits:  Split edits, where the video and audio have separate In and Out points, are 
represented by three lines. The first line indicates which track is delayed and by how 
much, the second line indicates the track (audio or video) that plays through the entire 
edit duration, and the third line contains the delayed track.

Notes

Between event lines there may be notes, which are optional. Notes can be used to describe 
any items in the EDL, including those that may not typically appear in an EDL.
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How to Create a Better EDL 
You can do things before you capture video and while you’re editing to create a better EDL. 
For more information, see the next section, “Before You Capture Video,” and “While You’re 
Editing” on page 1200.

Before You Capture Video

If you know you’ll export an EDL, do these things before capturing your first video clip to 
help insure a smooth translation from your Final Cut Pro sequence to an EDL.

m Calibrate your timecode.

m Organize source tapes with unique reel names.

m Keep clip names under 25 characters.

Calibrate Your Timecode

The accuracy of your captured timecode is extremely important when exporting an EDL. The 
timecode of the media files you capture to disk must match the timecode on the source tape 
for an EDL to export accurately. If timecode is inaccurate, online edits won’t match the 
original offline cuts. This can be fixed by the online editor, but you’ll lose valuable time. 

The timecode used by Final Cut Pro when exporting EDLs is displayed in the Source 
Timecode column of the Browser. You can change this timecode information, but if you do, 
the timecode in the source media file changes as well and affects any projects and sequences 
that use that clip.

Double-check your initial timecode. Make sure you calibrate your incoming timecode so it 
matches the captured video stream accurately. For information on calibrating timecode, see 
“Calibrating the Timecode Signal” on page 249.
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Organize Source Tapes With Unique Reel Names

Every tape that you capture from should have a unique reel name physically written on it for 
reference. This is the number you’ll enter in the Reel Name field of the Log and Capture 
window when you log your shots. It’s crucial to enter the correct reel number while logging 
new clips to make sure Final Cut Pro captures the right clip from the right tape during the 
batch capture process. 

With professional video equipment you can often record tapes with user-programmable 
timecode. User-programmable timecode means that a videographer in the field can enter a 
starting timecode number from hour 01 to hour 23 (on most systems) before recording. This 
makes logging easy because the reel number corresponds to the starting hour of the 
timecode on the tape. (Professionals rarely shoot with tapes longer than one hour at a time, 
so there is seldom more than one hour on a tape.)

Creating your own reel names is especially important when using the mini-DV format. mini-
DV equipment generally can’t record with user-programmable timecode. As a result, each 
mini-DV tape you shoot starts at 00:00:00:00. Also, if you have a timecode break on your tape, 
the timecode may reset itself to 00:00:00:00. In this case, you may actually have multiple reels 
on the same tape, where the first half of the tape goes from 00:00:00:00 to 00:30:00:00 and 
the second half of the tape also goes from 00:00:00:00 to 00:30:00:00. If you follow the steps 
below, you’ll capture your media properly.

Each EDL format has different restrictions on how you identify your tapes. Base the reel 
names for each tape on the chart on the following:

System Reel name length Reel name characters

CMX 340 1-3 characters Numbers only up to 253

CMX 3600 8 characters Uppercase letters; numbers 0-9

GVG 4 Plus 6 characters Uppercase letters; numbers 0-9

Sony 5000 1-3 characters Numbers only up to 998

Sony 9100 6 characters Uppercase letters; numbers 0-9; 
underscore (_)
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To identify tapes with multiple reel names:

1 Label each half of the tape with its own reel number and log each half separately, as if it were 
on its own tape. 

For example, name the first half of the reel 003a and the second half 003b.

2 While batch capturing, when a message appears asking for the next reel, cue the tape to the 
first or last half, whichever represents the correct reel.

If you entered the wrong reel name when you logged a clip, you can change the reel name in 
the Browser or in the Item Properties window.

To change the reel name in the Browser:

1 Select a clip, then Control-click in the Reel column.

To change the reel name for several clips at once, select multiple clips in the Browser. For 
more information, see “Selecting Items in the Browser” on page 179.

2 Choose the correct reel name from the shortcut menu.

All reels used in the current project are shown. The selected reel is assigned to the single clip 
or all selected clips. This information is transferred to the original media files stored on disk 
and results in a global change to all projects using that clip.

Keep Clip Names Under 25 Characters

Clip names are exported to an EDL as notes. When you log clips, make sure that all your clip 
names are 25 characters or shorter. Otherwise, when this material is recaptured, Final Cut 
Pro may capture the wrong clip and you may get unexpected results in your sequence.

Enter a reel name here.

Important  If you change EDL formats, you’ll no longer have correctly formatted reel 
names. Final Cut Pro automatically replaces any incorrect reel assignment and inserts a note 
in the EDL indicating the old and new reel names.
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While You’re Editing

After you’ve captured all your clips, do the following while editing to insure an easy EDL export.

m Keep track of how many edits are in your sequence.

m Only use transitions in track V1.

m Keep track of the number of audio tracks.

m Don’t rely on audio mix levels.

m Avoid nested sequences and non-standard video transitions.

m Be careful when using still frames and speed settings.

Keep Track of the Number of Edits

EDLs are based on the number of edits used in a sequence. A long sequence doesn’t mean a 
long EDL. For example, a fifteen-minute sequence with 450 edits produces a longer EDL than 
a two-hour sequence with only three edits.

Different EDL formats allow for different project lengths or numbers of edits in your 
sequence. Final Cut Pro exports an EDL no matter how long your sequence is or how many 
edits there are. If your sequence has more than the allowed number of edits for the selected 
EDL format, Final Cut Pro automatically creates additional EDLs, depending on the number 
of total events.

The following are the maximum number of edits, or events, allowed in various EDL formats.

m CMX 340, CMX 3600, and Sony 5000:   999 

m Sony 9100 and GVG 4 Plus:   9999 

Don’t Put Transitions in Tracks Other Than V1

A superimposed video track, or any track other than V1, is called a key track in an EDL. Only 
one key track can be in an EDL, so information for V1 and V2 tracks only appears in an 
exported EDL. Transitions in V2 are not allowed in EDLs and are ignored. If you want a 
transition on V2, use the Opacity overlay to dissolve V2 up and down.

Opacity keyframes in the Timeline are translated into values and locations and are listed as 
the Key Level in notes in the exported EDL. These values are based on the timecode of the 
master tape and are used by a video switcher. Some online systems can translate these values 
for automatic use by some switchers, but more commonly the values are only used as notes 
for the editor to use in an online session. 
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Keep Track of the Number of Audio Tracks

Final Cut Pro supports up to 99 tracks of audio in a sequence. However, EDLs only support 
two or four tracks of audio, depending upon the EDL and video format you use. 

If your sequence has more than four tracks, you may have to export separate EDLs. A simple 
way to do this is to export an EDL. Copy your sequence and delete everything except the audio 
tracks that weren’t included in the first EDL. Then export an EDL just for this audio version.

Don’t Rely on Audio Mix Levels

Mixed audio levels, represented by audio overlays in the Timeline, are notes in the EDL for 
the online editor to use as reference. However, only a few online systems can translate these 
notes into an automated mix.

Avoid Nested Sequences

Nested sequences, or sequences within a sequence, should not be used if you are exporting 
an EDL. Nested sequences can include any number of tracks and are commonly used for 
effects sequences. However, EDLs support only two video and up to four audio tracks, so 
Final Cut Pro cannot properly translate a nested sequence for use in an EDL. To prevent 
confusion, you can create a duplicate of your edited sequence and simplify sections where 
there are nested sequences. 

EDL format Number of audio tracks

CMX 340 2

CMX 3600 4

Sony 5000 2

Sony 9100 4

GVG 4 Plus 4
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To simplify a nested sequence for EDL export:

1 Duplicate your edited sequence.

2 In the duplicate sequence, remove all nested sequences.

3 Replace nested sequences with a maximum of two video and four audio tracks that approximate 
your edit.

4 Export this sequence as an EDL.

For more information, see “Exporting an EDL” on page 1202. The online editor will recreate 
what you want in the online session.

Avoid Non-Standard Video Transitions

Final Cut Pro has 43 transitions, but EDLs can recognize only a subset of these (primarily the 
cross dissolve and various wipes). If you use other transitions, Final Cut Pro automatically 
replaces them with the closest transition type. See Appendix E, “Transition Codes for EDL 
Export,” for more information.

Be Careful Using Still Frames and Speed Settings

If you use still frames, give all of your stills distinct reel names. It’s good to identify the source 
clips that are taken from graphic stills.

Keep speed settings to even percentages for optimal results. For example, use 50% speed 
rather than 57% speed. If you plan to export your EDL for a tape-based online edit, this may 
be important. Some video decks work well at a certain range of speeds for either slow or fast 
motion. Ask your online editor for a list of acceptable speeds.

Exporting an EDL 
You can export an EDL from any selected sequence. You can only export one EDL at a time, 
so avoid selecting multiple sequences.

To export a sequence as an EDL:

1 Select a sequence in the Browser or open the sequence in the Timeline. 

2 Choose Export from the File menu, then choose EDL from the submenu.
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3 Select your settings, then click OK.

m EDL Title:  This appears on the first line of the EDL and is limited to 60-77 characters, 
depending on the EDL format. The default is the sequence name. Changing the EDL title 
does not change the filename of the exported EDL.

m Format:  Choose a format for the system you’ll use to recreate your edit. Different styles 
of edit controllers can use different EDL formats. To find out which one you should use, 
contact the online editing facility you’re using.

m Sorting:  Choose a sorting option for your clips from the pop-up menu.

m Master, Audio Merged:  Clips appear in the order in which they occur in the sequence. 
Audio clips that start and end together are merged into one event line where possible.

m Source, Audio Merged:  Clips are ordered based on their arrangement in the original 
source tapes. Event number 1 is the earliest starting timecode on the lowest-numbered 
reel. This setting lets you quickly lay down all the edits from one reel at the same time, so 
you don’t have to keep changing reels.
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m Target Video Track Only:  This setting exports the target track only and ignores the key 
video track. This exports a single video track from a sequence, which is helpful if you 
don’t want to clutter your EDL with numerous key edits. You can then create a separate 
EDL that contains key edits only for the online editor to use as a reference. This option is 
also useful for exporting video tracks higher than V2, which otherwise aren’t exported 
into an EDL. 

Note:  This option does not affect audio track export.

m Omit Transitions:  Check this box to ignore all transitions in your sequence so the EDL 
contains cuts only. This keeps your EDL as simple as possible, so transitions won’t 
complicate your online session. The online editor can create the necessary transitions.

m Reel conflicts:  Choose how to deal with conflicts.

m B-Reel Edits:  When two shots that make up a transition are on the same reel, Final Cut 
Pro generates a B-Reel list. This list is a mini-EDL that edits all the second shots used in 
transitions onto a new master tape. This new tape can be referenced from the main 
EDL whenever this type of transition occurs.

m Pre-read Edits:  If you select this option, some high-end digital video decks can 
perform dissolves using one source deck. For example, D1, D2, and Digital Betacam 
format decks can be obtained with a pre-read option. Before selecting pre-read edits, 
contact your online editing facility.

m Generic Edits:  Use this when going from one nonlinear editing system to another. No 
reel numbers are modified (as with the other two options). 

m EDL Notes:  Information from the selected options are saved as notes in the EDL.

m Clip Name:  The clip name appears after the event line. If the event line describes a 
transition, the first note refers to the first clip and the second note refers to the second clip.

m Filters:  Describes filters applied to a clip in the sequence.

m Comments 4:  Information from the Comment 4 column of the Browser. This lets 
offline editors give notes to the online editor about complicated entries on the list. 

m Video Levels:  Video key levels, or opacity levels, on track V2 along with the keyframes 
for when they change and the location of the change based on the masters tape’s 
timecode. Bezier curves used for transitions from one keyframe to the next are ignored.

m Audio Levels:  Audio level changes, along with the keyframes for when they change 
and the location of the change based on the master tape’s timecode.

m Master:  Determines settings for the master tape.

m Start Time:  The timecode of the beginning of the master tape in the record deck. It 
defaults to the starting timecode of the sequence.

m Drop Frame:  Defines whether the timecode on the master tape being edited to has 
drop frame or non-drop frame timecode. This appears as the first element under the 
title in the EDL and defaults to the type of timecode of the sequence you’re exporting.
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m Audio Mapping:  Choose which audio channels in your sequence are edited onto which 
of the four tracks of the master tape. You can map to two or four EDL audio channels, 
depending on the selected format. 

Channels can be exported in any combination and from any audio track in your sequence. 
For example, audio track 5 of your sequence can be remapped to audio track 2 in the 
EDL, so all audio from track 5 of your original sequence is edited onto track 2 of the 
master tape.

4 Choose a location and enter a name for the file, then click Save.

5 If you didn’t select the Pre-read Edits option, another dialog box may appear where you can 
choose a location and enter a name for a second EDL for the B-Reel list.

If your sequence exceeds the maximum number of events for the format you specified, Final 
Cut Pro creates additional EDL files.

Choose a place
to save the file.

If you want, enter a
name for the file.

Choose a place to
save the second file.

If you want, enter a
name for the file.
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If an error message appears:  You may not be able to export an EDL in the specified format. 
Try changing the options and exporting again. You may also need to simplify your sequence 
further and try again.

Reviewing an EDL

After you’ve exported an EDL, you can open the text file and review its contents. 

To open an Edit Decision List:

1 Choose Open from the File menu.

2 Locate the EDL file, select it, then click Open.

For detailed information about the contents of an EDL, see “Information in the Edit Decision 
List” on page 1194.

Using EDL Access for RT-11 Disks

You may need to give your EDL to an online editor on a floppy disk. Editing systems 
manufactured by CMX and GVG (Grass Valley Group) use 720K double-density disks that are 
formatted with a proprietary file system, known as RT-11.

EDL Access™ from FocalPoint Systems, Inc. is a Mac OS application that you can use to 
format, read, and write to RT-11 formatted disks for file exchange with these editing systems. 
EDL Access is included on the Final Cut Pro CD-ROM disc. You can use EDL Access to copy 
an EDL file to or from an RT-11 formatted disk using a third-party USB floppy disk drive.

Editing systems manufactured by Sony Corporation use the DOS file format. For these 
editing systems, you can copy the EDL file directly to a DOS-formatted disk.

Important  It’s best to avoid making changes to the contents of this file. If you do make 
changes to the EDL, make sure you don’t change the formatting; otherwise, the resulting 
EDL may not be interpreted properly.

Locate the EDL,
then click Open.
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Using Batch Lists
A batch capture list is a tab-delimited text file that contains information about clips you want 
to capture and use in your project. Increasingly, logging on the set is done using a computer, 
which makes it easy to reformat for use in Final Cut Pro. If you have a camcorder and a copy 
of a spreadsheet program or word processor, such as AppleWorks, you can easily log tapes for 
capture even if Final Cut Pro is not installed on your computer.

You can use batch lists several ways:

m Producers and directors can create a list of selects for you to edit with and save you the 
tedium of reviewing endless takes. 

m The assistant cameraperson can log the In and Out points of every shot and whether the 
director liked each one.

m You can log material on one Final Cut Pro workstation for import and capture on another. 

Batch lists can be created using any popular spreadsheet program or word processor. Because 
spreadsheets are already set up to enter rows and columns of data, they are the easiest 
programs to use to create batch capture lists. However, even a very simple program such as 
SimpleText works, as long as you use tabs instead of spaces to separate entries in your list.

Batch capture list viewed in 
a spreadsheet program.
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Creating Batch Lists

You can create a batch capture list using a spreadsheet or word processor or you can export 
a batch list from Final Cut Pro as a template to work from.

Using a Spreadsheet or Word Processor to Create a Batch List

If you logged clips in another nonlinear editing application and want to edit the project in 
Final Cut Pro, you can produce a batch list using another application, then import the list 
into Final Cut Pro. You can then capture the media and edit in Final Cut Pro. 

You can use any spreadsheet program or word-processing program to create a batch list. If 
you format your list properly according to the lines and columns Final Cut Pro expects, 
importing a batch capture list generated in another application is easy. Follow these rules:

m The first row of your spreadsheet or line of your word-processing document must have 
field headings that exactly match the column titles found in the Browser. 

You don’t need to include every column in the Browser, but you must have Reel, Name, 
Media Start, and Media End headers.

Note:  In batch capture lists created for Final Cut Pro 1.2.5 or earlier, Media Start and Media 
End were previously referred to as In and Out. If you’re using such a list, change the column 
titles In and Out to Media Start and Media End, or your clips won’t import properly.

m All entries must be tab-delimited.

Using a File Exported From Final Cut Pro

One way to guarantee a correctly formatted batch capture list is to export a batch list from 
Final Cut Pro and use it as a guide. Export a list that contains the Browser columns you want, 
then open the list in a text editor or spreadsheet program. The main structure of the list is 
set up and ready to use as a template. For more information, see the next section, “Exporting 
a Batch List.” You can then enter logging information for all clips you want to capture from 
various source tapes and save the list as a tab-delimited, plain text file.

A spreadsheet program properly 
formatted for a batch list 
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Exporting a Batch List

You can export a batch list from Final Cut Pro if you want to recapture your clips on another 
editing system. You can also export this list to use as a template to create your own batch list 
for another project.

To export a sequence as a batch list:

1 Control-click in the Browser, then choose View As List from the shortcut menu.

2 Select a project tab or open a bin in its own window.

3 Arrange columns in the Browser in the order you want information exported.

All visible columns are included in the exported batch list.

m To hide a column:  Control-click the column heading, then choose Hide Column from the 
shortcut menu.

m To display a hidden column:  Control-click in any column heading, then choose Show 
“Column name” from the shortcut menu, where “Column name” is the name of the 
hidden column, such as Show Duration or Show Comment 2.

4 Choose Export from the File menu, then choose Batch List from the submenu.

5 Select a destination and enter a name for the list.

6 Choose an option from the Format pop-up menu.

7 When you’re ready to export, click Save.

Choose a place
to save the file.

If you want, enter a
name for the file.
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30 About Multi-Track 

and OMF Audio Export
When you finish an edit, you can export your edited video sequence to tape from your 
own studio. You can also finish your audio at an audio post-production facility. Many video 
editors focus primarily on the video and dialog tracks of their edit and lay in scratch tracks
of audio and effects for reference. They then have a specialized audio editor “sweeten” their 
sound tracks.

Audio sweetening is the process of polishing sound levels, rerecording bad sections of dialog, 
recording and adding narration, music, and sound effects, and creating a high-quality mix. 
Since audio post-production facilities use specialized digital audio workstations (DAWs), it’s 
important to deliver your edited audio sequences so they can be worked on quickly, with the 
facility recreating as little as possible.

You can export your audio tracks for post-production work as

m an EDL (Edit Decision List)

m AIFF files

m OMF audio files
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Exporting Audio Tracks as an EDL
If you plan to send just the edited dialog and synced material from your source tapes, you 
can export your audio edits as an EDL. An EDL, or Edit Decision List, is a text file that 
contains clip and editing information for a sequence. In this case, it includes just the audio 
information for your sequence.

EDLs describe clips captured using timecode only and can only handle a maximum of four 
audio channels. If some of your audio doesn’t have timecode (for example, if you imported a 
track from a CD), you must record your music and sound effects on a timecode-controllable 
video or audio device if you want to export an EDL. If your program has more than four 
audio tracks, you need to export multiple EDLs and have them collated by your audio editor.

Exporting an EDL gives your audio editor the opportunity to rerecord your source audio 
using better equipment than you may have used, so your program has better sound. 
The disadvantage of using EDLs is that your audio editor may have to reedit audio clips 
recorded “wild” (without timecode) from scratch using a copy of your exported sequence 
on tape for reference. 

For detailed information on exporting EDLs, see Chapter 29, “Working With Edit Decision 
Lists (EDLs) and Batch Lists.”

Exporting Audio Tracks as AIFF Files
If you have a lot of source audio in your sequence that wasn’t captured with timecode, or if 
you need to export your audio to equipment that doesn’t have OMF import capabilities, you 
can export all of the audio tracks as AIFF files. These files can then be imported into 
applications that support multiple tracks of AIFF files. However, this method doesn’t 
preserve your edit points because all of the audio clips for your sequence are exported as 
one AIFF file. Your audio editor then has to edit your audio together. 

Before you export AIFF files, make a duplicate of your sequence and use that duplicate for the 
export process. In case anything goes wrong, your original edited sequence is left untouched. 
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Preparing to Export AIFF Files

Step 1: Make a duplicate of your sequence

This lets you leave your original edited sequence untouched. 

To make a duplicate of your sequence:

1 Click your sequence in the Browser to select it.

2 Do one of the following:

m Choose Duplicate from the Edit menu.

m Control-click and choose Duplicate from the shortcut menu.

m Press Option-D.

A copy of your sequence is created. From now on, use the copy of your sequence for the 
export process.

Step 2: Insert sync beeps at the beginning and end of each audio track

Insert a one-frame sync beep (also known as two-pops) at the beginning and end of each 
audio track in your sequence. These beeps will help you line up the audio tracks after you 
import them into an audio application.

To create a sync beep: 

1 Choose Bars and Tone from the Generator pop-up menu in the Viewer.

Choose the Bars and Tone setting 
for NTSC or PAL, depending on 
your video equipment.
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2 Press I to mark an In point, press the Right Arrow key on the keyboard to move forward one 
frame, then press O to mark an Out point. 

3 Drag this clip from the Viewer to your sequence in the Timeline. 

4 Option-click the video portion of the one-frame clip to select that part only.

5 Press Delete to delete the video portion of this clip.

In and Out points for
the single-frame clip

Select the video only, 
then press Delete.

Only the audio portion 
remains as your sync beep.
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6 Cut the stereo beep and paste it at the beginning and end of each audio track you will export.

Step 3: If necessary, arrange audio clips so they don’t overlap

When you export audio as AIFF files, there is no automatic way to include “handles,” or extra 
audio at the beginning and end of each audio clip. If you want extra audio before and after 
the In and Out points of each audio clip, you need to reset the In and Out points to include 
additional audio before and after your actual In and Out points. 

Note:  Make sure the audio clips can be longer than the video clips without inadvertently 
changing your edit points.

It’s helpful to the audio editor if you break up your audio tracks by type. This makes it easier 
to include the desired handles and to keep everything organized from one application to the 
next. For example:

m Track 1:  Character A

m Track 2:  Character B 

m Tracks 3 and 4:  Room tone and ambiences

m Tracks 5 and 6:  Sound effects

m Tracks 7–10:  Two pairs of stereo music tracks to mix

This shows the sync beep at the 
beginning of an audio track.
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Step 4: Remove audio filters and flatten all audio overlays to 
0 decibels

To remove any dynamic mixing, remove all audio filters from your audio clips and flatten the 
audio overlays to 0 decibels (dB). Audio editors can add audio filters and adjust overlays 
when they mix during post-production.

To flatten the audio, do one of the following:

m Open the audio clip in the Viewer, then adjust all overlays to 0 dB.

m In the Timeline, click the Clip Overlays button, click the Selection tool in the Tool palette, 
then adjust all overlays to 0 dB.

Exporting AIFF Files

Export each track of audio in your sequence as a separate AIFF file. For example, if you have 
six audio tracks in a fifteen-minute sequence, export six fifteen-minute AIFF files. 

Adjust the overlays to 0 dB.

Click the Clip Overlays button 
to view the audio overlays.

With the Selection tool, 
adjust the overlays to 0 dB.
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To export an audio track as an AIFF file:

1 Option-click the Track Visibility control next to the audio tracks you want to export.

2 Choose Export from the File menu, then choose QuickTime from the submenu.

3 Choose a location and enter a name for the file.

4 Choose AIFF from the Format pop-up menu.

5 Click Options. In the Sound Settings dialog box, choose your sample rate and size.

6 Click Mono for the type of sound you want to use, then click OK.

7 When you’re ready to export, click Save.

Make sure just the
desired audio track

is visible (green).
All other tracks are disabled.

Choose a place
to save the file.

If you want, enter a
name for the file.

Chose AIFF from the 
Format pop-up menu.

Enter a sample rate or 
choose one from this 
pop-up menu.

Choose a bit depth.

Make sure you select Mono.
 About Multi-Track and OMF Audio Export 1217



Importing AIFF Files Into an Audio Editing Application

In your audio editing application, import all the AIFF files you exported from Final Cut Pro, 
then sync them. You can verify your sync by lining up the sync beeps you added earlier and 
listening. If the sync beeps at the beginning and the end line up and sound like one beep, all 
audio files are synchronized and you are ready to begin mixing.

Exporting OMF Audio Files
When you export audio as OMF files, the files contain a description of your audio edit along 
with the source audio. Using OMF for audio export has several important advantages:

m Exported OMF files contain not only the descriptions of the In and Out points you made 
in your edited sequence, but also the source audio embedded in the exported file. This 
makes an OMF file self-contained.

m EDLs only describe audio that was captured using a timecode-controllable device. OMF 
files, since they contain the audio itself, can be used to export all the audio clips in your 
edited sequence no matter what the source.

m You can export as many tracks of audio as you have in your sequence. (Disabled audio tracks 
aren’t exported.) EDL export limits you to a maximum of four tracks of audio at a time.

Using OMF files, editors can send edited and synchronized audio tracks to an audio post-
production facility quickly and easily, maintaining all track separations, edit points, cross 
fades, and video sync. Audio handles can be added, as long as there’s enough audio in the 
source file to support.

Use the OMF Export command if you plan to deliver your audio to an editor using an OMF- 
compatible digital audio workstation (DAW). Most audio facilities are able to use OMF files.

Tips for Exporting Good OMF Files

To make sure that the OMF files you export are easily imported into the recipient’s digital 
audio workstation, do the following:

m Make sure your audio is recorded properly with good levels and no distortion.

The audio post-production facility won’t recapture your audio, so this is your only chance 
to record it properly.

m Make sure that your audio tracks are organized by the kind of audio they contain. 

If you don’t, your audio editor will waste valuable time organizing your material. Here’s 
one way to organize your tracks:
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m Dialog:  This includes most of the audio that was captured along with your video. 
Whether you split each character’s lines out on their own dialog track is up to you and 
your audio editor.

m Ambience:  Ambient tracks include background tones and atmospheric sound effects, 
and possibly also room tone.

m Music:  Stereo music from any source may use up to four tracks, if you’re doing 
complicated music edits or cross fades.

m Voiceover:  Narration should be on its own track, separate from dialog, because it will 
probably have different equalization (EQ) settings.

m Sound Effects:  This includes material from effect libraries as well as effects clips you’ve 
recorded yourself. If you’ve edited in Foley, your sound effects should have their own 
set of audio tracks.

m If you have cross fades in your edit, they are exported as linear cross fades. 

No matter what kind of cross fades you use in your edited sequence, they are all exported 
as linear cross fades. Your audio editor can reset these to their desired type within the 
audio software.

How well your cross fades import into another application depends on the tool your audio 
editor uses. Since some OMF importing tools do not handle cross fade objects correctly, 
you have the option to leave these out when exporting your sequence as an OMF file.

m OMF Export will ignore all clips on disabled audio tracks. Any individually disabled audio 
clips will also be ignored.

m Speed and Reverse effects that have been applied to audio clips will be applied to the 
exported sound media.

m Nested sequences will be mixed together and exported as a single audio item.

You cannot export levels, pans, and audio filters as OMF files. You can use these in your edits, 
but they are ignored when exporting OMF. An audio editor at an audio post-production 
facility needs to have all of the audio in your sequence as close to the way it was originally 
recorded as possible. If you’re using an audio facility for sound sweetening, rely on the audio 
post-production specialist’s experience to repair dialog, finesse your audio edits, equalize 
your tracks, and create finely tuned mixes from your source material. 

Important  While maintaining high quality in your captured audio is always important, it’s 
critical if you plan to export OMF files. Since you capture the audio yourself instead of having 
your audio facility recapture audio for you, this is your only chance to make sure that your 
audio is recorded properly, with good levels and no distortion. For more information on 
importing audio, see Chapter 9, “Importing Graphics, QuickTime, and Audio Files.”
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Exporting Audio in the OMF Format

To export audio from a clip or sequence in the OMF format:

1 Select a clip or sequence in the Browser or open the sequence in the Timeline.

2 In the Timeline, click the Track Visibility button next to each audio track you want to export. 

3 Choose Export from the File menu, then choose Audio to OMF from the submenu.

4 In the OMF Audio Export dialog box, choose the desired options, then click OK.

 

m Sample Rate:  Choose an option that suits what you’re using the audio for. All of the audio 
you export has the same sample rate. If you use audio with different sample rates, it’s 
converted. The bit depth is always 16-bit.

Converting 32 kHz, 12-bit audio to 48 kHz, 16-bit audio does not result in good sound 
quality. To create a high-quality mix, use at least 44.1 kHz audio or better when importing 
source material for editing. For more information on importing audio, see Chapter 9, 
“Importing Graphics, QuickTime, and Audio Files.”

m Handle Length:  Enter a value in timecode format to add handles to the audio clips. 
Handles give your audio editor the flexibility needed to fix edits. Handles of one to three 
seconds are typical, but it’s best to check with your audio editor.

Clips used in their entirety aren’t exported with handles, since there is no extra audio 
available to include (for example, if the first frame of a clip is 01:01:01:00 and the In point 
for that clip in the Timeline is also 01:01:01:00). 

Make sure just the
desired audio tracks

are visible (green).
Disabled tracks are not exported.

Select the desired options, 
then click OK.
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m Include Crossfade Transitions:  Since some OMF importing tools do not handle cross 
fade objects correctly, you have the option to leave these out when exporting your 
sequence as an OMF file by disabling this checkbox. When this option is disabled, extra 
source media is substituted for the duration of the cross fade being left out. How much 
extra source media will be substituted depends on whether the cross fade was edited 
before, on, or after the edit point. Extra source media included as a result of this option 
will be in addition to extra source media added by the Handle Length option.

5 Choose a location and enter a name for the file.

6 To set additional sound settings, click the Options button.

7 When you’re ready to export, click Save. 

OMF Files Have a Two-Gigabyte Limit

OMF files that you create cannot be larger than 2 GB. In most cases, this should not 
present a problem since this will accommodate approximately seven hours of mono 
audio media. If your sequence exceeds this limit, you will see an error message.

Choose a place
to save the file.

If you want, enter a
name for the file.
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31 Using FXBuilder to Create, Test, 

and Modify Effects
FXBuilder is a scripting utility in Final Cut Pro that gives you the ability to create, test, and 
modify custom video effects, such as filters, text generators, or transitions. You can build and 
connect effects, modify existing Final Cut Pro effects, and combine several effects into one 
FXBuilder script. FXScript is the scripting language you use to build the effect in FXBuilder.

You can also save effects you’ve created or modified in a write-protected format that allows 
them to run, but prevents anyone from viewing their code. This lets you create and distribute 
copyrighted effects without losing control of their content.

You can get additional scripts and instructions from the Final Cut Pro Web site at 
www.apple.com/finalcutpro/fxscripts

What Is Scripting?
A set of instructions that performs a specific function is called a script. Scripting is the 
process of putting together a series of instructions in a way that Final Cut Pro understands, 
similar to programming. Scripting allows you to put many smaller instructions, or scripts, 
together in a sequence, so that you can perform complex tasks automatically.

For example, if you want to add a color tint to a video clip, Final Cut Pro does this by looking 
at the dots in each frame of the clip and then changing some of them to the color of the tint 
you want. Doing this without a script would be a tedious and error-prone task. With a script, 
all the instructions for creating the tint effect can be applied to the clip with one simple step. 
Scripting also guarantees that a particular effect will look and behave in the same way every 
time it is used, making a video effect consistent over multiple projects.

Scripts have elements in common with written language as well as with programming. Scripts 
have structural and syntactical rules, but the words you use are very similar to English. 
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Building Scripts
There are four stages to the process of building a good, well-structured script. 

Step 1: Planning

What do you want your script to do? It’s important to have clear goals in mind before you 
start. It should be possible to describe the function of a script in one or two sentences. You 
can write a script’s description as a comment line in the script code. 

Step 2: Creating the structure

The purpose of your script determines its structure to a great extent. Code that is broken up 
into structural “building blocks” is easier to test and modify than code written without careful 
attention to structural detail. 

FXScript allows you to break scripts up into subroutines that can be “called” from other parts 
of the script. This means that you only need to write code once, regardless of how many 
times it will be used. You should also group variable definitions together as much as possible, 
and use comments to break up the script’s text and provide information about what each 
part does.

Step 3: Coding

Once you know your script’s purpose and have an idea of how it will be structured, you can 
begin writing the code. When you’re coding, remember that the exact format (“syntax”) of each 
word or statement is important. Misspelled words, or words that are not accompanied by all the 
necessary information, will cause errors in the script. It’s also a good idea to keep your script 
lines as short as possible. This makes the code easier to read and interpret. You can also use 
upper- and lowercase characters throughout, since FXBuilder is not case-sensitive.

Step 4: Testing

Is your script working, and if not, how do you fix it? Testing is a crucial part of the scripting 
process. If you’ve written a simple script, you may only need to run it once or twice to be 
satisfied that it works. More complex scripts may need to be tested on different clips and 
incorporated into the Timeline to see how the final product will look. 

Some scripts will not run at all because they contain syntax errors. Syntax errors are like 
spelling mistakes in the code. If you try to run a script that contains syntax errors, FXBuilder 
stops the script and highlights the first line that contains an error. Use the reference 
information in Chapter 32, “Commands and Functions Used in FXScript,” on page 1243 to 
check the syntax of your script.
1226 Chapter  31  



If your script contains input controls, or controls that can be changed by the user, make sure 
you test the script with a representative range of input settings. This ensures that all 
combinations of settings will work together. If you find that certain combinations of settings 
give a result that is unacceptable, you may need to modify the range of values accepted by 
one or more of the input controls, to prevent those combinations from being chosen. 
Another option is to fix the code so it works on all combinations.

Using FXBuilder
You can do several things with effects scripts in FXBuilder:

m Open an existing script

m Make changes to a script

m Test a script to see how it looks

m Create a new script

FXBuilder has two integral parts:

m The FXBuilder window:  This is where you create, test, and edit effects scripts. This 
contains two tabs, one for script entry and one for the input controls that modify the 
behavior of the script when it is run.

m The FXScript language:  This is the scripting language you use. FXScript commands and 
functions are listed in Chapter 32, “Commands and Functions Used in FXScript,” on 
page 1243.

Important  FXBuilder does not support multiple levels of undo. So if you make a change 
and want to undo it, don’t wait—undo it right away.
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Learning the FXBuilder Interface

The FXBuilder window has two tabs: FXBuilder Text Entry and FXBuilder Input Controls. 
Text Entry is where you enter the actual code and Input Controls is where you test your 
script on source video. FXBuilder also has menu commands that let you quickly perform 
various functions.

m FX Builder Text Entry:  Click this tab to review, enter, and edit script code.

m FXBuilder Input Controls:  Click this tab to test your script on source video. Some scripts 
require input from you in order to run. For example, if you’re testing a script that adds a 
color tint, you need to specify which color you want the tint to be. You also need to set 
the input controls for a script when you apply it to a clip in a sequence’s Timeline.
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m FXBuilder menu commands:  When an FXBuilder window is active, the FXBuilder menu 
appears next to the Tools menu. This menu lets you easily insert script words, run a script 
on a sample of video, or save your script as a file that can’t be modified.

Using Effects That Come With Final Cut Pro

Final Cut Pro comes with various video effects that you can modify by changing the script 
code. You can also use these as a starting point for creating your own scripts.

You can get to the effects in the Effects tab in the Browser and by using the Effects menu. 
Video effects are divided into several groups:

m Video Transitions:  Change the picture from one clip to another

m Video Filters:  Modify the picture in a single clip

m Video Generators:  Create new video information, such as text

When the FXBuilder 
window is active, a menu 
item appears.
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Creating a New Script

You create and test effects scripts in the FXBuilder environment. You can open an existing 
script, or you can open a new FXBuilder window and begin creating a script from scratch. For 
information on how scripts are structured, see “Understanding the Structure of a Script” on 
page 1236.

To create a new script:

1 Choose FXBuilder from the Tools menu. 

You can open as many FXBuilder windows as you want. 

2 If necessary, click the FXBuilder Text Entry tab.

3 Enter your scripting code.

For more information, see “Understanding the Structure of a Script” on page 1236.

If you want to create a unique name for the script, make sure you enter the name on the first 
line of the script. The names of effects that appear in the Effects tab in the Browser and in 
the Effects menu are determined by the first line of the script and not the exported filename. 

When you’re ready to test the code, see “Testing a Script in FXBuilder” on page 1231 or 
“Applying Scripts in the Timeline” on page 1233. 

To open a script so that you can view its code:

1 In the Browser’s Effects tab, locate and select the effect you want.

2 Choose Effect Editor from the View menu.

An empty FXBuilder
window ready for

a new script.
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An FXBuilder window shows the script for the selected effect. 

3 If desired, change the script.

For more information, see “Understanding the Structure of a Script” on page 1236.

Testing a Script in FXBuilder

You can run scripts in real time, without rendering them first.This lets you easily test an 
effect, then modify it if necessary.

To test a script:

1 Open the effects script you want.

2 Click the FXBuilder Input Controls tab.

3 Drag a clip from the Browser, Timeline, or Viewer into the Source 1 area.

Drag the clip you want
to test the effect on into

the Source 1 area.

If you’re testing a
transition, you need to

place another clip here.
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Note:  Controls, or settings, don’t appear in the FXBuilder Input Controls tab until you run 
your script in the FXBuilder Text Entry tab.

4 Click the FXBuilder Text Entry tab, then choose Run from the FXBuilder menu.

A separate FXBuilder window opens and runs the scripted effect on the clip over and over, 
with the In point used as a source.

5 Click the FXBuilder Input Controls tab, and if desired, adjust any settings.

You can do this while the script is running. If you click the Stop button or choose Stop from 
the FXBuilder menu, the input settings revert to the default, or saved, settings.

6 If desired, encode your script to protect it from modification.

See “Preventing Scripts From Being Modified or Viewed” on page 1234. 

7 Save your settings.

Click these buttons to 
stop or run your effect.

Move the playhead to 
step through the effect 
frame by frame or 
move rapidly through it.

Click this tab, then
adjust the settings.
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See “Exporting FXBuilder Scripts as Text” on page 1234.

To run the script on another clip, drag the other clip from the Browser, Timeline, or Viewer 
to the Source 2 area.

Applying Scripts in the Timeline

You can apply scripts to video parts of a sequence in the Timeline. You can place effects 
anywhere in the clip you want to apply them to. You can also apply multiple effects to the 
same clip. When you place effects in the Timeline, you can adjust their inputs. If you do not 
set the input controls, the defaults apply.

To apply a scripted effect to a sequence:

1 Drag the script from the Effects tab in the Browser to the desired location in the Timeline. 

If the effect is a transition or generator, an icon appears. If you’re placing transitions in the 
Timeline, you can place them at the center, beginning, or end of the cut.

2 Open the effect in the Viewer.

m For a transition or generator effect:  Double-click the effect’s icon.

m For filter effects:  Double-click the clip that includes the filter, then click the Filters tab in 
the Viewer.

3 Adjust any settings.

4 If necessary, render your scripted effects.

When you apply scripts in the Timeline, you must render them before you can play them. If 
you do not render video to which scripts have been applied, you will see a blue display with 
the word “Unrendered” in the Canvas. For more information, see Chapter 23, “Rendering,” 
on page 1065.

To see what an effect looks like in real time, see “Testing a Script in FXBuilder” on page 1231. 
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Preventing Scripts From Being Modified or Viewed

Now that you’ve spent some time and creative effort coming up with new scripts, you may 
not want others to view or modify your work. 

To encode a script:

1 Open the script in FXBuilder.

2 Do one of the following:

m To save a script so that it can be viewed only in Final Cut Pro:  Choose Create Plugin 
from the FXBuilder menu.

m To save a script so that it can’t be viewed or changed:  Choose Create Encoded Plugin 
from the FXBuilder menu. 

3 Enter a name and select a destination for the effect, then click Save.

Exporting FXBuilder Scripts as Text

If you export your script as a text file, it can be opened, viewed, and changed. Use this option 
when you are working on a script or if you are using scripts that are in the public domain.

To export a script as a text file:

1 Make sure that the FXBuilder window for the script is active. 

2 Choose Export Text from the FXBuilder menu.

3 Enter a name and select a destination for the effect, then click Save.

To use the exported script, you need to install it in the appropriate location in the Final Cut 
Pro folder. For more information, see the next section, “Installing Scripts.”

Important  Names for effects that appear in the Effects tab in the Browser and in the Effects 
menu are determined by the first line of the script and not the exported filename. When you 
are creating your script, make sure you give it a unique name on the first line of the script.

Choose a place
to save the file.

If you want, enter a
name for the file.
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To use an exported script in Final Cut Pro:

1 Quit Final Cut Pro.

2 Place the exported script in Final Cut Pro: Plugins: FXScripts folder. 

If you know the type of script you are installing, such as a video transition or audio filter, 
place it in the appropriate folder. 

3 Open Final Cut Pro.

Installing Scripts

You can install scripts that you’ve created or ones that you’ve gotten from other sources so 
you can use them in Final Cut Pro. Once effects are installed, they are available in the Effects 
tab in the Browser and from the Effects menu.

To install and use a script:

1 Quit Final Cut Pro.

2 Drag the script to the following location:  Final Cut Pro: Plugins: FXScripts folder. 

If you know the type of script you’re installing, such as a video transition or audio filter, place 
it in the appropriate folder. 

Your script appears in
the designated location

in the Effects tab.
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3 Open Final Cut Pro.

Final Cut Pro loads the new effects and they are available from the Effects menu or within the 
Effects tab in the Browser.

Understanding the Structure of a Script
All scripts have the same simple structure, which makes it easy to understand and change 
them. A script is divided into lines. Each line contains a statement, or a group of statements. 
There are several rules to follow when scripting:

m You can’t end a line in the middle of a statement. 

If you break the line in the middle of this code, the script will not run. For example, in the 
Tint script shown in the next section, the statement yuvtint = RGBtint must all 
appear on the same line. 

m The semicolon character (;) denotes the end of a line. 

You can also use a carriage return (the Return key). 

m Use a semicolon character (;) to join two short lines together. 

Reviewing the Script for the Tint Effect

Let’s look at an example from a script that comes with Final Cut Pro, the Tint script. This 
script applies a color tint to the video. 

To view the Tint script:

1 In the Browser, click the Effects tab, then select Tint in the Image Control bin within the 
Video Filters bin.

Your script appears in
the designated location

in the Effects tab.
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2 Choose Effect Editor from the View menu.

First two lines

The first two lines state the script’s name and type, and assign it to a group in the Browser. 
This script is named “Tint.” It is a filter script and has been assigned to the group Image 
Control. It is stored in the Browser’s Image Control bin.

filter "Tint";

group "Image Control";

Note:  If you want to create a unique name for the script, make sure you enter the name on 
the first line of the script. Names for effects that appear in the Effects tab in the Browser and 
in the Effects menu are determined by the first line of the script.

Third and fourth lines

The third line specifies the input control needed. In this case, all that is needed is a standard 
color selection control. If more input controls were needed, they would appear in this part of 
the script, on separate lines. 

This input control takes a number corresponding to the color selected and places it in a 
variable called RGBtint. All input controls place the result of the input into a variable, so that 
it can be used later on in the script code. 

input RGBtint, "Tint Color", color, 0, 0, 0, 0;

input amt, "Amount", slider, 100, 0, 100;

Fifth line

This line indicates that the script is capable of processing colors in YUV ( YCrCb) color space.

InformationFlag("YUVaware")

Sixth line

This line shows where the actual script code begins. Every line that follows it is script code.

code
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Remaining lines

The remaining lines are the code required to take the selected color and apply it to the video 
by changing the colors in individual pixels of video. The line (second from the final) that 
begins with the word channelFill is the one that actually applies the selected color. 

YUVcolor yuvtint;

RGBtint.a = 255;

yuvtint = RGBtint;

yuvtint += 128;

ConvertImage(src1, dest, kFormatYUV219);

channelFill(Dest, -1, -1, yuvtint.u, yuvtint.v);

blend(src1, dest, dest, amt/100);

Customizing a Script:  An Example

There are many ways to customize scripts. For example, you can change the Tint script by 
adding a brightness control that can be set by the user. 

To customize the Tint script:

1 Set the input control for the brightness level. 

Enter the line below under the Tint Color input command at the top of the script:  

input brightness, “Brightness”, slider, 100, 0, 200 label “%”;

The input is then used to change the brightness of the clip. 

2 Use the channelMultiply command to multiply the luminance channel by the input variable.

Enter the following line of code below the channelFill line in the body of the script:  

channelMultiply (dest, dest, 1, brightness/100, 1, 1);

The next time you run the script, you can change the brightness as well as the color tint.
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About the FXScript Commands
FXScript commands have various functions, which are briefly reviewed here. For complete 
reference information about the FXScript language, see Chapter 32, “Commands and 
Functions Used in FXScript,” on page 1243.

Statements

A statement is a command that accomplishes a single action. There are several types of 
statements in FXScript.

The Definition Statement

The first statement in every script should be the definition statement. This tells Final Cut Pro 
what the name of the script is, and what type of script it is (filter, transition, or generator). 
Final Cut Pro uses this information to place the script in the Browser’s Effects tab. If you 
don’t place a definition statement in your script, it will not run.

Conditional Statements

A conditional statement says that something should happen if a certain condition is met.

Conditional statements always begin with if and end with end if.

This example comes from the Bevel filter script, which places a beveled border around the 
picture. 

if framewidth<frameheight

framemin=framewidth;

framemax=frameheight;

else

framemin=frameheight;

framemax=framewidth;

end if;

This statement is conditional upon the values of two variables, framewidth and frameheight. 
It changes the values of two other variables, framemin and framemax, depending upon the 
relative values of the variable pair mentioned in the conditional statement. 

You can add more conditions by placing else if clauses into the conditional statement. 
Each else if clause allows you to add one more condition to the statement. 

The else clause means “in all other cases not covered by the previous condition or 
conditions.” It is not essential to place else statements in scripts unless you want to specify 
what should happen if none of the conditions are met.
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Input Statements

Input statements are extremely powerful and versatile. They enable you to place user 
controls into a script, so that an effect can be finely adjusted. The user controls appear in the 
Input controls tab in the FXBuilder window, and also in the Viewer when a script is added to 
the Timeline for a sequence.

There are several types of input control. You can choose the type of control that meets the 
needs of the script most closely. You can have more than one input control in a script; some 
have three or four.

Loops

A loop is a section of code that repeats, usually according to certain conditions specified by 
the needs of the script. There are several types of loops in FXScript:

m For/Next loop 

m Repeat/End Repeat loop:   This has several specific forms.

m Repeat While (conditional loop)

m Repeat With Counter (similar to the For/Next loop)

m Repeat With List (list)

Subroutines

A subroutine is a section of the code that can be “called” from another part of the script. 
When the subroutine is called, it runs and then returns the script flow to the place from 
which it was called. Subroutines are a useful way to break code up, and they minimize the 
amount of code in a script, because they can be reused.

m You begin a subroutine in a script using the on command, like this:

on mcysub (parameter 1, parameter 2...)

m You end a subroutine with the word end on a line by itself.

m All the code between the on and end commands is part of the subroutine.

“Mysub” is the subroutine’s name, and the “parameters” in brackets are information the 
subroutine needs to do its job. Sometimes the parameters are taken from input controls in 
the script.

The script can call the subroutine at any time just by using its name in a line of code. In a 
sense, the subroutine has become a new scripting word, which you have created. When the 
subroutine has been run, the script returns to the line immediately after it was called.
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Variables

A variable is a “container” for information that is unknown and that can change, such as 
the result of an input control selection. You can treat variables as if they were numbers or 
sequences of text; they’re like placeholders. 

Any time you use a variable in a script, it must be introduced to the script in a declaration 
statement. The exception to this rule is any predefined variable included in the FXScript 
language. 

There are three types of variables in FXScript:

m Predefined variables:  These are part of the FXScript language. Examples are color 
specifications, used by drawing routines, and the constants used by the numeric 
formatter. Another example is the variable fps, which contains the number 
corresponding to the current frame rate for the sequence. 

m Global variables:  These are variables that you define in the code section of the script. 
They reset to zero after each video frame on which the effect is applied, and can be 
referred to in any part of the script following their declaration statement. The declaration 
statement for a global variable must specify the data type of the variable being defined, as 
well as the name. 

m Static variables:  These are declared before the code section of the script and are 
initialized to a constant (kUndefined) only once. They maintain their values between 
frames of video, unless the script code changes them. Use static variables to get values 
from previous frames. 

Constants

A constant is a number that always has the same value, such as colors (kRed, kGreen, and 
kBlue). Several are available for use in your scripts.

Data

Data is any type of information processed in a script. FXScript can handle several types of data:

m Strings:  A string is a sequence of characters. Strings are processed as characters only and 
do not have mathematical or arithmetical meaning, even if they contain numbers. 

m Numbers:  FXScript allows you to work with several types of numbers. You can use 
floating-point numbers, numeric coordinates, and numbers corresponding to colors.

m Images:  These are buffers that can hold frames of video.

m Regions:  These define an area of a video frame.

m Clips:  These are buffers that can hold entire clips.
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Arrays

An array is a grid of one or more dimensions. In a sense, a video picture is a two-dimensional 
grid made up of colored dots. Arrays are often used in scripts that calculate which pixels or 
regions of a frame need to be modified. 

Operators and Expressions

An expression is a statement about the value of a number or numbers. It consists of numbers 
themselves, or variables, combined with relational operators. 

A relational operator is a symbol that defines a mathematical, logical, or arithmetical function 
such as addition or subtraction, or a condition, such as the state of being greater than or less 
than something else. FXScript understands a wide variety of relational operators suited to 
different scripting purposes.

Functions 

A function is a predefined calculation. Functions are very useful in graphical calculations, 
such as the arctangent or cosine of a number. Some functions are used in color processing, 
and others are used when processing digital video information on a pixel-by-pixel level. 
Functions can be references in your scripts in the same way as variables.

Comments

Comments are an essential part of a script. They give information about the script and what it 
is doing. They can make a script much easier to understand, test, and change by giving useful 
explanatory detail about the script’s code and structure. Any script line that begins with the 
characters // is a comment. You can place a comment line anywhere in a script. 
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32 Commands and Functions Used in 

FXScript
This chapter lists all the commands and functions in the FXScript language. They are 
grouped by the FXBuilder submenu they appear in. Each command includes information 
about its syntax, any parameters it requires, and any special information about its use. 

When creating a script, you can place command templates into an FXBuilder Text Entry tab 
by choosing them from the FXBuilder menu.

Scripting Parameters

Many FXScript commands require parameters for the calculations they perform. These have 
names that indicate their uses. Any parameter required by FXScript functions and commands 
can be replaced by a variable, as long as the variable is of the correct data type and has been 
correctly declared elsewhere in the script. Some functions and commands can use numeric 
parameters as well as variables.

Expressions in FXScript

Expressions are like phrases made up from scripting words, numbers, and operators, 
together with parentheses. The operators determine what sort of calculation or evaluation 
(also known as an operation) is done, and the parentheses determine the order in which 
calculations are performed.

The rules are as follows:

m An expression is interpreted from left to right. 

m Multiplication and division take precedence over addition and subtraction.

m Parts of the expression that are enclosed in parentheses are given priority over parts that 
are outside the parentheses. If there are several layers of parentheses, the expression is 
evaluated in order from the innermost parentheses to the outermost.
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Operators

The following table lists all the operators that can be included in your scripts.

Note:  Numbers are assumed to be floating-point unless preceded by “0x,” which denotes 
hexadecimal.

Operator Meaning

+ Add (This operator can also be used to indicate a positive number.)

– Subtract (This operator can also be used to indicate a negative number.)

* Multiplication

/ Division

! or not Logical NOT

~ Bitwise NOT

% or mod Modulo

== Equal

!= Not equal

< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

<< Shift left

>> Shift right

& Bitwise AND

| Bitwise OR

ˆ or xor Bitwise XOR

&& or and Logical AND

|| or or Logical OR

? and : <conditional> ? <value 1> : <value 2>

If the conditional is true, it will return value 1; if it is false, it will return value 2.
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Compound Operators

In an assignment statement, you can use the compound assignment operators. These are 
+=, –=, *=, /=, %=, &=, |=, and ˆ=. 

Operators and Regions

For regions, only a few operators can be used. These are

m + (add)

m – (subtract)

m & (and)

m |(or)

m ˆ (exclusive or; means one or the other, but not both)

Operators and Strings

Only the + operator can be used for concatenating, or appending, strings together.

Data Types

Data types allow you to declare variables and assign specific data types to them. Data type 
statements are always followed by one or more variable names, separated by commas. You 
can create arrays by following a data type statement with up to 5 dimensions of the array in 
brackets. For example, the code below creates a 3 by 4 array of points and names it “p”:

point p [3] [4]

Data type Syntax Description

float float variablename Declares a floating-point 
variable

point point variablename Declares a variable that contains 
a two-dimensional point 
coordinate

point3d point3d variablename Declares a variable that contains 
a three-dimensional floating-
point coordinate

image image variablename 

[width][height]

Declares a two-dimensional 
buffer of pixels to be operated 
on

region region variablename Declares a named region (A 
region is an arbitrary shape.)
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Functions

Functions can be used with variables as well as with known numbers.

string string variablename Declares a text string

color color variablename Declares a variable with four 
fields (one each for a, r, g, and 
b) that contains an ARGB color 
value

YUVcolor YUVcolor variablename Declares a variable with four 
fields (one each for a, y, u, and 
v) that contains a YUV color 
value

clip clip variablename Declares a variable that holds a 
video clip

value value variablename Declares a non-modifiable 
parameter in a subroutine

Data type Syntax Description

Function Syntax Description

Sin Sin(angle) The sine of the specified angle 
(as a floating-point number in 
degrees)

Cos Cos(angle) The cosine of the specified 
angle (as a floating-point 
number in degrees)

Tan Tan(angle) The tangent of the specified 
angle (as a floating-point 
number in degrees)

ASin ASin(value) The arcsine of the value in 
degrees

ACos ACos(value) The arccosine of the value in 
degrees

ATan ATan(value) The arctangent of the value in 
degrees
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Sqrt Sqrt(value) The square root of the value

Abs Abs(value) The absolute integer value of 
the value

Power Power(value, exponent) The value raised to the specified 
exponent

Exp Exp(value) The mathematical constant e 
raised to the power 
corresponding to the specified 
value

Log Log(value) The base e logarithm of the 
value

Log10 Log10(value) The base 10 logarithm of the 
value

Integer Integer(value) Converts the value into an 
integer number

Sign Sign(value) The sign of the value. This is –1 
if the value is less than zero, 0 if 
the value equals zero, and 1 if 
the value is greater than zero.
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Geometry

Command Syntax Description

DistTo DistTo(p1, p2) The distance from p1 to p2, 
where p1 and p2 are two-
dimensional point coordinates

AngleTo AngleTo(p1, p2) Returns the angle from p1 to 
p2, where p1 to p2 is a vector

Interpolate Interpolate(p1, p2, 

percent, result)

Interpolates between two 
points. The result is a two-
dimensional point variable.

CenterOf CenterOf(poly, point) Places the center point of the 
polygon represented by “poly” 
into the variable represented by 
“point”

BoundsOf BoundsOf(image, result) Fills in the polygon represented 
by “result” with a four-sided 
rectangle that is the bounds of 
“image.” The result must be a 4 
point array.

DimensionsOf DimensionsOf(image, width, 

height)

Returns the width and height of 
the specified image buffer

AspectOf AspectOf(image) Returns a floating-point value 
that is the aspect ratio of the 
pixels of the specified image 
buffer. This buffer must have 
been previously declared and 
have the image data type.

Grid Grid(srcPoly, destPoly) Splits a rectangular polygon, 
“srcPoly,” and divides it into a 
grid of rectangles based on the 
dimensions of “destPoly” 

Mesh Mesh(srcPoly, destPoly) Makes a mesh out of a 
rectangular polygon, “srcPoly,” 
based on the dimensions of 
“destPoly”
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Shapes

Convert2dto3d Convert2dto3d(point/poly, 

point3d/poly3d, 

zvalue)

Fills in the values of “point3d” 
or “poly3d” with the 
corresponding values from 
“point” or “poly,” using the 
number represented by “zvalue” 
for the z-axis dimension of each 
point

Convert3dto2d Convert3dto2d(point3d/

poly3d, point/poly, 

eye3d)

Fills in the values of “point” or 
“poly” with the corresponding 
values from “point3d” or 
“poly3d.” “Eye3d” is the view 
point for the conversion. If it is 
zero, then parallel projection is 
used for the conversion. 

Command Syntax Description

Command Syntax Description

Line Line(p1, p2, image, color, 

width)

Draws a line in the buffer 
corresponding to “image,” from 
p1 to p2, with the specified 
color (expressed as an RGB 
value) and width (in pixels)

MakeRect MakeRect(result, left, 

top, width, height)

Fills in a rectangular polygon, 
“result,” with the dimensions 
specified. “Left” and “top” are 
two-dimensional points and 
width and height are distances 
in pixels.

MakeRegion MakeRegion(poly, rgn) Turns the specified polygon into 
a region, stored in the region 
named “rgn”

OvalRegion OvalRegion(poly, rgn) Makes an oval from the upper-
left and lower-right corners of 
the specified polygon, and 
stores it in the region named 
“rgn” 
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RegionIsEmpty RegionIsEmpty(rgn) Returns “true” if the region 
specified contains no pixels. 
“True” has a value of 1.

FrameRegion1 FrameRegion(rgn, image, 

color, width)

Draws a line around the 
specified region, “rgn,” with the 
specified color and width in the 
image buffer

FillRegion1 FillRegion(rgn, image, 

color)

Fills the specified region with 
the specified color and stores 
the result in the specified image 
buffer

FramePoly FramePoly(poly, image, 

color, width)

Draws a frame around the 
bounds of the specified 
polygon, with the specified 
color (as an RGB value) and the 
specified width (in pixels). 
Stores the result in the specified 
image buffer.

FillPoly FillPoly(poly, image, 

color)

Fills the specified polygon with 
the specified color and stores 
the result in the specified image 
buffer

DrawSoftDot DrawSoftDot(dest, point/

poly, shape, size, 

softness, subSteps, 

color(s), 

opacity(s), aspect)

Draws one or more sub-pixel-
positioned shapes in a buffer. 
This command can be used to 
draw circles, squares, and 
diamonds in the specified color, 
size, softness, positioning 
accuracy, and opacity. The color 
and opacity can be an array or a 
single value.

FillOval FillOval(poly, dest, 

color)

Fills the oval bounded by the 
specified polygon with the 
specified color and stores the 
result in the specified image 
buffer

Command Syntax Description
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FrameOval FrameOval(poly, dest, 

color, width)

Draws a frame around the oval 
bounded by the specified 
polygon, with the specified 
color (as an RGB value) and the 
specified width (in pixels). 
Stores the result in the specified 
image buffer.

FillArc FillArc(center, radius, 

startAngle, 

endAngle, dest, 

color, aspect)

Draws an arc from “startAngle” 
to “endAngle” to the “dest” 
output.

The size of the arc is specified 
by “radius” and the position is 
specified by “center.” The arc is 
filled with the specified color.

FrameArc FrameArc(center, radius, 

startAngle, 

endAngle, sides, 

dest, color, width, 

aspect)

Draws a frame of the arc from 
“startAngle” to “endAngle” to 
the “dest” output.  

The size of the arc is specified 
by “radius” and the position is 
specified by “center.” The frame 
is in the specified color and 
width.

“Sides” is a boolean. If it is true, 
it will draw two lines (of same 
color and width as the arc) from 
the ends of the arc to the center 
point; otherwise, no lines are 
drawn.

CurveTo CurveTo(startPt, 

tangentPt, endPt, 

dest, color, width)

Draws a curve from “startPt” to 
“endPt” to the “dest” output. The 
shape of the curve is determined 
by “tangentPt.” The curve is in 
the specified color and width.

1 The Region routine fills the alpha channel with black.

Command Syntax Description
 Commands and Functions Used in FXScript 1251



Transform

Command Syntax Description

Rotate Rotate(point/poly, center, 

angle, aspect)

Rotates the specified point or 
polygon through the specified 
angle in degrees, around the 
specified center

Rotate3d Rotate3d(point3d/poly, 

center3d, xrotate, 

yrotate, zrotate)

Rotates the specified three-
dimensional point or polygon 
through the specified angles, 
around the specified center. 
Note that “center3d” has three 
fields, corresponding to height, 
width, and depth. 

Scale Scale(point/poly, center, 

hScale, vScale)

Scales a point or polygon 
around the specified center by 
the amounts specified in 
“hscale” and “vscale”

Scale3d Scale3d(point3d/poly3d, 

center3d, xscale, 

yscale, zscale)

Scales a three-dimensional point 
or polygon around the specified 
center by the three scaling 
factors

Offset Offset(point/poly, 

hAmount, vAmount)

Moves a point or polygon by the 
specified amount on each 
dimension in the amount 
specified

Offset3d Offset3d(point3d/poly3d, 

xoffset, yoffset, 

zoffset)

Moves a three-dimensional 
point or polygon by the 
specified amount in each plane

Outset3d Outset3d(poly3d, center3d, 

amount)

Moves a four-sided polygon 
towards or away from the 
specified center point in three 
dimensions
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Blit

Command Syntax Description

RegionCopy RegionCopy(srcImage1, 

srcImage2, 

destImage, rgn, 

softness)

Copies the two source images 
into the destination image 
buffer using the specified region 
as a mask, softening the edges 
of the mask according to the 
value given for softness

Blit Blit(sourceImage, 

sourcePoly, 

destImage, 

destPoly, opacity)

Copies the pixels inside
“sourcePoly” in “sourceImage” 
into the “destPoly” in 
“destImage,” applying the 
specified opacity

BlitRect BlitRect(sourceImage, 

sourcePoly, 

destImage, 

destPoly)

Copies the pixels inside 
“sourcePoly” in “sourceImage” 
into the “destPoly” in 
“destImage.” The source and 
destination polygons must be 
four-sided and the alpha 
channel of the source is treated 
as opaque.

MeshBlit MeshBlit(sourceImage, 

sourcePoly, 

destImage, 

destPoly, opacity)

Copies the pixels from 
“sourceImage” into 
“destImage,” using two point 
meshes as the transformation 
and applying the specified 
opacity

MeshBlit3D MeshBlit3d(sourceImage, 

sourcePoly, 

destImage, 

destPoly3d, 

opacity, center3D)

Copies the pixels from 
“sourceImage” into 
“destImage,” using two 3D 
point meshes as the 
transformation and applying the 
specified opacity
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MaskCopy MaskCopy(sourceImage1, 

sourceImage2, 

maskImage, 

destImage,softness, 

amount)

Copies from the two source 
images into the destination 
image, using a gradient mask. 
The value given for “softness” 
defines the threshold amount 
for the gradient, and “amount” 
specifies the gradient 
percentage. This command is 
the same as RegionCopy, but 
the mask is derived from an 
image buffer.

PagePeel PagePeel(srcImage1, 

srcImage2, 

destImage, 

centerPoint, 

radius, angle, 

peel, aspect)

Performs a “page peel” effect, 
using the srcImage1 and 2 
buffers as the front and back of 
the page. The result is placed in 
the “destImage” buffer. The 
center point and angle specify 
the location and angle of the 
“cut line” for the peel. “Radius” 
is the radius of the curvature for 
the peel. The value given for 
“peel” determines the type of 
peel that occurs: if it is zero, the 
image is rolled up along one 
side, like a scroll, and if it is any 
value other than zero, the image 
peels upward and away, starting 
at one corner, from the image 
below.

Command Syntax Description
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Process

Command Syntax Description

Blur Blur(srcImage, destImage, 

radius, aspect)

Performs a blur operation on 
the source image buffer and 
places the result in the 
destination image buffer. 
“Radius” specifies the radius of 
blur.

BlurChannel BlurChannel(srcImage, 

destImage, radius, 

doAlpha, doRed, 

doGreen, doBlue, 

aspect)

Performs a blur operation on 
the specified channels of the 
source image buffer and places 
the result in the destination 
image buffer. “Radius” specifies 
the radius of blur. The 
doChannel values are Boolean 
numbers, either known 
numbers or variables.

Diffuse Diffuse(srcImage, 

destImage, 

repeatEdges, hMin, 

hMax, vMin, vMax)

Fills each pixel in the 
destination image buffer with a 
pixel from the source image 
buffer, which is offset spatially 
by a random number. The range 
for this random number is 
defined by the values assigned 
to “hMin” and “hMax” on the 
horizontal axis, and “vMin” and 
“vMax” on the vertical axis. 
“RepeatEdges” is a Boolean 
operation that determines 
whether pixels that would be 
beyond the bounds of the 
source image are filled with 
copies of the nearest edge pixel, 
or with transparent black pixels. 

DiffuseOffset DiffuseOffset(srcImage, 

destImage, 

repeatEdges, hMin, 

hMax, vMin, vMax, 

hTable[width], 

vTable[height])

This is similar to Diffuse, but the 
horizontal and vertical offset for 
each pixel is added to the 
“hTable” and “vTable,” which 
contain the horizontal and 
vertical position for each pixel.
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MotionBlur MotionBlur(srcImage, 

destImage, hDist, 

vDist, steps)

Copies the source image buffer 
into the destination image 
buffer, adding a motion blur 
with a magnitude specified by 
“hDist” and “vDist.” “Steps” 
determines how many 
intermediate steps are added.

RadialBlur RadialBlur(srcImage, 

destImage, 

centerPt, amount, 

spin, steps, 

aspect)

Copies the source image buffer 
into the destination image 
buffer, adding radial blur with a 
magnitude specified by 
“amount,” around the center 
specified in “centerPt.” “Steps” 
specifies how many 
intermediate steps are added to 
the blur effect. “Spin” can be 
either true or false. If true, 
“amount” is a rotation angle. If 
false, “amount” is the distance 
that the blur extends from the 
center point. 

Blend Blend(srcImage1, 

srcImage2, 

destImage, amount)

Blends the two source image 
buffers and places the result in 
the destination image buffer. 
“Amount” specifies the blend 
percentage. 

ColorTransform ColorTransform(srcImage, 

destImage, matrix, 

float[3], float[3])

Performs color transformation 
from the source image buffer to 
the destination image buffer, 
based on the specified 3x3 float 
matrix. The two float arrays 
specify the offsets to be added 
to the source and destination 
buffers during the operation. If 
the matrix is an RGB to RGB 
transformation, the arrays 
should be filled with zeros. 
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LevelMap LevelMap(src, dest, 

alphaMap[256], 

redMap[256], 

greenMap[256], 

blueMap[256])

Maps the source image buffer 
into the destination image 
buffer, passing each component 
of the source image through a 
256-entry floating-point lookup 
table. The tables are alpha, red, 
green, and blue, in that order. 

ChannelCopy ChannelCopy(src, dest, 

copyAlpha, copyRed, 

copyGreen, 

copyBlue)

Copies a set of channels from 
the source image buffer to the 
destination image buffer. Each 
channel is copied from the 
channel specified by its 
corresponding parameter. The 
“copy” parameters are the 
predefined variables kAlpha, 
kRed, kGreen, and kBlue. 

Convolve Convolve(srcImage, 

destImage, kernel, 

divisor, offset)

Performs a 3x3 convolution 
from the source image buffer to 
the destination image buffer. 
The sum of the contents of the 
3x3 array specified as “kernel” is 
divided by the specified divisor, 
and “offset” is added in.

ChannelFill ChannelFill(destImage, 

alphaValue, 

redValue, 

greenValue, 

blueValue)

Fills the channels of the 
destination image buffer with 
the color values specified

ChannelMultiply ChannelMultiply(srcImage, 

destImage, 

alphaValue, 

redValue, 

greenValue, 

blueValue)

Copies the source image buffer 
into the destination image 
buffer, multiplying each channel 
by the corresponding color 
value. If any of these is set to 
1.0, the channel is unchanged.

Desaturate Desaturate( image ) This converts the image to black 
and white in the most efficient 
way possible, depending on 
color space.
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Distort

Distort is a group of routines that distort a clip. 

Command Syntax Description

Cylinder Cylinder(srcImage, 

destImage, center, 

radius, amount, 

vertical)

Copies the source image buffer 
into the destination image 
buffer, distorting the pixels so 
that they appear to have been 
mapped onto the surface of a 
cylinder. “Center” specifies the 
two-dimensional center point 
for the cylinder; “radius” 
specifies the width of the 
affected area. “Vertical” is a 
Boolean number (true or false) 
that specifies whether the 
cylinder is horizontal or vertical. 
“Amount” specifies the intensity 
of the effect.

Fisheye FishEye(srcImage, 

destImage, 

centerPt, radius, 

amount, aspect)

Copies the source image buffer 
into the destination image 
buffer and distorts the image 
outwards, creating a fisheye lens 
effect. “Radius” specifies the 
effect’s radius from the center 
point in pixels. You can use a 
negative number for “amount,” 
which creates a reverse effect.

Whirlpool Whirlpool(srcImage, 

destImage, 

repeatEdges, 

centerPt, amount, 

aspect)

Copies the source image buffer 
into the destination image 
buffer, distorting the image 
outwards from the center point 
by spinning the pixels around 
by the “amount” specified. If 
“repeatEdges” is true, then the 
edge pixels are repeated; 
otherwise transparent black 
pixels are introduced at the 
edges.
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Ripple Ripple(srcImage, 

destImage, 

repeatEdges, 

centerPt, 

amplitude, 

wavelength, aspect)

Copies the source image buffer 
into the destination image 
buffer, distorting the image by 
applying waves from the edges. 
“Amplitude” and “wavelength” 
control the size and number of 
waves in the ripple. 

Wave Wave(srcImage, destImage, 

repeatEdges, 

centerPt, 

amplitude, 

wavelength, 

vertical, aspect)

Copies the source image buffer 
into the destination image 
buffer, distorting the image 
outwards from the center point 
in such a way that the image 
appears horizontally or vertically 
rippled. The number and size of 
the waves are controlled by 
“amplitude” and “wavelength.” 
The Boolean number (true or 
false) represented by “vertical” 
determines whether the waves 
are arranged horizontally or 
vertically. If “repeatEdges” is 
true, then the edge pixels are 
repeated; otherwise transparent 
black pixels are introduced at 
the edges.

PondRipple PondRipple(srcImage, 

destImage, 

centerPt, 

radius[n], 

thickness[n], 

amplitude, 

luminance, aspect)

Copies the source image buffer 
into the destination image 
buffer, distorting the image 
outward from the center point 
in a pond ripple pattern. The 
two parameters must be 
floating-point arrays of the same 
size. “n” ripples are created, 
with radius and thickness 
corresponding to “n.”
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Displace Displace(srcImage, 

destImage, 

mapImage, 

repeatEdges, 

xScale, yScale, 

lumaScale, aspect)

Performs a pixel operation by 
taking the red and green 
channel values of a clip to offset 
the source clip horizontally and 
vertically, respectively

BumpMap BumpMap(srcImage, 

destImage, 

mapImage, 

repeatEdges,

angle, scale, 

lumaScale, 

aspect)

Performs a pixel operation by 
taking the luminance value of a 
clip to offset the source clip

OffsetPixels OffsetPixels(srcImage, 

destImage, 

repeatEdges, 

hDisplace[width], 

vDisplace[height], 

aspect)

Performs a row and column 
operation by using two arrays to 
offset the source clip

Command Syntax Description
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Composite

Command Syntax Description

Matte Matte(overImage, 

baseImage, 

destImage, amount, 

type)

Composites the image buffer 
specified as “overImage” onto 
the buffer specified as 
“baseImage,” and places the 
result in the destination image 
buffer. “Type” can be one of the 
predeclared variables kAlpha, 
kWhite, or kBlack. These allow 
alpha channel compositing or 
black or white matte alpha 
channel compositing. “Amount” 
controls the opacity of the 
image being overlaid.

Screen Screen(srcImage1, 

srcImage2, 

destImage, amount, 

type)

Mixes the white areas of source 
image 1 into source image 2, 
placing the result in the 
destination image buffer. 
“Amount” controls the 
percentage of the blend.

Multiply Multiply(srcImage1, 

srcImage2, 

destImage, amount, 

type)

Mixes the black areas of source 
image 1 into source image 2, 
placing the result in the 
destination image buffer. 
“Amount” controls the 
percentage of the blend.

Overlay Overlay(srcImage1, 

srcImage2, 

destImage, amount, 

type)

Mixes the white areas of source 
image 1 into source image 2, 
where the color values of pixels 
in source image 1 are over 127, 
and mixes the black areas of 
source image 1 into source 
image 2 elsewhere. The result is 
placed in the destination image 
buffer. “Amount” controls the 
percentage of the blend.
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Lighten Lighten(srcImage1, 

srcImage2, 

destImage, percent, 

type)

For each pixel in the destination 
image buffer, this function 
chooses the corresponding 
pixel in the source image that 
has the lighter grayscale value.

Darken Darken(srcImage1, 

srcImage2, 

destImage, percent, 

type)

For each pixel in the destination 
image buffer, this function 
chooses the corresponding 
pixel in the source image that 
has the darker grayscale value. 

Difference Difference(srcImage1, 

srcImage2, 

destImage, type)

Fills each pixel in the 
destination image buffer with a 
color value corresponding to 
the absolute value of the 
difference between each of the 
channels in the two source 
image buffers

Add Add(srcImage1, srcImage2, 

destImage, percent, 

type)

Fills each pixel in the 
destination image buffer with a 
color value corresponding to 
the sum of the pixels in source 
image 1 and the fraction of 
source image 2 specified by 
“percent”

AddOffset AddOffset(srcImage1, 

srcImage2, 

destImage, offset)

Fills each pixel in the 
destination image buffer with a 
color value corresponding to 
the sum of the pixels in source 
image 1 and source image 2. 
The amount of offset is 
specified by adding or 
subtracting a value.

Command Syntax Description
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Subtract Subtract(srcImage1, 

srcImage2, 

destImage, percent, 

type)

Fills each pixel in the 
destination image buffer with a 
color value corresponding to 
that for the same pixel in source 
image 1 less the values of the 
matching pixels in the portion 
of source image 2 specified by 
“percent” 

ImageAnd ImageAnd(srcImage1, 

srcImage2, 

destImage)

Fills the destination image 
buffer with a logical AND of all 
the pixels in the two source 
image buffers

ImageOr ImageOr(srcImage1, 

srcImage2, 

destImage)

Fills the destination image 
buffer with a logical OR of all 
the pixels in the two source 
image buffers

ImageXor ImageXor(srcImage1, 

srcImage2, 

destImage)

Fills the destination image 
buffer with a logical “Exclusive 
OR” of all the pixels in the two 
source image buffers

Invert Invert(srcImage, 

destImage)

Inverts the image

InvertChannel InvertChannel(srcImage, 

destImage, doAlpha, 

doRed, doGreen, 

doBlue)

Inverts one or more channels 
selectively

UnMultiply UnMultiply(srcImage, 

srcImagetype)

Removes black or white 
pre-multiplication
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Key

Command Syntax Description

BlueScreen BlueScreen(srcImage, 

destImage, min, 

max, fillRGB)

Creates a mask from the source 
image buffer, extracting the blue 
areas of the image. “Min” and 
“max” control the range of color 
extraction. If “fillRGB” is 1, the 
RGB channels are filled with a 
grayscale mask. Otherwise only 
the alpha channel is filled. 

GreenScreen GreenScreen(srcImage, 

destImage, min, 

max, fillRGB)

Creates a mask from the source 
image buffer, extracting the 
green areas of the image. “Min” 
and “max” control the range of 
color extraction. If “fillRGB” is 1, 
the RGB channels are filled with 
a grayscale mask. Otherwise 
only the alpha channel is filled. 

BGDiff BGDiff(srcImage, 

destImage, min, 

max, fillRGB)

Creates a mask from the source 
image buffer, extracting the 
areas of maximum difference 
between the blue and green 
channels. “Min” and “max” 
control the range of color 
extraction. If “fillRGB” is 1, the 
RGB channels are filled with a 
grayscale mask. Otherwise only 
the alpha channel is filled.
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RGBColorKey RGBColorKey(srcImage, 

destImage, 

redTarget, redPass, 

greenTarget, 

greenPass, 

blueTarget, 

bluePass, softness, 

fillRGB)

Fills either the alpha or RGB 
channels of the destination 
image buffer with a mask 
created by comparing the values 
of the pixels in the source 
image to the “pass” values and 
“target” numbers specified. 
“Softness” specifies the softness 
of the mask. “FillRGB” specifies 
whether the alpha or RGB 
channels are filled with the 
results. 

YUVColorKey YUVColorKey(srcImage, 

destImage, yTarget, 

yPass, uTarget, 

uPass, vTarget, 

vPass, softness, 

fillRGB)

Fills either the alpha or RGB 
channels of the destination 
image buffer with a mask 
created by comparing the YUV 
values of the pixels in the 
source image to the “pass” 
values and “target” numbers 
specified. “Softness” specifies 
the softness of the mask. 
“FillRGB” specifies whether the 
alpha or RGB channels are filled 
with the results.
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External

Command Syntax Description

Filter Filter("name", source, 

dest, frame, 

duration, fps, 

["parmName", 

parmValue, ...])

Calls another script, which must 
be a filter. It passes one source 
and one destination image 
buffer, as well as values 
corresponding to the frame 
where the filter is to begin, the 
frames per second for the video 
where the frame is found, and 
the duration of the filter effect. 
You can also set the inputs for 
the filter using the parameters 
in square brackets. These 
should correspond to the 
variable names declared to hold 
the inputs in the filter script 
being called.
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Transition Transition("name", src1, 

src2, dest, frame, 

duration, fps, 

["parmName", 

parmValue, ...])

Calls another script, which must 
be a transition. It passes two 
source image buffers and one 
destination image buffer, as well 
as values corresponding to the 
frame where the transition is to 
begin, the frames per second 
for the video where the frame is 
found, and the duration of the 
transition effect. You can also 
set the inputs for the transition 
using the parameters in square 
brackets. These should 
correspond to the variable 
names declared to hold the 
inputs in the transition script 
being called. 

Generator Generator("name", dest, 

frame, duration, 

fps, ["parmName", 

parmValue, ...])

Calls another script, which must 
be a generator. It passes one 
destination image buffer, as well 
as values corresponding to the 
frame where the generator is to 
begin, the frames per second 
for the video where the frame is 
found, and the duration of the 
generator effect. You can also 
set the inputs for the generator 
using the parameters in square 
brackets. These should 
correspond to the variable 
names declared to hold the 
inputs in the generator script 
being called. 
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String

Command Syntax Description

NumToString NumToString(number, 

string, format)

Converts a number into a string 
of text, using the format 
specified. The format can be 
any one of the constants used 
to describe text formatting. 

StringToNum1 StringToNum(string) Converts a string into a series of 
numbers

Length Length(string) Returns a number 
corresponding to the number of 
characters in the specified string

CharsOf CharsOf(sourceString, 

first, last, 

destString)

Places a subset corresponding 
to the “first” through the “last” 
characters of the source string 
into the destination string

ASCIIOf ASCIIOf(string, index) Returns the ASCII value of the 
character at the index in the 
string

ASCIIToString ASCIIToString(ASCIIValue, 

destString)

Converts an ASCII value into the 
character it represents and 
places this character in the 
destination string specified

CountTextLines CountTextLines(string) Returns a number 
corresponding to the number of 
lines of text in the string 
specified

FindString FindString(sourceString, 

startOffset, 

findString)

Finds the characters in 
“FindString” within 
“sourceString,” starting from 
“startOffset”

1 StringToNum is not double-byte compatible. It properly converts a string to a number if the string contains single-byte 
numbers only. If the string contains a double-byte number, the routine converts to zero.
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Text

Command Syntax Description

DrawString DrawString(string, h, v, 

spacing, image, 

color, aspect)

Draws the specified text string 
in the specified image buffer, 
starting in the position specified 
by “h” and “v.” “Spacing” 
determines the distance in 
pixels between the characters 
(auto-kerning), and “color” 
specifies the color value for the 
text. Can be used with double-
byte characters.

DrawStringPlain DrawStringPlain(string, 

poly, image, color, 

aspect)

A faster string routine which 
does not perform auto-kerning. 
Can be used with double-byte 
characters.

MeasureString MeasureString(string, 

spacing, width, 

height, ascent, 

descent, aspect)

Takes the specified string and 
returns numbers based on its 
dimensions. “Spacing” 
determines the distance in 
pixels between the characters 
(auto-kerning). Can be used 
with double-byte characters.

MeasureStringPlain MeasureStringPlain(string, 

width, height, 

ascent, descent, 

aspect)

Takes the specified string 
without an auto-kerning 
calculation and returns 
numbers based on its 
dimensions. Can be used with 
double-byte characters.

SetTextFont SetTextFont(string) Chooses a font for the text from 
the available system fonts

SetTextJustify SetTextJustify

(justification)

Specifies right, left, or center 
justification for a text string

SetTextStyle SetTextStyle(style) Sets plain, bold, italic, or bold 
italic for the text type used in a 
text string
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Clip

SetTextSize SetTextSize(size) Sets the point size for a text 
string

ResetText ResetText Resets the text to plain style, 
black text color, 24-point size, 
Times® font, and left-aligned

Command Syntax Description

Command Syntax Description

GetVideo GetVideo(srcClip, 

timeOffset, 

destImage)

Places a frame from the clip 
specified in “srcClip” into the 
“destImage” buffer, starting at 
the specified time offset

GetTimeCode GetTimeCode(srcClip, 

timeCode, 

frameRate, 

dropFrame)

Gets the timecode for the 
specified frame

GetReelName GetReelName(srcClip, 

string)

Places the reel name for the 
source clip into the specified 
string

GetLimits GetLimits(srcClip, 

duration, offset)

Places the time duration of the 
specified clip into the variable 
represented by “duration”
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Utility

Command Syntax Description

SysTime SysTime Returns the computer’s current 
clock setting

Random Random(min, max) Returns a random number no 
less than “min” and no greater 
than “max”

RandomTable RandomTable(array[n]) Fills the specified float array 
with unique random values 
between 0 and n-1

RandomSeed RandomSeed(value) Initializes the random number 
generator. If “value” is zero, 
random numbers generated will 
be in a different sequence every 
time.

MatrixConcat MatrixConcat(srcMatrix1, 

srcMatrix2, 

destMatrix)

Concatenates two 3x3 matrices 
and places the result into the 
destination matrix

ColorOf ColorOf(image, point, 

color)

Places the color value of the 
specified point in the specified 
image buffer into the variable 
specified for “color”

Truncate Truncate(srcRect1, 

srcRect2)

Takes the two source rectangles 
specified and truncates them 
into two equal-sized rectangles. 
This is used right before Blit 
commands to improve speed if 
sub-pixel accuracy is not 
needed. 
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PointTrack PointTrack(fromImage, 

srcPoint, toImage, 

guessPoint, range, 

deltaPoint)

Scans a rectangle of the size 
specified in “range” around the 
specified source point in the 
“fromImage” buffer, looking for 
a match in the “toImage” buffer. 
This assesses the difference in 
position between the two image 
buffers. The offset of the 
matching image data in the 
“toImage” is placed in 
“deltaPoint.” 

Highlight Highlight(destImage, 

centerPoint, angle, 

width, softness, 

dither, gaussian, 

foreColor, 

backColor, aspect)

Paints a specular highlight band 
in the destination image buffer, 
using the specified center point 
and angle as the highlight line. 
“Width” and “softness” define 
the size of the highlight band, 
and “color” specifies the color. 
If the value for “dither” is true, a 
random dither is applied to the 
highlight gradient, making it 
smoother over large areas. If 
“gaussian” is true, the gradient 
will have a Gaussian fall-off, 
which looks more natural when 
used for specular highlight, or 
when two highlights are 
screened together.

CircleLight CircleLight(destImage, 

centerPoint, width, 

softness, aspect, 

dither, gaussian, 

foreColor, 

backColor)

Creates a circular highlight 
outwards from “centerPoint”

RandomNoise RandomNoise(destImage, 

alphaMin, alphaMax, 

redMin, redMax, 

greenMin, greenMax, 

blueMin, blueMax, 

makeColors)

Randomizes the color of all the 
pixels in the destination image 
buffer, according to the bounds 
set by the “min” and “max” 
values for each channel

Command Syntax Description
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Assert Assert(value) Stops the script with an error

GetPixelFormat GetPixelFormat(image) Returns the pixel format of the 
image. For example, 
kFormatRGB255, 
kFormatRGB219, 
kFormatYUV219.

SetPixelFormat SetPixelFormat(image, 

format)

Sets the pixel format of an 
image buffer without changing 
the contents of the image 
buffer. Thus, it should generally 
only be used on empty image 
buffers.

GetConversionMatrix GetConversionMatrix( 

srcFormat, 

destFormat, matrix, 

srcOffsets, 

destOffsets)

Returns a matrix and the 
“srcOffsets” and “destOffsets,” 
which would be used with 
ColorTransform to convert a 
buffer from “srcFormat” to 
“destFormat”

ConvertImage ConvertImage (srcImage, 

destImage, format

Performs a color space 
conversion from the source 
image’s color space, which can 
be obtained by 
GetPixelFormat(srcImage), into 
the format specified. It copies 
the data into “destImage” with 
the color space conversion and 
sets the pixel format of 
“destImage” to “format.”

Command Syntax Description
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Constants and Predeclared Variables

These are the predeclared variables included in FXScript. They can be used wherever 
appropriate in your scripts but can’t be declared in the script code. You can assign values to 
some of them as necessary in your scripts, including src1, src2, srcType1, scrType2, dest, 
exposedBackground, previewing, RGBtoYUV, and YUVtoRGB.

General

Color

Formatting

Constant Description

kUndefined A value that static variables initially have

kAlpha Used to define the alpha channel or straight alpha type

true A Boolean variable, anything but 0

false A Boolean variable, 0

Constant Description

kBlack Used to define black color or black pre-multiplied alpha type

kWhite Used to define white color or white pre-multiplied alpha type

kGray Used to define gray color

kRed Used to define red color or the red channel

kGreen Used to define green color or the green channel

kBlue Used to define blue color or the blue channel

kCyan Used to define cyan color

kYellow Used to define yellow color

kMagenta Used to define magenta color

Constant Description

kInteger Used to define the integer numerical format

kFloat2 Used to define the real numerical format with two decimal places
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Shapes

kFloat4 Used to define the real numerical format with four decimal places

kFloat6 Used to define the real numerical format with six decimal places

kSize Used to define the storage format (K, MB, GB, TB)

k24fps Used to define the timecode format 24 frames per second

k25fps Used to define the timecode format 25 frames per second

k30fps Used to define the timecode format 30 frames per second, non-drop 
frames

k60fps Used to define the timecode format 60 frames per second, non-drop 
frames

k30df Used to define the timecode format 30 frames per second, drop frames

k60df Used to define the timecode format 60 frames per second, drop frames

k16mm Used to define the timecode format 16 mm

k35mm Used to define the timecode format 35 mm

Constant Description

Constant Description

kRound Used to define an oval geometrical shape

kSquare Used to define a rectangle geometrical shape

kDiamond Used to define a diamond geometrical shape
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Text

Key

Constant Description

kleftjustify Used to define left text alignment

kcenterjustify Used to define center text alignment

krightjustify Used to define right text alignment

kplain Used to define a plain text style

kbold Used to define a bold text style

kitalic Used to define an italic text style

kbolditalic Used to define a bold, italic text style

Constant Description

kKeyNormal Used to define the composite mode Normal

kKeyAdd Used to define the composite mode Add

kKeySubtract Used to define the composite mode Subtract

kKeyDifference Used to define the composite mode Difference

kKeyMultiply Used to define the composite mode Multiply

kKeyScreen Used to define the composite mode Screen

kKeyOverlay Used to define the composite mode Overlay

kKeyHardLight Used to define the composite mode HardLight

kKeySoftLight Used to define the composite mode SoftLight

kKeyDarken Used to define the composite mode Darken

kKeyLighten Used to define the composite mode Lighten

kFormatRGB255 Used to label Final Cut Pro version 1.0/1.2.1 “RGB” buffers, which are RGB 
buffers with “white” at (255,255,255) and “black” at (0,0,0)
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Variables

kFormatRGB219 Used to label “RGB-219” buffers, which are RGB buffers scaled so that 
“white” is at (219,219,219), “CCIR superwhite” is at (238,238,238), and 
“black” is at (0,0,0)

kFormatYUV219 Used to label YUV buffers, in which the Y value of 0 is used for “CCIR 
black,” the Y value of 219 is used for “CCIR white,” and the Y value of 238 is 
used for “CCIR superwhite." (The CCIR recommended Y–range is 0–219 in 
this space.) The byte order of this packing is “A, Y, Cb, Cr.”1

1 Cb and Cr are both centered on 128. The CCIR recommended Cb and Cr ranges are 16–240. This YUV format is preferred 
to RGB when the codecs support YUV, because it does not cause “clamping” of bright or highly saturated colors. This 
format is identical to the “r408” format described in the QuickTime technical note “Rendering in YCbCr” located at 
http://developer.apple.com/quicktime/icefloe/dispatch027.html. Please see that page for more detailed documentation.

Constant Description

Variable Description

fps Used to define the effects frame rate

frame Used to define the current frame number

duration Used to define the length of an effect

ratio Used to define the ratio of current frame location to duration or frame/
duration

src1 Used to define the current frame buffer from the source clip in filters and 
outgoing source clip in transitions

clip1 Used to define the source clip in filters and outgoing source clip in 
transitions

srcType1 Used to define the source clip’s alpha type

src2 Used to define the current frame buffer from the incoming source clip in 
transitions

clip2 Used to define the incoming source clip in transitions

srcType2 Used to define the incoming source clip’s alpha type

dest Used to define the current buffer for video output

exposedBackground Used to define the background visibility

previewing Used to define the rendering mode, frame render, or sequence render
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Input

Input statements are used to specify the input controls that appear in the Input Controls tab 
for your script. In each case, “UIName” signifies the label that appears next to the input in 
the Input Controls tab. 

renderRes Used to define the sequence quality

RGBtoYUV Used to define the matrix conversion from RGB to YUV color space

YUVtoRGB Used to define the matrix conversion from YUV to RGB color space

linearRamp A convenience and efficiency variable, which is a linear ramp from 0–255. 
It can be passed to LevelMap for one or more components, when the 
component should not be changed. Using this is somewhat more efficient 
than building your own linear ramp using the parser.

This variable can sometimes be called identity color table. When a color 
value is mapped to this table, you get the same color value as the result.

srcIsGap1 This variable is a Boolean. It is true if src1 is a gap; otherwise, false.

srcIsGap2 This variable is a Boolean. It is true if src2 is a gap; otherwise, false.

Variable Description

Statement Syntax Description

CheckBox input varName, "UIName", 

CheckBox, value

Defines a checkbox. This can 
have a value of either 0 (not 
checked) or 1 (checked). 

Slider input varName, "UIName", 

Slider, value, min, 

max [ramp value] 

[label "Units"] 

[detent/snap v1, 

v2, ...]

Creates a slider bar control. You 
can specify an initial default 
value, minimum and maximum 
values, ramp value, “Units” 
specified as the label, and 
optional detent and snap values.

Angle input varName, "UIName", 

Angle, value, min, 

max [label "Units"] 

[detent/snap v1, 

v2, ...]

Creates an angle control
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Popup input varName, "UIName", 

Popup, value, 

label1, label2, 

..., labelN

Defines a pop-up menu with 
the specified labels, set to the 
default specified in “value”

RadioGroup input varName, "UIName", 

RadioGroup, 

value, label1, 

label2, ..., 

labelN

Specifies a radio button or 
group of radio buttons with the 
specified label or labels

Color input varName, "UIName", 

Color, alpha, red, 

green, blue

Defines a color selection tool. 
The chosen color is placed in 
the “color” variable. The default 
color is specified by “alpha,” 
“red,” “green,” and “blue.”

Clip input varName, "UIName", 

Clip

Defines an input control that 
allows you to input a video clip 
or a still image

Text input varName, "UIName", 

Text, "string" 

[TextHeight h]

Creates a text box

Point input varName, "UIName", 

Point, x, y

Creates a point entry control

Label input varName, "UIName", 

Label, "string"

Defines the static text in the 
Name column

FontList input varName, "UIName", 

FontList 

[, "InitialFont", 

“TextFieldName”]

Creates a pop-up list of 
TrueType fonts to choose from. 
The “TextFieldName” is the 
name of the text box to be 
associated with this font pop-up 
list. When you change the font 
pop-up to (for example) 
Geneva, the text in the text box 
“TextFieldName” will be drawn 
in Geneva.

Statement Syntax Description
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Definition

These statements are used to define and set up the script. They must be included at the 
beginning of the script, before any code. 

Statement Syntax Description

Filter Filter "name" Defines the script as a filter with 
the specified name, which 
means that it appears in the 
Filters bin in the Browser’s 
Effects tab

Transition Transition "name" Defines the script as a transition 
with the specified name, which 
means that it appears in the 
Transitions bin in the Browser’s 
Effects tab

Generator Generator "name" Defines the script as a generator 
with the specified name, which 
means that it appears in the 
Generators bin in the Browser’s 
Effects tab

Group Group "name" Specifies the group the script 
should be placed in. For 
example, the Gaussian blur 
sample script appears in the 
Blur bin in the Filters bin in the 
Browser’s Effects tab.

WipeCode WipeCode(code, accuracy) Defines the transition’s wipe 
code

KeyType KeyType(type) Defines the transition’s key type

AlphaType AlphaType(type) Defines the alpha type. A 
variable can be kNone (none/
ignore), kAlpha (straight), 
kBlack (black), or kWhite 
(white).
1280 Chapter  32  



QTEffect QTEffect("name") Defines the name of a QT real-
time effect. If a QT real-time 
effect with the same name is 
installed on a system, the 
application uses the QT real-
time effect instead.

ProducesAlpha ProducesAlpha Specifies that the effect will 
produce an alpha channel

FullFrame FullFrame An input definition, states that 
the filter only works on a full 
frame. Final Cut Pro, when 
processing fields, will only pass 
the full frames. This flag is only 
valid for filter scripts.

EffectID EffectID ("name") Reserved for future use

InvalEntireItem InvalEntireItem Identifies the effect as time- 
dependent (the effect changes 
over time). Thus, the render 
cache of the effect is invalidated 
when the duration of the effect 
changes.

Statement Syntax Description
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Assignment

RenderEachFrame
WhenStill

RenderEachFrameWhenStill Identifies the effect as time- 
dependent (the effect changes 
over time). Thus, even if the 
source is a still graphic or non-
animated generator, each frame 
should be rendered.

This can be used to tell Final 
Cut Pro that the script needs to 
be run for each frame, even if 
the parameters are not 
changing. This is useful for still 
graphics and generators or 
filters that are non-animated or 
time-varying, such as the 
"Blink" filter.

InformationFlag InformationFlag( string ) A general tool for supplying 
additional keywords to Final Cut 
Pro.1

1 The most important new keyword is "YUVaware," which tells Final Cut Pro that the script is aware of the existence of the YUV 
color space. The YUV color space is preferable because it does not "clamp" colors that are extremely bright or saturated. Also, 
if the "YUVaware" keyword is supplied, the Final Cut Pro version 1.0/1.2 matrix variables "RGBtoYUV" and "YUVtoRGB" will 
not be available. (Instead, use GetConversionMatrix.) Another new keyword is "hasfields", which can be used to tell Final Cut 
Pro that a generator can create field-rendered material. For example, this allows a Crawl text generator to tell Final Cut Pro's 
render engine that it can generate two fields of material when the user has enabled field rendering. The use of field rendering 
creates a smoother motion.

Statement Syntax Description

Statement Syntax Description

Set Set variable to value Assigns a value to a variable. 
The values that can be assigned 
to a variable depend on its data 
type. 

Set Field Set the field of variable 

to value

Assigns a value to a specific field 
within a variable

assign variable = value Assigns a value to a variable. 
The values that can be assigned 
to a variable depend on its data 
type.
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Flow Control

Statement Syntax Description

If/Else If (condition1)

Else if (condition2)

Else 

End If

If/Else statements run different 
script code if the stated 
conditions are met. Each If 
statement isolates a single 
condition and directs the flow 
of the script to the statement 
immediately following it only if 
the condition is met. 

Else/If statements isolate 
successive conditions and direct 
script flow to the code following 
them, if the condition attached 
to the statement is met. These 
are optional.

Else statements provide for any 
other circumstance. They 
literally mean “in any other 
event.” These are optional. 

The end of an If statement is 
always indicated by an End If 
statement.

Repeat While Repeat While (condition)

End Repeat

A loop that runs the script lines 
between Repeat While and End 
Repeat repeatedly as long as the 
condition in the Repeat While 
statement is true. As soon as the 
condition is no longer true, the 
script moves out of the loop 
and onto the next line. 

Repeat With Counter Repeat With Counter = 

start to finish 

[step amount]

End Repeat

A loop that runs the script lines 
between the Repeat and End 
Repeat statements for the 
number of times specified. 
Repeat with counter=1 to 10 
repeats the lines of script 10 
times. 
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Repeat With List Repeat With variable in 

[x1, x2, x3, ...]

End Repeat

Repeats the script lines between 
Repeat and End Repeat once for 
each of the values specified in 
the list. At the same time, it 
assigns each value in turn to the 
variable. 

Exit Repeat Exit Repeat Directs the script flow to the 
lines immediately following the 
End Repeat statement. It can be 
structured as the result of a 
condition being met.

For/Next For variable = start to 

finish [step 

amount]

Next

A loop that runs the script lines 
between the For and Next 
statements for the number of 
times specified. Loop with 
counter=1 to 10 loops the lines 
of script 10 times.

Exit For Exit For Directs the script flow in the For 
loop to the lines immediately 
following the Next statement. It 
can be structured as the result 
of a condition being met.

Statement Syntax Description
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Subroutine On subName(type parm1, 

type parm2, ...)

End

A part of a script that can be 
called by name from anywhere 
else in the script. Once the 
subroutine has been run, the 
flow of the script returns to the 
line immediately after the 
subroutine call.

You can “pass parameters” to a 
subroutine. This means that 
information, such as numbers 
or text strings, is put into the 
subroutine from the part of the 
script that calls it. 

The subroutine runs the code 
between the On statement and 
the End statement. 

Return Return

Return(value)

Directs script flow back to the 
line immediately after the 
subroutine was called; it “jumps 
out” of the subroutine and back 
to the main script. A return 
statement may be the result of a 
particular condition being met.

Return (value) can be used to 
return a numerical value.

Statement Syntax Description
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A Solutions to Common Problems and 
Customer Support
If you encounter problems while working with Final Cut Pro, there are several resources you 
can use to find a solution.

m This appendix:  This appendix includes information about some of the most frequent 
issues users run into. Problems are grouped by category.

m Late-breaking news:  A late-breaking news page in the Final Cut Pro onscreen help 
provides last-minute information that didn’t make it into this manual. Be sure to consult 
this immediately upon installing or upgrading Final Cut Pro.

m AppleCare Knowledge Base:  AppleCare Support maintains a database of common 
support issues that is updated and expanded to include new issues as they arise. This is an 
excellent, free resource for Final Cut Pro users. To access the AppleCare Knowledge Base, 
go to the AppleCare support page at www.apple.com/support

m AppleCare Support:  There are a variety of support options available to Final Cut Pro 
customers. For more information, see the Apple Software Service & Support Guide that 
came with your Final Cut Pro documentation.
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Solutions to Common Problems

Problems With Video Devices

Your camcorder or deck is not recognized.

m Make sure your device control cable or FireWire cable is properly connected.

m Verify that the camcorder is set to VCR mode.

m Make sure the appropriate protocol for your device is selected in the device control 
preset (see “Viewing Settings for a Preset” on page 106).

m Quit Final Cut Pro, shut down your computer, turn your camcorder or deck off and on, 
then restart your computer.

You can’t control certain functions of your camcorder or deck.

m Make sure your device control cable is properly connected.

m Make sure the appropriate protocol for your device is selected in the device control 
preset you’re using (see “Viewing Settings for a Preset” on page 106). If you’re using 
FireWire, try changing the protocol to Apple FireWire Basic.

m If your deck has a Local/Remote switch, make sure it’s set to Remote.

m Some DV camcorders and decks require special scripts, which are installed in the Final 
Cut Pro Plugins folder. These scripts are also on your Final Cut Pro CD. Check the Final 
Cut Pro Web site to find out which script, if any, should be installed.

Problems During Playback

Video is not visible on an external NTSC or PAL monitor.

m Make sure your cables are properly connected from the DV device to your computer and 
from the DV device to the NTSC or PAL monitor.

m If you’re viewing your video on a camcorder that’s connected to your computer’s FireWire 
port, make sure the camcorder is set to VCR mode.

m Close the Log and Capture window if it’s open.

m Make sure you choose All Frames or Single Frames from the External Video submenu in 
the View menu.

m Make sure you’ve selected the appropriate setting in the External Video tab within the 
Audio/Video Settings window (see “Choosing an External Video Setting” on page 133).

Warning  Installing the wrong script or a script for a device that does not require one can 
cause problems.
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m If you’re outputting to a DV device, make sure that the clip you’re viewing is a DV 
compressed clip. Choose Item Properties from the Edit menu and make sure the 
Compressor setting is the DV-NTSC or DV-PAL codec.

The audio is not in sync with the video, or you’re experiencing dropped frames 
in your video.

Many audio sync issues stem from dropped frames on capture or output. Nearly all dropped 
frames are due to either incorrectly configured hardware or incorrect preference settings. 
The leading causes of dropped frames are the following:

m If you’re using external speakers connected to a camcorder, deck, or third-party capture 
card, and external video is set to all frames, the video displayed on your computer’s 
monitor (from the Viewer or Canvas) will not be in sync with the audio. The audio will 
instead be in sync with the video that is displayed on the NTSC or PAL monitor that’s 
connected to the same output device.

m There is not enough random-access memory (RAM) allocated to Final Cut Pro. Ideally, 
Final Cut Pro should have 100 to 150 megabytes (MB) of RAM allocated to it (see 
“Allocating Memory for Final Cut Pro” on page 49).

m AppleTalk is turned on. When capturing and outputting video using Final Cut Pro, it’s a 
good idea to disable AppleTalk.

m Virtual memory is turned on. Using Final Cut Pro with virtual memory turned on is not 
recommended. Virtual memory can potentially cause dropped frames on capture and 
playback, as well as sluggish performance. Turn off virtual memory in the Memory control 
panel, then restart your computer.

m If your clip or sequence is zoomed while open in the Viewer or displayed in the Canvas, 
this can cause frames to be dropped. Choose Fit to Window from the View pop-up menu 
in the Canvas or Viewer.

m The computer monitor is set to a low refresh rate. The resolution in the Monitors control 
panel should always be set to 75 Hz or greater.

m The Canvas and Viewer windows are overlapping; they should not.

m Reduce the number of tracks in the Real-time Audio Mixing field in the General tab of the 
Preferences window. If more audio tracks are specified to be mixed in real time than your 
computer can handle, this can cause dropped frames. Reducing the number of tracks will 
result in your having to render your sequence, but will result in improved playback.

m Incorrect versions of the Mac OS and QuickTime, video, or FireWire extensions can be 
another source of dropped frames. Check the Final Cut Pro Web site for the version of 
system software you should use.

m On a PowerBook computer, processor cycling can cause intermittent dropped 
frames. Turn off processor cycling in the Advanced Settings pane of the Energy Saver 
control panel.
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m If you try to capture video to an unqualified storage device, any frames that are dropped 
will interfere with audio sync. This loss of sync will increase over time (drift), and will not 
disappear when you stop and start the affected video clip. In particular, this problem may 
occur if you attempt to capture M-JPEG video clips using the internal hard disk that came 
with your computer. The solution is to recapture all affected video clips using a qualified 
storage device. This device should be selected in the Scratch Disks tab of the Preferences 
window before reinitiating video capture (see “Setting Up Scratch Disks for Storing 
Media” on page 899).

m Another source of dropped frames on capture or playback may be fragmented hard disks. 
In general, it’s preferable to capture to disks that are specifically reserved for video. To 
avoid fragmentation, you should avoid filling up your disks with numerous files unrelated 
to the projects you’re working on. 

If you’re editing a long project where some clips are captured, others are deleted, then 
more are captured, and so on, even the cleanest storage volume may become fragmented. 
You can diagnose this with a hard disk utility. Should your capture disks be seriously 
fragmented to the point of impeding performance, you have three options:

m Quit Final Cut Pro, back up your project file, and delete all the clips from the affected 
volumes. (Delete only media that can be recaptured; do not delete graphics, audio, or 
project files.) Upon reopening your Final Cut Pro project, you will find that all your 
video clips are now offline. Simply recapture them and performance should improve. 

m Copy all the files from the fragmented volume to a blank volume with enough space. 
Copying files defragments them on the volume to which they are copied. Then delete 
the files from the original, fragmented volume; now you’re ready to capture more clips 
to it. Upon reopening your project, Final Cut Pro will automatically begin the process 
of reconnecting your media.

m A more time-intensive solution is to back up your project file, then use disk-
defragmenting software to defragment your volume.

m You can also try deselecting “Mirror on desktop during Playback” in the External Video tab 
within the Audio/Video Settings window.

m If the Sync Adjust Movies preference (in the General tab of the Preferences window) is 
disabled during capture of long DV clips, you may experience some drift of your audio/
video sync over time. Many DV camcorders and decks record audio at other than the true 
sample rates of 32 or 48 kilohertz (kHz). Variations in hardware sold by different 
manufacturers result in slight, but significant variances from these standard sample rates, 
depending on the equipment you’re using.
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Because QuickTime expects the sample rate of incoming audio to be exactly 32 or 48 kHz, 
the discrepancy between the sample rate used by your DV equipment and the sample rate 
that QuickTime is expecting may cause a drift in audio and video sync in your captured 
clips over many minutes of playback. How noticeable this drift will be depends on the DV 
camcorder or deck you’re using.

To enable Final Cut Pro to avoid this problem and ensure accurate sync in all of your 
captured DV clips, check the Sync Adjust Movies Over box (see “Adjusting A/V Sync of 
Clips” on page 891). When enabled, this option forces Final Cut Pro to count the samples 
in the audio tracks of all DV clips after they’ve been captured to determine the sample 
rate they were originally recorded at. With the original sample rate determined, Final Cut 
Pro can then ensure accurate sync no matter how long your captured clip. Since drifts in 
sync typically occur in clips with a long duration, there is a number field that allows you to 
specify when this feature should be used. The default value of five minutes is adequate for 
most cases, although you should refer to the Final Cut Pro Web site for information 
pertaining to your particular DV camcorder or deck.

m If the Sync Adjust Movies setting (in the General tab of the Preferences window) is on 
during capture of non-DV material, timecode breaks can cause the sync to be lost. Clips 
that you capture from non-DV sources, such as analog tape or from digital sources via 
SDI, will not have varying sample rates. Since lost A/V sync due to timecode breaks is still 
a risk, you should disable the Sync Adjust Movies setting whenever you’re not capturing 
from a DV source. 

m Another potential cause of dropped frames during output is having too many sequences 
open simultaneously in the Timeline. Especially with complex sequences with numerous 
edits, having more than one sequence open at the same time can affect playback 
performance. To resolve this, close all sequences except the one you want to output to video.

Note:  Clips with lost sync due to incorrect use of the Sync Adjust Movies setting won’t 
necessarily have to be recaptured to correct the problem. Simply delete the affected 
clips from the Browser of your project, and from any sequences you may have edited 
them into. Then, enable the Sync Adjust Movies feature in the Preferences window and 
reimport your clips.

For more information about the Sync Adjust Movies feature, see “Adjusting A/V Sync of 
Clips” on page 891.
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m Another cause of dropped frames is playing sequences with numerous short edits. 
Projects with a large number of short edits can sometimes overwhelm a hard disk's ability 
to jump from one clip to another. In this case there are two things you can try:

m Write out one single file. When rendering out using the Export Movie command, 
disable the Recompress All Frames feature to save unnecessary rendering time.

m Another solution, particularly in the case of long sequences, is to split a single long 
sequence into multiple short sequences, outputting them to tape one at a time.

After editing to tape, you don’t see the material you edited when you play back 
the tape.

m The Edit to Tape command requires that the sequence or clip you’re outputting be 
opened in the Viewer before you click the Insert or Assemble edit buttons in the Edit to 
Tape window. See Chapter 27, “Editing to Tape,” on page 1123 for more information.

An error message appears during capture reporting a “Break in the Timecode.”

m When capturing clips for your program from source tapes that were shot in the field, or 
from old source tapes that have been played to the point of wearing the media, 
sometimes timecode breaks appear, disrupting the computer’s ability to read a 
continuous stream of timecode. These timecode breaks should be avoided whenever 
possible, as they can cause audio/video sync problems and incorrect timecode in your 
captured clip. Incorrect timecode can in turn cause inaccurate EDL export, and incorrect 
recapture of the clips containing the breaks.

As you log your source tapes in preparation for capture, it’s a good idea to avoid logging 
clips along with the breaks that appear between shots, as these are spots where timecode 
breaks frequently occur. If a timecode break appears in the middle of a shot, it may be 
because the tape is worn, or because the media simply failed on that frame.

An error message says “Servo Can’t Lock.”

m The tape transport mechanism in the camcorder or deck may not be able to synchronize 
as expected and may require more time to synchronize to where the computer thinks it 
is. Try increasing the pre-roll time in your device control preset (see “Viewing Settings for 
a Preset” on page 106).

m If your device is connected via FireWire, try changing the protocol from Apple FireWire to 
Apple FireWire Basic in your device control preset (see “Viewing Settings for a Preset” on 
page 106).
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DV video clips look fuzzy on the computer’s monitor.

m Earlier Power Macintosh G3 computers cannot process and properly play back DV in real 
time when it’s set to High Quality. As a result, these computers display DV video at a 
lower resolution in order to maintain the full frame rate of playback for DV clips. This 
lower resolution results in a softer image, but no information is lost. You can see this 
when the picture is stopped. Final Cut Pro can use a high quality still frame when it 
doesn’t have to maintain playback, so the picture snaps back into focus.

To view your DV media at full quality while playing at 25 or 29.97 frames per second (fps), 
you’ll need to connect the FireWire output of your computer to a camcorder or deck. The 
camcorder or deck will decompress the DV stream using dedicated hardware, resulting in 
smooth playback of your DV media on an attached NTSC or PAL monitor.

Note:  You’ll see the same fuzzy effect with DV clips that are exported into other 
applications as well. As long as the clip is compressed with DV, slower computers will 
lower the resolution during playback, but the source media on disk still contains all of the 
information, at the highest quality.

Video does not play through to the computer screen.

m Make sure cables from the video device are properly connected to your computer.

m Check your QuickTime video settings in the Capture Presets tab in the Audio/Video 
Settings window. For details on QuickTime source and compression settings, see “About 
Capture Preset Settings” on page 121.

You experience poor playback and stuttering video when trying to edit.

m Make sure you are not editing with media using keyframe compression, such as Sorenson 
or Cinepak.

My camcorder or deck doesn’t go to the specified timecode or won’t perform a 
command.

m Make sure you selected the correct protocol in the Device Control Presets tab of the 
Audio/Video Settings window. If you’re using FireWire, try using the Apple FireWire 
Basic protocol.

m Some DV camcorders and decks require special scripts, which are installed in the Final 
Cut Pro Plugins folder. These scripts are also on your Final Cut Pro CD. Check the Final 
Cut Pro Web site to find out which script, if any, should be installed.
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General Performance Issues

Final Cut Pro seems to be working slowly.

m Using Final Cut Pro with virtual memory turned on is not recommended. Virtual 
memory can potentially cause dropped frames on capture and playback, as well as 
sluggish performance. Disable virtual memory in the Memory control panel, then 
restart your computer.

m The amount of memory allocated to Final Cut Pro can make a big difference in 
performance, especially with long projects. Final Cut Pro should ideally have 100 to 150 
MB of RAM allocated to it. For more information, see “Allocating Memory for Final Cut 
Pro” on page 49.

Problems With Audio Quality

You don’t hear audio through your camcorder speakers.

m Make sure your cables are properly connected.

m If you are scrubbing audio in the Audio tab of the Viewer, increase the volume of the 
computer’s audio output.

You don’t hear audio on your computer’s speakers when playing video from 
your camcorder or deck.

m Make sure the speaker’s cables are properly connected.

m Make sure your audio cables are properly connected.

m If you’re monitoring your audio from your computer, make sure that Mute is off, and that 
the computer’s volume is adjusted to a reasonable level.

m When external video is set to all frames in order to monitor video using a camcorder, 
deck, or third-party capture card, both the video and audio are played through the 
external monitor and speakers that are connected to your camcorder, deck, or third-party 
capture card. The computer’s speakers don’t receive any audio. Make sure the external 
monitor and speakers are both on and make sure the speaker’s volume level is turned up.

m Check your QuickTime audio settings in the Capture Presets tab in the Audio/Video 
Settings window. For details on audio sample and source settings, see “About Capture 
Preset Settings” on page 121.
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Captured audio sounds distorted and “crackly” during capture.

m During capture, make sure that you always set Final Cut Pro’s sample rate to that of 
your recorded source material. Mismatched sample rates can result in pops and crackles 
in the audio, incorrect audio/video sync, and in generally diminished sound quality. These 
rates are

m 32 kHz if you’re capturing media from a DV camera that was set to 12-bit recording

m 44.1 kHz if you’re using your microphone input or other audio interface

m 48 kHz if you’re recording from a DV camera set to 16-bit recording, or if you’re 
recording from an audio interface capable of this rate.

Captured audio sounds fine during capture and when played in the Viewer, but 
when you edit it into a sequence along with other audio clips, it sounds 
distorted.

m Make sure that the sample rates of the audio clips you’re using match the sample rate set 
for your sequence. If they don’t, Final Cut Pro will resample your audio during playback. 
Mixing 44.1 kHz audio and 48 kHz audio sounds acceptable, but audio will sound best 
with the audio rate of your edited sequence set to 48 kHz. Upsampling audio in Final Cut 
Pro sounds better than downsampling it.

It’s not recommended you mix 32 kHz audio (12-bit) and 48 kHz audio (16-bit) in the 
same sequence, as this may result in slight audio distortion.

Problems Playing a Reference Movie

You’re having problems playing a reference movie.

m If you encounter playback problems with a reference movie, export the media as a 
self-contained movie (which includes all its media files), and not as a QuickTime 
reference movie. 

To do this, make sure there is a checkmark in the Make Movie Self-Contained checkbox in 
the Export dialog box. For more information, see “Exporting a Final Cut Pro Movie” on 
page 1151.
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Calling AppleCare Support
Included in your Final Cut Pro package is documentation on the support options available 
from Apple. Several levels of support are available, depending on your needs.

Whatever your issue, it’s a good idea to have the following information immediately available. 
The more of this information you have to give to the support agent, the faster he or she will 
be able to address your issue.

Note:  Much of this information can be obtained by using the Apple System Profiler in the 
Apple menu. Using the Apple System Profiler, you can generate reports on your computer’s 
configuration, which you can send to the support staff via email if necessary.

m The serial number of your computer. You can obtain your computer’s serial number by 
using the Apple System Profiler.

m Which version of the Mac OS you have installed. Include updates, if applicable. 

m Which version of Final Cut Pro you have installed. Final Cut Pro’s version number can 
be viewed by choosing About Final Cut Pro from the Apple menu while Final Cut Pro 
is open.

m Which model of computer you are using.

m How much RAM is installed in your computer, and how much is allocated to Final Cut Pro. 
You can find out how much RAM is installed in your computer using the Apple System 
Profiler, or by choosing About This Computer from the Apple menu in the Finder. The 
amount of RAM allocated to Final Cut Pro can be found by selecting the Final Cut Pro icon 
on your hard disk and choosing Get Info from the File menu. When the Final Cut Pro Info 
window appears, choose Memory from the Show pop-up menu.

m Whether you’re using an internal or external video capture device.

m What other third-party hardware is connected to the computer, and who are the 
manufacturers. Include hard disks, video cards, etc. Some of this information can be 
obtained using the Apple System Profiler.

m A listing of the currently selected extension set. This list can be generated using the Apple 
System Profiler.

m Which third-party plug-ins or other software is installed along with Final Cut Pro.

m Whether the QuickTime Pro serial number is installed. You can find out by opening the 
QuickTime Settings control panel and choosing Registration from the pop-up menu at the 
top of the window.

AppleCare Support can be reached online at www.apple.com/support
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B

B Keyboard Shortcuts

By Key 

Keys
No 
modifier Shift Option Command Control

Command/ 
Option

F1 Help

F2 Log Clip Resize 
Viewer

F3 Find Next Find 
Previous

F4 Lock 
Video 
Track

Lock All 
Video 
Tracks

F5 Lock 
Audio 
Track

Lock All 
Audio 
Tracks

F6 Source 
Video

Video 
None

F7 Source A1 Audio 1 
None

F8 Source A2 Audio 2 
None

F9 Insert Edit Insert w/
Transition
  1297



F10 Overwrite Overwrite 
with 
Transition

F11 Replace Fit to Fill

F12 Super-
impose

Output 
Video Frame

F15 Output 
Video 
Frame

A Select Tool Make 
Selection 
an In/Out 

Make In/
Out a 
Selection

Select All

B Razor 
Blade Tool

Set 
Standard 
List View

Set Logging 
List View

Insert Bin

C Crop Tool Capture 
Now

Nest 
Item(s)

Copy

D Distort 
Tool

Make 
Offline

Duplicate Deselect 
All

Modify 
Duration

E Extend 
Edit

Next Edit Previous 
Edit

New 
Project

F Match 
Frame

Go to 
Master 
Clip

Make 
Favorite

Find Make 
Favorite 
Motion

G Edit/
Group/ 
Range 
Select Tool

Next Gap Previous 
Gap

Find Again Close Gap

H Hand Tool List/Icon 
View 
(Toggle)

Batch 
Capture

Scrub 
Video 
Tool

I Set In Go to In Clear In Import File Set 
Video In

Set 
Audio In

Keys
No 
modifier Shift Option Command Control

Command/ 
Option
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J Play 
Reverse 
(Shuttle)

Speed

K Pause Next 
Keyframe

Previous 
Keyframe

Render 
Effect 
(FXBuilder)

Add 
Keyframe

Add Audio 
Level 
Keyframe

L Play 
Forward 
(Shuttle)

Linked 
Selection 
On/Off

Break/
Create 
Stereo Pair

Break/
Create 
Link

Looped 
Playback 
On/Off

Levels

M Set Marker Next 
Marker

Previous 
Marker

Print to 
Video

Mixdown 
Audio

Edit 
Previous 
Marker

N Snap to 
Edges 
(Toggle)

Make 
Freeze 
Frame

New 
Sequence

New 
Sequence 
w/ Presets

O Set Out Go to Out Clear Out Open Set 
Video Out

Set 
Audio 
Out

P Pen Tool Play Here 
to Out

Play Every 
Frame

Set Poster 
Frame

Q Viewer/
Canvas 

Preferences Quit Easy 
Setup

Audio/
Video 
Settings

R Ripple/Roll 
Edit Tool

Ripple/Roll 
Edit Mode

Render 
Sequence

Render 
Selection

Render 
Realtime

S Slip/Slide 
Tool

Audio 
Scrub 
(Toggle)

Save All Save

T Track 
Select Tool

Change 
Timeline 
Track Size

Show/Hide 
Filter Bars

Apply 
Default 
Video 
Transition

Apply 
Default 
Video 
Transition

Apply 
Default 
Audio 
Transition

Keys
No 
modifier Shift Option Command Control

Command/ 
Option
  Keyboard Shortcuts 1299



U Ripple/Roll 
Edit Type 
(Toggle) 

Custom 
Layout 1

Custom 
Layout 2

Make 
Subclip

Standard 
Window 
Config.

V Select an 
Edit

Paste 
Insert

Paste 
Attributes

Paste 
Overwrite

Add Edit

W Wireframe 
Mode 
(Toggle) 

RGB/
RBG+A/
Alpha 
(Toggle) 

Show/Hide 
Overlays 

Close 
Window

Close Tab Waveforms 
in Timeline 
On/Off

X Mark Clip Ripple Cut Clear In & 
Out

Cut Open Text 
Generator

Y Change 
Render 
Quality 

Edit 
Render 
Quality

Redo

Z Zoom Tool Zoom to 
Fit

Undo

, Trim 1 
Frame

Trim Back 
X frames1

Pan Left

. Trim 1 
Frame

Trim 
Forward X 
frames1

Pan Right

\ Play 
Around

Play In to 
Out

Play Every 
Frame

Pan 
Center

; Previous 
Edit

‘ Next Edit

[ Trim Back 
1 Frame

Trim Back 
X Frames

] Trim 
Forward 1 
Frame

Trim 
Forward X 
Frames

= Zoom In

Keys
No 
modifier Shift Option Command Control

Command/ 
Option
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‘ Set Marker Reposition 
Marker

Extend 
Marker

Delete 
Marker

Clear All 
Markers

+ Zoom In 
Timeline

Zoom In Gain +1 
dB

— Zoom Out 
Timeline

Zoom Out Gain –1 
dB

~

Space Play/Stop Play 
Reverse

Delete/
bcksp.

Lift 
(leaving 
gap)

Ripple 
Delete 
(no gap)

Caps Lock Rendering 
Off/On 

Return Open Item Open in 
Separate 
Window

Open Item 
Editor

Home Go to Beg. 
of Media

Go to End 
of Media

End Go to End 
of Media

Page Up Vertical 
Scroll Up

Horizontal 
Up

Page 
Down

Vertical 
Scroll 
Down

Horizontal 
Down

Arrow-Up Go to Prev. 
Edit

Go to 
Prev. Edit/
Marker

Nudge 
Position Up

Sub Pixel 
Up

Arrow-
Down

Go to Next 
Edit

Go to Next 
Edit/
Marker

Nudge 
Position 
Down

Sub Pixel 
Down

Keys
No 
modifier Shift Option Command Control

Command/ 
Option
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Arrow-
Left

Go Back 1 
Frame

Go Back 1 
second

Nudge 
Position 
Left

Sub Pixel 
Left

Arrow-
Right

Go 
Forward 1 
Frame

Go 
Forward 1 
second

Nudge 
Position 
Right

Sub Pixel 
Right

1 Specify the number of frames in the General tab of the Preferences window.

Numeric 
keys

No 
Modifier Shift Option Command Control

Command
/Option

/ Set In

* Set Out

1 Viewer

2 Canvas

3 Timeline

4 Audio 
Meters

Browser

5 Effects

6 Favorites 
Bin

7 Trim Edit

8 Log and 
Capture

9 Item 
Properties

0 Sequence 
Settings

Keys
No 
modifier Shift Option Command Control

Command/ 
Option
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By Function

Key command General control

New project

New sequence

New sequence with presets

Open file

Open selected item

Open in separate window

Open item editor

Open text generator

Close window

Close tab

Help

Quit

Save

Save all

Undo

Redo

+x E

+x N

+x + Noption

+x O

return

shift return+

+option return

control X+

+x W

control W+

+x ?

+x Q

+x S

+ Soption

+x Z

+x Y
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Audio scrub toggle

Edit render quality

Looping toggle

Snapping toggle

Key command General control

shift S+

shift Y+

control L+

N

Key command Window

Viewer

Canvas

Timeline

Audio Meters

Browser

Effects

Favorites Bin

Trim Edit

Log and Capture

Item Properties

+x 1

+x 2

+x 3

+ 4option

+x 4

+x 5

+x 6

+x 7

+x 8

+x 9
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Sequence Settings

Preferences

Key command Window

+x 0

+ Qoption

Key command Select, Cut, Copy, and Paste

Copy

Cut (lift to Clipboard)

Duplicate

Make In/Out a selection

Paste (overwrite)

Paste attributes

Paste insert

Select all

Deselect all

+x C

+x X

+ Doption

+ Aoption

+x V

+ Voption

shift V+

+x A

+x D
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Key command Navigation

Forward one frame

Back one frame

Forward one second

Back one second

Play reverse1

Stop/Pause2

Play forward3

Match frame

Select an edit

Add edit

Next edit

Previous edit

Next gap

Previous gap

To beginning of media

To end of media

shift +

shift +

J shift space+or

K spaceor

L spaceor

F

V

control V+

shift E+ 'or

+ E ;option or

shift G+

+ Goption

home

shiftend +or home
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To next edit or In/Out

To previous edit or In/Out

To next edit, In/Out, or marker

To previous edit, In/Out, or marker

To master clip

1 Press key up to four times for accelerated reverse playback: once (1x), twice (2x), three (3x), and four (4x) times.
2 Hold key down while pressing J or L to step forward or backward one frame at a time.
3 Press key up to four times for accelerated forward playback: once (1x), twice (2x), three (3x), and four (4x) times.

Key command Navigation

shift +

shift +

shift F+

Key command Finding items

Find

Find next (in Find results)

Find previous (in Find results)

+x F

+x G

shift F3+

Key command Scrolling

Horizontal scroll left

Horizontal scroll right

Vertical scroll up

Vertical scroll down

shift + page
up

shift + page
down

page
up

page
down
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Key command Screen layout and display

Custom layout 1

Custom layout 2

Standard layout

+ Ushift

+ Uoption

control U+

Key command Projects and sequences

Import file

New project

New sequence

New sequence with presets

+x I

+x E

+x N

+x + Noption

Key command Browser

Change list (icon view)

Insert bin

Open bins (list view)

Close bins (list view)

Make a favorite

Make a favorite motion

shift H+

+x B

option F+

control F+
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Set Logging columns (list view)

Set Standard columns (list view)

Key command Browser

option B+

shift B+

Key command Timeline

Create or break link

Linked selection on/off

Create or break stereo pair

Change track size

Clip Keyframes on/off

Clip overlays on/off

Lift (leaving gap)

Ripple delete (no gap)

Fit sequence in window

Lock video track

Lock all video tracks

Lock audio track

+x L

shift L+

option L+

shift T+

option T+

option W+

delete

delete+ orshift x

shift Z+

+F4 track number

shift + F4

+F5 track number
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Lock all audio tracks

Turn on waveforms

Key command Timeline

shift + F5

+x + Woption

Key command Logging and capturing

Log clip

Batch capture

Capture now

F2

+x H

shift C+

Key command Playing video

Play reverse1

Stop/Pause2

Play forward3

Play around current

Play every frame

Play here to Out

Play In to Out

1 Press the J key up to four times for accelerated reverse playback: once (1x), twice (2x), three (3x), and four (4x) times.
2 Hold key down while pressing J or L to step forward or backward one frame at a time.
3 Press the L key up to four times for accelerated forward playback: once (1x), twice (2x), three (3x), and four (4x) times.

J shift space+or

K spaceor

L spaceor

\

+ Poption

shift P+

shift + \
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Key command In and Out points1

Set In point

Set Out point

Set video In only

Set audio In only

Set video Out only

Set audio Out only

Audio level keyframe

Clear In

Clear Out

Clear In and Out

Make selection an In or Out

Mark clip

To In point

To Out point

1 In and Out shortcuts follow a simple “set-go to-clear” scheme, using “I” or “O” for set, Shift+I or O to go to In or Out, and 
Option+I or O to clear In or Out. For a navigation key matrix, see “Quick Navigation Keys and Modifiers” on page 1317.

I or /

O or *

control I+

+x l+option

control O+

+x O+option

+x K+option

+ Ioption

+ Ooption

+ Xoption

+ Ashift

X

+ Ishift

+ Oshift
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Key command Markers

Add marker

Add and name marker

Delete marker

Delete all markers

Extend marker

Reposition marker

Next marker

Previous marker

M

+M M

+x ~

control `+

+ ~option

shift + ~

shift + M

+ Moption
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Key command Editing

Apply default video transition

Apply default audio transition

Lift (leaving gap)

Ripple delete (no gap)

Extend edit

Insert edit

Insert with transition

Overwrite

Overwrite with transition

Replace

Fit to fill

Superimpose

Make subclip

Modify duration

Switch between Ripple/Roll edits

Ripple cut to Clipboard

control T+x + T or

+x T+option

delete delete+xor

delete+ orshift x

E

F9

shift F9+

F10

shift F10+

F11

shift F11+

F12

+x U

control D+

U Rshift +or

shift X+
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Slip edit

Split edit

Set target video

Set target video to None

Set target Audio 1

Set target Audio 1 to None

Set target Audio 2

Set target Audio 2 to None

Mixdown audio

Trim backward one frame

Trim backward X frames1

Trim forward one frame

Trim forward X frames1

1 Specify the number of frames in the General tab of the Preferences window.

Key command Editing

+click In or Outshift

option +click In or Out

+F6 track number

shift F6+

+F7 track number

shift F7+

+F8 track number

shift F8+

control M+

[ ,or

shift [+ shift ,+or

] .or

shift ]+ shift .+or
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Effects

Key command Output

Switch render quality

Display frame

Print to video

Y

shiftF15 F12+or

+x M

Key command Function

Nest item(s)

Add motion keyframe

Next keyframe

Previous keyframe

Make freeze frame

Render effect (FXBuilder)

Render selection

Render sequence

Rendering off/on

Speed

Change Image/Wireframe view

+ Coption

control K+

shift K+

+ Koption

shift N+

+x K

+x R

+ Roption

caps
lock

+x J

W
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Change RGB/RGB+A/Alpha 

Fit in window

Nudge position down

Nudge position left

Nudge position right

Nudge position up

Sub pixel down

Sub pixel left

Sub pixel right

Sub pixel up

Zoom in

Zoom out

Key command Function

shift W+

shift Z+

+option

+option

+option

+option

+x

+x

+x

+x

+x =

+x -
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Quick Navigation Keys and Modifiers

Tools and Modifier Keys

Key No modifier Shift + key Option + key or
Control + Shift + key 

I Set In Go to In Clear In

O Set Out Go to Out Clear Out

M Set Marker Next Marker Previous Marker

E Extend Edit Next Edit Previous Edit

G Next Gap Previous Gap

K Next Keyframe Previous Keyframe

Tool Select Tool + (x)
Command

Tool +
Shift

Tool +
Option

Selection A Select 
additional

Select range Link on/off

Edit Selection G Select 
additional

To Ripple 
tool

Link on/off

Group Selection G+G Select 
additional

Select 
additional

Link on/off

Range Selection G+G+G Link on/off

Select Track Forward T All forward Link on/off

Select Track 
Backward

T+T All backward Link on/off

Track Selection T+T+T Link on/off

Select All Tracks 
Forward

T+T+T+T Track 
forward

Link on/off

Select All Tracks 
Backward

T+T+T+T+T Track 
backward

Link on/off
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Roll Edit R Select 
additional

To Ripple 
tool

Link on/off

Ripple Edit R+R Select 
additional

To Roll tool Link on/off

Slip Item S Select 
additional

Select clip Link on/off

Slide Item S+S Select 
additional

Select clip Link on/off

Razor Blade B To Razor 
Blade All

Link on/off

Razor Blade All B+B To Razor 
Blade

Hand H Zoom in Zoom out

Zoom In Z To Hand tool Zoom in 
maximum

Zoom out

Zoom Out Z+Z To Hand tool Zoom out 
maximum

Zoom in

Scrub H+H To Hand tool To Hand 
tool

Crop C All sides Two sides

Distort D Perspective Resize

Pen P Smooth

on/off

Adjust line Pen delete

Pen Delete P+P Pen

Pen Smooth P+P+P

Tool Select Tool + (x)
Command

Tool +
Shift

Tool +
Option
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Using Tools with Modifier Keys

Tool Cmd Option Shift None
Cmd + 
Shft

Cmd + 
Ctrl

Cmd + 
Shift

Selection Add/
Subtract 
selection

Toggles 
linking 
state

Selects 
range

Arrow 
tool

Scrub 
tool

Selection—
On Point

Gear 
down

Subtract Uncon-
strained

Move 
Point

Arrow 
tool

Selection—
On Line 
Seg.

Gear 
down

Add Key-
frame

Adjust 
Line 
Segment

Adjust 
Line

Arrow 
tool

Selection—
Empty

Moves 
Playhead

Moves 
Playhead

Moves 
Playhead

Move 
Point

Arrow 
tool

Group 
Select

Add/
Subtract 
Select-
ion

Toggles 
linking 
state

Add/
Subtract 
Select-
ion

Edit Select Add/
Subtract 
Select-
ion

Toggles 
linking 
state

Ripple 
Tool

Add 
Ripple 
Select-
ion

Arrow 
tool

Range 
Select

Toggles 
linking 
state

Arrow 
tool

Full Track Toggles 
linking 
state

Arrow 
tool

Track 
Forward

Toggles 
linking 
state

All 
Tracks 
forward

Arrow 
tool

Track 
Backward

Toggles 
linking 
state

All 
Tracks 
back-
ward

Arrow 
tool
  Keyboard Shortcuts 1319



All Tracks 
Forward

Toggles 
linking 
state

Track 
forward

Arrow 
tool

All Tracks 
Backward

Toggles 
linking 
state

Track 
backwar
ds

Arrow 
tool

Roll Edit Selects 
multiple

Toggles 
linking 
state

Ripple 
Tool

Arrow 
tool

Ripple Edit Selects 
multiple

Toggles 
linking 
state

Roll Tool Arrow 
tool

Slip Item Gear 
Down

Toggles 
linking 
state

Allows 
selection 
of a clip

Arrow 
tool

Slide Item Gear 
Down

Toggles 
linking 
state

Allows 
selection 
of a clip

Arrow 
tool

Razor 
Blade 

Toggles 
linking 
state

To Razor 
Blade All

Arrow 
tool

Razor 
Blade All

To Razor 
Blade

Arrow 
tool

Zoom In Switch 
to Hand 
Tool

Zooms 
Out

Zoom In 
all the 
way

Arrow 
tool

Zoom Out Switch 
to Hand 
Tool

Zooms 
In

Zoom 
Out all 
the way

Arrow 
tool

Hand Zoom In Zoom 
Out

Arrow 
tool

Scrub Tool Arrow 
tool

Arrow 
tool

Tool Cmd Option Shift None
Cmd + 
Shft

Cmd + 
Ctrl

Cmd + 
Shift
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Crop Crops 
opposite 
sides

All sides Selec-
tion tool

Distort Perspect
ive

Resize Selec-
tion tool

Pen—
On Point

Gear 
Down

Pen 
Subtract

Move 
Point

Move 
Point

Selec-
tion tool

Pen—
On Line 
Seg.

Gear 
Down

Pen 
Subtract

Adjust 
Line 
Segment

Pen Add Selec-
tion tool

Pen—
Empty

Moves 
Playhead

Moves 
Playhead

Moves 
Playhead

Moves 
Playhead

Selec-
tion tool

Pen 
Subtract—
On Point

Gear 
Down

Pen Add Pen 
Subtract

Pen 
Subtract

Selec-
tion tool

Pen 
Subtract—
On Line 
Seg.

Gear 
Down

Pen Add Adjust 
Line 
Segment

Adjust 
Line 
Segment

Selec-
tion tool

Pen 
Subtract—
Empty

Moves 
Playhead

Moves 
Playhead

Moves 
Playhead

Moves 
Playhead

Selec-
tion tool

Pen 
Smooth

Selec-
tion tool

Arrow Tool 
In Canvas

Corner 
Point

Resize 
and 
Rotate

Force 
Render

Uncon-
strain 
Aspect 
Ratio

Selec-
tion tool

Outside 
Line Rotate

Force 
Render

Snap to 
45 
degrees

Selec-
tion tool

Tool Cmd Option Shift None
Cmd + 
Shft

Cmd + 
Ctrl

Cmd + 
Shift
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Center 
Point

Force 
Render

Vertical/
Horizon-
tal 
Move-
ment

Selec-
tion tool

Crop Tool 
in Canvas

Corner 
Point

Crops 
both 
sides

Force 
Render

Maintain 
Aspect 
Ratio

Selec-
tion tool

Outside 
Line Rotate

Force 
Render

Snap to 
45 
Degrees

Selec-
tion tool

Center 
Point

Force 
Render

Vertical/
Horizon-
tal 
Move-
ment

Selec-
tion tool

Distort Tool Change 
Pers-
pective

Force 
Render

Motion 
Path in 
Canvas

On 
Keyframe

Vertical/
Horizon-
tal 
Move-
ment

Selec-
tion tool

Bezier 
Handles

Outer Edge One 
Side 
Rotate 
Restrict

Force 
Render

Resize 
Only 
One Size

Selec-
tion tool

Tool Cmd Option Shift None
Cmd + 
Shft

Cmd + 
Ctrl

Cmd + 
Shift
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Keyboard Shortcuts for the Viewer, Browser, and Log and 
Capture

Acceler-
ation 
Handle

Force 
Render

Only 
One 
Side

Selec-
tion tool

Pen Tool

Motion 
Path

Selec-
tion tool

Tool Cmd Option Shift None
Cmd + 
Shft

Cmd + 
Ctrl

Cmd + 
Shift

Key command Viewer

Option-click In & Out points Splits the points for audio 
and video

Shift + Marker Button Sets marker and opens 
marker dialog box

Option + Marker Button Delete marker if playhead 
stopped at one

Option + Mark Clip Button Clears both In & Out

Option + In Marker Clears In point

Option + Out Marker Clears Out point

Shift-click an In or Out point Go to an In & Out point 
marker

Shift-click either In or Out Slip an edit

Key command Browser

Control-click in column heading and choose Edit Heading Change labels for 
Comment columns
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Key command Log and Capture

Right click Choose previous reel 
number

Right click in Log Note Previous comments

F2 Log a clip

Option-click slates Clear out slate field
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A P P E N D I X

C

C About Shortcut Menus

Various shortcut menus are available throughout Final Cut Pro. These menus appear when 
you press and hold the Control key and click items in the interface. For more information, 
see “Viewing and Using Shortcut Menus” on page 84.

Shortcut Menus in the Browser

A

B

C

D

B F G H I J K L

E
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Project Tab

Legend Interface item Browser shortcut menus 

A Project tab

B Bin, Name column

C Clip

D Sequence

E Column heading (except Name column)

F In and Out columns

G Good, Reverse Alpha, and Anamorphic 
columns
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H Alpha column

I Composite column

J Pixel Aspect column

K Reel column

L Label column

Legend Interface item Browser shortcut menus 
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Shortcut Menus in the Viewer

Video Tab

B

A

E

D

C

Legend Interface item Viewer shortcut menus 

A Timecode Duration field

B All tabs 

C Current Timecode field
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D Add Keyframe button

E Scrubber bar

Legend Interface item Viewer shortcut menus 
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Audio Tab

B

A

F

E

D

C

G

Legend Interface item Viewer shortcut menus

A Timecode Duration field

B All tabs

C Current Timecode field
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D Viewer ruler

E Add Keyframe button

F Scrubber bar

G Keyframe

Legend Interface item Viewer shortcut menus
  About Shortcut Menus 1331



Filters Tab

B

C

A

D

Legend Interface item Viewer shortcut menus

A Viewer ruler

B Filter specifications

C Current In point

D Keyframe
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Motion Tab

B

A

C

Legend Interface item Viewer shortcut menus

A Viewer ruler

B Current In point

C Keyframe
  About Shortcut Menus 1333



Shortcut Menus in the Timeline

J

G

H

I EF

B

A

C

D

C

Legend Interface item Timeline shortcut menus

A All tabs

B Timeline ruler

C Empty space above and below video 
and audio tracks
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D Video transition

Audio transition (not shown above)

E Empty space after clips on a track

F All clips (only one clip shown above)

G All edit points

H Track gaps

I Current Timecode field

J Currently placed tracks

Legend Interface item Timeline shortcut menus
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Shortcut Menus in the Canvas

B

A

D

E

C

Legend Interface item Canvas shortcut menus

A Timecode Duration field

B All tabs 

C Current Timecode field
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D Scrubber bar

E Add Keyframe button

Legend Interface item Canvas shortcut menus
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With Animated Layers in a Sequence

B

A

D

E

C

F

J

Legend Interface item Canvas shortcut menus

A Timecode Duration field

B All tabs 

C Current Timecode field

D Scrubber bar
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E Add Keyframe button

F Image layers 
(in Image+Wireframe mode with at 
least one motion path)

Legend Interface item Canvas shortcut menus
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A P P E N D I X

D

D Working With Anamorphic Media

In Final Cut Pro, you can capture, edit, and export anamorphic 16:9 media for NTSC and PAL. 
Before you shoot or capture this type of video, you may want to find out more about how 
Final Cut Pro handles this format. This will help you determine what settings and options you 
need to use.

About Anamorphic 16:9 Media
Standard NTSC and PAL monitors have a picture aspect ratio of 4:3. This means that the ratio 
of the width of the visible area to the height of the visible area is 4/3, or 1.33. DV video, which 
has a frame size of 720 x 480 pixels, also has an aspect ratio of 4:3. 

It’s possible to shoot video for playback using a different aspect ratio. The widescreen aspect 
ratio commonly used for video is 16:9, which allows you to create a widescreen experience 
similar to film. High Definition Television (HDTV ), for example, uses several formats that 
have a picture aspect ratio of 16:9, or 1.78. 
  1341



About Anamorphic Transfer and Shooting Anamorphic Video

When shooting widescreen video using standard definition DV camcorders, the recorded DV 
video frame is still 720 x 480 pixels. Shooting 16:9 visuals and recording them to a 4:3 frame 
size is referred to as shooting anamorphic video. In this process, the active area of the 16:9 
program is stretched vertically to fill all 480 lines. 

The advantage of this is that producers can shoot widescreen material using inexpensive 
equipment. The disadvantage of shooting anamorphic video is that everything in the 
anamorphic frame looks thin and distorted on a normal monitor unless the image is adjusted. 

To view this type of material, the display device needs to squeeze the image vertically by 25%, 
canceling out the stretch performed during recording. This puts 480 lines into a smaller 
vertical space (360 lines), reducing the appearance of scan lines. If the source material is film, 
which has no inherent line count, the vertical stretch is accomplished optically, giving an 
increase in vertical resolution. 

This picture is slightly
distorted after being
stretched vertically.
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This squeezing can be done by Final Cut Pro or by using an appropriate video display 
monitor. If your video monitor has a 16:9 button (many high-end broadcast video monitors 
do), you can also use this. Pressing this button rescales the video vertically as it is displayed 
on the monitor, giving it the proper widescreen dimensions.

Since anamorphic video creates a widescreen image by stretching a squished 4:3 image out 
to fill a larger area, fewer pixels are rescaled to fit a larger area. The only video format that 
actually has a larger frame, using more vertical and horizontal pixels to create a widescreen 
image, is high definition video. 

Remember that 16:9 anamorphic video is supposed to look stretched on a typical 4:3 
monitor. Although it may seem odd, it is the correct behavior. When recording, editing, and 
outputting to tape, an anamorphic image should never be permanently rescaled in order to 
retain the full video resolution of the image for future use, either for display on a widescreen 
monitor, or for enlarging to film. 

About Letterboxing

When you rescale anamorphic 16:9 video in order to see the entire widescreen frame on a 
standard definition 4:3 monitor, you’ll see black bars at the top and bottom of the picture. 
The result is known as letterboxing. (Laserdisc and DVD aficionados are familiar with this.)

This picture
is letterboxed.
  Working With Anamorphic Media 1343



If the original, unmodified 16:9 anamorphic image has 480 active lines (NTSC DV, for example), 
then the letterboxed version of this image will only be 360 lines tall, comprising 75% of the total 
viewable area of the monitor. As a result, 25% of the displayed video frame is black. 

Letterboxing your program results in the loss of the maximum resolution available in the 
original, anamorphic source footage. You should only letterbox your video when you are 
finished editing and want to deliver a tape that will look right on consumer equipment.

Why Shoot 16:9 Video? 
There are three main reasons to shoot 16:9, or anamorphic, video.
m Achieving a cinematic look.

Even if you end up letterboxing your output for standard definition televisions, viewers 
tend to associate the widescreen look with a cinematic feel. Using the widescreen format 
also allows videomakers more room for creativity in their shot composition. 

m Keeping higher resolution and quality when transferring to film.

Film and video have different aspect ratios: 35 mm film, with an aspect ratio of 1.85:1, is 
wider than the standard 4:3 ratio of broadcast video. Those who shoot standard 4:3 video 
have to crop the top and bottom of the image to resize it and fit the film frame, losing 
resolution and quality.

Videomakers shooting 16:9 can make higher resolution transfers by virtue of not having 
to crop as many pixels (16:9 is still a bit narrower than the American film standard 1.85:1).

16:9

1.85:1

2.0:1

70mm Film

35mm Film

Widescreen TV

Television

Lines of video lost
when cropping a
4:3 video to fit in
a 1.85:1 frame

A comparison
of aspect ratios

4:3
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m Preparing for the future.

High definition video has several formats that use an aspect ratio of 16:9. While high 
definition video is not in common use yet, eventually the entire broadcast industry will 
move to high definition video as the standard means of broadcast. Videomakers who want 
to be able to resize their productions to take advantage of the new frame size of this 
upcoming standard should shoot 16:9 anamorphic.

How Can I Record Anamorphic Video? 
Anamorphic video can be acquired in one of two ways:
m Using an anamorphic lens. 

An anamorphic lens is a wide angle lens that optically distorts the 16:9 image to fit into a 
4:3 frame before sending it into your camcorder's CCD (charged coupling device). 
Because this is done optically, the result is clean and clear and takes advantage of the full 
resolution of the DV frame. This method is recommended for users looking for the best 
possible quality.

m Using the 16:9 Wide button found on most camcorders. 

While easy and inexpensive, this method yields the lowest resolution. The camcorder 
crops the top and bottom of the screen, then stretches this smaller widescreen image 
vertically to fit the full 4:3 aspect ratio, producing the necessary anamorphic distortion 
before recording the image to tape. 

This method is the less desirable of the two because it uses fewer pixels, actually reducing 
the available resolution, and can result in degradation of the final image quality. 

On the other hand, this method is slightly more convenient, since many camcorders 
embed information in the video signal that indicates whether or not it was recorded in 
16:9 mode. Final Cut Pro can read this information and automatically capture and output 
the video in the correct mode. 

If your camera has an anamorphic lens, recording can be done as usual. In the camera’s 
viewfinder, the image appears stretched vertically; the recorded clips will only look correct 
on an NTSC or PAL monitor with a 16:9 setting.

Most DV cameras crop pixels from your image to reproduce it in anamorphic form. If you 
have the camera set to 16:9 mode, the image in the viewfinder looks correctly letterboxed, 
but the output of the camera will only view properly on an NTSC or PAL monitor with a 
manual or automatic 16:9 setting.
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Capturing Anamorphic Media
When you capture and batch capture video, Final Cut Pro uses the settings in the currently 
selected capture preset. One of these settings is Anamorphic 16:9, which can be turned on or 
off. For more information, see “About Capture Presets” on page 121.

m If you used the 16:9 Wide button on your camcorder when recording video:

You typically don’t need to worry about the Anamorphic option in the capture preset. 
Some cameras can embed information regarding the selected aspect ratio directly in the 
videotape. When a user presses the 16:9 Wide button on these cameras, the DV stream 
recorded to tape includes this information. Final Cut Pro automatically detects this and 
marks the resulting imported clip as Anamorphic 16:9. This happens regardless of 
whether or not the Anamorphic 16:9 option is checked in the Capture Preset Editor.

m If you used an anamorphic lens:

Those using an anamorphic lens to achieve the 16:9 look are actually recording their 
footage at a 4:3 aspect ratio. As a result, it is not automatically identified as 16:9 material 
by Final Cut Pro. If you are using an anamorphic lens, turning on the Anamorphic 16:9 
option in the Capture Preset Editor marks all subsequently captured clips as Anamorphic 
16:9, regardless of whether or not they are actually supposed to be. Make sure you 
deselect this box when recording regular, non-anamorphic 4:3 material. 

Make sure this checkbox is 
selected if you’re capturing 
16:9 media.
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m If you’re not sure whether or not the aspect ratio information was recorded 
on the videotape:

Before you capture video, make sure you choose an Easy Setup or capture preset that 
includes the anamorphic option. This way the media won’t fill the entire screen image 
and look distorted. 

Viewing and Editing Anamorphic Media
Final Cut Pro has the ability to properly display anamorphically captured material at the 
correct 16:9 aspect ratio directly on your computer display without rendering. Transitions 
such as the oval and star iris are correctly shaped, and all motion effects automatically take 
the 16:9 aspect ratio into account.

When you edit anamorphic 16:9 media, the following apply:

m All non-16:9 media added to a 16:9 sequence is adjusted to match the pixel aspect ratio.

m In the Viewer and Canvas, the default setting is “Show as Sq. Pixels” in the Zoom 
pop-up menu. This properly adjusts anamorphic 16:9 content for viewing on the 
computer’s monitor.

m Final Cut Pro sets the anamorphic bit in each DV frame rendered or played back.

If you’re doing a batch capture, 
choose a capture preset that has 
the anamorphic option turned on.
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Specifying Sequence Settings for Anamorphic Media

When you use anamorphic media in a sequence, the Anamorphic option needs to be enabled 
in its sequence settings so the media can be viewed properly. There are two ways you can 
do this:

m Choose a sequence preset that has the Anamorphic option turned on, then create 
a sequence.

m Create a sequence, then turn the Anamorphic option on for that sequence.

This should be done before adding any 16:9 clips to a 16:9 sequence. If a 16:9 clip is edited 
into a 4:3 sequence (the Anamorphic setting is turned off ), the clip will display properly but 
require rendering. If that sequence is then changed to 16:9 without first removing the edited 
clip, the clip will not look correct. So normal video edited into 16:9 media will look 
squeezed; 16:9 media edited into normal video will squeeze.

To set up a sequence to use anamorphic media:

1 Choose Audio/Video Settings from the Edit menu.

2 Choose a preset from the Sequence Preset pop-up menu that includes the Anamorphic setting.

If you’re unsure if any preset includes this option, click the Sequence Presets tab, then click a 
preset and view its summary on the right side of the window.

If no preset includes this option, you need to create a new sequence preset. For more 
information, see “Editing a Preset” on page 110. 
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To turn the Anamorphic setting on after you’ve created a sequence:

1 Open the sequence in the Timeline.

2 Choose Sequence Settings from the Sequence menu.

3 Click the box next to Anamorphic 16:9 so there’s an X in it.

Using Specific Layouts for Anamorphic Media

Several layouts are provided for properly arranging windows when editing anamorphic 
material. These options appear in the Arrange submenu of the Window menu.

Changing Clip Properties for Anamorphic Media

Once a clip is captured, you can change its aspect ratio in the Item Properties window by 
turning the Anamorphic 16:9 setting on or off. This information is saved when you render 
the clip from a sequence that has the Anamorphic setting on or off (in the sequence preset), 
whichever is appropriate.

If you’ve captured anamorphic media but didn’t use a capture preset that had the 
Anamorphic option turned on, you must change the clip settings for this media. You 
should do this before you add the clip to a sequence, so you can view your newly captured 
media correctly. 

Check this box to turn on 
the anamorphic setting.

Some screen layouts 
are set up for editing 
anamorphic media.
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If you’ve already added a clip to a sequence, the clip settings default to the current sequence 
settings. To change the clip’s settings, you must then change the sequence settings. For more 
information, see “Specifying Sequence Settings for Anamorphic Media” on page 1348.

To turn on the Anamorphic setting for a clip:

1 Open the clip from the Browser, then choose Item Properties from the Edit menu.

2 Make sure the box next to Anamorphic 16:9 has an X in it to indicate it’s turned on.

The Anamorphic column in the Browser also lets you turn this option on or off for clips 
and sequences.

Rendering Items That Contain Anamorphic Media
There are several things to keep in mind before you render sequences that contain 
anamorphic 16:9 media:

m Any clips with the Anamorphic setting turned on in the Item Properties window will be 
appropriately rendered in that format.

m If you’re using a sequence preset that has the Anamorphic setting turned on, all clips in 
the sequence will be rendered in that format.

m When adding 16:9 clips to a 16:9 sequence, no rendering is necessary.

m If non-16:9 media is added to a 16:9 sequence or vice versa, the new content is adjusted 
to maintain the proper pixel aspect ratio and needs to be rendered.

If your media is 
anamorphic, make sure 
there’s an X in this box.

A checkmark in this 
column denotes 
anamorphic media.
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Exporting Anamorphic Video to Tape 
When outputting an edited sequence to tape using anamorphic video, you have two choices, 
depending on what kind of equipment you want to play back from:

m Output as is, with the video appearing squished on a 4:3 monitor. 

This is the preferable option if you're planning on playing back your video on hardware 
that will compensate for the proper aspect ratio, or if you're planning on transferring to 
film. High-end broadcast monitors can rescale for 16:9 at the push of a button. Some 
specialty widescreen monitors, popular with home theater enthusiasts, will do this as well. 

m Letterbox your video if you’re unsure how it will be viewed. 

If you're unsure who is going to be viewing the tape and you want to guarantee 
undistorted playback on a standard 4:3 monitor, you can manually letterbox your 
video. This will require rendering your entire edited sequence, so allocate some time 
for this process. 

To letterbox your edited sequence:

1 Open the 16:9 sequence in the Timeline.

2 Create a new sequence that is not 16:9 anamorphic.

3 Drag the non-16:9 sequence’s icon from the Browser to the Overwrite area of the 
Edit Overlay in the Canvas.

4 In the Timeline, open a clip from your 16:9 sequence in the Viewer. 

5 Click the disclosure triangle next to the Distort property in the Motion tab.

6 Click Reset. Your sequence is rescaled to –33.33 in the Distort property. 

7 Render the new sequence, then print it to tape.

Click the Reset button to view 
the modified distort settings.
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Exporting Anamorphic Video to QuickTime 
Instead of outputting to tape, you may want to export your sequence as a QuickTime movie 
for multimedia or Web distribution using a rectangular, 16:9 frame size. For examples of 16:9 
frame size, see some of the movie trailers at www.quicktime.com/trailers/ 

To export your edited sequence with a 16:9 rectangular frame size:

1 Create a new sequence with the amount of cropping you want to subtract from the current 
frame size, at the aspect ratio you want to use. 

This process gives you the opportunity to crop off the top and bottom of a 4:3 frame to fit 
into a 16:9 aspect ratio, or any other ratio you choose.

2 Edit the clip or edited sequence that you want to crop into this new sequence. 

Since it has a larger frame size than that of the export sequence you’ve created, you can 
reposition the edited clip or sequence by using the Center motion parameter. For more 
information on using motion effects, see “Motion Effects” on page 940.

3 Use the Export QuickTime command to export the export sequence you’ve just created.

For more information, see “Exporting a QuickTime File” on page 1154.

Note:  Here’s another tip on frame sizes when using codecs for creating highly compressed 
movies. If you use a custom frame size, make sure that both horizontal and vertical pixel 
dimensions are divisible by 4. This helps to ensure higher image quality.
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E

E Transition Codes for EDL Export

In an Edit Decision List, or EDL, each type of transition has a unique code. This code is used 
to tell the video switcher which transition to use for any given edit. Since many of Final Cut 
Pro’s transitions have no equivalent in a given EDL format, all non-standard transitions will be 
automatically mapped to the closest approximate SMPTE standard wipe pattern during the 
EDL export process.

EDLs were originally developed for older tape-to-tape editing systems with fairly limited 
capabilities. Therefore, they are equipped to describe only a narrow variety of transitions. 
Although today’s nonlinear editing systems have introduced a much wider variety of 
transitions, the EDL format continues to reflect the simplicity of older systems.

Final Cut Pro transition EDL wipe number equivalent

Cross Zoom 17

Cube Spin 18

Spin3D 19

Spinback3D 20

Swing 21

Zoom 22

Additive Dissolve 0

Cross Dissolve 0

Dip to Color Dissolve 0

Dither Dissolve 0

Non-Additive Dissolve 0
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Ripple Dissolve 0

Cross Iris 12

Diamond Iris 18

Oval Iris 19

Point Iris 12

Rectangle Iris 17

Star Iris 18

Channel Map 0

Luminance Map 0

Page Peel 0

Band Slide 23

Center Split Slide 12

Multi Spin Slide 1

Push Slide 1

Spin Slide 1

Split Slide 3

Swap Slide 2

Cross Stretch 1

Squeeze 3

Squeeze and Stretch 3

Stretch 3

Band Wipe 23

Center Wipe 4

Checker Wipe 23

Final Cut Pro transition EDL wipe number equivalent
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Checkerboard Wipe 1

Clock Wipe 13

Edge Wipe 2

Gradient Wipe 0

Inset Wipe 4–11

Jaws Wipe 120

Random Edge Wipe 1

V Wipe 115

Venetian Blind Wipe 123

Final Cut Pro transition EDL wipe number equivalent
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F

F Video Calibration Using Color Bars

Broadcast video professionals use color bars to ensure that video shot in the field is adjusted 
for accurate color and brightness. These bars are also used to ensure that no color distortion 
occurs when this video is converted from an analog to a digital signal by a nonlinear editing 
system. Another reason to use color bars is to ensure that the output from a nonlinear 
editing system is properly adjusted and that copies (also referred to as “dubs”) made from 
the final master tape have the correct color and brightness.

Typically, 30 seconds of color bars are recorded at the beginning of each new videotape shot 
in the field. Initially, color bars output from a professional camcorder are used to calibrate 
the monitors used to watch what’s being shot. In this way, adjustments for brightness or 
color temperature made to the camcorder are accurately seen. Later, the color bars recorded 
at the beginning of all source tapes are used to calibrate the color and brightness settings 
of the nonlinear editing workstation used to capture this video for editing. Finally, color bars 
are output at the beginning of the program when outputting the final edit to tape. These bars 
are used by a tape duplication facility to ensure that all copies made have the correct color 
and brightness.

Using Color Bars to Calibrate Your Broadcast Monitor
Videographers don’t rely on the viewfinder of a camcorder to adjust the image being 
recorded. Viewfinders and camcorder LCD displays are often too small and have color fidelity 
that’s too inaccurate to ensure proper focus, brightness, and color adjustments. Similarly, 
editors and broadcast designers shouldn’t rely on an uncalibrated monitor when making 
crucial adjustments to the color and brightness of clips in their program.

Instead, it’s important to use a calibrated broadcast monitor to ensure that any adjustments 
made to exposure and color quality are truly accurate. 
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Monitors are calibrated using SMPTE standard color bars. Brightness and contrast is adjusted 
by eye, using the color bars onscreen. Adjusting chroma and phase involves using the “blue 
only” button found on professional video monitors. This calibration should be done to all 
monitors in use, whether they’re in the field or in the editing room.

Calibrating Your Broadcast Monitor

To calibrate your monitor:

1 Run color bars through the monitor you’re using so that they’re visible.

Near the bottom right corner of the color bars are three gray bars of varying shades. These 
are the pluge bars (Picture Lineup Generating Equipment), and they allow you to adjust the 
brightness and contrast of the monitor by showing you what absolute black should be.

2 Do the following:

a Adjust the brightness control of your monitor to the point where the middle gray bar just 
becomes black (this is the 7.5 pluge bar, representing absolute black). 

At this point, the brightest of the gray bars (11.5 pluge) should just barely be visible. 

b Now, turn the contrast all the way up so that this bar becomes bright, and then turn it
back down. 

The point where this bar goes back to being barely visible is the correct contrast setting 
for your monitor. (The example shown below is exaggerated to demonstrate.) 

Note:  Prior to Final Cut Pro 1.2.5, the first and second pluge bars were identical, and the 
third bar was slightly brighter. This is no longer the case, and the three bars represent 3.5, 
7.5, and 11.5 correctly.

When monitor brightness and
contrast is properly adjusted, 
this strip should barely be 
visible above black.
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3 Press the “blue only” button on the front of your monitor.

Notice how all of the differently colored bars turn into alternating light and dark ones. 

m If your monitor is correctly calibrated, all the gray bars will be evenly gray and all the black 
bars evenly black. 

m If the two outer light bars don’t match, adjust the chroma control of the monitor until 
they do. Then adjust the phase control to even out the inner bars.

Note:  NTSC and PAL video have brightness and contrast levels that are very different from 
those of RGB computer displays. Broadcast video viewed on a computer monitor often looks 
dull and dark, whereas the same video viewed on a broadcast monitor will be bright and 
clear. For this reason, the color bars above are shown for reference only and not to reflect 
what you should be seeing.

“Legal” Broadcast Colors
A mistake beginners often make when creating graphics for video is to use colors that are 
vivid on the computer display, but have chroma and luma that are outside of the “legal” 
range of color that can be broadcast. Many graphics and compositing applications have a 
“broadcast colors” filter that you can use to limit the color range of a graphic so that it will 
broadcast properly without distortion.

When the phase (similar to hue) 
of the monitor is correctly 
adjusted, you should see 
alternating bars of gray and 
black as shown.
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Capturing Accurate Color in Your Video
After all of your material has been shot, the next step is to make sure that the color and 
brightness on your tapes is captured with the proper values. How you capture your video 
determines how you manage the color of your program.
m Capturing from FireWire and other digital formats

Those importing DV over FireWire don’t have to worry about calibrating Final Cut Pro to 
match the color bars at the beginning of their tape. DV cameras digitize the material 
before it is recorded onto tape and the process of capturing DV is a simple digital file 
transfer, entirely in the YUV color space. 

Beginning with Final Cut Pro version 1.2.5, DV material is imported from YUV, and all 
subsequent renders are YUV as well. This enhances the accuracy of both color and 
brightness, and ensures that captured clips will match the color and brightness of the 
original material on tape. For these reasons, the various sliders in the Clip Settings tab of 
the Log and Capture window are disabled. Those who wish to modify the brightness or 
color of DV clips must do so using filters in their project. 

Similarly, if material is captured using a professional digital VTR (such as a Sony Digital 
Betacam deck) and a CCIR-601 SDI capture card, there will be no analog-to-digital 
conversion, as it’s digital to begin with. Therefore, color adjustments would normally be 
made with Final Cut Pro filters, not during capture. 

m Capturing from analog capture devices

If you’re capturing material from one of the analog formats, such as Beta SP or Hi-8, you 
should check to make sure that the color in the clips you are capturing is accurate. This is 
also true for users of analog-to-digital capture solutions, such as the Targa or Igniter cards.

Calibrating an Incoming Video Signal to Color Bars

The simplest way to calibrate an incoming video signal in Final Cut Pro is to use the built-in 
Waveform and Vectorscope.

Calibrating to color bars in Final Cut Pro:

1 Connect your video deck to the capture card.

2 Cue the videotape you want to capture clips from to the 30 seconds of color bars that should 
have been recorded at the beginning of the tape.

3 Choose Log and Capture from the File menu.

4 In the Log and Capture window, click the Clip Settings tab, then click the Waveform Monitor 
and Vectorscope button. 
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A window appears displaying two green graphs. Don’t worry if the graphs shown appear to 
be some what noisy. This is normal for video played back from tape.

To the left is the Waveform Monitor, which displays the brightness levels of the color bars 
within the video frame as a graph. Each “step” of the graph corresponds to one of the color 
bars, and the goal is to adjust the brightness and contrast so that the green bars of the graph 
match their ideal targets, shown in purple. These targets can be displayed and hidden with 
the “Targets” checkbox at the bottom of the window. 

Note:  The brightness, or luminance, in the image is measured in IRE. 100 IRE represents 
absolute white, and in the United States, 7.5 IRE represents absolute black. If any part of the 
signal goes above 100, the result will be overbright whites that will wash out. Likewise, if too 
much of the signal goes below 7.5, the result will be lost detail in the dark parts of the 
picture.  While 7.5 IRE is the standard in the United States, in Europe and Japan, black is 
standardized at 0 IRE.

5 There are two ways of adjusting video brightness and contrast using the Waveform Monitor, 
depending on the kind of hardware you’re using. 

a If you are capturing using Composite or S-Video input, chances are you’ll only have the 
Hue, Saturation, Brightness, and Contrast sliders enabled. 

1 Adjust the Brightness so that all of the bars more or less hit the upper purple targets 
shown in the background. 

VectorscopeWaveform Monitor
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2 Adjust the Contrast so that the tops and the bottoms of the bars all keep within the 
boundaries established by both top and bottom targets. 

3 Keep adjusting both Brightness and Contrast until you have an acceptable range of 
brightness between the 100 and 7.5 IRE targets shown below.

b If you’re capturing using Component video input, you’ll probably only have the Black 
Level and White Level sliders activated. 

1 In this case, adjust the Black Level so that the third bar from the left hits the 7.5 IRE 
target towards the bottom.

2 Then, adjust the White Level so that the second bar from the left hits the 100 IRE 
target at the top.

To the right is the Vectorscope, which displays the color values of the different areas of 
the video frame as a point graph. Each point on the circular graph represents one of the 
color bars. 

6 Adjust the Hue slider so that these points line up with their respective targets. 

m Adjusting this slider makes these points rotate about the center of the graph. 

m To make this easier, selecting the Lines checkbox at the bottom of the window connects 
all the dots in order to make their positions relative to one another more obvious. 

m If the Saturation slider is properly adjusted, each point should now fall within the purple 
target boxes. If they don’t, adjusting the Saturation slider will move the dots closer or 
farther away from the center of the graph.

100 IRE Target

7.5 IRE Target

The line marked FT is
where the skin color, or
flesh tone, of actors in

the frame should fall.
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Using Additional Hardware to Calibrate Color During Capture

Working with Final Cut Pro’s built-in Waveform Monitor and Vectorscope will give you largely 
accurate color and brightness, and for most users this will render good results. Still, advanced 
users should note that the Final Cut Pro Waveform and Vectorscope base their measurements 
on RGB conversions of the original YUV video signals. This may not be accurate enough for 
the discerning video engineer. In these cases, it is simple to set up your Final Cut Pro 
workstation to measure and adjust video input and output more precisely.

This involves using two pieces of external video hardware: 

m Processing Amplifier (or Proc Amp):  A Proc Amp will provide hardware control of  video 
gain (white level), luminance gain (brightness), chroma gain (saturation), hue, pedestal 
(black level), and Y/C delay. By inserting a Proc Amp between your analog VTR and the 
capture card installed in your computer, precise control of the incoming video signal in 
YUV color space can be obtained.

m Hardware Waveform/Vectorscope:  Having a hardware Waveform/Vectorscope enables 
you to measure the actual analog YUV output coming out of the capture card installed in 
your CPU. Making adjustments to the Proc Amp before the video capture card and 
viewing the resulting final output through the capture card allows the final NTSC output 
to be precisely calibrated to take into account any changes that happen to the signal while 
it’s in the digital domain.

With all of the necessary hardware installed as shown below, follow the same steps outlined 
in “Calibrating an Incoming Video Signal to Color Bars” on page 1360, substituting the 
hardware controls of the Proc Amp for the software controls.

The following is a typical setup for calibrating the capture and output of analog broadcast video.

Analog
capture

card

Computer NTSC
monitor

Waveform/
Vectorscope

Analog VTR Proc Amp

Analog
video

Analog
video in

Analog video in
(for comparison)

Analog
video out

Analog
video
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Outputting Color-Accurate DV Video Using FireWire

When outputting DV video using FireWire, Final Cut Pro outputs video with black at the 
industry standard digital value of 16 (as specified by the ITU-R BT.601-4 engineering 
specification for video). Consequently, video recorded to DV tape using either FireWire or 
the CCIR-601 SDI digital output of a professional video card has correct black and white 
levels in the digital domain.

When DV material is played back out of the analog interface of various NTSC DV camcorders 
and VTRs, some equipment translates the digital value 16 for black into an analog value of 7.5 
IRE, which is correct in the United States. Other equipment translates digital 16 into the 
analog value of 0 IRE, which is used in Japan. The waveform level defining “black” in the 
analog domain is known as “Setup,” so you will sometimes hear of devices referred to as 
either “Zero Setup” or “7.5 Setup.” 

Casual users may not notice the difference, but professionals who want to make sure that their 
video accurately matches the broadcast standard in the United States may want to adjust the 
analog output of their DV device using color bars output from their computer, along with a Proc 
Amp and Waveform Monitor, to adjust the black level of such equipment to 7.5 IRE.

Note:  “Setup” is an NTSC-specific issue. PAL always uses “Zero Setup.”

The following is a typical setup to calibrate FireWire converted to analog in order to adjust 
the black level of output video.

Computer NTSC
monitor

Waveform/
Vectorscope

Proc AmpDV VTR

Analog video
out Analog out

Analog video
throughFireWire

Analog video out to recording deck
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For More Information

For detailed technical information, see:

m SMPTE Engineering Guideline (EG) 1-1990, “Alignment Color Bar Test Signal for 
Television Picture Monitors.” Society of Motion Picture and Television Engineers, 
White Plains, NY, 1990.

m Poynton, Charles. A Technical Introduction to Digital Video. Jon Wiley & Sons, 
Inc., New York, 1996.

m Recommendation ITU-R BT.601-4, “Encoding Parameters of Digital Television for 
Studios.” ITU, Geneva, 1990.
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Glossary
16:9  A widescreen aspect ratio for video. The ratio of the width to the height of the visible 
area of the video frame, also called the picture aspect ratio, is 16:9, or 1.78. 

A

A-Only Edit   Editing the audio files or video files of your base track only. 

A-Roll   Editing clips that contain audio data from the base track or a narration. 

alpha channel  An additional image channel used to store transparency information for 
compositing. Alpha channels are often 8-bit, but some applications support 16-bit alpha 
channels. Only certain formats, such as PICT and the QuickTime Animation codec, support 
alpha channels. 

analog  The opposite of digital, analog signals consist of a constantly varying voltage level, 
called a waveform, that represents video and audio information. Analog signals must be 
digitized, or captured, which is the process of turning analog information into digital files for 
use by Final Cut Pro. VHS tapes are analog.

anamorphic  Shooting 16:9 visuals and recording them to a 4:3 frame size is referred to as 
shooting anamorphic video. In this process, the active area of the 16:9 program is stretched 
vertically to fill all 480 lines. This can be done in software or using an anamorphic lens.

aspect ratio  A video frame’s width-to-height ratio on your viewing screen. The most 
common aspect ratio is 4:3, used for common television screens. 

assemble edit  In linear systems, assemble edit mode lays down a new video, audio, and 
control track all at once. It usually allows anywhere from 3–5 seconds of pre-roll before you 
edit to tape. In Final Cut Pro, it’s a function that writes the sequence or clip to tape at the 
designated In point, or at the current point. Assemble edit mode usually breaks the timecode 
on your edit tape. 

audio clip  A media clip containing audio samples. 

AVI  Audio-Video Interleaved. Microsoft’s standard format for digital video. 
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axis  The pitch, roll, and yaw of a camera shot determines its axis. For a cut edit sequence 
this determines continuity and quality. 

B

B-roll   A term used to describe alternate footage shot to intercut with the primary shots 
used in a program. B-roll is frequently used for cutaway shots. Ideally these should fit with 
the continuity of the base track.

back light  A light source that comes from behind and above the subject. It outlines the 
subject and differentiates it from the background. Also called a rim light. 

batch capture  A process where information stored in clips is used to control the deck or 
camcorder to automatically capture, or digitize, the video or audio material that corresponds 
to each clip.

batch compression  Grouping two or more movies together to be compressed 
sequentially, so that each compression doesn't need to be started manually. 

batch list  A specific list of movies to be compressed in a batch, as well as the settings with 
which each movie will be processed. 

batch recapture  Recapturing only the parts of logged clips that you actually use in your 
sequences at a higher resolution. This will help you conserve disk space. 

Bezier handles  Two-direction handles that control or influence the curve of the line 
segment between the handle and the next point on either side. The farther a direction 
handle is pulled out from its vertex point, the more force it applies to its line segment to 
bend or curve it. Direction handles are moved by dragging them.

bin  In Final Cut Pro, the window that contains your clips, transitions, effects, and 
generators. The bin lets you organize all of these elements, sort them, add comments, 
rename items, and so on.

blue-screening  A production technique in which the subject is shot against a blue screen. 
The screen in the image is then made transparent during the editing process so that the subject 
can be superimposed over other scenes. This effect can also be achieved using a green screen.

broadcast  Refers to signals intended for delivery on television, as well as network delivery 
to a wide audience.

C

calibrate  The process of adjusting a feature for accuracy.

Canvas  This is your record monitor in Final Cut Pro. It shows the playback of the clips in a 
sequence.

capture   Moving NTSC or PAL video, or audio, from tape to a digital format for use by Final 
Cut Pro. Also called digitizing video.
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CG  Acronym for Character Generator. A specialized hardware device used for creating titles.

channels  May refer to color channels or alpha channels. Color and transparency 
information for video and graphics clips is divided into individual channels. 

chroma  The color information contained in a video signal, consisting of hue (phase angle) 
and saturation (amplitude of the color subcarrier).

chroma key   See blue-screening. 

clip  Media files containing video, audio, graphics, or any other content imported into Final 
Cut Pro. 

CMYK  Cyan Magenta Yellow Black. The color space commonly used for images that will be 
printed with 4-color ink on offset presses. 

color bars  A standard color test signal displayed as columns, often accompanied by a 
reference audio tone. Color bars are used to adjust the video signal of the incoming source 
tape to maintain proper color from tape to computer, and through to output. 

codec  Compressor/decompressor. Software component used to translate video or audio 
between its uncompressed form and the compressed form in which it is stored. Sorenson 
Video and Cinepak are common QuickTime video codecs. Also referred to as a compressor. 

color depth  The possible range of colors that can be used in a movie or image. There are 
generally four choices with computer graphics—grayscale, 8-bit, 16-bit, and 24-bit. Higher 
color depths provide a wider range of colors but require more space for a given image size. 
Broadcast video is almost always 24-bit, with 8 bits of color information per channel. See 
channels.

component video  A type of video signal in which the luminance and chrominance signals 
are kept separate for better video quality. 

compositing  Combining two or more video or electronic images into a single frame. This 
term can also describe the process of creating various video effects.

compression  Process by which video, graphics, and audio files are reduced in size by the 
removal of redundant or less important data. See also Codec.

cut  An edit where the last frame of a clip is followed by the first frame in a subsequent clip, 
with no transition effect. This is the simplest type of edit. 

D

data rate  The speed at which data can be transferred. Often described in megabytes per 
second (MB/sec.). The higher a video file’s data rate, the higher quality it will be, but the 
more system resources (processor speed, hard disk space, and performance) it will take to 
work with it. Some codecs allow you to specify a maximum data rate for a movie.

decibel (db)  Unit of measurement for sound levels.
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decompression  The process of creating a viewable image for playback from a compressed 
video, graphics, or audio file.

device control  Computer software that allows Final Cut Pro to control an external 
hardware device, such as a video deck. 

digital  A description of data that is stored or transmitted as a sequence of ones and zeros. 
Most commonly, this means binary data represented using electronic or electromagnetic 
signals. QuickTime movie files are digital.

digital video  Refers to the capturing, manipulation, and storage of video using a digital 
format, such as QuickTime. A digital video camcorder, for example, is a video camera that 
captures and stores images on a digital medium such as DV. Video can then be easily 
imported.

digitize  To capture an analog video signal and save it to a digital video format.

drop frame timecode  Timecode that represents the actual time duration of NTSC at 
29.97 frames per second (fps). To achieve this accuracy in numbering the frames, two frame 
numbers are dropped every minute on the minute, except for the 10th minute.

duration  The length of time that a segment of audio or video takes to play from beginning 
to end. 

DV  See digital video. Also used as the name of a tape-based video format.

DVD  A DVD disc looks much like a CD-ROM or audio disc, but uses higher density storage 
methods to significantly increase their capacity.

E

EDL (Edit Decision List)  A text file that sequentially lists all of the edits and individual 
clips used in a sequence. EDLs are used to move a project from one editing application to 
another, or to coordinate the assembly of a program in a tape-based online editing facility. 

edit  The process of combining audio, video, effects transitions, and graphics in a sequence 
to produce a program.

Edit to Tape  In Final Cut Pro, the Edit to Tape command lets you perform frame-accurate 
Insert and Assemble edits to tape from Final Cut Pro.

effects  (See transitions, filters, and generators.) A general term used to describe all of 
Final Cut Pro’s capabilities that go beyond cuts-only editing.

F

favorite  A customized effect that you use frequently. You can create favorites from most of 
the effects in Final Cut Pro.

field  Half of an interlaced video frame consisting of the odd or the even scan lines. 
Alternating video fields are drawn every 1/60th of a second in NTSC video to create the 
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perceived 30 frames-per-second video. There are two fields for every frame, an upper field 
and a lower field.

filters  Effects you can apply to either the video or audio component of a clip or sequence. 
Filters affect the visual or aural quality of the clip to which they’re applied. A video filter 
might change the colors of your image. An audio filter might reduce background noise. In 
addition to using the filters that came with Final Cut Pro, you can use some third-party Adobe 
After Effects filters as well. You should note that while filters can correct problems with video 
and audio quality, they are no substitute for proper exposure and recording techniques. 

FireWire  Apple's trademark name for the IEEE 1394 standard. FireWire is a fast and versatile 
interface used to connect DV cameras to computers. FireWire is well suited to applications 
that move large amounts of data, and can also be used to connect hard disks, scanners, and 
other kinds of computer peripherals.

fit to fill edit  Editing a clip into a sequence such that its duration matches a 
predetermined amount of track space that you specify. 

frames  Video consists of a number of still image frames which, when they play back over 
time, give the illusion of motion. NTSC video plays back 29.97 frames per second, and PAL 
video plays back 25 frames per second. Each broadcast video frame is made up of two fields. 
This is different from the way film handles frames. A film frame is a single photographic 
image, and does not have separate fields. 

G

gain  In video, the amount of white in a video picture. In audio, the loudness of an audio 
signal.

gamma  Curve that describes how the middle tones of images appear. Gamma is a 
nonlinear function often confused with “brightness” and/or “contrast.” Changing the value of 
the gamma affects middle tones while leaving the white and black of the image unaltered. 
Gamma adjustment is often used to compensate for differences between Macintosh and 
Windows video cards and display.

gaps  A gap is a location in a sequence where there is no media on any track. 

generators  Generators create computer-generated clips within Final Cut Pro. Background, 
Bars, Text, Gradient, and Titles are all generators. 

H

handles  Extra footage that can be added to logged clips when you recapture footage. 

head clip  The clip that begins your sequence.

hue  An attribute of color perception, also known as color phase.
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I

importing  Importing is the process of bringing files of various types into a project in Final 
Cut Pro. Imported files have usually been created or captured in another application. 

In point  The first marked frame of your edit. 

insert edit  An edit in which a clip is added to the track at the specified point, moving clips 
that follow it out in time. An insert edit does not replace existing material. 

interlaced video  An analog video signal consisting of alternating odd and even fields.

invisible track  A track that has had its visibility control disabled.

J

jog control  In Final Cut Pro, a control that allows you to move forward or backward 
through audio or video one frame at a time. 

jog  To move forward or backward through video or audio one frame at a time. 

jump cut  A cut where there is an abrupt change between two shots, with no continuity 
from one to the other. 

K

keyframe  A keyframe is a special-purpose marker that denotes the change in value to an 
applied effect parameter. When two keyframes are set in Final Cut Pro, the application 
calculates a transition based on their values. 

L

L-cut  An editing technique in which either the video track or audio track of a synchronized 
clip is longer than the other. For example, the sound is longer than the video at the head of 
the clip, so it is heard before the video appears. Also referred to as a split edit.

linear editing  Video editing style where a program is edited together by moving shots 
from the original source tapes to a master tape, one by one. Because the assembly is linear, 
changes made to an earlier point of the tape result in the rest of the edited tape being 
reassembled.

log and capture  In Final Cut Pro, the process of logging the clips you want to capture, and 
then having Final Cut Pro use device control to automatically capture them in the Log and 
Capture window. 

log bin  In Final Cut Pro, the specified bin where all of your logged clips go. 

logging  The process of recording detailed information about which clips from your source 
tapes you want to use, in preparation for capturing them from videotape. 

looping  In Final Cut Pro, when you turn looped playback on, clips and sequences will loop 
back to the beginning whenever the playhead reaches the end of the media.
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luma  Short for luminance. A value describing the brightness of a video image. A luminance 
channel is a grayscale image showing the range of brightness across the whole clip.

M

markers  In Final Cut Pro, markers refer to either the edit points that define the start and 
end points of a clip, or points of reference that you can use to denote places of interest in 
your clips and sequences.

mask  An image or clip used to define areas of transparency in another clip. Similar to an 
alpha channel.

master clip  The source clip in the Browser from which clips and subclips are defined.

mastering mode  A mode in the Edit to Tape function within Final Cut Pro. It lets you 
output additional elements when you output your program to tape, such as color bars and 
tone, a slate, and a countdown.

match frame edit  An edit that joins two shots that link or match a related action. For 
example, when cutting between a long shot and a close-up, a match frame edit makes the 
action smooth and continuous. 

media  Generic term for elements such as movies, sounds, and pictures.

mono  Monophonic Sound Reproduction. Both audio channels are taken from the tape and 
mixed together into a single track, using equal amounts of audio channels 1 and 2. Only one 
channel appears with the clip in Final Cut Pro. 

motion path  When you keyframe different center point locations in the motion settings for 
a clip over time, a motion path appears in the Canvas showing the path your clip will travel 
over time.

MPEG  Moving Picture Experts Group, a group of compression standards for video and 
audio, which includes MPEG-1, MPEG-2, and MPEG-3 (referred to as MP3). 

N

nested sequence  A sequence that is edited within another sequence. 

non-drop frame timecode  Timecode that counts an even number of frames per second. 

noninterlaced video  The standard representation of images on a computer. Also referred 
to as progressive scan. The monitor displays the image by drawing one line after another 
from top to bottom. Different from interlaced video. 

nonlinear editing  When you use a nonlinear editing application to edit a program, all 
footage used is stored on a hard disk rather than on tape. This allows random access to all 
video, audio, and images as you edit. The advantage is that, unlike linear editing on tape, 
edits within the program can be changed at any time without having to recreate the entire 
edit. 
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NTSC format  NTSC stands for National Television Standards Committee, the organization 
that defines North American broadcast standards. The term “NTSC video” refers to the video 
standard defined by the committee, which has a specifically limited color gamut, is 
interlaced, and is approximately 720 x 480 pixels, 29.97 fps.

O

offline  Refers to clips that are currently unavailable to your project. This may be because 
they haven’t been captured yet, or because they’ve been moved to another location.

offline editing  Generally refers to the process of editing the majority of one’s program at 
low resolution, either to save on equipment costs or to conserve hard disk space. When the 
edit is finished, the material can be recaptured at high quality, or an EDL can be output to 
recreate the edit on another system. 

Out point  The last marked frame of a video clip. 

output  Video and audio that is ready for playback and distribution. Your edited program in 
Final Cut Pro can be output to tape as a QuickTime file or any one of a variety of different 
digital media.

overwrite edit  An edit type where the clip being edited into a sequence replaces frames 
that are already in the sequence. 

P

PAL format  Phase Alternating Line—a 25 fps (625 lines per frame) interlaced video format 
used by many European countries.

PICT  A still-image file format developed by Apple Computer. PICT files can contain both 
vector images and bitmap images, as well as text and an alpha channel. PICT is a ubiquitous 
image format on Mac OS computers.

pixel  One dot in a video or still image. A typical low-resolution computer screen is 640 
pixels wide and 480 pixels tall. Digital video movies are often 320 pixels wide and 240 pixels 
tall.

pixel aspect ratio  The ratio of width to height for the pixels that compose the image. 
NTSC pixels are square (1:1 ratio), but D-1 pixels are non-square. 

post-production  The process of editing film or video after acquiring the footage. 

preset  A saved group of settings that can be applied to a sequence when it is created. 
Presets determine items such as frame rate, editing timebase, and Timeline options used for 
creating new sequences or exporting media. 

Print to Video  In Final Cut Pro, this command renders your sequence and prepares it to 
output to videotape. 
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project  The top-level file that holds all media in Final Cut Pro, such as sequences, clips, 
transitions, and so on. 

Q

QuickTime  Apple Computer's cross-platform multimedia technology. Widely used for CD-
ROM, Web video, editing, and more. 

QuickTime streaming  Apple's streaming media addition to the QuickTime architecture.

R

RAID  Redundant Array of Independent Disks. A method of providing nonlinear editors with 
many gigabytes of high-performance data storage by teaming together a group of slower, 
smaller, cheaper hard disks.

RAM  Random-access memory. Your computer’s memory capacity, measured in bytes, which 
determines the amount of data the computer can process and temporarily store at any moment.

raw data  Uncompressed data.

real-time effects  Changes made to media that can play, record, compress, or decompress 
on your system as fast as they would when played back in real time, without requiring 
rendering first.

record monitor  The monitor that plays the previewed and finished versions of your 
project when you print to tape. 

redigitize  Also referred to as recapture. To digitize clips again. Usually done to eliminate 
unused material in order to capture the clips that are used in a program at a higher rate and 
quality. 

render  The process of combining your video and audio with any applied effects, such as 
transitions or filters, one frame at a time. Once rendered, your sequence can be played in real 
time.

replace edit  A form of overwrite editing that replaces the current frame in the Canvas with 
the current frame displayed in the Viewer, together with specified additional frames of video 
on either side. 

RGB  Red Green Blue. A color space commonly used on computers. Each color is described 
by the strength of its red, green, and blue components. This color space directly translates to 
the red, green, and blue phosphors used in computer monitors. The RGB color space has a 
very large gamut, meaning it can reproduce a very wide range of colors.

ripple edit  Adjusts the start and end times of a range of clips on a track when the duration 
of one of the clips is altered. 

roll edit  Affects two clips that share an edit point. The overall duration of the sequence is 
unchanged. 
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rotoscoping  Manipulating or painting on individual frames. 

rough edit  The first editing pass. The rough cut is an early version of the movie that pulls 
together the basic elements before adding effects, transitions, and so on. 

S

sampling  The process during which analog audio is converted into digital information. The 
sampling rate of an audio stream specifies the interval at which all samples are captured. 

saturation  A measurement of chrominance, or the intensity of color in the video signal. 

scratch disk  The disk or disk space you allocate in Final Cut Pro for digital video capture 
and editing. 

script  A set of instructions that performs a specific function, similar to programming. 
FXScript allows you to create custom scripts for use in Final Cut Pro.

scrub, scrubber bar  To move through a clip or sequence with the aid of the playhead. 
The scrubber bar is where the playhead is located in the Viewer, Canvas, or Timeline. You can 
speed up or slow down playback in forward or reverse. Scrubbing is used to find a particular 
point or frame. 

SECAM  Sequential Couleur Avec Memoire. The French television standard for playback. 
Similar to PAL, the playback rate is 25 fps. 

sequence  A structured collection of video, audio, and graphics clips, edit information, and 
effects. 

slug  A generator in Final Cut Pro used to create blank space in a sequence to represent a 
video clip that has not yet been placed. 

SMPTE  Society of Motion Picture and Television Engineers. The organization which 
established the SMPTE standard timecode for video playback. 

SOT  Sound on tape. Refers to audio recorded on analog or digital formats (audio and 
video). A subject on tape with a sound byte or interview. 

sound byte  See SOT.

source monitor  In Final Cut Pro, the Viewer acts as the source monitor. Use the Viewer to 
watch individual clips, mark edit points, and apply effects. 

special effects  Visual effects applied to clips and sequences such as motion effects, 
layering, and filters.

split edit  See L-Cut.

stereo  Stereophonic Sound Reproduction. Stereo pairs are always linked and must be 
edited together. Audio level changes are made to both channels together. 

storyboard  A series of diagrams that show how a project will look when completed. 
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straight cut  A synchronized transition where both the audio and video tracks are cut 
together. 

streaming  Refers to the delivery of media over an intranet, or over the Internet.

subclip  A clip created to represent a section of a master clip. These are saved as separate 
items within a bin in the Browser, but do not generate any additional media on the hard disk.

superimpose edit  An edit that overlays one or more tracks of video so they play at the 
same time. Used to overlay titles and text onto video, as well as to create other compositing 
effects.

sync  When the timecode for two clips (audio and video) is matched up so they play in 
unison. 

T

tabs  These delineate projects in the Canvas, Timeline, and Browser, and functions within 
the Viewer. Click a tab to open the project or go to the specified function window, such as 
Video, Audio, Filters, or Motion. Tabs can also be dragged out of the main window to create a 
separate window.

tail clip  The last clip, or the clip on the right side when looking at an edit point between 
two clips. 

target track  The destination track for the edits you perform. Specified in the Timeline.

three-point editing  Final Cut Pro uses three-point editing, so you only need to specify 
three edit points to define where a new clip should be edited into your sequence. Final Cut 
Pro automatically calculates the fourth point.

thumbnail  Shows the first frame of the clip as a tiny picture for reference.

TIFF  Tagged Image File Format. A widely used bitmapped graphics file format, developed 
by Aldus and Microsoft, that handles monochrome, grayscale, 8- and 24-bit color. 

timecode  A method of associating each frame of film or video in a clip with a unique, 
sequential unit of time. The format is hours: minutes: seconds: frames.

title safe area  The part of the video image that is guaranteed to be visible on all 
televisions. The title safe area is 80% of the screen. 

tracks  Refers to layers in the Timeline that contain the audio and video items in 
your sequence. Also used to refer to the separation of audio and video on tape into 
separate tracks. 
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transitions  Visual effects that are applied between edit cuts to smooth out a change from 
clip to clip. In Final Cut Pro, you can choose from a variety of effects, such as a dissolve, 
wipe, or iris.

trimming  Adding or subtracting numbers from the timecode at the edit point to make the 
edit occur earlier or later than originally planned. To precisely define the In and Out points of 
a scene.

U

U-Matic  An analog tape format once popular for broadcast.

V

VCR  Videocassette Recorder. Generally refers to consumer equipment.

VTR  Videotape Recorder. Generally refers to professional equipment.

Vectorscope  Specialized oscilloscope that graphically displays the color parts of a video 
signal, precisely showing the color’s strength and hue.

W

Waveform Monitor  A specialized oscilloscope for displaying video signal levels and timing.

widescreen  Widescreen format is a way of shooting and projecting a movie in theatres. 
The original footage doesn’t get cut off because of the 4:3 aspect ratio. With the advent of 
high definition video, widescreen 16:9 video is coming into more popular use.

window dub  Copies of videotape with “burned in” timecode. Hours, minutes, seconds, 
and frames appear in a small box on the recorded image. Window dubs are commonly used 
for offline editing, and for reference. 

wireframe  A view of the outline of a clip’s video frame. 

X

X  Used to refer to the X coordinate in Cartesian geometry. The X coordinate describes 
horizontal placement in motion effects.
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Y

Y  Used to refer to the Y coordinate in Cartesian geometry. The Y coordinate describes 
vertical placement in motion effects.

YCrCb  Many digital video formats store data in a color space known as YCrCb. Three 
components are stored for each pixel—one for luminance ( Y ) and two for color information 
(Cr and Cb). Also referred to as YUV.

YUV   See YCrCb.
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Index
% of Blur parameter, 943
3 Band Equalizer filter, 845
3D simulation transitions, 646
4-Point Garbage Matte filter, 1048
4:3 monitor, 1351
4:3 video, 1341, 1344, 1346
7.5 Setup waveform level, 1364
8-bit audio, 731
8-Point Garbage Matte filter, 1048
16-bit audio, 731
16:9 button, 1343
16:9 media. See anamorphic media
16:9 Wide button, 1345, 1346
160M SCSI disks, 32

A

Abort capture on dropped frames setting, 61, 
264, 890

Abs function, 1247
absolute black, 1358, 1361
absolute white, 1361
AC-3 format, 1100
ACos function, 1246
acquisition process, 18
acquisition strategies, 145–159
action safe boundaries, 371
adapters

BNC connectors, 27, 28
FireWire technology and, 28
Genlock connector, 28
House Sync connector, 28
RCA connectors, 25, 27
SCART connector, 29

S-Video connector, 27
USB-to-serial adapters, 25, 40, 41, 42
video equipment, 26–29
XLR connectors, 25

Add command, 1262
Add compositing mode, 930
Add Edit command, 703
Add Handles option, 277
Additive Dissolve transition, 646, 1353
Add Keyframe button, 90, 337, 432
Add Marker button, 90, 337, 338, 394, 432
AddOffset command, 1262
Add to Find Results option, 203
Adobe Photoshop files, 157, 306
Advanced button, 117, 123, 124
Advanced QuickTime settings, 117–119, 124–127
After Effects filters, 120, 164, 1053
AIFF files, 19, 1106, 1212–1218
AIFF format, 19, 159, 1149, 1177
All Files option, 216, 218
All Frames option, for external video, 137
alignment, transitions, 621, 623, 778
alignment buttons, 623
All Items in Logging Bin option, 276
alpha channels

changing, 295–296, 920–921
codecs and, 1105
creating, 922
defined, 1367
displaying information, 922–924
identifying, 295–296
image formats, 19, 156
image sequences and, 1106
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importing clips with, 294–296
JPEG movies and, 1105
nested sequences and, 1090
properties, 918–919
QuickTime files and, 294–296, 918, 1105
reversing, 295–296, 920, 921
types of, 294, 918–921
using graphics clips with, 918–925
using video clips with, 918–925
video codecs and, 155–156
viewing in Viewer, 368–369

Alpha column in Browser, 167
Alpha Compositor transition, 648
Alpha mode, 369, 964
Alpha+RGB mode, 369
Alpha option, 935
Alpha Type menu, 920–921
Alpha Type property, 211
AlphaType statement, 1280
Always Render in RGB setting, 120
ambience. See background noise
ambience tracks, 853
analog audio, 16, 24, 44, 730, 735
analog devices. See also devices; video devices

analog-to-DV system, 42–44
connecting to capture card, 43–44
data rates, 123
FireWire and, 35
monitoring audio from, 24
outputting audio from, 24
patch panels, 26
USB-to-serial adapters, 25
video camcorder, 25

analog formats, 15
analog system, 21, 42–44
analog-to-digital capture cards, 23, 24, 26, 27, 43
analog-to-DV system, 42–44
analog video. See also digital video; video

artifacts, 27
color calibration, 1360, 1363, 1364
described, 15–16
duplication of, 16
output to, 1098
quality of, 16

analog waveforms, 730

Analyze Movie command, 855, 856–858
Anamorphic column in Browser, 168
anamorphic lens, 1345, 1346
anamorphic media, 1341–1352

benefits of, 1344–1345
capturing, 122, 1346–1347
described, 1341–1343, 1367
disadvantages of, 1342
editing, 1347–1350
exporting to QuickTime, 1352
exporting to tape, 1351
recording, 1345
rendering, 1350
rescaling and, 1343
viewing, 1347–1350

Anamorphic property, 115, 211
Anamorphic 16:9 setting for sequences, 115, 

1348–1350
Anchor Point parameter, 942
Angle control, 944, 1029–1030
Angle parameter, 943
Angle statement, 1278
AngleTo command, 1248
animation

animating filters, 69
animating motion effects, 69
graphics for, 1021
with keyframes, 981–1020
from Photoshop files, 157
resolution and, 1021

Animation codec, 155, 1104
animation movies, 155, 1104
Anti-Alias filter, 1051
A-only edit, 1367
AppleCare Knowledge Base, 1287
AppleCare Support, 11, 1296
Apple DV codec, 147, 1105
Apple FireWire. See FireWire
Apple FireWire NTSC option, 133, 134, 135
Apple FireWire PAL option, 133, 134, 135
Apple M-JPEG codec, 116, 155, 1105
Apple Store, 12
Apple System Profiler, 1296
AppleTalk, 47, 1289
Apple Web sites, 10–12
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applications, third-party, 10, 56
Arithmetic filter, 1042
A-roll, 1367
Arrange command, 198–199
artifacts

analog video and, 27
Motion J-PEG and, 155, 1105
video codecs and, 155–156, 1105

ASCIIOf command, 1268
ASCIIToString command, 1268
ASin function, 1246
aspect ratio, 1341, 1344, 1345, 1347, 1367
Aspect Ratio parameter, 942
AspectOf command, 1248
assemble editing, 1124, 1125, 1136–1139
Assert command, 1273
assign statement, 1282
ATA interface, 32
ATan function, 1246
Attack Time control, 825, 826
Aud Format column in Browser, 168
audio, 727–853. See also volume

adjusting gain, 246–247, 737
analog audio, 16, 24, 44
audio sweetening, 728, 729, 1211
background noise, 851
balanced vs. unbalanced, 25
basic concepts, 730–733
bit depth, 730, 731
calling attention to, 784
capture presets, 124–127, 280–286
capturing, 157–158, 280–286
compressed audio, 732, 824–825, 1149, 1156
correcting levels, 24–25
cross fades, 612, 775, 847, 852
distortion, 731
DVD audio, 1100
dynamic range. See dynamic range
editing out problems with, 728, 847–851
edit points, 760–763
equalization filter, 823
evaluating, 728–729
expansion filter, 826
exporting, 284–286, 1176–1178, 1211–1221
external video and, 352

file formats, 19, 159, 288, 1149
flattening, 1216
importing, 159, 742–743
levels. See audio levels
linking items, 488–491
matchboxes, 25
matching for clips, 90
matching for sequences, 90
mixdown audio, 815–816, 1081
mixing. See audio mixing
monitoring from DV device, 24
monitoring output levels, 75
moving between tracks, 774–775
outputting, 737–741
overdriven audio, 734, 735
playing, 759–760
pops/clicks in, 816–818, 848
post-production facility, 729
prerecorded, 159
presets, 59, 117–119, 742
problems with, 24, 25, 847–851, 1289–1292, 

1294–1295
quality of, 158, 727, 1219, 1295
QuickTime settings, 117–119, 124–127, 

1162–1163
recording, 158–159, 735–737
reference levels, 735–740
reference tone, 246
rendering, 786, 1079–1082
room tone, 771–774, 848
sample rates, 306–309, 730–731
sequence presets, 117–119
settings for, 59, 310, 331, 742
signal-to-noise ratio, 733
stereo pairs, 490–491, 746–747
subframe audio operations, 757–758, 816–820
synchronizing with video. See audio/video sync
types that can be captured, 157
volume. See audio levels
working with in Timeline, 766–775
working with in Viewer, 743–751

audio clip icon, 172
audio clips. See also clips

adding transitions between, 776–777
applying filters to, 829–832
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average loudness, 734
avoiding overlap, 1215
capturing, 157
defined, 1367
downsampling, 307
dragging to Browser, 309, 752
dragging to Canvas, 752
dragging to Timeline, 752
nesting, 843–844
opening, 752
pasting audio attributes, 518–519, 831–832
peaks, 734
quality of, 761
rendering, 1080–1081
resolution, 757
scrolling through, 756–757
scrubbing, 757–760
shuttling through, 759–760
trimming in Viewer, 764–766
upsampling, 307
volume. See audio levels
waveforms, 68
zoom controls, 753–757, 769

Audio column in Browser, 168
Audio command, 811
audio devices, 24

calibrating for output, 740
audio editing. See also editing

external speakers and, 23
goals of, 728, 760–761
in Viewer, 762–766

audio editing application, 1218
audio files

converting CD audio files, 307–309
importing, 307–311
MP3 audio files, 307
OMF files, 284–285, 1107, 1218–1221
QDesign audio files, 307
sample rates, 306–309
saving to scratch disk, 52, 55

audio filter icon, 172
audio filters, 821–847. See also filters; specific 

filter names
adding, 728
applying to audio clips, 829–832

categories, 823–829
changing order of, 834
compression filters, 824–825
controls in, 822–823
copying/pasting between clips, 831–832
displaying in Timeline, 833
effects filters, 828–829
enabling/disabling, 834
equalization (EQ) filters, 823–824
expansion filters, 824, 826
favorite filters, 834–835
included with Final Cut Pro, 845–847
keyframing, 835–839
noise reduction filters, 826–827
removing, 834, 1216
rendering, 840–842
settings for, 69
stereo pairs and, 821–822
viewing in Viewer, 833–834

Audio Format pop-up menu, 238
audio gain setting, 737
audio levels

adjusting, 24, 734–741, 785–789
controlling, 807, 809–810
keyframes and, 786, 793–801, 807, 809–810
mixed, 781–785, 799–801, 1201
monitoring, 783
in Viewer, 785–789
while recording, 735–740

audio matchbox, 24–25
audio meters, 24, 64, 75, 735, 785
audio mixer, 24
audio mixing, 737–740

audio levels, 781–785, 799–801, 1201
audio tracks, 24, 812–816, 887
described, 325, 781
EDLs and, 1201
guidelines, 781–782
options for, 729
real-time audio mixing, 812–816, 887, 1289
volume and stereo levels, 781–785

audio offset. See audio/video sync
audio overlays, 767–768, 785–786, 1216

adjusting pan or spread, 791
adjusting volume, 788
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audio reference tone, 246–737
audio sweetening, 728, 729, 1211
Audio tab, 68, 330, 331, 743, 744–751
audio track labels, 456, 768, 895
audio tracks. See also tracks; video tracks

analyzing, 857, 858
blank, 1156, 1162
categories, 853
cleaning up, 847–853
default number of, 62, 897
disabling in clips, 514–515
display settings for, 766–768
displaying in Timeline, 453
EDLs and, 1201
exporting, 1106
exporting as AIFF files, 1212–1217
exporting as EDLs, 285–286, 1212
exporting as OMF files, 158, 284–285, 1107
height of, 767–768
importing from CD, 159, 309–311
inserting sync beeps in, 1213–1215
labels, 456, 741, 768, 895
locking in Timeline, 479–480, 553–554
mixing. See audio mixing
nesting, 843–844
organizing, 853
output of, 1106
real-time mixing, 812–816, 887, 1289
rendering, 1079–1081
scrolling through, 465
target tracks, 484, 550–552
in Timeline, 443, 472–474
track costs, 814–815, 1079, 1080
waveforms, 766–767

audio transition icon, 172
audio transitions, 775–781

adding, 613, 776–777
changing duration, 620, 778
default, 642–643, 777, 781
deleting, 780
edit points, 779–780
modifying in Timeline, 778–780
saving as favorites, 780
swapping, 778

Audio/Video Settings window, 59, 106–113, 132, 133

audio/video sync (A/V sync), 716–725
adjusting, 891
drift in, 888
external video, 352, 424
marking clips in sync, 724–725
moving clips into sync, 722
moving items into sync, 721–725
moving items out of sync, 717–721
problems with, 1289–1292
reasons for breaking sync, 721
replace edits and, 576
slipping clips into sync, 723
subframe synchronization, 819–820
Sync Adjust Movies setting, 887–888
tips for, 761

audio waveforms. See waveforms
audiotape, 741
Aud Rate column in Browser, 168, 888
Automatic Save Every setting, 61, 887
autosave feature, 175–176, 887
autosave files, 176, 887
Aux TC 1-2 column in Browser, 168
A/V sync. See audio/video sync
AVI format, 1148, 1367
AVI movies, 1167–1170
AVI QuickTime files, 1167–1170
Avid 24-track EDLs, 317
axis, 1368

B

background modes, 964
background noise, 733, 761, 771, 783, 851
backgrounds, 370
backing up items

media files, 175
project files, 175
source clips, 148, 149

back light, 1368
backtiming clips, 542–544, 545, 556, 557
Band Pass filter, 845
Band Slide transition, 649, 1354
Band Wipe transition, 650, 1354
bars. See color bars
Bars and Tone (NTSC) generator, 1057
Bars and Tone (PAL) generator, 1057
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Basic 3D filter, 1050
Basic Border filter, 1041
Basic Motion settings, 941–942
batch capture lists. See batch lists
Batch Capture dialog box, 240, 276–277
batch captures, 273–280

defined, 1368
example of, 278
performing, 152, 275–278
preparing for, 274
restarting, 279
stopping, 279

batch compression, 1368
Batch Export command, 1109, 1179, 1180–1181
batch exports, 1179–1190

opening in Viewer, 1190
performing, 1189
QuickTime movies, 1109
redoing, 1190
selecting items for, 1180–1181
settings, 1181–1188
setting up for, 1179

batch lists, 1207–1209
creating, 152, 258–259, 1208
described, 223, 258, 1368
exporting, 1208, 1209
importing, 152, 223, 260
problems importing, 1208
uses for, 152, 1207
vs. EDLs, 1192

batch recapture, 1368
batch rendering, 1078
Beta SP format, 15, 146, 1098
Bevel filter, 1041
Bezier curves, 993, 994–995, 1009–1013
Bezier handles, 992–995

adding to keyframes, 1010, 1018
adjusting curves, 1011–1013
defined, 1368
removing from keyframes, 1011

BGDiff command, 1264
bin icon, 171
bins, 184–190. See also folders

adding to projects, 185
batch exports, 1180–1181

Browser tab for, 187
closing, 186
creating, 185
deleting from projects, 182
described, 162, 1368
Favorites bin, 66, 637
labels and, 189
log bins, 151, 224, 254–255, 1372
moving items between, 188
opened in separate window, 171, 186
opening, 181, 186
renaming, 182
selecting, 179–180
sorting, 183–184

bit depth, 730, 731
black

absolute, 244, 1358, 1361
adding between color bars and slate, 1121, 1129
fading to or from, 615
kBlack constant, 1274
waveform level for, 1364

Black alpha channel, 919
black and code, 1133–1134
blacked tapes, 1133
black trailers, 1122, 1130
Blend command, 1256
Blink filter, 1052
Blit command, 1253
BlitRect command, 1253
Blue and Green Screen filter, 1046
blue-screening, 1368
BlueScreen command, 1264
BlurChannel command, 1255
Blur command, 1255
blur filters, 1041
BMP format, 19, 1150
BNC connectors, 27, 28
border filters, 1041
boundaries. See action safe boundaries; title safe 

boundaries
BoundsOf command, 1248
Box Slide transition, 649
“Break in the Timecode” message, 1292
B-Reel list, 1196
brightness, 120, 244, 1044, 1361–1362
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Brightness and Contrast filter, 1044
broadcast monitor, 1357–1359
broadcast video, 299, 1368
B-roll, 20, 1368
Browser, 65–66, 161–220

activating, 179
bins in, 181
Browser/Viewer operations, 342–350
changing clip properties, 208–213
changing project properties, 178–179
closing, 65
closing projects, 177–178
columns in, 66, 167–171, 193–196
copying clips to, 505
copying items in, 181–182
creating projects, 173–174
customizing appearance of, 191–201
deleting items in, 182
described, 65, 162, 166
displaying items in, 192
dragging audio clips to, 309, 752
icons in, 171–172
icon view, 196–199
illustrated, 64
importing items in, 289–291
keyboard shortcuts used in, 1308–1309, 1323
list view, 193–196
navigating in, 181
opening, 65
opening clips in, 344, 752
opening projects in, 177
organizing clips in, 546–548
organizing projects in, 159
overview, 166–172
poster frames, 199
renaming items in, 182
saving projects, 174–176
searching for items in, 202–207
selecting items in, 179–180
shortcut menus in, 1325–1327
sorting items in, 183–184
tabs in, 86
working in, 179–184

BumpMap command, 1260
Bumpmap filter, 1043

C

cables
analog audio, 44
FireWire, 21
SCSI, 33
serial, 37

cache files
saving to scratch disk, 52, 55
thumbnail cache, 891, 901
waveform cache, 901

calibration
analog audio, 24
analog video, 1360, 1363, 1364
broadcast monitor, 1357–1359
color bars, 240–246, 1357–1365
defined, 1368
image settings, 240–247
incoming video signal, 1360–1362
monitor, 1357–1359
output devices, 740
timecode, 249–250, 1132, 1197

camcorder
16:9 Wide button, 1345, 1346
analog camcorder, 25, 43–44
Camera mode, 36
capturing video with, 271–273
connecting video monitor through, 23
device control, 34–37, 149, 229, 230
differing sample rates, 887–888
DV camcorder, 21, 35
FireWire and, 35, 36, 38, 149
logging tapes with, 152
manual use of, 35
problems with, 1288, 1293, 1294
serial device control, 149
VCR mode, 36

Camera mode, 36
Canvas, 71–72, 425–441

closing, 71
closing sequences in, 419
controls in, 71, 88–90
described, 1368
displaying items in, 633
dragging audio clips to, 752
edit buttons in, 441, 565
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editing controls in, 438–441
editing in, 71–72, 564–565
Edit Overlay, 440
edit points in, 553–563, 595–599
geometry of clips in, 967
illustrated, 64
keyframed motion paths, 1003–1018
markers in, 520–527
marking controls, 431–433
Match Frame control, 431
media and, 422
motion settings in, 963–980
navigation controls, 427–431
opening, 71, 426
opening sequences in, 419
overview, 425–426
playhead controls, 427–431
sequence controls, 427–429
sequences and, 64
setting In and Out points in, 554–563
shortcut menus in, 1336–1339
split edits in, 590–592
tabs in, 86, 426
timecode fields, 436–437
Timeline and, 64, 73, 422, 442
transport controls, 426, 429–431
two-up display in, 633, 660
view controls, 434, 435
viewing alpha channels in, 922–924
wireframe handles, 969–980
wireframe views, 965–966
zoom controls, 434, 967–968

Caps Lock key, 585
Capture Batch button, 223, 265
capture buttons, 225
capture cards. See video capture cards
Capture Clip button, 223, 265, 271–273
Capture column in Browser, 168
Capture Format pop-up menu, 238
Capture Now button, 223, 265, 268–270
Capture Preset Editor, 121–127, 281
capture presets, 121–127

capturing audio only, 280–286
default choices in, 105, 106
described, 104, 121

general settings, 122
QuickTime settings, 122–127
specifying, 262
third-party video cards and, 121
viewing, 107

Capture property for a clip, 213
capturing process. See also logging process; 

recording process
aborting, 264, 890
adjusting brightness/contrast, 1361–1362
analog capture devices, 1360
and AppleTalk, 47
audio/video files captured separately, 901
batch capturing clips. See batch captures
Capture Clip button, 223, 265, 271–273
capture controls, 238–239
Capture Now button, 223, 265, 268–270
capturing accurate color, 1360–1365
capturing anamorphic media, 1346–1347
capturing audio, 157–158, 1295
capturing audio only, 280–286
capturing media, 223
capturing video, 147–154, 265–279
capturing video at different data rates, 152–154
capturing video for offline editing, 153
capturing video with device control, 149, 268–273
capturing video without device control, 148, 

230, 266–268
described, 145, 223, 1368
dropped frames and, 61, 264, 890
DV media, 146
exporting EDLs and, 1197–1199
iMovie and, 150
keyboard shortcuts for, 1310
manual video capture, 148
multiple video decks, 128
presets for, 104, 105, 121–127
problems with, 1295
resolution and, 148
setting up for, 43–44, 261–265
using non-controllable device, 230

CD audio tracks, 159, 309–311
CD-ROM video, 1101
CD-RW drives, 30
CDs, importing audio from, 159, 309–311
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center handle, 966
Center parameter, 942
Center Split Slide transition, 649, 1354
Center Wipe transition, 650, 1354
CenterOf command, 1248
CG (Character Generator), 1369
Ch1/Ch2 tabs, 745
Channel Blur filter, 1042
ChannelCopy command, 1257
ChannelFill command, 1257
channel filters, 1042
Channel Map transition, 647, 1354
ChannelMultiply command, 1257
Channel Offset filter, 1042
channels, 1369
Character Generator (CG), 1369
CharsOf command, 1268
CheckBox statement, 1278
Checkerboard Wipe transition, 650, 1355
Checker Wipe transition, 650, 1354
Choose Setup window, 52
chroma, 1369
chroma key, 1369
Chroma Key transition, 648
Cinepak, 19, 1101
CircleLight command, 1272
clip1 variable, 1277
clip2 variable, 1277
clip attributes, 517–520
clip controls, 89, 335–336
clip data type, 1246
clip handles. See handles
clip icon, 172
clip In Point field, 228
clip keyframes, 445
Clip Keyframes control, 445, 833, 896, 961, 1004
clip markers, 520–521
clip Out Point field, 228
clip overlays, 445, 896
Clip Overlays control, 445, 767, 805, 913
clips, 327–401. See also audio clips; digital video clips

adding markers to, 394, 522
adding to open projects, 347
adding to projects, 347
adding transitions to, 606–615

adjusting length, 635–636
adjusting pan, 790–792
adjusting settings for log and capture, 264–265
adjusting size, 364–365
adjusting spread, 790–792
adjusting volume, 748, 806–810
alpha channels and, 294–296, 918–925
analyzing, 856–858
anamorphic media and, 1349–1350
applying filters to, 1032–1035
arranging in storyboard, 546–548
audio level of, 786–789
backgrounds for, 370
backtiming, 542–544, 545
batch capturing, 152
batch exporting, 1109, 1178–1190
boundaries, 502–503
breaking links to, 871–872, 878–879
Browser/Viewer operations, 342–350
capturing. See capturing process
changing pan for, 788–792, 801–803, 811
changing parameters, 995–1002
changing settings after logging, 240
changing timecode, 17
Clip Settings tab, 236–239
compositing, 907
controlling speed of, 579–581, 1013–1018
copying in Timeline, 508–509
copying to Browser, 505
copying with Match Frame command, 600–601
cropping, 973–974
cutting, 671–672, 701–703
deleting from projects, 182
described, 16, 162, 327, 1369
description fields, 233–235
deselecting in Timeline, 500
disabling audio/video tracks in, 514–515
displaying in Transition Editor, 630
displaying in Viewer, 360–372
distorting shape of, 972–973
dragging to trim an edit, 669–670
dragging within the Canvas, 969–980
duration, 212, 301
editing into sequences, 485, 538–539
editing multiple clips, 546–548
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exporting audio from, 1177–1178
format information for, 210–211
graphical manipulation of, 967
head, 1371
iMovie and, 150
imported QuickTime clips, 291
In and Out points and, 538–544
jogging through, 354–355
keyframe effects and, 995–1002
labels for, 63, 189–190, 897–898
layering, 908–937
links to source media, 214–220, 871–872
locked tracks and, 480
logging, 150–152, 255–258, 323–325
logging information for, 213
making invisible, 514
manipulating geometry of, 967
marking controls, 235–236
master clips, 344
matching audio for, 90
matching video for, 90
merged in Timeline, 347
motion effects for, 69
moving, 971
moving between markers, 911–912
moving in sequences, 669–676
moving markers within, 524–525
moving with timecode, 506, 673
moving within Timeline, 505–507, 524
names of, 233–234, 256, 1199
navigating, 89
nesting, 1040
offline clips. See offline clips
online clips, 151, 224
opacity of, 997–1002
opening, 327, 347
opening copies of, 345
opening for trimming, 666–667
opening from Browser, 344
opening from Timeline, 344–345
opening in original application, 346
opening in Viewer, 344–346, 752, 963
opening outside current project, 346
organizing, 184–190
organizing in Browser, 546–548

outputting to videotape, 1108
pasting, 509–511, 671–672
playback speed, 1063
playing, 61, 88, 347–349
playing at varying speeds, 353–354
printing to video, 1108
properties, 208–213
rearranging, 911–912
recapturing, 148, 149, 154, 175, 279–280, 316
recently accessed, 346, 624, 886
reconnecting to media files, 214–219, 871–878
redoing changes in, 97
reestablishing links, 871–878
removing from sequences, 602–604
renaming, 182
replacing from In point, 575–576
replacing sections of, 577–578
resizing (duration), 674–676
rotating, 971–972
saving to scratch disk, 52, 55
scaling, 969–970
scrubbing, 197–198, 352–353
searching for in Browser, 202–207
selecting, 179–180, 494–500, 658–666
selecting for trimming, 658–666
sequence clips. See sequence clips
setting In and Out points for, 90, 373–375, 548
setting keyframes for, 90, 795–796
setting markers for, 90, 236
setting up for compositing, 910–912
setting up for logging, 230–250
shown in Timeline, 472–474, 514–515
shuttling through, 353–354
sliding, 692–695
slipping, 690–695, 715
sorting, 183–184, 189, 546, 898
source clips, 17, 148, 149
speed settings, 1062–1063
split clips, 537, 552–553, 589
tail, 1377
in Timeline, 444, 472–474
timing information for, 212
transparent clips, 912–918
trimming, 632–636
undoing changes in, 97
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viewing, 327, 344–347
zooming in and out of, 360–361

Clip section of Timing tab, 212
Clip Settings tab, 231, 236–240, 264–265
Clip statement, 1279
Clip Visibility command, 514–515
Clock Wipe transition, 650, 1355
Close Project command, 177
CMX 340 format, 231, 1193, 1198, 1201
CMX 3600 format, 1193, 1198, 1201
CMYK color space, 1369
Coalesce Overlapping Clips option, 277
codecs

alpha channels and, 1105
Animation, 155, 1104
Apple DV, 147, 1105
Apple M-JPEG, 155
artifacts and, 155–156, 1105
CD-ROMs, 1101
Cinepak, 1101
described, 147, 1098, 1110, 1369
DV-NTSC, 116, 147, 1105
DV-PAL, 116, 147, 1105
DVDs, 1100
image quality and, 1156
JPEG, 147, 153, 156, 1105
lossless, 155, 1104, 1110
lossy, 147, 1110
M-JPEG, 147, 1105
M-JPEG A, 147
M-JPEG B, 147
MPEG-2, 1100
playback quality and, 146
processor power and, 1111
quality and, 1103
QuickTime, 146, 147, 1111
Sorenson, 1156
third-party, 116, 147, 156, 1105
uncompressed items, 155, 1103–1104, 1110
for video file exchange, 154–156
video quality and, 155–156
vs. file formats, 1147
YCrCb color space support, 165, 1084
YUV processing and, 166

color
broadcast colors, 299, 1359
capturing accurate color, 1360–1365
CMYK, 1369
color coding in Timeline, 452
computer vs. broadcast video, 299, 1359
distorted, 299
filters, 1030
labels, 63, 189, 897
monitors and, 22
in render bar, 532, 841, 1066–1067, 1093
RGB, 1375

Color Balance filter, 1044
color bars, 1357–1365

calibrating broadcast monitor, 1357–1359
calibrating video signals, 240–246, 1360–1362
defined, 1369
editing to tape and, 1129
printing to video and, 1121–1122

color control, 1030
color data type, 1246
color depth, 1369
Color Key filter, 1046
Color Matte generator, 1058
ColorOf command, 1271
Color Offset filter, 1042
Color parameter, 943
color space

CMYK, 1369
RGB, 27–28, 120, 163, 164, 1083–1084, 1375
updating projects and, 163, 164–165, 1085
YCrCb. See YCrCb color space
YUV. See YCrCb color space

Color statement, 1279
ColorTransform command, 1256
Column option for searches, 203
columns

batch export settings, 1185–1188
in Browser, 66, 167–171, 193–196
customizing, 193–196, 201
in Export Queue window, 1185–1188
labels, 189–190
logging columns, 167, 201
standard columns, 167, 189, 201
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Command key
Bezier curves and, 994
“gearing down” with, 501, 657, 787, 806
selecting items with, 495

commands. See also specific command names
blit commands, 1253–1254
clip commands, 1270
composite commands, 1261–1263
distort commands, 1258–1260
external commands, 1266–1267
geometry commands, 1248–1249
key commands, 1264–1265
process commands, 1255–1257
search commands, 203
shapes commands, 1249–1251
string commands, 1268
text commands, 1269–1270
transform commands, 1252
utility commands, 1271–1273

Comment Column Headings option, 179
Comment columns, 168, 195–196, 546
Comments fields in Item Properties window, 213
Component RGB, 27–28
Component video, 27–28, 1362, 1369
Component YUV, 27–28
Composite column in Browser, 168
Composite Mode property, 211
composite signal, 27
composite video, 19, 1361
compositing

described, 905, 907, 1369
modes for, 926–937
settings, 926–937
setting up clips for, 910–912
YCrCb/RGB color space and, 1083

Compound Arithmetic filter, 1042
compression

audio, 732, 1149, 1156
batch, 1368
CD-ROMs, 1101
defined, 1369
DVDs, 1100
dynamic range and, 824–825
image sequences, 1106
keying quality and, 1045

quality and, 155, 156, 1103
QuickTime files, 1154–1156
QuickTime movies, 305, 1109
settings for, 1152
spatial, 1110
temporal, 1111
Undo command and, 1154
video, 1110–1111
Web movies, 1101–1103

compression filters, 824–825
Compressor column in Browser, 169
Compressor/Limiter filter, 825, 845
Compressor setting, 116, 118, 119, 122, 125
computer

connecting monitor to, 23
setting up for Final Cut Pro, 21–44

conditional statements, 1239
connectors

BNC connectors, 27, 28
FireWire technology and, 28
Genlock connector, 28
House Sync connector, 28
RCA connectors, 25, 27
SCART connector, 29
S-Video connector, 27
USB-to-serial adapters, 25, 40, 41, 42
video equipment, 26–29
XLR connectors, 25

Contains option for searches, 203
Context Sensitive Help menu item, 10
contrast, 1044, 1361–1362
control tracks, 1123–1124
Controls tab, 70, 330, 334
Convert2dto3d command, 1249
Convert3dto2d command, 1249
ConvertImage command, 1273
Convolve command, 1257
Copy command, 182
Corners parameter, 942
Cos function, 1246
countdowns, 1122, 1130
CountTextLines command, 1268
Crawl generator, 1060
Create option for reconnecting clips, 216, 218
Crop handles, 966
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Crop parameter, 942
cropping items

clips, 973–974
video frames, 1155–1156

Crop settings, 942
Crop tool, 655, 967, 1318
cross dissolves, 642, 1353
Cross Dissolve transition, 646, 1353
cross fades, 612, 775, 847, 852, 1221
Cross Fade transition, 648
Cross Iris transition, 1354
Cross Stretch transition, 650, 1354
Cross transition, 647
Cross Zoom transition, 646, 1353
Cube Spin transition, 646, 1353
Curl filter, 1050
Current Timecode field

Canvas, 94, 436–437
Log and Capture window, 226
Timeline, 447, 469
Viewer, 94, 341–342, 358, 359

CurveTo command, 1251
Custom Gradient generator, 1058
customizing. See also preferences; presets

audio track display, 766–768
Browser display, 191–201
columns, 193–196, 201
Easy Setups, 137–142
label names, 189, 190
scripts, 1238
Timeline display, 453–459

Custom option for EDL import, 315
cuts

audio cuts, 770–771
described, 605, 1369
jump cuts, 1372
L-cuts, 1372
rendering and, 1069
rough cuts, 19, 55
vs. transitions, 606

cuts-only editing, 605, 1069, 1195
cutting items

clips, 671–672, 701–703
dialog, 847–851
keyboard shortcuts, 1305

music, 851–852
in Timeline, 701–703

Cutting Station mode, 55, 892, 893, 1194
Cylinder command, 1258
Cylinder filter, 1043

D

Darken command, 1262
Darken compositing mode, 934
DAT decks, 158
data, raw, 1375
Data Rate column in Browser, 169
data rates

analog video equipment, 123
capturing video and, 152–154
defined, 1369
offline editing and, 152, 153
QuickTime movies, 1110

data transfer rates, 30
DAWs (digital audio workstations), 284, 1107
DC Notch filter, 845
decibels (dB), 736–741, 1369
deck. See video deck
decompression, 1370
Default Number of Tracks field, 62, 454, 897
definition statement, 1239
De-Interlace filter, 1052
Delete Tracks dialog box, 478
deleting items

audio transitions, 780
clips or parts of clips in a sequence, 602–603, 

687–688
Easy Setups, 102–103, 140
edit points, 763
found items, 207
items in Browser, 182
keyframes, 798–799, 805, 839, 991–992, 1009
markers, 395, 524
In and Out points, 381
presets, 111–112
render files, 165, 481, 880–881, 1086, 1088, 1089
scratch disks, 902
sequences from projects, 418
split edits, 595
static regions, 468
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in Timeline, 515–517
tracks from sequences, 477–478
transitions, 618
volume keyframes, 808

Depth setting for capture, 125
Desaturate command, 1257
Desaturate filter, 1044
Description column in Browser, 169
Description field, 114, 122, 129, 234
Description in Item Properties window, 213
dest variable, 1277
device control, 34–37. See also devices

analog devices, 25
audio capture with, 158
camcorders, 34–37, 149, 229, 230
capturing video, 226–229, 268–273
capturing video without, 230, 266–268
checking for, 139
defined, 1370
DV device control, 149
editing to tape and, 80, 1131, 1133
FireWire, 35–36, 38–41, 149
logging clips and, 150
methods, 149
protocols for, 37
recapturing clips, 175
serial device control, 149, 248
serial devices, 35, 36–37, 40–41
status messages, 248–249
verifying setup of, 248–249
video capture with, 148, 149
video capture without, 148
video deck, 34–37, 149, 229, 230, 271

Device Control Preset Editor, 129–132
device control presets, 128–132

choosing, 262
default choices in, 106
described, 104, 128
viewing, 108

devices. See also analog devices; device control; 
video devices

audio devices, 24
calibrating, 740
Easy Setup for, 52–55, 128–132

FireWire. See FireWire
non-controllable, 35, 230
protocols supported, 37
scripts for, 1288, 1293
SCSI, 32–34
settings, 1133

Device setting for capture presets, 124, 127
Device Settings tab, 1126, 1131
dialog

from different takes, 850
editing, 20, 784
off-camera, 849
stereo and, 804
tips for cutting, 847–851

dialog tracks, 853
Diamond Iris transition, 1354
Diamond transition, 647
Difference command, 1262
Difference compositing mode, 931
Difference Matte filter, 1046
Diffuse command, 1255
Diffuse filter, 1051
DiffuseOffset command, 1255
digital audio workstations (DAWs), 284, 1107
Digital Betacam format, 16, 1098
digital CRT transfer, 1100
digital data, 1370
Digital Laser Transfer, 1100
digital media, 29–34. See also media
digital video. See also analog video; video

aspect ratio, 1341
color calibration and, 1360
described, 16, 1370
duplication of, 16
formats, 16
output to, 1098
playback quality, 350–352, 423–424
quality of, 16
transfer rate, 30

digital video clips. See also clips
creating subclips with, 399–401
data rates, 153
fuzzy, 1293
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digital video devices
assemble edits and, 1125
FireWire connection, 38–39
monitoring audio from, 24

digital video system
FireWire device control, 38–41
serial device control, 40–41
setting up, 21, 38–41

Digitizer setting for capture presets, 122, 126
digitizing, 1370
DimensionsOf command, 1248
Dip to Color Dissolve transition, 1353
Dip to Color transition, 646
disk arrays, 30, 33–34
disk drive. See hard disk
Displace command, 1260
Displace filter, 1043
dissolve transitions, 606, 642, 646–647
distort filters, 1043
distorting clips, 972–973
Distort settings, 942
Distort tool, 655, 967, 1318
distribution, 1097–1111. See also exporting items

described, 19
file formats for, 1148–1150
options for, 77, 79–80, 1097–1107
outputting QuickTime files, 1109
outputting to tape, 1108
theatrical, 1099
video compression, 1110–1111

DistTo command, 1248
Dither Dissolve transition, 646
documentary-style projects, 253
double-byte characters, 163, 184, 314, 1193
drag-and-drop editing, 554, 586–587
Drag hand, 750
drag handle, 624
dragging items

clips, 669–670, 969–980
Option key and, 508
sequences, 421

DrawSoftDot command, 1250
DrawString command, 1269
DrawStringPlain command, 1269
drives, removable media, 30. See also hard disk

Drop Frame option, 62, 92, 315, 454, 894
drop frame timecode, 62, 91–92, 356–357, 894, 1370
dropped frames

A/V sync and, 1289–1292
aborting capture on, 61, 890
capture and, 264
causes of, 1289–1292
EDLs and, 1194
memory and, 1289
mixdown audio and, 815–816
number of tracks and, 813
during playback, 889
reporting, 61, 264, 889

Drop Shadow parameter, 943
Drop Shadow settings, 943
duration

audio transitions, 778, 780
clips, 301, 375
defined, 1370
gaps, 706
imported images, 890
markers, 398–399, 526–527
still images, 300–301, 890
transitions, 607, 619–620, 623, 634, 778

Duration Calculator, 79, 1120, 1130
Duration column in Browser, 169
Duration field in Transition Editor, 623
Duration property, 212
duration variable, 1277
DV camcorder, 21, 35
DV clips. See also clips

creating subclips with, 399–401
data rates, 153
fuzzy, 1293

DV codec, 153
DV-CAM format, 146
DVD audio, 1100
DVDs

compression, 1100
described, 1100, 1370
outputting video to, 1100

DV devices
assemble edits and, 1125
FireWire connection, 38–39
monitoring audio from, 24
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DV (digital video). See also analog video; video
aspect ratio, 1341
color calibration and, 1360
described, 16, 1370
duplication of, 16
formats, 16
output to, 1098
playback quality, 350–352, 423–424
quality of, 16
transfer rate, 30

DV format, 16, 19
DV-NTSC codec, 116, 147, 1105
DV-PAL codec, 116, 147, 1105
DV Stream files, 150, 1106, 1148, 1170–1171
DV system

FireWire device control, 38–41
serial device control, 40–41
setting up, 21, 38–41

DV Time option, 130
DV-to-analog converter box, 40, 41
dynamic mixing, 1216
dynamic range, 732–733

compression and, 824–825
controlling, 738–739
described, 732
determining, 782
for Internet media, 782

E

Ease In/Ease Out command, 1018
Easy Setups. See also presets; settings

accessing, 58
changing, 101–102
customizing to fit your needs, 53, 103, 

137–142
described, 52, 53, 99–100
earlier versions of Final Cut Pro and, 53
locked, 111
making unavailable, 102, 103
removing, 102–103, 140
restoring original, 103
selecting different presets in, 105–106
selecting initial Easy Setup, 52, 54–55, 101
working with, 101–103

Easy Setup window, 58

EBR (Electronic Beam Recording), 1100
Echo filter, 828–829, 845
Edge Feather parameter, 942
Edge Wipe transition, 650, 1355
edit buttons, 72, 565
Edit Decision Lists. See EDLs
editing. See also trimming

advanced techniques, 653–725
anamorphic media, 1347–1350
assemble editing, 1124, 1125, 1136–1139
audio editing, 23, 728, 760–766
basics, 20, 321–326, 533–604
canceling, 697, 714
in Canvas, 71–72, 438–441, 564–565
changing simple edit to split edit, 592–593
clips into sequences, 485, 538–539
Command key for “gearing down,” 501, 657, 787
considerations, 20
controls for, Canvas, 438–441
cuts-only editing, 1069, 1195
described, 19, 321, 1370
designating target tracks, 482–484
drag-and-drop editing, 554, 586–587
with edit buttons, 565
Edit Overlay, 72, 80, 440, 564
dialog, 20
EDL export and, 1200–1202
extend editing, 680–681
in Final Cut Pro, 535–545
fit to fill editing. See fit to fill editing
insert editing. See insert editing
insert with transition editing, 536, 567–569
keyboard shortcuts for, 565, 1313–1314
lift delete, 515–516, 602–603, 686–687
linear editing, 17, 1372
logging clips and, 151, 323, 324–325
match frame editing, 600–601, 1373
methods for, 563
multiple clips, 546–548
nondestructive editing, 17
nonlinear editing, 17, 1373
offline editing, 17–18, 152, 153, 1191, 1374
online editing, 17–18, 152, 1191
overview of, 1191
overwrite editing. See overwrite editing
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overwrite with transition editing, 439, 536, 
571–573, 607

performing, 563–599
presets, 110
previewing, 1143
real-time editing, 1091–1092
replace editing. See replace editing
resize editing, 634, 674–676
ripple editing. See ripple editing
roll editing. See roll editing
rough editing, 325, 1376
setting up for, 546–563
slip editing, 380–381, 819–820
split editing. See split editing
strategies for, 324–326
superimpose editing. See superimpose editing
swap editing, 695–697
to tape, 1108, 1123–1144
three-point editing, 538–545, 1377
in Timeline, 447–452, 584–587, 769–775
with transitions, 1195–1196
trim editing. See trim editing
trimming. See trimming
types of, 71, 438–439, 536–537
typical editing operation, 322
user mode and, 55

Editing mode, 1127, 1138, 1142
Editing Timebase setting, 115
Edit Marker dialog box, 395, 398, 523
Edit Overlay, 72, 80, 440, 564
edit points. See also In and Out points

audio edit points, 760–763
audio transitions, 779–780
changing, 617
copying transitions between, 618
guidelines for, 545
moving playhead to, 470, 558
navigating between, 382
not setting, 545, 555
removing, 763
reviewing, 375
selecting for trimming, 661–662, 664
setting, 373–385, 555–563
slipping, 763

split edit points, 594–595, 762, 763
transitions and, 609–610, 617

Edit Render Qualities option, 179
Edit Selection tool, 492, 493, 655, 659, 1317
Edit to Tape command, 1108, 1123–1144, 1292
Edit to Tape operations, 1124–1125

described, 1370
device control and, 80, 1131, 1133
problems with, 1292
requirements, 1125
setting up for, 1131–1135

Edit to Tape window, 80, 88, 1123, 1126–1131
EDLs (Edit Decision Lists)

audio tracks and, 1201
described, 313, 1107, 1192–1193, 1370
double-byte characters and, 163
editing and, 1200–1202
effects and, 1193–1194
errors during export, 1206
exporting, 1107, 1200, 1202–1206
exporting audio tracks as, 285–286, 1212
exporting sequences as, 1193–1194, 1202–1206
export settings, 1203–1206
export transition codes, 1353–1355
formats, 1193
importing, 313–317
improving, 1197–1202
information in, 1194–1196
limitations, 314
nested sequences and, 1201–1202
offline editing and, 18
opening, 1206
overview, 1192–1196
recapturing clips from, 316
reviewing, 1206
RT-11 disk access, 1206
speed settings and, 1202
superimposed video and, 909, 917–918
timecode and, 151, 286, 1197
tracks and, 1200
transitions, 610, 1200, 1202
uses for, 1107
vs. batch capture lists, 1192

EffectD statement, 1281
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effects
adjusting with keyframes, 908
animating with keyframes, 981–1020
applying to sequences, 1233
categories, 905–906
clip duplication and, 508
described, 19
editing process and, 326
EDLs and, 1193–1194
favorites, 1370
FXBuilder and, 1229
keyboard shortcuts for, 1315–1316
modifying with scripts, 1229
motion effects, 940–980
overview, 905–906
previewing, 1076
real-time effects, 1069, 1082, 1091–1093, 1375
rendering, 842
settings, 332
sound effects, 851

effects filters, 828–829
Effects menu

adding audio transitions, 613, 776
adding transitions from, 612–613
adding video transitions, 613
real-time effects, 1092

Effects tab
adding audio transitions, 777
adding transitions from, 614
creating favorite transitions, 638–639
described, 66
real-time effects, 1092

Electronic Beam Recording (EBR), 1100
elements for outputting to tape

leader, 1121–1122, 1129–1130
media, 1122, 1130
timing of, 1122, 1130–1131

Emboss filter, 1051
encoding scripts, 1234
End property for a clip, 212
End slider for transitions, 626
equalization (EQ) filters, 823–824
equipment. See video equipment

error messages. See messages
event number, 1195
Exit For statement, 1284
Exit Repeat statement, 1284
Expander/Noise Gate filter, 846
expansion filters, 824, 826
Exp function, 1247
Explode transition, 648
Export Final Cut Pro Movie command, 1103, 

1109, 1146, 1147, 1151–1153
exporting items. See also distribution

anamorphic video to QuickTime, 1352
anamorphic video to tape, 1351
audio, 284–286, 1211–1221
audio only, 1176–1178
audio tracks, 1106
audio tracks as AIFF files, 1212–1217
audio tracks as EDLs, 1212
AVI QuickTime files, 1167–1170
batch capture lists, 1208, 1209
batch exports, 1109, 1179–1190
DV Stream files, 1170–1172
EDLs, 1107, 1200, 1202–1206, 1353–1355
Final Cut Pro movies, 1109, 1151–1153
FLC QuickTime files, 1165–1166
FXBuilder scripts as text, 1234–1235
numbered image sequences, 1172–1174
OMF audio files, 284–285, 1107, 1218–1221
QuickTime files, 1100, 1154–1171
QuickTime movies, 1109, 1157–1165
scripts, 1234–1235
sequences as EDLs, 1193–1194, 1202–1206
still images, 1174–1176

Export Queue window, 1180–1190
Export QuickTime command, 1103, 1146, 

1147, 1154
Export QuickTime Movie command, 1109
exposedBackground variable, 1277
extend editing, 680–681
extensions, file, 1184, 1188
extensions, third-party, 47–48
external speakers, 23
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external video
audio/video sync with, 352, 424, 716–725
editing to tape and, 1132–1133
enabling, 23, 352
recording to videotape and, 1114–1115
settings, 132–137
video monitor and, 23

External Video tab, 132, 134–136
Extract filter, 1048

F

Fade In, Fade Out transition, 646
fade-to-black transitions, 615
false constant, 1274
Fast Forward button, 227
favorites, 637–641

audio filters, 834–835
audio transitions, 780
creating, 638–639
defined, 1370
motion effects, 1019–1020
organizing, 640–641
renaming, 640, 780
transitions, 637–641
video filters, 1037–1038

Favorites bin, 66, 637
field dominance, 292–293
Field Dominance setting, 115, 211, 292, 293
fields in Final Cut Pro. See also specific fields

clip descriptions, 233–235
Comments fields, 213
Label fields, 213
timecode fields, 94, 329, 341–342, 436–437

fields of a video image, 1370–1371
file formats

analog, 15
audio, 19, 159, 288, 1149
Beta SP, 15
BMP, 19
Cinepak, 19
composite video, 19
Digital Betacam, 16
digital video, 16, 19
distribution, 1148–1150
EDLs, 1193

exporting in QuickTime, 1157
graphics, 11, 19, 50, 288
Hi-8, 15
images, 19, 288, 1150
for importing, 288
JPEG, 19
MacPaint, 19
Motion JPEG, 19, 116
NTSC, 19
PAL, 19
Photo JPEG, 19, 116
Photoshop, 19
PICT, 19
PNG, 19
QuickTime Image, 19
SDI, 19, 28
SGI, 19
Sorenson, 19, 1101
special, 288
supported, 19, 288
TARGA, 19
TIFF, 19
VHS, 15
video, 15–16, 146–147, 288, 1148
vs. codecs, 1147
YCrCB, 27–28
YUV, 27–28

File Size property of a clip, 210
files. See also QuickTime files

Adobe Photoshop files, 157, 306
AIFF files, 19, 1106, 1212–1218
audio files. See audio files
autosave files, 176, 887
AVI files, 1167–1170
backing up, 175
cache files, 52, 55, 891, 901
DV Stream files, 150, 1106, 1148, 1170–1171
extensions for, 1184, 1188
FLC files, 1165–1166
importing, 289–291
MP3 audio files, 307
naming, 252–253
offline files, 878–879
OMF files, 284–285, 1107, 1218–1219, 1221
QDesign audio files, 307
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QuickTime files. See QuickTime files
render files. See render files
saving, 887
Targa files, 156, 1150
Wave files, 19, 1106

FillArc command, 1251
FillOval command, 1250
FillPoly command, 1250
FillRegion command, 1250
filmstrip icon, 550
Filmstrip display setting, 456
film, transferring video to, 1099–1100
film transfer facilities, 1099
filter bar, 446, 457, 896, 961–963
filter category bars, 835, 1026
Filter command, 1266
filters. See also specific filter names

After Effects filters, 164, 1053
applying to audio clips, 829–832
audio. See audio filters
changing order of, 834
color control, 1030
compression filters, 824–825
controls for, 1028–1031
copying/pasting between clips, 831–832
described, 906, 1371
displaying in Timeline, 833
effects filters, 828–829
enabling/disabling, 834
equalization (EQ) filters, 823–824
expansion filters, 824, 826
favorite filters, 834–835, 1038–1039
noise reduction filters, 826–827
parameter controls, 1026
QuickTime filters, 1161
removing from clips, 834
settings for, 69, 332
start and end points, 1026
stereo pairs and, 821–822
video. See video filters
viewing in Viewer, 833–834
YCrCb color space and, 164

Filter setting for capture presets, 126
Filters option, 832
Filters tab, 69, 330, 332, 1026–1027, 1037

Filter statement, 1280
Final Cut Pro

acquisition strategies, 145–159
distribution options, 1097–1111
documentation for, 7
earlier versions of, 163–166
final distribution, 1097–1111
formats supported, 19
Help menu, 8–10
initial setup, 52–55
installing, 47–51
interface, 57–97
late-breaking news, 9, 21
media used in, 145
memory allocated to, 49–51, 1296
performance, 47–48, 1294
setting up system for, 21–44
system requirements, 21
transitions included with, 646–651
tutorials for, 8, 56
version number, 1296
video creation process, 18–19
Web site for, 10, 19

Final Cut Pro CD, 112–113
Final Cut Pro Tutorials, 56
Find Again command, 217, 219
Find All command, 203, 205
Find command, 202, 204, 205, 278, 528, 881
Find dialog box, 202–205
Find Edges filter, 1051
finding items

for batch capture, 278
in Browser, 202–207
commands for, 203
keyboard shortcuts for, 1307
media files, 881
offline clips, 874
options, 202–203
Search option, 203
in sequences, 528–529
timecode, 528–529
in Timeline, 528–529

Find Next command, 203, 204, 529
Find Results window, 205, 206–207
FindString command, 1268
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FireWire
analog equipment and, 35
cables for, 21
calibration, 1364
camcorders, 35, 36, 38, 149
codecs for, 147
connectors for, 28
described, 28, 35, 1371
device control, 35–36, 38–41, 149
interface, 21
ports for, 21, 23, 38
Protocol setting for, 129–130
versions of, 36
video capture and, 25
video decks, 36, 38, 149
Web site for, 12, 36

Fisheye command, 1258
Fisheye filter, 1043
Fit All command, 364–365, 967
Fit All setting, 434
fit to fill editing

described, 537, 1371
edit points and, 545
performing, 579–581
speed settings and, 579–581, 1063

Fit to Window setting, 364, 434, 967
flattening audio, 1216
FLC format, 1148, 1165–1166
FLC QuickTime files, 1165–1166
flesh tones, 245–246
float data type, 1245
Flop filter, 1050
floppy disks, 1206
folders. See also bins

importing, 288, 289–291
naming, 163
specifying as scratch disk, 900

FontList statement, 1279
fonts, 299, 1031, 1059–1061
footage

animation and, 1104
compression and, 155, 1104
eliminating, 391–392
logging in advance, 323, 324

master clips and, 391–392
subclips and, 391–392
unused, 391–392

Forget Movie button, 215, 876
Forget Render button, 215, 876
Format setting, 126
Format tab, 210–211
formats. See file formats
For/Next statement, 1284
For option, 203
FPS (Frames per second) setting for capture 

presets, 123
fps variable, 1277
fragmentation, 1290
FrameArc command, 1251
FrameOval command, 1251
FramePoly command, 1250
frame rate, 1156
Frame Rate setting for device control, 130
FrameRegion command, 1250
frames

blending, 1062
closeup view of, 625
cropping, 1155–1156
defined, 1371
dropped. See dropped frames
freeze frames, 890
moving one frame at a time, 355
moving playhead to, 394
overlapping, 609–610
playing all, 349
poster frames, 195, 199–200, 389–390
size of. See frame size
still frames, 1202
trimming and, 887

frame size
choosing, 1155–1156
imported graphics and, 297, 299–300
QuickTime and, 1162
sequence presets, 114–115
for video, 407

Frame Size column in Browser, 169
Frame Size settings, 114, 122
Frames per second option, 118, 125
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frame variable, 1277
freeze frames, 890
FullFrame statement, 1281
FXBuilder, 1225–1242. See also scripts

described, 1225, 1227
interface, 1228–1229
menu commands, 1229
undoing actions, 1227
using, 1227–1236
video effects and, 1229

FXBuilder Input Controls tab, 1228, 1231–1232
FXBuilder Text Entry tab, 1228, 1230–1231
FXBuilder window, 1227, 1228–1229
FXScript, 1243–1285. See also specific FXScript 

commands
arrays, 1242
blit commands, 1253–1254
clip commands, 1270
command overview, 1239–1242
comments, 1242
composite commands, 1261–1263
constants, 1241, 1274–1277
custom filters, 1031
data types, 1241, 1245–1246
distort commands, 1258–1260
expressions, 1242, 1243–1245
external commands, 1266–1267
functions, 1242, 1246–1247
geometry commands, 1248–1249
key commands, 1264–1265
loops, 1240
operators, 1242, 1243–1245
parameters, 1243
process commands, 1255–1257
shapes commands, 1249–1251
statements, 1239, 1278–1285
string commands, 1268
subroutines, 1240
text commands, 1269–1270
transform commands, 1252
utility commands, 1271–1273
variables, 1241, 1277–1278

G

gain
adjusting, 246–247
defined, 1371

gain controls, 237
Gain slider, 127, 237, 246–247
gamma, 1371
Gamma Correction filter, 1044
gaps, 511–514

closing, 704
duration of, 706
editing clips into, 540–541
filling, 848
finding, 704
track gaps, 511, 704, 705
types of, 703–704
while editing, 703–706

Gaussian Blur filter, 1041
general preferences, 61, 884, 885–891
General tab, 61, 405–408, 885–891
generational loss, 16
Generator command, 1267
Generator pop-up menu, 329, 339
generators. See also video generators

described, 328, 906, 1371
keyframing generators, 1056
real-time generators, 1057
settings for, 70, 334
titling generators, 1059–1061
using, 1057–1061
YCrCb color space and, 164

Generator statement, 1280
Genlock connector, 28
GetConversionMatrix command, 1273
GetLimits command, 1270
GetPixelFormat command, 1273
GetReelName command, 1270
GetTimeCode command, 1270
GetVideo command, 1270
glossary, 1367–1379
Good column in Browser, 169, 206
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Go to In Point button, 228
Go to Out Point button, 228
Gradient generator, 1058
Gradient Wipe transition, 648, 650, 1355
graphical generators, 1057–1059
graphics. See also images

for animation, 1021
action/title safe boundaries and, 371–372
broadcast video and, 299
compositing, 907
computer vs. video, 299
distorted, 296–298
file formats, 288, 1106
line art, 299
pixels and, 296–298, 366–367
resolution, 908, 1021–1022
scaling, 299–300
video output and, 296–298

graphics clips, 918–925
GreenScreen command, 1264
Grid command, 1248
Group Selection tool, 492, 493, 495, 655, 659, 1317
Group statement, 1280
GVG 4 Plus format, 231, 1193, 1198, 1201

H

Hand tool, 363, 655, 1318
handles

audio clips, 1215
Bezier handles, 992–995, 1010–1011, 1368
center handle, 966
clip handles, 625
crop handles, 966
defined, 1371
drag handle, 624
OMF audio, 1220
rotational handle, 966
scale/distort handles, 966
wireframe handles, 966, 969–980

Handle Size field, 131, 315
hard disk. See also scratch disks

160M SCSI disks, 32
data transfer rates, 30–33
digital media storage, 29–34
external, 29

internal, 29, 32
moving sequences/media to, 866–868
multiple disks, 29
naming, 163
RAID system, 34
saving space on, 18, 82
SCSI disk drives, 31–32
seek time, 30, 32
space required, 22, 31, 148, 153
spindle speed, 30, 32
Ultra ATA disk drives, 31
Ultra2 LVD SCSI disks, 32, 33

Hard Light compositing mode, 933
hardware. See also hard disk; video equipment

for color calibration, 1363
considerations, 20–26
Easy Setup for, 52–55
requirements for, 21
setting up, 38–44
video capture cards, 15

Hardware Settings folder, 102, 103
head clips, 1371
headphones, 783
headroom, 736, 739, 781–782
Help Cursor menu item, 10
help features, 8–10, 1287
Help menu, 8–10
Hi-8 format, 15
hiding items

columns in Browser, 193
overlays, 385
thumbnails, 195
tracks, 480–482

Highlight command, 1272
Highlight generator, 1058
High Pass filter, 846
High Quality Playback option, 351
High Shelf filter, 846
hinted QuickTime files, 1102, 1163–1164
Hinted Streaming option for export, 1163–1164
House Sync connector, 28
HTML pages, 1102
hue, 1371
Hue slider, 1362
Hum Remover filter, 826–827, 846
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I

icons
audio clip icon, 172
audio filter icon, 172
audio transition icon, 172
bin icon, 171
clip icon, 172
filmstrip icon, 550
locked bin icon, 171
marker icon, 172
offline clip icon, 172
sequence icon, 171
speaker icon, 550
subclip icon, 172
video filter icon, 172
video generator icon, 172
video transition icon, 172

icon view, 166, 191, 192, 196–199, 546–548
IEEE 1394. See FireWire
If/Else statement, 1283
i.LINK. See FireWire
Image+Wireframe mode, 964
ImageAnd command, 1263
image control filters, 1044–1045
image controls for capture, 237
image data type, 1245
Image Mask filter, 1048
Image mode, 964
ImageOr command, 1263
images. See also graphics

calibrating, 240–247
codecs and, 1156
file formats, 19, 1150
importing, 156–157
magnified, 363
pixels and, 296–298, 366–367
quality of, 1156
resolution, 1021–1022
still. See still images
zooming in and out of, 362

image sequences, 302, 1106, 1172–1174
Image Stabilizer filter, 1052
ImageXor command, 1263
iMovies, 150
Implode transition, 648

Import For option, 315
importing items, 287–311

AIFF files, 1218
audio, 159, 307–311, 742–743
batch lists, 152, 223, 260
CD audio tracks, 159, 309–311
clips with alpha channels, 294–296
described, 145, 1372
EDLs, 313–317
field dominance and, 292–293
file formats for, 156, 288
files, 289–291
folders, 288, 289–291
graphics and, 299–300
image files, 156–157, 890
layered Photoshop files, 306
media files into Final Cut Pro, 288–291
numbered image sequences, 157, 302–305
Photoshop files, 157, 306
prerecorded audio, 159
QuickTime files, 154–156, 291–296
sequences, 156–157
still images, 296–306

In and Out point overlays, 383
In and Out points. See also edit points

changing location of, 379–381
clearing, 381, 549, 563
controls for, 90
editing clips and, 543–544
extending on subclips, 388–389
keyboard shortcuts for, 1311
marking, 374, 375, 548–549
moving for split edits, 593
moving playhead to, 382, 558, 559
playing clips between, 348–349
recapturing clips and, 148
removing, 381
replace edits and, 573–574
ripple edits, 636–637
selecting clips, 496–497
serial device control and, 35
setting for clips, 90, 373–375, 548
setting for sequences, 90
setting in Canvas, 554–563
setting in Timeline, 554–563
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setting in Viewer, 90, 548
slipping, 380–381
working with in Viewer, 373–385

In column in Browser, 169
InformationFlag statement, 1282
In points

defined, 1372
moving playhead to, 382, 558, 559
setting for audio/video, 762

In property, 212
Input setting, 122, 124, 126, 127
input statements, 1239
In Selected Sequences option for searches, 203
insert editing

described, 439, 536, 1125, 1372
dragging clips, 669–670
pasting items as, 508
performing, 565–567, 584–585, 669–676, 

1139–1144
previewing, 1125
in Timeline, 584
video reference signals and, 1125

Insert mode, 1141
Insert Settings tab, 1128–1131
Insert Tracks dialog box, 476–477
insert with transition editing, 536, 567–569
Inset Wipe transition, 650, 1355
In Shift indicator, 710
installing items

After Effects filters, 1053
Final Cut Pro, 47–51
presets, 112–113
QuickTime, 45
scripts, 1235–1236
third-party software, 56
tutorial files, 56

“Insufficient content for edit” message, 668
Integer function, 1247
interlaced video, 292, 293, 1372
Internet

dynamic range and, 782
streaming video over, 1163–1165

Interpolate command, 1248
InvalEntireItem statement, 1281
Invert command, 1263

InvertChannel command, 1263
Invert filter, 1042
invisible tracks, 448–449, 480–482, 1090, 1372
iris transitions, 647, 648
Item Properties window, 530

changing alpha channels, 920
changing clip properties, 210–231
described, 206
opening in Timeline, 530
viewing clip properties, 210–231

items
copying in Browser, 181–182
copying in Timeline, 508–509
deleting found items, 207
deleting from projects, 182
deleting in Browser, 182
deleting in Timeline, 515–517
deselecting, 500
displaying in Browser, 192
linking in Timeline, 488–491
modifying properties, 530
moving, 188
moving in Timeline, 505–507, 524
moving with timecode, 506–507
renaming in Browser, 182
searching for in Browser, 202–207
searching for in Timeline, 528–529
selecting in Browser, 179–180
selecting in Timeline, 491–500
sorting in Browser, 183–184
viewing properties, 530
working with in Timeline, 484–527

J

Jaws Wipe transition, 650, 1355
Jaz drives, 30
jog control

Canvas, 89, 425–428
described, 1372
device control, 228
jogging through clips, 354–355
jogging through sequences, 471
moving forward or backward, 355
moving frame at a time, 355
Viewer, 89, 328, 335–336, 354–355
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JPEG codec, 147, 153, 156, 1105
JPEG format, 19, 156, 1150
jump cuts, 1372
jumping playhead, 469
JVC RS-232 protocol, 37

K

k16mm constant, 1275
k24fps constant, 1275
k25fps constant, 1275
k30fps constant, 1275
k35mm constant, 1275
k60df constant, 1275
kAlpha constant, 1274
kBlack constant, 1274
kBlue constant, 1274
kbold constant, 1276
kbolditalic constant, 1276
kcenterjustify constant, 1276
kCyan constant, 1274
kDiamond constant, 1275
Key frame every _frames option, 118–119, 125
key tracks, 917
keyboard, 326
keyboard shortcuts, 1297–1324. See also shortcut 

menus
application windows, 1304–1305
Browser, 1308–1309, 1323
capturing functions, 1310
clip controls, 89
copying items, 1305
cutting items, 1305
described, 83
editing functions, 565, 1313–1314
effects functions, 1315–1316
finding items, 1307
general controls, 1303–1304
In and Out points, 1311
listed by function, 10, 1303–1315
listed by key, 10, 1297–1302
logging functions, 258, 1310, 1324
markers, 1312
marking controls, 90, 338
modifier keys, 1317–1323
navigation, 470–471, 1306–1307, 1317

output functions, 1315
pasting items, 1305
pen tools, 805–806, 983
playback controls, 88
playhead controls, 89
playing audio, 759–760
playing video, 1310
projects, 1308
screen layout, 1308
scrolling functions, 1307
selecting items, 663, 666, 1305
sequence controls, 89
sequences, 1308
shuttling through clips with, 354
Timeline, 1309–1310
for tools, 1317–1323
transport controls, 88, 337
Viewer, 1323
volume controls, 789
zoom controls, 460, 462–463, 986

Keyboard Shortcuts menu item, 10
keyframe buttons, 69, 836, 983–984, 1026
keyframe controls, 90, 794
keyframe graph ruler, 836, 1027
keyframe graphs, 836, 985–986, 1027
keyframe navigation buttons, 836, 1027
keyframe overlays, 445, 458, 767–768, 896–897
keyframes, 793–804

adding Bezier handles to, 1010, 1018
adjusting, 807, 838, 989
adjusting overlays, 797, 838, 990–991
adjusting pan/spread, 796
adjusting velocity of, 1014–1018
adjusting volume level, 796
animating visual effects with, 981–1020
audio levels and, 786
changing clip parameters, 995–1002
changing clip volume, 807–810
clip keyframes, 445
compression and, 1111
controlling audio levels, 807, 809–810
controlling pan/spread, 801–804
creating, 805
curved keyframes, 1018
deleting, 798–799, 805, 839, 991–992, 1009
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described, 908, 940, 981, 1372
filter bar and, 961–963
filters and, 833
keyframe overlays, 458
mixing levels, 799–801
motion bar and, 961–963
motion paths and, 1003–1018
moving, 797, 838, 963, 991
navigating between, 796, 838, 989
one-dimensional keyframes, 993
removing Bezier handles from, 1010
setting, 987–989
setting for audio filters, 837
setting for clips, 90, 795–796
setting for parameters, 837
setting for sequences, 90
smoothing, 838, 994–995
subframe keyframes, 816–818, 848
two-dimensional keyframes, 993
uses for, 981

keyframing
audio filters, 835–839
controls for, 835–836, 982–986
described, 905, 981–982
examples, 997–1002
generators, 1056
settings, 982–986
video filters, 1039

keying filters, 1045–1047
KeyType statement, 1280
kFloat2 constant, 1274
kFloat4 constant, 1275
kFloat6 constant, 1275
kFormatRGB219 constant, 1277
kFormatYUV219 constant, 1277
kGray constant, 1274
kGreen constant, 1274
kInteger constant, 1274
kitalic constant, 1276
kKeyAdd constant, 1276
kKeyDarken constant, 1276
kKeyDifference constant, 1276
kKeyHardLight constant, 1276
kKeyLighten constant, 1276
kKeyMultiply constant, 1276

kKeyNormal constant, 1276
kKeyOverlay constant, 1276
kKeyScreen constant, 1276
kKeySoftLight constant, 1276
kKeySubtract constant, 1276
kleftjustify constant, 1276
kMagenta constant, 1274
kplain constant, 1276
kRed constant, 1274
krightjustify constant, 1276
kRound constant, 1275
kSize constant, 1275
kSquare constant, 1275
kUndefined constant, 1274
kWhite constant, 1274
kYellow constant, 1274

L

Label 2 column in Browser, 169, 189
Label column in Browser, 169, 189
Label fields in Item Properties window, 213
Label property, 213
labels

audio tracks, 456, 768, 895
audiotape, 741
clips, 189–190, 897–898
colored, 63, 189, 897
defaults, 897
media, 897–898
names, 189, 190, 897–898
organizing clips with, 189–190
paired, 456, 895
preferences, 63, 884, 897–898
sequential, 456, 895
sorting clips by, 898
in the Timeline, 452
uses for, 897

Labels tab, 63, 884
Label statement, 1279
LANC format, 149
Last Modified column in Browser, 170
µLaw format, 1149
layering clips, 908–937
layer masks, 306
layers, 306, 908–937
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L-cuts, 1372
leader elements, 1121–1122
Length column in Browser, 170
Length command, 1268
Length property for clips, 212
Less search option, 203
letterboxing, 1343–1344
letterbox video, 1343–1344, 1351
Level Keyframe button, 749, 794
level keyframe navigation buttons, 749, 794
LevelMap command, 1257
level overlay, 751, 785–786, 788
Level slider, 748–749, 787
Levels filter, 1044
Levels of Undo setting, 61, 886
lift editing

described, 602, 686
performing, 515–516, 603, 686–687

Lighten command, 1262
Lighten compositing mode, 934
Limit Data Rate to _KBytes/sec option, 119, 123, 125
Line command, 1249
Linear command, 1018
linear editing, 17, 1372
linearRamp variable, 1278
linked selection control, 656
linked selections, 486–487, 504, 716
link indicators, 450
Linking control, 450, 487
links

to audio items, 488–491
breaking, 219, 489
broken, 871–872
between clips and source media, 182, 214–220, 

871–872
to items in Timeline, 488–489
online/offline status and, 224
reconnecting between clips and media, 871–878
to video items, 488–489

List Recent Clips setting, 886
list view, 166, 191, 192, 193–196, 546
Local control, 35
locked bin icon, 171

locked items
Easy Setups, 111
pen tools and, 890
presets, 111
tracks, 479–480, 553–554, 657

locked tracks control, 657
Lock Track control, 448, 479, 513, 553–554
Log10 function, 1247
log and capture process, 222–230, 1372. See also 

capturing process; logging process
Log and Capture window, 225–250

AppleTalk and, 47
batch captures, 275–278
capture preferences, 262–263
controls in, 88, 225–230
log and capture buttons, 77–78, 229
marking controls, 226, 228
opening, 77, 225
performance and, 47
playhead controls, 227–228
tabs in, 229, 230–240
transport controls, 227
using, 151

logarithmic sliders, 1028
Log Bin button, 233
Log Bin controls, 233
log bins, 151, 224, 254–255, 1372
Log button, 225
Log function, 1247
logging columns, 201
Logging Info tab, 213
logging process. See also capturing process

batch capture lists, 152
benefits of, 150–151
changing clip settings, 240, 264–265
described, 18, 145, 147, 222, 1372
keyboard shortcuts for, 258, 1310, 1324
Log and Capture window, 151
logging clips, 150–152, 255–258, 323, 324–325
logging media, 251–258
logging video, 222
setting up for, 230–250
tips for, 258
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Logging tab, 230–236
Log Note column in Browser, 170, 546
Log Note field, 235
Log Note property for a clip, 213
longitudinal timecode (LTC), 36, 37, 130, 149
looped playback, 79, 350, 430–431, 1372
looping sequences, 1117
lossless codecs, 155, 1104, 1110
lossy codecs, 147, 1110
Lower 3rd generator, 1060
Low Pass filter, 846
Low Shelf filter, 846
LTC (longitudinal timecode), 36, 37, 130, 149
luma, 1372
Luma Key filter, 1047
Luma option, 935
luminance, 1373
Luminance Map transition, 647, 1354

M

Mac OS updates, 21
MacPaint format, 19, 1150
magnified images, 363
Make File Names Unique option, 315
Make Movie Self-Contained option, 305, 1109, 1151, 

1153
Make Offline command, 220
Make Offline dialog box, 220, 879
MakeRect command, 1249
MakeRegion command, 1249
Make Subclip command, 399
map transitions, 647
Mark Clip button, 90, 337, 375, 432
marker icon, 172
Marker list for logged clips, 236
marker overlays, 385, 393
markers

adding to clips, 394, 522
adding to sequences, 521
in Canvas, 520–527
clip markers, 520–521
controls for, 90
defining subclips with, 389
deleting, 395, 524
described, 392–393, 1373

extending duration of, 398–399, 526–527
keyboard shortcuts for, 1312
logging, 236
moving, 396–397, 525–526
moving clips with, 524
moving frame to, 394
moving playhead to, 394, 470, 525
moving with timecode, 397
renaming, 396
sequence markers, 521
setting for clips, 90
setting for In and Out points, 374, 375, 548–549
setting for sequences, 90
in Timeline, 470, 520–527
turning into subclips, 399
in Viewer, 392–401
working with, 392–401

Mark Good option, 235
Mark In and Mark Out button, 337, 338
Mark In button, 90, 228, 374, 432–433, 710
marking controls

Canvas, 90, 431–433
device control, 228
Edit to Tape window, 1127–1128
keyboard shortcuts, 338
Log and Capture window, 228
Logging tab, 235–236
Viewer, 90, 328, 337–338

Mark in Sync command, 724–725, 761
Mark menu, 497
Mark Out button, 90, 228, 374, 432–433, 710
Mark Selection command, 497
Mark Split command, 377–379
MaskCopy command, 1254
Mask Feather filter, 1048
Mask Shape filter, 1049
masks, 1373
master clips. See also subclips

breaking into subclips, 386, 387
defined, 1373
finding original for subclips, 387–388
unused footage and, 391–392
working with, 344

Mastering mode, 1127, 1138, 1373
Mastering Settings tab, 1126
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master monitoring volume, 783
master tapes, 741, 1192
matchboxes, 25
Match Frame button, 90, 337, 431
Match Frame command, 600–601
match frame editing, 600–601, 1373
Match option, 203
MatrixConcat command, 1271
Matrix Wipe transition, 648
Matrox real-time video card, 48–49
Matte Choker filter, 1049
Matte command, 1261
matte filters, 1048–1049
MeasureString command, 1269
MeasureStringPlain command, 1269
media. See also digital media; source media

acquiring, 77–78
adding colored labels to, 63
anamorphic. See anamorphic media
backing up, 175
Canvas and, 422
capturing, 223
defined, 1373
distribution, 77, 79–80, 1097–1111
Easy Setup for, 52–55
importing, 287–311
labeling, 897–898
logging, 251–258
logging and capturing, 221–286
management tools for, 81, 855–881
moving to new disk, 866–868
options, 1122
organizing, 159, 184–190
playing at varying speeds, 353–354
reconnecting clips to, 214–219, 871–878
reestablishing links, 871–878
removing unused, 864–865
storing on scratch disks, 899–902
unused, 202, 864–865
used in Final Cut Pro, 145
utilities for, 855–881
Viewer and, 422

media elements, 1122, 1130
Media End column in Browser, 170, 1208
media files

finding, 881
importing into Final Cut Pro, 288–291
reconnecting clips to, 214–219, 872–878

“Media limit” message, 668, 673, 676
Media Manager, 859–870

deleting unused media, 391–392
described, 81, 855
errors, 870
examples, 864–870
opening, 81
operations in, 863
recapturing clips, 154, 279
settings in, 862–863
using, 859–861

Media Manager window, 860, 862–863
“Media Offline” message, 872
Media section of Timing tab, 212
Media Start column in Browser, 170, 1208
memory

allocated to Final Cut Pro, 49–51, 1296
defined, 1375
dropped frames and, 1289
extensions for, 47
real-time PCI cards and, 1091
requirements for, 22, 49
undo function and, 534
undo levels and, 886
video capture cards and, 22, 49
virtual memory, 1289, 1294

MeshBlit command, 1253
MeshBlit3D command, 1253
Mesh command, 1248
messages

“Break in the Timecode,” 1292
device control status, 248–249
during EDL export, 1206
“Insufficient content for edit,” 668
“Media limit,” 668, 673, 676
Media Manager, 870
“Media Offline,” 872
“Servo Can’t Lock,” 1292
trimming operations and, 668

microphone, 819, 848
microphone jacks, 25, 285, 819
microphone popping, 848
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microUDF file system, 1100
mini-DV format, 146, 1198
mini-DV timecode, 356–357
miniplug, 25
Mirror filter, 1050
Mirror on Desktop option, 135, 136, 1290
mixdown audio, 815–816, 1081
Mixdown Audio command, 815–816, 1081
mixing audio. See audio mixing
M-JPEG A codec, 147, 1105
M-JPEG B codec, 147, 1105
M-JPEG codec, 147, 1105, 1110
M-JPEG video, 30, 42
modifier keys, 1317–1323
monitor. See also NTSC monitor; PAL monitor

4:3 monitor, 1351
16:9 button, 1343
broadcast monitors, 1357–1359
calibrating with color bars, 1357–1359
color and, 22, 1357–1359
connecting to computer, 23
problems with, 1288–1289, 1293
record monitor, 1375
refresh rates and, 1289
second computer display, 23
source monitor, 1376
standard definition (SD), 298

monitoring speakers, 783
mono, 1373
Mono Mix option, 239
More option for searches, 203
motion bar, 446, 457, 896, 961–963
MotionBlur command, 1256
Motion Blur parameter, 943
Motion Blur settings, 942–943
motion effects, 940–980

animating, 69
controls for, 941–944
creating favorites, 1019–1020
described, 905, 907, 940
examples, 944–961
settings, 333, 941–961, 963–980

Motion JPEG, 19, 115, 116, 1105
motion paths

adding keyframes to, 1008

Bezier curves and, 1009–1013
controlling speed along, 1013–1018
creating, 1006–1013
defined, 1373
deleting keyframes in, 1009
keyframed motion paths, 1003–1018
moving keyframes in, 1008

motion settings, 69, 333, 941–961
Motion tab, 941–961

adjusting clip opacity, 916–917, 997–1001
described, 69, 330, 333
examples, 944–961
keyframe controls on, 983–986
settings in, 941–961
shortcut menus, 1333
working with keyframes, 987–992

mouse, 326
Move into Sync option, 451, 722
movies. See also QuickTime movies

analyzing, 856–858
animation movies, 155, 1104
AVI movies, 1167–1170
exporting, 1109, 1151–1153
Fast Start movies, 1102
iMovies, 150
reference movies, 305, 1109, 1151–1153, 1295
self-contained movies, 305, 1109, 1151–1153
streaming movies, 1102
uncompressed movies, 155

MP3 audio files, 307
MPEG, 1373
MPEG-2 codec, 1100
MPEG-2 encoder, 1100
multichannel mixers, 24
Multi-Frame Trim Size field, 887
Multiply command, 1261
Multiply compositing mode, 931–932
Multi Spin Slide transition, 649, 1354
music

mixing, 784
stereo, 804
synchronization, 819
tips for cutting, 851–852

music editing, 761
music tracks, 853
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N

Name bar, 835, 1026
Name column in Browser, 66, 167
Name field for clips, 114, 122, 129, 234
narratives, 253
navigation

in Browser, 181
in Canvas, 89, 427–431
clips, 89
in Edit to Tape window, 1127–1128
keyboard shortcuts, 470–471, 1306–1307, 1317
playhead in Timeline, 468–471
sequences, 73, 89
with timecode values, 93, 469
in Timeline, 73, 446–447, 468–471
in Viewer, 89, 352–355

nested items
audio clips, 843–844
audio tracks, 843–844
filtered clips, 1040

nested sequences, 937–940
alpha channels and, 1090
described, 907, 1373
EDLs and, 1201–1202
preserving render files, 1090
uses for, 937–938

Nest Items command, 939–940
New Bin button, 233
New Project command, 174
Next Edit button, 88, 336, 337, 708
NeXT format, 1149
Next Frame button, 708
noise, background, 733, 851
Noise generator, 1059
noise reduction filters, 826–827
Non-Additive Dissolve transition, 647, 1353
non-controllable devices, 35, 230
nondestructive editing, 17
non-drop frame timecode, 91–92, 356, 1373
None option for external video, 134, 135
non-interlaced video, 1373
nonlinear editing, 17, 1373
non-square pixels, 296–298, 366–367, 968
Normal compositing mode, 930

Notch filter, 846
NTSC FireWire DV camera, 53
NTSC format

contrast levels, 1358
defined, 1374
drop frame timecode and, 894
Setup waveform level, 1364
timecode and, 91, 356

NTSC monitor, 22–23
action/title safe boundaries, 371–372
anamorphic media and, 1341
problems with, 23, 1288–1289

NumToString command, 1268

O

offline, defined, 1374
Offline Clip icon, 172
offline clips

breaking links to, 871–872, 878–879
described, 17–18, 151, 214, 224
finding, 874
illustrated, 151, 871
logging and, 151, 152
moving and, 214
reestablishing links, 214–219, 871–878
renaming files and, 182, 214
using, 219–220
vs. missing clips, 879
vs. online clips, 224

Offline column in Browser, 170
offline editing

capturing video for, 153
data rate and, 152, 153
described, 152, 1191, 1374

offline files, 871–879
Offline Files dialog box, 215
Offline Files window, 875–877
Offline Items in Logging Bin option, 276
Off option for external video, 137
Offset3d command, 1252
Offset command, 1252
Offset parameter, 943
OffsetPixels command, 1260
OMF Audio Export command, 1100
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OMF export
audio files, 284–285, 1107, 1218–1221
audio tracks, 158, 1107

OMF files, 284–285, 1107, 1221
Omit search option, 203
online clips, 151, 224
online editing, 17–18, 152, 1191
onscreen help, 8–10
opacity

adjusting, 997–1002
adjusting in Timeline, 912–918
compositing modes and, 929

opacity overlay, 1001–1002
Opacity parameter, 942, 943
Opacity settings, 942
Open command, 177
Option key

dragging items and, 508
modifying commands with, 508
pen tools, 805–806, 983

options. See settings
Options button, 135, 136
Out column, 169
out-of-sync indicators, 451, 474, 717–720
Out points

defined, 1374
moving playhead to, 382, 558, 559
setting for audio/video, 762
setting with clip duration, 375

Out property, 212
output, defined, 1374
output features, 1315
Outset3d command, 1252
Out Shift indicator, 709
Oval Iris transition, 1354
OvalRegion command, 1249
Oval transition, 647
Overlay command, 1261
Overlay compositing mode, 933
overlays, 382–385

adjusting, 797, 807, 838, 990–991
audio overlays, 1216
clip overlays, 896
described, 370
displaying, 383–385, 767–768

Edit Overlay, 72, 80, 440, 564
hiding, 385
keyframe overlays, 445, 896–897
level overlay, 788
marker overlays, 385, 393
opacity overlay, 1001–1002
pan/spread overlay, 751, 792
in Viewer, 382–385
viewing, 385

overscanning, 371
overwrite editing

copying/pasting clips, 671–672
described, 536, 1374
dragging clips, 670
pasting items as, 508
performing, 569–571, 584–585, 670–672
in Timeline, 584

overwrite with transition editing, 536, 571–573, 607

P

PagePeel command, 1254
Page Peel transition, 647, 1354
PAL equipment, 29
PAL format

contrast levels, 1358
defined, 1374
Setup waveform level, 1364
timecode and, 356

PAL monitor, 22–23
action/title safe boundaries, 371–372
anamorphic media and, 1341
problems with, 23, 1288–1289

PAL video format, 19
pan

adjusting for clips, 790–792
changing in Timeline, 811
controlling with keyframes, 793–799, 

801–804
setting in Viewer, 789–792
tips for working with, 804

Panasonic RS-232 protocol, 37
Panasonic RS-422 protocol, 37
Pan slider, 749, 790, 791
Pan/Spread Keyframe button, 750, 794
Pan/Spread keyframe navigation buttons, 750, 794
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pan/spread overlay, 751, 792
Pan/Spread slider, 749–750, 789–792
Parametric Equalizer filter, 846
Particle Noise generator, 1059
partitions

arrays, 33
multiple, 29
naming, 163

Paste Attributes command, 519–520, 961, 1035
Paste Attributes dialog box, 517–520, 832, 949, 1035
Paste command, 182
pasting clips

attributes, 517–520
overwrite edits, 671
in Timeline, 509–511

Paste Insert command, 672
patch panel, 26, 43
paths, motion, 1373
PCI cards, 1091–1093
peak light, 740
Pen Delete tool, 655, 982, 1318
Pen Smooth tool, 655, 982
Pen tool, 655, 982, 983, 989, 1318
pen tools, 805, 890, 983
Pen tools setting, 890
performance

DV playback and, 350
extensions for, 47
fragmentation and, 1290
mixdown audio and, 1081
problems with, 1294
recommendations, 47–48
working with projects, 173

perspective filters, 1050
Photo JPEG format, 19, 116, 156
Photoshop files, 157, 306
Photoshop format, 19, 1150
PICT format, 19, 156, 1150, 1374
Pixel Aspect column in Browser, 170
pixel aspect ratio, 114, 115, 296–297, 1374
Pixel Aspect Ratio setting, 115, 211

pixels
defined, 1374
graphics creation and, 295–296
non-square, 296–298, 366–367, 968
square, 296–298, 366–367, 968

plain media bars, 62
Play Around Current button, 61, 88, 227, 336, 430
Play Around Edit Loop button, 708
playback. See also playhead

codecs and, 146
dropped frames and, 61, 889
of every frame, 430
keyboard controls, 88
Log and Capture window, 226
looping, 79, 350, 430–431, 1372
options, 429–431
problems during, 1288–1293, 1295
quality of, 146, 350–352, 423–424
speed of, 1062–1063
stopping, 347
testing, 1116
from Timeline, 1108
in Trim Edit window, 708–709
viewing options during, 134–135

Playback Offset field, 132
Play button, 88, 227, 336, 347, 429, 708
Play command, 1118
Play Every Frame command, 430
playhead. See also playback

in Canvas, 89, 425, 427–431, 470–471
described, 335
extending marker duration, 399, 527
jumping, 469
in Log and Capture window, 227–228
moving forward and backward, 358
moving markers with, 396–397, 525
moving to edit point, 470, 558
moving to In and Out points, 382, 558, 559
moving to marker, 470
moving to marker frame, 394
moving to specific location, 469
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moving with timecode, 355, 358–359
navigating between keyframes, 796, 989
navigating in Timeline, 468–471
playing clips around current position of, 349
positioning in Timeline, 469
positioning on sequence marker, 522–523
positioning with ruler, 469
stopped, 395
in Timeline, 446
in Viewer, 89, 328, 329, 335–336

playhead controls, 89, 227–228
playing audio, 759–760
playing clips

around current playhead position, 349
keyboard shortcuts for, 1310
between In and Out points, 348–349
playing every frame, 349
in reverse, 348, 1062, 1063
at varying speeds, 353–354
in Viewer, 347–349

Play In to Out button, 88, 227, 336, 429, 708
pluge bars, 1358
PNG format, 19, 1150
point3d data type, 1245
Point controls, 1028–1029
point data type, 1245
Point Iris transition, 1354
Point statement, 1279
PointTrack command, 1272
PondRipple command, 1259
Pond Ripple filter, 1043
Popup statement, 1279
ports

FireWire, 21, 23, 38
sound input, 158

Port setting, 130
poster frames, 195, 199–200, 389–390
Posterize filter, 1051
post-production process, 15, 18–19, 20, 1374
post-roll settings, 61, 131, 891
Power function, 1247
Power Mac G4 computers, 32, 350, 351, 423, 424
Power Macintosh G3 computers, 32, 350, 423, 1293

preferences, 60–63, 883–902. See also settings
autosave, 176
capture, 262–264
described, 100
general, 61, 884–891
labels, 63, 884, 897–898
scratch disks, 63, 884, 899–902
setting, 61–63, 884
tabs for, 884
Timeline, 62, 454–459, 884, 894–897
user mode, 884, 892–893
video devices and, 21

Preferences window, 53, 60, 883–902
pre-roll settings, 61, 131, 890
Preset Editor window, 109, 110
presets, 58–59, 104–132. See also Easy Setups; 

settings
audio settings, 59
capture presets, 104, 105, 107, 121–127
choosing, 104–106
creating, 108–109
deleting, 111–112
described, 99, 100, 1374
device control presets, 104, 106, 108, 128–132
editing, 110
Edit to Tape operations, 1131
installing, 112–113
locking, 111
obtaining additional, 112–113
sequence presets, 104–107, 113–120, 416–417
video settings, 59
viewing settings for, 106–108
working with, 104–113

Preview area of Log and Capture, 77
previewing transitions, 644–645
Preview Post-roll setting, 61, 891
Preview Pre-roll setting, 61, 890
Previous Edit button, 88, 336, 429, 708
Previous Frame button, 708
Primary Scratch Disk option, 52
printing to video, 1108, 1119–1122
Print to Video command, 79, 1108, 1113, 

1118–1123, 1374
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Print to Video window, 79
problems. See troubleshooting
Proc Amp filter, 1044
Process Maximum White As setting, 120
Processing Amplifier (Proc Amp), 1363
ProducesAlpha statement, 1281
programs, third-party, 10, 56
progressive scanning, 293
project files

backing up, 175
naming schemes, 252–253
reestablishing links, 871–878

projects
adding bins to, 185
adding clips to, 347
adding clips to open projects, 347
adding new sequences, 418
autosaving open projects, 61, 887
changing properties of, 178–179
closing, 177–178
copying sequences between, 421
creating, 173–174
deleting items from, 182
described, 16, 161, 1375
distribution, 1097–1111
documentary-style, 253
dragging sequences between, 421
dynamic range, 782
importing audio into, 742–743
monitoring audio levels, 783
narratives, 253
opening, 177
organizing, 159, 184–190
performance issues, 173
reconnecting links, 214–219, 871–878
redoing changes in, 97
removing unused media from, 864–865
saving, 61, 174–176, 887
searching for items in, 202–208
theatrical distribution, 1099
undoing changes in, 97
unused media in, 202
updating earlier versions of, 163–166, 1085–1086
working with, 173–179

Project tab, 1326–1327

Prompt box, 234
properties

changing clip properties, 208–213
changing project properties, 178–179
modifying item properties, 530
viewing clip properties, 208–213
viewing item properties, 530

Protocol setting, 129–130
Push Slide transition, 649, 1354
Push transition, 648

Q

QDesign audio files, 307
QTEffect statement, 1281
Quality setting, 117, 118, 123, 125
QuickTime, 1145–1190

action/title safe boundaries and, 371, 372
described, 45, 1375
exporting anamorphic media to, 1352
file formats. See QuickTime file formats
filters, 1161
installing, 45
sample rates, 888, 1291
settings. See QuickTime settings
sound settings, 1162–1163
types of output, 1145–1147
video settings, 1159–1162
Web site for, 12

QuickTime codecs, 146, 147, 1111
QuickTime Compression Settings dialog box, 

1110, 1111
QuickTime Fast Start movies, 1102
QuickTime file formats

audio files, 1149
image files, 1150
video files, 1148

QuickTime files
alpha channels and, 294–296, 918
analyzing, 856, 858
compression, 1154–1156
digital delivery, 1103–1106
export formats, 1157
exporting, 1100, 1154–1171
exporting for DV streaming, 1170–1172
exporting in AVI format, 1167–1170
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exporting in FLC format, 1165–1166
field dominance and, 292–293
frame size, 1155–1156
hinted, 1163–1164
iMovie and, 150
importing, 154–156, 291–296
Internet streaming, 1163–1165
outputting, 1109
rendering and, 150
streaming over Internet, 1102, 1163–1165
vs. DV Stream files, 150

QuickTime filters, 1161
QuickTime Image format, 19, 1150
QuickTime Movie format, 1148
QuickTime movies. See also movies

analyzing, 856, 858
compression, 1109
converting numbered image sequences into, 

304–305
described, 1103
distributing on Web, 1101–1103
exporting, 1109, 1157–1165
outputting, 1101–1103, 1109
save options, 305
types of, 154
uncompressed, 1103–1104
for Web, 1101–1103

QuickTime Pro
converting numbered image sequences, 304–305
registering, 46–47
serial number, 1296

QuickTime settings, 1159–1165
audio, 117–119, 124–127, 1162–1163
capture presets, 121–127
sequence presets, 116–119
video, 116–119, 122–123, 1159–1162

QuickTime streaming video, 19, 1101–1102, 1375
QuickTime transitions, 648–649

R

RadialBlur command, 1256
Radial Blur filter, 1041
Radial transition, 649
RadioGroup statement, 1279
RAIDs (Redundant Array of Independent Disks), 

34, 1375
RAM. See memory
Random command, 1271
Random Edge Wipe transition, 650, 1355
RandomNoise command, 1272
RandomSeed command, 1271
RandomTable command, 1271
Range Selection tool, 492–494, 655, 659–660, 1317
Rate setting, 117, 119, 124, 126
Ratio slider, 825, 826
ratio variable, 1277
raw data, 1375
Razor Blade All tool, 701, 703, 1318
Razor Blade tool, 701–702, 1318
Razor Blade tools, 655
RCA connectors, 25, 27
real-time audio mixing, 812–816, 887, 1289
Real-time Audio Mixing setting, 887
real-time editing, 1091–1092
real-time effects, 1069, 1082, 1091–1093, 1375
real-time generators, 1057
real-time PCI cards, 1091–1093
real-time video cards, 26, 49, 1082
Recapture option for EDL import, 315
recapturing clips

with device control, 149, 175
from imported EDLs, 316
manually, 148
with Media Manager, 279–280
for online input, 154
without device control, 148

Recent Clips pop-up menu, 329, 339, 346, 624, 886
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Reconnect Media command, 214, 217, 224, 855, 
871–878

Reconnect option for EDL import, 315
record monitor, 1375
recording process. See also capturing process

audio levels during, 735–740
Print to Video command, 1113, 1119–1122
recording anamorphic media, 1345
recording audio, 158–159, 735–737
recording from Timeline, 1113, 1116–1119
recording to videotape, 1113–1122
setting up for, 1114–1116
viewing options during, 135–136

Rectangle Iris transition, 1354
Rectangle transition, 647
redigitizing, 1375
Redo command, 97, 534
redo function, 97, 534
Redundant Array of Independent Disks (RAIDs), 

34, 1375
Reel column in Browser, 170
Reel field, 233
Reel property for a clip, 213
reels

information about, 233
names of, 232, 1195, 1198–1199
numbers, 17, 230–231

reference levels, 736–740
reference movies, 305, 1109, 1151–1153, 1295
RegionCopy command, 1253
region data type, 1245
RegionIsEmpty command, 1250
registering QuickTime Pro, 46–47
Release time control, 825, 826
Remote control, 35
removable media drives, 30
removable storage media, 288
renaming items

bins, 182
clips, 182
favorites, 640, 780
files, 182
markers, 396
sequences, 182

Render All command, 1082

render bars
colors in, 532, 841, 1066–1067, 1093
described, 643–644, 815
filters and, 840–842
indicators in, 531–532, 1066–1067
real-time PCI cards and, 1093
regions in, 531

RenderEachFrameWhenStill statement, 1282
Rendered Frames option, 133, 134, 135
render files

audio render files, 843–844
deleting, 165, 481, 880–881, 1086, 1088, 1089
invisible tracks and, 481, 889, 1090
location of, 1070, 1088
managing, 82, 1087–1090
preserving, 843–844, 1089–1090
saving to scratch disk, 52, 55
storage locations for, 899–902, 1087
Undo command and, 1086
updating projects and, 165
viewing, 1089

rendering, 1065–1090
anamorphic media, 1350
audio, 786, 1079–1081
audio filters, 840–842
avoiding need for, 1069
basics of, 1065–1068
batch rendering, 1078
controlling, 136–137
cuts and, 1069
defaults for new projects, 1075
described, 643, 1065, 1091, 1375
disabling, 1078–1079
DV Stream files, 150
effects, 842
external display option, 136–137
generators and, 1057
order of, 1068
planning for, 1068–1069
previewing effects, 1076
printing to video and, 1115, 1116
quality levels for, 1069, 1070–1075, 1115, 1135
QuickTime files and, 150
real-time effects, 1069, 1082, 1093
reducing time for, 1069
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render quality settings, 1070–1075
sequences, 1077–1078
settings for, 1070–1075
single frames, 137
source media, 1066
time required for, 1068
transitions, 643–645, 840–842
video, 1076–1079
in YCrCb color space, 1083–1086

Render Manager, 82, 855, 880–881, 1088–1089
Render Quality command, 1073
Render Quality Editor, 1071–1075
Render Quality pop-up menu, 449, 481
renderRes variable, 1277
Render Selection command, 1082
render status bar, 449
Repeat While statement, 1283
Repeat With Counter statement, 1283
Repeat With List statement, 1284
replace editing

described, 536, 1375
edit points and, 545
examples, 575–578
In and Out points and, 573–574
performing, 573–578
replacing clip contents, 577–578
replacing clips in Timeline, 575
resynchronizing audio/video clips, 576
rules for, 573–574

Replace Find Results option, 203
Replicate filter, 1051
Report Dropped Frames setting, 61, 264, 889
Reset button, 629, 750, 794, 822, 836
ResetText command, 1270
resize editing, 634, 674–676
resolution

anamorphic video, 1344, 1345
animation, 1021
audio clips, 757
capturing clips and, 148
graphics clips, 908, 1021–1022
images, 1021–1022

Results option, 203
Return statement, 1285
Reverb filter, 828–829, 847

Reverse Alpha column in Browser, 170
Reverse Alpha property, 211, 919
reverse play, 348, 1062, 1063
Reverse Transition button, 629
Rewind button, 227
RGB channels, 368–369
RGB color space

Component RGB, 27–28
compositing and, 1083
updating projects and, 163, 164, 1375
working in, 1083

RGB format, 1358
RGB mode, 368, 964
RGBColorKey command, 1265
RGBtoYUV variable, 1278
Ripple command, 1259
ripple deletes, 602–603, 687–688
Ripple Dissolve transition, 647, 1354
ripple editing

adjusting clip length, 635–636
described, 602, 681, 1375
performing, 516–517, 604
performing in Timeline, 682–683
performing in Viewer, 683
rippling multiple tracks, 685
synced clips and, 684, 689
tips for, 685

Ripple Edit tool, 655, 681, 1318
Ripple filter, 1043
roll editing

changing transition location, 634–635
described, 677, 1375
performing in Timeline, 677–678
performing in Viewer, 679
rolling multiple tracks, 679
tips for, 679
transition bar and, 626

Roll Edit tool, 655, 677, 1318
room tone, 761, 771–774, 848
Rotate3d command, 1252
Rotate command, 1252
Rotate filter, 1050
rotating clips, 971–972
rotational handle, 966
Rotation parameter, 941
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rotoscoping, 1376
rough cuts, 55, 325
rough editing, 19, 1376
RS-232 interface, 36, 40, 149
RS-422 interface, 36, 40, 149
RT-11 disks, 1206
ruler

keyframe graphs, 836, 1027
positioning playhead with, 469
Timeline, 446
Transition Editor, 625
Viewer, 750–751

S

Same as Playback option, 135
sample rates

capturing audio and, 730–731
described, 730–731
importing audio and, 307–309
mismatched, 887–888, 1295
OMF audio, 1220
QuickTime, 888, 1291
Sync Adjust Movies setting, 887–888

samples, 816
Samples parameter, 943
sampling, 1376
saturation, 1376
Saturation slider, 1362
Save All command, 174
Save command, 887
Save Normally option, 305
Save Project command, 174
saving items

autosave feature, 175–176, 887
cache files, 52, 55
clips, 52, 55
files, 887
projects, 61, 174–176, 887
QuickTime movies, 305
render files, 52, 55
to scratch disk, 52, 55

Scale3d command, 1252
Scale Attribute Times option, 518, 832
Scale command, 1252
Scale/Distort handles, 966

Scale parameter, 941
Scale to Sequence command, 1022
scaling items

anamorphic media, 1343
clips, 969–970
graphics, 299–300

SCART connector, 29
Scene column in Browser, 170
Scene field, 234
Scene property for clips, 213
scratch disks. See also hard disk

defined, 1376
preferences, 63, 274, 884, 899–902
redefining, 262–263
removing, 902
separating audio and video, 901
setting up, 52, 55, 899–902

Scratch Disks button, 262
Scratch Disks tab, 63, 884, 899–902
Screen command, 1261
Screen compositing mode, 932
screen layouts, 94–96, 1308
scripting

described, 1225
rules for, 1236

scripts. See also FXBuilder
applying in Timeline, 1233
building, 1226–1227
coding, 1226
creating, 1230–1231
customizing, 1238
described, 1225, 1376
for devices, 1288, 1293
encoding, 1234
examples, 1236–1238
exporting, 1234–1235
exporting as text, 1234
input controls in, 1227, 1228, 1237
installing, 1235–1236
modifying effects with, 1229
naming, 1230, 1237
opening, 1230–1231
planning, 1226
structure of, 1226, 1236–1238
testing, 1226, 1231–1233
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updating projects and, 164
using in Final Cut Pro, 1235
viewing code, 1230–1231

scrolling
keyboard shortcuts for, 1307
through audio clips, 756–757
through sequences, 464–465
through tracks, 465–468
in Timeline, 464–468, 465
in Viewer, 363

Scrolling Text generator, 1061
scrubber bar, 89, 328, 335, 352–353
scrubbing

audio scrubbing, 757–760
defined, 1376
in clips, 197–198, 352–353
in sequences in Timeline, 469
in thumbnails, 195, 891

Scrub tool, 1318
Scrub Video tool, 197–198, 655
SCSI cables, 33
SCSI disk arrays, 33–34
SCSI disk drives, 31–32
SCSI interface cards, 33
SD (standard definition) video, 298, 366
SDI (Serial Digital Interface) format, 19, 28
search feature. See finding items
Search option, 203
SECAM standard, 22, 1376
Select All Tracks Backward tool, 493, 499, 661, 1317
Select All Tracks Forward tool, 493, 499, 661, 1317
Selected Items in Logging Bin option, 276
Selection tool, 197, 492, 494, 658, 1317
selection tools, 655, 658–666
Select Preset option, 315
Select Track Backward tool, 493, 498, 660, 1317
Select Track Forward tool, 493, 498, 660, 705, 1317
Select Track tool, 493, 498, 660
self-contained movies, 305, 1109, 1151–1153
Sepia filter, 1045
sequence clips, 503–505

opening, 600–601, 752
working with, 344

sequence controls, 89, 427
sequence icon, 171

sequence markers, 521, 522–523
sequence marking controls, 425, 426
Sequence Preset Editor, 113–120
sequence presets, 113–120

audio settings, 117–119
choosing, 890
default choices in, 105
described, 104, 113
general settings, 114–115
new sequences and, 890
QuickTime settings, 116–119
video settings, 116–117, 120
viewing, 107

sequences, 404–421
adding markers to, 521
adding split clips to, 552–553
adding to current project, 418
adding tracks to, 475–477, 586
anamorphic video and, 1348–1350
applying composite mode to, 929
applying scripted effects to, 1233
applying transitions to in Timeline, 631–632
batch exporting, 1109, 1178–1190
Canvas and, 64
changing settings for, 405, 415–417
changing transition alignment in, 621
changing transition duration in, 620
closing, 419
copying between projects, 421
creating, 417–418
deleting from projects, 182, 418
deleting tracks from, 477–478
deleting transitions from, 618
described, 16, 162, 1376
dragging between projects, 421
duplicating, 420, 535, 1213
duplicating for recapture, 869–870
editing clips into, 485, 538–539
exporting, 1172–1174
exporting as batch lists, 1209
exporting as EDLs, 1193–1194, 1202–1206
exporting audio from, 1177–1178
gaps in, 511–514, 540–541, 704
importing, 156–157
jogging through, 471
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length of, 16
letterboxing, 1351
locked tracks in, 479–480
looping, 1117
matching audio for, 90
matching video for, 90
moving clips in, 669–676
moving to new disk, 866–868
moving transitions in, 617
navigating, 73, 89
nested, 907, 937–940, 1373
numbered, 157, 302–305, 1106, 1172–1174
opening, 419
opening clips from, 344–345, 666–667
output of, 1106
outputting to videotape, 1108
playing, 88
presets for, 416–417
printing to video, 1108
QuickTime clips and, 291
redoing changes in, 97
removing clips from, 602–604
removing unused media from, 864–865
renaming, 182
rendering, 1077–1078
rendering audio in, 1079–1081
rendering transitions in, 644–645
replacing transitions in, 616
scrolling through, 464–465
scrubbing, 469
searching for items in, 528–529
setting In and Out points for, 90
setting keyframes for, 90
setting markers for, 90
settings for, 61, 291, 405–417
shuttling through, 470–471
sorting, 183–184
testing, 534–535, 886
timecodes, 894
Timeline and, 64
Timeline settings, 409–413, 454–459, 894
transitions in, 606–615
undoing changes in, 97
updating earlier versions of, 166
video processing settings, 414–415

Sequence Settings command, 173
Sequence Settings window, 405–414, 768
serial cables, 37
serial device control

accuracy of, 35
described, 149
DV system setup, 40–41
guidelines, 248
Protocol setting, 130
using, 36–37

Serial Digital Interface (SDI) format, 19, 28
serial numbers, 1296
“Servo Can’t Lock” message, 1292
Set Field statement, 1282
Set Marker button, 235
Set Marker In field, 235
Set Marker Out field, 235
SetPixelFormat command, 1273
Set statement, 1282
SetTextFont command, 1269
SetTextJustify command, 1269
SetTextSize command, 1270
SetTextStyle command, 1269
settings. See also Easy Setups; preferences; 

presets; specific settings
alpha channels, 918–919
audio, 59, 310, 331, 742, 1178
AVI QuickTime files, 1168–1169
Batch Capture dialog box, 276–277
batch exports, 1181–1188
capture, 261–265
Capture Preset Editor, 281
capture presets, 121–127
clip speed, 1063
clips, 241–245, 264–265
compositing, 926–937
described, 99, 100
device control presets, 128–132
Edit to Tape, 1126–1131
EDL export, 1203–1206
EDL import, 315–316
effects, 332
external video, 132–137
film transfer facilities and, 1099
filters, 69, 332
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Filters tab, 1026–1027
FLC QuickTime files, 1166
general, 406–408, 884–891
generators, 70, 334
image sequences, 1172–1174
Internet streaming, 1163–1165
keyframing, 982–986
labels, 897–898
Media Manager window, 862–863
motion, 69, 333, 941–961, 963–980
Motion tab, 941–961
paste attributes, 1035
Play command, 1118
presets, 106–108
Print to Video, 1121–1122
QuickTime, 1159–1165
QuickTime sound, 1162–1163
QuickTime video, 1159–1162
render quality, 1070–1075
scratch disks, 899–902
sequence presets, 113–121
sequences, 61, 291, 405–417
still images, 1176
timecode, 342
Timeline, 894–897
Timeline Options tab, 409–413, 454–458
Timeline recording, 1118
transitions, 629
trim edits, 655–656
Trim Edit window, 707–710
user mode, 892–893
video, 59, 132–137
video filters, 1026–1027
Video Processing tab, 414–415
YCrCb color space, 414–415, 1084–1086

Settings button, 1182–1185
Setup waveform level, 1364
SGI format, 19, 1150
Sharpen filter, 1050
sharpen filters, 1050
Shift key, 495, 994
shortcut menus, 1325–1340. See also keyboard 

shortcuts
Browser, 1325–1327
Canvas, 1336–1339

timecode navigation, 93
Timeline, 1334–1335
using, 84–85
Viewer, 1328–1333
viewing, 84–85

Shot/Take column in Browser, 171
Shot/Take field, 213, 234
Show as Sq. Pixels setting, 367, 434
Show Audio Waveforms option, 62, 458, 897
Show Filter and Motion Bars option, 896
Show Keyframe Overlays option, 458, 896–897
Show option, 216, 218
Show Preview option, 216, 218
Show ToolTips option, 889
shuttle control

Canvas, 89, 425, 426, 427–428
Log and Capture window, 227
Viewer, 89, 328, 335, 353–354

shuttling
through audio clips, 759–760
through clips, 353–354
through sequences, 470–471

signal-to-noise ratio, 733
Sign function, 1247
Sin function, 1246
Single Frames option, 137
Size column in Browser, 171
Size setting, 119, 126
Skip All command, 217, 219
Skip command, 217, 219
slate, 1121, 1129–1130
Slate button, 233, 234
Slide Item tool, 655, 692, 693, 1318
slider controls, 944, 1028
Slider statement, 1278
Slide transition, 649
slide transitions, 649
sliding clips, 692–695
slip editing, 380–381, 819–820
Slip into Sync option, 451, 723
Slip Item tool, 381, 655, 690, 1318
slipping

clips, 690–695, 715
edit points, 763
In and Out points, 380–381
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Slug generator, 1057
slugs, 1376
SMPTE standard, 149, 1353, 1365, 1376
SMPTE timecode, 356–357
snapping

in Timeline, 500–501
trimming and, 657
turning on/off, 501
in Viewer, 335

Snapping control, 450, 657
Soft Edges filter, 1049
Soft Light compositing mode, 934
Softness parameter, 943
software, third-party, 10, 56
Solarize filter, 1051
Sony 5000 format, 231, 316, 1193, 1198, 1201
Sony 9100 format, 231, 1193, 1198, 1201
Sony LANC protocol, 37
Sony RS-232 protocol, 37
Sony RS-422 protocol, 37
Sony VISCA protocol, 37
Sorenson codec, 1156
Sorenson format, 19, 1101
sorting items

bins, 183–184
in Browser, 183–184
clips, 183–184, 189, 546, 898
with labels, 189
sequences, 183–184

SOT (Sound On Tape), 1376
sound. See audio
sound bytes. See Sound On Tape (SOT)
sound effects, 851
sound effects tracks, 853
Sound Files option, 216, 218
sound input port, 158
Sound On Tape (SOT), 1376
sound quality, 1295
sound sweetening, 728, 729, 1211
source clips, 17, 148, 149
Source column in Browser, 171
Source File property, 210

source media. See also media
breaking links to, 871–872, 878–879
General tab settings and, 405
links to clips, 214–220, 871–872
omitting tracks, 553
reconnecting clips to, 214–219, 872–878
rendering, 1066

source monitor, 1376
source tapes

adjusting, 245–246
EDLs and, 1192, 1198–1199
reel names, 230–231, 1198–1199

Space bar, 347
spatial compression, 119, 125, 1110
speaker icon, 550
Speaker setting, 127
speakers

external, 23, 1289
monitoring speakers, 783
problems with, 1289, 1294

special effects, 1376. See also effects
Speed command, 1062
Speed Indicator in Timeline, 452
Speed section of Timing tab, 212
Speed settings, 212, 1062–1063, 1202
Spill Suppressor, Blue filter, 1047
Spill Suppressor, Green filter, 1047
Spin3D transition, 646, 1353
Spinback3D transition, 646, 1353
Spin Slide transition, 649, 1354
split clips, 537, 552–553, 589
split editing, 588–599

audio cuts and, 770–771
changing simple edits to, 592–593
clearing, 595
creating, 537, 764–766, 770–771
described, 376, 537, 588
EDLs and, 1196
modifying, 593–595
performing, 595–599
setting up, 376–379, 589–595
uses for, 589
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split edit overlays, 383
split edit points, 376–379, 762, 763
Split Slide transition, 649, 1354
spread. See also Pan/Spread slider; pan/spread 

overlay
adjusting for clips, 790–792
controlling with keyframes, 801–804
setting in Viewer, 789–792

spreadsheet programs, 152, 1207, 1208
Spread slider, 749, 789, 791
Sqrt function, 1247
square pixels, 296–298, 366–367, 968
Squeeze and Stretch transition, 650, 1354
Squeeze transition, 650, 1354
src1 variable, 1277
src2 variable, 1277
srclsGap1 variable, 1278
srclsGap2 variable, 1278
srcType1 variable, 1277
srcType2 variable, 1277
standard columns, 201
standard definition (SD) video, 298, 366
standard element timing, 1122, 1130–1131
Standard user mode, 55, 892, 893
Star Iris transition, 1354
Start and End of Edits overlay, 384
Start and End of Media overlay, 384
Start and End sliders for transitions, 626
Starting Timecode field, 62, 454, 894
Start property, 212
Star transition, 647
static regions, 466–468
stereo audio

defined, 1376
displaying, 744–745
guidelines, 804

stereo effects, 804
stereo levels, 781–785
stereo pair indicators, 451, 491
stereo pairs, 490–491

creating, 746–747
display of, 744
filters and, 821–822
pan and, 786, 811
separating, 747

settings and, 786
stereo pan, 801–803, 804
still frames, 1202
Still/Freeze Duration field, 890
Still Image Files option, 216, 218
still images. See also images

duration of, 300–301, 890
exporting, 1174–1176
importing, 156–157, 296–306
types supported, 156

Stop button, 227, 708
Stop Motion Blur filter, 1052
storage media, 30
storyboard, 546–548, 1376
Straight alpha channel, 919
straight cut, 1377
streaming

defined, 1377
movies, 1102
QuickTime files, 1163–1165, 1170–1172, 1375

Stretch transition, 650, 1354
stretch transitions, 650
string data type, 1246
StringToNum command, 1268
strobe effects, 1062
Strobe filter, 1052
stuttering, 1293
stylize filters, 1051
subclip icon, 172
subclips. See also master clips

breaking master clips into, 386, 387
creating, 236, 387, 399–401
defining with markers, 389
described, 386, 1377
extending In and Out points on, 388–389
finding original master clip, 387–388
poster frames and, 389–390
turning markers into, 236, 399
unused footage and, 391–392
working with, 386–392

subframe audio operations, 757–758, 816–820
subframe keyframes, 816–818, 848
subframe syncing, 851
Subroutine statement, 1285
Subtract command, 1263
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Subtract compositing mode, 930
Summary tab, 137–138, 140–142
Sun Audio format, 1149
superimpose editing, 582–583

described, 537, 1377
performing, 910–911
target tracks and, 554

superimposed video, 909, 917–918
superwhite, 120, 414, 1083–1085
S-Video connector, 27
S-Video input, 1361
S-Video signal, 27
swap editing, 695–697
Swap Edit tool, 695
Swap Slide transition, 649, 1354
Swing transition, 646, 1353
Sync Adjust Movies setting, 263, 887–888, 891, 

1290, 1291
sync beeps, 1213–1215
synchronization

audio/video. See audio/video sync
music, 819

System 7 Sound format, 1149
system requirements, 21
SysTime command, 1271

T

tabbed windows, 86–87
tail clips, 1377
Tan function, 1246
tape. See audiotape; videotape
tape-based editing suites, 17, 18
Targa files, 156, 1150
TARGA format, 19
Target Track controls

adding split clips, 552
omitting source media tracks, 553
specifying target tracks for editing, 483–484
in Timeline, 73, 447–448, 550–554

target tracks
defined, 1377
deselecting, 550, 553
designating in edits, 482–484
drag operations and, 554, 586–587
selecting in Timeline, 482–484, 550–552

superimpose editing and, 554
swapping, 551–552

TC column in Browser, 171
television, 22
temporal compression, 118, 119, 125, 1111
terminators, 33
Text generator, 1061
Text statement, 1279
TGA format, 156, 1150
three-point editing, 538–545, 1377
Threshold parameter, 825, 826
Thumbnail Cache setting, 891
Thumbnail column in Browser, 171
Thumbnail Display setting, 455, 895
thumbnails

cache for, 891, 901
defined, 1377
displaying, 194, 195, 895
hiding, 195
poster frames, 199
scrubbing through, 195, 891

thumb tabs, 444
TIFF format, 19, 156, 1150, 1377
timecode, 91–94

calibrating, 249–250, 1132, 1197
capturing, 35–37, 40
capturing audio, 158
changing clip’s timecode, 17
described, 91, 355–357, 1377
determining type of, 91
drop frame timecode, 62, 91–92, 356, 894, 1370
EDLs and, 151, 286, 1197
entering, 92–93, 357–358
extending marker duration with, 398, 526–527
format of, 91
iMovie and, 150
logging tape and, 222
LTC, 36, 37
moving clips with, 673
moving items with, 506–507
moving markers with, 397, 526
moving playhead with, 355, 358–359
navigation with, 93, 469
non-drop frame, 91–92, 1373
NTSC format and, 19, 356
1426 Index  



problems with, 1292, 1293
searching for items by, 528–529
serial connection, 36, 37, 40
settings, 342
setting starting timecode, 62, 894
shortcuts for, 93
sliding clips with, 694–695
slipping clips with, 692
start time, 62
trimming and, 698–701
types of, 356–357
user-programmable, 1198
using in Viewer, 355–359
video decks and, 37
VITC, 36, 37

timecode breaks, 1124–1125
avoiding, 252, 1292
recapture process and, 280
source tapes, 151
Sync Adjust Movies setting and, 888

Timecode Duration field, 94, 226, 341, 375, 436
timecode fields

Canvas, 94, 425, 426, 436–437
Viewer, 329, 341–342

Timecode navigation field, 836, 1027
timecode numbers, 1195–1196
timecode offset, 249–250
Timecode Offset field, 131
Timecode Print filter, 1053
timecode tracks, 857, 858, 1123–1124
Time Display option, 178
Timeline, 442–532

adding transition effects in, 608
adjusting keyframes in, 807
adjusting opacity in, 912–918
applying scripts in, 1233
applying transitions to sequences, 631–632
audio waveforms, 62
canceling edits in, 697
Canvas and, 73, 422, 442
changing pan in, 811
changing volume in, 806–810
clips merged in, 347
closing, 73
closing sequences in, 419

color coding in, 452
copying clips to Browser, 505
copying/pasting clips in, 508–509
creating static regions for tracks, 465–468
customizing display of, 453–459
cutting clips in, 701–703
deleting items in, 515–517
deselecting items in, 500
displaying audio tracks in, 453
displaying filters in, 833, 1036
displaying video tracks in, 73, 453
dragging audio clips to, 752
drop frame timecode, 62
editing in, 447–452, 584–587, 769–775
edit points in, 555–563
filter bars in, 833, 961–963
illustrated, 64
jumping to locations in, 469
keyboard shortcuts used in, 1309–1310
linking items in, 488–489
loading transitions from, 631
locking tracks in, 479–480
markers in, 470, 520–527
modifying audio transitions in, 778–780
modifying clips in, 501–505
modifying transitions in, 619–621, 779
motion bars in, 833, 961–963
moving clips within, 505–507, 524
navigating in, 73, 446–447, 468–471
opening, 73, 452
opening clips from, 344–345, 752
opening Item Properties window in, 530
opening sequences in, 419
options, 454–459, 894–897
overview, 73, 442–452
performing ripple edits in, 682–683
performing roll edits in, 677–678
playback from, 1108
playhead in, 446
playhead navigation in, 468–471
positioning clips in, 911–912
positioning playhead in, 469
preferences, 62, 454–459, 884, 894–897
recording from, 1113, 1116–1119
replacing clips from In point, 575
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resizing clips in, 674–675
ruler, 446
scrolling in, 464–468
scrubbing sequences in, 469
searching for items in, 528–529
selecting clips in, 494–496, 661–666
selecting edit points in, 661–662
selecting items in, 491–500
selecting target tracks in, 482–484, 550–552
sequences and, 73
setting In and Out points in, 554–563
setting starting timecode number, 62
shortcut menus in, 1334–1335
showing clips in, 514–515
sliding clips in, 693–695
slipping clips in, 690–692
snapping in, 500–501
tabs in, 86, 443, 453
Target Track controls in, 73, 550–554
transparency effects, 912–918
trimming edits in, 654
working with audio in, 766–775
working with clips in, 444, 472–474
working with items in, 484–527
working with tracks in, 73, 443–446, 474–484
zoom controls in, 444, 460–464, 755, 757, 769
zooming view of, 460–464, 755–756, 757, 769

Timeline Options tab
described, 62, 884
Preferences window, 453–459
Sequence Settings window, 409–413

Timer option, 130
time scale, 630
Time Source setting, 130
timing information, 212
Timing tab, 212
Tint effect, 1236–1238
Tint filter, 1045
titles, 1194
title safe area, 1377
title safe boundaries, 371–372, 955–956
titling generators, 1059–1061
tone, 741, 761, 771–774, 848

Tool palette
illustrated, 64, 74
selecting items in Timeline, 492–500
selecting tools in, 74
trimming tools in, 655–656
viewing tools in, 74

tools. See also specific tools
keyboard shortcuts for, 1317–1323
media management tools, 855–881
pen tools, 805, 890, 983
selection tools, 658–666
Timeline selection tools, 492–500
in Tool palette, 74, 492–500, 655–656

tooltips, 85
track controls, 238–239
track gaps, 511, 512–513, 704, 705
Track Height control, 73, 446, 768
Track pop-up menu, 707
tracks. See also audio tracks; video tracks

adding to sequences, 475–477, 586
ambience, 853
audio played in real time, 812–813
control tracks, 1123–1124
default number of, 62, 897
default size of, 894
defined, 1377
deleting from sequences, 477–478
dialog tracks, 853
EDLs and, 1200
hiding, 480–482
invisible tracks, 448–449, 480–482, 1090, 1372
key tracks, 917
locked tracks, 479–480, 482, 553–554, 657
moving audio between, 774–775
moving clips between, 506, 911–912
music, 853
omitting source media tracks, 553
order of, 73
pasting clips onto, 510–511
rippling on, 685
rolling, 679
scrolling vertically through, 465–468
selecting, 492, 660–661
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selecting all clips on, 497–500
selecting for trimming, 660–661
selection tools, 497–500, 660–661
size of, 894
sound effects, 853
target tracks, 482–484, 1377
timecode tracks, 1123–1124
types of, 1195
vertical height, 62
on videotape, 1123–1124
voiceover tracks, 853
working with in Timeline, 73, 443–446, 474–484
working with regions, 465–468

Tracks column in Browser, 171, 240
track selection tools, 497–500, 655, 660–661, 

1317
Track Size option, 62, 455, 894
Track Visibility control, 448–449, 482
trailers

adding, 79, 1130
black trailers, 1122, 1130
options, 1122, 1130

transition bar, 626
transition codes, 1353–1355
Transition command, 1267
Transition Editor

applying transitions to sequences, 631–632
controls in, 622–629
displaying clips in, 630
loading/modifying transitions, 631
trimming transitions/clips, 632–636
zoom controls in, 630

transition effects. See effects
transitions, 605–651. See also specific transition 

names
adding in Timeline, 608
adding transition effects, 606–615
alignment of, 621, 623, 778
applying to sequences in Timeline, 631–632
audio. See audio transitions
changing location, 634–635
copying, 618
custom settings, 629
default transitions, 611–612, 629, 642–643
deleting from sequences, 618

described, 606, 1378
duration of, 619–620, 623, 634, 778
edits with, 1195–1196
EDLs and, 610, 1195, 1200, 1202
fade-to-black transitions, 615
favorite transitions, 637–641
included with Final Cut Pro, 646–651
insert with transition edits, 567–569, 607
making precise changes to, 622–636
modifying, 642–643
modifying in Timeline, 619–621
modifying in Transition Editor, 631
moving, 617
non-standard, 1202
opening in Transition Editor, 623, 631
overlapping frames and, 609–610
overwrite with transition edits, 571–573, 607
previewing, 644–645
rendering, 643–645, 840–842
replacing, 616
resetting properties of, 629
reversing direction of, 629
in sequences, 606–615
settings, 629
start/end percentages slider, 626–628
trimming, 632–636
video. See video transitions
vs. cuts, 606
YCrCb color space and, 164

Transition statement, 1280
transparency effects, 912–918
transport controls

Canvas, 88, 426, 429–431
Edit to Tape window, 1128
keyboard shortcuts, 337
Log and Capture window, 77, 227
Trim Edit window, 708, 715
Viewer, 88, 328, 336–337

Travel Matte compositing mode, 934
travel mattes, 936–937
Trim Edit window, 707–715

canceling edit in, 714
closing, 712
controls in, 707–710, 715
described, 75–76
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opening, 711–712
playing back edits in, 715
reviewing edits in, 715
slipping clips in, 715
trimming edits in, 654, 712–714
using, 711–715

trim editing, 653–725
controls for, 656–657
Tool palette, 655–656
windows used for, 654

trimming, 653–725. See also editing
audio clips, 764–766
clips, 632–636
described, 632, 654, 1378
edits, 75
frames and, 887
opening clips for, 666–667
selecting clips for, 658–666
selecting edit points for, 661–662, 664
selecting tracks for, 660–661
selection tools for, 658–666
track selection tools for, 660–661
with timecode, 698–701
transitions, 632–636
in Trim Edit window, 707–715
types of trimming operations, 669–706
in Viewer, 698–701, 764–766
warning messages for, 668

troubleshooting, 1287–1296. See also artifacts; 
messages

A/V sync problems, 1289–1292
audio problems, 24, 25, 1294–1295
camcorder/deck problems, 1288, 1293, 1294
common problems, 1288–1295
contacting AppleCare Support, 1296
editing to tape, 1292
EDL exports, 1206
external speakers, 1289, 1294
importing batch lists, 1208
monitor problems, 23, 1288–1289, 1293
opening autosave files, 176
performance problems, 1294
playback problems, 1288–1293, 1295
reference movies, 1295
stuttering video, 1293

timecode problems, 1292, 1293
video devices, 1288, 1293
video problems, 1289–1292

true constant, 1274
Truncate command, 1271
tutorials, 8, 56
Type column in Browser, 171
Typewriter generator, 1061

U

Ultra ATA disk drives, 31
Ultra2 LVD SCSI disks, 32, 33
U-Matic format, 1378
uncompressed video, 30, 155, 1103–1104, 1110
underscanning, 371
Undo command, 97, 534, 1086
undo function

FXBuilder, 1227
levels of undo, 61, 534, 886
memory and, 886
undoing actions, 534
undoing changes, 97
using to test sequences, 534, 886

UnMultiply command, 1263
Unsharp Mask filter, 1050
Up button in Log Bin controls, 233
Update button for markers, 236
USB hubs, 41, 42, 43
USB-to-serial adapter, 25, 40, 41, 42
Use Deck Search Mechanism option, 131
Use Digitizer’s Default Settings button, 237
Use Existing option, 870
Use Logged Clip Settings option, 277
user mode

changing, 893
choosing, 324
Cutting Station mode, 55, 892, 893, 1194
preferences, 884, 892–893
setting, 52, 55, 892–893
Standard mode, 55, 892, 893

User Mode option, 52
User Mode tab, 884
Use setting, 119
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V

V Wipe transition, 650, 1355
V1 tracks, 917, 1200
V2 tracks, 917, 1200
value data type, 1246
variables, 1241
VCR mode, 36, 1114, 1132
VCR ( Videocassette Recorder), 1378
Vectorscope, 241–246, 1360–1363, 1364, 1378
Venetian Blind Wipe transition, 650, 1355
vertical interval timecode ( VITC), 36, 37, 

130, 149
vertical scroll bars, 444
VHS format, 15, 1098
video. See also analog video; digital video

accurate color, 1360–1365
capture presets, 122–123
capturing. See capturing process
Component, 1369
Composite, 19
compression, 1110–1111
creation process, 18–19
data rates, 152–154
different tape formats, 146–147
displaying in Viewer, 360–372
external video, 352
file formats, 288, 1148
fonts and, 299
iMovie use, 150, 1106
inactive, 336
interlaced, 292, 293, 1372
letterbox video, 1343–1344, 1351
line art and, 299
linking items, 488–489
logging, 222
M-JPEG, 30
matching for clips, 90
matching for sequences, 90
non-interlaced, 1373
outputting to CD-ROMs, 1101
outputting to DVD, 1100
presets, 59, 116–117
printing to, 1108

problems with, 1289–1292
quality of, 26, 27
QuickTime settings, 116–117, 122–123, 

1159–1162
saving to scratch disk, 52, 55
sequence presets, 116–117, 120
stuttering, 1293
superimposed video, 917–918
synchronizing with audio. See audio/video sync
transferring to film, 1099–1100
uncompressed, 30, 155, 1110

video camera. See camcorder
video capture cards

analog-to-digital, 15, 21, 23, 24, 26, 27
capture presets and, 121
codecs and, 147
connecting analog equipment to, 43–44
data rates, 152
memory and, 22, 49
real-time, 26
third-party, 22, 25, 116, 152

Videocassette Recorder ( VCR), 1378
video CDs, 1101
video clips. See clips
video codecs. See codecs
video compression, 1110–1111
video deck

analog video decks, 25, 43–44
capturing video with, 271–273
connecting video monitor through, 23
controlling with Final Cut Pro, 35
controlling with transport buttons, 35
device control, 34–37, 149, 229, 230, 271
DV video decks, 21, 41
FireWire and, 36, 38, 149
Local control, 35
logging tapes with, 152
manual use of, 35
multiple decks, 128
problems with, 1288, 1293
Remote control, 35
sample rates, 887–888
serial device control, 149
timecode and, 37
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video devices. See also analog devices; devices
capturing clips manually, 148
Easy Setup for, 52–55
preferences, 21
troubleshooting, 1288

video editing. See editing
video effects. See effects
video equipment. See also hardware

connectors. See connectors
considerations, 20–26
Easy Setups for, 52–55, 1114–1115
editing to tape and, 1132
film transfer facilities and, 1099
recording to videotape and, 1114
video signals, 26–29

Video Files option, 216, 218
video filter category, 1052–1053
video filter icon, 172
video filters, 1024–1053. See also audio filters; 

filters; specific filter names
After Effects filters, 1053
applying to clips, 1032–1035
color control, 1030
controls for, 1028–1031
displaying in Timeline, 1036
favorite filters, 1038–1039
included with Final Cut Pro, 1041–1053
keyframing, 1039
modifying, 1036–1037
parameter controls, 1026
removing, 1037–1038
settings, 69, 1026–1027
start and end points, 1026
uses for, 1024–1025

video footage. See footage
video format. See file formats
video generator icon, 172
video generators, 1054–1061. See also generators

described, 1054
graphical generators, 1057–1059
included with Final Cut Pro, 1057–1061
using, 1057–1061
working with, 1055–1056

Video Items Format section of tab, 211
Video Processing tab, 414–415
video signals, 26–29
Video tab

controls in, 328–329, 1126–1128
described, 67–68
Viewer shortcut menus, 1328–1329

videotape. See also video
blacking, 1133
considerations, 1098
cueing, 1115
editing to, 1108, 1123–1144
exporting anamorphic media to, 1351
logging, 150–152, 222
organizing, 1198–1199
outputting clips to, 1108
outputting sequences to, 1108
outputting to, 22, 43, 47, 1108
preparing with black and code, 1133–1134
printing to, 1108, 1119–1122
recording to, 1113–1122
source, 1198–1199
television broadcast, 22
tracks on, 1123–1124

video tracks. See also audio tracks; tracks
analyzing, 857, 858
default number of, 62, 897
disabling in clips, 514–515
displaying, 73, 453
locking, 479–480, 553–554
scrolling through, 465
target tracks, 483, 550–551
in Timeline, 73, 443, 472–474

video transfer facilities, 1099
video transition icon, 172
video transitions, 611, 620

adding, 611, 613
changing duration, 620
default, 611, 642–643

Videotape Recorder ( VTR), 1378
Vid Rate column in Browser, 171
view controls, 434, 435
View During Playback Using setting, 134
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View During Recording Using setting, 135
Viewer, 67–70, 327–401

activating, 330
audio controls, 748–751
Audio tab, 744–751
Browser/Viewer operations, 342–350
canceling edits in, 697
closing, 67, 330
controls in, 67, 88–90, 328–329
described, 327–329
displaying video in, 360–372
editing audio in, 762–766
Filters tab in, 1026–1027
illustrated, 64
In and Out points, 548–549
keyboard shortcuts used in, 1323
loading clips into, 1036–1037
media and, 422
moving playhead in, 838
navigating in, 352–355
opening, 67, 330
opening clips in, 344–346, 666–667, 752, 963
opening exported files in, 1190
opening sequence clips in, 503–505, 600–601
opening sequences in, 419
overlays in, 382–385
performing ripple edits in, 683
performing roll edits in, 679
playing clips in, 347–349
resizing clips in, 675–676
setting audio levels in, 785–789
setting edit points in, 373–385
setting stereo pan/spread in, 789–792
setting up split edits in, 376–379
shortcut menus in, 1328–1333
slipping clips in, 692
split edits in, 590–592, 595–599
tabs in, 86, 328, 330–334
trimming audio clips in, 764–766
trimming in, 654, 698–701
uses for, 327–328
using markers in, 392–401
using timecode in, 355–359
video display in, 360–372

viewing alpha channels in, 368–369, 922
viewing filters in, 833–834
viewing RGB channels in, 368–369
working with audio in, 743–751
working with In and Out points in, 373–385
working with markers in, 392–401
zoom controls in, 340, 360–363

Viewer window, 364
View Finder filter, 1053
View menu, 132, 136, 504
View pop-up menu

Canvas, 425, 426, 434, 435
Viewer, 328, 340

virtual memory, 1289, 1294
VISCA format, 149
VITC (vertical interval timecode), 36, 37, 

130, 149
Vocal DeEsser filter, 827, 847
Vocal DePopper filter, 827, 847
voiceover recordings, 848
voiceover tracks, 853
voices, 784
volume. See also audio

adjusting for clips, 748, 787–789
changing in Timeline, 806–810
levels. See audio levels
master monitoring volume, 783

Volume slider, 127
VTR mode, 1360
VTR ( Videotape Recorder), 1378
VU meters, 24, 735, 737, 740

W

Wave command, 1259
Wave files, 19, 1106
Wave filter, 1043
Wave format, 159, 1149, 1177
waveform cache, 901
waveform display area, 750, 753–758
waveform displays, 331, 759
Waveform Monitor and Vectorscope button, 239, 

1360
Waveform Monitor, 241–245, 1360–1363, 1364, 

1378
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waveforms
analog, 730
audio levels and, 734
in audio tracks, 766–767
displaying, 62, 68, 897
dynamic range and, 733
navigating through, 753–756

Web
compression for, 1101–1103
distributing movies on, 1101–1103
QuickTime movies for, 1101–1103

Web sites
Apple Store, 12
Apple Support, 10–11, 1296
Apple Web sites, 10–12
Final Cut Pro, 10, 19
FireWire, 12, 36
QuickTime, 12

What’s New? menu item, 10
Where Do I Start? menu item, 10
Whirlpool command, 1258
Whirlpool filter, 1043
white, absolute, 244, 1361
White alpha channel, 919
white value, 120, 165
Wide Screen filter, 1049
widescreen format, 1378
widescreen video, 1341, 1342. See also 

anamorphic media
Wind Blur filter, 1041
“window burn,” 27, 1053
window dub, 1378
windows. See also specific windows

activating, 64–65
in Final Cut Pro, 64–76
screen layouts, 94–96
tabbed windows, 86–87
Undo/Redo commands and, 97

WipeCode statement, 1280
wipes, 606
Wipe transition, 649
wipe transitions, 650–651
wireframe, 1378
wireframe handles, 966, 969–980

Wireframe mode, 964
wireframe views, 963–966
word-processing programs, 152, 1207, 1208
Wrap Wipe transition, 650

X

X and Y coordinates, 951–953
X coordinate, 1378
XLR connectors, 25

Y

Y coordinate, 1379
YCrCb color space

compositing and, 1083
defined, 1379
rendering in, 1083–1086
settings for, 414–415, 1084–1086
updating projects and, 163, 164–165, 1085
working in, 1083

YCrCb format, 27, 28, 1379
YUVcolor data type, 1246
YUVColorKey command, 1265
YUV color space, 147, 166, 1360. See also YCrCb 

color space
YUV processing, 147, 166
YUVtoRGB variable, 1278

Z

Zero Setup waveform level, 1364
Zigzag Wipe transition, 650
Zip drives, 30
Zoom Blur filter, 1041
zoom controls

audio clips, 753–757, 769
in Audio tab, 751
audio waveforms, 753–755
in Canvas, 434, 967–968
keyframe graphs, 836, 985–986, 1027
Timeline, 460, 461, 462
in Timeline, 444, 460–464, 755–757, 769
in Transition Editor, 630
in Viewer, 340, 360–363
waveform display area, 753–758
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zoom feature, 360–363
Zoom In tool

keyboard modifiers, 1318
Timeline, 462–463, 464, 755–756
Tool palette, 655
Viewer, 361, 362, 364

Zoom Out tool
keyboard modifiers, 1318
Timeline, 462–463, 464, 755–756
Tool palette, 655
Viewer, 362

Zoom pop-up menu
Canvas, 425, 426, 434
Viewer, 328, 340, 360–361

Zoom slider
Audio tab, 751
keyframe graphs, 836, 1027
Motion tab, 985
Timeline, 447, 460–462, 464, 465, 755
Viewer, 751

Zoom transition, 646, 649, 1353
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